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DISCLAIMER            
 
This report was prepared as an account of work sponsored by an agency of the United States 

Government.  Neither the United States Government nor any agency thereof, nor any of their 

employees, makes any warranty, express or implied, or assumes any legal liability or 

responsibility for the accuracy, completeness, or usefulness of any information, apparatus, 

product, or process disclosed, or represents that its use would not infringe privately owned rights.  

Reference herein to any specific commercial product, process, or service by trade name, 

trademark, manufacturer, or otherwise does not necessarily constitute or imply its endorsement, 

recommendation, or favoring by the United States Government or any agency thereof.  The 

views and opinions of the authors expressed herein do not necessarily state or reflect those of the 

United States Government or any agency thereof. 
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ABSTRACT            
 
Gas storage is a critical element in the natural gas industry.  Producers, transmission and 

distribution companies, marketers, and end users all benefit directly from the load balancing 

function of storage.  The unbundling process has fundamentally changed the way storage is used 

and valued.  As an unbundled service, the value of storage is being recovered at rates that reflect 

its value.  Moreover, the marketplace has differentiated between various types of storage services 

and has increasingly rewarded flexibility, safety, and reliability.  The size of the natural gas 

market has increased and is projected to continue to increase towards 30 trillion cubic feet over 

the next 10 to 15 years.  Much of this increase is projected to come from electric generation, 

particularly peaking units.  Gas storage, particularly the flexible services that are most suited to 

electric loads, is crucial in meeting the needs of these new markets. 

To address the gas storage needs of the natural gas industry, an industry-driven consortium was 

created – the Gas Storage Technology Consortium (GSTC).  The objective of the GSTC is to 

provide a means to accomplish industry-driven research and development designed to enhance 

the operational flexibility and deliverability of the nation’s gas storage system, and provide a 

cost-effective, safe, and reliable supply of natural gas to meet domestic demand.  

This report addresses the activities for the quarterly period of January 1, 2008 through March 31, 

2008.  Key activities during this time period included: 

• Drafting and releasing the 2008 Request for Proposals; 

• Planning the 2008 GSTC Spring Meeting, Chicago, IL, on April 17-18, 2008;  

• Scheduling and participating in four (4) project mentoring conference calls; 

• Conducting elections for five (5) Executive Council seats;  

• Releasing the GSTC Insider e-newsletter; and 

• One 2006 project final report received.
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INTRODUCTION           

Gas storage is a critical element in the natural gas industry.  Producers, transmission and 

distribution companies, marketers, and end users all benefit directly from the load 

balancing function of storage.  The unbundling process has fundamentally changed the 

way storage is used and valued.  As an unbundled service, the value of storage is being 

recovered at rates that reflect its value.  Moreover, the marketplace has differentiated 

between various types of storage services and has increasingly rewarded flexibility, 

safety, and reliability.  The size of the natural gas market has increased and is projected to 

continue to increase toward 30 trillion cubic feet over the next 10 to 15 years.  Much of 

this increase is projected to come from electric generation, particularly peaking units.  

Gas storage, particularly the flexible services that are most suited to electric loads, is 

crucial in meeting the needs of these new markets. 

 
To address the gas storage needs of the natural gas industry, an industry-driven 

consortium was created – the Gas Storage Technology Consortium.  The objective of the 

GSTC is to provide a means to accomplish industry-driven research and development 

designed to enhance the operational flexibility and deliverability of the nation’s gas 

storage system, and provide a cost-effective, safe, and reliable supply of natural gas to 

meet domestic demand.  Consortium technology development is conducted in the general 

areas of well-bore and reservoirs, operations, mechanical, and salt caverns.  Consortium 

members elect an executive council that is charged with reviewing projects for 

consortium co-funding.  Projects are submitted by GSTC members and are funded on an 

annual basis.  Proposals must address improving the production performance of gas 

storage and provide significant cost sharing.  The process of having industry members 

develop, review, and select projects for funding ensures that the GSTC conducts research 

that is relevant and timely to the industry.   
 

The scope of Penn State’s activities includes managing the process of attracting and 

maintaining consortium members, soliciting proposals, awarding and monitoring 

subcontracts to members to accomplish the selected technical works and disseminating 

the results of the technical work via meetings and final reports.
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EXECUTIVE SUMMARY         
This report summarizes the important accomplishments during the period of January 1, 
2008 through March 31, 2008.  The GSTC was established under contract to The 
Pennsylvania State University from the U.S. Department of Energy (DOE), National 
Energy Technology Laboratory (NETL), in June 2004.  The agreement provides the 
Pennsylvania State University with the overarching management responsibilities for the 
GSTC.  Key activities for this reporting period included the following: 

 
2008 Request for Proposals 

The 2008 GSTC Request for Proposals was released in January 2008 with proposals 
due on April 2, 2008.  

2008 GSTC Spring Meeting 
Plans for the 2008 GSTC Spring Meeting continues.  The meeting will be held at the 
Embassy Suites Chicago Downtown Lakefront, Chicago, IL on April 17-18, 2008.  
All proposals received are required to give a presentation as well as technology 
updates from current projects.  
 

Project Mentoring Conference Calls  
Four conference calls were scheduled and conducted, as follows: 
• RGD X-ray Technology Well Bore Inspection and Assessment- A Feasibility 

Study, (Gas Technology Institute), January 24, 2008; 
• Evaluation of Magnetic Pulse Welding (MPW) for Improved Casing Repair, 

(Edison Welding Institute), January 31, 2008;  
• Gas Storage Facility Design Under Uncertainty, (University of Texas at Austin), 

January 31, 2008;  
• Smart Gas: Using Chemicals to Improve Gas Deliverability – Phase II, 

(Correlations Company), January 31, 2008.  
 

Executive Council Candidates 
The Technical Advisory Committee elected five (5) Executive Council 
representatives to serve for 2008-2009. 

 

GSTC Insider E-newsletter 
The GSTC Insider e-newsletter was released in February 2008.  This is the first 
newsletter in 2008 and offers an additional mechanism for keeping the industry 
informed. 

 
Technical Feasibility Evaluation of Casing Cement Leaks Final Report 

The Technical Feasibility Evaluation of Non-Intrusive Optical Detection, Monitoring 
and Preliminary Characterization of Casing Cement Leaks for Gas Wells, (URS) has 
been received and posted to the GSTC member’s only section of the website.    
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EXPERIMENTAL          
A description of experimental methods is required by the DOE for all quarterly technical 

progress reports.  In this program, Penn State is responsible for establishing and 

managing an industry-driven underground gas storage consortium.  Technology 

development research awards are made on a competitive basis.  Technical reports from 

the individual researchers are required to contain experimental discussion sections and 

are submitted to consortium members and the DOE for review.  Therefore, this section is 

not applicable to the Penn State contracted activities.  
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RESULTS & DISCUSSION         
This report addresses the activities for the reporting period from January 1, 2008 through 

March 31, 2008.  Key activities during this time period included: 

• Drafting and releasing the 2008 Request for Proposals; 

• Preliminary planning for the 2008 Spring Meeting, Chicago, IL on April 17-18, 

2008; 

• Conducting four mentoring team conference calls; 

• Identifying representatives to serve on the Executive Council for 2008-2009;  

• GSTC Insider e-newsletter released; and 

• One final report for a 2006 project received.   
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GSTC Administration 
The scope of the GSTC administration activities includes managing the process of 

attracting and maintaining consortium members, soliciting proposals, developing 

strategies for action on recommendations from the technical committee and executive 

council, keeping the industry informed on issues and events, and awarding and 

monitoring subcontracts to members to accomplish the selected technical works. 

 

2008 GSTC Request for Proposals 

The 2008 GSTC Request for Proposals was drafted and released on January 30, 2008, 

with proposals due April 2, 2008.  Proposals are sought in the following focus areas:  

    •  Mechanical 
    •  Well-bore and reservoir 
    •  Operations 
    •  Salt cavern 
 
The Pipeline Research Council International (PRCI) is providing cost share to the GSTC 

and has a specific interest in the following topics: 

    •  Deliverability maintenance and enhancement 
    •  Base gas reduction 
    •  Improved assessment of wellbore tublars 
    •  Reduced well workover costs 
 
The RFP is attached as Appendix A.  
 

2008 GSTC Spring Meeting 

The GSTC administration continues planning for the 2008 GSTC Spring Meeting at the 

Embassy Suites Chicago Downtown Lakefront, Chicago, IL on April 17-18, 2008.  In 

addition to hearing funding requests, this meeting is an opportunity to hear the 

technology developments from current projects.  At the close of the general meeting, the 

Executive Council will meet and recommend which proposals they desire to go forward.  

 

Project Mentoring Conference Calls 

Four project-mentoring conference calls were conducted.  The mentoring team was 

established in 2006 to better communicate between meetings, hence assuring the projects 



 

 

6     
 

are on track.  The notes from the conference calls are posted in the member’s only section 

of the GSTC website: http://www.energy.psu.edu/gstc/ 

The calls were: 

• RGD X-ray Technology Well Bore Inspection and Assessment- A Feasibility 
Study, (Gas Technology Institute), January 24, 2008; 

• Evaluation of Magnetic Pulse Welding (MPW) for Improved Casing Repair, 
(Edison Welding Institute), January 31, 2008;  

• Gas Storage Facility Design Under Uncertainty, (University of Texas at Austin), 
January 31, 2008;  

• Smart Gas: Using Chemicals to Improve Gas Deliverability – Phase II, 
(Correlations Company), January 31, 2008.  

 

The RGD X-ray Technology Well Bore Inspection and Assessment- A Feasibility Study 

project proposes to study, develop, and demonstrate a real-time RGD tool for in situ 

compositional identification and quantification of scale in gas storage wells and pipelines.  

The RGD tool will also assess and quantify material defects, pitting, and penetrations in 

casings and associated piping.  This innovative technology can provide real time data and 

analysis on both scale formation inside the well bore as well as assess the well bore 

casing integrity.  The Executive Summary is attached as Appendix B.  Due to the 

inability of GTI to begin work in a time frame that would allow the work to be completed 

in the allocated time period, this project was terminated during this quarter.  

 

The objective of the Evaluation of Magnetic Pulse Welding (MPW) for Improved Casing 

Repair project is to determine the feasibility of MPW for improved casing repair.  MPW 

is a single shot joining technology, which means the weld is made instantaneously by 

pressing a button.  EWI has completed extensive work on externally welding tublar 

structures with MPW.  Up to two internal coil systems will be built for testing.  EWI is 

now doing welding trials to confirm the feasibility and durability of the internal coil 

system.  Around 40 weld samples will be cut from casing material provided by 

Whipstock.  The Executive Summary is attached as Appendix C. 

 

The Gas Storage Facility Design Under Uncertainty project will examine the sensitivity 

of gas storage facility design decisions to uncertainty in the estimates used during 

concept comparison and selection.  It will investigate how uncertainty in estimates 
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influence optimal facility sizing and other design decisions and assess the relative value 

of reducing uncertainty in these same estimates.  There will be a spreadsheet of tools (or 

comparable format) that will convert the key findings of the research into tools and 

templates that decision-makers can use to inform decision-making.  The Executive 

Summary is attached as Appendix D. 

 

The Smart Gas: Using Chemicals to Improve Gas Deliverability – Phase II project 

proposes to develop new technology to improve gas deliverability from gas storage wells.  

The laboratory tests with oil demonstrated that intermediate wettability is optimum.  

Numerical simulation indicated the same.   Phase I of the project showed that wettability 

alteration worked in sandstone cores, but not dolomite.  Field-testing of the surfactant 

that reduced favorable laboratory results is proposed.  The analytical approach developed 

during the original project will be used to evaluate the proposed field tests.  Two 

operators of aquifer gas storage sites are interested in testing the wettability-altering 

concept.  The Executive Summary is attached as Appendix E. 

 

Executive Council  

The GSTC conducted elections for five representatives to serve on the Executive Council 

for 2008-2009.  The Council's responsibilities include attending a two-day proposal 

meeting to review and select proposals for GSTC funding, to participate, either in person 

or via teleconference, in other Council meetings at various locations throughout the year 

and are encouraged to serve on Ad hoc committees to steer the GSTC research projects.  

The Executive Council Election Form is attached as Appendix F.  The new 

representatives are:  

• Larry Kennedy, El Paso Corporation  
• Brian Hall, Equitable Resources  
• Ramon Harris, National Fuel  
• Steve Bergin, ONEOK, Inc.   
• John Jackson, Spectra Energy  

 

The Executive Council members who will continue to serve until the end of 2008 are: 

• Greg Theirl, Dominion Delivery 
• Todd Thomas, NW Natural 
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• Jim Mansdorfer, Southern California Gas 
• George Hodges, Southern Union 
 

New Members 

The 2008 membership includes 43 members from 16 U.S. states and two members from 

Canada.  Three new members have been added:  

• Atmos Energy, Dallas, TX 
• Enstor Operating Co., Houston, TX 
• NITEC, Denver, CO 
 

GSTC Insider E-newsletter 

The GSTC Insider electronic newsletter was released in February 2008.  This was the 

first electronic newsletter for 2008.  The newsletter is another method of keeping 

representatives informed on issues relevant to the industry.  The newsletter was 

distributed to the GSTC list serve as well as being posted to the GSTC website.  
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Technology Transfer/Outreach  
There are several avenues for accelerating the commercialization and deployment of 

technology into industry.  The GSTC strategy includes meetings to hear technology 

updates from co-funded projects, software training, and disseminating the final research 

results in a timely manner. 

 

Technical Feasibility Evaluation of Casing Cement Leaks Final Report  

The final report for the 2006 project, Technical Feasibility Evaluation of Non-Intrusive 

Optical Detection, Monitoring and Preliminary Characterization of Casing Cement Leaks 

for Gas Wells, (URS) has been received and posted to the GSTC member’s only section 

of the website.  The report is attached as Appendix G.  
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Planned Activities for Next Reporting Period 
During the next quarter the GSTC will: 

• Host the 2008 GSTC Spring Meeting in Chicago, IL on April 17-18, 2008; 

• Begin negotiations on subcontracts for projects identified at the 2008 Spring 

Meeting; 

• Continue the mentoring team conference calls;  

• Submit final reports for the 2004, 2005, and all 2006 reports received to DOE for 

posting on the public website; 

• Release another online newsletter. 
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CONCLUSIONS           
During this reporting period, the GSTC drafted and released a request for proposals.  The 

GSTC continued planning for the GSTC 2008 Spring Meeting in Chicago, IL.  Four 

project mentoring calls were conducted.  Three new members were added this quarter. 

Elections were conducted for five new Executive Council members.  The GSTC released 

an on-line newsletter.  Through these efforts, the GSTC continues to improve and better 

serve the gas storage industry.   
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REFERENCES           
A listing of referenced materials is required by the DOE for each quarterly technical 

progress report.  However, this technical progress report for the GSTC did not utilize any 

reference materials during this reporting period. 
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2008 REQUEST FOR PROPOSALS  

FOR THE GAS STORAGE TECHNOLOGY CONSORTIUM 

 
 
APPLICANT ELIGIBILITY 
Competition is open to all current Full and University Members of the Gas Storage 
Technology Consortium (GSTC).  The GSTC Executive Council will not review 
proposals without a fully executed membership agreement in place.  New memberships 
are accepted throughout the year.  Membership information and applications can be 
found on the GSTC website at http://www.energy.psu.edu/gstc. Proposals received from 
members whose dues are not current, or whose membership agreement is not fully 
executed will be returned without review. 
 
University employees eligible to serve as principal investigators for proposals submitted 
to the consortium are: 
         Full-time regular tenure-track or regular faculty, and; 
         Persons with the title of Research Assistant, Associate, Scientist or Senior Scientist. 
 

 
INSTITUTION COMMITMENT  
Each proposal must be signed by an official of the company or university who is 
authorized to commit the company/institutional resources to the project.   The name of 
the Applicant’s authorized official shall be entered in the appropriate space shown on the 
cover page (Attachment B).  
 
 
RESEARCH FOCUS AREAS 
The mission of the GSTC is to assist in the development, demonstration and 
commercialization of technologies to improve the integrity, flexibility, deliverability, and 
cost-effectiveness of the nation’s underground natural gas/hydrocarbon storage facilities.  
Projects selected for funding will be based on those that best accomplish the Consortium 
goals.  Proposals in this funding cycle are being solicited from GSTC Full and University 
Members in the following focus areas: 
 
 

Mechanical 
Examples include, but are not limited to, investigations that address pipe and 
well casing integrity, the improvement of downhole leak detection, the 
development of new casing evaluation tools, the development/ evaluation of 
advanced metallurgy/ materials for use in well casing and casing repairs, 
cement bonding, delta-temperature effects on casing, use of “smart pipe” 
concepts for well casing, corrosion mitigation and quantification, removal 
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techniques for scales, fines, salts, asphalts, and techniques to remediate 
damage through stimulation/ recompletion/ workover of existing wells. 
 
 
Well-bore and Reservoir 
Examples include, but are not limited to, investigations that address reservoir 
characterization, consider new approaches to modeling of gas cycling and 
inventory verification, develop techniques to maintain and improve injectivity 
and deliverability, and expand existing aquifers and reservoirs. 
 
 
Operations 
Examples include, but are not limited to, investigations that address handling 
of produced water, techniques to minimize/mitigate water encroachment, cost 
effective multiphase wellhead measurement systems, design criteria for 
facility sizing to meet variable demand, and best practices associated with 
product quality shipped/delivered. In addition, applied research into the 
development/ evaluation of low-cost salt inhibitors to mitigate salt 
precipitation within the reservoir, well, and pipeline systems are being sought. 
 
 
Salt Cavern 
Examples include, but are not limited to, investigations that address salt 
cavern stability and growth rates, interconnectivity and best practices 
techniques for management of caverns.  
 
 

The four focus areas and their corresponding examples are to be used as general 
guidelines for applicants.  The Pipeline Research Council International (PRCI) is 
providing cost share to GSTC.  In addition to the above, PRCI has a specific interest in 
the following topics: 
 
 
Deliverability maintenance and enhancement – reduce time and cost to deliver 
improved storage performance (applicable to existing well maintenance/enhancement or 
new wells).  Examples include: 

• Lower cost, long lasting damage remediation, precipitate removal 
• Enhanced coiled tubing delivery technology 
• Improved downhole sensing devices for determining reservoir parameters and 

performance 
• Improved reservoir characterization for quick, low-cost optimization analysis 
• Develop protocol for identification and remediation of damage mechanisms 

impacting brine disposal wells 
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• Improved technology for eliminating gas hydrates in wells and pipeline systems.  
Must be non-damaging to reservoir and pipe 

• Improved wellhead separation/filtration methods for removing produced brines 
and eliminating undesirables from being injected into storage.  Need low 
maintenance cost solutions. 

 
 
Base gas reduction 

• Conversion to top gas capacity 
• Replacement with inert gas 

 
 
Improved assessment of wellbore tubulars 

• Improved MFL (magnetic flux leakage) defect characterization 
• Other technology (non-MFL) for defect detection 
• Improved understanding of the remaining strength in wellbore casings with 

defects of various character (geometry, depth, general versus isolated pit, well 
bonded cement, no cement, poorly bonded cement, tension, etc) 

• Follow-up to threaded coupling work 
• Assessment of non-metallic wellbore tubulars 
• Develop an operational tool to determine the maximum velocity in brine strings to 

avoid damage to tubulars in caverns.  Examine applicability to velocity strings in 
reservoir storage. 

• Review casing vintage/manufacturer relationship to corrosion/defects 
 
 

Reduced well workover costs 
• Improved casing repair methods – follow-up to assessment of casing repair 

alternatives 
• Examine methods of recycling workover fluids for use in multiple wells 
• Improved technology for removing defective casings from wellbores – present 

brute force methods can be time consuming and uneconomic (ripping, pulling, 
cutting, milling) 
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AWARDS 
Awards will be made on an annual basis.  Subcontracts will be issued from The 
Pennsylvania State University to the successful applicant.  The period of performance for 
the 2008 funding cycle will be from July 1, 2008 to June 30, 2009.  Members will be 
permitted to submit future proposals to extend the proposed work; however, this must be 
performed on a year-to-year basis. 
 
If additional documentation is required prior to issuance of a subcontract, a delay in 
submission of the July 1 start date may occur. 
 
 
SUBMISSION 
The deadline for receipt of GSTC proposals is April 2, 2008 by 4 PM (Eastern 
Standard Time).  Proposals received after the deadline will be returned to the applicant.  
Applicants are to submit one original, twelve copies of the proposal, and one electronic 
copy in PDF format.  The full proposal and a separate copy of the public abstract should 
be saved in PDF format on a CD or ZIP disk and submitted with the paper copies.   
 
In addition to the proposal, each applicant is required to provide the GSTC Membership a 
nominal 20-minute presentation at the GSTC Spring Meeting which will be held in 
Chicago, Illinois on April 17-18, 2008.  The 20-minute presentation will consist of a 15-
minute presentation focused on the technical and budget aspects of the proposed project 
and 5-minute question and answer session.  The presentation is due at the time of the 
proposal submission.  The presentation format should be either in the form of an 
electronic PowerPoint presentation or in the form of overhead transparencies.  The 
proposal packet should be submitted to the following address:  
 

Mr. Joel L. Morrison 
Director, Gas Storage Technology Consortium  

The Pennsylvania State University 
C-211 Coal Utilization Laboratory 
University Park, PA  16802-2323 

 
 
If funded, the applicant will be required to provide the GSTC membership with an annual 
presentation in 2008 and 2009 at the GSTC fall technology transfer meetings in addition 
to the required reporting requirements. 
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PROPOSAL FORMAT 
Proposals should be formatted to fit standard 8 x 11” letter size paper with 1” margins, 
single-spaced, using 12 point font and be consecutively numbered at the bottom on each 
page.  
 
 
SECTIONS OF THE PROPOSAL 
The proposal shall consist of the following sections in order. 
 
Proposal Checklist  See Attachment A 
The proposal checklist is required to ensure the proposal submittal is complete and that 
the applicant is eligible for Consortium funding consideration. 
 
Public Cover Page   See Attachment B 
The cover sheet along with the public Executive Summary will be distributed to the 
GSTC membership as part of the proposal evaluation process.  
 
Table of Contents  One (1) page maximum 
 
Public Executive Summary  One (1) page maximum 
Provide a one-page summary of the proposed research.  The executive summary should 
not contain any propriety or business sensitive data because the summary will be 
distributed to the GSTC membership along with the proposal cover sheet.  An electronic 
copy of the executive summary is required.  The summary will be posted to the GSTC 
and/or program sponsor websites if the Consortium funds the proposal.  The summary 
should be written in the third person and include a statement of objectives and methods to 
be employed.  It should be informative to other persons working in related fields and 
understandable to a scientifically or technically literate lay reader.  
 
Technology Overview  One (1) page maximum 
The technology overview section of the proposal enables the applicant to discuss how 
their proposed technology is different from existing technology that may be available 
within the industry.  At a minimum the following should be discussed: 
• Is the technology covered by existing patents, and if so, what are they; and 
• How does the proposed technology differ from existing technology?  
 
Project Description  Five (5) page maximum 
The main body of the proposal should outline the plan of work, including the broad 
design of activities to be undertaken. At a minimum, the following should be discussed: 
• Statement of the problem;  
• Has the proposed work, or a portion of the proposed work, been funded elsewhere; 
• Objectives and expected significance of the research;  
• Statement of the work plan;  
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• Relation of the proposed work to comparable work in progress;  
• Description of available facilities and major items of equipment available for the 

work; and reference citations. 
 
Project Schedule  One (1) page maximum 
A plan which establishes the time schedule for accomplishing the work.  The plan should 
include major milestones of the project in bar chart format and should cover the complete 
period of performance.  
   
Anticipated Results  Two (2) page maximum 
Discuss how the project will improve the integrity, flexibility, deliverability, and cost-
effectiveness of the nation’s underground natural gas/hydrocarbon storage facilities.  
Discuss the commercial viability of the proposed project.  Identify specific groups in the 
commercial sector that may use the project results. 
 
Previous GSTC-Funded Projects                                   One (1) page maximum/ project 
If the applicant has been awarded GSTC-funding in previous years, the applicant is 
required to provide a brief summary of those projects for review.  The summary for each 
project should not exceed one page and should contain the following: 

• Project title 
• Total level of funding (GSTC funding and applicant cost share) 
• Description of how it has benefited the U.S. underground natural gas storage 

industry. 
• List of companies and key contact information for those using the previously 

funded project results.  
 
Budget    See Attachment C 
The submission of a reasonable budget is an important part of the proposal.  Your budget 
may request funds under any of the categories listed on Attachment C, as long as the item 
and amount are considered necessary to perform the work.  Proposed equipment 
expenditures are permitted; but their purchase must be justified.  Ownership of the 
equipment vests with the Pennsylvania State University and is reported to DOE on an 
annual basis.  It is expected that the participants will already have most of the necessary 
permanent equipment to conduct the research.  The majority of the funding is intended to 
support research activities.  Permanent equipment purchases are discouraged and will be 
considered during the proposal evaluation. After approval by the Executive Council, but 
prior to purchase, written approval must be obtained by the Department of Energy for 
purchase of equipment items that have a life of 2-years or more and a cost of $5,000 or 
more. 
 
Cost-Share Commitments 
A minimum of 40% cost-share is required for each project that is selected by the GSTC 
for funding.  The 40% cost-share is calculated as 40% of the proposed project (i.e. the 
sum of the recipient’s allowable cost-share and the GSTC share equals the total allowable 
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costs of the project).  Cost-share, which may be in the form of cash and third party in-
kind, is acceptable as part of the match provided it meets the following criteria: 

• Are verifiable, necessary and reasonable for proper and efficient accomplishment 
of the project; 

• Are incurred within the project performance period. Previously expended research 
development, or exploration costs are unallowable. 

• Are not included as contributions for any other federal project, are not paid by the 
Federal Government under another award, and otherwise allowable in accordance 
with Federal cost principles and DOE regulations governing cost sharing. 

• The value of patents and data contributed to the project is unallowable as cost 
sharing. 

• The value of salaries or wages of 1st party personnel directly involved in the 
project are allowed as cost share. 

 
All cost-share commitments must be supported by appropriate documentation.  Third 
parties proposing to provide all or part of the required cost share must include a letter 
from the third party stating it’s commitment to provide a specific minimum dollar amount 
of cost-share.  The letter should also identify the type of proposed cost share (e.g., cash, 
services) to be contributed.  Letters must be signed by the person authorized to commit 
the expenditure of funds and be provided in PDF format.  Failure to provide appropriate 
documentation can result in the proposal being returned without review. 
 
Biographical Sketches                                                   One (1) page per person maximum 
Vitae of key personnel involved in the project must be included and should include 
educational background, professional experience, research interest, honors, professional 
activities and relevant publications. 
 
Letters of Support 
Letters of support from outside sources are encouraged, but not mandatory. 
 
 
PROPOSAL EVALUATION PROCESS 
The GSTC Executive Council will review and recommend projects for GSTC funding.  
The GSTC Director will notify all applicants within thirty (30) days of the GSTC 
Executive Council meeting, by letter, of the final decision regarding their proposals.  The 
decision of the GSTC is final and not subject to reconsideration or appeal. 
 
 
ADDITIONAL INFORMATION 
Additional questions should be forwarded to the GSTC Director.  Questions should be 
submitted via e-mail to gstc@ems.psu.edu or contact Mr. Joel Morrison at (814) 865-
4802. 
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ATTACHMENT A – PROPOSAL PACKET CHECKLIST   
 

I certify that:   
 ❏ I am a current Full member of the GSTC 
 ❏ I am a current University member of the GSTC 
 

Project Title:   ____________________________________________________________ 
 
Principal Investigator (PI):   __________________________________________________ 
 

 
To assure that your application is complete, please complete and paper clip (one copy only) the 
proposal packet checklist to the cover sheet of the original (signed) copy of the proposal.  Be 
sure the following items are included in the following order. 
 
________ Public Cover page completed and signed by PI and authorized representative 
 
________ Public Executive Summary (one page maximum) 
 
________ Technology Overview (one page maximum) 
 
________ Project Description (five page maximum) 
 
________ Project Schedule (one page maximum) 
 
________ Anticipated Results (two page maximum) 
 
________ Previous GSTC-Funded Work (one page maximum/ project) 
 
________ Budget (Using Attachment C budget template)  
 
_________ Cost-Share Commitment Letters 
 
________ Biographical Sketches (one page/ person maximum) 
 
________ Letters of Support   
 
________ One signed original copy, twelve copies, and one electronic copy of the proposal 

in PDF Format are due to the GSTC Consortium no later than 4:00 PM (EST) on 
April 2, 2008. 

 
________ One electronic copy of the Public Executive Summary in PDF Format 
 
________ Proposal presentation (15 minute presentation, PowerPoint encouraged) 
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ATTACHMENT B – PROPOSAL COVER SHEET 
 
Proposal Submitted to: Mr. Joel Morrison 
 Director, Gas Storage Technology Consortium 

The Pennsylvania State University 
C-211 Coal Utilization Laboratory 
University Park, PA  16802-2308 

 
 
Proposal Deadline:   April 2, 2008 (4:00 PM EST) 
 
 
Date of Submission ____________________ 
 
Title of Proposal: _______________________________________________________ 
 

_______________________________________________________ 
 

 
Company Name: _______________________________________________________ 
 
Principal Investigator: _______________________________________________________ 
  

Phone:  _______________ Fax: ____________ Email ______________ 
  
 Address: _______________________________________________________ 

 
 ________________________________________________ 

 
Other Participants: ________________________________________________ 
 
 
Amount Requested from GSTC   $_____________________ 
 
Cost Share Commitments   Cash  $_________ 
(Minimum 40% Required) 
      In-Kind $_________  
 
Total Project Costs    $_____________________ 
 
Submitted by:       Approved by: 

 
__________________________   ___________________________ 
Signature of PI     Authorized Representative 
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ATTACHMENT C – BUDGET  Name of PI: _______________________________ 
 
       REQUESTED GSTC  COST-SHARE  
Salaries and Wages 
List individually all personnel identified in the proposal. 
Include title and percent of effort     $____________   $_____________ 
NOTE: The use of undergraduate and graduate students  
is encouraged, and appropriate.  
The basis  for proposed percent of effort or labor hours  
should be identified (historical hours, engineering estimates). 
 
Fringe Benefits      $_____________   $_____________ 
 
Materials and Supplies     $_____________   $_____________ 
List types required and estimated costs. 
NOTE:  State whether amounts proposed are based  
on catalog prices or other cost estimating.  
 
Equipment      $_____________   $_____________ 
Items exceeding $5,000 and a 1-year useful life are 
defined as permanent equipment.  List item and dollar  
amount for each amount.  Justify and/or provide 
quotation.   
 
Travel (see Note 4)     $_____________   $_____________ 
State the type and extent of travel and its relation to the  
project.  Itemize by destination and estimated costs.   
 
Publication/Information Dissemination   $_____________    $_____________ 
Estimate costs of documenting, preparing, publishing  
and sharing research findings.  Show estimates. 
 
Other Direct Costs      $______________  $_____________ 
Itemize and justify. (*See note below)    
 ______________________   $ _____________   
 
______________________________   $ _____________ 
 
Facilities and Administration (F&A)   $______________  $_____________ 
Specify current rate(s) and base.   
Note:  A copy of the negotiated agreement should  
be included with the proposal.  If none exists, a disclosure  
of the contents of the rate should be made. 
 
TOTALS      $______________  $_____________ 
 
*Applicants can attach up to two additional pages of justification covering items. 
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*NOTES:   
 

1) If more than 5% of project funding is provided by the Gas Storage Technology Consortium the contracting 
organization must be a Full or University Member of the Consortium. 

 
2) Projects that include subcontracts to current consortium members must insure the subcontract is less than 50% 

of the total requested Consortium funding.  Budgets and work statements from each subcontractor, in the format 
above, should be included with the initial proposal. 

 
3) Fees or profits cannot be recovered from any award resulting from this solicitation.  Nor can fee or profit be         

considered as part of the applicant total cost-share. 
 

4) The GSTC is planning to host two technology transfer workshops in 2008 and 2009.  Recipients of GSTC 
funding are required to provide a presentation on the status of their project at these meetings if requested.  The 
costs of attending these GSTC technology transfer meeting are to be included in the travel budget.  
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Appendix B 
RGD X-ray Technology Well Bore Inspection and Assessment -  

A Feasibility Study Executive Summary 



 

PUBLIC EXECUTIVE SUMMARY 

RGD X-ray Technology Well Bore Inspection and Assessment 
- A Feasibility Study 

Research Focus Area: Mechanical 

Scaling, Corrosion, Precipitates, and Casing defects are all issues storage operators face on a 
continual basis in managing the integrity of their gas storage assets.  These issues often lead to 
diminished deliverability (5 to 20%), as well as casing integrity issues requiring costly 
remediation.  The mineral scale formation and material defect assessment process in well bores 
is complicated, time consuming, and costly due to the range of storage conditions and existing 
technologies.  

GTI proposes to study, develop, and demonstrate a real-time RGD tool for in-situ compositional 
identification and quantification of scale in gas storage wells and pipelines.  The RGD tool will 
also assess and quantify material defects, pitting, and penetrations in casings and associated 
piping.  The system consists of a RGX Source tube to produce and scan the object with X-rays 
with single exposure (with minimum dosage).  An array of crystal detectors simultaneously 
acquires RGX-ray images from several different positions. The separate images are combined to 
produce individual “slices” through the object. By shifting the images with respect to one 
another, different planes within the object volume come into focus. This technology determines 
the gray value of every point in the three-dimensional space of an object that makes it possible to 
reconstruct any layer. 
 
The gas storage industry will benefit from this innovative technology as it can provide real time 
data and analysis on both scale formation inside the well bore as well as assess the well bore 
casing integrity itself. The proposed technology can provide this information in a single scan, 
creating an ideal application of for determining pre and post remedial treatment effectiveness.  
The assessment process will be significantly streamlined, eliminating the delay for lab analysis 
and reducing rig time considerably.  Cost savings will be in the tens of thousands on an annual 
basis for a typical integrity management program.  The project goals include improved well bore 
integrity assessment, flow deliverability, and reduced O&M costs. 

The following table summarizes the team members involved in the proposed project. 
 

Table 1 – Team Member Roles and Qualifications for the Proposed Project 

Team Member Role Qualification 

Gas 
Technology 
Institute 

Project 
Manager/Lab 
Analysis 

• The leading natural gas R&D organization 
• 60 years of developed technology-based solutions for 

consumers, industry, and government 
CMOSXRAY X-Ray tool 

manufacturer 
• 10+ years of portable X-ray tool manufacturing 

experience 
• Equipped with large test facilities, safety and field 

experience 
 

RGD X-Ray Feasibility Study -GSTC  Page 1 
Topic: Mechanical   05/03/07 
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Appendix C 
Evaluation of Magnetic Pulse Welding (MPW) for  

Improved Casing Repair Executive Summary 



PUBLIC EXECUTIVE SUMMARY 
 

Evaluation of Magnetic Pulse Welding (MPW) for Improved Casing Repair 
 

Principal Investigator:  Mr. Matt Boring, P.E. 
Edison Welding Institute, Inc. (EWI) 

1250 Arthur E. Adams Drive, Columbus, Ohio 43221 
Phone:  (614) 688-5257, Fax:  (614) 688-5001, Email:  matt_boring@ewi.org

 
Background 
Natural gas storage well casings occasionally require repair as the result of deterioration over 
time.  Currently-used repair methods are costly and often create flow restrictions and subsequent 
operational limitations.  Alternative repair methods for natural gas storage well casings are 
required to lower the costs of casing repairs and to reduce operational constraints.  Magnetic 
Pulse Welding (MPW) was identified as one of the most promising candidate repair technologies 
identified by GSTC Project No. 3138-EWI-DOE-1779, State-of-the-Art Assessment of 
Alternative Casing Repair Methods. 
 
Objective 
The objective of this project is to determine the feasibility of using Magnetic Pulse Welding for 
improved casing repair. 
 
Statement of Work 
The statement of work is summarized as follows: 

• Development of a Robust Coil System Design for Repetitive Use 
• Numerical Modeling to Determine Initial Welding Parameters 
• Coil Fabrication 
• Welding Evaluation Trials 
• Reporting 

 
Budget and Duration 
The project is estimated as a 12 month, $150,750 effort.  The portion of the estimated cost that is 
being cost shared by PRCI and Whipstock Natural Gas is $60,750. 
 
Anticipated Results 
If Magnetic Pulse Welding is determined to be feasible for casing repair, use of this process will 
potentially reduce the costs of repair and reduce operational constraints following repair. 
 
Contractor Information 
Based in Columbus, Ohio, EWI is North America’s leading engineering and technology 
organization dedicated to welding and materials joining.  EWI’s staff provides materials joining 
assistance, contract research, consulting services, and training to over 3,300 member company 
locations representing world-class leaders in the aerospace, automotive, defense, energy, 
government, heavy manufacturing, medical, and electronics industries.  Cost sharing contribution 
is being provided by Pipeline Research Council International Inc. (PRCI). 

EWI Proposal 50687GTH 
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Appendix D 
Gas Storage Facility Design Under Uncertainty Executive Summary 



Gas Storage Facility Design Under Uncertainty 
 
 

Public Executive Summary 
 
During the concept comparison phase of gas storage projects, many estimates are required to 
value the development scenarios under consideration. These estimates determine which concept 
proceeds into front end engineering and design. Estimates are required for reservoir attributes, 
surface facility costs, construction schedule, facility performance attributes, and market demand 
and price. The importance of these estimates cannot be overstated, they determine which concept 
is selected for development, the configuration and sizing of facilities, project timing, maximum 
injection and delivery rates, and ultimately, the value derived from the project.  
 
This research project examines the sensitivity of gas storage facility design decisions to 
uncertainty in the estimates used during concept comparison and selection. There are two 
research objectives. (1) To investigate how uncertainty in estimates influences optimal facility 
sizing and other design decisions. (2) To assess the relative value of reducing uncertainty in these 
same estimates.  
 
The first objective is accomplished using a stochastic simulation approach (Monte Carlo). The 
second objective employs the same approach but integrates it within a value-of-information 
framework. That is, reducing uncertainty increases project value—the question to be asked is “by 
how much?” The researchers will specify a dynamic optimization model of a greenfield and/or 
brownfield gas storage project assuming a risk-neutral, profit-maximizing decision-maker. Real 
options to expand will be fully accounted for in the model.  
 
The project will yield practical and valuable deliverables that provide insight into which 
estimates “matter most” to project value: 
 

1. A quantitative and qualitative assessment of the sensitivity of gas storage design 
decisions to uncertainties in estimates used during concept comparison; 

 
2. A detailed value-of-information analysis that provides information on the relative value 

of reducing the uncertainty of estimates; 
 

3. A workflow that incorporates the learning from the above assessment and analysis, 
including (a) a toolbox of specific planning aids for engineering teams to use in facility 
design given a particular project’s attributes and uncertainties, and (b) guidelines for 
decisions to collect, or not to collect, additional information to reduce uncertainty. 
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Appendix E 
Smart Gas: Using Chemicals to Improve Gas Deliverability –  

Phase II Executive Summary 



Public Executive Summary 
Each year, more than 17,000 gas storage wells in the United States lose from 3–5% of 

their storage capacity and deliverability.  The gas storage industry spends $80–100 million 
annually to revitalize existing wells with methods such as mechanically removing debris, 
washing, injecting acids, and creating new perforations in the well pipe.  Only limited and 
temporary improvements have been achieved.  There is a need to cost effectively increase the 
deliverability and hence the flexibility of the Nation’s underground gas storage facilities.   

It is known that water-wet porous media imbibe water in a fashion similar to water rising 
in a glass capillary tube.  In the reservoir of a gas storage well, the imbibition force promotes the 
retention of water in the pore space, which curtails the deliverability of gas to the wellbore 
during periods of high demand.  Similarly, the injection of gas during the fill cycle is restricted.  
In addition, the pore space occupied by irreducible water is not available to hold gas.  
 The overall objective of the proposed project is to develop new technology to improve 
gas deliverability from gas storage wells.  During the first year of the original project, two cost-
effective surfactants were selected from 11 candidates through screening tests prior to reservoir 
core tests.  Reservoir cores from three gas storage facilities including sandstone and dolomite 
reservoirs were used to evaluate the two surfactants.  The imbibition and core flood tests showed 
that gas deliverability and storage capacity were improved in surfactant-treated sandstone cores.  
However, the surfactants had a very limited effect on dolomite cores.  An engineering analysis 
was conducted to develop an analytical method to evaluate future field tests of the new 
technology.  It was concluded that the aquifer storage facilities are candidates for field testing.  
Results from the first year provided the foundation for this continuation project. 
 During Phase II, we propose to field test the surfactant that produced favorable laboratory 
results.  Two operators of aquifer gas storage sites are interested in testing the wettability-
altering concept.  The analytical approach developed during the original project will be used to 
evaluate the proposed field tests.  Many variables are expected to affect the field results.  New 
smart technology based on fuzzy logic and neural networks will be used to analyze the results of 
the field tests and generate correlations that will optimize future commercial applications.  
 Although storage facility costs where gas is bought and sold remain relatively constant, 
the economic benefits of increasing gas deliverability by 50%, while difficult to quantify, should 
be considerable.  Operating economics are frequently proprietary in this competitive industry 
making a detailed economic analysis difficult, but the improved flexibility in the form of greater 
deliverability could significantly increase profitability. 
 Laboratory results consisting of screening additional surfactants, crude oil, and crude oil 
plus surfactant will be compared to the two surfactants known to be effective.  An additional 
laboratory screening technique based on contact angle observations will be examined.  The use 
of a centrifuge technique for evaluating changes in core wettability induced by surfactants will 
be investigated.    

Correlations Company staff has experience directing both university research programs 
and the application of laboratory results to commercial oilfield projects.  The company has 
considerable experience with reporting requirements and has successfully completed several 
Department of Energy-funded projects.  
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Appendix F 
2008 GSTC Executive Council Ballot 



 
 
 
 
Company Name:  
 
Your Name:  
 

 
 
 

Indicate your selection of five (5). 
 

GSTC Executive Council Election Form 
 

See the following pages for a brief description of each nominee’s experience and/or credentials. 
 

 
 Thomas Stemmer, Basic Systems, Inc. 

 Larry Kennedy, El Paso Corporation 

 Brian Hall, Equitable Resources 

 Andrew Hammerschmidt, Gas Technology Institute 

 Ramon Harris, National Fuel  

  Steve Bergin, Oneok, Inc.  

 Ken Brown, Schlumberger Data and Consulting Services 

 John Jackson, Spectra Energy 

 
 Return Deadline:  January 24, 2008 (5 PM EST) 

Fax completed form to: GSTC Director, (814) 863-7432 

 
 

 
 

Reply to:  Joel L. Morrison • GSTC Director   
The Energy Institute, The Pennsylvania State University • C-211 CUL • University Park, PA  16802-2323 

phone – 814.865.4802 • fax  – 814.863.7432 • email – gstc@ems.psu.edu  
Visit the GSTC web site at:  http://www.energy.psu.edu/gstc 
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GSTC Executive Council Nominees 
 
Thomas Stemmer (Basic Systems, Inc.) 
Basic Systems provides engineering services to the natural gas industry.  Our primary focus is in the design of 
facilities such as compressor stations – both transmission and storage, gas treatment and dehydration, metering 
and regulation.  Basic has experience in the design of many storage facilities for members of the Consortium.  
75 employees, Nationwide Service Area. 
 
Tom has 26 years of natural gas engineering experience in the design of compressor stations, dehy facilities, 
meter and regulation stations.  The last 3 years have been in his current position as President of Basic Systems.  
Tom is responsible for the leadership of the company.  Basic Systems is continuously evaluating the industry 
and looking into the future.  As such, Tom can provide valuable business experience into new areas of 
development as the Consortium moves into the future.  
 
 
Larry Kennedy (El Paso Corporation) 
El Paso pipeline group is the largest United States pipeline.  El Paso Corporation’s pipelines (CIG-Colorado 
Interstate Gas Company, SNG-Southern Natural Gas, TGP-Tennennesse Gas Pipeline, and EPNG-El Paso 
Natural Gas Company) operate 43,000 miles pipelines and transporters ¼ of the total throughput in the United 
States.  In addition El Paso’s pipelines operates 9 natural gas storage fields and 450+ storage wells in Colorado, 
Kansas, New Mexico, Pennsylvania, Mississippi, and Louisiana and jointly owns 3 fields in New York and 
Pennsylvania. 
 
I have been employed by the El Paso Corporation for 22 years.  Prior to 2001, I held various engineer and 
supervision positions in the reservoir and production departments within CIG.  In 2001, I became Manager of El 
Paso’s Western Pipelines storage department and my responsibilities included monitoring the integrity and 
reliability of the CIG and EPNG storage fields.  Beginning in February 2006, my responsibilities were expanded 
to include the storage fields on the TGP and SNG pipeline systems.   
 
Since, 2002 I have been El Paso’s representative on PRCI’s Underground Storage Committee and participated 
on various research projects.  The first two years of the Gas Storage Consortium I served a two year term on the 
Executive Council.    
 
As a storage operator it is important that the storage industry continue to invest in research that ensures the 
storage fields continue to provide a safe, economical, and reliable service. 
 
 
Brian Hall (Equitable Resources) 
Equitable Resources owns and operates gas transmission, storage and gathering facilities in southwestern 
Pennsylvania and north central West Virginia. 
 
I graduated with a BS degree in Geology from West Virginia University in 1988 and have worked in the gas 
industry ever since, with a brief stint in environmental.  Some of the positions that I have held during my career 
are, Core Analyst for Core Laboratories, Junior Field Engineer for Atlas Wireline, Production Geologist for two 
independent producers, Geologist and Project Manager for Strum Environmental and currently hold the position 
of Manager of Storage Well Operations.  My current responsibilities include the planning and management of 
Surveillance Logging, Top Joint Repairs, Workovers, Well Testing, Coiled Tubing Clean-outs, New Drills and 
Plugging.  I believe with my varying work experience I can address any aspect involved in the operations of gas 
storage facilities.  
 
 
 

Reply to:  Joel L. Morrison • GSTC Director   
The Energy Institute, The Pennsylvania State University • C-211 CUL • University Park, PA  16802-2323 

phone – 814.865.4802 • fax  – 814.863.7432 • email – gstc@ems.psu.edu  
Visit the GSTC web site at:  http://www.energy.psu.edu/gstc 
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GSTC Executive Council Nominees cont. 
 
Andrew Hammerschmidt (Gas Technology Institute) 
The Gas Technology Institute is a private, not-for-profit research institute headquartered in Des Plaines, Illinois.  
It performs research and development in all phases of the gas industry, including underground gas storage.  GTI 
has a staff of more than 250, approximately 40% of whom perform scientific research. 
 
I have been involved in the natural gas storage industry for over 10 years, the past 3 in research and 
development as an employee of GTI.  I am currently managing the Gas Storage and Transmission Pipeline 
Research Program as well as performing on individual gas storage focused projects.  Prior to joining GTI, I 
spent 8 years with Nicor Gas, holding supervisory positions within Supply Operations, Storage Development, 
Reservoir/Production Engineering, and Distribution Operations. 
 
 
Ray Harris (National Fuel Gas Supply) 
National Fuel Gas Supply represents the Pipeline & Storage segment of National Fuel Gas, an integrated energy 
company with approximately 2,000 employees.  Supply owns and operates 32 gas storage fields along its 2,972-
mile transmission system located in western New York and western Pennsylvania.  Other primary segments of 
the corporation includes Utility - Gas distribution in Western NY and northwestern PA, Exploration & 
Production - TX, LA, AL Gulf Coast, CA, and the Appalachian basin. 
 
I am the general manager of gas storage at National Fuel and have combined gas storage experience of 21 years 
with National and Columbia Gas.  I have been involved in gas storage research groups for 18+ years.  I am the 
current chairman of the PRCI Storage Committee, past chair of the AGA Underground Storage Committee, and 
have served on the GSTC executive council.  My involvement with the numerous groups has given me a broad 
base of understanding of the concerns of the industry.  I have demonstrated the ability to pool resources together 
to further meaningful R&D programs in times of limited funding.  I think my experience and enthusiasm will be 
helpful to the council over the next two years of changing times in R&D and the industry as a whole. 
 
 
Steve Bergin (Oneok, Inc.)  
Oneok is a diversified energy company and the general partner of Oneok Partners, one of the largest publicly 
traded limited partnerships.  Oneok, Inc. and Oneok Partners gather, process, transport, store, distribute and 
provide energy services for both natural gas and natural gas liquids.  Oneok Partners owns and operates natural 
gas underground storage facilities in: Kansas, Oklahoma, and Texas.   Oneok Partners also owns and operates 
natural gas liquids underground storage facilities in: IA, IL, KS, OK and TX.  
 
I have been employed for various aspects of underground storage engineering for the past 28 years.  Currently, 
the Manager, storages and reserves for Oneok.  Oneok owns and operates underground storage facilities for 
natural gas and natural gas liquids in depleted reservoirs, domal salt formations, bedded salt formations and in 
conventionally mined hard-rock formations.  All storage operators share most of the same technology 
constraints and working together to address these constraints holds great promise for all involved in this critical 
segment of our energy infrastructure.  
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GSTC Executive Council Nominees cont 
 
Ken Brown (Schlumerber Data and Consulting Services)  
Schlumberger is the leading oilfield services provider, trusted to deliver superior results and improved E&P 
performance for oil, gas, and gas storage companies around the world.  The Pittsburgh DCS office, previously 
Holditch Reservoir Technologies, has been involved with numerous domestic and international underground 
gas storage projects since 1988, and has worked on several projects with GRI, DOE and NYSERDA. 
 
Ken has BS and MS degrees in Petroleum and Natural Gas Engineering from the Pennsylvania State University. 
He worked for several major oil and gas operators including Marathon (in their offshore Gulf of Mexico 
operations), Shell (in their California thermal recovery operations), TOTAL (in their south Texas in-situ 
uranium leaching operations), and Michigan Consolidated Gas (now DTE) - a major Midwest Gas Utility (in 
their underground gas storage operations).  Ken also has considerable experience in the consulting sector with 
S.A. Holditch & Associates and Schlumberger Data and Consulting Services, where he has focused primarily 
on gas storage projects during the last 15 years. 
 
 
John Jackson (Spectra Energy Transmission) 
Spectra Energy was spun off from Duke Energy in early 2007.  Spectra operates about 17,500 miles of 
transmission lines primarily in the eastern U.S. and Canada.  Spectra has about 265 Bcf of working gas storage 
capacity in the U.S. and Canada.  Spectra operates reservoir, salt dome and bedded salt gas storage facilities (as 
well as one liquid storage facility) primarily in the Gulf Coast, the northeast U.S and Ontario Canada. 
 
I have 25 years experience in the natural gas industry with over half of that time being directly involved in gas 
storage.  My current responsibilities involve the operations and reservoir engineering of our U.S. gas storage 
fields.  I believe that I could represent a diverse range of storage operators both geographically as well as type 
of storage facility. 
. 
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Appendix G 
Technical Feasibility Evaluation of Non-Intrusive Optical Detection, 

Monitoring and Preliminary Characterization of  
Casing Cement Leaks for Gas Wells 



 
 
 
Technical Feasibility Evaluation of Non-intrusive Optical 
Detection, Monitoring, and Preliminary Characterization of 
Casing Cement Emissions of Gas Wells 
 
Final Report  
 
 
Reporting Period Start Date:  June 1, 2006  
Reporting Period End Date: December 31, 2007 
 
 
 
 
Principal Authors: Glenn DeWolf, Dr. Mark Eltgroth, Dr. Curtis Laush 
 
 
 
 
February 28, 2008 
 
 
 
 
Gas Storage Technology Consortium  
Subcontract No. 3146-URSGI-DOE-1779   
 
 
 
 
 
URS Corporation 
9400 Amberglen Blvd 
Austin, Texas, 78729 
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DISCLAIMER 
 

This report was prepared as an account of work sponsored by an agency of the United 
States Government.  Neither the United States Government nor any agency thereof, nor 
any of their employees, makes any warranty, express or implied, or assumes any legal 
liability or responsibility for the accuracy, completeness, or usefulness of any 
information, apparatus, product, or process disclosed, or represents that its use would not 
infringe privately owned rights.  Reference herein to any specific commercial product, 
process, or service by trade name, trademark, manufacturer, or otherwise does not 
necessarily constitute or imply its endorsement, recommendation, or favoring by the 
United States Government or any agency thereof.  The views and opinions of authors 
expressed herein do not necessarily state or reflect those of the United States Government 
or any agency thereof. 
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ABSTRACT 
 

Natural gas losses from underground storage are an economic loss and are undesirable for 
other reasons.  Pathways for surface emissions from gas wells are the deterioration of the 
exterior casing cement at the outer casing wall and the borehole wall and casing defects.  
Emissions from casing defects can occur as venting from annular spaces between casings 
even when cement is intact.  The emission rate can be a measure of the integrity 
degradation of both casings and casing cement.  The rapid and cost effective detection 
and measurement of surface emissions for both active and abandoned wells, has value to 
the industry in terms of economic, environmental, safety, and operational benefits.   
 
This work was a trial feasibility evaluation of Tunable Diode Laser (TDL) remote optical 
sensing device for determining gas emissions in active or abandoned wells in gas storage 
fields.  It is also applicable to surface seepage from natural fissures not associated with 
wells.  In this project, TDL measurements of methane concentrations in the air near 
wellheads in a gas storage field were analyzed using a modified gas dispersion model to 
estimate the emission rate from active well vents.  Qualitative observations were also 
made regarding requirements for a practical protocol for using the TDL method in the 
rugged and forested terrain areas of the type encountered in this project.  The project has 
determined requirements for completing a practical protocol for such a detection and 
measurement method.  Modeling of TDL measurements can reasonably estimate 
emissions.  However, additional work beyond the current project would be needed to 
provide a fully developed practical method and protocol with a defined level of accuracy 
and precision. 
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Technical Feasibility Evaluation of Non-Intrusive Optical Detection, Monitoring 
and Preliminary Characterization of 

Casing Cement Emissions for Gas Wells 
 
 

INTRODUCTION 
 
This report presents the results of an initial feasibility study: Technical Feasibility 
Evaluation of Non-Intrusive Optical Detection, Monitoring and Preliminary 
Characterization of Casing Cement Emissions for Gas Wells, Gas Storage Technology 
Consortium (GSTC) Subcontract No. 3146-URSGI-DOE-1779. It focuses on results from 
a preliminary field test for the application of a Tuned Diode Laser (TDL) for detecting 
and measuring airborne concentrations of methane from gas well surface emissions in gas 
storage fields.  It describes the collection of data, analysis of the data, dispersion 
modeling associated with data analysis, and estimating emission rates from the measured 
ambient concentrations of methane in the downwind gas plume from the emissions.  The 
purpose of this work is to provide a preliminary feasibility analysis of the TDL optical 
method as a potential low cost detection and measurement that might be amenable to 
routine field application by gas storage operators.   
 
General practice today uses other methods of direct detection and measurement.  
However, many emissions are indirectly accounted for by differences between injection 
and withdrawal quantities.  Differentiation between well emissions from downhole 
pathways and surface equipment emissions (equipment fugitive emissions) is not always 
made.  Improving individual well emissions detection and measurement by low cost and 
easy to apply methods is a desirable goal for reasons of business economics, storage 
integrity enhancement, safety, and environmental stewardship, especially with regard to 
methane in natural gas as a potent Greenhouse Gas (GHG).   
 
The intent of this study was to determine if a TDL method and field protocol might be 
technically and economically feasible and hence worthy of further development, based on 
some initial field tests and evaluation of the results.  Various optical methods other than 
TDL are available, continue to be developed, and have been applied in the industry.  
However, it appeared that the TDL had particular advantages for the current application, 
and so it was selected for evaluation.  It is believed that application of the TDL method in 
the current context was a new approach to a segment of the industry for which these 
methods had not yet been generally used, or used at all.  
 
The overall project was conceived as a potential means to provide an additional tool to 
enhance gas well integrity management related to casing and cement deterioration over 
time.  The incentive is ultimately the adverse impacts associated with:  
 

• Uncontrolled gas losses;  
• Unscheduled emergency well-maintenance interventions;  
• Potential safety issues;  

47



2 

• Environmental issues associated with methane gas and other natural gas 
constituent emissions; and  

• Regulatory and corporate image issues associated with well emissions.    
 
The premise of the subject study is that TDL detection and measurement method might 
be integrated into an operational protocol that will enhance well integrity work processes, 
procedures, and practices, and add value in planning well maintenance and repairs.  
Using a TDL, the path-averaged concentrations of methane from well emissions would 
be detected and measured down wind from the emission source.  At the same time 
meteorological conditions of wind speed, direction, and temperature would be measured.  
The time averaged data would be input to a dispersion model that would calculate an 
emission rate.  The full details of method, data to be collected, and correlations necessary 
to allow the use of the data to estimate the emission rate will all have been established in 
a final Protocol.  The current study is a preliminary screening to assess the feasibility of 
developing such a Protocol. 
 
In conjunction with the TDL spectrometer used in this study, supplied by Boreal Laser, 
Inc. (Ref.1) the URS Complex Hazardous Air Release Model (CHARM®) gas and vapor 
dispersion model (Ref. 2) was used to process the measured field data into an estimated 
emission rate.  Measurements were for the methane gas plume from well vents associated 
with well casing annulus emissions.  Previous work by others has demonstrated the 
effectiveness of the TDL method for detecting and measuring methane emissions using 
releases metered from gas cylinders and actual fugitive emissions from operating natural 
gas facilities.  It was not known to have been applied to gas storage field well emissions.  
A distinctive feature of the current work was also application of the method in spatially 
confined settings, close to the emission source compared with earlier tests by others in 
more open areas farther from the emission source.  This difference affects the ease 
applying dispersion modeling for emissions estimation.  The application is more difficult 
in spatially-confined settings.   
 
Two volunteer operators offered wells for testing.  Wells were selected for testing based 
on availability and known gas emission rates from previous measurements by other 
means.  Other criteria included reasonable accessibility and “representative” well 
architecture and wellhead configurations.  The timing of testing also had to coincide with 
acceptable weather conditions and other scheduling considerations.  Because this was a 
relatively small project, there were other constraints on choices.  
 
The original intent was to carry out tests for a single well.  However, the proximity of 
several wells made it possible to test a total of six.  Of these three were examined in 
detail and the others were used for additional measurements and qualitative data analysis.  
The tests were limited because the current project was conceived as a feasibility or proof 
concept study, the results of which would be used as a decision tool for determining if 
additional investigation was warranted.  Field test results from this work would not 
necessarily be conclusive on a stand-alone basis.  Tests were carried out during the week 
of September 22, 2006 in gas storage fields in the northeast.  
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The remainder of the report discusses the following items defined in the GSTC contract, 
Section 4.7, page 29 of 39 as required report content:  
 

• Experimental Apparatus; 
• Experimental and Operating Data; 
• Data Reduction; and 
• Hypothesis and Conclusions. 

 
These items have been addressed as content in the following, remaining sections of this 
report:  

 

EXECUTIVE SUMMARY 

EXPERIMENTAL 

1 Test Apparatus 

2 Methodology 

3 Test Data Reduction and Analysis 

RESULTS AND DISCUSSION 

1 Data Analysis Results 

2 Discussion of Findings 

3 Technical Feasibility Evaluation 

4 Economic Feasibility Evaluation 

5 Proposed Protocol Outline 

CONCLUSIONS 

REFERENCES 
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EXECUTIVE SUMMARY 
 
Natural gas losses from underground storage are an economic loss and are undesirable for 
other reasons.  Pathways for surface emissions from gas wells are the deterioration of the 
exterior casing cement at the outer casing wall and the borehole wall and casing defects.  
Emissions from casing defects can occur as venting from annular spaces between casings 
even when cement is intact, in the borehole.  The emission rate can be a measure of the 
integrity degradation of both casings and casing cement.  The rapid and cost effective 
detection and measurement of surface emissions for both active and abandoned wells, has 
value to the industry in terms of economic, environmental, safety, and operational benefits.   
 
This work was a trial feasibility evaluation of Tunable Diode Laser (TDL) remote optical 
sensing device for determining gas emissions in active and abandoned wells in gas storage 
fields.  It is also applicable to surface seepage from natural fissures not associated with 
wells.  In this project, TDL measurements of methane concentrations in the air near a 
wellhead in a gas storage field was analyzed using a modified gas dispersion model to 
estimate the emission rate from an active well’s casing vent. Qualitative observations were 
also made regarding requirements for a practical protocol for using the TDL method in the 
rugged and forested terrain areas of the type encountered in this project.  The project has 
determined requirements for completing a practical protocol for such a detection and 
measurement method.  Modeling of TDL measurements can reasonably estimate emissions.  
However, additional work beyond the current project would be needed to provide a fully 
developed practical method and protocol with a defined level of accuracy and precision. 
 
Results from the best data set in terms of minimal variability in wind direction and speed, 
and in TDL measurements data were used as data input to a commercial dispersion model.  
The basic model was fitted with a special input modification aligned with the specific needs 
of data analysis from TDL measurements.  From the measurements, the emission rate of the 
well selected for final data analysis yielded an emission rate about four times the average 
reported from measurements by other means outside of this project.  The project estimate 
was based on a short interval value where the least statistical uncertainty was likely in the 
computed result.  The operator indicated that emissions from the wells can sometimes 
fluctuate significantly.  Given the short data interval of about one minute used to estimate a 
near instantaneous emission rate, for modeling reasons with minimal uncertainty for the 
available data set, it was concluded that the result was reasonable. 
 
Based on the testing, data analysis, and observations in this study, it is clear that additional 
work will be required in further testing under actual field conditions to finalize a protocol 
for the proposed methodology, in the kinds of settings encountered in the current tests.  
Special emphasis will be on better understanding the effects of wind conditions.  With 
additional field work and modeling it is believed that a practical protocol will be feasible.  
The report discusses some the remaining technical needs in detail and some corresponding 
economic implications.  It also outlines the contents of a proposed protocol.  The protocol 
might include the combined use of other methods, in conjunction with and complementary 
to the TDL method. 
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EXPERIMENTAL 
 
1.0 Test Apparatus 
 
A Boreal Laser, Gas Finder – 2 (from Boreal Laser, Inc.), Tuned Diode Laser (TDL) 
transmitter/receiver and reflector system was used in this project (Ref. 1).  The TDL 
equipment is described in detail in Appendix A.  Other equipment consisted of a standard 
portable meteorological station (met station) and laptop computers for data transfer and 
analysis.  The apparatus was used to detect and measure the concentrations of methane in 
the ambient air in the vicinity of the gas storage field wellheads. The data was input to a 
gas dispersion model to estimate the emission rate.   
 
The emissions being measured can occur at two locations at the base of a gas well head.  
They can occur: 1) in the wall of production casing, which allows gas to migrate into an 
annular space between the production or inner casing wall and the next layer of 
concentric casing, and to discharge through an annular vent at the top of the well, or 2) 
from the production zone (or a higher geological stratum) up the borehole through defects 
in the outer casing cement.   
 
Emissions are also possible from defects or loose joints in aboveground piping 
components in the wellhead.  In order to distinguish between these and borehole or 
casing flaw emissions it is necessary to conduct separate measurements.  For this study 
the above ground equipment was believed to be tight with no fugitive emissions.  
 
The measurements comprised transmitting the laser beam across several paths in the 
ambient air region downwind of the wellhead at a convenient elevation.  The TDL emits 
a laser beam from a transceiver unit though the atmosphere to a retro-reflector positioned 
at a distance referred to as the path length.  A reflected beam travels back to the 
transceiver unit where the signal is converted to concentration data (e.g., units of parts 
per million by volume, ppm) or path-loading data (e.g., ppm-meter) and electronically 
logged.  The concentration is recorded electronically in the instrument electronic memory 
and can be observed on a digital readout screen on the back panel of the apparatus.  The 
instrument yields a direct reading the methane concentration for the selected path based 
on an electronic sampling interval of about one to three seconds.  Measurements for a 
given path were recorded for periods of about twenty minutes or more and subsequently 
downloaded to a computer for data processing and use in the dispersion model.  Various 
paths can be scanned to provide a spatial concentration profile according the purpose of 
the measurements.  The path length is defined by the distance between the TDL 
transmitter and retro-reflector.  Modeling is described later in this report. 
 
A schematic representation of the method’s measurement set-up is shown in Figure 1. 
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Figure 1.  General Set-up Schematic for a Measurement Path 
 
 
In addition to the TDL devices, a standard met station measured wind speed, direction, 
and ambient air temperature, data for which were automatically recorded and downloaded 
to a computer for later data processing.  Sampled met data were averaged over one 
minute intervals with the particular device used.  The met station consisted of the 
following equipment: 
 

• MetOne 010C wind speed; 
• MetOne 020C wind direction; 
• MetOne 064A-5980 ambient temperature with gill, naturally-aspirated housing; 

and 
• Campbell Scientific 10X datalogger. 

 
The TDL detection limits depend on the gas or vapor species and the path length.  A 
minimum detection limit (MDL) can be specified based on the path length available.  
Conversely the path length required can be determined based on the desired MDL.  At 
some point the path length becomes limiting for a given device and corresponding 
electronics configuration.  

  Estimated emission rate
Data Compilation, 

Analysis, and 
Modeling 

TDL Transceiver and 
Data Logger 

  Path loading data 

Methane Plume Region 

Retro-reflector 
Laser beam
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Figure 2 shows the TDL minimum detection limits (MDL) for methane with path length, 
based on technical literature data (Ref 5).  The detection limit decreases linearly with the 
increasing path length.  A typical path length in many applications has been about 100m, 
but a path length up to 1 km is possible (Ref 5).  For this project path lengths were in the 
range of 10 to 30 meters. 
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Figure 2.  Minimum Inherent Methane Detection Limits 
 
 
In the atmospheric environment, the TDL is operating in an environment with a 
background methane concentration of about 2 ppm.  Therefore, the ability to detect small 
emission rates depends on the resolution of the TDL to detect concentrations above the 
background.  That resolution is governed by the inherent stability of the background 
measurement relative to the difference in concentration above background.  Assuming 
that for a given data set the background variability was less than ±25%, the working 
baseline would be 2 ppm +(0.25/2 ppm) = 2+0.5 = 2.5 ppm.  Consistent values above 2.5 
ppm would represent a contribution from an emission source.  In Table 1, the MDL range 
effectively demonstrates sensitivity, and implies resolution.  Small changes above the 
background are easier to detect at greater path lengths. 
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Table 1. Tuned Diode Laser Inherent Minimum Detection Limits (MDL) for 
Methane in Absence of a Background Level 

 

Path Length 
MDL Range 

(ppm) 

(m) (ft)  
1 3.24 1 - 2 

10 32.4 0.1 – 0.2 
20 64.8 0.05 – 0.1 
40 129.6 0.025-0.05 

 
 
 
Figures 3 and 4 show the TDL equipment used in the current project and Figure 5 shows 
a typical field set up with the transceiver and retro-reflector in place of a specific path.  
Figure 6 shows an infrared video camera also used to observe methane plumes at the well 
emission source.  Descriptive material on this equipment is available from the vendor 
(Ref. 3). Its use and significance to the project is discussed later in this report. 
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Figure 3.  Boreal Laser TDL Transceiver 
 
 
 
 
 
 
 
 

 
 

Figure 4.  Example of TDL Transceiver in Field Position
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Figure 5.  Example of TDL Retro-reflector in Field Position 
 
 
 
 
 
 
 

 
  

Figure 6.  Infrared Video Camera Used for Spotting Emission Plume at Source  
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2.0 Methodology 
 
Figure 7 illustrates the concept of TDL gas plume concentration measurement.  The TLD 
device measures a path across the plume of high methane concentration as well as some 
distance outside of and on each side of the plume as illustrated in Figure 7.  
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

Figure 7.  Illustrative Diagram of Relationship between 
Plume Measurement Location Parameters 

 
 
For any distance “d” along the plume centerline, there is a path length, “mp”, and a plume 
width “wp” along the path.  The TDL instrument reading is the average methane 
concentration along the path length, where the transmitter is at A and the reflector at B.  
 
Depending on the specific conditions of an emission and positioning of the TDL 
equipment, the path may lie partly within the plume and partly outside the plume as 
shown in Figure 7, or lie entirely within the plume.  The plume boundary is defined as the 
concentration contour where plume methane concentration matches the background 
methane concentration.  The plume boundaries represent the average boundary of the 
plume over a specified averaging time.  The exact location and extent of the plume 
boundary is an unknown until after measurements are taken.  However, it does not matter 
for emission detection or emission rate estimation based on dispersion modeling.  
Detection merely requires that a path cross the plume at some point. Estimation of 
emission rate merely requires that the path be accurately mapped relative to the emission 
source.  The path measurement averages the concentration gradient within the plume and 
outside the plume.   
 
Figure 8 is an illustrative schematic the concentration gradient within the plume 
represented by three isopeths (contours of constant concentrations).  Outside the plume 
the background concentration remains essentially constant.  
 
 

B
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Emission 
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Figure 8.  Illustrative Diagram of Relationship between 
Plume Isopleths along Measurement Path 

 
 
 
The field activities consisted of the following general steps: 
 

• Reviewing site conditions and the prevailing wind direction for placement of the 
measuring equipment in a downwind direction;  

• For each path: positioning the equipment relative to a best estimate of the 
probable plume location;  

• Setting up and aligning the equipment;  
• Taking the measurements; and  
• Taking down the equipment.   

 
Apparatus was set up with an appropriate positioning of the tripod mounted TDL 
transceiver and retro-reflector, each tripod mounted, to provide a measurement path 
across the estimated gas plume location, downwind of the emission source at the 
wellhead.  In these preliminary tests, positioning was intended to provide at least 
indicative and not necessarily conclusive results of specific plume positions or paths 
within the plume.  Positioning was based on previous staff experience with plume 
measurements, the available equipment, and some rough preliminary modeling of plume 
behavior using the URS Complex Hazardous Air Release Model (CHARM®). 
 
The data for an individual measurement path is expressed as a path-loading in units of 
concentration-length (e.g., parts per million (ppm) – meter (m)).  The loading divided by 
the path length yields the average gas concentration for the optical path.   

B 

A 
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C0 
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The background methane concentration was obtained by positioning the apparatus 
upwind of the wellhead.  This was done to confirm that the background in the work areas 
was comparable to the general atmospheric background of approximately 2 ppm.  Higher 
levels would indicate the proximity of an emission source other than the one being 
measured.  This background level was confirmed in the field and had also been 
confirmed in a lab with the equipment prior to going into the field.  
 
Operation of the TDL detector followed the procedures outlined in the manual included 
in Appendix A.  A sampling rate of one per second was used.   
 
The met station was set up near the measurement path in a manner that would not 
interfere with the optical line of sight. Meteorological data was acquired at a 1 to 2 
second sampling rate and collected at 15-second, 1-minute and 5-minute averaging 
intervals. 
 
Tests were conducted with site conditions as they were at the time, conditions that were 
not always ideal, but were, in fact, what the methodology would face in actual practice.  
This was deemed to be a better approach for an initial feasibility study than consuming 
resources in controlled conditions that might not prove practical in a field application.  
Other studies had shown the capabilities of the TDL so that the emphasis in this initial 
study was to subject the method to conditions not explored before that were specific to 
the current proposed application.   
 
The field conditions had relatively calm wind conditions overall, but the characteristics of 
the test sites are believed to have contributed to local turbulence effects that had to be 
accounted for in the data analysis.  Temperature and humidity were measured but are not 
a highly significant factor with the outcome. Both wind speed and direction were 
measured. Wind direction was the dominant variable that affected results.  
 
All tests were conducted on emissions from well casing vents. The location of the height 
of the vents and the orientations of the vents varied for each of the wells tested.  Sites 1, 
2, and 3 had the vent heights and orientations as listed below.  The positions of the 
various measurement paths for each site are shown in Figures 1, 2, and 3 in Appendix B. 
 
Two GSTC member operating companies volunteered sites for testing.  The wells were 
located in several northeastern U.S. gas storage fields.  All wells were located in eastern 
hilly, mountainous, and forested terrain.  The wells were in clearings in the forest 
accessible by dirt roads.  There was sufficient clearance at the selected sites to set up the 
equipment and take the required measurements.  The particular wells were selected 
because emissions were occurring from a casing annulus, which had open venting to the 
atmosphere, making the testing convenient.  For these sites, the emissions rate is 
routinely measured by other means, the rate is relatively large and easy to detect, and 
venting occurs from the end of a vent pipe.  These factors were favorable for the tests of 
this project by easing the data reduction and modeling issues.  Results from these tests 
can be readily translated into comparative projections for the behavior of emissions that 
might occur directly at the ground surface associated with direct well bore emissions.   
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The original proposal called for measurements to be made on one well and given the 
ultimate data quality it was with a single site that we were most able to successfully 
analyze the data.  However, because opportunities presented themselves, quantitative 
measurements were made on three wells and indicator measurements made on three 
others.  This provided valuable information related to potential setup issues for real well 
locations and supplementary information on plume behavior beyond what could have 
been obtained from tests on a single well.  
 
Tables 2 and 3 summarize the overall characteristics for the tests.  Detailed path 
measurement data are found in Appendix C.  Table 4 presents equipment position 
coordinates.  Direct data averaging for all runs includes implicit averaging for changes in 
wind direction. 
 

Table 2.  Overall Collected Data Summary for Sites 1, 2, and 3 

Time (EDT) 

Site 1 
Path 

Path Load 
Average 
(ppm-m) 

Concentration
Average 
(ppm) Start End 

Total 
(min.) 

Average 
Wind 

Direction 
(degrees) 

1 35.1 2.2 10:40 11:06 26   
2 145.4 8.8 11:29 11:53 14   
3 81.0 3.9 12:00 12:20 20   
4 122.3 6.3 12:24 12:32 8   
      123 

Time (EDT) 

Site 2 
Path 

Path Load 
Average 
(ppm-m) 

Concentration
Average 
(ppm) Start End 

Total 
(min.) 

Average 
Wind 

Direction 
(degrees) 

1 878.6 73.2 15:29 15:53  24  
2 215.1 15.9 15:59 16:19  20  
3 169.3 8.5 14:33 14:54  21  
4 108.2 5.4 15:01 15:18  17  
      106 

Time (EDT) 

Site 3 
Path 

Path Load 
Average 
(ppm-m) 

Concentration
Average 
(ppm) Start End 

Total 
(min.) 

Average 
Wind 

Direction 
(degrees) 

1 100.3 14.6 10:03 10:24 21    
2 447.2 23.5 10:39 11:17 18    
      106 

 

Direct data averaging for all runs includes implicit averaging for changes in wind 
direction.  
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Table 3.  Overall Collected Data Summary for Sites 3, 4, and 5. 

Time (EDT) 

Site 4 
Path 

Path Load 
Average 
(ppm-m) 

Concentration
Average 
(ppm) Start End 

Total 
(min.) 

Average 
Wind 

Direction 
(degrees) 

1 82.1 7.7 9:26 9:47  21   
2 159.4 12.5 9:54 10:20  26   
3 150.4 8.4 10:24 10:46  22   
4 33.0 2.2 10:52 11:10  16   
5 66.2 3.5 11:14 11:34  20   
      182 

Time (EDT) 

Site 5 
Path 

Path Load 
Average 
(ppm-m) 

Concentration
Average 
(ppm) Start End 

Total 
(min.) 

Average 
Wind 

Direction 
(degrees) 

1 48.6 3.2 13:03 13:20  23  
2 46.5 3.1 13:22 13:30  7  
3 38.4 2.4 13:33 13:49  16  
      170 

Time (EDT) 

Site 6 
Path 

Path Load 
Average 
(ppm-m) 

Concentration
Average 
(ppm) Start End 

Total 
(min.) 

Average 
Wind 

Direction 
(degrees) 

1 61.0 6.1 8:09 8:33  42  
2 45.9 4.2 8:39 9:01  38  
3 92.9 8.4 9:04 9:26  30  
4 52.6 4.8 9:30 9:51  21  
5 33.2 2.8 9:53 10:16  22  

      
Not 

measured. 
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Table 4.  Equipment Position Coordinates 

Equipment* 
Source 
Height 
(m/ft) 

North 
Position 
(m/ft) 

East 
Position 
(m/ft) 

Path 
Length 
(meters) 

Path 
Elevation 

(ft) 

Centerline 
Path 

Range (ft) 

SITE 1       
Source 7 382 367    

T2  372 375  3  
R2  420 342 16.5 3 6 
R3  452 376 21.0 3 8 
R4  437 396 19.5 3 11 

       
T1*  333    n.a. 
R1*  --- --- 16.0  n.a. 

       
SITE 2       
Source 2      

TR  136 471    
R1  158 476 12 4 15 
R2  168 507 13.5 4 25 
R3  171 539 20 4 36 

       
R4**  147 426 20 4 n.a. 

       
SITE 3       
Source 1 880 415    

T  893 382  4.5  
R2  870 455 19 4.5 5 

       
R1**  866 421 14.6 4.5 n.a. 

       
 

*Key: T refers to “Transceiver.” 
  R refers to “Retro-reflector.” 
  The numbers refer to path or position as recorded in the original data logs. 
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Figure 9.  Example of a Field Equipment Set-Up Close to Wellhead  
 

 
 

Figure 10.  Example of Field Equipment Set-Up at Moderate Distance from 
Wellhead. 
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Figure 11.  Site 3 Path Positions 
Notes: 

T = Transceiver.  
R1, and R2 = Retro-reflectors for corresponding measurement paths. 
S = Source.  
Small blue arrow indicates orientation of horizontal vent.   
Green arrow indicates approximate average prevailing wind direction.  

 
 
Meteorological data of wind speed, wind direction, and temperature were automatically 
logged with a conventional portable met tower with a one minute averaging of met 
conditions.   
 
An example of the collected path data is shown in Table 5 for Site 3.  The complete data 
for Sites 1, 2, and 3 is presented in Appendix C.  An example of the corresponding 
meteorological data is shown in Table 6.  The complete data for Sites 1, 2, and 3 is shown 
in Appendix D.   
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Table 5.  Selected Path-Loading Data for Site 3 - Path 2.  
(See Appendix C for complete data set.) 

Site 3 - Path 2 Path length = 19 m 9/20/2006 
Average path-loading 

(ppm –m) 
Average path 

concentration (ppm) 
Date and time (EDT) 

1247 65.6   11:06:00 AM 
1263 66.5   11:06:02 AM 
1159 61.0   11:06:04 AM 
2099 110.5   11:06:06 AM 
1850 97.4   11:06:08 AM 
1996 105.1   11:06:09 AM 
2233 117.5   11:06:11 AM 
1841 96.9   11:06:13 AM 
2164 113.9   11:06:17 AM 
1593 83.8   11:06:18 AM 
1858 97.8   11:06:20 AM 
2353 123.8   11:06:22 AM 
1747 91.9   11:06:24 AM 
1197 63.0   11:06:26 AM 
2868 150.9   11:06:27 AM 
2935 154.5   11:06:29 AM 
2405 126.6   11:06:31 AM 
1928 101.5   11:06:36 AM 
1218 64.1   11:06:38 AM 
1363 71.7   11:06:40 AM 
1373 72.3   11:06:42 AM 
1161 61.1   11:06:43 AM 

1366 71.9   11:06:45 AM 
1492 78.5   11:06:47 AM 
1575 82.9   11:06:49 AM 
1586 83.5   11:06:51 AM 
1677 88.3   11:06:53 AM 
1948 102.5   11:06:55 AM 
1790 94.2   11:06:57 AM 
1177 61.9   11:06:58 AM 
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Table 6.  Portion of Meteorological Data for Site 3 
Date: 9/20/2006 

(See Appendix D for complete data set.) 

Time 
(hhmm)  

Wind 
Speed 

(1- min. 
average) 

(mph) 

Wind 
Direction 
(1-min. 

average) 
(degrees) 

Wind 
Speed 

Standard 
Deviation 

Wind 
Speed 

Resultant 

Wind 
Direction 
Resultant 

Wind 
Direction 
Resultant 
Standard 
Deviation 

Wind 
Gust 

(mph) 

Tempera-
ture 
(F) 

1100 1.5 143 25.2 1.4 142.6 25.26 1.9 50.3 
1101 2.5 45 27.4 2.3 44.0 25.58 3.2 50.36 
1102 1.8 67 5.3 1.8 66.9 5.134 2.2 50.34 
1103 1.5 72 4.9 1.5 71.4 4.889 1.8 50.44 
1104 1.7 73 15.6 1.6 74.4 16.47 2.7 50.51 
1105 3.4 141 38.7 2.8 142.1 34.75 5.2 50.54 
1106 2.9 130 22.9 2.7 132.6 22.63 4.4 50.97 
1107 2.5 154 51.8 1.8 157.7 42.21 3.5 50.91 
1108 2.2 96 17.9 2.1 96.2 17.24 2.6 51.01 
1109 2.8 118 87.4 0.4 128.4 74.3 4.0 51.08 
1110 2.5 144 8.8 2.5 143.4 9.63 4.3 51.41 
1111 2.0 126 13.7 1.9 123.9 12.79 2.4 51.33 
1112 2.6 117 30.6 2.3 114.9 27.93 3.3 51.32 
1113 2.6 156 83.4 0.9 143.1 66.06 3.6 51.29 
1114 1.8 63 39.2 1.5 58.6 36.29 2.6 51.42 
1115 1.8 153 75.9 0.6 160.4 64.6 2.2 51.28 

 
 
The data show considerable variation with time.  These data are all for optical paths 
relatively close to the emission source and close to the ground.  Such locations have high 
concentration gradients and near ground atmospheric turbulence from obstacles.  This is 
characteristic of the relatively confined, forest-bordered clearings for the subject test 
sites.    
 
It is believed that the emission rate over time is relatively stable based on the nature of 
the emission source.  It is known that local turbulence can cause significant variations in 
wind direction and speed and corresponding variations in the plume concentration profile.  
Therefore, it is believed that the apparent variations in the estimated rates are due to 
modeling wind conditions that do not represent the actual conditions seen along the 
measurement path.   
 
Comparing the estimated rates to the met data shows that the estimates most closely 
matched the reported emission rates when met conditions were most stable.   
 
In addition to TDL measurements, the incidental availability of an infrared video camera 
from one of the operators, while not part of the original test plan, offered a unique 
opportunity for the project.  It provided a clear visual image of the initial several inches 
of the methane gas plumes from the emission sources.  The flow pattern and overall 
appearance of the methane plumes was similar to a steam plume rising from the spigot of 
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a teapot with boiling water.  When combined with prior knowledge from field and 
modeling experience these images were a valuable additional tool for positioning the 
TDL equipment and later interpretation the TDL measurement data. The video photos 
confirmed that the gas plumes had very little momentum (as would be expected from the 
low emission rates), and began dispersing quickly, even in the low wind conditions 
encountered during the tests.  The also showed clearly how the direction of the plumes 
could shift abruptly directly opposite to the prevailing wind direction as the result of 
momentary local turbulence in the wind field.  These images also showed the plume rise 
of the escaping natural gas from buoyancy.  These images made clear that that attempts to 
take measurements close to the source will ultimately require a very sophisticated 
approach for placement of equipment and especially for measurements of wind speed and 
direction. 
 
Used with dispersion modeling results, these observations also provide a basis for 
estimating the lower detection thresholds for both the infrared video compared with TDL 
method of detection.   
 
3.0 Test Data Reduction and Analysis 
 
Collected Data 
The field data consisted of the path data and met data.  
 
The measured result from the field is the average value over the path length of the 
measurement.  The model, to which the measured emissions are being compared, yields 
average point values of concentration.  These must be converted to path length averages 
for comparison with the field measured data.   
 
The larger the plume dispersion, the greater the path length in which the gas is found and 
the lower the actual average concentration level than can be detected.   
 
For the wells tested, within about 30 feet of the wellhead, and downwind, ambient 
concentrations ranging from about 8 ppm to 12 ppm were typical.  These are in the range 
estimated by modeling. 

 
These data are shown plotted in Figure 12.  The high variability of the individual 
measurement readings at 2 sec intervals within any one minute period is evident.  Figure 
13 shows a shorter time region.  These large variations are attributable to mixing effects 
for paths near the source due to wind turbulence and are primarily associated with rapid 
local fluctuations in wind direction.  
 
These variations can be seen in the plot of Figure 14, which shows the variability in wind 
direction associated with the meteorological station.  A portion of the data as collected 
and processed is shown in Table 7.  The full met data record is in Appendix D. 
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Figure 12.  Site 3 Path-Loading Data as Concentrations at Approximate Two-Second Intervals  

  

Site 3 - Path 2 - Average Concentration vs. Time 
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Site 3 - Path 2 - Average Concentration vs. Time
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Figure 13.  Reduced Scale Partial Site 3 Path-Loading Data at Approximate Two Second Intervals 
(partial data record at reduced scale from previous figure) 
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Site 3 - Five Minute Averages - Wind Direction vs. Time
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Figure 14.  Site 3 Wind Direction Data at 5-Minute Averaging Interval 
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Table 7.  Data Used for Modeling Emission Estimate 

Path Load Measurements  
Meteorological Data (1 minute 

average) 
Date and Time ppm-m  Spd_Avg_mph 2.495 

9/20/06 11:06:00 1247  Dir_Avg_deg 153.9 
9/20/06 11:06:02 1263  Sigma_Avg_deg 51.79 
9/20/06 11:06:04 1159  Spd_Res_mph 1.818 
9/20/06 11:06:06 2099  Dir_Res_deg 157.7 
9/20/06 11:06:08 1850  Sigma_Res_deg 42.21 
9/20/06 11:06:09 1996  Gust_mph 3.463 
9/20/06 11:06:11 2233  Temp_F 50.91 
9/20/06 11:06:13 1841  End_Date_Time 9/20/06 11:07:00 
9/20/06 11:06:17 2164    
9/20/06 11:06:18 1593    
9/20/06 11:06:20 1858    
9/20/06 11:06:22 2353    
9/20/06 11:06:24 1747    
9/20/06 11:06:26 1197    
9/20/06 11:06:27 2868    
9/20/06 11:06:29 2935    
9/20/06 11:06:31 2405    
9/20/06 11:06:36 1928    
9/20/06 11:06:38 1218    
9/20/06 11:06:40 1363    
9/20/06 11:06:42 1373    
9/20/06 11:06:43 1161    
9/20/06 11:06:45 1366    
9/20/06 11:06:47 1492    
9/20/06 11:06:49 1575    
9/20/06 11:06:51 1586    
9/20/06 11:06:53 1677    
9/20/06 11:06:55 1948    
9/20/06 11:06:57 1790    
9/20/06 11:06:58 1177    
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Data Reduction  
Data reduction consisted of three distinct parts: 
 

1. Downloading path measurement and meteorological field data and aligning the 
path and met data by time period. 

2. Compiling the field data in a format specific to this project, review of the data, 
and selection of data for further processing and analysis; 

3. Applying customized modeling of the data to estimate emission rate, and 
modifying the model as needed. 

 
After review of the data, Site 3 data were selected for detailed analysis based on having 
the least uncertainty for estimating emission rate.  Data from other wells and observations 
for all wells and the general characteristics of the gas field in which these wells resided 
provided additional information used in the overall feasibility evaluation.  
 
The path-averaged concentrations of methane were aligned with the meteorological data 
(wind speed and direction, temperature, and pressure).  The data were time averaged.  
Combined with the geographical layout of the path relative to the emission source, these 
data provided input to the dispersion model for estimating the emission rate.   
 
Data tables are included in Appendix C. 
 
Data Analysis and Emission Estimating by Modeling  
Previous researchers have used the TDL together with dispersion modeling software to 
estimate the emission rates.  Bauer et al. outlined a protocol based on these investigations 
for a specific method of monitoring fugitive methane emissions (Ref. 4).  
 
The dispersion model used in this study is a variation of the URS commercial version of 
its Complex Hazardous Air Release Model (CHARM®).  A discussion of CHARM® is 
provided in Appendix E.  Version 11 was used in this work.  The model is a grid based, 
LaGrangian model, in contrast with the more commonly used Gaussian dispersion 
models.  These designations refer to the mathematical algorithm by which the emission 
source characteristics and wind field conditions into which a gas or vapor is emitted 
estimate the airborne concentration distribution of the gas or vapor cloud or plume.  A 
LaGrangian model facilitates more sophisticated modeling.  
 
The met term defines wind direction, atmospheric stability, and other variables than will 
influence dispersion.  In this project, part of the effort is modifying the existing model to 
better estimate near field emissions for correlation of emission rates with concentrations 
in the dispersion plume region near well head.  At this stage, the extent of such 
modifications and their form are being investigated.   
 
The two types of source characteristics for a well head are the relatively uniform orifices 
of casing vent pipes and non-uniform orifices of borehole seepage through cracks in 
cementing and gaps between the cement and casing wall or cement and borehole wall.  
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Both types of situations can be modeled, and within typical measurement distances from 
the source, the non-uniform source plume should not differ greatly from the more 
uniform case.  
 
Besides the stand-alone version of the software, as a calculation tool for estimating 
dispersion patterns associated with specific emission rates, a data reduction tool has been 
developed using the standard set of CHARM® library functions. The program tool is 
called EmissionEstimate11 and is described in the next section. 
 
The CHARM® model, Version 11, was used to generate the measured path data and 
back-calculate the emission rate that would yield those conditions.  This was done at one 
minute intervals for Site 3.  The back-calculated emission rate for each one minute 
interval was then compared with the reported emission rate for the test site that had been 
previously determined by another method, outside of the current project.   
  
The values of interest that were to be used in the modeling are: 
 

• Resultant wind speed; 
• Resultant wind direction; and 
• Average standard deviation of the horizontal wind direction (σθ.). 

 
Because the meteorological data was an average over a longer time period, the path 
loading data was averaged over the same time periods as the meteorological data.  This 
resulted in a large number of data pairs of meteorological conditions and path loading 
over a concurrent time period.  To select the best data sets to be used for analysis a 
number of criteria were applied, as described below. 
 
Of the six sites where measurements were taken only the first three could be used 
because the last three had no GPS measurements.  The meteorological data at Site 1 was 
recorded as five minute averages.  Other than the first measurement at Site 2, all other 
meteorological data was recorded as one minute averages.  The first measurement at Site 
2 was a five minute average.  Path-loading data was collected approximately every two 
seconds. 
 
For each of the five minute meteorological averaging periods there were up to 170 path-
loading data values.  For each of the one minute meteorological averaging periods there 
were up to 35 path-loading data values.  A total of 166 data collection periods containing 
both average meteorological and path-loading data were available for further analysis. 
 
The average and the standard deviation (σ) of the path loading data were calculated for 
each data collection period.  With a background methane concentration of 2 ppm, an 
expected background path load was also calculated. 
 
To find the data set with the least uncertainty for modeling, the criterion to qualify a 
period for further analysis was that the average measured path load had to be greater than 
twice the calculated expected background path load and the σ of the path loading had to 
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be less than one-half the average measured path load.  This culled the original 166 data 
collection periods down to 10.  The path loading measurements displayed a wide 
variation over the meteorological time intervals.  Of the 166 data collection periods, 109 
failed the test for the σ to be less than one-half the average measured path load.  In fact, 
47 data collection periods failed the test of the σ to be less than the average measured 
path load. 
 
Finally, a calculation was carried out to see which of the data collection periods was 
consistent with when the view path would be most likely to intersect the horizontal plume 
centerline (as determined using the average wind speed).  When this criterion is applied, 
only one data collection period passes.  That period is the 37th time interval measured 
along Path 2 at Site 3.  Data used as input to the CHARM® modeling is summarized in 
the table in Appendix F. 
 
This data analysis shows that there are periods of relative uniformity with the 
concentration measurements for a given path.  Such uniformity would be expected with a 
relatively stable emission rate under stable and low wind speed atmospheric conditions.  
Based on previous measurements of emission rates from these gas wells, emission rates 
can fluctuate erratically around an average for some periods.  It is believed that the 
frequency for atmospheric variations is likely to be greater than the frequency for 
emission variations.  The variations therefore can reflect intermittent plume turbulence 
variations of concentration across a path caused by changes in wind conditions at the time 
of measurement as well as fluctuations in actual emission rate.   
 
The meteorological equipment used was only capable of one minute averaging.  This was 
less that the period of the measurements shown and the capability of the TDL equipment, 
which used a 1-second sampling rate with nearly instantaneous recording of the observed 
concentration.  Therefore, it is believed that changes in local wind direction are the 
predominant reason for variations in the observed methane concentrations in the 
measurement path at any moment.  
 
Using these measurements shown in Table 7 results in combination with the CHARM® 
model, the path location and length information was used to back calculate an estimated 
emission rate based on the plume measurement. 
 
Emission Rate Calculation Tool (EmissionEstimate11) 
A program was developed that will allow a user to input measured data on-site and then 
calculate an emission rate that would give a path-load that agrees with the measured 
value.  The program displays a single dialog interface, which is shown in Figure 15. 
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Figure 15.  Dialog Form for Entering Measured Data for CHARM® 
Calculation of an Emission Rate. 

 
The Input Files provide the CHARM® engine with the basic and default values that are 
going to be used in the calculation.  Short descriptions of each are: 
 

• Base Release File specifies that methane is being released and that it comes from 
a small hole; 

• Base Met File specifies some default meteorological conditions, such as the 
pressure is at one atmosphere, the relative humidity is at 50 percent, and that there 
is no inversion height; and 

• Base Grid File specifies a flat terrain grid with dimensions of 51 feet North/South, 
17 feet East/West, and 15 feet in the vertical.  The grid region is made up of cells 
that are all of 1 X 1 X 1 foot dimension.  The surface roughness is set at 3 cm. 
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These files can be edited or new ones created by using the stand-alone version of 
CHARM®.  Help information supplied with the stand-alone version can be used to aid in 
creating and modifying the files.  
 
All the other information that needs to be supplied should be available from on-site 
measurements.  The Easting, Northing, and Altitude of the source and each end of the 
view path should be able to be measured from GPS equipment.  The altitudes can be 
given in heights above ground or absolute heights. If absolute heights are used the 
Surface altitude at the source should be supplied so that the calculator can determine the 
height above ground for each point.  The distance measurements can be supplied in either 
feet or meters.  The temperature, wind speed, direction, and direction sigma are available 
from the meteorological data. Various units are available for each.  In the program, the 
calculation accounts for the background concentration of methane.  If the background 
concentration gives a higher path-load than actually measured, the calculation stops and a 
warning message is given.  The final input required is the path-load number given from 
the path equipment.  Once all input is provided, the entries can be saved in a file by 
pressing the “Save Input” button.  Correspondingly, the Load Input button can be pressed 
to find and open a file with saved entries. 
 
To have the program calculate an emission rate, the “Calculate” button needs to be 
pressed.  When this happens the program will begin the calculation.  An iterative 
approach is used in the calculation.  An initial emission rate is used and the calculation is 
carried out until steady-state conditions have been reached.  Then a path-loading is 
calculated for the path provided and compared to the measured value.  If the measured 
value is higher than the calculated value, the emission rate is increased by a factor equal 
to the ratio of the measured to calculated path-load.  If the measured value is lower than 
the calculated value, the emission rate is decreased by the same factor.  This continues 
until the measured load and the calculated load are within 1 percent of each other.  This 
calculation can take anywhere from a few minutes to more than an hour.  When 
complete, the program will display a dialog box with the calculated emission rate.  When 
finished performing calculations, the “Done” button can be pressed and the program will 
exit. 
 
RESULTS AND DISCUSSION 
 
1.0 Data Analysis Results 
 
The calculated emission rate for the path data set with the least uncertainty (Site 3, Path 
2) is 8.2 mcfd.  This is about four times larger than the reported emission rate, determined 
previously by other means, by the operator.  Figure 16 shows the modeled plume 
configuration and path location for Site 3 upon which emission estimate is based.  
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Figure 16.  Modeled Plume and Measurement Path for Site 3, 
11:06 AM, September 20, 2006 

 
 
For the wells tested at Sites 1, 2, and 3, previous measurements by the operator using the 
cylindrical orifice cap and manometer flow meter method for several minutes had yielded 
the following average rates (thousands of standard cubic per day (mscfd): 
 

• Site #1 – 1.8 mscfd 
• Site #2 – 1.5 mscfd 
• Site #3 – 1.8 mscfd 

 
Well characteristics are such that these can be averages of significantly varying 
“instantaneous” emission rate values, from near zero to several times the average.  Surges 
of high rates can occur.  As will be seen later in the report modeling suggested a higher 
rate during one of the test intervals of this project. 
 
The standard deviation of the horizontal wind direction for the overall data collection 
period is 52°. The CHARM® model was used with the assumption of a constant wind 
direction and speed.  A standard deviation of the horizontal wind direction of 25° is 
considered large.  Of the 166 data collection periods available, 101 have standard 
deviations of the horizontal wind direction of more than 25°.  Larger standard deviations 
indicate a large amount of mixing and that the plume is probably discontinuous.  By 
averaging the collected data some of the variability’s effect on the calculated emission 
can be reduced but not eliminated. 
 
Examination of the data and field conditions suggested that there would be sensitivity in 
the measurements to the positions of the transceiver and the retro-reflector.  This 
sensitivity would increase the closer the measurement path is to the source.  The 
horizontal placement of the transceiver and retro-reflector is relatively easy to manage 

Emission 
source 
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and measure.  The vertical placement is less so.  Small elevation differences between the 
transceiver and retro-reflector were not recognized as a variable for close monitoring in 
the current tests, the modeling sensitivity of this variable was determined after the tests.  
A model sensitivity analysis was run to determine how much the estimated emission rate 
determined by the model would be affected by a vertical disparity between the elevation 
of the transceiver and retro-reflector when the model assumed equivalent elevations in 
the data analysis modeling.  As discussed in the next section, this analysis showed that a 
displacement on the order of 1 to 1.5 feet could affect the results by a factor sufficient to 
cause a true value of near 2 to be rendered as 4.  Given the rough terrain, such vertical 
alignment differences could have contributed to a difference of the observed magnitude.  
This would be a technical issue to be further explored in any additional field tests.  
 
2.0 Discussion of Findings 
 
This discussion examines the results of the field data analysis in terms of the project 
objectives and possible future emission detection and measurement protocol 
development.  It addresses field data results, further development needs, and implications 
for final protocol development. 
 
Data Sensitivity to Path Location  
The variability the path-loading data is similar to what has been observed in other studies 
(Ref. 4).  Magnitudes were within expectations for the reported emission rates and 
measurement locations.  The variability in wind direction and speed, especially direction 
for a given measurement path, was more than had been expected for a given 
measurement path, based on other experience in remote emissions monitoring.  There are 
several possible reasons for this.  The measurement paths were all within about 20 to 30 
ft of the emission source, which in this type of work, is considered close.  Most studies of 
optical systems have used greater distances from the source and longer path lengths.  For 
example, one detailed study of emissions from a gas processing plant was done at 
distances of over 300 ft downwind from the source with a path length of over 500 ft. 
(Ref. 4).  However, one of the objectives in this study was to determine how feasible 
closer measurements to the source would be because of practical limits for some typical 
gas storage field well locations.   
 
The sites volunteered in this study, are in rough, hilly terrain, often in forest clearings 
with limited access for optical view paths and choice positioning of the equipment.  Tall 
trees at the forest’s edge bounded the sites.  This was helpful in limiting the average wind 
speed but might have increased turbulence resulting in large and frequent fluctuations in 
local wind direction.  This was anticipated to some extent, but initially wind speed was 
believed to be the primary met variable of concern.  In fact, wind direction appeared to be 
the greater issue.   
 
The result is that measurements were taken in plume regions of relatively high 
concentration gradients where slight changes in local wind direction and speed cause 
rapid temporal and spatial variations in the concentration for a given view path, and 
uncertainties in positioning of equipment can have a significant impact on the modeling 
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results if the actual path positions, including TDL transceiver and retro-reflector 
elevations, were different enough from the recorded data and displaced enough from 
those used in modeling.  
 
Another factor contributing to data variability was that for this study was that standard 
meteorological monitoring equipment was used for wind measurements.  The variation 
over a relatively small spatial scale suggests that the standard met station may not have 
adequately represented wind conditions along the measurement path.  Additional 
measurements might be beneficial for comparing conditions closer to the measurement 
paths with conditions at differing met station positions nearby.  Both the positioning and 
type of met equipment used is a factor contributing to some of the data uncertainties for a 
given path.  
 
It is clear that more tests are required to better understand the relationship between 
positioning of the measurement equipment, the sampling rates and averaging times, and 
the number and location of measurement paths relative to the emission source.  
 
These field tests have helped to refine several important working parameters involved in 
using the proposed method to determine emission rates under “real world” circumstances.  
The importance of averaging time and the positioning of the transceiver and retro- 
reflector has been quantitatively recognized.  The averaging time must be adequate to 
smooth out the frequency and significant variations in the gas concentration seen across 
any measurement path.  Video observations of the plume behavior at the source indicated 
a complete reversal of plume flow direction, on occasion, due to momentary wind shifts.  
This explains the abrupt drops from time to time of measured path concentrations 
observed in the data.   
 
The length, width, and depth of the plume will vary with emission rate, the size of the 
emission orifice, and wind conditions.  The emission rate determines when the 
demarcation between a momentum-controlled plume region and a dispersion-controlled 
region occurs.  This has implications for observed concentrations and their distances 
downwind from the emission source, in other words, the plume shape and concentration 
distribution within the plume.  
 
These issues will have to be accounted for in the measurement protocol.  The measured 
concentrations will vary with these conditions as well as the path length over which the 
measurements are taken.  
 
The protocol will have to specify designated path lengths according to these conditions.  
It might be possible to establish a fixed path length and develop correlations in future 
based on that length.  The protocol would also specify limits to wind conditions, and 
downwind distances under which measurements would be taken.  
 
Plume rise is the second factor that affects the shape and concentration distribution within 
the plume.  These plumes were the result of emission rates high enough such that they 
were visible as index of refraction disturbances in the air just at the vent orifice and a few 
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inches beyond.  Infrared videos also showed clearly the plume rise and rapid dispersion 
of the escaping gas, even at the low wind speed conditions.   
 
Emission Rate Estimate Sensitivity to Path Elevation Orientation  
When the model is used to estimate the emission rate by varying it until the calculated 
path load is equal to the measured path load, the result can vary significantly if the 
location (x, y, and z) of the transceiver and retro-reflector are incorrect.  This is especially 
true if the path traverses very near the source where the vertical concentration gradient 
can be very large. 
 
In the measurement with the best chance for having a large enough signal-to-noise ratio 
the viewing path does travel near the source, as can be seen in Figure 16.  The calculation 
grid is assumed to be flat in the model simulation. In reality slight terrain variations 
would be expected.  The altitudes (4.5 feet) of both the transceiver and retro-reflector are 
both with respect to the ground. If the ground altitude varies between the two pieces of 
equipment then the relative position of the plume and path is incorrect.  The actual 
ground altitude at sufficient resolution at the measurement site is not known.  The model 
can take terrain altitude variation into account if it is available. 
 
To determine how sensitive the emission rate may be for conditions modeled, the heights 
of the transceiver and retro-reflector were varied to indicate what size of variation could 
be expected in the calculated emission rates. The emission rate at different transceiver 
and retro-reflector altitudes was estimated assuming an inverse relationship between the 
estimated path-loading to the estimated path load for the base case where both 
instruments are at 4.5 feet. The range of emission rates are given in Table 8. 

 

Table 8.  Model-Estimated Emission Rates at Various Transceiver and 
Retro-reflector Elevations  

Transceiver Elevation (ft) Retro-reflector Elevation (ft) Emission Rate (mcfd) 
4.5 4.5 8.2 
3.0 3.0 2.0 
4.5 3.0 4.4 
3.0 4.5 3.6 
1.5 1.5 0.8 

 
As can be seen in Table 8, a small variation in elevation of one or both of the TDL 
devices (transceiver and retro-reflector) can result in significant variations in estimated 
emission rate.  The reported emission rate of 1.8 mscfd discussed earlier is within the 
range that could result with possible field variations in relative elevations of the TDL 
equipment.  A difference of 1.5 ft over the path length of Site 3 would account for the 
reported compared with modeling estimate of emission rate.  This effect indicates that, 
because of the large vertical concentration gradient, it is better to have the view path 
traverse the plume downwind farther from rather than nearer to the source. 
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Effect of Emission Rate on Plume Pattern 
To further examine sensitivity to system parameters, the stand-alone version of 
CHARM® was used to estimate concentration impacts from several emission rates.  The 
Meteorological conditions are the same as for the field test emission rate estimate using 
CHARM®.  The release height is one foot above the ground.   
 
The simulations use emission rates of 0.2, 2.0 and 20.0 mcfd.  The meteorological data 
used is from an actual measured time period in the field data.  The conditions are shown 
in Table 9. 
 

Table 9.  Meteorological Data Used in Simulations 

Parameter Value 
Relative Humidity 50 % 
Ambient Temperature 50.9 °F 
Ambient Pressure 1 atmosphere 
Cloud Cover (tenths) 0 
Stability Class A 
Solar Radiation 0 kW/m² 
Inversion Height No inversion present 
Wind Measurement Height 8 ft 
Wind Direction 180° 
Wind Speed 1.8 mph 

 
 
The implications are that the exact location for the placement of equipment becomes 
more critical for paths closer to the emission source.  In the current application, where a 
site can be in a forest clearing, this establishes the need for more precautions than would 
occur in more open settings.  
 
Figures 17 through 22 show the modeled concentration fields downwind of a release 
from an example well.  The figures show plan views and vertical elevation views of each 
plume.  All plan views are at the same scale.  All vertical cross-sections are at scales 
chosen to show the entire plume nearly filling the display area.  Note that the distance 
scale [Dist (ft)] in each vertical cross-section is with respect to the left extent of the 
region selected for plotting.  The actual release location is at a distance of about 2 feet in 
all the vertical cross-sections.  Each of the figures uses the same isopleths (contours of 
constant concentration).  The effect of dilution by dispersion from atmospheric mixing 
for low flow rates is clearly apparent for the lowest modeled emission rate of 0.2 Mscfd.  
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Site3 Path2_37
Species: Methane

Snapshot Plume 
Time: 00=30
Height:      2 ft
Above Ground
Radius:    100 ft
Plot Scale 1:378

Hatch Conc(ppm)   Max Dist
   1e+003       20 ft
   5e+003        4 ft
   1e+004        2 ft

Hatch Conc(µg/m³) 
6.89e+005
3.45e+006
6.89e+006

Max Conc
x = 1.33e+004 ppm
Dist:      1 ft  Ang: 13
Max Conc at hgt      2 ft
 1.33e+004 ppm
Dist:      1 ft  Ang: 13

sx

 
Figure 17.  Plan view of plume footprint 2 feet above ground. Emission rate is 2 mcfd. 
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Site3 Path2_37
Species: Methane

Vertical X-Section 
Snapshot Plume 
Time: 00=30
Base Hgt:      0 ft
View angle: 2
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Figure 18.  Vertical cross section near plume centerline. Emission rate is 2 mcfd. 
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Site3 Path2_37
Species: Methane

Snapshot Plume 
Time: 00=30
Height:      2 ft
Above Ground
Radius:    100 ft
Plot Scale 1:378
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Figure 19.  Plan view of plume footprint 2 feet above ground. Emission rate is 0.2 mcfd. 
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Site3 Path2_37
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Vertical X-Section 
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Time: 00=30
Base Hgt:      0 ft
View angle: 7

Hatch Conc(ppm)   Max Hgt
   1e+003        1 ft
   5e+003        0 ft
   1e+004        0 ft

Hatch Conc(µg/m³) Min Hgt
6.89e+005        1 ft
3.45e+006        0 ft
6.89e+006        0 ft

0.0

0.5

1.0

1.5

2.0

H
ei

gh
t (

ft
)

0.0 0.5 1.0 1.5 2.0 2.5 3.0 3.5 4.0 4.5 5.0
Dist (ft)  

Figure 20.  Vertical cross section near plume centerline. Emission rate is 0.2 mcfd. 
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Site3 Path2_37
Species: Methane

Snapshot Plume 
Time: 00=45
Height:      2 ft
Above Ground
Radius:    100 ft
Plot Scale 1:378
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Figure 21.  Plan view of plume footprint 2 feet above ground. Emission rate is 20 mcfd. 
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Site3 Path2_37
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Time: 00=45
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View angle: 1

Hatch Conc(ppm)   Max Hgt
   1e+003       10 ft
   5e+003        5 ft
   1e+004        4 ft

Hatch Conc(µg/m³) Min Hgt
6.89e+005        0 ft
3.45e+006        0 ft
6.89e+006        0 ft

0

2

4

6

8

10

H
ei

gh
t (

ft
)

0 10 20 30 40 50 60 70 80 90
Dist (ft)  

Figure 22.  Vertical cross section near plume centerline. Emission rate is 20 mcfd. 
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3.0 Technical Feasibility Evaluation  
 
It appears that the measurement method used in this project could be successful for its 
intended purpose with further development.  That development requires testing with 
better meteorological measurements to reduce uncertainty concerning conditions closer to 
the measured path.  It also requires testing at additional path positions.  More 
sophisticated meteorological measurements at multiple locations near the measurement 
path and source appear to be desirable.  Testing additional methods of measurement and 
positioning the equipment would be a specific goal of any future testing. Careful 
measurement of the elevation of the transceiver and retro-reflector relative to each must 
be included in the setup protocol, in addition to horizontal alignment.  The measurement 
duration of the meteorology and path-loading is adequate.  The averaging that takes place 
eliminates some of the variability in the data.  The major need is to use a view path that 
intersects the plume further from the source at about 20 to 30 feet downwind as a 
minimum. 
 
An illustrative example of a typical acceptable view path/wind direction orientation is 
provided in Figure 23. 
 

 
 

Figure 23.  Example Preferred Configuration for Acquiring a Path-load 
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The Boreal TDL equipment performed according to expectations for collecting the 
required data.  For a given set of electronics the equipment can be limited to a not-to-
exceed concentration when used for short measurement paths.  In any future testing, 
additional paths would be run farther away from the source, field conditions permitting, 
as well as closer to the source for reasons explained elsewhere in this technical note.  The 
current model should be usable, without modification for that purpose.  Within a few 
inches of the emission source, a model modified to have lower sensitivity would be 
helpful to allow easier measurement of high concentrations near the source at reasonable 
path lengths.  Other than that the current equipment appears to meet all the necessary 
requirements for the intended use.  
 
Near real time data analysis would greatly facilitate the effectiveness of the field 
measurements. It would allow adjustments on the spot to ensure good data collection. 
From a practical point of view as a field tool, such analysis would appear to be a 
requirement of a final protocol.  
 
Based on results of the current study, it should be possible to estimate the best positioning 
of the TDL equipment through modeling with a minimal effort.  The results of these tests 
underscore the benefit of conducting tests under relatively calm and spatially stable wind 
conditions to the extant possible.  Correspondingly the additional modeling would be 
conducted for a limited set of conditions consistent with such wind conditions.  
 
Another means of accounting for varying met conditions would be to introduce a second 
“tracer” gas source into the same region as the methane gas plume.  The tracer gas would 
be metered at a known rate and released in the same region as the emission source.  A 
second TDL would be set up tuned to the tracer gas.  By comparing the tracer 
measurements with methane measurements, a de facto calibration of the effects of wind 
conditions on plume behavior could be established. 
 
During this project one of the operators asked about the suitability of the TDL method for 
Emissions’ speciation beyond methane.  The short answer is that Fourier Transform 
Infrared (FTIR) Spectroscopy, another method of measuring ambient air concentrations 
of gases, would likely be used if speciation were the primary measurement to be made.  
The reason is that TDL uses electronic circuitry tuned to a specific spectral region of a 
single specific compound.  Other compounds can be identified and quantified but it 
requires, with current technology, a hard-wired change in the transceiver.  FTIR captures 
absorbance data for an entire spectral region, which can then be analyzed for individual 
species comprising that absorbance spectrum.  The logistics and operational costs would 
be similar, equipment costs would be higher, but positioning of the equipment would be 
easier for an open path measurement.  The method can be used also in a closed path 
sampling mode.   
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4.0 Economic Feasibility Evaluation  
 
To be feasible, the TDL method and Protocol for gas well and gas field seepage emission 
measurements must be economically competitive with alternative means for detection, 
monitoring, and measurement of gas emissions.  The total cost includes the cost to complete 
methods and protocol development to provide a basis for routine operational use by a storage 
field operator.  Further development costs are assumed to be funded through additional GSTC 
development.  At this time a fixed cost is assigned to that item.  
 
On a preliminary basis, the most direct way is to compare the cost of the TDL method with the 
cost of alternative methods of emission detection and measurement.  A preliminary, simple 
estimate is presented for the costs of completing development and providing a Protocol as a 
routine, field-ready operational method.  
 
It assumes that a gas storage operator would implement such an emission detection and 
measurement protocol using a contractor under the supervision of the operator’s staff.  The 
estimate examines the operator’s one time cost for implementation and recurring annual expense 
costs to conduct the well monitoring.  
 
Tables 10 and 11 summarize the results of the cost analysis.  Table 10 is an estimate of 
development costs to complete development of the method and Protocol for commercial 
application.  In includes the following pre-field test activities: additional emissions modeling, 
path positioning and analysis based on modeling, pre-field test planning based on a complete 
draft protocol, and future field work, data reduction and analysis, reporting, and final protocol 
preparation, including criteria for positioning the TDL equipment. 
 
Table 11 shows operating costs for uses of the protocol by a base case operator.  It includes one-
time and recurring costs as defined previously.  The estimate is based on the following 
assumptions: 
 
The operator will train at least two persons to coordinate and supervise the field work, and at 
least two other persons to analyze the data and prepare appropriate internal reporting of results.   
 
The actual field work will be conducted by a contractor.  The contractor will provide the TDL 
and infrared video camera, and other materials for the field testing.  It is assumed that contractor 
could cover one well per day with two technicians on an annual round of well tests. 
 
For the hypothetical base case operator, it is assumed that there will be a need to test 25 wells per 
year in a rotational monitoring program through the entire system of wells. 
 
One time costs will be incurred in the first year and will be allocated over the first five years of 
operation.  
 
Recurring annual expenses will occur every year.  (The exact scheduling of a monitoring 
program depends on the timing required to remedy emissions according to an optimal economic 
benefit plan.  This means that for each well or group of wells there will be an emission rate 
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threshold that will be reached before remedial action is taken.  It is also assumed that this work 
all takes place in the absence of any regulatory driver that requires emission reduction at a 
mandated threshold.  It should be clearly understood that because the costs and economic 
benefits will vary by individual operator the example given here is for conceptual illustration 
only).   
 

Table 10.  Estimated Development and Deployment Costs 

Activity Cost, $ 
Pre-field Testing   
Methane - controlled gas release set-up 15,000 
Testing 2 weeks  
   Plan 5,000 
   Staff 20,000 
Data analysis and reporting 15,000 

Sub-total pre-field testing 55,000 
Field Testing  
 Plan 7,000 
 Mobilization 5,000 
 Equipment 20,000 
 Field supervision labor, one person, 4 weeks, 40 hr/wk 16,000 
 Field measurements staff labor, two persons, 4 weeks, 80 hr/wk  32,000 

Sub-total field testing 80,000 
 Data Analysis and Reporting 20,000 

Sub-total data analysis and reporting 20,000 
 Protocol Preparation 50,000 

 25,000 
Subtotal Labor 180,000 

Equipment and Material Costs  
Equipment 20,000 
Materials 10,000 
Shipping  15,000 

Subtotal Other Direct Costs 50,000 
Travel Costs 25,000 

Subtotal Travel Costs 25,000 
  

Total Completion Development Costs by GSTC 255,000 
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Table 11.  Approximate Implementation and Operational Expenses  
for Base Case Operator  

Expense Item Cost, $ 
One-time Implementation  
Implementation plan 10,000 
Staff training (Basis: 3 operator staff, 1 week, 120 hrs) 12,000 

Total one-time implementation expense 22,000 
Annual Operating Expense (Basis: 25 wells per year)  
Operator field labor (Basis: 1 person, 8 hrs per well allowing for travel 
between wells) 20,000 

Contractor fee (Basis: 2 persons, 16 hrs per well allowing for travel 
between wells) 40,000 

Data review and operational integration (Basis: 40 hrs per year) 4,000 
Total annual application expense 64,000 

Unit cost per well 2,560 

 
All of the preceding costs are preliminary estimates only, and subject to further modification in 
future work. 
 
At this time it is assumed that the TDL protocol would compete with an aerial monitoring 
approach that in some circumstances might achieve the same results.  At this time it is not clear 
that the aerial method could in fact accomplish everything that the proposed TDL method could 
accomplish, especially in rugged terrain and heavily forested areas.  An aerial detection and 
measurement cost on an equivalent performance basis is necessary to complete an economic 
feasibility analysis.   

 
5.0 Proposed Protocol Outline 
 
Assuming that all technical issues can be resolved, and that the protocol would be economically 
feasible, the field protocol that would be fully developed in a future phase of work to the current 
project would take a form similar to that described here.  It is assumed that the protocol would 
involve the combination use of infrared videography and TDL technology, rather than TDL 
technology alone. 
 
The protocol would be implemented by two trained field technicians working as a team.  The 
monitoring program would monitor all wells on a rotating schedule and previously identified 
emitter wells on a risk-based schedule.  The schedules would be established according to prior 
knowledge and an appropriate risk assessment method determined by the operator from their 
own experience and criteria.  
 
The protocol would comprise the following basic steps recoding data specified by the protocol 
for each step: 
 
Technicians would arrive at the site on a day and time where favorable weather conditions are 
expected.  
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After unpacking equipment, one or more met stations would be set up at designated locations 
near the test well.  These locations would be specified according to specific criteria in the 
protocol document.  These criteria would have been established in the Phase 2 development 
program.  The wind conditions would be monitored for a protocol specified time establish the 
prevailing wind direction and wind speed for the site.   
 
The technicians might first apply infrared videography to the emission source according to 
protocol criteria.  A videographic data analysis, perhaps using video-image analysis software, 
would be applied to estimate the emission rate.  TDL would also be applied according to 
protocol criteria.  This assumes that the two methods could have complementary roles based on 
current observations. 
 
For the application of the TDL, at least three paths would be selected for measurement. The 
technicians would position the TDL equipment appropriately.  In addition, to the basic GPS 
position of the well and the TDL equipment and other data to be recorded, the distance 
downwind from the source for each path and the orientation and elevation of that path would be 
recorded, as specified in the protocol.  
 
The technicians would then set up the TDL apparatus and conduct a series of path measurements 
as specified by the protocol.   
 
Technicians would field-evaluate the collected data based on a software data reduction and 
analysis algorithm loaded on their field computers and on receiving real time or near real time 
data directly from the TDL and met station data loggers.  A determination would be made 
whether the data session was satisfactory or additional data were required.  When acceptance 
criteria were met the data collection session would end. 
 
At the end of the session the technicians would pack up the equipment and leave the site. 
 
The expectation is that when fully developed the protocol could be executed within three hours 
from initial arrival at the well site to departure with all equipment packed up.    
 
Final data analysis and reporting would take place off site. 
 
The above general steps would be covered in a protocol document following an outline similar to 
that shown on the next page.  
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Proposed Outline of Content for TDL Detection and Measurement Protocol 
 

1.0 Introduction 

2.0 Purpose and Need 

3.0 Initial Site Survey 

4.0 Infrared Videography Screening     

5.0 TDL Execution Decision 

6.0 TDL and Meteorological Station Equipment Preparation 

7.0 Setting up the Meteorological Station 

8.0 Met Data Collection and Analysis 

9.0 Setting up the TDL Apparatus 

10.0 TDL Data Collection and Analysis 

11.0 Concluding the Test 

12.0 Re-packing Equipment and Site Departure 

13.0 Final Data Analysis, Interpretation, and Reporting 

Appendices 
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CONCLUSIONS 
 

1. Preliminary field tests have applied a TDL for detecting and measuring airborne 
concentrations of methane, relatively close to the well heads, from gas well surface 
emissions in gas storage fields. Such emissions occur through cement defects such as 
fissures and cracks, and between cement and the outer walls of casing and the borehole 
wall.  The current work constitutes screening tests and has established the directions of 
future work for developing the TDL method for the subject application.  

2. Dispersion modeling was able to reasonably estimate emission rate within the 
uncertainties of the current data.  An updated Version 11 of the CHARM® dispersion 
model was used.  The result with the least uncertainty was estimated emission rate of 
8.2 mscfd. This compares with the operator-reported well vent average emission rate of 
1.8 mscfd from other types of measurement.  This does not, at first, appear to be very 
good agreement.  However, there is no assurance that during the time of the TDL tests 
the actual emission rate was the average reported by other means.  Also, modeling 
effects of differences in emission rate and positioning of equipment showed significant 
sensitivity to minor differences in elevation between the TDL transceiver and retro-
reflector relative to gas plume position.  These issues should be explored further in any 
future tests. 

3. Additional field tests are needed to provide more comprehensive data for confirming 
the requirements for determining emission rates by modeling the measured ambient 
concentrations of methane in the vicinity of emission sources.  Specifically, the greatest 
needs are: 1) better measurements of the wind field in the vicinity of each measurement 
path; 2) more measurement paths positioned closer to a right-angle with the plume axis; 
and 3) more accurate and precise measurement of elevation differences between the 
transceiver and retro-reflector.  For the current data set, a modeling sensitivity analysis 
revealed that an elevation distance of about 18 inches over a 60-ft path length could 
alter the calculated result by the magnitude of the difference between reported and 
calculated.  The modeling assumes a horizontal path through the gas cloud, not one at 
an angle.  

4. The actual tests were conducted on emissions from casing annuli vented to the 
atmosphere. These types of emissions were present for the wells available to the 
project. The data allow a preliminary assessment of feasibility and definition of a 
preliminary protocol for field application of the method for monitoring, detecting, and 
measuring emissions from gas seepage from cement casing and cement defects.   

5. The ambient methane concentration measurements over short durations of a few 
minutes show extensive variability as would be expected from atmospheric turbulence 
and measurements in regions close to the emission source with incomplete mixing. This 
is consistent with other data from the technical literature for similar testing (Ref. 4).   

6. Wind speed did not appear to be major factor at the relatively low average wind speed 
during the tests.  Wind direction is important as is the frequency and duration of shifts 
in wind direction. 
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7. The TDL can detect very low methane concentrations and can find emission locations 
easily.  There were cases where levels or changes as low as 1 ppm (or less) above a 
background methane concentration of about 2 ppm would show up on the TDL 
transceiver monitor very quickly when it was obvious there was a momentary wind 
shift.  In one case the detector responded so quickly that when the wind shifted 180 
degrees the detector would drop or rise to a reading within about 1 sec of the wind shift.  
The concentration at a given distance and height will vary with emission rate and met 
conditions.  The farther one moves from the source, the less variation there is in the 
time variation in the measurements, but the greater the uncertainty relating the 
measurements to the emission rate.  This is the core issue that must be further explored 
to better define at which locations measurements would be most favorable to the 
desired objective and what changes need to be made to the field protocols to 
accomplish those measurements.  The sensitivity of the instrument should make 
possible the measurement of emissions at far lower rates than was occurring at the 
wells tested.  The wells had rates in the range of a few hundreds to a few thousands 
standard cubic feet per day of gas.  Based on observations of field conditions, the 
measurements taken, and modeling to date, detection and measurement of 
concentrations should be possible for lower rates.  

8. An infrared video camera was used to scan the area of the wellhead and identify 
emissions from piping components.  The value of the TDL method can probably be 
enhanced when used in combination with infrared photography, especially video 
photography.  The TDL would be used to find the general location of an emission from 
a distance, and the IR could show an image where the concentration was high enough 
to be detectable by that means.  The video also helps to detect changes in nearby wind 
direction, at least close to the emission source, which helps in the interpretation of the 
down wind gas concentration measurements by the TDL, and conversion of those 
measurements in to emission rate.  It would be advantageous to also apply infrared 
videography in conjunction with TDL measurements in future tests.  It is not clear at 
this time how infrared videography detection sensitivity compares with TDL at low 
emission rates. 

9. More work needs to be done in optimizing the selection of the downstream 
measurement path(s) distance.  This can probably be done by modeling, with a future 
phase of field work needed for confirmation, along with further work on the items 
discussed above. 

10. For open field gas seepage the TDL could be used to scan a large field, or with 
appropriate modifications a forested area.  The basic techniques of data collection and 
analysis would be similar to the other applications.   

11. Before such testing is conducted, it would be beneficial to modify the TDL equipment 
used and establish other field test equipment needs for complementary measurements 
such a meteorological conditions and infrared imaging data capture and analysis.   

12. Provision should be made for real time or near real time data reduction and analysis to 
guide changes in measurement set-up locations and settings during measurements and 
field tests. The current study analyzed captured field data off-site after the tests were 
run.  The real time or near real time analysis of field data would require loading 
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appropriate software routines into the computers used for data transfer from the field 
data loggers that would allow direct transfer in real time from the commercial 
equipment to the data processing routines in a field computer.  This would allow a 
technician to validate results in the field and make appropriate testing adjustments 
while in the field.  

13. “Common wisdom” is that it is better to take measurements far from the source, where 
high variability has been smoothed out in the plume concentration.  In the era before 
rapid measurements and computer tools, this was reasonable.  However, the 
disadvantage of far field measurements is that concentration gradients are dampened so 
that relating the plume concentration to an emission rate requires more measurements.  
Moving closer to the source seems desirable. 

14. The high concentrations nearer the wellhead, at the source of the emissions, would 
require shorter path lengths and or a less instrument sensitivity than was used in the 
current tests.  

15. There is the issue of how to configure the field equipment set up for flexibility in very 
difficult terrain conditions, such as highly convoluted hilly or mountainous terrain 
where some gas storage field reside.  The task of measurement using optical systems is 
far easier in more open and flat areas.   

16. Location constraints in the placement of the equipment caused by some individual well 
locations offer challenges in developing an appropriate protocol.  However, at this stage 
these do not appear to be insurmountable challenges.  This issue might be addressed 
through mathematical means to define modified instrument requirements, and modified 
methods field methods to acquire additional data and resolve questions arising from the 
work to date.  As we move forward we will be attempting to define the feasibility 
envelope based on location factors. 

17. Other optical methods have been and continue to be under investigation.  From the 
present study it is the opinion of the authors that there would be value to a comparative 
analysis of the various methods that have been proposed and to seek a clear 
identification of their relative merits in the interest of defining a broader protocol that 
may include multiple methods.  The TDL method tested here could be part of suite of 
tools each with its optimal application.   

18. Further development of the TDL method is believed to capable of providing a fully 
developed protocol for the stated purpose.  The final protocol should include the 
combined use of infrared videography and TDL as complementary tools for monitoring 
and measuring gas emissions.  This tool kit would provide the gas storage industry with 
a better and more accurate means to detect low gas emission rates, to measure and 
monitor changes in these rates, and improve the well integrity maintenance process.  

19. A preliminary cost estimate to complete development of the method and protocol for 
the subject applications was generated and is included in the body of the report. A 
proposed outline of the contents of a final protocol is also presented.  Further 
experimental work would be required to provide the necessary data to complete 
development and a full protocol.  The cost effectiveness and value of the method to 
meet targeted operator needs must be determined by the individual operators.  
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GasFinder2.0 shown on different mounts 
 
 

 
 

GasView2 Software Display 
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System Description 
 
Boreal Laser’s patented (US Patent 5,637,872) TDL (Tunable Diode Laser) Open-
Path Monitor, measures gas concentration over an open path. It consists of an 
integrated transmitter/receiver unit and a remote, passive retroreflector array. The 
remote retroreflector is initially targeted by the operator using a two-axis instrument 
mount assisted by a alignment scope and an on-board visible aiming laser.  
The transceiver houses the laser diode source, the transmitter and receiver 
electronics, the detector module, and microcomputer subsystems. The transceiver 
unit is contained in a weatherproof enclosure and has connectors for 12V power 
input and data I/O. A schematic representation of the GasFinder2.0 system is 
shown below. 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
Fig. 1 Schematic representation of GasFinder2.0 
 
The laser light emitted from the transceiver unit propagates through the atmosphere 
to the retroreflector and returns to the GasFinder2.0, where it is focused onto a 
photodiode detector. A portion of the laser beam is passed through an onboard 
reference cell to provide a continuous calibration update.  These two optical signals 
are converted into electrical waveforms, which the microcontroller processes to 
determine the actual concentration of gas along the optical path. The computed gas 
concentration is then displayed on the back panel of the instrument and can be 
transmitted to a coordinating computer where the data can be collected, stored and 
graphically displayed.  
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Specifications 
 
Scan Rate 1 sample/sec
Distance Range 0.1 - 1000 m
 
 
Certification 
 
CSA Class 1, Division 2, Groups A, B, C and D*  

NRTL/C 
CE  EN 50082-1 : 1998
ATEX Pending
* The input power must be connected to a NON-Incendive source of supply that 
does not exceed 12.5Vdc and 3A. 
 
 
Physical Data 
 
Weight  5.2kg
Dimensions   (LxWxH)    290x195x150mm
Power Requirements 2A @ 12Vdc
Operating Temperature Range -30°C to +50°C
Sighting Optics  3 - 9 x 40 scope

(also an on-board visible aiming laser)
Display Options 2 x 20 character Liquid Crystal Display
Data I/O Interface  RS232, 1200/2400/9600 baud (N-8-1)

optional 4-20mA Current Loop
Laser Type Semiconductor laser
Eye Safety Class  IIIa (as per ANSI Z136)
 
 
Sensitivity 
 
Sensitivity: HF System 0.1 ppmm
Sensitivity: H2S System  30 ppmm
Sensitivity; NH3 System  10 ppmm
Sensitivity: CH4 System (long path)  100 ppmm
Sensitivity: CH4 System (short path)  (high sensitivity)              2 ppmm  
Sensitivity: CO2 System 1000ppmm
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Dimensions   
 
 

                                 
 
      Side View             Rear View 
Fig. 2 
 
For mount dimensions see Fig. 7 
 
Power Supply 
 
Any regulated 12 volt supply capable of delivering 2A d.c. will power the 
GasFinder2.0. The battery unit supplied by Boreal Laser Inc. for portable use, 
shown in Fig. 3, lasts about 6 hrs. A car or truck battery will last about 48 hrs. 
 
 

      
 

Fig. 3          Fig. 4 
 

 
A regulated power supply, shown in Fig. 4, connects to 110v / 220v and 50~/60~, 
and is recommended for fixed operation. A dual channel power supply is also 
available which can operate two GasFinder2.0s simultaneously. 

 290mm 
195mm 

 150mm 

 65mm 

105mm

Laser Beam
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Installation 
    
Portable Use 
 
When the GasFinder2.0 is to be used as a portable instrument, there are two 
different configurations to consider. 
 
For rapid deployment on a tripod over short paths(<30m), a tilt/pan head camera 
mount can be used (see Fig. 6). The tripod should be placed on a firm base, and 
the ‘pan head’ mounted to the top of the tripod. If a hex plate is attached to the base 
of the quick-release fitting on the GasFinder2.0, the instrument can be attached to 
the pan head. The instrument can be aligned using the visible laser. 
 
 

      
 

Fig. 5        Fig. 6    
 
For longer paths, a small X-Y mount can be mounted directly to a tripod (see Fig.5). 
The tripod legs and the rotating base can be adjusted so that the mount is roughly 
aligned with the retroreflector. The GasFinder2.0 is attached to the mount with a 
quick-release fitting. Precise alignment can be made with the X - Y mount. If the 
tripod base is firm, path lengths up to 600m can be achieved easily. The stability of 
the tripod can often be increased by tying a heavy weight such as a car battery to 
the central hub of the tripod. The tripod is adjustable to give a laser operating height 
from 620mm to 2,340mm. 
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Fixed Use 
 
Large X – Y Alignment Mount  
 
 
         

                         
 
 
 
 
 
 
 

                   
 
 
 
Fig.7.   
 
Installation Guidelines 
 
With bolts going through the four slots of the mount and base plate, roughly align 
the X – Y mount to face the retro reflector. Tighten the four mounting bolts. Place 
the GasFinder2.0 on the mount such that the rear panel of the GasFinder2.0 locks 
under the rear angle plate on the mount.  Tighten the two red locking screws on the 
front of the mount into the holes at the bottom of the front panel on the 
GasFinder2.0.  Connect the power supply and data cables. For precise alignment 
procedures refer to Operating Instruction  #6. 
 
Note: The minimum recommended separation between multiple GasFinder2.0 
transceiver units is 300mm. Due to the modulation techniques employed in the 
GasFinder2.0 system, interaction or “cross-talk” with other types of monitoring 
instruments should be negligible. 
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Illustrations of Mounts  
 
 

 
 
 
 
 
Illustrations of Enclosure 
 

     
 
 

          Rear                  Front 
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Retroreflectors 
 
The type of reflector used will depend on the path length, atmospheric conditions 
such as dust or fog, and the type of laser. When choosing a reflector, the prime 
concern should be to keep the returning light level value between 2000 and 12,000. 
The following reflectors are suggested only as a guide. Consultation with Boreal 
Laser is recommended before choosing a reflector. 
 
Note: It is possible to get too much light returned(>16,368). When this happens the 
receiver saturates and the displayed light value will read very low (<200). 
 
For distances 1m to 10m use reflective traffic tape.  #RFTP 
 
For distances 5m to 30m, use grey reflective tape.   #RFGT 
 
For distances 20m to 70m, use plastic highway reflectors.  #RFHWY 
 
For distances 60m to 120m, use one 1” corner-cube retroreflector. 
 
For distances 100m to 150m, use one 2½” corner-cube retroreflector. 
 
For distances 150m to 200m, use two 2½” corner-cube retroreflector. 
 
Reflector enclosures are available with enough retros inside to measure gas 
concentrations over path lengths up to 1km. Consult Boreal Laser for more 
information. 
 

6 - Retro enclosure    21 - Retro enclosure 
 
 
 

                      
 
 
 
 

265

400 

4 mounting lugs, on a 
   rectangle153 x  278 4 mounting holes, on a 

  rectangle  280 x 380 

165 230 

130 300
All dimensions  
In millimetres 
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Operating Instructions 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
   Fig. 8   Rear Panel Layout 
 
1. Connect the GasFinder2.0 to the 12V power supply, the data interface cable to 

the computer if required, and switch on. The display will read*: 
 

GasFinder2.0    Warm_up 
Ver:0.37     HF     180 

 
 This warm-up cycle lasts three minutes. The warm-up period for other  

gases maybe different.  
 
2. After the warm-up cycle, the following display may appear: 
 

           Low Light 
           No Reading 

 
indicating that the GasFinder2.0 is off-target and requires alignment with the 
retroreflector. 

 
* Throughout the manual, various gas types will be referred to in the displays. In 
this case the display refers to Hydrogen Fluoride. 
 

BOREAL  LASER  INC. 

   ppm               HF                 R2 
    1.8                                    0.98 

DATA I/O
12VDC

ON 
 
OFF

ENTESC

GasFinder2.0 

110



Boreal Laser Inc.   GasFinder2.0 (Ver.0.39) Operation Manual September 2003     

 9

3.  Press the ENT key on the keypad, then the key twice, and the Light Value 
display will appear: 

 
  Light Value        dist   m 
            64                10  

 
indicating a pre-set default distance of 10 meters and a minimum returning 
light value of 64 (a light value of < 100 indicates a no-light situation) 

 
4. Adjust the distance to the retroreflector by pressing the ENT key again. A 

flashing “Adj.” will be visible in the lower left corner of the display. Note that the 
GasFinder2.0 does not measure the distance to the retroreflector. The distance, 
in metres,  must be entered manually. It is measured from the front panel of the 
Gasfinder2.0 to the retroreflector. 

 
   Light Value        dist   m 
   Adj.    64               10 

 
5. Pressing the  or the  key increases or decreases the distance. Once the 

appropriate distance has been entered, press the ESC key. The display will now 
show the entered distance. 

 
6. The system is now ready for optical alignment. The red aiming laser will be 

visible. Using the attached scope, adjust the X – Y mount adjusting screws to 
locate the retroreflector in the cross hairs of the scope. Fine-tune the adjustment 
so that the displayed light value is in the optimal range (2000 – 12000).  

 
If the light value is below this range, the system is in a low-light situation and 
may fail to make a correct measurement. When the light value drops below a 
factory set value of 500, the system will give a status message on the display 
indicating “low light - no reading”. To increase the light value, move the cross-
hairs closer to the center of the retroreflector array or increase the number of 
retros.  

 
If the light value is above the optimal range, the receiver electronics may 
saturate and spurious readings may be displayed, e.g., unrealistically high 
concentration values and low confidence factors. To reduce the light value, 
move the cross-hairs slightly away from the centre of the retroreflector or cover 
some of the retros. 

 

Note: At short distances of less than 50m, reflective tape should be used. The red 
aiming laser can be used for initial alignment. Do not look at the reflector through 
the scope over short distances when the red laser is operating.   
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7. Press the ESC key twice to return to the normal operating mode. After the 
computer checks the calibration, the display will read something like: 

 
ppm       HF         R2 
4                    0.99 

 
This indicates a measured path-averaged hydrogen fluoride concentration of 
4ppm with an R2 of 0.99 (99%). Of course, this display will depend upon the 
type of gas, and the actual concentration. Note that to get the correct value for 
ppm, the path length (distance) has to be set correctly (see item 5). 

 
Note: The ESC key returns to the previous menu item. So, if the user becomes 

“lost” within the menu system, press the ESC key until the system returns to the 
normal operation mode (as shown above in step 7). 
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Data I/O 
 

 
Fig.9 
 
The DB15F connector on the back of the instrument is a hybrid data I/O connector, 
combining serial data output (RS-232) and analogue signals useful for examining 
system performance. The connections for a serial data cable are shown in 
Appendix E. 
 
 
Signal Description  (n/c = No Connection) 
 

1 n/c   
2 PCRX Data Receive at PC digital output from GasFinder2.0 
3 PCTX Data Transmit at PC digital input to GasFinder2.0 
4 PCDTR Data Terminal Ready digital input to GasFinder2.0 
5 GND Signal Ground  digital / analogue 
6 RAMP System Timing Clock analogue output from GasFinder2.0 
7 Isink (-) 4-20mA Loop Return* analogue output from GasFinder2.0 
8 n/c   
9 PCDSR Data Set Ready not currently implemented 
10 PCRTS Ready To Send not currently implemented 
11 PCCTS Clear To Send not currently implemented 
12 +5Vdc System Voltage digital / analogue 
13 RCVR System Signal analogue output from GasFinder2.0 
14 MONITOR System Signal analogue output from GasFinder2.0 
15 Isource (+) 4-20mA loop source* analogue output from GasFinder2.0 

*when option installed 
 

Note: Data I/O equipment may be connected or disconnected while the system is 
operating. Caution should be observed as:  

a) during transition, data may be lost or altered, 
b)  mechanical stresses on the system while plugging or unplugging connectors                              

may misalign the system (see Operating Instructions). 

113



Boreal Laser Inc.   GasFinder2.0 (Ver.0.39) Operation Manual September 2003     

 12

Serial Communications 
 
The GasFinder2.0 instrument will transmit serial data at 1200/2400/9600 baud, no 
parity, 8 bits, one stop bit, (i.e., 9600,N,8,1) after each scan. Two hardware 
handshaking options are available: 
 
1. No Handshaking – Connect pin 4 (PCDTR) to pin 12 (+5Vdc) at the 

GasFinder2.0 end of the data cable. Data will be sent automatically after every 
scan. This is the standard configuration of the cable as supplied by Boreal 
Laser. 

 
2. DTR Handshaking – Control computer raises the voltage to +5Vdc on pin 4 

(PCDTR) in order to request a data string. Data will be sent only when 
requested to by the control computer. 

 
Appendix E shows details of the serial-data cable connections. 

 
 
Data String Specification 
 
The data are transmitted as an ASCII string. The format of the string is as follows: 
 
concentration,R2,distance,light,date_time,ser_num,status_code,*checksum 
 
where: 
 concentration  in ppmm (parts per million meter),    Integer 
 R2   between 0 and 99,      Integer 
 distance   user set distance to reflector in metres  Integer 
 light   returning light level,      Integer 
 date_time   current date and time,       YYYY/MM/DD hh:mm:ss 
 ser_num   identification number of the system,    String 
 status_code  code giving system operation parameters,  Integer 
 checksum  check summing option to verify data integrity, String 
 
These data are comma-delimited (,) and an asterisk (*) signifies end of string.  
Each string is terminated by a carriage return and a line feed. 
 
Status codes are described in detail in Appendix B of this manual. 
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Maintenance 
 

The Gasfinder2.0 instrument requires no internal maintenance and 
 there are no user-serviceable parts. 

 

Note: The instrument relies on a clear optical path to obtain readings of gas 
concentration. Dust settling on the instrument’s window and the window of the retro 
enclosure must be cleaned off whenever it degrades the instrument’s performance. 
The average value for the light level should be kept between 2,000 and 10,000. 

 
Cleaning the Windows  

 
Many dusts, especially aluminium oxide, are very abrasive and care must be 

taken not to scratch the windows when cleaning them. The recommended 
procedure for cleaning is as follows: 
 

1. Blow off any dust using cannedA, compressed air. Note that compressed 
“shop” air may contain oil from the compressor, and should not be used. 

 
2. If the window is streaked with rain-deposited particles, wash it with copious 

amounts of water using a spray bottle (laboratory or other type), and clean 
fingers. 

 
3. Gently wipe with a soft “Kleenex” tissue. 

 

4. Spray a small quantity of an anti-static solutionB, if one is available, on the 
window.  

 
5. Gently wipe clean with a dry, soft tissue. 

 
A This product is available from camera shops, electronic stores or directly from 
Boreal Laser Inc.  
B A suitable anti-static solution is “Novus No.1”, used by plastic fabricators and 
aircraft maintenance staff for cleaning windscreens, and can be obtained 
directly from Boreal Laser Inc.  
 

Note: Extreme care should be exercised when cleaning the window on the front 
of the GasFinder2.0, as it is a very delicate plastic membrane.  
 

Cleaning Intervals 
 
The need for cleaning will be indicated by a consistent loss of light, which may 
result in poor gas concentration readings. Cleaning intervals may vary from once 
per week to once per year. 
Difficulty in obtaining an adequate light level after cleaning the windows may 
indicate that the instrument has moved out of alignment. This may be caused by 
movement of the base due to vibration or other factors. Details of the alignment 
procedures can be found in the Operation Manual. 
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Troubleshooting 
 
• Symptom:  System not operating. 
 
• Solution:  Check power supply integrity. 
    - plugged in? 
    - fuse intact? 
    - power cable intact? 
 
• Symptom:  Status message: “Low Light - No Reading” 
 
• Solution:  Check that open path is clear (see note below). 
    - vehicle/personnel obstruction? 
    - heavy fog? 

- heavy rain? 
- windows dirty? 

 
   Verify optical alignment (see Operating Instructions) 
 
Note: If the system enters the “Low Light - No Reading” status condition due to 
temporary path obstruction, normal operation will automatically resume once 
obstruction has been removed (e.g.: fog lifts, rain stops or vehicle/ personnel is 
moved). 
 
 
• Symptom:  No data transmission. 
 
• Solution:  Check that the correct handshaking option is selected. 
    (see Serial Communications section) 
 
   Check that the correct baud rate is selected. 
    (see Serial Communications section) 
 
   Check that the correct check sum option is enabled 

when used with the GasView2 display program. 
 
   Check system. 
    -on line? 
    -data cable connected? 
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Safety Issues 
  
Boreal Laser’s GasFinder2.0 contains both visible and invisible (infrared) laser 
sources. Both sources conform to Class 3a as per ANSI Z136.1-1993 and do not 
require the use of protective eye ware, protective equipment or special safety 
measures. 
 
Note: Even though these lasers are considered to be “Eye Safe”, it is the 
recommendation of Boreal Laser Inc. that, as with ANY LASER SYSTEM, the 
user/operator should avoid staring directly into the output aperture of the 
instrument. 
 
• There is no optical ignition hazard presented by lasers of this type. 
 
• The GasFinder2.0 transceiver unit is suitable for operation in  
      Class I, Division 2, Groups A,B,C, & D electrical areas per CSA, NRTL/C. 
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Calibration 
 

The GasFinder2.0 is shipped already calibrated and does not require any 
calibration in the field. 
The calibration of the GasFinder2.0 is done by passing a known concentration of 
gas through a test cell, which is placed in the path of the laser beam. Gases which 
are very reactive or unstable, such as ammonia and hydrogen fluoride, are 
generated at the time of use with a permeation tube. The tube is placed in a 
temperature-controlled chamber and emits the calibration gas at a known rate. A 
measured flow of inert dilution gas creates a concentration of gas which is traceable 
to NIST standards. The calibration data are stored in the instrument’s software as a 
standard reference waveform. 
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During operation, the GasFinder2.0’s internal reference cell is compared with this 
stored waveform at frequent intervals. Any significant deviation generates a status 
code to alert the user to a potential calibration problem. The GasFinder2.0 software 
can be used to check the reference cell, as well as to download sample, reference 
and calibration waveforms to verify that the internal calibration system is functioning 
correctly. If GasView2 is being used, these waveforms can be displayed on the 
computer (Port1/Arrays Plot Enable and then at the GasFinder2.0 press the 
‘Internal Arrays Transfer’ in Maintenance Menus).  
 

     
 

     Calibration Room        Test Cell 
A technical note detailing the calibration procedure and quality assurance is available from Boreal Laser 
Inc. 
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 Main Display Menu 
 
• normal display:  

When the system is functioning normally, the display will read something like: 
 

 ppm          CH4         R2 
      8                          0.99 

 
Of course, the actual displayed values will depend on the particular gas 
concentration being monitored. In this example, the instrument is displaying a 
path-averaged methane gas concentration of 8ppm with an R2 of 99%. A 
detailed explanation of R2 is given in Appendix D 

 
• alarm display: 

If the system operation is outside the normal operating bounds, the display will 
provide insight into the abnormal situation. There are several possible displays. 

 
warm-up mode - When the instrument is first turned on, the system requires 
a period of two to four minutes to establish and lock-in the required laser-
diode operating temperature. During this period, the display will read: 

 
GasFinder2.0    Warm_up 
Ver:0.37      HFOP-10## 

 
During this phase the operator should refrain from adjusting the 
instrument. A count-down timer in the lower right corner provides an 
indication of progress during this phase. 

 
low-light mode - If the beam path is obstructed, there will not be sufficient 
returning light for the instrument to make a measurement of gas 
concentration. In this event, the display will be: 

 
   Low Light 
           No Reading 

 
When this happens, the operator should remove the obstacle or reposition 
the instrument to provide a clear optical path. 
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cooler failure - If a problem develops with the internal thermoelectric cooler 
or the associated electronics, the system will protect the laser diode by 
shutting the laser off and displaying: 

 
 TEC Failure 
     Laser Diode Off Line 

 
In this situation, the operator should contact Boreal Laser Inc. for 
further information as to resolving this problem. 

 
 

receiver unlocked - If the signal being analysed by the onboard electronics 
falls below a certain set value, and the returning light level is within the 
acceptable bounds, this may indicate a problem with the internal receiver 
electronics. In this event, the system will display: 

 
    Unlocked 
            No Reading 

 
If this situation persists, the operator should contact Boreal Laser Inc. 
for further information as to resolving this problem. 

 
 

low battery - If the voltage of the portable battery or power supply goes 
below 11.5V, a ‘B’ will appear in the top right corner of the display.  If the 
voltage goes below 10.0V, the GasFinder2.0 will shut down and enter a “low 
power” mode after saving all the system variables. In this mode internal 
logging of the data will be suspended. 

 
  ppm         CH4        R2    B 
      8                         0.99 

 
After a voltage greater than 11.5V is applied, the GasFinder2.0 will resume normal 
operations.  
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Parameter Adjustment Menu 
 
If the operator presses the ENT key while the instrument is in the normal operating 
mode, the system will enter a parameter display/adjustment menu. The arrow keys 
( , ) can be used to move between the various menu items. When the operator is 
in the menu system, pressing the ENT key will enter the adjustment mode of the 
displayed menu item.  A blinking “Adj.” will be visible in the bottom-left corner of the 
display, and the value of the parameter displayed can be raised or lowered using 
the arrows. The ESC key always jumps back to the previous level; that is, if the 
user is in the adjust mode, pressing ESC once will move back to the display mode 
of that item, and pressing ESC again will return the user to the main display menu. 
The display/adjustment items are described below. 
 
• Concentration Units: This is the first menu item accessed when the ENT key is 

pressed. This item displays the units chosen to display the concentration in the 
main display. These can be adjusted between ppmm (parts per million metre: 
the total amount of gas along the path) and ppm (parts per million: average 
concentration along the path).    

      ppmm / m = ppm. See Appendix C for a more detailed explanation. 
 
• Light Value    Dist: This menu item switches on the on-board visible aiming 

laser and displays the returning light value as well as the entered distance to the 
retroreflector. The distance can be adjusted to correspond to the actual 
distance. The arrow key  increases the distance and  decreases the 
distance. This item is explained in detail in the Operating Instructions section in 
this manual. 

 
• Concentration Range: (HF gas only) The user should select the low range if 

the concentration is expected to be below 450ppmm. Otherwise select high. 
 
• Average Window: This item sets the number of samples to be averaged. When 

set to a value >1, the normal operating display will indicate “AVG”. This average 
is an R2 weighted average: concentration values with low R2s will have a smaller 
effect on the average than those with higher R2s. 

 
• Min acceptable R2: This item allows the user to specify the value of the 

confidence factor below which the concentration is deemed to be insignificant. 
Operators can adjust this value to reduce the occurrence of “noisy” readings in 
the presence of factors such as steam, traffic or thermal scintillation. 
Consultation with Boreal Laser Inc. may be prudent before changing this value 
from the factory default value. 
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• Serial Baud Rate: This item allows the user to select the baud rate at which 
data are transmitted from the GasFinder2.0 instrument, depending on the 
storage device/computer used. Available options are: 1200, 2400, and 9600 
baud. The serial data parameters are detailed in the Data I/O section of this 
manual. 

 
• Serial Checksum: To ensure the integrity of the data when it is sent to a data 

logger or GasView2, a checksum string can be added to the serial data. This 
option can be enabled or disabled in order to achieve compatibility with all 
versions of GasView2. 

 
• Sample / ref. scan: This item selects the number of times the sample path is 

measured before the reference cell is checked. With this option, the user can 
specify how often the reference cell is checked during the measurement period. 
It should not be necessary to change this value from the factory default setting. 

 
• Sweeps per reference: This item displays the number of sweeps of the internal 

reference cell that are averaged to give a full reference scan. The more sweeps 
that are averaged, the more accurate the reference reading will be. However, 
there is a trade-off between accuracy and sample time. The user is cautioned 
that increasing the reference averaging time will have a minimal effect 
compared to increasing the sample averaging time (see next item). It should not 
be necessary to change this value from the factory default setting. 

 
• swps/ref   swps/samp: This item selects the number of sweeps averaged to 

obtain a sample scan. The number of sample sweeps is a multiple of the 
number of reference sweeps to a preset maximum value. Consultation with 
Boreal Laser Inc. may be prudent before changing this value from the factory 
default value. 

 
• Alarm ppmm: This item allows the user to select the set-point at which the 

optional audible alarm will sound. The displayed value for this item will be 
expressed in the units selected in the item dealing with concentration units 
described above. For more information on the audible alarm option, contact 
Boreal Laser Inc. 

 
• Baseline Adjustment menus: These items allow the user to correct for 

background noise.  This option is employed in situations where atmospheric 
interference may cause reduced sensitivity.  
The Auto Baseline Acquire and Auto Baseline Adjust menus permit 
automatic selection of the baseline adjustment function using various control 
parameters.  
Consultation with Boreal Laser Inc. is strongly recommended before changing 
these values from the factory default value. 
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• Serial dump per sample sweep: this item selects the interval at which serial 
data are outputted. Serial Dump per Sample Window will output data once 
every sample (default is approximately once per second). Serial Dump per 
Average Window will output data once every completed average. For example, 
in the default configuration, if the average window is set to 60 samples, the data 
will be outputted approximately once per minute. The actual rate can be 
determined by observing the date_time field in the serial data. 

 
• Log Menus: This enables the GasFinder2.0 to be used as a data logger. The 

storage capacity is about 10,000 lines. Recording a data point every second will 
give nearly three hours of recording.  If the average is set to one minute using 
the Average Window set to 60, then the recording time is nearly seven days.  
The data can be stored in the buffer in a wrap-around mode where data 
overwrites the initial records when the memory is full. Thus only the latest data 
is recorded.  Alternatively, if the fill mode is used, the data will fill the buffer and 
then all future data is lost. The data in the buffer can be downloaded to a 
computer using a terminal program such as Hyperterminal.  Note that switching 
the GasFinder2.0 off does not erase the data.  This is done using Clear Log in 
the Log Menus option. For more detailed instructions on using the Log Menus 
options, see Appendix F on pages 29 and 30.   

 
• Serial ##    version 0.37: This item provides a convenient way of checking the 

serial number of the instrument and the software version currently installed. This 
is not an adjustable item. 

 
• Battery Voltage: This provides a convenient way of checking the voltage of the 

12V power input.  This is not an adjustable item. 
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• Maintenance Menus!: This item allows the user access to internal settings of 
the GasFinder2.0 instrument. These parameters should normally not be 
changed by anyone other than Boreal Laser personnel except for Internal 
Arrays Xfer, 4-20mA settings and Real Time Clock. 
The values in parentheses are examples only and may differ for each 
instrument. 
 

• Internal Arrays Xfer: If Boreal Laser personnel need to check the 
system, the Internal Arrays Xfer allows the instrument’s internal array 
configuration to be downloaded to a file. The operator can transmit this 
file to Boreal Laser Inc. for analysis. Boreal Laser personnel will instruct 
as necessary. 

• Periodic Array Transfer: Downloads the previous item at selected    
intervals 

• Beam Block Safety: Used to disable the laser beam when the path is 
blocked. 

• Sweep Light Minimum: Used in variable light conditions, fog, etc. (0) 
• Sweep Light Maximum: Used in variable light conditions (1023) 
• 4-20mA Current Loop Settings: When installed, this submenu allows 

the user to configure the 4-20mA current loop option. 
• 4mA ppmm Set Point: Used to set the value in ppmm which 

corresponds to a loop current of 4mA. 
• 20mA ppmm Set Point: Used to set the value in ppmm which 

corresponds to a loop current of 20mA. 
• 4-20mA enable: Used to enable or disable the 4-20mA current 

loop output. 
• Reference Cell ppmm: Reference cell concentration (XX) 
• Points per Sweep:  Number of internal points on the graph (128) 
• Skip pts/swp start:  Initial points discarded (28) 
• Mirror flip delay:  Time delay before reading values (250ms) 
• Target Scan Peak: Percentage where maximum value occurs (65% 

    or 90%) 
• Min. acceptable light: Lower level for light value (500) 
• Ref. Cell check:  Internal reference cell check (ppmm & R2) 
• Ref. Swps/cal.check:  Frequency of reference checking (10) 
• Calibration centre line/light value: Data for reference cell (65 & 4000) 
• Real Time Clock:  This submenu allows the user to set the Real  

    Time Clock (RTC). Press ENT to cycle through 
    the date and time entries,  and  to change the 
    item, and ESC to back out of the submenu.  
    The values will automatically be saved. 
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                      Calibration Menus. !!  Caution !!   
 
Note!!: This item allows the user access to internal calibration settings of the 
GasFinder2.0 instrument. This menu area should not be accessed by anyone 
other than Boreal Laser personnel . 
 
 

• Reference Acquire:  Obtain reference waveform. 
• Store Calibration:  Confirmation of lock. 
• Calibration Storage:  Used to unlock and lock storage. 

 
 
Pressing  ESC  twice will return the user to the main display menu. 
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Appendix A   Menu Structure 
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Appendix B   Status Codes 
 
When the GasFinder2.0 is used in conjunction with ‘Hyperterminal’ or Boreal Laser’s 

‘GasView2’ data-logging programs, the data stream output which is sent to the file is as follows: 
 
 122.8,99,235,8835,2002/03/01 10:21:25,HF-1015,2800,*(2F) 
 

122.8 99 235 8835 2002/03/01   10:21:25 HF-1015 2800 * (2F) 
ppmm R2 Distance Light Level Date         Time Serial Number Status Code End Of String Checksum 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

Status Code 2 8 0 0

Hex n7 n6 n5 n4

0 0 0 0 0 
1 0 0 0 1 
2 0 0 1 0 
3 0 0 1 1 
4 0 1 0 0 
5 0 1 0 1 
6 0 1 1 0 
7 0 1 1 1 
8 1 0 0 0 
9 1 0 0 1 
A 1 0 1 0 
B 1 0 1 1 
C 1 1 0 0 
D 1 1 0 1 
E 1 1 1 0 
F 1 1 1 1 

n15 n14 n13 n12 n11 n10 n9 n8 n7 n6 n5 n4 n3 n2 n1 n0

n15 - CAL_ERR:   calibration line center error 
n14 - WAVG_ENAB: averaging enabled 
n13 - NOT_CALIB: calibration not verified 
n12 – LOW_BAT:   low battery indication 
n11 - MENU_MODE: unit is currently in menu system 
n10 - CALIB_ERR: reference cell out of factory calibration 
n9 - OVERFLOW:  gas concentration >8 digits 
n8 - OVERRANGE: receiver signal beyond gain switch control 

n7 - LD_COLD:  TE Failure, laser diode off line 
n6 – Lt_Lv_ERR: turbulence, timed out 
n5 - NOLOCKDET: receiver unlocked, low signal 
n4 - LOW_LIGHT: laser path blocked, low light 
n3 - R2_LOW:  R2 lower than set minimum value 
n2 - NOT_CTRD:   laser not centered on gas wavelength 
n1 - GAS_HIGH:  concentration higher than set maximum 
n0 - NO_ERROR:  normal operation, no errors 

Hex n3 n2 n1 n0

0 0 0 0 0 
1 0 0 0 1 
2 0 0 1 0 
3 0 0 1 1 
4 0 1 0 0 
5 0 1 0 1 
6 0 1 1 0 
7 0 1 1 1 
8 1 0 0 0 
9 1 0 0 1 
A 1 0 1 0 
B 1 0 1 1 
C 1 1 0 0 
D 1 1 0 1 
E 1 1 1 0 
F 1 1 1 1 

The above sample status code of “2800” corresponds to “0010_1000_0000_0000”.  This indicates an 
instrument status of:     n13  - NOT_CALIB,  n11 - MENU_MODE 
 
The following is another example: 
     Code “A42E” would correspond to “1010_0100_0010_1110” and indicate an instrument status of: 
n15 -CAL_ERR, n13 -NOT_CALIB, n10 -CALIB_ERR, n5 -NOLOCKDET, n3 -R2_LOW, n2 -NOT_CTRD, n1 -GAS_HIGH  
 
     Under normal operating conditions, the most common status code is “1”.  This is actually 0001, but the 
software ignores the leading zeros and indicates a status code of “1”.  This corresponds to 
“0000_0000_0000_0001”, and indicates an instrument status of:  n0 - NO_ERROR. 

Hex n15 n14 n13 n12 

0 0 0 0 0 
1 0 0 0 1 
2 0 0 1 0 
3 0 0 1 1 
4 0 1 0 0 
5 0 1 0 1 
6 0 1 1 0 
7 0 1 1 1 
8 1 0 0 0 
9 1 0 0 1 
A 1 0 1 0 
B 1 0 1 1 
C 1 1 0 0 
D 1 1 0 1 
E 1 1 1 0 
F 1 1 1 1 

Hex n11 n10 n9 n8 

0 0 0 0 0 
1 0 0 0 1 
2 0 0 1 0 
3 0 0 1 1 
4 0 1 0 0 
5 0 1 0 1 
6 0 1 1 0 
7 0 1 1 1 
8 1 0 0 0 
9 1 0 0 1 
A 1 0 1 0 
B 1 0 1 1 
C 1 1 0 0 
D 1 1 0 1 
E 1 1 1 0 
F 1 1 1 1 
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Appendix C  Explanation of  ppmm 
 

Gas concentration is measured in ppm, ‘parts per million’ by volume. If a 
room measuring 100m x 100m x 100m (1 million cubic metres) has 10 cubic metres 
of air replaced by a pure gas, then the gas concentration is expressed as 10ppm.  A 
point sensor measures directly in ppm.  

 
Open path monitors, like the GasFinder2.0, measure the total amount of a 

specific gas, for example HF, in the path of the laser beam between the transmitter 
unit and a reflector. This is a ‘total path’ measurement. The units are ‘parts per 
million metres’, or ‘ppmm’.  

 
A uniform background concentration of 10 ppm over 50m gives a reading of 

500 ppmm. 
 
 

 
           
 
 
 
 
 
    
 
 
 
 
 
 
A concentrated cloud of 50 ppm,10m in diameter, in a background of 0 ppm also 
gives a reading of 500ppmm 
 
 
        
 
 
      
                    
             50m 
 
 
When the 500 ppmm is divided by 50m the result is a value of 10 ppm, which is the 
‘path averaged’ concentration. 
 

10ppm

50ppm

GasFinder 
Retroreflector

Retroreflector

50m

GasFinder 

10m
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Appendix D     Explanation of R2 
 
When the GasFinder2.0 receives the returning laser signal after it has passed 
through the sample gas, the receiver converts it to the shape of a specific waveform 
or curve. This is the sample waveform. The GasFinder2.0 also receives a similar 
signal after the laser beam has passed through the internal reference cell. These 
curves are then digitised and compared as two numeric arrays. 
 
 

 
 
 
 
 
An accepted mathematical procedure to compare curves or numeric arrays is the 
Linear Least Squares Regression analysis. This analysis results in a measure of 
the similarity (R2), between the waveform of the sample gas and that of the 
reference cell gas. A perfect similarity would give a value for R2 of 1.0, and a total 
mismatch would be 0.0. 
 
 
   

 
 
The blue line represents the Linear Least Squares fit of the data and is the best fit 
of a straight line between the reference (X) and sample (Y) data points. The slope 
is a component in the ratio-metric calculation of gas concentration. 
 
 

Reference 
Waveform 

Sample 
Waveform A 

R2 = 0.98 

Reference 
Waveform 

Sample 
Waveform B 

R2 = 0.04

Regression 
analysis for 
Waveform A 

R2 = 0.98 

Regression 
analysis for 
Waveform B 

R2 = 0.04
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(Explanation of R2 continued). 
 
A typical plot of concentration versus R2 will give the following graph:  
 

 
 
 
Measurement Accuracy 
 
R2 can also be used as an indication of the accuracy of the gas concentration 
measurement. 
The following data were generated in the laboratory under controlled conditions 
using a 1m Teflon tube and a permeation source for the generation of the target 
gas. 
 
 

R2 Measurement 
Accuracy 

>0.95 ±2% 
0.9 ±5% 
0.7 ±10% 
0.5 ±15% 
0.4 ±20% 
0.3 ±25% 
0.15 ±50% 
0.1 ±70% 

<0.05 ±100% 
 

With lower levels of sample gas, the 
R2s decrease, and equal zero when 
there is no gas present. As the signal 
from the gas becomes stronger, the 
effect of noise, both electronic and 
optical, is reduced and the R2s will 
increase (i.e., the signal to noise ratio 
will increase). The general shape of the 
plot is the same for all gases, however, 
the x-axis values will depend on the 
sensitivity of the instrument to the gas 
species being observed. 
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Appendix E  Cables 
 
Data Cable 

              
 
 
 
 
 
 
 

 
 
 
 
 
 
 
 
Battery Cable 
 
 
 

           
 

      
 
The battery cables use Amphenol connectors with two-wire connections marked ‘A’ 
and ‘B’.  ‘A’ is positive and uses a white or red wire;  ‘B’ is negative and uses a 
black wire. 
 

DB15M to 
GasFinder DB9F to 

Computer 

DB9F 
5 

2 

12 
5 
4 

2 

DB15M 

      Amphenol 
 PT06E-8- 2S(SR) 
          9812 
 
   To GasFinder 

      Amphenol 
 PT06E-8- 2P(SR) 
          9902 
 
     To Battery 
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Appendix F      Internal Logging Option 
 
Log to Memory Menus: To use this option, enter the Parameter Adjustment Menu 
by pressing Ent on the keypad. The display will read Concentration Units. Press the 
up arrow ( ) five times and the Log to Memory Menus will be displayed. Press Ent 
and Buffer Mode will be displayed. 
 
• Buffer Mode: Pressing Ent again will enable the user to choose between fill 

and wrap mode. The data can be stored in the memory in a wrap- around 
mode where, when the memory is full, data overwrites the initial records. 
Thus only the last 10,000 readings are retained.  Alternatively, if the fill 
mode is used, once 10,000 readings have filled the memory, all future data 
are discarded. Pressing ESC will return to Buffer Mode, and then pressing 
the down arrow ( ) will lead to the next item. 

 
• Log to Memory: When this is Enabled, the internal logging option is activated.  
 
• Log Memory Records: This item lists the number of records currently in the 

memory. The storage capacity is about 10,000 lines. Recording a data 
point every second will give nearly three hours of recording. If the data are 
averaged over one minute, the recording time is nearly seven days. 

 
• Log Memory Dump: Pressing Ent will download the stored data to a computer 

terminal through the serial data port. See the description of HyperTerminal 
in Appendix G.  Downloading the data will not erase the internal memory. 

 
• Clear Memory Log:  Pressing Ent will erase all data stored in the memory. 

 
To return to the normal operating mode, press ESC twice. 

 
 
 
Example 1:  If data are to be recorded every second, ‘Log to Memory’ should be 
Enabled, set the 'Serial Dump per Sample Sweep'  to 'Serial Dump per Sample 
Sweep', and set the ‘Average Window’  to 1.  
 
Example 2:  To record data with a one-minute average, ‘Log to Memory’ should be 
Enabled, set the ‘Average Window’ to 60, and set the ‘Serial Dump per Sample 
Sweep’ to ‘Serial Dump per Average Window’. In this configuration, the recording 
time is nearly seven days.   
 
Note: !!: To ensure that the logging proceeds correctly, three menu items should be 
checked:  'Log to Memory',  'Serial Dump per Sample Sweep' and ‘Average 
Window’.   
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Note: 
 

• When the GasFinder2.0 is in Menu Mode, the data output is set automatically 
to once per second.  This can appear confusing if the Average Interval is set 
to a value other than one. However, when the Menu Mode is exited, data will 
be stored at the selected rate. 

 
• Care should be taken if the GasView2 program is used at the same time as 

the Log to Memory is enabled in an averaging mode. Due to possible re-
averaging by the GasView2 program, false values may be generated. 

 
• Switching the GasFinder2.0 off does not erase the data.  Data are erased 

using Clear Log in the Log Menus option. 
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Appendix G     HyperTerminal 
 
HyperTerminal is a standard accessory in most ‘Windows’ programs of ’95 or later. 
 
To Use HyperTerminal 
 
On the computer, open ‘Windows Explorer’. 
Choose ‘Program Files’, ‘Accessories’ and then ‘HyperTerminal’.  
Choose ‘HyperTrm - Application’.   
Choose a ‘name’ and an ‘icon’, and click OK.  
 
In the ‘Connect to’ display, bypass the phone connections and under ‘Connect 
Using’, scroll down to the correct port (i.e. go directly to com1 or com2). Click OK. 
  
In the ‘Port Settings’ display, change the ‘bits per second’(baud rate) to the correct 
value, typically 9600. Also select ‘8’ data bits, ‘no’ parity, and ‘1’ stop bit.  
‘Flow control’ should be set to ‘none’. Click OK. 
 
The data should now be appearing on the screen. 
 
Note:  Some versions of Windows may have a different path for obtaining 
HyperTerminal. 
 
 
To record the data to a file  
 
In the upper Tool Bar click on ‘Transfer’ and ‘Capture Text’. 
Data can be recorded to a file in a specific location. To do this type in a file name in 
the ‘Capture Text’ window, or use the ‘Browse’ option to choose a file. 
Clicking ‘Start’ will activate the recording procedure and on the lower toolbar the word 
‘Capture’ will be highlighted. 
 
To stop recording the data, in the upper Tool Bar click on ‘Transfer’ and ‘Capture 
Text’ and ‘Stop’. 
 
The file is a standard text file and can be loaded into Excel. 
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Appendix H  Conversion from PPM to mg/nm³ of Hydrogen Fluoride 
 
(Parts per Million to milligrams per normalised cubic metre) 
 
 
The molecular weight (mw) of F  = 18.998 g/mol 
The molecular weight (mw) of H  =   1  g/mol 
The molecular weight (mw) of HF  =  19.998 g/mol 

 
The Universal Gas Constant (R)  = 0.08206 litre /mol.°K 
Therefore, at STP, 1m³ of gas   = 44.6229 moles 
(Standard Temperature and Pressure) 
 
Standard Atmospheric Pressure (P)  =  101.325 Kpa 
Standard temperature (T°K)   = 273.13 °K 
 
 
 

1ppm of any gas = 1 x 10-6 
      = 44.6229 x 10-6 mol 
            m³  
 
   1ppm HF  = 19.998 x 44.6229    g   x  mol 
             1,000,000 mol x  m³ 
 
   1ppm HF  = 0.8929  mg  at STP 
           m³ 
 
 

Adjustments for different Temperatures and Pressures. 
 
 
Actual Concentration = New Pressure(Kpa)    x  273.13   x  STP concentration        

101.325    x   New Temperature(°K) 
 
 

eg. At a pressure of 94.34Kpa and a temperature of 20°C.  
 
Actual Concentration =   94.34   x 273.13  x   0.8929 mg/m³ 
         101.325 x 293.13 
 
     =  0.867      x   0.8929 mg/m³ 
 
 1ppm of HF   = 0.774  mg/m³      at 94.34Kpa and 20°C. 
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Appendix I    Alignment procedures for a moving building. 
 
All buildings move. Some move more than others depending on the external and 
internal forces. In most cases, this movement goes unnoticed until cracks form in 
concrete or a small piece of plaster flakes off. Movement can occur over years as 
the building foundations settle, or over seconds as wind forces move the structure. 
Settlement over time is too slow to cause an alignment problem, because any 
movement is very small, and can be compensated for with periodic adjustments. 
When the movement is caused by wind, the structure returns to its previous position 
once the wind has passed. In the same way, the shaking motion produced by the 
movement of overhead cranes is not usually a problem as the structure quickly 
returns to its original position when the crane has stopped.  
 
Movement caused by thermal expansion due to solar heating is different. Metal 
structures are particularly susceptible to deflection when the solar heating produces 
large differential forces, which result in a twisting or warping motion of the structure. 
This is seen, especially on sunny days, as a diurnal variation in the GasFinder light 
level. This is caused by the expansion and contraction of the metal structure 
carrying the laser mount, which twists with respect to the longitudinal axis of the 
original laser path. This causes the laser beam to move away from the reflectors 
and results in a drop in the returning light level. The amount of movement will vary 
considerably with the orientation of the building and the attachment of the mount 
within the building. 
 
If movement is suspected, it can be verified and measured as follows: 
Arrange to have access to the mount where the transmitter and telescope are 
located, and plan to make observations through the telescope at least four times 
throughout the day. Movement is usually a maximum on bright, sunny days. At 
each observation, note the time and the position of the cross hairs in the telescope 
with respect to a part on the reflector. Shining a flashlight beam on the reflector will 
make it easy to see at long distances. Do not adjust any alignment screws. At the 
end of the day, you should have a number of points showing the different positions 
of the cross hairs. This difference between these positions will indicate the amount 
and direction of movement of the laser beam. See Fig 1.  
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The observations can be made over a shorter time period, but the results may not 
give an accurate picture of the movement. A plot of the positions in a continuous 
time period will yield a graph similar to Fig. 2. This graph can be used to estimate 
the maximum movement of the beam. 
In the preceding example, the final retro array will be similar to the shape shown in 
Fig 3. The number of reflectors and their spacing may have to be increased. 
Contact Boreal Laser Inc. for more specific details. 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

Centering the cross hairs with the centre of the laser beam.  
 
At 400m, the diameter of the beam is about 600mm, so the area of the beam may 
be larger than the enclosure. To find the edges of the beam, the GasFinder has to 
be traversed horizontally and vertically until the light level drops.  Note where the 
cross hairs are in the scope at these positions, (see Fig.4) and position the 
GasFinder or transmitter head, so that the cross hairs are in the centre of the 
travel. Looking through the telescope, and without adjusting the alignment of the 
GasFinder, adjust the crosshairs to the centre of the reflector. This is done by 
removing the two cover caps in the centre of the scope and turning the screws 
underneath so that the cross hairs are centred on the reflector.  
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Appendix J   Accessories 
 
GasFinder2.0 
Aiming Scope 
 4 - 20mA Option 
GasFinder2.0 Manual 
Software 
GasView2 Software (version #              ) 
GasView2 Manual 
Case 
Black Plastic Carrying Case 
Mount 
Large Boreal Mount 
Small Boreal Mount 
Rotating Base 
Manfrotto Quick Release Assembly 
 
 
Universal Enclosure 
Universal Enclosure Kit 
Vortex Cooler Kit 
Tripods 
Tripod, Large Manfrotto 
Tripod, Small Manfrotto 
Tripod Head, Manfrotto Pan-Tilt 
Tripod Head, Manfrotto Ball 
Hex Plate 
Battery & Power Supply 
Battery 
Battery Cable 
Battery Charger 
Power Supply (Single Channel) 
Power Supply (Dual Channel) 
Power Cable, 12v Spare 
Plug Adapter for Foreign Operation 
 
 

 
 
Retroreflectors 
Retro Tape Sheet, Grey 
Retro Tape Sheet, Red/White 
Retro Tape Roll, Red/White 
2½" Opticon retros  
2" Opticon retros  
Retro Enclosure, Small 
Hood for Small Retro Enclosure 
Retro Enclosure, Large 
Hood for Large Retro Enclosure 
Retro Enclosure, 4" Square Box 
 
Retro Enclosure Heater 
Solar Panel Kit 
Data Cables 
Data Cable 
Data Cable, with 4-20mA Connection 
Data Cable, for Fiberoptic Modem 
Modems 
Modem, Fiberoptic 
Fiberoptic Cable (Multimode) 
Modem, Telephone 
Modem, Wireless 
Consumables 
"Novus" Cleaner 
Compressed Air Canister 
Test Equipment 
Infra-red Card 
Range-finding Binoculars 
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Appendix  K  Parameter Settings 
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Appendix B 
 

Path Positions  
Sites 1,2 3 

 
Data tables and graphs are provided for field tests on the three primary and three 
supplementary wells.  These tests show data for each well and the individual 
measurement paths for each well. 
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 Path Positions by Site 
 
 
 
 
 
 

 
Figure E1.  Equipment and Path Positioning for Site 1. 

     Notes: 
      T = transceiver. R1, and R2 = Retro-reflectors for corresponding measurement paths. 
      S = source. Small blue arrow indicates orientation of horizontal vent.   

      Green arrow indicates approximate average 
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Figure E2.  Equipment and Path Positioning for Site 2. 

    Notes: 
      T = transceiver. R1, and R2 = Retro-reflectors for corresponding measurement paths. 
      S = source. Small blue arrow indicates orientation of horizontal vent.   

      Green arrow indicates approximate average 
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Figure E3.  Equipment and Path Positioning for Site 3. 

      Notes: 
      T = transceiver. R1, and R2 = Retro-reflectors for corresponding measurement paths. 
      S = source. Small blue arrow indicates orientation of horizontal vent.   
      Green arrow indicates approximate average prevailing wind direction.  
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Appendix C 
 

Path Measurement Data  
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Data tables in this appendix include the following data, grouped by site and TDL 
measurement path at that site: 
 
1) Path Loading – The concentration of methane in parts per million by volume times 

the path length in meters (ppm*m). 

2) Path length in meters (m). 

3) Time - The “timestamp” as recorded in the datalogger with the date and the time of 
path-loading data recorded at 2-3 second intervals.  The tables in this appendix 
follow that format.  Some of the records say Eastern Time and some say Mountain 
Time.  This was the result of the technician not changing the setting for a particular 
run at the Eastern Time zone location.  It does not affect the technical results.  
Mountain Time can be converted to the Eastern equivalent by merely adding two 
hours to the Mountain Time value. 

 
NOTE:  The original Excel® field data files were also provided to GSTC. 
 
The data records are for the following sites and corresponding paths. 
 
 Sites   Path 
 1 1, 2, 3, 4 
 2 1, 2, 3, 4 
 3 1, 2 
 4 1, 2, 3, 4, 5 
 5 1, 2, 3 
 6 1, 2, 3, 4, 5 
 
In some tables the sequence of path numbers might not follow the time sequence.  Path 
numbers were related to field note locations and not necessarily the sequence of times at 
which measurements were taken for that path.  For example measurement data for Site 1 
Path 1 were actually taken at a later time of day then data for Site 1 Part 5. 
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Path Measurement Data 
Site 1 Path 1 

Path Measurement Data 
Site 1 Path 2 

ppm*m pathlength timestamp ppm*m pathlength timestamp 
34 16 9/19/2006 10:40 68.1 16.5 9/19/2006 11:29 
34 16 9/19/2006 10:40 72 16.5 9/19/2006 11:29 

34.2 16 9/19/2006 10:40 69.9 16.5 9/19/2006 11:29 
34.4 16 9/19/2006 10:40 68.5 16.5 9/19/2006 11:29 
34.6 16 9/19/2006 10:40 73.6 16.5 9/19/2006 11:29 
34.5 16 9/19/2006 10:40 91.9 16.5 9/19/2006 11:29 
35.1 16 9/19/2006 10:40 103 16.5 9/19/2006 11:29 
35 16 9/19/2006 10:40 168 16.5 9/19/2006 11:29 

35.2 16 9/19/2006 10:40 85.7 16.5 9/19/2006 11:29 
35.5 16 9/19/2006 10:40 70.9 16.5 9/19/2006 11:29 
35.6 16 9/19/2006 10:40 54.1 16.5 9/19/2006 11:29 
35.6 16 9/19/2006 10:40 48.8 16.5 9/19/2006 11:29 
35.5 16 9/19/2006 10:40 45.3 16.5 9/19/2006 11:29 
35.8 16 9/19/2006 10:40 77.5 16.5 9/19/2006 11:29 
35.6 16 9/19/2006 10:40 66.9 16.5 9/19/2006 11:29 
35.4 16 9/19/2006 10:40 61.1 16.5 9/19/2006 11:29 
35.2 16 9/19/2006 10:40 70 16.5 9/19/2006 11:29 
34.9 16 9/19/2006 10:40 46.7 16.5 9/19/2006 11:29 
35.1 16 9/19/2006 10:40 55 16.5 9/19/2006 11:29 
35 16 9/19/2006 10:40 50.2 16.5 9/19/2006 11:29 

34.9 16 9/19/2006 10:40 65.1 16.5 9/19/2006 11:29 
35.1 16 9/19/2006 10:40 88.6 16.5 9/19/2006 11:29 
34.9 16 9/19/2006 10:40 63.7 16.5 9/19/2006 11:29 
35 16 9/19/2006 10:40 76.1 16.5 9/19/2006 11:29 

34.8 16 9/19/2006 10:40 93 16.5 9/19/2006 11:29 
34.8 16 9/19/2006 10:40 66.6 16.5 9/19/2006 11:29 
34.6 16 9/19/2006 10:40 64.7 16.5 9/19/2006 11:29 
34.7 16 9/19/2006 10:40 73.8 16.5 9/19/2006 11:29 
34.3 16 9/19/2006 10:40 57.6 16.5 9/19/2006 11:30 
34.1 16 9/19/2006 10:40 71.1 16.5 9/19/2006 11:30 
34.4 16 9/19/2006 10:40 59 16.5 9/19/2006 11:30 
34.2 16 9/19/2006 10:40 68.4 16.5 9/19/2006 11:30 
34.3 16 9/19/2006 10:40 55.6 16.5 9/19/2006 11:30 
34.1 16 9/19/2006 10:41 78.5 16.5 9/19/2006 11:30 
34.5 16 9/19/2006 10:41 50.3 16.5 9/19/2006 11:30 
34 16 9/19/2006 10:41 71.1 16.5 9/19/2006 11:30 

34.4 16 9/19/2006 10:41 63.1 16.5 9/19/2006 11:30 
34.4 16 9/19/2006 10:41 52 16.5 9/19/2006 11:30 
34.4 16 9/19/2006 10:41 53.4 16.5 9/19/2006 11:30 
34.4 16 9/19/2006 10:41 45 16.5 9/19/2006 11:30 
34.2 16 9/19/2006 10:41 60.9 16.5 9/19/2006 11:30 
34.5 16 9/19/2006 10:41 77.3 16.5 9/19/2006 11:30 
34.4 16 9/19/2006 10:41 91.8 16.5 9/19/2006 11:30 
34.3 16 9/19/2006 10:41 109 16.5 9/19/2006 11:30 
34.1 16 9/19/2006 10:41 100 16.5 9/19/2006 11:30 
34.5 16 9/19/2006 10:41 79.3 16.5 9/19/2006 11:30 
34.4 16 9/19/2006 10:41 81.1 16.5 9/19/2006 11:30 
34.4 16 9/19/2006 10:41 74.4 16.5 9/19/2006 11:30 
34.5 16 9/19/2006 10:41 51.1 16.5 9/19/2006 11:30 
34.4 16 9/19/2006 10:41 50.2 16.5 9/19/2006 11:30 
34.5 16 9/19/2006 10:41 48.1 16.5 9/19/2006 11:30 
34.2 16 9/19/2006 10:41 73.3 16.5 9/19/2006 11:30 
34.5 16 9/19/2006 10:41 69.3 16.5 9/19/2006 11:30 
34.6 16 9/19/2006 10:41 62.1 16.5 9/19/2006 11:30 
34.6 16 9/19/2006 10:41 60.4 16.5 9/19/2006 11:30 
34.3 16 9/19/2006 10:41 61.9 16.5 9/19/2006 11:30 
34.3 16 9/19/2006 10:41 77 16.5 9/19/2006 11:30 
34.5 16 9/19/2006 10:41 126 16.5 9/19/2006 11:30 
34.7 16 9/19/2006 10:41 191 16.5 9/19/2006 11:30 
34.6 16 9/19/2006 10:41 375 16.5 9/19/2006 11:30 
34.6 16 9/19/2006 10:41 722 16.5 9/19/2006 11:30 
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Path Measurement Data 
Site 1 Path 1 

Path Measurement Data 
Site 1 Path 2 

ppm*m pathlength timestamp ppm*m pathlength timestamp 
34.7 16 9/19/2006 10:41 259 16.5 9/19/2006 11:31 
34.3 16 9/19/2006 10:41 430 16.5 9/19/2006 11:31 
33.8 16 9/19/2006 10:42 389 16.5 9/19/2006 11:31 
33.9 16 9/19/2006 10:42 605 16.5 9/19/2006 11:31 
33.9 16 9/19/2006 10:42 395 16.5 9/19/2006 11:31 
33.9 16 9/19/2006 10:42 222 16.5 9/19/2006 11:31 
33.9 16 9/19/2006 10:42 61.5 16.5 9/19/2006 11:31 
34 16 9/19/2006 10:43 34.9 16.5 9/19/2006 11:31 

33.9 16 9/19/2006 10:43 34.4 16.5 9/19/2006 11:31 
33.8 16 9/19/2006 10:43 34.9 16.5 9/19/2006 11:31 
33.5 16 9/19/2006 10:43 34.4 16.5 9/19/2006 11:31 
33.5 16 9/19/2006 10:43 34.3 16.5 9/19/2006 11:31 
33.5 16 9/19/2006 10:43 34.5 16.5 9/19/2006 11:31 
33.6 16 9/19/2006 10:44 34.7 16.5 9/19/2006 11:31 
33.5 16 9/19/2006 10:44 34.6 16.5 9/19/2006 11:31 
33.5 16 9/19/2006 10:44 34.7 16.5 9/19/2006 11:31 
33.8 16 9/19/2006 10:44 34.1 16.5 9/19/2006 11:31 
33.7 16 9/19/2006 10:44 34.4 16.5 9/19/2006 11:31 
33.9 16 9/19/2006 10:44 34.4 16.5 9/19/2006 11:31 
33.6 16 9/19/2006 10:45 34.5 16.5 9/19/2006 11:31 
33.5 16 9/19/2006 10:45 34.3 16.5 9/19/2006 11:31 
33.6 16 9/19/2006 10:45 34.3 16.5 9/19/2006 11:31 
33.7 16 9/19/2006 10:45 34.3 16.5 9/19/2006 11:31 
33.7 16 9/19/2006 10:45 34.2 16.5 9/19/2006 11:31 
33.7 16 9/19/2006 10:45 34.3 16.5 9/19/2006 11:31 
33.9 16 9/19/2006 10:46 34.3 16.5 9/19/2006 11:31 
33.8 16 9/19/2006 10:46 34.3 16.5 9/19/2006 11:31 
34.2 16 9/19/2006 10:46 34.5 16.5 9/19/2006 11:31 
34.4 16 9/19/2006 10:46 34.4 16.5 9/19/2006 11:31 
34.3 16 9/19/2006 10:46 34.3 16.5 9/19/2006 11:31 
34.3 16 9/19/2006 10:46 34.3 16.5 9/19/2006 11:31 
34.2 16 9/19/2006 10:47 34.3 16.5 9/19/2006 11:31 
34.2 16 9/19/2006 10:47 34.4 16.5 9/19/2006 11:31 
34.3 16 9/19/2006 10:47 34.7 16.5 9/19/2006 11:31 
34.1 16 9/19/2006 10:47 34.5 16.5 9/19/2006 11:32 
34.2 16 9/19/2006 10:47 35.5 16.5 9/19/2006 11:32 
34.5 16 9/19/2006 10:48 36.9 16.5 9/19/2006 11:32 
34.5 16 9/19/2006 10:48 40.5 16.5 9/19/2006 11:32 
34.4 16 9/19/2006 10:48 38.8 16.5 9/19/2006 11:32 
34.4 16 9/19/2006 10:48 38.6 16.5 9/19/2006 11:32 
34.5 16 9/19/2006 10:48 43.3 16.5 9/19/2006 11:32 
34.5 16 9/19/2006 10:48 37.4 16.5 9/19/2006 11:32 
34.5 16 9/19/2006 10:49 36.4 16.5 9/19/2006 11:32 
34.6 16 9/19/2006 10:49 36.7 16.5 9/19/2006 11:32 
34.8 16 9/19/2006 10:49 36.8 16.5 9/19/2006 11:32 
34.9 16 9/19/2006 10:49 43.6 16.5 9/19/2006 11:32 
34.8 16 9/19/2006 10:49 38.4 16.5 9/19/2006 11:32 
36.5 16 9/19/2006 10:49 37.7 16.5 9/19/2006 11:32 
39.4 16 9/19/2006 10:50 41.1 16.5 9/19/2006 11:32 
34.8 16 9/19/2006 10:50 56.6 16.5 9/19/2006 11:32 
43.6 16 9/19/2006 10:50 35.6 16.5 9/19/2006 11:32 
60.1 16 9/19/2006 10:50 35.1 16.5 9/19/2006 11:32 
42.6 16 9/19/2006 10:50 34.8 16.5 9/19/2006 11:32 
36.7 16 9/19/2006 10:50 34.7 16.5 9/19/2006 11:32 
38.8 16 9/19/2006 10:51 34.5 16.5 9/19/2006 11:32 
38.4 16 9/19/2006 10:51 34.5 16.5 9/19/2006 11:32 
36.3 16 9/19/2006 10:51 34.6 16.5 9/19/2006 11:32 
35.2 16 9/19/2006 10:51 34.8 16.5 9/19/2006 11:32 
35.1 16 9/19/2006 10:51 34.9 16.5 9/19/2006 11:32 
35.1 16 9/19/2006 10:52 34.7 16.5 9/19/2006 11:32 
35 16 9/19/2006 10:52 34.7 16.5 9/19/2006 11:32 
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Path Measurement Data 
Site 1 Path 1 

Path Measurement Data 
Site 1 Path 2 

ppm*m pathlength timestamp ppm*m pathlength timestamp 
35.3 16 9/19/2006 10:52 34.7 16.5 9/19/2006 11:32 
35.3 16 9/19/2006 10:52 34.9 16.5 9/19/2006 11:32 
35.3 16 9/19/2006 10:52 34.8 16.5 9/19/2006 11:32 
35.2 16 9/19/2006 10:52 34.8 16.5 9/19/2006 11:32 
35.3 16 9/19/2006 10:53 34.8 16.5 9/19/2006 11:32 
35.3 16 9/19/2006 10:53 34.8 16.5 9/19/2006 11:32 
35.2 16 9/19/2006 10:53 34.8 16.5 9/19/2006 11:32 
35.3 16 9/19/2006 10:53 35 16.5 9/19/2006 11:32 
35.2 16 9/19/2006 10:53 35.8 16.5 9/19/2006 11:33 
35.3 16 9/19/2006 10:53 38.1 16.5 9/19/2006 11:33 
35.2 16 9/19/2006 10:54 41.5 16.5 9/19/2006 11:33 
35.3 16 9/19/2006 10:54 52.2 16.5 9/19/2006 11:33 
35.2 16 9/19/2006 10:54 55 16.5 9/19/2006 11:33 
35.1 16 9/19/2006 10:54 65.8 16.5 9/19/2006 11:33 
35.1 16 9/19/2006 10:54 65.2 16.5 9/19/2006 11:33 
35.1 16 9/19/2006 10:54 59 16.5 9/19/2006 11:33 
35.3 16 9/19/2006 10:55 56 16.5 9/19/2006 11:33 
35.4 16 9/19/2006 10:55 66.8 16.5 9/19/2006 11:33 
35.4 16 9/19/2006 10:55 65.6 16.5 9/19/2006 11:33 
35.3 16 9/19/2006 10:55 58.9 16.5 9/19/2006 11:33 
35.3 16 9/19/2006 10:55 51.1 16.5 9/19/2006 11:33 
35.3 16 9/19/2006 10:56 71.1 16.5 9/19/2006 11:33 
35.3 16 9/19/2006 10:56 85.6 16.5 9/19/2006 11:33 
35.3 16 9/19/2006 10:56 443 16.5 9/19/2006 11:33 
35.2 16 9/19/2006 10:56 230 16.5 9/19/2006 11:33 
35.3 16 9/19/2006 10:56 438 16.5 9/19/2006 11:33 
35.3 16 9/19/2006 10:56 70.5 16.5 9/19/2006 11:33 
35.2 16 9/19/2006 10:57 36.6 16.5 9/19/2006 11:33 
35.4 16 9/19/2006 10:57 38.9 16.5 9/19/2006 11:33 
35.4 16 9/19/2006 10:57 39.1 16.5 9/19/2006 11:33 
35.5 16 9/19/2006 10:57 36.9 16.5 9/19/2006 11:33 
35.6 16 9/19/2006 10:57 35.5 16.5 9/19/2006 11:33 
37.4 16 9/19/2006 10:57 36.4 16.5 9/19/2006 11:33 
48.9 16 9/19/2006 10:58 38.6 16.5 9/19/2006 11:33 
58.4 16 9/19/2006 10:58 41.2 16.5 9/19/2006 11:33 
42.3 16 9/19/2006 10:58 40.8 16.5 9/19/2006 11:33 
35.3 16 9/19/2006 10:58 41.9 16.5 9/19/2006 11:33 
35 16 9/19/2006 10:58 47 16.5 9/19/2006 11:33 

34.9 16 9/19/2006 10:58 60.5 16.5 9/19/2006 11:33 
34.9 16 9/19/2006 10:59 62.8 16.5 9/19/2006 11:33 
34.9 16 9/19/2006 10:59 54.6 16.5 9/19/2006 11:33 
35.1 16 9/19/2006 10:59 51.3 16.5 9/19/2006 11:33 
34.8 16 9/19/2006 10:59 46.6 16.5 9/19/2006 11:34 
34.8 16 9/19/2006 10:59 47.9 16.5 9/19/2006 11:34 
34.9 16 9/19/2006 11:00 46.7 16.5 9/19/2006 11:34 
34.7 16 9/19/2006 11:00 41.9 16.5 9/19/2006 11:34 
35 16 9/19/2006 11:00 41.9 16.5 9/19/2006 11:34 

34.8 16 9/19/2006 11:00 44.3 16.5 9/19/2006 11:34 
34.9 16 9/19/2006 11:00 44.8 16.5 9/19/2006 11:34 
35 16 9/19/2006 11:00 213 16.5 9/19/2006 11:34 

34.7 16 9/19/2006 11:01 84.1 16.5 9/19/2006 11:34 
34.2 16 9/19/2006 11:01 150 16.5 9/19/2006 11:34 
34.2 16 9/19/2006 11:01 123 16.5 9/19/2006 11:34 
34.2 16 9/19/2006 11:01 91 16.5 9/19/2006 11:34 
34.1 16 9/19/2006 11:01 72.1 16.5 9/19/2006 11:34 
34.1 16 9/19/2006 11:01 57.1 16.5 9/19/2006 11:34 
34.2 16 9/19/2006 11:02 65.6 16.5 9/19/2006 11:34 
34.3 16 9/19/2006 11:02 86.1 16.5 9/19/2006 11:34 
34.1 16 9/19/2006 11:02 68.2 16.5 9/19/2006 11:34 
34.1 16 9/19/2006 11:02 65.1 16.5 9/19/2006 11:34 
34.3 16 9/19/2006 11:02 72.3 16.5 9/19/2006 11:34 
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Path Measurement Data 
Site 1 Path 1 

Path Measurement Data 
Site 1 Path 2 

ppm*m pathlength timestamp ppm*m pathlength timestamp 
34.2 16 9/19/2006 11:02 76.2 16.5 9/19/2006 11:34 
34.3 16 9/19/2006 11:03 101 16.5 9/19/2006 11:34 
34.2 16 9/19/2006 11:03 118 16.5 9/19/2006 11:34 
34.2 16 9/19/2006 11:03 106 16.5 9/19/2006 11:34 
34.3 16 9/19/2006 11:03 120 16.5 9/19/2006 11:34 
34.3 16 9/19/2006 11:03 84.3 16.5 9/19/2006 11:34 
34.2 16 9/19/2006 11:04 133 16.5 9/19/2006 11:34 
34.3 16 9/19/2006 11:04 123 16.5 9/19/2006 11:34 
34.3 16 9/19/2006 11:04 124 16.5 9/19/2006 11:34 
34.3 16 9/19/2006 11:04 218 16.5 9/19/2006 11:34 
34.4 16 9/19/2006 11:04 79.8 16.5 9/19/2006 11:34 
34.4 16 9/19/2006 11:04 146 16.5 9/19/2006 11:34 
34.4 16 9/19/2006 11:05 195 16.5 9/19/2006 11:34 
34.2 16 9/19/2006 11:05 121 16.5 9/19/2006 11:34 
34.4 16 9/19/2006 11:05 131 16.5 9/19/2006 11:35 
34.7 16 9/19/2006 11:05 119 16.5 9/19/2006 11:35 
34.7 16 9/19/2006 11:05 108 16.5 9/19/2006 11:35 
34.9 16 9/19/2006 11:05 108 16.5 9/19/2006 11:35 
34.8 16 9/19/2006 11:06 100 16.5 9/19/2006 11:35 

   147 16.5 9/19/2006 11:35 
   210 16.5 9/19/2006 11:35 
   227 16.5 9/19/2006 11:35 
   176 16.5 9/19/2006 11:35 
   292 16.5 9/19/2006 11:35 
   298 16.5 9/19/2006 11:35 
   336 16.5 9/19/2006 11:35 
   306 16.5 9/19/2006 11:35 
   237 16.5 9/19/2006 11:35 
   363 16.5 9/19/2006 11:35 
   407 16.5 9/19/2006 11:35 
   379 16.5 9/19/2006 11:35 
   298 16.5 9/19/2006 11:35 
   205 16.5 9/19/2006 11:35 
   95.3 16.5 9/19/2006 11:35 
   84.3 16.5 9/19/2006 11:35 
   75.2 16.5 9/19/2006 11:35 
   74.6 16.5 9/19/2006 11:35 
   49.5 16.5 9/19/2006 11:35 
   44.6 16.5 9/19/2006 11:35 
   45.9 16.5 9/19/2006 11:35 
   53.4 16.5 9/19/2006 11:35 
   56.5 16.5 9/19/2006 11:35 
   49.7 16.5 9/19/2006 11:35 
   46.8 16.5 9/19/2006 11:35 
   43.7 16.5 9/19/2006 11:35 
   43.2 16.5 9/19/2006 11:35 
   41.2 16.5 9/19/2006 11:35 
   40.4 16.5 9/19/2006 11:35 
   39.7 16.5 9/19/2006 11:36 
   142 16.5 9/19/2006 11:36 
   141 16.5 9/19/2006 11:36 
   58.1 16.5 9/19/2006 11:36 
   229 16.5 9/19/2006 11:36 
   674 16.5 9/19/2006 11:36 
   353 16.5 9/19/2006 11:36 
   360 16.5 9/19/2006 11:36 
   843 16.5 9/19/2006 11:36 
   1220 16.5 9/19/2006 11:36 
   1108 16.5 9/19/2006 11:36 
   1801 16.5 9/19/2006 11:36 
   404 16.5 9/19/2006 11:36 
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Path Measurement Data 
Site 1 Path 1 

Path Measurement Data 
Site 1 Path 2 

ppm*m pathlength timestamp ppm*m pathlength timestamp 
   435 16.5 9/19/2006 11:36 
   233 16.5 9/19/2006 11:36 
   199 16.5 9/19/2006 11:36 
   135 16.5 9/19/2006 11:36 
   119 16.5 9/19/2006 11:36 
   77.4 16.5 9/19/2006 11:36 
   52.3 16.5 9/19/2006 11:36 
   55.2 16.5 9/19/2006 11:36 
   75 16.5 9/19/2006 11:36 
   47.1 16.5 9/19/2006 11:36 
   45.9 16.5 9/19/2006 11:36 
   44.2 16.5 9/19/2006 11:36 
   44.4 16.5 9/19/2006 11:36 
   53.8 16.5 9/19/2006 11:36 
   50.9 16.5 9/19/2006 11:36 
   63.3 16.5 9/19/2006 11:36 
   54.9 16.5 9/19/2006 11:36 
   87.2 16.5 9/19/2006 11:36 
   105 16.5 9/19/2006 11:36 
   56 16.5 9/19/2006 11:36 
   56.8 16.5 9/19/2006 11:36 
   64.4 16.5 9/19/2006 11:37 
   47.3 16.5 9/19/2006 11:37 
   42.7 16.5 9/19/2006 11:37 
   42.3 16.5 9/19/2006 11:37 
   42.1 16.5 9/19/2006 11:37 
   42.5 16.5 9/19/2006 11:37 
   42.3 16.5 9/19/2006 11:37 
   42.7 16.5 9/19/2006 11:37 
   42.4 16.5 9/19/2006 11:37 
   42.5 16.5 9/19/2006 11:37 
   43.9 16.5 9/19/2006 11:37 
   44.7 16.5 9/19/2006 11:37 
   42.6 16.5 9/19/2006 11:37 
   42.1 16.5 9/19/2006 11:37 
   42.6 16.5 9/19/2006 11:37 
   42.5 16.5 9/19/2006 11:37 
   42.8 16.5 9/19/2006 11:37 
   42 16.5 9/19/2006 11:37 
   42.3 16.5 9/19/2006 11:37 
   40.6 16.5 9/19/2006 11:37 
   40.8 16.5 9/19/2006 11:37 
   39.7 16.5 9/19/2006 11:37 
   38.4 16.5 9/19/2006 11:37 
   37.2 16.5 9/19/2006 11:37 
   36.5 16.5 9/19/2006 11:37 
   35.6 16.5 9/19/2006 11:37 
   35.5 16.5 9/19/2006 11:37 
   35.1 16.5 9/19/2006 11:37 
   35.1 16.5 9/19/2006 11:37 
   34.8 16.5 9/19/2006 11:37 
   34.6 16.5 9/19/2006 11:37 
   34.7 16.5 9/19/2006 11:37 
   34.6 16.5 9/19/2006 11:37 
   35 16.5 9/19/2006 11:37 
   34.9 16.5 9/19/2006 11:38 
   35.6 16.5 9/19/2006 11:38 
   36.3 16.5 9/19/2006 11:38 
   35.3 16.5 9/19/2006 11:38 
   34.6 16.5 9/19/2006 11:38 
   34.5 16.5 9/19/2006 11:38 
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Path Measurement Data 
Site 1 Path 1 

Path Measurement Data 
Site 1 Path 2 

ppm*m pathlength timestamp ppm*m pathlength timestamp 
   34.6 16.5 9/19/2006 11:38 
   34.8 16.5 9/19/2006 11:38 
   34.4 16.5 9/19/2006 11:38 
   34.5 16.5 9/19/2006 11:38 
   34.4 16.5 9/19/2006 11:38 
   34.4 16.5 9/19/2006 11:38 
   34.6 16.5 9/19/2006 11:38 
   34.5 16.5 9/19/2006 11:38 
   34.7 16.5 9/19/2006 11:38 
   34.6 16.5 9/19/2006 11:38 
   34.7 16.5 9/19/2006 11:38 
   34.8 16.5 9/19/2006 11:38 
   34.9 16.5 9/19/2006 11:38 
   34.8 16.5 9/19/2006 11:38 
   34.7 16.5 9/19/2006 11:38 
   34.7 16.5 9/19/2006 11:38 
   34.8 16.5 9/19/2006 11:38 
   34.8 16.5 9/19/2006 11:38 
   34.9 16.5 9/19/2006 11:38 
   34.7 16.5 9/19/2006 11:38 
   34.9 16.5 9/19/2006 11:38 
   34.7 16.5 9/19/2006 11:38 
   34.6 16.5 9/19/2006 11:38 
   34.8 16.5 9/19/2006 11:38 
   34.8 16.5 9/19/2006 11:38 
   34.7 16.5 9/19/2006 11:38 
   34.6 16.5 9/19/2006 11:38 
   34.6 16.5 9/19/2006 11:38 
   34.7 16.5 9/19/2006 11:39 
   34.6 16.5 9/19/2006 11:39 
   34.5 16.5 9/19/2006 11:39 
   34.7 16.5 9/19/2006 11:39 
   34.6 16.5 9/19/2006 11:39 
   37.4 16.5 9/19/2006 11:39 
   54.1 16.5 9/19/2006 11:39 
   88.4 16.5 9/19/2006 11:39 
   110 16.5 9/19/2006 11:39 
   371 16.5 9/19/2006 11:39 
   292 16.5 9/19/2006 11:39 
   477 16.5 9/19/2006 11:39 
   542 16.5 9/19/2006 11:39 
   377 16.5 9/19/2006 11:39 
   107 16.5 9/19/2006 11:39 
   61.5 16.5 9/19/2006 11:39 
   77.8 16.5 9/19/2006 11:39 
   76.9 16.5 9/19/2006 11:39 
   73 16.5 9/19/2006 11:39 
   120 16.5 9/19/2006 11:39 
   104 16.5 9/19/2006 11:39 
   114 16.5 9/19/2006 11:39 
   80.6 16.5 9/19/2006 11:39 
   58.2 16.5 9/19/2006 11:39 
   85.5 16.5 9/19/2006 11:39 
   66.6 16.5 9/19/2006 11:39 
   104 16.5 9/19/2006 11:39 
   92.8 16.5 9/19/2006 11:39 
   70.7 16.5 9/19/2006 11:39 
   55.7 16.5 9/19/2006 11:39 
   50.3 16.5 9/19/2006 11:39 
   64.1 16.5 9/19/2006 11:39 
   62.2 16.5 9/19/2006 11:39 
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Path Measurement Data 
Site 1 Path 1 

Path Measurement Data 
Site 1 Path 2 

ppm*m pathlength timestamp ppm*m pathlength timestamp 
   62 16.5 9/19/2006 11:39 
   62.4 16.5 9/19/2006 11:40 
   53.6 16.5 9/19/2006 11:40 
   47.8 16.5 9/19/2006 11:40 
   41.7 16.5 9/19/2006 11:40 
   46.2 16.5 9/19/2006 11:40 
   45.5 16.5 9/19/2006 11:40 
   139 16.5 9/19/2006 11:40 
   108 16.5 9/19/2006 11:40 
   110 16.5 9/19/2006 11:40 
   93.7 16.5 9/19/2006 11:40 
   84.2 16.5 9/19/2006 11:40 
   84.7 16.5 9/19/2006 11:40 
   104 16.5 9/19/2006 11:40 
   83 16.5 9/19/2006 11:40 
   110 16.5 9/19/2006 11:40 
   112 16.5 9/19/2006 11:40 
   174 16.5 9/19/2006 11:40 
   147 16.5 9/19/2006 11:40 
   164 16.5 9/19/2006 11:40 
   138 16.5 9/19/2006 11:40 
   104 16.5 9/19/2006 11:40 
   97.7 16.5 9/19/2006 11:40 
   546 16.5 9/19/2006 11:40 
   376 16.5 9/19/2006 11:40 
   304 16.5 9/19/2006 11:40 
   280 16.5 9/19/2006 11:40 
   83.7 16.5 9/19/2006 11:40 
   127 16.5 9/19/2006 11:40 
   81 16.5 9/19/2006 11:40 
   44 16.5 9/19/2006 11:40 
   79.8 16.5 9/19/2006 11:40 
   106 16.5 9/19/2006 11:40 
   100 16.5 9/19/2006 11:40 
   122 16.5 9/19/2006 11:41 
   71.8 16.5 9/19/2006 11:41 
   115 16.5 9/19/2006 11:41 
   95.1 16.5 9/19/2006 11:41 
   98 16.5 9/19/2006 11:41 
   111 16.5 9/19/2006 11:41 
   114 16.5 9/19/2006 11:41 
   102 16.5 9/19/2006 11:41 
   61.1 16.5 9/19/2006 11:41 
   65.9 16.5 9/19/2006 11:41 
   75.3 16.5 9/19/2006 11:41 
   90.7 16.5 9/19/2006 11:41 
   199 16.5 9/19/2006 11:41 
   171 16.5 9/19/2006 11:41 
   202 16.5 9/19/2006 11:41 
   173 16.5 9/19/2006 11:41 
   141 16.5 9/19/2006 11:41 
   87.8 16.5 9/19/2006 11:41 
   76.2 16.5 9/19/2006 11:41 
   58.9 16.5 9/19/2006 11:41 
   52 16.5 9/19/2006 11:41 
   45.5 16.5 9/19/2006 11:41 
   37.2 16.5 9/19/2006 11:41 
   44.5 16.5 9/19/2006 11:41 
   67.5 16.5 9/19/2006 11:41 
   93.5 16.5 9/19/2006 11:41 
   88.8 16.5 9/19/2006 11:41 
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Path Measurement Data 
Site 1 Path 1 

Path Measurement Data 
Site 1 Path 2 

ppm*m pathlength timestamp ppm*m pathlength timestamp 
   58.6 16.5 9/19/2006 11:41 
   86 16.5 9/19/2006 11:41 
   156 16.5 9/19/2006 11:41 
   98.1 16.5 9/19/2006 11:41 
   98.5 16.5 9/19/2006 11:41 
   122 16.5 9/19/2006 11:41 
   163 16.5 9/19/2006 11:41 
   231 16.5 9/19/2006 11:42 
   247 16.5 9/19/2006 11:42 
   277 16.5 9/19/2006 11:42 
   367 16.5 9/19/2006 11:42 
   315 16.5 9/19/2006 11:42 
   127 16.5 9/19/2006 11:42 
   62.7 16.5 9/19/2006 11:42 
   87.8 16.5 9/19/2006 11:42 
   118 16.5 9/19/2006 11:42 
   117 16.5 9/19/2006 11:42 
   102 16.5 9/19/2006 11:42 
   92.5 16.5 9/19/2006 11:42 
   102 16.5 9/19/2006 11:42 
   274 16.5 9/19/2006 11:42 
   187 16.5 9/19/2006 11:42 
   106 16.5 9/19/2006 11:42 
   94.9 16.5 9/19/2006 11:42 
   111 16.5 9/19/2006 11:42 
   300 16.5 9/19/2006 11:42 
   92.7 16.5 9/19/2006 11:42 
   95.5 16.5 9/19/2006 11:42 
   150 16.5 9/19/2006 11:42 
   154 16.5 9/19/2006 11:42 
   745 16.5 9/19/2006 11:42 
   1392 16.5 9/19/2006 11:42 
   983 16.5 9/19/2006 11:42 
   618 16.5 9/19/2006 11:42 
   633 16.5 9/19/2006 11:42 
   647 16.5 9/19/2006 11:42 
   416 16.5 9/19/2006 11:42 
   121 16.5 9/19/2006 11:42 
   76.5 16.5 9/19/2006 11:42 
   49 16.5 9/19/2006 11:42 
   45.3 16.5 9/19/2006 11:43 
   47 16.5 9/19/2006 11:43 
   71.9 16.5 9/19/2006 11:43 
   70.4 16.5 9/19/2006 11:43 
   84.5 16.5 9/19/2006 11:43 
   117 16.5 9/19/2006 11:43 
   101 16.5 9/19/2006 11:43 
   105 16.5 9/19/2006 11:43 
   100 16.5 9/19/2006 11:43 
   166 16.5 9/19/2006 11:43 
   96.3 16.5 9/19/2006 11:43 
   89 16.5 9/19/2006 11:43 
   149 16.5 9/19/2006 11:43 
   269 16.5 9/19/2006 11:43 
   385 16.5 9/19/2006 11:43 
   115 16.5 9/19/2006 11:43 
   77.6 16.5 9/19/2006 11:43 
   55.6 16.5 9/19/2006 11:43 
   42.3 16.5 9/19/2006 11:43 
   73.6 16.5 9/19/2006 11:43 
   463 16.5 9/19/2006 11:43 
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Path Measurement Data 
Site 1 Path 1 

Path Measurement Data 
Site 1 Path 2 

ppm*m pathlength timestamp ppm*m pathlength timestamp 
   336 16.5 9/19/2006 11:43 
   491 16.5 9/19/2006 11:43 
   178 16.5 9/19/2006 11:43 
   130 16.5 9/19/2006 11:43 
   219 16.5 9/19/2006 11:43 
   1381 16.5 9/19/2006 11:43 
   1003 16.5 9/19/2006 11:43 
   85.7 16.5 9/19/2006 11:43 
   79.3 16.5 9/19/2006 11:43 
   79.3 16.5 9/19/2006 11:43 
   98.4 16.5 9/19/2006 11:43 
   229 16.5 9/19/2006 11:43 
   123 16.5 9/19/2006 11:43 
   154 16.5 9/19/2006 11:44 
   125 16.5 9/19/2006 11:44 
   82.3 16.5 9/19/2006 11:44 
   50.5 16.5 9/19/2006 11:44 
   56 16.5 9/19/2006 11:44 
   53.6 16.5 9/19/2006 11:44 
   65.2 16.5 9/19/2006 11:44 
   74.1 16.5 9/19/2006 11:44 
   139 16.5 9/19/2006 11:44 
   147 16.5 9/19/2006 11:44 
   605 16.5 9/19/2006 11:44 
   276 16.5 9/19/2006 11:44 
   139 16.5 9/19/2006 11:44 
   120 16.5 9/19/2006 11:44 
   216 16.5 9/19/2006 11:44 
   144 16.5 9/19/2006 11:44 
   102 16.5 9/19/2006 11:44 
   71 16.5 9/19/2006 11:44 
   103 16.5 9/19/2006 11:44 
   105 16.5 9/19/2006 11:44 
   121 16.5 9/19/2006 11:44 
   75.3 16.5 9/19/2006 11:44 
   96.1 16.5 9/19/2006 11:44 
   81 16.5 9/19/2006 11:44 
   253 16.5 9/19/2006 11:44 
   171 16.5 9/19/2006 11:44 
   75.6 16.5 9/19/2006 11:44 
   87.3 16.5 9/19/2006 11:44 
   86.8 16.5 9/19/2006 11:44 
   87.9 16.5 9/19/2006 11:44 
   95.5 16.5 9/19/2006 11:44 
   111 16.5 9/19/2006 11:44 
   104 16.5 9/19/2006 11:44 
   96.3 16.5 9/19/2006 11:44 
   109 16.5 9/19/2006 11:45 
   164 16.5 9/19/2006 11:45 
   138 16.5 9/19/2006 11:45 
   150 16.5 9/19/2006 11:45 
   207 16.5 9/19/2006 11:45 
   215 16.5 9/19/2006 11:45 
   113 16.5 9/19/2006 11:45 
   120 16.5 9/19/2006 11:45 
   146 16.5 9/19/2006 11:45 
   210 16.5 9/19/2006 11:45 
   586 16.5 9/19/2006 11:45 
   542 16.5 9/19/2006 11:45 
   313 16.5 9/19/2006 11:45 
   171 16.5 9/19/2006 11:45 
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Path Measurement Data 
Site 1 Path 1 

Path Measurement Data 
Site 1 Path 2 

ppm*m pathlength timestamp ppm*m pathlength timestamp 
   97.8 16.5 9/19/2006 11:45 
   71.1 16.5 9/19/2006 11:45 
   65.2 16.5 9/19/2006 11:45 
   57.7 16.5 9/19/2006 11:45 
   54.6 16.5 9/19/2006 11:45 
   49.6 16.5 9/19/2006 11:45 
   41.8 16.5 9/19/2006 11:45 
   39.9 16.5 9/19/2006 11:45 
   41.8 16.5 9/19/2006 11:45 
   40.8 16.5 9/19/2006 11:45 
   40.2 16.5 9/19/2006 11:45 
   39.1 16.5 9/19/2006 11:45 
   38.7 16.5 9/19/2006 11:45 
   37.4 16.5 9/19/2006 11:45 
   37.2 16.5 9/19/2006 11:45 
   39.5 16.5 9/19/2006 11:45 
   38.8 16.5 9/19/2006 11:45 
   44.1 16.5 9/19/2006 11:45 
   46.7 16.5 9/19/2006 11:45 
   60.2 16.5 9/19/2006 11:46 
   148 16.5 9/19/2006 11:46 
   69.1 16.5 9/19/2006 11:46 
   45.4 16.5 9/19/2006 11:46 
   54.1 16.5 9/19/2006 11:46 
   59.2 16.5 9/19/2006 11:46 
   60.3 16.5 9/19/2006 11:46 
   56 16.5 9/19/2006 11:46 
   192 16.5 9/19/2006 11:46 
   529 16.5 9/19/2006 11:46 
   570 16.5 9/19/2006 11:46 
   121 16.5 9/19/2006 11:46 
   44.8 16.5 9/19/2006 11:46 
   36.6 16.5 9/19/2006 11:46 
   35.4 16.5 9/19/2006 11:46 
   34.8 16.5 9/19/2006 11:46 
   34.9 16.5 9/19/2006 11:46 
   34.9 16.5 9/19/2006 11:46 
   34.6 16.5 9/19/2006 11:46 
   34.6 16.5 9/19/2006 11:46 
   34.6 16.5 9/19/2006 11:46 
   34.3 16.5 9/19/2006 11:46 
   34.4 16.5 9/19/2006 11:46 
   34.2 16.5 9/19/2006 11:46 
   34.2 16.5 9/19/2006 11:46 
   36.4 16.5 9/19/2006 11:46 
   37.7 16.5 9/19/2006 11:46 
   41.8 16.5 9/19/2006 11:46 
   49.1 16.5 9/19/2006 11:46 
   75.1 16.5 9/19/2006 11:46 
   59.2 16.5 9/19/2006 11:46 
   63.1 16.5 9/19/2006 11:46 
   51.5 16.5 9/19/2006 11:46 
   100 16.5 9/19/2006 11:46 
   88.7 16.5 9/19/2006 11:47 
   101 16.5 9/19/2006 11:47 
   93.1 16.5 9/19/2006 11:47 
   82.9 16.5 9/19/2006 11:47 
   87.8 16.5 9/19/2006 11:47 
   95.1 16.5 9/19/2006 11:47 
   70.9 16.5 9/19/2006 11:47 
   64.6 16.5 9/19/2006 11:47 
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Path Measurement Data 
Site 1 Path 1 

Path Measurement Data 
Site 1 Path 2 

ppm*m pathlength timestamp ppm*m pathlength timestamp 
   71.8 16.5 9/19/2006 11:47 
   53.9 16.5 9/19/2006 11:47 
   63.5 16.5 9/19/2006 11:47 
   51.9 16.5 9/19/2006 11:47 
   65 16.5 9/19/2006 11:47 
   59.5 16.5 9/19/2006 11:47 
   72.5 16.5 9/19/2006 11:47 
   113 16.5 9/19/2006 11:47 
   113 16.5 9/19/2006 11:47 
   102 16.5 9/19/2006 11:47 
   92.7 16.5 9/19/2006 11:47 
   88.4 16.5 9/19/2006 11:47 
   54.3 16.5 9/19/2006 11:47 
   72.2 16.5 9/19/2006 11:47 
   52.9 16.5 9/19/2006 11:47 
   43.7 16.5 9/19/2006 11:47 
   153 16.5 9/19/2006 11:47 
   852 16.5 9/19/2006 11:47 
   2333 16.5 9/19/2006 11:47 
   2252 16.5 9/19/2006 11:47 
   1908 16.5 9/19/2006 11:47 
   1170 16.5 9/19/2006 11:47 
   484 16.5 9/19/2006 11:47 
   166 16.5 9/19/2006 11:47 
   195 16.5 9/19/2006 11:47 
   121 16.5 9/19/2006 11:47 
   80.4 16.5 9/19/2006 11:48 
   40.2 16.5 9/19/2006 11:48 
   36.5 16.5 9/19/2006 11:48 
   35.7 16.5 9/19/2006 11:48 
   34.3 16.5 9/19/2006 11:48 
   34.2 16.5 9/19/2006 11:48 
   36.7 16.5 9/19/2006 11:48 
   41.4 16.5 9/19/2006 11:48 
   40.6 16.5 9/19/2006 11:48 
   46.2 16.5 9/19/2006 11:48 
   46.5 16.5 9/19/2006 11:48 
   48.2 16.5 9/19/2006 11:48 
   43.2 16.5 9/19/2006 11:48 
   41 16.5 9/19/2006 11:48 
   40 16.5 9/19/2006 11:48 
   50.3 16.5 9/19/2006 11:48 
   82.2 16.5 9/19/2006 11:48 
   210 16.5 9/19/2006 11:48 
   407 16.5 9/19/2006 11:48 
   729 16.5 9/19/2006 11:48 
   891 16.5 9/19/2006 11:48 
   815 16.5 9/19/2006 11:48 
   553 16.5 9/19/2006 11:48 
   88.8 16.5 9/19/2006 11:48 
   42.5 16.5 9/19/2006 11:48 
   218 16.5 9/19/2006 11:48 
   353 16.5 9/19/2006 11:48 
   286 16.5 9/19/2006 11:48 
   77.5 16.5 9/19/2006 11:48 
   99.1 16.5 9/19/2006 11:48 
   109 16.5 9/19/2006 11:48 
   68.2 16.5 9/19/2006 11:48 
   92.2 16.5 9/19/2006 11:48 
   89.6 16.5 9/19/2006 11:48 
   56 16.5 9/19/2006 11:49 
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Path Measurement Data 
Site 1 Path 1 

Path Measurement Data 
Site 1 Path 2 

ppm*m pathlength timestamp ppm*m pathlength timestamp 
   62.6 16.5 9/19/2006 11:49 
   86.2 16.5 9/19/2006 11:49 
   114 16.5 9/19/2006 11:49 
   96.8 16.5 9/19/2006 11:49 
   93 16.5 9/19/2006 11:49 
   80.9 16.5 9/19/2006 11:49 
   96.4 16.5 9/19/2006 11:49 
   103 16.5 9/19/2006 11:49 
   79.8 16.5 9/19/2006 11:49 
   92.5 16.5 9/19/2006 11:49 
   185 16.5 9/19/2006 11:49 
   222 16.5 9/19/2006 11:49 
   108 16.5 9/19/2006 11:49 
   169 16.5 9/19/2006 11:49 
   161 16.5 9/19/2006 11:49 
   111 16.5 9/19/2006 11:49 
   189 16.5 9/19/2006 11:49 
   802 16.5 9/19/2006 11:49 
   322 16.5 9/19/2006 11:49 
   138 16.5 9/19/2006 11:49 
   116 16.5 9/19/2006 11:49 
   170 16.5 9/19/2006 11:49 
   152 16.5 9/19/2006 11:49 
   138 16.5 9/19/2006 11:49 
   149 16.5 9/19/2006 11:49 
   152 16.5 9/19/2006 11:49 
   133 16.5 9/19/2006 11:49 
   121 16.5 9/19/2006 11:49 
   139 16.5 9/19/2006 11:49 
   118 16.5 9/19/2006 11:49 
   116 16.5 9/19/2006 11:49 
   93.8 16.5 9/19/2006 11:49 
   67 16.5 9/19/2006 11:50 
   62.7 16.5 9/19/2006 11:50 
   78.2 16.5 9/19/2006 11:50 
   250 16.5 9/19/2006 11:50 
   382 16.5 9/19/2006 11:50 
   473 16.5 9/19/2006 11:50 
   362 16.5 9/19/2006 11:50 
   255 16.5 9/19/2006 11:50 
   142 16.5 9/19/2006 11:50 
   118 16.5 9/19/2006 11:50 
   50.3 16.5 9/19/2006 11:50 
   69.1 16.5 9/19/2006 11:50 
   99.2 16.5 9/19/2006 11:50 
   95.4 16.5 9/19/2006 11:50 
   98.3 16.5 9/19/2006 11:50 
   87.2 16.5 9/19/2006 11:50 
   53.3 16.5 9/19/2006 11:50 
   64.3 16.5 9/19/2006 11:50 
   81 16.5 9/19/2006 11:50 
   53.8 16.5 9/19/2006 11:50 
   48 16.5 9/19/2006 11:50 
   66.5 16.5 9/19/2006 11:50 
   56.4 16.5 9/19/2006 11:50 
   63.7 16.5 9/19/2006 11:50 
   65.1 16.5 9/19/2006 11:50 
   58 16.5 9/19/2006 11:50 
   47.2 16.5 9/19/2006 11:50 
   70.9 16.5 9/19/2006 11:50 
   94.9 16.5 9/19/2006 11:50 
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Path Measurement Data 
Site 1 Path 1 

Path Measurement Data 
Site 1 Path 2 

ppm*m pathlength timestamp ppm*m pathlength timestamp 
   86.5 16.5 9/19/2006 11:50 
   132 16.5 9/19/2006 11:50 
   124 16.5 9/19/2006 11:50 
   100 16.5 9/19/2006 11:50 
   106 16.5 9/19/2006 11:50 
   105 16.5 9/19/2006 11:50 
   179 16.5 9/19/2006 11:51 
   188 16.5 9/19/2006 11:51 
   109 16.5 9/19/2006 11:51 
   193 16.5 9/19/2006 11:51 
   1153 16.5 9/19/2006 11:51 
   2281 16.5 9/19/2006 11:51 
   290 16.5 9/19/2006 11:51 
   44.1 16.5 9/19/2006 11:51 
   47.4 16.5 9/19/2006 11:51 
   91.8 16.5 9/19/2006 11:51 
   218 16.5 9/19/2006 11:51 
   142 16.5 9/19/2006 11:51 
   77.2 16.5 9/19/2006 11:51 
   148 16.5 9/19/2006 11:51 
   650 16.5 9/19/2006 11:51 
   1000 16.5 9/19/2006 11:51 
   776 16.5 9/19/2006 11:51 
   244 16.5 9/19/2006 11:51 
   411 16.5 9/19/2006 11:51 
   447 16.5 9/19/2006 11:51 
   2077 16.5 9/19/2006 11:51 
   623 16.5 9/19/2006 11:51 
   461 16.5 9/19/2006 11:51 
   500 16.5 9/19/2006 11:51 
   1195 16.5 9/19/2006 11:51 
   443 16.5 9/19/2006 11:51 
   315 16.5 9/19/2006 11:51 
   250 16.5 9/19/2006 11:51 
   259 16.5 9/19/2006 11:51 
   316 16.5 9/19/2006 11:51 
   330 16.5 9/19/2006 11:51 
   336 16.5 9/19/2006 11:51 
   198 16.5 9/19/2006 11:51 
   237 16.5 9/19/2006 11:52 
   206 16.5 9/19/2006 11:52 
   268 16.5 9/19/2006 11:52 
   274 16.5 9/19/2006 11:52 
   164 16.5 9/19/2006 11:52 
   97.9 16.5 9/19/2006 11:52 
   98.7 16.5 9/19/2006 11:52 
   114 16.5 9/19/2006 11:52 
   82.9 16.5 9/19/2006 11:52 
   93.7 16.5 9/19/2006 11:52 
   107 16.5 9/19/2006 11:52 
   76.1 16.5 9/19/2006 11:52 
   75.7 16.5 9/19/2006 11:52 
   64.9 16.5 9/19/2006 11:52 
   53 16.5 9/19/2006 11:52 
   40.7 16.5 9/19/2006 11:52 
   39.9 16.5 9/19/2006 11:52 
   41.8 16.5 9/19/2006 11:52 
   45.4 16.5 9/19/2006 11:52 
   54.5 16.5 9/19/2006 11:52 
   53 16.5 9/19/2006 11:52 
   73.8 16.5 9/19/2006 11:52 

163



Path Measurement Data 
Site 1 Path 1 

Path Measurement Data 
Site 1 Path 2 

ppm*m pathlength timestamp ppm*m pathlength timestamp 
   73.4 16.5 9/19/2006 11:52 
   48.3 16.5 9/19/2006 11:52 
   48.3 16.5 9/19/2006 11:52 
   81.2 16.5 9/19/2006 11:52 
   137 16.5 9/19/2006 11:52 
   83.7 16.5 9/19/2006 11:52 
   68.8 16.5 9/19/2006 11:52 
   53.4 16.5 9/19/2006 11:52 
   47.8 16.5 9/19/2006 11:52 
   38.3 16.5 9/19/2006 11:52 
   36.5 16.5 9/19/2006 11:52 
   36.3 16.5 9/19/2006 11:52 
   35.5 16.5 9/19/2006 11:53 
   35.6 16.5 9/19/2006 11:53 
   35.4 16.5 9/19/2006 11:53 
   35.4 16.5 9/19/2006 11:53 
   35.6 16.5 9/19/2006 11:53 
   36.6 16.5 9/19/2006 11:53 
   39.5 16.5 9/19/2006 11:53 
   38.2 16.5 9/19/2006 11:53 
   37.4 16.5 9/19/2006 11:53 
   37.8 16.5 9/19/2006 11:53 
   38.4 16.5 9/19/2006 11:53 
   38.5 16.5 9/19/2006 11:53 
   39 16.5 9/19/2006 11:53 
   41.7 16.5 9/19/2006 11:53 
   41 16.5 9/19/2006 11:53 
   41.5 16.5 9/19/2006 11:53 
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Path Measurement Data 
Site 1 Path 3 

Path Measurement Data 
Site 1 Path 4 

ppm*m pathlength timestamp ppm*m pathlength timestamp 
1122 21 9/19/2006 12:00 178 19.5 9/19/2006 12:24 
751 21 9/19/2006 12:00 209 19.5 9/19/2006 12:24 
879 21 9/19/2006 12:00 569 19.5 9/19/2006 12:24 
811 21 9/19/2006 12:00 247 19.5 9/19/2006 12:24 
836 21 9/19/2006 12:00 162 19.5 9/19/2006 12:24 
528 21 9/19/2006 12:00 164 19.5 9/19/2006 12:24 
366 21 9/19/2006 12:00 130 19.5 9/19/2006 12:24 
990 21 9/19/2006 12:00 152 19.5 9/19/2006 12:24 

1345 21 9/19/2006 12:00 181 19.5 9/19/2006 12:24 
442 21 9/19/2006 12:00 171 19.5 9/19/2006 12:24 
372 21 9/19/2006 12:00 170 19.5 9/19/2006 12:24 
338 21 9/19/2006 12:00 168 19.5 9/19/2006 12:24 
229 21 9/19/2006 12:00 155 19.5 9/19/2006 12:24 
152 21 9/19/2006 12:00 169 19.5 9/19/2006 12:24 
77.1 21 9/19/2006 12:00 168 19.5 9/19/2006 12:24 
51.3 21 9/19/2006 12:00 204 19.5 9/19/2006 12:24 
45.2 21 9/19/2006 12:00 229 19.5 9/19/2006 12:24 
44.3 21 9/19/2006 12:01 197 19.5 9/19/2006 12:24 
47.7 21 9/19/2006 12:01 181 19.5 9/19/2006 12:24 
62.3 21 9/19/2006 12:01 225 19.5 9/19/2006 12:24 
49.3 21 9/19/2006 12:01 211 19.5 9/19/2006 12:24 
45.1 21 9/19/2006 12:01 179 19.5 9/19/2006 12:24 
45.8 21 9/19/2006 12:01 158 19.5 9/19/2006 12:24 
47.3 21 9/19/2006 12:01 161 19.5 9/19/2006 12:24 
48.5 21 9/19/2006 12:01 127 19.5 9/19/2006 12:24 
53.5 21 9/19/2006 12:01 86.2 19.5 9/19/2006 12:25 
53.7 21 9/19/2006 12:01 59.5 19.5 9/19/2006 12:25 
49.6 21 9/19/2006 12:01 43.2 19.5 9/19/2006 12:25 
51.7 21 9/19/2006 12:01 40.2 19.5 9/19/2006 12:25 
47.1 21 9/19/2006 12:01 40.6 19.5 9/19/2006 12:25 
45.3 21 9/19/2006 12:01 42.1 19.5 9/19/2006 12:25 
50.1 21 9/19/2006 12:01 43 19.5 9/19/2006 12:25 
53.9 21 9/19/2006 12:01 43.4 19.5 9/19/2006 12:25 
57.4 21 9/19/2006 12:01 43.5 19.5 9/19/2006 12:25 
57.9 21 9/19/2006 12:01 42.3 19.5 9/19/2006 12:25 
50.9 21 9/19/2006 12:01 41.4 19.5 9/19/2006 12:25 
52.6 21 9/19/2006 12:01 41.3 19.5 9/19/2006 12:25 
51.4 21 9/19/2006 12:01 46.4 19.5 9/19/2006 12:25 
47.2 21 9/19/2006 12:01 69.3 19.5 9/19/2006 12:25 
49.8 21 9/19/2006 12:01 101 19.5 9/19/2006 12:25 
49.3 21 9/19/2006 12:01 117 19.5 9/19/2006 12:25 
50.1 21 9/19/2006 12:01 189 19.5 9/19/2006 12:25 
50.6 21 9/19/2006 12:01 121 19.5 9/19/2006 12:25 
52.5 21 9/19/2006 12:01 56.6 19.5 9/19/2006 12:25 
51.5 21 9/19/2006 12:01 42.8 19.5 9/19/2006 12:25 
52 21 9/19/2006 12:01 44.2 19.5 9/19/2006 12:25 

53.5 21 9/19/2006 12:01 57.8 19.5 9/19/2006 12:25 
53.6 21 9/19/2006 12:01 124 19.5 9/19/2006 12:25 
53.2 21 9/19/2006 12:01 117 19.5 9/19/2006 12:25 
50.9 21 9/19/2006 12:01 518 19.5 9/19/2006 12:25 
47.9 21 9/19/2006 12:01 465 19.5 9/19/2006 12:25 
47.3 21 9/19/2006 12:02 165 19.5 9/19/2006 12:25 
47.5 21 9/19/2006 12:02 76.7 19.5 9/19/2006 12:25 
48.8 21 9/19/2006 12:02 52.5 19.5 9/19/2006 12:25 
48.8 21 9/19/2006 12:02 54.4 19.5 9/19/2006 12:25 
46.9 21 9/19/2006 12:02 45.4 19.5 9/19/2006 12:25 
45.9 21 9/19/2006 12:02 62.2 19.5 9/19/2006 12:25 
45.2 21 9/19/2006 12:02 77.5 19.5 9/19/2006 12:25 
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Path Measurement Data 
Site 1 Path 3 

Path Measurement Data 
Site 1 Path 4 

ppm*m pathlength timestamp ppm*m pathlength timestamp 
44.8 21 9/19/2006 12:02 83.3 19.5 9/19/2006 12:26 
45.4 21 9/19/2006 12:02 154 19.5 9/19/2006 12:26 
45.3 21 9/19/2006 12:02 749 19.5 9/19/2006 12:26 
45.2 21 9/19/2006 12:02 452 19.5 9/19/2006 12:26 
45.3 21 9/19/2006 12:02 365 19.5 9/19/2006 12:26 
45.6 21 9/19/2006 12:02 407 19.5 9/19/2006 12:26 
45.2 21 9/19/2006 12:02 313 19.5 9/19/2006 12:26 
45 21 9/19/2006 12:02 447 19.5 9/19/2006 12:26 

44.2 21 9/19/2006 12:02 305 19.5 9/19/2006 12:26 
44 21 9/19/2006 12:02 226 19.5 9/19/2006 12:26 

44.1 21 9/19/2006 12:02 299 19.5 9/19/2006 12:26 
44.6 21 9/19/2006 12:02 130 19.5 9/19/2006 12:26 
44.2 21 9/19/2006 12:02 144 19.5 9/19/2006 12:26 
44.6 21 9/19/2006 12:02 84.9 19.5 9/19/2006 12:26 
44.6 21 9/19/2006 12:02 229 19.5 9/19/2006 12:26 
44.4 21 9/19/2006 12:02 82.6 19.5 9/19/2006 12:26 
44.8 21 9/19/2006 12:02 60.1 19.5 9/19/2006 12:26 
44.4 21 9/19/2006 12:02 56.4 19.5 9/19/2006 12:26 
44.2 21 9/19/2006 12:02 50.1 19.5 9/19/2006 12:26 
44.2 21 9/19/2006 12:02 47.3 19.5 9/19/2006 12:26 
44 21 9/19/2006 12:02 50.1 19.5 9/19/2006 12:26 

44.1 21 9/19/2006 12:02 63.2 19.5 9/19/2006 12:26 
44 21 9/19/2006 12:02 96.7 19.5 9/19/2006 12:26 

43.7 21 9/19/2006 12:02 136 19.5 9/19/2006 12:26 
43.7 21 9/19/2006 12:02 85.9 19.5 9/19/2006 12:26 
43.7 21 9/19/2006 12:02 65.7 19.5 9/19/2006 12:26 
43.4 21 9/19/2006 12:03 50 19.5 9/19/2006 12:26 
43.4 21 9/19/2006 12:03 77.1 19.5 9/19/2006 12:26 
43.5 21 9/19/2006 12:03 90.6 19.5 9/19/2006 12:26 
43.6 21 9/19/2006 12:03 132 19.5 9/19/2006 12:26 
43.5 21 9/19/2006 12:03 115 19.5 9/19/2006 12:26 
43.6 21 9/19/2006 12:03 120 19.5 9/19/2006 12:26 
43.5 21 9/19/2006 12:03 133 19.5 9/19/2006 12:26 
43.4 21 9/19/2006 12:03 81.2 19.5 9/19/2006 12:26 
43.5 21 9/19/2006 12:03 47.9 19.5 9/19/2006 12:27 
43.6 21 9/19/2006 12:03 43.4 19.5 9/19/2006 12:27 
43.3 21 9/19/2006 12:03 41.8 19.5 9/19/2006 12:27 
43.5 21 9/19/2006 12:03 45.1 19.5 9/19/2006 12:27 
43.2 21 9/19/2006 12:03 44.3 19.5 9/19/2006 12:27 
43.3 21 9/19/2006 12:03 42.7 19.5 9/19/2006 12:27 
43.1 21 9/19/2006 12:03 42.1 19.5 9/19/2006 12:27 
43 21 9/19/2006 12:03 41.5 19.5 9/19/2006 12:27 

43.4 21 9/19/2006 12:03 42.2 19.5 9/19/2006 12:27 
43.5 21 9/19/2006 12:03 42 19.5 9/19/2006 12:27 
43.3 21 9/19/2006 12:03 41.7 19.5 9/19/2006 12:27 
43.5 21 9/19/2006 12:03 41.2 19.5 9/19/2006 12:27 
43.7 21 9/19/2006 12:03 42.2 19.5 9/19/2006 12:27 
43.4 21 9/19/2006 12:03 42 19.5 9/19/2006 12:27 
43.6 21 9/19/2006 12:03 41.6 19.5 9/19/2006 12:27 
43.8 21 9/19/2006 12:03 41.8 19.5 9/19/2006 12:27 
43.7 21 9/19/2006 12:03 41.1 19.5 9/19/2006 12:27 
44 21 9/19/2006 12:03 40.3 19.5 9/19/2006 12:27 

44.2 21 9/19/2006 12:03 40.9 19.5 9/19/2006 12:27 
44 21 9/19/2006 12:03 42.2 19.5 9/19/2006 12:27 

43.6 21 9/19/2006 12:03 42.2 19.5 9/19/2006 12:27 
43.9 21 9/19/2006 12:03 44.1 19.5 9/19/2006 12:27 
44 21 9/19/2006 12:03 49.7 19.5 9/19/2006 12:27 

43.7 21 9/19/2006 12:03 75.5 19.5 9/19/2006 12:27 
43.6 21 9/19/2006 12:03 53.5 19.5 9/19/2006 12:27 
43.5 21 9/19/2006 12:03 50 19.5 9/19/2006 12:27 
43.3 21 9/19/2006 12:03 47.3 19.5 9/19/2006 12:27 
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Path Measurement Data 
Site 1 Path 3 

Path Measurement Data 
Site 1 Path 4 

ppm*m pathlength timestamp ppm*m pathlength timestamp 
43.6 21 9/19/2006 12:04 48.3 19.5 9/19/2006 12:27 
43.5 21 9/19/2006 12:04 48.2 19.5 9/19/2006 12:27 
43.4 21 9/19/2006 12:04 50.3 19.5 9/19/2006 12:27 
43.3 21 9/19/2006 12:04 53.4 19.5 9/19/2006 12:27 
43.4 21 9/19/2006 12:04 56.9 19.5 9/19/2006 12:27 
43.2 21 9/19/2006 12:04 57.2 19.5 9/19/2006 12:27 
43.2 21 9/19/2006 12:04 54.3 19.5 9/19/2006 12:27 
43.2 21 9/19/2006 12:04 54.8 19.5 9/19/2006 12:28 
43.6 21 9/19/2006 12:04 59 19.5 9/19/2006 12:28 
43.3 21 9/19/2006 12:04 61.1 19.5 9/19/2006 12:28 
43.3 21 9/19/2006 12:04 63 19.5 9/19/2006 12:28 
43.4 21 9/19/2006 12:04 64.3 19.5 9/19/2006 12:28 
43.2 21 9/19/2006 12:04 60.9 19.5 9/19/2006 12:28 
44.6 21 9/19/2006 12:04 61 19.5 9/19/2006 12:28 
44.8 21 9/19/2006 12:04 59.6 19.5 9/19/2006 12:28 
44.8 21 9/19/2006 12:04 57.9 19.5 9/19/2006 12:28 
51.1 21 9/19/2006 12:04 56.8 19.5 9/19/2006 12:28 
52.4 21 9/19/2006 12:04 60.1 19.5 9/19/2006 12:28 
62.3 21 9/19/2006 12:04 63.7 19.5 9/19/2006 12:28 
57.6 21 9/19/2006 12:04 64 19.5 9/19/2006 12:28 
64.2 21 9/19/2006 12:04 63.7 19.5 9/19/2006 12:28 
344 21 9/19/2006 12:04 62.5 19.5 9/19/2006 12:28 
709 21 9/19/2006 12:04 59.6 19.5 9/19/2006 12:28 
192 21 9/19/2006 12:04 58 19.5 9/19/2006 12:28 
57.5 21 9/19/2006 12:04 55.2 19.5 9/19/2006 12:28 
47.9 21 9/19/2006 12:04 425 19.5 9/19/2006 12:28 
49.7 21 9/19/2006 12:04 373 19.5 9/19/2006 12:28 
47.4 21 9/19/2006 12:04 261 19.5 9/19/2006 12:28 
62.1 21 9/19/2006 12:04 208 19.5 9/19/2006 12:28 
54.7 21 9/19/2006 12:04 184 19.5 9/19/2006 12:28 
90.1 21 9/19/2006 12:04 176 19.5 9/19/2006 12:28 
80.4 21 9/19/2006 12:04 108 19.5 9/19/2006 12:28 
265 21 9/19/2006 12:04 102 19.5 9/19/2006 12:28 
82.1 21 9/19/2006 12:04 157 19.5 9/19/2006 12:29 
128 21 9/19/2006 12:05 177 19.5 9/19/2006 12:29 
304 21 9/19/2006 12:05 128 19.5 9/19/2006 12:29 
551 21 9/19/2006 12:05 105 19.5 9/19/2006 12:29 
427 21 9/19/2006 12:05 170 19.5 9/19/2006 12:29 
209 21 9/19/2006 12:05 136 19.5 9/19/2006 12:29 
145 21 9/19/2006 12:05 289 19.5 9/19/2006 12:29 
156 21 9/19/2006 12:05 704 19.5 9/19/2006 12:29 
160 21 9/19/2006 12:05 175 19.5 9/19/2006 12:29 
135 21 9/19/2006 12:05 137 19.5 9/19/2006 12:29 
92.8 21 9/19/2006 12:05 162 19.5 9/19/2006 12:29 
68.3 21 9/19/2006 12:05 228 19.5 9/19/2006 12:29 
57.8 21 9/19/2006 12:05 798 19.5 9/19/2006 12:29 
51.7 21 9/19/2006 12:05 688 19.5 9/19/2006 12:29 
51.1 21 9/19/2006 12:05 594 19.5 9/19/2006 12:29 
56.5 21 9/19/2006 12:05 453 19.5 9/19/2006 12:29 
63.7 21 9/19/2006 12:05 86.5 19.5 9/19/2006 12:29 
51.8 21 9/19/2006 12:05 49.7 19.5 9/19/2006 12:29 
48.7 21 9/19/2006 12:05 67.8 19.5 9/19/2006 12:29 
47.3 21 9/19/2006 12:05 133 19.5 9/19/2006 12:29 
52.4 21 9/19/2006 12:05 1064 19.5 9/19/2006 12:29 
51.3 21 9/19/2006 12:05 393 19.5 9/19/2006 12:29 
52 21 9/19/2006 12:05 277 19.5 9/19/2006 12:29 

51.9 21 9/19/2006 12:05 235 19.5 9/19/2006 12:29 
50 21 9/19/2006 12:05 159 19.5 9/19/2006 12:29 

49.2 21 9/19/2006 12:05 109 19.5 9/19/2006 12:29 
48.6 21 9/19/2006 12:05 113 19.5 9/19/2006 12:29 
48.5 21 9/19/2006 12:05 63.1 19.5 9/19/2006 12:29 
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Path Measurement Data 
Site 1 Path 3 

Path Measurement Data 
Site 1 Path 4 

ppm*m pathlength timestamp ppm*m pathlength timestamp 
47.3 21 9/19/2006 12:05 41.4 19.5 9/19/2006 12:29 
47.3 21 9/19/2006 12:05 40.8 19.5 9/19/2006 12:29 
47.6 21 9/19/2006 12:05 40.5 19.5 9/19/2006 12:29 
48 21 9/19/2006 12:05 40.4 19.5 9/19/2006 12:29 

48.5 21 9/19/2006 12:05 42.8 19.5 9/19/2006 12:29 
50.1 21 9/19/2006 12:05 51 19.5 9/19/2006 12:30 
50.4 21 9/19/2006 12:06 50.5 19.5 9/19/2006 12:30 
51 21 9/19/2006 12:06 45.1 19.5 9/19/2006 12:30 

50.9 21 9/19/2006 12:06 42.4 19.5 9/19/2006 12:30 
51.3 21 9/19/2006 12:06 41.2 19.5 9/19/2006 12:30 
51.9 21 9/19/2006 12:06 41.1 19.5 9/19/2006 12:30 
53.7 21 9/19/2006 12:06 40.5 19.5 9/19/2006 12:30 
54.7 21 9/19/2006 12:06 39.7 19.5 9/19/2006 12:30 
53.3 21 9/19/2006 12:06 39.7 19.5 9/19/2006 12:30 
53.6 21 9/19/2006 12:06 39.8 19.5 9/19/2006 12:30 
52.7 21 9/19/2006 12:06 39.8 19.5 9/19/2006 12:30 
51.9 21 9/19/2006 12:06 39.3 19.5 9/19/2006 12:30 
53.1 21 9/19/2006 12:06 39.6 19.5 9/19/2006 12:30 
52.1 21 9/19/2006 12:06 39.6 19.5 9/19/2006 12:30 
52.5 21 9/19/2006 12:06 39.7 19.5 9/19/2006 12:30 
56.4 21 9/19/2006 12:06 40 19.5 9/19/2006 12:30 
55.8 21 9/19/2006 12:06 40 19.5 9/19/2006 12:30 
55 21 9/19/2006 12:06 39.8 19.5 9/19/2006 12:30 

55.4 21 9/19/2006 12:06 40 19.5 9/19/2006 12:30 
54.7 21 9/19/2006 12:06 39.8 19.5 9/19/2006 12:30 
52.1 21 9/19/2006 12:06 39.8 19.5 9/19/2006 12:30 
51.6 21 9/19/2006 12:06 39.9 19.5 9/19/2006 12:30 
53.8 21 9/19/2006 12:06 39.7 19.5 9/19/2006 12:30 
69.2 21 9/19/2006 12:06 39.9 19.5 9/19/2006 12:30 
100 21 9/19/2006 12:06 39.8 19.5 9/19/2006 12:30 
84.2 21 9/19/2006 12:06 39.6 19.5 9/19/2006 12:30 
81 21 9/19/2006 12:06 39.7 19.5 9/19/2006 12:30 

91.6 21 9/19/2006 12:06 39.7 19.5 9/19/2006 12:31 
158 21 9/19/2006 12:06 41.4 19.5 9/19/2006 12:31 
158 21 9/19/2006 12:06 41.6 19.5 9/19/2006 12:31 
208 21 9/19/2006 12:06 41.3 19.5 9/19/2006 12:31 
145 21 9/19/2006 12:06 41.2 19.5 9/19/2006 12:31 
87.5 21 9/19/2006 12:06 41.8 19.5 9/19/2006 12:31 
95.9 21 9/19/2006 12:06 42.3 19.5 9/19/2006 12:32 
74.3 21 9/19/2006 12:06 42.3 19.5 9/19/2006 12:32 
49.4 21 9/19/2006 12:06 42.3 19.5 9/19/2006 12:32 
47.8 21 9/19/2006 12:07 42.6 19.5 9/19/2006 12:32 
47.2 21 9/19/2006 12:07 43.2 19.5 9/19/2006 12:32 
47.1 21 9/19/2006 12:07 44 19.5 9/19/2006 12:32 
46.9 21 9/19/2006 12:07 43.7 19.5 9/19/2006 12:32 
46.3 21 9/19/2006 12:07 44 19.5 9/19/2006 12:32 
46.7 21 9/19/2006 12:07 43.8 19.5 9/19/2006 12:32 
46.6 21 9/19/2006 12:07 43.5 19.5 9/19/2006 12:32 
45.4 21 9/19/2006 12:07 44.3 19.5 9/19/2006 12:32 
44.8 21 9/19/2006 12:07 44.3 19.5 9/19/2006 12:32 
45.1 21 9/19/2006 12:07 44.2 19.5 9/19/2006 12:32 
45 21 9/19/2006 12:07 44.2 19.5 9/19/2006 12:32 

44.8 21 9/19/2006 12:07 44.9 19.5 9/19/2006 12:32 
44.2 21 9/19/2006 12:07 46.1 19.5 9/19/2006 12:32 
44.1 21 9/19/2006 12:07    
43.9 21 9/19/2006 12:07    
44.3 21 9/19/2006 12:07    
44.2 21 9/19/2006 12:07    
44.5 21 9/19/2006 12:07    
44 21 9/19/2006 12:07    

44.1 21 9/19/2006 12:07    
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Path Measurement Data 
Site 1 Path 3 

Path Measurement Data 
Site 1 Path 4 

ppm*m pathlength timestamp ppm*m pathlength timestamp 
43.9 21 9/19/2006 12:07    
43.9 21 9/19/2006 12:07    
44 21 9/19/2006 12:07    

44.3 21 9/19/2006 12:07    
44.1 21 9/19/2006 12:07    
44.2 21 9/19/2006 12:07    
44.7 21 9/19/2006 12:07    
44.6 21 9/19/2006 12:07    
44.3 21 9/19/2006 12:07    
44.3 21 9/19/2006 12:07    
44 21 9/19/2006 12:07    

44.4 21 9/19/2006 12:07    
44.4 21 9/19/2006 12:07    
44.4 21 9/19/2006 12:08    
44.3 21 9/19/2006 12:08    
44.2 21 9/19/2006 12:08    
44.3 21 9/19/2006 12:08    
44.1 21 9/19/2006 12:08    
44.3 21 9/19/2006 12:08    
43.9 21 9/19/2006 12:08    
44 21 9/19/2006 12:08    

44.4 21 9/19/2006 12:08    
44.3 21 9/19/2006 12:08    
44.2 21 9/19/2006 12:08    
44.8 21 9/19/2006 12:08    
44.9 21 9/19/2006 12:08    
44.7 21 9/19/2006 12:08    
44.7 21 9/19/2006 12:08    
55.3 21 9/19/2006 12:08    
124 21 9/19/2006 12:08    
203 21 9/19/2006 12:08    
212 21 9/19/2006 12:08    
253 21 9/19/2006 12:08    
186 21 9/19/2006 12:08    
161 21 9/19/2006 12:08    
184 21 9/19/2006 12:08    
114 21 9/19/2006 12:08    
68.5 21 9/19/2006 12:08    
66.5 21 9/19/2006 12:08    
84.4 21 9/19/2006 12:08    
78.3 21 9/19/2006 12:08    
57.9 21 9/19/2006 12:08    
53.8 21 9/19/2006 12:08    
46 21 9/19/2006 12:08    
45 21 9/19/2006 12:08    

44.7 21 9/19/2006 12:08    
43.7 21 9/19/2006 12:08    
43.4 21 9/19/2006 12:09    
43.3 21 9/19/2006 12:09    
43.6 21 9/19/2006 12:09    
43.4 21 9/19/2006 12:09    
43.6 21 9/19/2006 12:09    
43.4 21 9/19/2006 12:09    
43.9 21 9/19/2006 12:09    
46 21 9/19/2006 12:09    

49.6 21 9/19/2006 12:09    
48.5 21 9/19/2006 12:09    
47 21 9/19/2006 12:09    

50.1 21 9/19/2006 12:09    
58.8 21 9/19/2006 12:09    
58.1 21 9/19/2006 12:09    
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Path Measurement Data 
Site 1 Path 3 

Path Measurement Data 
Site 1 Path 4 

ppm*m pathlength timestamp ppm*m pathlength timestamp 
50.7 21 9/19/2006 12:09    
50.8 21 9/19/2006 12:09    
50.1 21 9/19/2006 12:09    
46.4 21 9/19/2006 12:09    
45.5 21 9/19/2006 12:09    
45.2 21 9/19/2006 12:09    
55.8 21 9/19/2006 12:09    
46.6 21 9/19/2006 12:09    
52.8 21 9/19/2006 12:09    
63.5 21 9/19/2006 12:09    
82.2 21 9/19/2006 12:09    
253 21 9/19/2006 12:09    
176 21 9/19/2006 12:09    
135 21 9/19/2006 12:09    
48.7 21 9/19/2006 12:09    
45.4 21 9/19/2006 12:09    
44.6 21 9/19/2006 12:09    
44.5 21 9/19/2006 12:09    
49.5 21 9/19/2006 12:09    
51.1 21 9/19/2006 12:09    
60.1 21 9/19/2006 12:10    
56.9 21 9/19/2006 12:10    
51.2 21 9/19/2006 12:10    
58.2 21 9/19/2006 12:10    
141 21 9/19/2006 12:10    
191 21 9/19/2006 12:10    
229 21 9/19/2006 12:10    
97.5 21 9/19/2006 12:10    
66.5 21 9/19/2006 12:10    
355 21 9/19/2006 12:10    
61 21 9/19/2006 12:10    

61.8 21 9/19/2006 12:10    
59.1 21 9/19/2006 12:10    
51.2 21 9/19/2006 12:10    
48.5 21 9/19/2006 12:10    
46.9 21 9/19/2006 12:10    
47.6 21 9/19/2006 12:10    
45.2 21 9/19/2006 12:10    
46.1 21 9/19/2006 12:10    
45.6 21 9/19/2006 12:10    
46.2 21 9/19/2006 12:10    
45.1 21 9/19/2006 12:10    
45.7 21 9/19/2006 12:10    
43.9 21 9/19/2006 12:10    
44 21 9/19/2006 12:10    

44.2 21 9/19/2006 12:10    
43.8 21 9/19/2006 12:10    
43.8 21 9/19/2006 12:10    
47.5 21 9/19/2006 12:10    
56.7 21 9/19/2006 12:10    
54.5 21 9/19/2006 12:10    
50.8 21 9/19/2006 12:10    
50 21 9/19/2006 12:10    

49.1 21 9/19/2006 12:10    
48.2 21 9/19/2006 12:11    
49 21 9/19/2006 12:11    

49.6 21 9/19/2006 12:11    
47.9 21 9/19/2006 12:11    
45.9 21 9/19/2006 12:11    
44.4 21 9/19/2006 12:11    
43.7 21 9/19/2006 12:11    
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Path Measurement Data 
Site 1 Path 3 

Path Measurement Data 
Site 1 Path 4 

ppm*m pathlength timestamp ppm*m pathlength timestamp 
44.2 21 9/19/2006 12:11    
54.4 21 9/19/2006 12:11    
49.2 21 9/19/2006 12:11    
50.1 21 9/19/2006 12:11    
58.6 21 9/19/2006 12:11    
73.1 21 9/19/2006 12:11    
91.3 21 9/19/2006 12:11    
67.6 21 9/19/2006 12:11    
58.3 21 9/19/2006 12:11    
65.6 21 9/19/2006 12:11    
51.3 21 9/19/2006 12:11    
45.7 21 9/19/2006 12:11    
46.4 21 9/19/2006 12:11    
59.9 21 9/19/2006 12:11    
131 21 9/19/2006 12:11    
189 21 9/19/2006 12:11    
333 21 9/19/2006 12:11    
78.3 21 9/19/2006 12:11    
45.9 21 9/19/2006 12:11    
49.8 21 9/19/2006 12:11    
44.6 21 9/19/2006 12:11    
44.1 21 9/19/2006 12:11    
44.1 21 9/19/2006 12:11    
54.9 21 9/19/2006 12:11    
51.4 21 9/19/2006 12:11    
43.7 21 9/19/2006 12:11    
305 21 9/19/2006 12:12    
203 21 9/19/2006 12:12    
43.7 21 9/19/2006 12:12    
43.6 21 9/19/2006 12:12    
43.7 21 9/19/2006 12:12    
43.5 21 9/19/2006 12:12    
43.4 21 9/19/2006 12:12    
43.6 21 9/19/2006 12:12    
43.5 21 9/19/2006 12:12    
43.6 21 9/19/2006 12:12    
43.6 21 9/19/2006 12:12    
43.7 21 9/19/2006 12:12    
43.9 21 9/19/2006 12:12    
43.6 21 9/19/2006 12:12    
43.6 21 9/19/2006 12:12    
43.4 21 9/19/2006 12:12    
43.7 21 9/19/2006 12:12    
43.5 21 9/19/2006 12:12    
43.5 21 9/19/2006 12:12    
43.5 21 9/19/2006 12:12    
43.6 21 9/19/2006 12:12    
43.3 21 9/19/2006 12:12    
43.7 21 9/19/2006 12:12    
43.5 21 9/19/2006 12:12    
43.8 21 9/19/2006 12:12    
43.7 21 9/19/2006 12:12    
43.7 21 9/19/2006 12:12    
43.6 21 9/19/2006 12:12    
43.9 21 9/19/2006 12:12    
43.8 21 9/19/2006 12:12    
43.6 21 9/19/2006 12:12    
43.5 21 9/19/2006 12:12    
44 21 9/19/2006 12:12    
44 21 9/19/2006 12:12    

44.2 21 9/19/2006 12:12    
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Path Measurement Data 
Site 1 Path 3 

Path Measurement Data 
Site 1 Path 4 

ppm*m pathlength timestamp ppm*m pathlength timestamp 
44.1 21 9/19/2006 12:13    
43.7 21 9/19/2006 12:13    
44 21 9/19/2006 12:13    

43.7 21 9/19/2006 12:13    
44.2 21 9/19/2006 12:13    
44.4 21 9/19/2006 12:13    
45.1 21 9/19/2006 12:13    
45.7 21 9/19/2006 12:13    
45.4 21 9/19/2006 12:13    
46.1 21 9/19/2006 12:13    
47.3 21 9/19/2006 12:13    
47.1 21 9/19/2006 12:13    
46.8 21 9/19/2006 12:13    
46.4 21 9/19/2006 12:13    
46.1 21 9/19/2006 12:13    
46.7 21 9/19/2006 12:13    
46.1 21 9/19/2006 12:13    
46 21 9/19/2006 12:13    

45.9 21 9/19/2006 12:13    
45.4 21 9/19/2006 12:13    
45.4 21 9/19/2006 12:13    
45.4 21 9/19/2006 12:13    
45.4 21 9/19/2006 12:13    
45.1 21 9/19/2006 12:13    
45.2 21 9/19/2006 12:13    
45.1 21 9/19/2006 12:13    
45.2 21 9/19/2006 12:13    
45.3 21 9/19/2006 12:13    
45.4 21 9/19/2006 12:13    
45.6 21 9/19/2006 12:13    
45.6 21 9/19/2006 12:13    
45.7 21 9/19/2006 12:13    
46.1 21 9/19/2006 12:13    
45.7 21 9/19/2006 12:14    
45.6 21 9/19/2006 12:14    
45.8 21 9/19/2006 12:14    
46.2 21 9/19/2006 12:14    
46 21 9/19/2006 12:14    

46.1 21 9/19/2006 12:14    
46.2 21 9/19/2006 12:14    
46.1 21 9/19/2006 12:14    
46.1 21 9/19/2006 12:14    
46 21 9/19/2006 12:14    

45.6 21 9/19/2006 12:14    
46 21 9/19/2006 12:14    

47.6 21 9/19/2006 12:14    
47.2 21 9/19/2006 12:14    
46 21 9/19/2006 12:14    

46.1 21 9/19/2006 12:14    
45.7 21 9/19/2006 12:14    
45.6 21 9/19/2006 12:14    
45.6 21 9/19/2006 12:14    
45.7 21 9/19/2006 12:14    
45.3 21 9/19/2006 12:14    
44.8 21 9/19/2006 12:14    
44.7 21 9/19/2006 12:14    
44.7 21 9/19/2006 12:14    
44.5 21 9/19/2006 12:14    
44 21 9/19/2006 12:14    

43.5 21 9/19/2006 12:14    
43.5 21 9/19/2006 12:14    
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Path Measurement Data 
Site 1 Path 3 

Path Measurement Data 
Site 1 Path 4 

ppm*m pathlength timestamp ppm*m pathlength timestamp 
43.7 21 9/19/2006 12:14    
43.4 21 9/19/2006 12:14    
43.3 21 9/19/2006 12:14    
43.1 21 9/19/2006 12:14    
43.4 21 9/19/2006 12:14    
43 21 9/19/2006 12:15    

43.2 21 9/19/2006 12:15    
43.4 21 9/19/2006 12:15    
43.4 21 9/19/2006 12:15    
95.1 21 9/19/2006 12:15    
137 21 9/19/2006 12:15    
78.2 21 9/19/2006 12:15    
243 21 9/19/2006 12:15    
247 21 9/19/2006 12:15    
154 21 9/19/2006 12:15    
125 21 9/19/2006 12:15    
98.2 21 9/19/2006 12:15    
88.4 21 9/19/2006 12:15    
82.9 21 9/19/2006 12:15    
84.5 21 9/19/2006 12:15    
65.4 21 9/19/2006 12:15    
61.3 21 9/19/2006 12:15    
60.1 21 9/19/2006 12:15    
60 21 9/19/2006 12:15    

64.7 21 9/19/2006 12:15    
68.2 21 9/19/2006 12:15    
65.5 21 9/19/2006 12:15    
50.8 21 9/19/2006 12:15    
55.8 21 9/19/2006 12:15    
79.5 21 9/19/2006 12:15    
100 21 9/19/2006 12:15    
250 21 9/19/2006 12:15    
274 21 9/19/2006 12:15    
268 21 9/19/2006 12:15    
308 21 9/19/2006 12:15    
49.3 21 9/19/2006 12:15    
44.9 21 9/19/2006 12:15    
44.3 21 9/19/2006 12:15    
43.8 21 9/19/2006 12:15    
43.9 21 9/19/2006 12:16    
44 21 9/19/2006 12:16    

44.1 21 9/19/2006 12:16    
44.5 21 9/19/2006 12:16    
44.2 21 9/19/2006 12:16    
44 21 9/19/2006 12:16    
44 21 9/19/2006 12:16    

44.2 21 9/19/2006 12:16    
44.4 21 9/19/2006 12:16    
44.4 21 9/19/2006 12:16    
45.4 21 9/19/2006 12:16    
55.7 21 9/19/2006 12:16    
71.5 21 9/19/2006 12:16    
81.5 21 9/19/2006 12:16    
78.5 21 9/19/2006 12:16    
51.1 21 9/19/2006 12:16    
59.5 21 9/19/2006 12:16    
61.8 21 9/19/2006 12:16    
62.4 21 9/19/2006 12:16    
82 21 9/19/2006 12:16    

72.3 21 9/19/2006 12:16    
70.9 21 9/19/2006 12:16    
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Path Measurement Data 
Site 1 Path 3 

Path Measurement Data 
Site 1 Path 4 

ppm*m pathlength timestamp ppm*m pathlength timestamp 
69.7 21 9/19/2006 12:16    
54.5 21 9/19/2006 12:16    
49.2 21 9/19/2006 12:16    
46.6 21 9/19/2006 12:16    
46.2 21 9/19/2006 12:16    
45.3 21 9/19/2006 12:16    
45.8 21 9/19/2006 12:16    
48.8 21 9/19/2006 12:16    
48.5 21 9/19/2006 12:16    
49.6 21 9/19/2006 12:16    
49.2 21 9/19/2006 12:16    
47.7 21 9/19/2006 12:16    
48.4 21 9/19/2006 12:17    
48.2 21 9/19/2006 12:17    
48.7 21 9/19/2006 12:17    
47.7 21 9/19/2006 12:17    
47.4 21 9/19/2006 12:17    
47.7 21 9/19/2006 12:17    
45 21 9/19/2006 12:17    

44.5 21 9/19/2006 12:17    
44.6 21 9/19/2006 12:17    
44.5 21 9/19/2006 12:17    
44.7 21 9/19/2006 12:17    
44.7 21 9/19/2006 12:17    
44.5 21 9/19/2006 12:17    
59.5 21 9/19/2006 12:17    
58 21 9/19/2006 12:17    

46.2 21 9/19/2006 12:17    
51.2 21 9/19/2006 12:17    
50.6 21 9/19/2006 12:17    
61.2 21 9/19/2006 12:17    
65.1 21 9/19/2006 12:17    
71 21 9/19/2006 12:17    

64.1 21 9/19/2006 12:17    
125 21 9/19/2006 12:17    
198 21 9/19/2006 12:17    
259 21 9/19/2006 12:17    
119 21 9/19/2006 12:17    
252 21 9/19/2006 12:17    
676 21 9/19/2006 12:17    
233 21 9/19/2006 12:17    
249 21 9/19/2006 12:17    
192 21 9/19/2006 12:17    
129 21 9/19/2006 12:17    
68.5 21 9/19/2006 12:17    
89.6 21 9/19/2006 12:18    
67.4 21 9/19/2006 12:18    
65.8 21 9/19/2006 12:18    
56.8 21 9/19/2006 12:18    
59.5 21 9/19/2006 12:18    
47.3 21 9/19/2006 12:18    
44.2 21 9/19/2006 12:18    
44.3 21 9/19/2006 12:18    
44.2 21 9/19/2006 12:18    
47 21 9/19/2006 12:18    

44.9 21 9/19/2006 12:18    
45.4 21 9/19/2006 12:18    
44.3 21 9/19/2006 12:18    
45.2 21 9/19/2006 12:18    
47.3 21 9/19/2006 12:18    
48.6 21 9/19/2006 12:18    
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Path Measurement Data 
Site 1 Path 3 

Path Measurement Data 
Site 1 Path 4 

ppm*m pathlength timestamp ppm*m pathlength timestamp 
47.8 21 9/19/2006 12:18    
48.6 21 9/19/2006 12:18    
48 21 9/19/2006 12:18    

47.8 21 9/19/2006 12:18    
47.2 21 9/19/2006 12:18    
46.8 21 9/19/2006 12:18    
47.1 21 9/19/2006 12:18    
46.7 21 9/19/2006 12:18    
46.9 21 9/19/2006 12:18    
46.3 21 9/19/2006 12:18    
46.3 21 9/19/2006 12:18    
46 21 9/19/2006 12:18    

45.7 21 9/19/2006 12:18    
45.5 21 9/19/2006 12:18    
45.2 21 9/19/2006 12:18    
44.6 21 9/19/2006 12:18    
44.6 21 9/19/2006 12:18    
44.7 21 9/19/2006 12:18    
44.1 21 9/19/2006 12:18    
44.2 21 9/19/2006 12:19    
44 21 9/19/2006 12:19    
46 21 9/19/2006 12:19    

47.6 21 9/19/2006 12:19    
49.1 21 9/19/2006 12:19    
48.8 21 9/19/2006 12:19    
48.2 21 9/19/2006 12:19    
47.7 21 9/19/2006 12:19    
47.7 21 9/19/2006 12:19    
47.5 21 9/19/2006 12:19    
47.8 21 9/19/2006 12:19    
48.6 21 9/19/2006 12:19    
54.6 21 9/19/2006 12:19    
67.8 21 9/19/2006 12:19    
96.6 21 9/19/2006 12:19    
142 21 9/19/2006 12:19    
131 21 9/19/2006 12:19    
189 21 9/19/2006 12:19    
151 21 9/19/2006 12:19    
127 21 9/19/2006 12:19    
121 21 9/19/2006 12:19    
216 21 9/19/2006 12:19    
641 21 9/19/2006 12:19    
220 21 9/19/2006 12:19    
105 21 9/19/2006 12:19    
98.7 21 9/19/2006 12:19    
115 21 9/19/2006 12:19    
126 21 9/19/2006 12:19    
103 21 9/19/2006 12:19    
90.8 21 9/19/2006 12:19    
75.3 21 9/19/2006 12:19    
51.2 21 9/19/2006 12:19    
45.2 21 9/19/2006 12:19    
45 21 9/19/2006 12:20    

44.8 21 9/19/2006 12:20    
44.8 21 9/19/2006 12:20    
44.7 21 9/19/2006 12:20    
44 21 9/19/2006 12:20    

 

175



Path Measurement Data 
Site 2 Path 1 

Path Measurement Data 
Site 2 Path 2 

ppm*m pathlength 
Timestamp 

(Eastern time) ppm*m pathlength 
Timestamp 

(Eastern time) 
1531 12 9/19/2006 15:29 535 13.5 9/19/2006 15:59 
1362 12 9/19/2006 15:29 280 13.5 9/19/2006 15:59 
979 12 9/19/2006 15:29 249 13.5 9/19/2006 15:59 
575 12 9/19/2006 15:29 347 13.5 9/19/2006 15:59 
474 12 9/19/2006 15:29 270 13.5 9/19/2006 15:59 

1946 12 9/19/2006 15:29 209 13.5 9/19/2006 15:59 
2397 12 9/19/2006 15:29 179 13.5 9/19/2006 15:59 
1652 12 9/19/2006 15:29 155 13.5 9/19/2006 15:59 
428 12 9/19/2006 15:29 188 13.5 9/19/2006 15:59 
337 12 9/19/2006 15:29 103 13.5 9/19/2006 15:59 
385 12 9/19/2006 15:29 56.3 13.5 9/19/2006 15:59 
806 12 9/19/2006 15:29 44.4 13.5 9/19/2006 15:59 
266 12 9/19/2006 15:29 38.2 13.5 9/19/2006 15:59 

1120 12 9/19/2006 15:29 35.7 13.5 9/19/2006 15:59 
2096 12 9/19/2006 15:29 32.3 13.5 9/19/2006 15:59 
1880 12 9/19/2006 15:29 32.5 13.5 9/19/2006 15:59 
890 12 9/19/2006 15:29 33 13.5 9/19/2006 15:59 
176 12 9/19/2006 15:29 32.5 13.5 9/19/2006 15:59 
84.9 12 9/19/2006 15:29 32.8 13.5 9/19/2006 15:59 
487 12 9/19/2006 15:29 33.3 13.5 9/19/2006 15:59 
470 12 9/19/2006 15:29 33.7 13.5 9/19/2006 15:59 
306 12 9/19/2006 15:29 37.3 13.5 9/19/2006 15:59 
930 12 9/19/2006 15:29 173 13.5 9/19/2006 16:00 

1129 12 9/19/2006 15:29 460 13.5 9/19/2006 16:00 
1192 12 9/19/2006 15:29 312 13.5 9/19/2006 16:00 
671 12 9/19/2006 15:29 121 13.5 9/19/2006 16:00 
656 12 9/19/2006 15:29 175 13.5 9/19/2006 16:00 
875 12 9/19/2006 15:29 283 13.5 9/19/2006 16:00 

1605 12 9/19/2006 15:30 64.3 13.5 9/19/2006 16:00 
1396 12 9/19/2006 15:30 41.4 13.5 9/19/2006 16:00 
1569 12 9/19/2006 15:30 38 13.5 9/19/2006 16:00 
1716 12 9/19/2006 15:30 36.2 13.5 9/19/2006 16:00 
1752 12 9/19/2006 15:30 34 13.5 9/19/2006 16:00 
1292 12 9/19/2006 15:30 31.9 13.5 9/19/2006 16:00 
1352 12 9/19/2006 15:30 32 13.5 9/19/2006 16:00 
1703 12 9/19/2006 15:30 32.2 13.5 9/19/2006 16:00 
1096 12 9/19/2006 15:30 49.9 13.5 9/19/2006 16:00 
867 12 9/19/2006 15:30 72.6 13.5 9/19/2006 16:00 

1598 12 9/19/2006 15:30 132 13.5 9/19/2006 16:00 
1024 12 9/19/2006 15:30 239 13.5 9/19/2006 16:00 
1002 12 9/19/2006 15:30 207 13.5 9/19/2006 16:00 
221 12 9/19/2006 15:30 117 13.5 9/19/2006 16:00 
625 12 9/19/2006 15:30 301 13.5 9/19/2006 16:00 
430 12 9/19/2006 15:30 230 13.5 9/19/2006 16:00 
237 12 9/19/2006 15:30 279 13.5 9/19/2006 16:00 
199 12 9/19/2006 15:30 254 13.5 9/19/2006 16:00 
433 12 9/19/2006 15:30 353 13.5 9/19/2006 16:00 
154 12 9/19/2006 15:30 282 13.5 9/19/2006 16:00 
517 12 9/19/2006 15:30 180 13.5 9/19/2006 16:00 
248 12 9/19/2006 15:31 130 13.5 9/19/2006 16:00 
209 12 9/19/2006 15:31 91.5 13.5 9/19/2006 16:00 
135 12 9/19/2006 15:31 82.3 13.5 9/19/2006 16:00 
613 12 9/19/2006 15:31 43.4 13.5 9/19/2006 16:00 
646 12 9/19/2006 15:31 43.1 13.5 9/19/2006 16:00 
168 12 9/19/2006 15:31 38.9 13.5 9/19/2006 16:00 
158 12 9/19/2006 15:31 37.2 13.5 9/19/2006 16:01 
133 12 9/19/2006 15:31 37.4 13.5 9/19/2006 16:01 
62.9 12 9/19/2006 15:31 37.8 13.5 9/19/2006 16:01 
75.6 12 9/19/2006 15:31 35.3 13.5 9/19/2006 16:01 
638 12 9/19/2006 15:31 34.5 13.5 9/19/2006 16:01 
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Path Measurement Data 
Site 2 Path 1 

Path Measurement Data 
Site 2 Path 2 

ppm*m pathlength 
Timestamp 

(Eastern time) ppm*m pathlength 
Timestamp 

(Eastern time) 
409 12 9/19/2006 15:31 33.7 13.5 9/19/2006 16:01 
289 12 9/19/2006 15:31 34.4 13.5 9/19/2006 16:01 
142 12 9/19/2006 15:32 34.6 13.5 9/19/2006 16:01 
100 12 9/19/2006 15:32 33.5 13.5 9/19/2006 16:01 
93.1 12 9/19/2006 15:32 32.1 13.5 9/19/2006 16:01 
323 12 9/19/2006 15:32 31.6 13.5 9/19/2006 16:01 
98.9 12 9/19/2006 15:32 31.8 13.5 9/19/2006 16:01 
683 12 9/19/2006 15:32 31.7 13.5 9/19/2006 16:01 

1255 12 9/19/2006 15:32 31.8 13.5 9/19/2006 16:01 
991 12 9/19/2006 15:32 32.1 13.5 9/19/2006 16:01 
583 12 9/19/2006 15:32 32 13.5 9/19/2006 16:01 
883 12 9/19/2006 15:32 119 13.5 9/19/2006 16:01 
990 12 9/19/2006 15:32 474 13.5 9/19/2006 16:01 
199 12 9/19/2006 15:32 564 13.5 9/19/2006 16:01 
678 12 9/19/2006 15:32 582 13.5 9/19/2006 16:01 
565 12 9/19/2006 15:32 313 13.5 9/19/2006 16:01 
759 12 9/19/2006 15:32 296 13.5 9/19/2006 16:01 
950 12 9/19/2006 15:32 208 13.5 9/19/2006 16:01 

1167 12 9/19/2006 15:32 82.6 13.5 9/19/2006 16:01 
2431 12 9/19/2006 15:32 63.6 13.5 9/19/2006 16:01 
1009 12 9/19/2006 15:32 52.5 13.5 9/19/2006 16:01 
1810 12 9/19/2006 15:32 43.8 13.5 9/19/2006 16:01 
1571 12 9/19/2006 15:32 41.3 13.5 9/19/2006 16:01 
1286 12 9/19/2006 15:32 50.7 13.5 9/19/2006 16:01 
1416 12 9/19/2006 15:32 52 13.5 9/19/2006 16:01 
2080 12 9/19/2006 15:32 52.5 13.5 9/19/2006 16:01 
1157 12 9/19/2006 15:32 53.2 13.5 9/19/2006 16:01 
1665 12 9/19/2006 15:32 50.2 13.5 9/19/2006 16:01 
2319 12 9/19/2006 15:32 52.3 13.5 9/19/2006 16:01 
1304 12 9/19/2006 15:32 52.5 13.5 9/19/2006 16:02 
1227 12 9/19/2006 15:32 62 13.5 9/19/2006 16:02 
1242 12 9/19/2006 15:32 79.3 13.5 9/19/2006 16:02 
586 12 9/19/2006 15:32 165 13.5 9/19/2006 16:02 

1191 12 9/19/2006 15:32 392 13.5 9/19/2006 16:02 
2017 12 9/19/2006 15:32 289 13.5 9/19/2006 16:02 
1209 12 9/19/2006 15:33 184 13.5 9/19/2006 16:02 
959 12 9/19/2006 15:33 143 13.5 9/19/2006 16:02 

2229 12 9/19/2006 15:33 584 13.5 9/19/2006 16:02 
1113 12 9/19/2006 15:33 477 13.5 9/19/2006 16:02 
1617 12 9/19/2006 15:33 376 13.5 9/19/2006 16:02 
1470 12 9/19/2006 15:33 76.7 13.5 9/19/2006 16:02 
1561 12 9/19/2006 15:33 127 13.5 9/19/2006 16:02 
1472 12 9/19/2006 15:33 751 13.5 9/19/2006 16:02 
2376 12 9/19/2006 15:33 223 13.5 9/19/2006 16:02 
1158 12 9/19/2006 15:33 550 13.5 9/19/2006 16:02 
874 12 9/19/2006 15:33 422 13.5 9/19/2006 16:02 

1392 12 9/19/2006 15:33 359 13.5 9/19/2006 16:02 
1625 12 9/19/2006 15:33 278 13.5 9/19/2006 16:02 
1646 12 9/19/2006 15:33 265 13.5 9/19/2006 16:02 
2199 12 9/19/2006 15:33 283 13.5 9/19/2006 16:02 
2136 12 9/19/2006 15:33 372 13.5 9/19/2006 16:02 
1234 12 9/19/2006 15:33 320 13.5 9/19/2006 16:02 
944 12 9/19/2006 15:33 174 13.5 9/19/2006 16:02 

1495 12 9/19/2006 15:33 106 13.5 9/19/2006 16:02 
1035 12 9/19/2006 15:33 104 13.5 9/19/2006 16:02 
1634 12 9/19/2006 15:33 148 13.5 9/19/2006 16:02 
1121 12 9/19/2006 15:33 140 13.5 9/19/2006 16:02 
907 12 9/19/2006 15:33 39.1 13.5 9/19/2006 16:02 
516 12 9/19/2006 15:33 146 13.5 9/19/2006 16:02 
426 12 9/19/2006 15:33 247 13.5 9/19/2006 16:02 
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Path Measurement Data 
Site 2 Path 1 

Path Measurement Data 
Site 2 Path 2 

ppm*m pathlength 
Timestamp 

(Eastern time) ppm*m pathlength 
Timestamp 

(Eastern time) 
1164 12 9/19/2006 15:33 177 13.5 9/19/2006 16:02 
485 12 9/19/2006 15:33 83.8 13.5 9/19/2006 16:02 
258 12 9/19/2006 15:33 113 13.5 9/19/2006 16:03 
68 12 9/19/2006 15:33 92.5 13.5 9/19/2006 16:03 

388 12 9/19/2006 15:33 109 13.5 9/19/2006 16:03 
1018 12 9/19/2006 15:33 115 13.5 9/19/2006 16:03 
1669 12 9/19/2006 15:33 111 13.5 9/19/2006 16:03 
803 12 9/19/2006 15:33 128 13.5 9/19/2006 16:03 
564 12 9/19/2006 15:33 110 13.5 9/19/2006 16:03 
791 12 9/19/2006 15:34 74.4 13.5 9/19/2006 16:03 
396 12 9/19/2006 15:34 66.5 13.5 9/19/2006 16:03 
770 12 9/19/2006 15:34 83.8 13.5 9/19/2006 16:03 

1133 12 9/19/2006 15:34 68.5 13.5 9/19/2006 16:03 
1797 12 9/19/2006 15:34 80.5 13.5 9/19/2006 16:03 
1831 12 9/19/2006 15:34 71.2 13.5 9/19/2006 16:03 
1605 12 9/19/2006 15:34 1331 13.5 9/19/2006 16:03 
1042 12 9/19/2006 15:34 1053 13.5 9/19/2006 16:03 
1399 12 9/19/2006 15:34 444 13.5 9/19/2006 16:03 
892 12 9/19/2006 15:34 550 13.5 9/19/2006 16:03 
854 12 9/19/2006 15:34 282 13.5 9/19/2006 16:03 

1239 12 9/19/2006 15:34 131 13.5 9/19/2006 16:03 
1074 12 9/19/2006 15:34 42.4 13.5 9/19/2006 16:03 
834 12 9/19/2006 15:34 38.6 13.5 9/19/2006 16:03 

1198 12 9/19/2006 15:34 39.4 13.5 9/19/2006 16:03 
1066 12 9/19/2006 15:34 42.5 13.5 9/19/2006 16:03 
907 12 9/19/2006 15:34 42.6 13.5 9/19/2006 16:03 
325 12 9/19/2006 15:34 40.9 13.5 9/19/2006 16:03 
276 12 9/19/2006 15:34 42.1 13.5 9/19/2006 16:03 
486 12 9/19/2006 15:34 40.3 13.5 9/19/2006 16:03 
371 12 9/19/2006 15:34 35.7 13.5 9/19/2006 16:03 
272 12 9/19/2006 15:34 34.8 13.5 9/19/2006 16:03 
249 12 9/19/2006 15:34 34.6 13.5 9/19/2006 16:03 
100 12 9/19/2006 15:34 35.1 13.5 9/19/2006 16:03 
244 12 9/19/2006 15:34 36 13.5 9/19/2006 16:03 
392 12 9/19/2006 15:34 155 13.5 9/19/2006 16:03 

1735 12 9/19/2006 15:34 900 13.5 9/19/2006 16:04 
158 12 9/19/2006 15:34 492 13.5 9/19/2006 16:04 
115 12 9/19/2006 15:34 190 13.5 9/19/2006 16:04 
534 12 9/19/2006 15:34 454 13.5 9/19/2006 16:04 
797 12 9/19/2006 15:34 260 13.5 9/19/2006 16:04 
690 12 9/19/2006 15:34 227 13.5 9/19/2006 16:04 
305 12 9/19/2006 15:34 112 13.5 9/19/2006 16:04 
87.6 12 9/19/2006 15:35 77.8 13.5 9/19/2006 16:04 
67.8 12 9/19/2006 15:35 99.8 13.5 9/19/2006 16:04 
56.7 12 9/19/2006 15:35 46.4 13.5 9/19/2006 16:04 
46.1 12 9/19/2006 15:35 42.5 13.5 9/19/2006 16:04 
38.8 12 9/19/2006 15:35 37.9 13.5 9/19/2006 16:04 
43.2 12 9/19/2006 15:35 33.7 13.5 9/19/2006 16:04 
101 12 9/19/2006 15:35 32.5 13.5 9/19/2006 16:04 
281 12 9/19/2006 15:35 31.6 13.5 9/19/2006 16:04 
155 12 9/19/2006 15:35 31.2 13.5 9/19/2006 16:04 
155 12 9/19/2006 15:35 30.7 13.5 9/19/2006 16:04 
162 12 9/19/2006 15:35 30.6 13.5 9/19/2006 16:04 
133 12 9/19/2006 15:35 30.8 13.5 9/19/2006 16:04 

1884 12 9/19/2006 15:35 30.6 13.5 9/19/2006 16:04 
2360 12 9/19/2006 15:35 31 13.5 9/19/2006 16:04 
986 12 9/19/2006 15:35 38.8 13.5 9/19/2006 16:04 
594 12 9/19/2006 15:35 88.9 13.5 9/19/2006 16:04 

1239 12 9/19/2006 15:35 393 13.5 9/19/2006 16:04 
1123 12 9/19/2006 15:35 334 13.5 9/19/2006 16:04 
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Path Measurement Data 
Site 2 Path 1 

Path Measurement Data 
Site 2 Path 2 

ppm*m pathlength 
Timestamp 

(Eastern time) ppm*m pathlength 
Timestamp 

(Eastern time) 
706 12 9/19/2006 15:35 158 13.5 9/19/2006 16:04 
312 12 9/19/2006 15:35 37.3 13.5 9/19/2006 16:04 
252 12 9/19/2006 15:35 34 13.5 9/19/2006 16:04 
438 12 9/19/2006 15:35 34.1 13.5 9/19/2006 16:04 

1136 12 9/19/2006 15:35 33.3 13.5 9/19/2006 16:04 
633 12 9/19/2006 15:35 32.9 13.5 9/19/2006 16:04 

1223 12 9/19/2006 15:35 32.9 13.5 9/19/2006 16:04 
2114 12 9/19/2006 15:35 33.1 13.5 9/19/2006 16:04 
1332 12 9/19/2006 15:35 32.5 13.5 9/19/2006 16:04 
104 12 9/19/2006 15:35 31.7 13.5 9/19/2006 16:05 
26.4 12 9/19/2006 15:35 31.6 13.5 9/19/2006 16:05 
26.3 12 9/19/2006 15:35 31.3 13.5 9/19/2006 16:05 
26.3 12 9/19/2006 15:35 31.3 13.5 9/19/2006 16:05 
26.3 12 9/19/2006 15:35 30.7 13.5 9/19/2006 16:05 
26.4 12 9/19/2006 15:35 30.6 13.5 9/19/2006 16:05 
29.3 12 9/19/2006 15:36 30.4 13.5 9/19/2006 16:05 
448 12 9/19/2006 15:36 30.1 13.5 9/19/2006 16:05 
618 12 9/19/2006 15:36 30.2 13.5 9/19/2006 16:05 
104 12 9/19/2006 15:36 30.1 13.5 9/19/2006 16:05 
573 12 9/19/2006 15:36 30.1 13.5 9/19/2006 16:05 
634 12 9/19/2006 15:36 30.2 13.5 9/19/2006 16:05 
117 12 9/19/2006 15:36 30.2 13.5 9/19/2006 16:05 
38.9 12 9/19/2006 15:36 30.4 13.5 9/19/2006 16:05 
29.4 12 9/19/2006 15:36 30.2 13.5 9/19/2006 16:05 
26.9 12 9/19/2006 15:36 31.7 13.5 9/19/2006 16:05 
26.2 12 9/19/2006 15:36 208 13.5 9/19/2006 16:05 
26.4 12 9/19/2006 15:36 753 13.5 9/19/2006 16:05 
26.3 12 9/19/2006 15:36 202 13.5 9/19/2006 16:05 
26.8 12 9/19/2006 15:36 223 13.5 9/19/2006 16:05 
26.7 12 9/19/2006 15:36 167 13.5 9/19/2006 16:05 
27 12 9/19/2006 15:36 197 13.5 9/19/2006 16:05 

27.6 12 9/19/2006 15:36 77.3 13.5 9/19/2006 16:05 
27.3 12 9/19/2006 15:36 80.5 13.5 9/19/2006 16:05 
27.2 12 9/19/2006 15:36 90.8 13.5 9/19/2006 16:05 
28.2 12 9/19/2006 15:36 79.3 13.5 9/19/2006 16:05 
29 12 9/19/2006 15:36 56.4 13.5 9/19/2006 16:05 
30 12 9/19/2006 15:36 36.8 13.5 9/19/2006 16:05 

30.3 12 9/19/2006 15:36 33.1 13.5 9/19/2006 16:05 
134 12 9/19/2006 15:36 34.6 13.5 9/19/2006 16:05 
482 12 9/19/2006 15:36 60.2 13.5 9/19/2006 16:05 
93 12 9/19/2006 15:36 66.4 13.5 9/19/2006 16:05 

52.1 12 9/19/2006 15:36 67.1 13.5 9/19/2006 16:05 
69.5 12 9/19/2006 15:36 58.4 13.5 9/19/2006 16:06 
101 12 9/19/2006 15:36 44.8 13.5 9/19/2006 16:06 
110 12 9/19/2006 15:36 38 13.5 9/19/2006 16:06 
134 12 9/19/2006 15:36 32.9 13.5 9/19/2006 16:06 
124 12 9/19/2006 15:36 36.8 13.5 9/19/2006 16:06 
125 12 9/19/2006 15:36 42.9 13.5 9/19/2006 16:06 
85.9 12 9/19/2006 15:37 40.5 13.5 9/19/2006 16:06 
100 12 9/19/2006 15:37 44.6 13.5 9/19/2006 16:06 

1872 12 9/19/2006 15:37 47 13.5 9/19/2006 16:06 
487 12 9/19/2006 15:37 43.3 13.5 9/19/2006 16:06 

2299 12 9/19/2006 15:37 41.2 13.5 9/19/2006 16:06 
1056 12 9/19/2006 15:37 36.5 13.5 9/19/2006 16:06 
1016 12 9/19/2006 15:37 35.7 13.5 9/19/2006 16:06 
1069 12 9/19/2006 15:37 36.8 13.5 9/19/2006 16:06 
831 12 9/19/2006 15:37 36.5 13.5 9/19/2006 16:06 
593 12 9/19/2006 15:37 35.5 13.5 9/19/2006 16:06 
149 12 9/19/2006 15:37 34.9 13.5 9/19/2006 16:06 
932 12 9/19/2006 15:37 35 13.5 9/19/2006 16:06 
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Path Measurement Data 
Site 2 Path 1 

Path Measurement Data 
Site 2 Path 2 

ppm*m pathlength 
Timestamp 

(Eastern time) ppm*m pathlength 
Timestamp 

(Eastern time) 
764 12 9/19/2006 15:37 34.2 13.5 9/19/2006 16:06 

1888 12 9/19/2006 15:37 34 13.5 9/19/2006 16:06 
2023 12 9/19/2006 15:37 34.6 13.5 9/19/2006 16:06 
1184 12 9/19/2006 15:37 35.8 13.5 9/19/2006 16:06 
1683 12 9/19/2006 15:37 35 13.5 9/19/2006 16:06 
486 12 9/19/2006 15:37 35.3 13.5 9/19/2006 16:06 

1276 12 9/19/2006 15:37 36.7 13.5 9/19/2006 16:06 
1587 12 9/19/2006 15:37 36.8 13.5 9/19/2006 16:06 
365 12 9/19/2006 15:37 35.7 13.5 9/19/2006 16:06 
341 12 9/19/2006 15:37 36.9 13.5 9/19/2006 16:06 

1492 12 9/19/2006 15:37 37.8 13.5 9/19/2006 16:06 
962 12 9/19/2006 15:37 39.4 13.5 9/19/2006 16:06 
628 12 9/19/2006 15:37 39.7 13.5 9/19/2006 16:06 
141 12 9/19/2006 15:37 38.7 13.5 9/19/2006 16:06 
99.4 12 9/19/2006 15:37 36.5 13.5 9/19/2006 16:06 
139 12 9/19/2006 15:37 35.9 13.5 9/19/2006 16:06 
145 12 9/19/2006 15:37 35.8 13.5 9/19/2006 16:07 
694 12 9/19/2006 15:37 35.8 13.5 9/19/2006 16:07 
994 12 9/19/2006 15:38 35.6 13.5 9/19/2006 16:07 
73.7 12 9/19/2006 15:38 35.1 13.5 9/19/2006 16:07 
70 12 9/19/2006 15:38 35.3 13.5 9/19/2006 16:07 

349 12 9/19/2006 15:38 35.3 13.5 9/19/2006 16:07 
278 12 9/19/2006 15:38 35 13.5 9/19/2006 16:07 
323 12 9/19/2006 15:38 35.5 13.5 9/19/2006 16:07 

1797 12 9/19/2006 15:38 35.5 13.5 9/19/2006 16:07 
694 12 9/19/2006 15:38 35.3 13.5 9/19/2006 16:07 
283 12 9/19/2006 15:38 35.8 13.5 9/19/2006 16:07 
679 12 9/19/2006 15:38 36 13.5 9/19/2006 16:07 

1730 12 9/19/2006 15:38 35.4 13.5 9/19/2006 16:07 
119 12 9/19/2006 15:38 35.8 13.5 9/19/2006 16:07 
429 12 9/19/2006 15:38 40 13.5 9/19/2006 16:07 

1197 12 9/19/2006 15:38 42 13.5 9/19/2006 16:07 
1171 12 9/19/2006 15:38 43.3 13.5 9/19/2006 16:07 
946 12 9/19/2006 15:38 41 13.5 9/19/2006 16:07 
730 12 9/19/2006 15:38 174 13.5 9/19/2006 16:07 
414 12 9/19/2006 15:38 516 13.5 9/19/2006 16:07 
298 12 9/19/2006 15:38 391 13.5 9/19/2006 16:07 
452 12 9/19/2006 15:38 705 13.5 9/19/2006 16:07 
256 12 9/19/2006 15:38 496 13.5 9/19/2006 16:07 

1846 12 9/19/2006 15:38 275 13.5 9/19/2006 16:07 
1586 12 9/19/2006 15:38 89.3 13.5 9/19/2006 16:07 
2047 12 9/19/2006 15:38 454 13.5 9/19/2006 16:07 
2438 12 9/19/2006 15:38 473 13.5 9/19/2006 16:07 
619 12 9/19/2006 15:38 289 13.5 9/19/2006 16:07 
181 12 9/19/2006 15:38 513 13.5 9/19/2006 16:07 
137 12 9/19/2006 15:38 675 13.5 9/19/2006 16:07 
237 12 9/19/2006 15:38 434 13.5 9/19/2006 16:07 
133 12 9/19/2006 15:38 328 13.5 9/19/2006 16:07 
134 12 9/19/2006 15:38 371 13.5 9/19/2006 16:07 
396 12 9/19/2006 15:38 296 13.5 9/19/2006 16:07 
746 12 9/19/2006 15:38 346 13.5 9/19/2006 16:08 
724 12 9/19/2006 15:39 394 13.5 9/19/2006 16:08 
716 12 9/19/2006 15:39 411 13.5 9/19/2006 16:08 
248 12 9/19/2006 15:39 582 13.5 9/19/2006 16:08 
737 12 9/19/2006 15:39 833 13.5 9/19/2006 16:08 

1563 12 9/19/2006 15:39 313 13.5 9/19/2006 16:08 
827 12 9/19/2006 15:39 453 13.5 9/19/2006 16:08 
499 12 9/19/2006 15:39 1073 13.5 9/19/2006 16:08 
658 12 9/19/2006 15:39 551 13.5 9/19/2006 16:08 
482 12 9/19/2006 15:39 199 13.5 9/19/2006 16:08 
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Path Measurement Data 
Site 2 Path 1 

Path Measurement Data 
Site 2 Path 2 

ppm*m pathlength 
Timestamp 

(Eastern time) ppm*m pathlength 
Timestamp 

(Eastern time) 
880 12 9/19/2006 15:39 591 13.5 9/19/2006 16:08 
698 12 9/19/2006 15:39 1168 13.5 9/19/2006 16:08 
242 12 9/19/2006 15:39 772 13.5 9/19/2006 16:08 
108 12 9/19/2006 15:39 102 13.5 9/19/2006 16:08 
58.1 12 9/19/2006 15:39 106 13.5 9/19/2006 16:08 
84.5 12 9/19/2006 15:39 234 13.5 9/19/2006 16:08 
554 12 9/19/2006 15:39 134 13.5 9/19/2006 16:08 

1161 12 9/19/2006 15:39 152 13.5 9/19/2006 16:08 
949 12 9/19/2006 15:39 245 13.5 9/19/2006 16:08 

1280 12 9/19/2006 15:39 258 13.5 9/19/2006 16:08 
1271 12 9/19/2006 15:39 336 13.5 9/19/2006 16:08 
400 12 9/19/2006 15:39 631 13.5 9/19/2006 16:08 
592 12 9/19/2006 15:39 472 13.5 9/19/2006 16:08 
509 12 9/19/2006 15:39 224 13.5 9/19/2006 16:08 

1213 12 9/19/2006 15:39 157 13.5 9/19/2006 16:08 
680 12 9/19/2006 15:39 140 13.5 9/19/2006 16:08 
931 12 9/19/2006 15:39 75.6 13.5 9/19/2006 16:08 
465 12 9/19/2006 15:39 76.7 13.5 9/19/2006 16:08 
213 12 9/19/2006 15:39 61.5 13.5 9/19/2006 16:08 
434 12 9/19/2006 15:39 75.2 13.5 9/19/2006 16:08 

1071 12 9/19/2006 15:39 62 13.5 9/19/2006 16:08 
1335 12 9/19/2006 15:39 57.4 13.5 9/19/2006 16:08 
1533 12 9/19/2006 15:39 51.5 13.5 9/19/2006 16:08 
1018 12 9/19/2006 15:40 41.3 13.5 9/19/2006 16:09 
2071 12 9/19/2006 15:40 33.5 13.5 9/19/2006 16:09 
1494 12 9/19/2006 15:40 32.2 13.5 9/19/2006 16:09 
1125 12 9/19/2006 15:40 35.9 13.5 9/19/2006 16:09 
2021 12 9/19/2006 15:40 34.1 13.5 9/19/2006 16:09 
1225 12 9/19/2006 15:40 33.9 13.5 9/19/2006 16:09 
1258 12 9/19/2006 15:40 34.5 13.5 9/19/2006 16:09 
666 12 9/19/2006 15:40 68.4 13.5 9/19/2006 16:09 
179 12 9/19/2006 15:40 156 13.5 9/19/2006 16:09 
531 12 9/19/2006 15:40 230 13.5 9/19/2006 16:09 

1109 12 9/19/2006 15:40 233 13.5 9/19/2006 16:09 
772 12 9/19/2006 15:40 572 13.5 9/19/2006 16:09 

1818 12 9/19/2006 15:40 373 13.5 9/19/2006 16:09 
1614 12 9/19/2006 15:40 589 13.5 9/19/2006 16:09 
1103 12 9/19/2006 15:40 1061 13.5 9/19/2006 16:09 
256 12 9/19/2006 15:40 1143 13.5 9/19/2006 16:09 
726 12 9/19/2006 15:40 1619 13.5 9/19/2006 16:09 
809 12 9/19/2006 15:40 531 13.5 9/19/2006 16:09 

2368 12 9/19/2006 15:40 100 13.5 9/19/2006 16:09 
1709 12 9/19/2006 15:40 31.1 13.5 9/19/2006 16:09 
816 12 9/19/2006 15:40 30.7 13.5 9/19/2006 16:09 
845 12 9/19/2006 15:40 40.4 13.5 9/19/2006 16:09 
814 12 9/19/2006 15:40 114 13.5 9/19/2006 16:09 
489 12 9/19/2006 15:40 667 13.5 9/19/2006 16:09 
399 12 9/19/2006 15:40 524 13.5 9/19/2006 16:09 

1089 12 9/19/2006 15:40 370 13.5 9/19/2006 16:09 
1616 12 9/19/2006 15:40 522 13.5 9/19/2006 16:09 
2006 12 9/19/2006 15:40 445 13.5 9/19/2006 16:09 
1618 12 9/19/2006 15:40 282 13.5 9/19/2006 16:09 
2324 12 9/19/2006 15:40 247 13.5 9/19/2006 16:09 
1451 12 9/19/2006 15:41 109 13.5 9/19/2006 16:09 
1501 12 9/19/2006 15:41 62 13.5 9/19/2006 16:09 
1981 12 9/19/2006 15:41 66.1 13.5 9/19/2006 16:09 
2508 12 9/19/2006 15:41 55.1 13.5 9/19/2006 16:10 
1579 12 9/19/2006 15:41 42.4 13.5 9/19/2006 16:10 
1040 12 9/19/2006 15:41 42.7 13.5 9/19/2006 16:10 
1095 12 9/19/2006 15:41 51.6 13.5 9/19/2006 16:10 
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Path Measurement Data 
Site 2 Path 1 

Path Measurement Data 
Site 2 Path 2 

ppm*m pathlength 
Timestamp 

(Eastern time) ppm*m pathlength 
Timestamp 

(Eastern time) 
923 12 9/19/2006 15:41 66.1 13.5 9/19/2006 16:10 

2236 12 9/19/2006 15:41 114 13.5 9/19/2006 16:10 
1525 12 9/19/2006 15:41 635 13.5 9/19/2006 16:10 
675 12 9/19/2006 15:41 1182 13.5 9/19/2006 16:10 
187 12 9/19/2006 15:41 801 13.5 9/19/2006 16:10 
115 12 9/19/2006 15:41 221 13.5 9/19/2006 16:10 
499 12 9/19/2006 15:41 506 13.5 9/19/2006 16:10 
923 12 9/19/2006 15:41 563 13.5 9/19/2006 16:10 

1036 12 9/19/2006 15:41 501 13.5 9/19/2006 16:10 
695 12 9/19/2006 15:41 401 13.5 9/19/2006 16:10 
820 12 9/19/2006 15:41 398 13.5 9/19/2006 16:10 
258 12 9/19/2006 15:41 208 13.5 9/19/2006 16:10 
331 12 9/19/2006 15:41 174 13.5 9/19/2006 16:10 
200 12 9/19/2006 15:41 278 13.5 9/19/2006 16:10 
969 12 9/19/2006 15:41 316 13.5 9/19/2006 16:10 
902 12 9/19/2006 15:41 200 13.5 9/19/2006 16:10 
186 12 9/19/2006 15:41 199 13.5 9/19/2006 16:10 
155 12 9/19/2006 15:41 532 13.5 9/19/2006 16:10 
360 12 9/19/2006 15:41 332 13.5 9/19/2006 16:10 
695 12 9/19/2006 15:41 162 13.5 9/19/2006 16:10 
735 12 9/19/2006 15:41 67.3 13.5 9/19/2006 16:10 
99.2 12 9/19/2006 15:41 153 13.5 9/19/2006 16:10 
1120 12 9/19/2006 15:41 1416 13.5 9/19/2006 16:10 
741 12 9/19/2006 15:41 413 13.5 9/19/2006 16:10 
633 12 9/19/2006 15:41 193 13.5 9/19/2006 16:10 
771 12 9/19/2006 15:41 1008 13.5 9/19/2006 16:10 
147 12 9/19/2006 15:42 1688 13.5 9/19/2006 16:10 
702 12 9/19/2006 15:42 1843 13.5 9/19/2006 16:10 
616 12 9/19/2006 15:42 992 13.5 9/19/2006 16:10 
568 12 9/19/2006 15:42 504 13.5 9/19/2006 16:10 
564 12 9/19/2006 15:42 399 13.5 9/19/2006 16:11 
887 12 9/19/2006 15:42 447 13.5 9/19/2006 16:11 
872 12 9/19/2006 15:42 411 13.5 9/19/2006 16:11 
738 12 9/19/2006 15:42 513 13.5 9/19/2006 16:11 

1000 12 9/19/2006 15:42 670 13.5 9/19/2006 16:11 
875 12 9/19/2006 15:42 403 13.5 9/19/2006 16:11 

1755 12 9/19/2006 15:42 135 13.5 9/19/2006 16:11 
569 12 9/19/2006 15:42 84.6 13.5 9/19/2006 16:11 
233 12 9/19/2006 15:42 71.5 13.5 9/19/2006 16:11 
156 12 9/19/2006 15:42 75.7 13.5 9/19/2006 16:11 
474 12 9/19/2006 15:42 71.3 13.5 9/19/2006 16:11 
919 12 9/19/2006 15:42 72.4 13.5 9/19/2006 16:11 
792 12 9/19/2006 15:42 70.7 13.5 9/19/2006 16:11 

1037 12 9/19/2006 15:42 65.8 13.5 9/19/2006 16:11 
1938 12 9/19/2006 15:42 52.9 13.5 9/19/2006 16:11 
2602 12 9/19/2006 15:42 50.3 13.5 9/19/2006 16:11 
2077 12 9/19/2006 15:42 57.2 13.5 9/19/2006 16:11 
167 12 9/19/2006 15:42 81.9 13.5 9/19/2006 16:11 

1932 12 9/19/2006 15:42 66.5 13.5 9/19/2006 16:11 
2450 12 9/19/2006 15:42 55.3 13.5 9/19/2006 16:11 
701 12 9/19/2006 15:42 68.5 13.5 9/19/2006 16:11 
872 12 9/19/2006 15:42 95.9 13.5 9/19/2006 16:11 

1581 12 9/19/2006 15:42 93.8 13.5 9/19/2006 16:11 
1102 12 9/19/2006 15:42 97.6 13.5 9/19/2006 16:11 
600 12 9/19/2006 15:42 80.8 13.5 9/19/2006 16:11 
496 12 9/19/2006 15:42 75.8 13.5 9/19/2006 16:11 
364 12 9/19/2006 15:42 64.8 13.5 9/19/2006 16:11 
169 12 9/19/2006 15:43 53.9 13.5 9/19/2006 16:11 
71.4 12 9/19/2006 15:43 56.1 13.5 9/19/2006 16:11 
39.1 12 9/19/2006 15:43 42.1 13.5 9/19/2006 16:11 
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Path Measurement Data 
Site 2 Path 1 

Path Measurement Data 
Site 2 Path 2 

ppm*m pathlength 
Timestamp 

(Eastern time) ppm*m pathlength 
Timestamp 

(Eastern time) 
40.3 12 9/19/2006 15:43 38.7 13.5 9/19/2006 16:11 
123 12 9/19/2006 15:43 35.1 13.5 9/19/2006 16:11 
984 12 9/19/2006 15:43 33.7 13.5 9/19/2006 16:11 

1389 12 9/19/2006 15:43 33.1 13.5 9/19/2006 16:12 
854 12 9/19/2006 15:43 39.3 13.5 9/19/2006 16:12 
970 12 9/19/2006 15:43 484 13.5 9/19/2006 16:12 

1171 12 9/19/2006 15:43 1513 13.5 9/19/2006 16:12 
1545 12 9/19/2006 15:43 1132 13.5 9/19/2006 16:12 
1152 12 9/19/2006 15:43 2390 13.5 9/19/2006 16:12 
754 12 9/19/2006 15:43 893 13.5 9/19/2006 16:12 

1144 12 9/19/2006 15:43 1012 13.5 9/19/2006 16:12 
757 12 9/19/2006 15:43 1680 13.5 9/19/2006 16:12 
893 12 9/19/2006 15:43 596 13.5 9/19/2006 16:12 

1059 12 9/19/2006 15:43 260 13.5 9/19/2006 16:12 
1123 12 9/19/2006 15:43 818 13.5 9/19/2006 16:12 
1676 12 9/19/2006 15:43 1170 13.5 9/19/2006 16:12 
1429 12 9/19/2006 15:43 733 13.5 9/19/2006 16:12 
1929 12 9/19/2006 15:43 306 13.5 9/19/2006 16:12 
2842 12 9/19/2006 15:43 196 13.5 9/19/2006 16:12 
2255 12 9/19/2006 15:43 283 13.5 9/19/2006 16:12 
1233 12 9/19/2006 15:43 328 13.5 9/19/2006 16:12 
769 12 9/19/2006 15:43 352 13.5 9/19/2006 16:12 
464 12 9/19/2006 15:43 225 13.5 9/19/2006 16:12 
165 12 9/19/2006 15:43 249 13.5 9/19/2006 16:12 
302 12 9/19/2006 15:43 236 13.5 9/19/2006 16:12 
137 12 9/19/2006 15:43 193 13.5 9/19/2006 16:12 
90.1 12 9/19/2006 15:43 341 13.5 9/19/2006 16:12 
78.2 12 9/19/2006 15:43 279 13.5 9/19/2006 16:12 
75.7 12 9/19/2006 15:44 268 13.5 9/19/2006 16:12 
70.3 12 9/19/2006 15:44 131 13.5 9/19/2006 16:12 
449 12 9/19/2006 15:44 68.1 13.5 9/19/2006 16:12 
282 12 9/19/2006 15:44 43.1 13.5 9/19/2006 16:12 

1745 12 9/19/2006 15:44 31.6 13.5 9/19/2006 16:12 
783 12 9/19/2006 15:44 667 13.5 9/19/2006 16:12 

1176 12 9/19/2006 15:44 733 13.5 9/19/2006 16:12 
1682 12 9/19/2006 15:44 550 13.5 9/19/2006 16:12 
2587 12 9/19/2006 15:44 673 13.5 9/19/2006 16:13 
1661 12 9/19/2006 15:44 678 13.5 9/19/2006 16:13 
735 12 9/19/2006 15:44 385 13.5 9/19/2006 16:13 
282 12 9/19/2006 15:44 438 13.5 9/19/2006 16:13 
103 12 9/19/2006 15:44 593 13.5 9/19/2006 16:13 
64.5 12 9/19/2006 15:44 141 13.5 9/19/2006 16:13 
103 12 9/19/2006 15:44 380 13.5 9/19/2006 16:13 
724 12 9/19/2006 15:44 509 13.5 9/19/2006 16:13 

1664 12 9/19/2006 15:44 417 13.5 9/19/2006 16:13 
499 12 9/19/2006 15:44 1067 13.5 9/19/2006 16:13 
175 12 9/19/2006 15:44 796 13.5 9/19/2006 16:13 

1054 12 9/19/2006 15:44 620 13.5 9/19/2006 16:13 
856 12 9/19/2006 15:44 519 13.5 9/19/2006 16:13 

1876 12 9/19/2006 15:44 725 13.5 9/19/2006 16:13 
2243 12 9/19/2006 15:44 450 13.5 9/19/2006 16:13 
964 12 9/19/2006 15:44 237 13.5 9/19/2006 16:13 

1101 12 9/19/2006 15:44 92.4 13.5 9/19/2006 16:13 
1634 12 9/19/2006 15:44 79.8 13.5 9/19/2006 16:13 
703 12 9/19/2006 15:44 34.6 13.5 9/19/2006 16:13 
600 12 9/19/2006 15:44 31.2 13.5 9/19/2006 16:13 
724 12 9/19/2006 15:44 31.1 13.5 9/19/2006 16:13 
983 12 9/19/2006 15:44 31.3 13.5 9/19/2006 16:13 
684 12 9/19/2006 15:44 32.5 13.5 9/19/2006 16:13 

1361 12 9/19/2006 15:45 40.3 13.5 9/19/2006 16:13 
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Path Measurement Data 
Site 2 Path 1 

Path Measurement Data 
Site 2 Path 2 

ppm*m pathlength 
Timestamp 

(Eastern time) ppm*m pathlength 
Timestamp 

(Eastern time) 
1054 12 9/19/2006 15:45 110 13.5 9/19/2006 16:13 
554 12 9/19/2006 15:45 152 13.5 9/19/2006 16:13 
465 12 9/19/2006 15:45 542 13.5 9/19/2006 16:13 
281 12 9/19/2006 15:45 503 13.5 9/19/2006 16:13 

1986 12 9/19/2006 15:45 185 13.5 9/19/2006 16:13 
1205 12 9/19/2006 15:45 92.3 13.5 9/19/2006 16:13 
295 12 9/19/2006 15:45 436 13.5 9/19/2006 16:13 
36 12 9/19/2006 15:45 339 13.5 9/19/2006 16:13 

49.7 12 9/19/2006 15:45 122 13.5 9/19/2006 16:13 
113 12 9/19/2006 15:45 95.5 13.5 9/19/2006 16:13 

1832 12 9/19/2006 15:45 62.1 13.5 9/19/2006 16:14 
972 12 9/19/2006 15:45 60.4 13.5 9/19/2006 16:14 
348 12 9/19/2006 15:45 64.9 13.5 9/19/2006 16:14 
455 12 9/19/2006 15:45 73.2 13.5 9/19/2006 16:14 
415 12 9/19/2006 15:45 76.8 13.5 9/19/2006 16:14 
43.1 12 9/19/2006 15:45 81.6 13.5 9/19/2006 16:14 
51.2 12 9/19/2006 15:45 44.7 13.5 9/19/2006 16:14 
42.2 12 9/19/2006 15:45 36.5 13.5 9/19/2006 16:14 
35.8 12 9/19/2006 15:45 32.4 13.5 9/19/2006 16:14 
34.4 12 9/19/2006 15:45 32.1 13.5 9/19/2006 16:14 
31.4 12 9/19/2006 15:45 31.8 13.5 9/19/2006 16:14 
34.4 12 9/19/2006 15:45 31.1 13.5 9/19/2006 16:14 
1441 12 9/19/2006 15:45 30.8 13.5 9/19/2006 16:14 
1742 12 9/19/2006 15:45 30.8 13.5 9/19/2006 16:14 
1109 12 9/19/2006 15:45 30.9 13.5 9/19/2006 16:14 
1733 12 9/19/2006 15:45 30.6 13.5 9/19/2006 16:14 
2247 12 9/19/2006 15:45 30.7 13.5 9/19/2006 16:14 
601 12 9/19/2006 15:45 30.8 13.5 9/19/2006 16:14 
997 12 9/19/2006 15:45 30.8 13.5 9/19/2006 16:14 

1337 12 9/19/2006 15:45 30.7 13.5 9/19/2006 16:14 
1404 12 9/19/2006 15:46 30.7 13.5 9/19/2006 16:14 
1584 12 9/19/2006 15:46 30.8 13.5 9/19/2006 16:14 
2122 12 9/19/2006 15:46 30.9 13.5 9/19/2006 16:14 
1908 12 9/19/2006 15:46 30.9 13.5 9/19/2006 16:14 
1222 12 9/19/2006 15:46 30.9 13.5 9/19/2006 16:14 
2051 12 9/19/2006 15:46 31 13.5 9/19/2006 16:14 
1110 12 9/19/2006 15:46 30.8 13.5 9/19/2006 16:14 
1664 12 9/19/2006 15:46 30.8 13.5 9/19/2006 16:14 
1928 12 9/19/2006 15:46 30.8 13.5 9/19/2006 16:14 
2074 12 9/19/2006 15:46 30.8 13.5 9/19/2006 16:14 
1852 12 9/19/2006 15:46 30.9 13.5 9/19/2006 16:14 
1175 12 9/19/2006 15:46 30.8 13.5 9/19/2006 16:14 
1346 12 9/19/2006 15:46 30.8 13.5 9/19/2006 16:14 
1649 12 9/19/2006 15:46 112 13.5 9/19/2006 16:15 
1550 12 9/19/2006 15:46 154 13.5 9/19/2006 16:15 
2121 12 9/19/2006 15:46 120 13.5 9/19/2006 16:15 
1458 12 9/19/2006 15:46 101 13.5 9/19/2006 16:15 
1386 12 9/19/2006 15:46 92.5 13.5 9/19/2006 16:15 
1086 12 9/19/2006 15:46 78.4 13.5 9/19/2006 16:15 
837 12 9/19/2006 15:46 73.5 13.5 9/19/2006 16:15 

1687 12 9/19/2006 15:46 52.8 13.5 9/19/2006 16:15 
1464 12 9/19/2006 15:46 45.5 13.5 9/19/2006 16:15 
899 12 9/19/2006 15:46 43.2 13.5 9/19/2006 16:15 

1272 12 9/19/2006 15:46 43.9 13.5 9/19/2006 16:15 
1350 12 9/19/2006 15:46 38.7 13.5 9/19/2006 16:15 
1275 12 9/19/2006 15:46 36.8 13.5 9/19/2006 16:15 
238 12 9/19/2006 15:46 37.6 13.5 9/19/2006 16:15 
88.1 12 9/19/2006 15:46 66.2 13.5 9/19/2006 16:15 
41.5 12 9/19/2006 15:46 69.3 13.5 9/19/2006 16:15 
48.4 12 9/19/2006 15:46 69.2 13.5 9/19/2006 16:15 
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Path Measurement Data 
Site 2 Path 1 

Path Measurement Data 
Site 2 Path 2 

ppm*m pathlength 
Timestamp 

(Eastern time) ppm*m pathlength 
Timestamp 

(Eastern time) 
1199 12 9/19/2006 15:46 78.5 13.5 9/19/2006 16:15 
172 12 9/19/2006 15:47 63.5 13.5 9/19/2006 16:15 
94.4 12 9/19/2006 15:47 40.7 13.5 9/19/2006 16:15 
113 12 9/19/2006 15:47 35.4 13.5 9/19/2006 16:15 

1323 12 9/19/2006 15:47 32.8 13.5 9/19/2006 16:15 
2443 12 9/19/2006 15:47 31.7 13.5 9/19/2006 16:15 
605 12 9/19/2006 15:47 31.1 13.5 9/19/2006 16:15 
322 12 9/19/2006 15:47 30.8 13.5 9/19/2006 16:15 
476 12 9/19/2006 15:47 30.5 13.5 9/19/2006 16:15 
650 12 9/19/2006 15:47 30.6 13.5 9/19/2006 16:15 
664 12 9/19/2006 15:47 56.2 13.5 9/19/2006 16:15 
638 12 9/19/2006 15:47 113 13.5 9/19/2006 16:15 

1390 12 9/19/2006 15:47 124 13.5 9/19/2006 16:15 
940 12 9/19/2006 15:47 68.1 13.5 9/19/2006 16:15 
929 12 9/19/2006 15:47 62.5 13.5 9/19/2006 16:15 

1211 12 9/19/2006 15:47 57.6 13.5 9/19/2006 16:15 
579 12 9/19/2006 15:47 59.3 13.5 9/19/2006 16:15 
776 12 9/19/2006 15:47 56.5 13.5 9/19/2006 16:16 
309 12 9/19/2006 15:47 44.7 13.5 9/19/2006 16:16 
668 12 9/19/2006 15:47 33.6 13.5 9/19/2006 16:16 
571 12 9/19/2006 15:47 30.9 13.5 9/19/2006 16:16 
491 12 9/19/2006 15:47 30.7 13.5 9/19/2006 16:16 
542 12 9/19/2006 15:47 31 13.5 9/19/2006 16:16 
306 12 9/19/2006 15:47 32.6 13.5 9/19/2006 16:16 
51.4 12 9/19/2006 15:47 34.8 13.5 9/19/2006 16:16 
49.4 12 9/19/2006 15:47 43.3 13.5 9/19/2006 16:16 
52.8 12 9/19/2006 15:47 53 13.5 9/19/2006 16:16 
33.7 12 9/19/2006 15:48 55.1 13.5 9/19/2006 16:16 
38.5 12 9/19/2006 15:48 81.9 13.5 9/19/2006 16:16 
78.6 12 9/19/2006 15:48 109 13.5 9/19/2006 16:16 
201 12 9/19/2006 15:48 79.7 13.5 9/19/2006 16:16 
665 12 9/19/2006 15:48 105 13.5 9/19/2006 16:16 
534 12 9/19/2006 15:48 118 13.5 9/19/2006 16:16 
386 12 9/19/2006 15:48 103 13.5 9/19/2006 16:16 
391 12 9/19/2006 15:48 197 13.5 9/19/2006 16:16 
676 12 9/19/2006 15:48 468 13.5 9/19/2006 16:16 
466 12 9/19/2006 15:48 534 13.5 9/19/2006 16:16 
119 12 9/19/2006 15:48 316 13.5 9/19/2006 16:16 
131 12 9/19/2006 15:48 237 13.5 9/19/2006 16:16 
188 12 9/19/2006 15:48 136 13.5 9/19/2006 16:16 
87.3 12 9/19/2006 15:48 283 13.5 9/19/2006 16:16 
42.3 12 9/19/2006 15:48 479 13.5 9/19/2006 16:16 
29.8 12 9/19/2006 15:48 600 13.5 9/19/2006 16:16 
27.4 12 9/19/2006 15:48 469 13.5 9/19/2006 16:16 
27.4 12 9/19/2006 15:48 744 13.5 9/19/2006 16:16 
71.3 12 9/19/2006 15:48 290 13.5 9/19/2006 16:16 
328 12 9/19/2006 15:48 807 13.5 9/19/2006 16:16 
444 12 9/19/2006 15:48 537 13.5 9/19/2006 16:16 

1087 12 9/19/2006 15:48 431 13.5 9/19/2006 16:16 
1121 12 9/19/2006 15:48 1204 13.5 9/19/2006 16:16 
360 12 9/19/2006 15:48 784 13.5 9/19/2006 16:16 
358 12 9/19/2006 15:48 505 13.5 9/19/2006 16:17 
834 12 9/19/2006 15:48 947 13.5 9/19/2006 16:17 
977 12 9/19/2006 15:48 875 13.5 9/19/2006 16:17 

1239 12 9/19/2006 15:48 650 13.5 9/19/2006 16:17 
2176 12 9/19/2006 15:48 550 13.5 9/19/2006 16:17 
1940 12 9/19/2006 15:48 120 13.5 9/19/2006 16:17 
1576 12 9/19/2006 15:48 138 13.5 9/19/2006 16:17 
1184 12 9/19/2006 15:49 74.3 13.5 9/19/2006 16:17 
1314 12 9/19/2006 15:49 48.7 13.5 9/19/2006 16:17 

185



Path Measurement Data 
Site 2 Path 1 

Path Measurement Data 
Site 2 Path 2 

ppm*m pathlength 
Timestamp 

(Eastern time) ppm*m pathlength 
Timestamp 

(Eastern time) 
974 12 9/19/2006 15:49 34.5 13.5 9/19/2006 16:17 
529 12 9/19/2006 15:49 33.9 13.5 9/19/2006 16:17 
339 12 9/19/2006 15:49 31.8 13.5 9/19/2006 16:17 
216 12 9/19/2006 15:49 34.4 13.5 9/19/2006 16:17 
133 12 9/19/2006 15:49 33.9 13.5 9/19/2006 16:17 
39.8 12 9/19/2006 15:49 85.9 13.5 9/19/2006 16:17 
34.6 12 9/19/2006 15:49 60 13.5 9/19/2006 16:17 
32.3 12 9/19/2006 15:49 34.4 13.5 9/19/2006 16:17 
42.2 12 9/19/2006 15:49 38.3 13.5 9/19/2006 16:17 
159 12 9/19/2006 15:49 46.9 13.5 9/19/2006 16:17 
486 12 9/19/2006 15:49 40.8 13.5 9/19/2006 16:17 
540 12 9/19/2006 15:49 38.2 13.5 9/19/2006 16:17 
421 12 9/19/2006 15:49 34.7 13.5 9/19/2006 16:17 

1776 12 9/19/2006 15:49 36.3 13.5 9/19/2006 16:17 
1038 12 9/19/2006 15:49 35 13.5 9/19/2006 16:17 
2460 12 9/19/2006 15:49 34.1 13.5 9/19/2006 16:17 
1259 12 9/19/2006 15:49 33 13.5 9/19/2006 16:17 
740 12 9/19/2006 15:49 65.4 13.5 9/19/2006 16:17 
463 12 9/19/2006 15:49 677 13.5 9/19/2006 16:17 
572 12 9/19/2006 15:49 700 13.5 9/19/2006 16:17 
622 12 9/19/2006 15:49 181 13.5 9/19/2006 16:17 
668 12 9/19/2006 15:49 213 13.5 9/19/2006 16:17 
341 12 9/19/2006 15:49 140 13.5 9/19/2006 16:17 

1208 12 9/19/2006 15:49 558 13.5 9/19/2006 16:17 
444 12 9/19/2006 15:49 291 13.5 9/19/2006 16:18 
340 12 9/19/2006 15:49 331 13.5 9/19/2006 16:18 
738 12 9/19/2006 15:49 357 13.5 9/19/2006 16:18 

1237 12 9/19/2006 15:49 351 13.5 9/19/2006 16:18 
1197 12 9/19/2006 15:49 524 13.5 9/19/2006 16:18 
787 12 9/19/2006 15:49 1129 13.5 9/19/2006 16:18 

2133 12 9/19/2006 15:50 689 13.5 9/19/2006 16:18 
924 12 9/19/2006 15:50 396 13.5 9/19/2006 16:18 
926 12 9/19/2006 15:50 335 13.5 9/19/2006 16:18 

1178 12 9/19/2006 15:50 402 13.5 9/19/2006 16:18 
593 12 9/19/2006 15:50 416 13.5 9/19/2006 16:18 
466 12 9/19/2006 15:50 541 13.5 9/19/2006 16:18 
776 12 9/19/2006 15:50 618 13.5 9/19/2006 16:18 
907 12 9/19/2006 15:50 601 13.5 9/19/2006 16:18 

1188 12 9/19/2006 15:50 141 13.5 9/19/2006 16:18 
1889 12 9/19/2006 15:50 77.9 13.5 9/19/2006 16:18 
1643 12 9/19/2006 15:50 143 13.5 9/19/2006 16:18 
1274 12 9/19/2006 15:50 289 13.5 9/19/2006 16:18 
2515 12 9/19/2006 15:50 310 13.5 9/19/2006 16:18 
2325 12 9/19/2006 15:50 100 13.5 9/19/2006 16:18 
419 12 9/19/2006 15:50 47.1 13.5 9/19/2006 16:18 
871 12 9/19/2006 15:50 51.3 13.5 9/19/2006 16:18 

1510 12 9/19/2006 15:50 60.6 13.5 9/19/2006 16:18 
1979 12 9/19/2006 15:50 53.3 13.5 9/19/2006 16:18 
1780 12 9/19/2006 15:50 47.1 13.5 9/19/2006 16:18 
1495 12 9/19/2006 15:50 45 13.5 9/19/2006 16:18 
1752 12 9/19/2006 15:50 40.9 13.5 9/19/2006 16:18 
2411 12 9/19/2006 15:50 42.2 13.5 9/19/2006 16:18 
1759 12 9/19/2006 15:50 30.8 13.5 9/19/2006 16:18 
1291 12 9/19/2006 15:50 30.8 13.5 9/19/2006 16:18 
1183 12 9/19/2006 15:50 30.6 13.5 9/19/2006 16:18 
1435 12 9/19/2006 15:50 30.8 13.5 9/19/2006 16:18 
1916 12 9/19/2006 15:50 30.6 13.5 9/19/2006 16:18 
896 12 9/19/2006 15:50 30.7 13.5 9/19/2006 16:18 
479 12 9/19/2006 15:50 30.8 13.5 9/19/2006 16:19 
451 12 9/19/2006 15:50 30.9 13.5 9/19/2006 16:19 
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Path Measurement Data 
Site 2 Path 1 

Path Measurement Data 
Site 2 Path 2 

ppm*m pathlength 
Timestamp 

(Eastern time) ppm*m pathlength 
Timestamp 

(Eastern time) 
559 12 9/19/2006 15:50 31 13.5 9/19/2006 16:19 

1381 12 9/19/2006 15:50 30.8 13.5 9/19/2006 16:19 
967 12 9/19/2006 15:51 31 13.5 9/19/2006 16:19 

1356 12 9/19/2006 15:51 30.7 13.5 9/19/2006 16:19 
1790 12 9/19/2006 15:51    
2540 12 9/19/2006 15:51    
1216 12 9/19/2006 15:51    
1837 12 9/19/2006 15:51    
1603 12 9/19/2006 15:51    
1347 12 9/19/2006 15:51    
2251 12 9/19/2006 15:51    
1870 12 9/19/2006 15:51    
1070 12 9/19/2006 15:51    
2572 12 9/19/2006 15:51    
2384 12 9/19/2006 15:51    
1524 12 9/19/2006 15:51    
818 12 9/19/2006 15:51    
386 12 9/19/2006 15:51    
160 12 9/19/2006 15:51    
89.3 12 9/19/2006 15:51    
648 12 9/19/2006 15:51    
476 12 9/19/2006 15:51    
947 12 9/19/2006 15:51    
445 12 9/19/2006 15:51    
533 12 9/19/2006 15:51    
472 12 9/19/2006 15:51    

1247 12 9/19/2006 15:51    
1116 12 9/19/2006 15:51    
1017 12 9/19/2006 15:51    
1089 12 9/19/2006 15:51    
1260 12 9/19/2006 15:51    
547 12 9/19/2006 15:51    

1318 12 9/19/2006 15:51    
1243 12 9/19/2006 15:52    
1892 12 9/19/2006 15:52    
1835 12 9/19/2006 15:52    
1640 12 9/19/2006 15:52    
2184 12 9/19/2006 15:52    
1343 12 9/19/2006 15:52    
217 12 9/19/2006 15:52    
151 12 9/19/2006 15:52    
149 12 9/19/2006 15:52    
337 12 9/19/2006 15:52    

1133 12 9/19/2006 15:52    
226 12 9/19/2006 15:52    
56.6 12 9/19/2006 15:52    
2516 12 9/19/2006 15:52    
1628 12 9/19/2006 15:52    
1203 12 9/19/2006 15:52    
1814 12 9/19/2006 15:52    
1795 12 9/19/2006 15:52    
1505 12 9/19/2006 15:52    
1604 12 9/19/2006 15:52    
1426 12 9/19/2006 15:52    
486 12 9/19/2006 15:52    
506 12 9/19/2006 15:52    
763 12 9/19/2006 15:52    
605 12 9/19/2006 15:52    

1574 12 9/19/2006 15:52    
1038 12 9/19/2006 15:52    
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Path Measurement Data 
Site 2 Path 1 

Path Measurement Data 
Site 2 Path 2 

ppm*m pathlength 
Timestamp 

(Eastern time) ppm*m pathlength 
Timestamp 

(Eastern time) 
782 12 9/19/2006 15:53    
531 12 9/19/2006 15:53    
589 12 9/19/2006 15:53    
409 12 9/19/2006 15:53    

1304 12 9/19/2006 15:53    
1039 12 9/19/2006 15:53    
2557 12 9/19/2006 15:53    
2340 12 9/19/2006 15:53    
379 12 9/19/2006 15:53    

2238 12 9/19/2006 15:53    
866 12 9/19/2006 15:53    
250 12 9/19/2006 15:53    
254 12 9/19/2006 15:53    
51.9 12 9/19/2006 15:53    
1770 12 9/19/2006 15:53    
2147 12 9/19/2006 15:53    
1146 12 9/19/2006 15:53    
2157 12 9/19/2006 15:53    
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Path Measurement Data 

Site 2 Path 3 
Path Measurement Data 

Site 2 Path 4 

ppm*m pathlength 
Timestamp 

(Mountain time) ppm*m pathlength 
Timestamp 

(Mountain time) 
150 20 9/19/2006 14:33 42.9 20 9/19/2006 15:01 
171 20 9/19/2006 14:33 43 20 9/19/2006 15:01 
97 20 9/19/2006 14:33 43.2 20 9/19/2006 15:01 

60.3 20 9/19/2006 14:33 42.9 20 9/19/2006 15:01 
69.3 20 9/19/2006 14:34 42.9 20 9/19/2006 15:01 
67.7 20 9/19/2006 14:34 42.9 20 9/19/2006 15:01 
64.3 20 9/19/2006 14:34 42.9 20 9/19/2006 15:01 
81.4 20 9/19/2006 14:34 43.1 20 9/19/2006 15:01 
107 20 9/19/2006 14:34 43.1 20 9/19/2006 15:01 
115 20 9/19/2006 14:34 42.8 20 9/19/2006 15:01 
178 20 9/19/2006 14:34 43.1 20 9/19/2006 15:01 
182 20 9/19/2006 14:34 42.9 20 9/19/2006 15:01 
281 20 9/19/2006 14:34 42.8 20 9/19/2006 15:01 
533 20 9/19/2006 14:34 42.9 20 9/19/2006 15:02 
628 20 9/19/2006 14:34 42.9 20 9/19/2006 15:02 
328 20 9/19/2006 14:34 42.8 20 9/19/2006 15:02 
446 20 9/19/2006 14:34 43 20 9/19/2006 15:02 
496 20 9/19/2006 14:34 42.7 20 9/19/2006 15:02 
384 20 9/19/2006 14:34 43.3 20 9/19/2006 15:02 
225 20 9/19/2006 14:34 42.9 20 9/19/2006 15:02 
170 20 9/19/2006 14:34 42.8 20 9/19/2006 15:02 
95.3 20 9/19/2006 14:34 42.7 20 9/19/2006 15:02 
113 20 9/19/2006 14:34 42.5 20 9/19/2006 15:02 
225 20 9/19/2006 14:34 43.1 20 9/19/2006 15:02 
162 20 9/19/2006 14:34 42.7 20 9/19/2006 15:02 
175 20 9/19/2006 14:34 42.7 20 9/19/2006 15:02 
221 20 9/19/2006 14:34 42.8 20 9/19/2006 15:02 
272 20 9/19/2006 14:34 43 20 9/19/2006 15:02 
220 20 9/19/2006 14:34 42.7 20 9/19/2006 15:02 
471 20 9/19/2006 14:34 42.9 20 9/19/2006 15:02 
637 20 9/19/2006 14:34 42.7 20 9/19/2006 15:02 
611 20 9/19/2006 14:34 42.8 20 9/19/2006 15:02 
536 20 9/19/2006 14:34 42.7 20 9/19/2006 15:02 
444 20 9/19/2006 14:34 42.8 20 9/19/2006 15:02 
385 20 9/19/2006 14:34 42.8 20 9/19/2006 15:02 
322 20 9/19/2006 14:34 42.6 20 9/19/2006 15:02 
237 20 9/19/2006 14:34 47.1 20 9/19/2006 15:02 
167 20 9/19/2006 14:34 45.7 20 9/19/2006 15:02 
156 20 9/19/2006 14:35 44.2 20 9/19/2006 15:02 
157 20 9/19/2006 14:35 45.2 20 9/19/2006 15:02 
151 20 9/19/2006 14:35 44.4 20 9/19/2006 15:02 
126 20 9/19/2006 14:35 43.3 20 9/19/2006 15:02 
166 20 9/19/2006 14:35 43 20 9/19/2006 15:02 
158 20 9/19/2006 14:35 42.7 20 9/19/2006 15:02 
195 20 9/19/2006 14:35 43 20 9/19/2006 15:02 
175 20 9/19/2006 14:35 42.9 20 9/19/2006 15:02 
124 20 9/19/2006 14:35 43 20 9/19/2006 15:02 
178 20 9/19/2006 14:35 42.7 20 9/19/2006 15:03 
163 20 9/19/2006 14:35 42.9 20 9/19/2006 15:03 
399 20 9/19/2006 14:35 42.5 20 9/19/2006 15:03 
557 20 9/19/2006 14:35 42.9 20 9/19/2006 15:03 
656 20 9/19/2006 14:35 42.6 20 9/19/2006 15:03 
420 20 9/19/2006 14:35 43 20 9/19/2006 15:03 
649 20 9/19/2006 14:35 43 20 9/19/2006 15:03 
468 20 9/19/2006 14:35 43 20 9/19/2006 15:03 
362 20 9/19/2006 14:35 43 20 9/19/2006 15:03 
320 20 9/19/2006 14:35 43.1 20 9/19/2006 15:03 
274 20 9/19/2006 14:35 42.9 20 9/19/2006 15:03 
252 20 9/19/2006 14:35 43.1 20 9/19/2006 15:03 

189



Path Measurement Data 
Site 2 Path 3 

Path Measurement Data 
Site 2 Path 4 

ppm*m pathlength 
Timestamp 

(Mountain time) ppm*m pathlength 
Timestamp 

(Mountain time) 
248 20 9/19/2006 14:35 43.6 20 9/19/2006 15:03 
192 20 9/19/2006 14:35 43.1 20 9/19/2006 15:03 
204 20 9/19/2006 14:35 43.1 20 9/19/2006 15:03 
253 20 9/19/2006 14:35 42.9 20 9/19/2006 15:03 
224 20 9/19/2006 14:35 43 20 9/19/2006 15:03 
269 20 9/19/2006 14:35 43.1 20 9/19/2006 15:03 
252 20 9/19/2006 14:35 43.1 20 9/19/2006 15:03 
253 20 9/19/2006 14:35 43 20 9/19/2006 15:03 
283 20 9/19/2006 14:35 43.4 20 9/19/2006 15:03 
275 20 9/19/2006 14:35 44.4 20 9/19/2006 15:03 
222 20 9/19/2006 14:35 56.7 20 9/19/2006 15:03 
160 20 9/19/2006 14:35 91.2 20 9/19/2006 15:03 
138 20 9/19/2006 14:35 155 20 9/19/2006 15:03 
116 20 9/19/2006 14:36 207 20 9/19/2006 15:03 
75.9 20 9/19/2006 14:36 202 20 9/19/2006 15:03 
244 20 9/19/2006 14:36 217 20 9/19/2006 15:03 
168 20 9/19/2006 14:36 224 20 9/19/2006 15:03 
85.7 20 9/19/2006 14:36 217 20 9/19/2006 15:03 
50.8 20 9/19/2006 14:36 198 20 9/19/2006 15:03 
52.9 20 9/19/2006 14:36 181 20 9/19/2006 15:03 
53.6 20 9/19/2006 14:36 142 20 9/19/2006 15:03 
49.3 20 9/19/2006 14:36 134 20 9/19/2006 15:03 
44.8 20 9/19/2006 14:36 116 20 9/19/2006 15:04 
44.2 20 9/19/2006 14:36 102 20 9/19/2006 15:04 
49.9 20 9/19/2006 14:36 95.2 20 9/19/2006 15:04 
56.7 20 9/19/2006 14:36 85.4 20 9/19/2006 15:04 
75.3 20 9/19/2006 14:36 240 20 9/19/2006 15:04 
115 20 9/19/2006 14:36 336 20 9/19/2006 15:04 
298 20 9/19/2006 14:36 1205 20 9/19/2006 15:04 
341 20 9/19/2006 14:36 1117 20 9/19/2006 15:04 
343 20 9/19/2006 14:36 1041 20 9/19/2006 15:04 
336 20 9/19/2006 14:36 527 20 9/19/2006 15:04 
366 20 9/19/2006 14:36 390 20 9/19/2006 15:04 
367 20 9/19/2006 14:36 707 20 9/19/2006 15:04 
262 20 9/19/2006 14:36 807 20 9/19/2006 15:04 
249 20 9/19/2006 14:36 861 20 9/19/2006 15:04 
225 20 9/19/2006 14:36 1142 20 9/19/2006 15:04 
197 20 9/19/2006 14:36 762 20 9/19/2006 15:04 
177 20 9/19/2006 14:36 700 20 9/19/2006 15:04 
152 20 9/19/2006 14:36 442 20 9/19/2006 15:04 
144 20 9/19/2006 14:36 287 20 9/19/2006 15:04 
118 20 9/19/2006 14:36 212 20 9/19/2006 15:04 
110 20 9/19/2006 14:36 121 20 9/19/2006 15:04 
100 20 9/19/2006 14:36 66.8 20 9/19/2006 15:04 
101 20 9/19/2006 14:36 57.8 20 9/19/2006 15:04 
137 20 9/19/2006 14:36 84.5 20 9/19/2006 15:04 
157 20 9/19/2006 14:37 110 20 9/19/2006 15:04 
150 20 9/19/2006 14:37 95.2 20 9/19/2006 15:04 
390 20 9/19/2006 14:37 72.8 20 9/19/2006 15:04 
452 20 9/19/2006 14:37 68.1 20 9/19/2006 15:04 
364 20 9/19/2006 14:37 54.1 20 9/19/2006 15:04 
367 20 9/19/2006 14:37 50.9 20 9/19/2006 15:04 
366 20 9/19/2006 14:37 49 20 9/19/2006 15:04 
633 20 9/19/2006 14:37 45.6 20 9/19/2006 15:04 

1057 20 9/19/2006 14:37 44 20 9/19/2006 15:04 
638 20 9/19/2006 14:37 43.6 20 9/19/2006 15:05 
559 20 9/19/2006 14:37 43.3 20 9/19/2006 15:05 
803 20 9/19/2006 14:37 43.8 20 9/19/2006 15:05 
967 20 9/19/2006 14:37 43.1 20 9/19/2006 15:05 
572 20 9/19/2006 14:37 42.6 20 9/19/2006 15:05 
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Path Measurement Data 
Site 2 Path 3 

Path Measurement Data 
Site 2 Path 4 

ppm*m pathlength 
Timestamp 

(Mountain time) ppm*m pathlength 
Timestamp 

(Mountain time) 
399 20 9/19/2006 14:37 42.6 20 9/19/2006 15:05 
172 20 9/19/2006 14:37 42.5 20 9/19/2006 15:05 
60 20 9/19/2006 14:37 42.5 20 9/19/2006 15:05 

75.5 20 9/19/2006 14:37 42.6 20 9/19/2006 15:05 
83.7 20 9/19/2006 14:37 42.2 20 9/19/2006 15:05 
88.1 20 9/19/2006 14:37 41.8 20 9/19/2006 15:05 
106 20 9/19/2006 14:37 42.4 20 9/19/2006 15:05 
95.3 20 9/19/2006 14:37 42.2 20 9/19/2006 15:05 
90.2 20 9/19/2006 14:37 42.4 20 9/19/2006 15:05 
91.4 20 9/19/2006 14:37 42.5 20 9/19/2006 15:05 
90.4 20 9/19/2006 14:37 42.4 20 9/19/2006 15:05 
94.5 20 9/19/2006 14:37 42.2 20 9/19/2006 15:05 
103 20 9/19/2006 14:37 42.1 20 9/19/2006 15:05 
110 20 9/19/2006 14:37 42.3 20 9/19/2006 15:05 
106 20 9/19/2006 14:37 42.1 20 9/19/2006 15:05 
88.3 20 9/19/2006 14:37 42.3 20 9/19/2006 15:05 
50.8 20 9/19/2006 14:37 42.3 20 9/19/2006 15:05 
93.4 20 9/19/2006 14:37 42.3 20 9/19/2006 15:05 
122 20 9/19/2006 14:37 42 20 9/19/2006 15:05 
204 20 9/19/2006 14:37 42.2 20 9/19/2006 15:05 
188 20 9/19/2006 14:38 42.1 20 9/19/2006 15:05 
145 20 9/19/2006 14:38 42.3 20 9/19/2006 15:05 
127 20 9/19/2006 14:38 42.2 20 9/19/2006 15:05 
108 20 9/19/2006 14:38 42.4 20 9/19/2006 15:05 
102 20 9/19/2006 14:38 42.4 20 9/19/2006 15:05 
108 20 9/19/2006 14:38 42.2 20 9/19/2006 15:05 
97 20 9/19/2006 14:38 42.7 20 9/19/2006 15:05 

102 20 9/19/2006 14:38 42.6 20 9/19/2006 15:05 
207 20 9/19/2006 14:38 42.1 20 9/19/2006 15:05 
256 20 9/19/2006 14:38 42.3 20 9/19/2006 15:05 
220 20 9/19/2006 14:38 42.4 20 9/19/2006 15:06 
147 20 9/19/2006 14:38 41.4 20 9/19/2006 15:06 
156 20 9/19/2006 14:38 41.8 20 9/19/2006 15:06 
116 20 9/19/2006 14:38 41.6 20 9/19/2006 15:06 
70.9 20 9/19/2006 14:38 41.6 20 9/19/2006 15:06 
52.4 20 9/19/2006 14:38 41.6 20 9/19/2006 15:06 
48.1 20 9/19/2006 14:38 42 20 9/19/2006 15:06 
47.6 20 9/19/2006 14:38 41.7 20 9/19/2006 15:06 
44.7 20 9/19/2006 14:38 42.5 20 9/19/2006 15:06 
42.8 20 9/19/2006 14:38 375 20 9/19/2006 15:06 
41.2 20 9/19/2006 14:38 819 20 9/19/2006 15:06 
41.5 20 9/19/2006 14:38 273 20 9/19/2006 15:06 
41.4 20 9/19/2006 14:38 137 20 9/19/2006 15:06 
42.2 20 9/19/2006 14:38 171 20 9/19/2006 15:06 
41.9 20 9/19/2006 14:38 61.6 20 9/19/2006 15:06 
42.4 20 9/19/2006 14:38 51.7 20 9/19/2006 15:06 
42.9 20 9/19/2006 14:38 53.8 20 9/19/2006 15:06 
42.6 20 9/19/2006 14:38 41.9 20 9/19/2006 15:06 
41.6 20 9/19/2006 14:38 41.9 20 9/19/2006 15:06 
41.8 20 9/19/2006 14:38 42.1 20 9/19/2006 15:06 
41.6 20 9/19/2006 14:38 58.8 20 9/19/2006 15:06 
41.8 20 9/19/2006 14:38 77.2 20 9/19/2006 15:06 
41.4 20 9/19/2006 14:38 63.5 20 9/19/2006 15:06 
41.4 20 9/19/2006 14:38 56.8 20 9/19/2006 15:06 
41.5 20 9/19/2006 14:39 58.8 20 9/19/2006 15:06 
41.1 20 9/19/2006 14:39 52.2 20 9/19/2006 15:06 
41.2 20 9/19/2006 14:39 49.4 20 9/19/2006 15:06 
41.1 20 9/19/2006 14:39 45.4 20 9/19/2006 15:06 
46.5 20 9/19/2006 14:39 47.6 20 9/19/2006 15:06 
236 20 9/19/2006 14:39 41.9 20 9/19/2006 15:06 
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Path Measurement Data 
Site 2 Path 3 

Path Measurement Data 
Site 2 Path 4 

ppm*m pathlength 
Timestamp 

(Mountain time) ppm*m pathlength 
Timestamp 

(Mountain time) 
288 20 9/19/2006 14:39 41.5 20 9/19/2006 15:06 
135 20 9/19/2006 14:39 41.9 20 9/19/2006 15:06 
108 20 9/19/2006 14:39 41.8 20 9/19/2006 15:06 
98.2 20 9/19/2006 14:39 41.8 20 9/19/2006 15:07 
111 20 9/19/2006 14:39 41.9 20 9/19/2006 15:07 
241 20 9/19/2006 14:39 41.7 20 9/19/2006 15:07 
211 20 9/19/2006 14:39 41.5 20 9/19/2006 15:07 
149 20 9/19/2006 14:39 41.7 20 9/19/2006 15:07 
92.5 20 9/19/2006 14:39 41.8 20 9/19/2006 15:07 
71.5 20 9/19/2006 14:39 42 20 9/19/2006 15:07 
70.5 20 9/19/2006 14:39 41.5 20 9/19/2006 15:07 
64.9 20 9/19/2006 14:39 41.4 20 9/19/2006 15:07 
99.7 20 9/19/2006 14:39 41.7 20 9/19/2006 15:07 
154 20 9/19/2006 14:39 41.9 20 9/19/2006 15:07 
163 20 9/19/2006 14:39 41.9 20 9/19/2006 15:07 
160 20 9/19/2006 14:39 41.7 20 9/19/2006 15:07 
126 20 9/19/2006 14:39 41.8 20 9/19/2006 15:07 
112 20 9/19/2006 14:39 42.1 20 9/19/2006 15:07 
91.2 20 9/19/2006 14:39 42.1 20 9/19/2006 15:07 
70 20 9/19/2006 14:39 42 20 9/19/2006 15:07 

75.5 20 9/19/2006 14:39 41.7 20 9/19/2006 15:07 
68.1 20 9/19/2006 14:39 41.6 20 9/19/2006 15:07 
84.2 20 9/19/2006 14:39 41.4 20 9/19/2006 15:07 
59.5 20 9/19/2006 14:39 41.5 20 9/19/2006 15:07 
41.6 20 9/19/2006 14:39 41.7 20 9/19/2006 15:07 
40.5 20 9/19/2006 14:39 41.5 20 9/19/2006 15:07 
40.9 20 9/19/2006 14:39 41.8 20 9/19/2006 15:07 
41.1 20 9/19/2006 14:39 41.5 20 9/19/2006 15:07 
40.9 20 9/19/2006 14:40 41.3 20 9/19/2006 15:07 
41.1 20 9/19/2006 14:40 41.4 20 9/19/2006 15:07 
41.2 20 9/19/2006 14:40 41.6 20 9/19/2006 15:07 
41 20 9/19/2006 14:40 41.5 20 9/19/2006 15:07 

40.9 20 9/19/2006 14:40 41.5 20 9/19/2006 15:07 
40.9 20 9/19/2006 14:40 41.9 20 9/19/2006 15:07 
41.3 20 9/19/2006 14:40 41.8 20 9/19/2006 15:07 
41.1 20 9/19/2006 14:40 41.9 20 9/19/2006 15:07 
41 20 9/19/2006 14:40 41.7 20 9/19/2006 15:07 

40.8 20 9/19/2006 14:40 41.6 20 9/19/2006 15:08 
40.8 20 9/19/2006 14:40 41.6 20 9/19/2006 15:08 
41.1 20 9/19/2006 14:40 41.4 20 9/19/2006 15:08 
41.1 20 9/19/2006 14:40 41.7 20 9/19/2006 15:08 
41 20 9/19/2006 14:40 41.6 20 9/19/2006 15:08 

41.7 20 9/19/2006 14:40 41.5 20 9/19/2006 15:08 
43 20 9/19/2006 14:40 41.5 20 9/19/2006 15:08 

42.9 20 9/19/2006 14:40 41.7 20 9/19/2006 15:08 
82.2 20 9/19/2006 14:40 41.8 20 9/19/2006 15:08 
79.2 20 9/19/2006 14:40 41.8 20 9/19/2006 15:08 
70.1 20 9/19/2006 14:40 41.4 20 9/19/2006 15:08 
49.9 20 9/19/2006 14:40 41.7 20 9/19/2006 15:08 
44.7 20 9/19/2006 14:40 41.4 20 9/19/2006 15:08 
40.9 20 9/19/2006 14:40 41.6 20 9/19/2006 15:08 
41 20 9/19/2006 14:40 41.7 20 9/19/2006 15:08 

41.1 20 9/19/2006 14:40 41.7 20 9/19/2006 15:08 
41 20 9/19/2006 14:40 41.6 20 9/19/2006 15:08 
41 20 9/19/2006 14:40 41.4 20 9/19/2006 15:08 
41 20 9/19/2006 14:40 41.6 20 9/19/2006 15:08 

40.9 20 9/19/2006 14:40 41.4 20 9/19/2006 15:08 
40.9 20 9/19/2006 14:40 41.2 20 9/19/2006 15:08 
41.5 20 9/19/2006 14:40 41.5 20 9/19/2006 15:08 
41.4 20 9/19/2006 14:40 41.9 20 9/19/2006 15:08 
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Path Measurement Data 
Site 2 Path 3 

Path Measurement Data 
Site 2 Path 4 

ppm*m pathlength 
Timestamp 

(Mountain time) ppm*m pathlength 
Timestamp 

(Mountain time) 
41 20 9/19/2006 14:40 41.7 20 9/19/2006 15:08 

40.8 20 9/19/2006 14:40 41.7 20 9/19/2006 15:08 
40.8 20 9/19/2006 14:41 41.5 20 9/19/2006 15:08 
41.1 20 9/19/2006 14:41 41.6 20 9/19/2006 15:08 
48.5 20 9/19/2006 14:41 41.6 20 9/19/2006 15:08 
43.5 20 9/19/2006 14:41 41.4 20 9/19/2006 15:08 
43.5 20 9/19/2006 14:41 41.4 20 9/19/2006 15:08 
41 20 9/19/2006 14:41 41.6 20 9/19/2006 15:08 

40.8 20 9/19/2006 14:41 41.3 20 9/19/2006 15:08 
41.1 20 9/19/2006 14:41 41.6 20 9/19/2006 15:08 
41 20 9/19/2006 14:41 41.7 20 9/19/2006 15:08 
41 20 9/19/2006 14:41 41.6 20 9/19/2006 15:09 
41 20 9/19/2006 14:41 41.6 20 9/19/2006 15:09 

40.9 20 9/19/2006 14:41 41.5 20 9/19/2006 15:09 
41 20 9/19/2006 14:41 41.5 20 9/19/2006 15:09 

40.8 20 9/19/2006 14:41 41.7 20 9/19/2006 15:09 
40.8 20 9/19/2006 14:41 42 20 9/19/2006 15:09 
40.6 20 9/19/2006 14:41 41.5 20 9/19/2006 15:09 
41 20 9/19/2006 14:41 41.8 20 9/19/2006 15:09 
41 20 9/19/2006 14:41 41.7 20 9/19/2006 15:09 

40.9 20 9/19/2006 14:41 42 20 9/19/2006 15:09 
40.7 20 9/19/2006 14:41 41.6 20 9/19/2006 15:09 
40.7 20 9/19/2006 14:41 41.9 20 9/19/2006 15:09 
41 20 9/19/2006 14:41 41.6 20 9/19/2006 15:09 

40.7 20 9/19/2006 14:41 41.8 20 9/19/2006 15:09 
40.9 20 9/19/2006 14:41 41.8 20 9/19/2006 15:09 
40.6 20 9/19/2006 14:41 41.7 20 9/19/2006 15:09 
40.9 20 9/19/2006 14:41 41.6 20 9/19/2006 15:09 
41.2 20 9/19/2006 14:41 41.6 20 9/19/2006 15:09 
40.7 20 9/19/2006 14:41 41.8 20 9/19/2006 15:09 
40.8 20 9/19/2006 14:41 41.8 20 9/19/2006 15:09 
40.9 20 9/19/2006 14:41 41.5 20 9/19/2006 15:09 
41 20 9/19/2006 14:41 41.7 20 9/19/2006 15:09 

41.1 20 9/19/2006 14:41 41.8 20 9/19/2006 15:09 
41.3 20 9/19/2006 14:41 41.7 20 9/19/2006 15:09 
43.4 20 9/19/2006 14:41 44.1 20 9/19/2006 15:09 
50.7 20 9/19/2006 14:42 50.9 20 9/19/2006 15:09 
69.3 20 9/19/2006 14:42 55.3 20 9/19/2006 15:09 
56.4 20 9/19/2006 14:42 63.1 20 9/19/2006 15:09 
44.1 20 9/19/2006 14:42 47.9 20 9/19/2006 15:09 
50.4 20 9/19/2006 14:42 44.1 20 9/19/2006 15:09 
126 20 9/19/2006 14:42 66.5 20 9/19/2006 15:09 
202 20 9/19/2006 14:42 82.4 20 9/19/2006 15:09 
88.7 20 9/19/2006 14:42 87.6 20 9/19/2006 15:09 
42 20 9/19/2006 14:42 71.9 20 9/19/2006 15:09 

40.9 20 9/19/2006 14:42 48.9 20 9/19/2006 15:10 
40.9 20 9/19/2006 14:42 42.9 20 9/19/2006 15:10 
41.1 20 9/19/2006 14:42 43.8 20 9/19/2006 15:10 
41 20 9/19/2006 14:42 46.5 20 9/19/2006 15:10 

40.8 20 9/19/2006 14:42 42.3 20 9/19/2006 15:10 
41 20 9/19/2006 14:42 42 20 9/19/2006 15:10 
41 20 9/19/2006 14:42 42 20 9/19/2006 15:10 

41.5 20 9/19/2006 14:42 41.7 20 9/19/2006 15:10 
42.7 20 9/19/2006 14:42 41.9 20 9/19/2006 15:10 
42 20 9/19/2006 14:42 41.9 20 9/19/2006 15:10 

41.4 20 9/19/2006 14:42 41.8 20 9/19/2006 15:10 
40.9 20 9/19/2006 14:42 41.8 20 9/19/2006 15:10 
41.7 20 9/19/2006 14:42 41.6 20 9/19/2006 15:10 
41.6 20 9/19/2006 14:42 41.6 20 9/19/2006 15:10 
40.9 20 9/19/2006 14:42 41.7 20 9/19/2006 15:10 
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Path Measurement Data 
Site 2 Path 3 

Path Measurement Data 
Site 2 Path 4 

ppm*m pathlength 
Timestamp 

(Mountain time) ppm*m pathlength 
Timestamp 

(Mountain time) 
41.1 20 9/19/2006 14:42 41.7 20 9/19/2006 15:10 
41.1 20 9/19/2006 14:42 42 20 9/19/2006 15:10 
41 20 9/19/2006 14:42 75 20 9/19/2006 15:10 

40.8 20 9/19/2006 14:42 400 20 9/19/2006 15:10 
40.8 20 9/19/2006 14:42 1201 20 9/19/2006 15:10 
41.1 20 9/19/2006 14:42 373 20 9/19/2006 15:10 
41.2 20 9/19/2006 14:42 729 20 9/19/2006 15:10 
41.3 20 9/19/2006 14:42 836 20 9/19/2006 15:10 
41.2 20 9/19/2006 14:42 851 20 9/19/2006 15:10 
41 20 9/19/2006 14:42 506 20 9/19/2006 15:10 

41.4 20 9/19/2006 14:43 531 20 9/19/2006 15:10 
41 20 9/19/2006 14:43 416 20 9/19/2006 15:10 
41 20 9/19/2006 14:43 491 20 9/19/2006 15:10 

41.1 20 9/19/2006 14:43 446 20 9/19/2006 15:10 
40.8 20 9/19/2006 14:43 510 20 9/19/2006 15:10 
40.7 20 9/19/2006 14:43 471 20 9/19/2006 15:10 
40.9 20 9/19/2006 14:43 341 20 9/19/2006 15:10 
40.9 20 9/19/2006 14:43 266 20 9/19/2006 15:10 
41.1 20 9/19/2006 14:43 250 20 9/19/2006 15:10 
41.1 20 9/19/2006 14:43 180 20 9/19/2006 15:11 
40.9 20 9/19/2006 14:43 173 20 9/19/2006 15:11 
41 20 9/19/2006 14:43 112 20 9/19/2006 15:11 
41 20 9/19/2006 14:43 120 20 9/19/2006 15:11 

41.2 20 9/19/2006 14:43 105 20 9/19/2006 15:11 
41 20 9/19/2006 14:43 84.3 20 9/19/2006 15:11 

40.8 20 9/19/2006 14:43 80.5 20 9/19/2006 15:11 
40.8 20 9/19/2006 14:43 62.7 20 9/19/2006 15:11 
40.6 20 9/19/2006 14:43 59.1 20 9/19/2006 15:11 
40.9 20 9/19/2006 14:43 58.5 20 9/19/2006 15:11 
41 20 9/19/2006 14:43 43.8 20 9/19/2006 15:11 
41 20 9/19/2006 14:43 42.6 20 9/19/2006 15:11 

40.9 20 9/19/2006 14:43 42.2 20 9/19/2006 15:11 
40.8 20 9/19/2006 14:43 42.6 20 9/19/2006 15:11 
41.2 20 9/19/2006 14:43 42.1 20 9/19/2006 15:11 
41 20 9/19/2006 14:43 42.5 20 9/19/2006 15:11 

40.9 20 9/19/2006 14:43 42.2 20 9/19/2006 15:11 
41 20 9/19/2006 14:43 42.4 20 9/19/2006 15:11 
41 20 9/19/2006 14:43 43.1 20 9/19/2006 15:11 
41 20 9/19/2006 14:43 43 20 9/19/2006 15:11 

40.9 20 9/19/2006 14:43 42.8 20 9/19/2006 15:11 
40.9 20 9/19/2006 14:43 43.3 20 9/19/2006 15:11 
41 20 9/19/2006 14:43 45 20 9/19/2006 15:11 

41.1 20 9/19/2006 14:43 55.7 20 9/19/2006 15:11 
41.1 20 9/19/2006 14:43 258 20 9/19/2006 15:11 
41.3 20 9/19/2006 14:44 576 20 9/19/2006 15:11 
41.2 20 9/19/2006 14:44 444 20 9/19/2006 15:11 
41 20 9/19/2006 14:44 319 20 9/19/2006 15:11 

41.1 20 9/19/2006 14:44 309 20 9/19/2006 15:11 
40.9 20 9/19/2006 14:44 289 20 9/19/2006 15:11 
40.9 20 9/19/2006 14:44 225 20 9/19/2006 15:11 
41 20 9/19/2006 14:44 207 20 9/19/2006 15:11 
41 20 9/19/2006 14:44 154 20 9/19/2006 15:11 

40.9 20 9/19/2006 14:44 133 20 9/19/2006 15:11 
41.1 20 9/19/2006 14:44 141 20 9/19/2006 15:12 
41.2 20 9/19/2006 14:44 63.6 20 9/19/2006 15:12 
40.9 20 9/19/2006 14:44 49.1 20 9/19/2006 15:12 
41.9 20 9/19/2006 14:44 42.9 20 9/19/2006 15:12 
45.5 20 9/19/2006 14:44 42.7 20 9/19/2006 15:12 
46.5 20 9/19/2006 14:44 42.4 20 9/19/2006 15:12 
47.6 20 9/19/2006 14:44 42.3 20 9/19/2006 15:12 
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Path Measurement Data 
Site 2 Path 3 

Path Measurement Data 
Site 2 Path 4 

ppm*m pathlength 
Timestamp 

(Mountain time) ppm*m pathlength 
Timestamp 

(Mountain time) 
46.8 20 9/19/2006 14:44 42.3 20 9/19/2006 15:12 
43.8 20 9/19/2006 14:44 42.1 20 9/19/2006 15:12 
42.5 20 9/19/2006 14:44 42.2 20 9/19/2006 15:12 
42.1 20 9/19/2006 14:44 42.5 20 9/19/2006 15:12 
42 20 9/19/2006 14:44 42.1 20 9/19/2006 15:12 

42.2 20 9/19/2006 14:44 42.3 20 9/19/2006 15:12 
42.4 20 9/19/2006 14:44 42.2 20 9/19/2006 15:12 
42.9 20 9/19/2006 14:44 42.3 20 9/19/2006 15:12 
42.8 20 9/19/2006 14:44 42.2 20 9/19/2006 15:12 
42.8 20 9/19/2006 14:44 42.4 20 9/19/2006 15:12 
43.2 20 9/19/2006 14:44 42.1 20 9/19/2006 15:12 
42.9 20 9/19/2006 14:44 41.8 20 9/19/2006 15:12 
42.6 20 9/19/2006 14:44 41.7 20 9/19/2006 15:12 
42.7 20 9/19/2006 14:44 41.9 20 9/19/2006 15:12 
43.1 20 9/19/2006 14:44 42 20 9/19/2006 15:12 
51.2 20 9/19/2006 14:44 42.1 20 9/19/2006 15:12 
65.3 20 9/19/2006 14:44 41.9 20 9/19/2006 15:12 
91 20 9/19/2006 14:44 41.8 20 9/19/2006 15:12 

86.4 20 9/19/2006 14:45 42 20 9/19/2006 15:12 
59.3 20 9/19/2006 14:45 42.1 20 9/19/2006 15:12 
49 20 9/19/2006 14:45 42 20 9/19/2006 15:12 

46.7 20 9/19/2006 14:45 42 20 9/19/2006 15:12 
46 20 9/19/2006 14:45 42 20 9/19/2006 15:12 

43.8 20 9/19/2006 14:45 42 20 9/19/2006 15:12 
45.1 20 9/19/2006 14:45 42 20 9/19/2006 15:12 
49.5 20 9/19/2006 14:45 75.5 20 9/19/2006 15:12 
56.4 20 9/19/2006 14:45 318 20 9/19/2006 15:12 
67.9 20 9/19/2006 14:45 174 20 9/19/2006 15:13 
90.4 20 9/19/2006 14:45 88.7 20 9/19/2006 15:13 
73.9 20 9/19/2006 14:45 144 20 9/19/2006 15:13 
147 20 9/19/2006 14:45 712 20 9/19/2006 15:13 
363 20 9/19/2006 14:45 416 20 9/19/2006 15:13 
416 20 9/19/2006 14:45 1220 20 9/19/2006 15:13 
267 20 9/19/2006 14:45 485 20 9/19/2006 15:13 
141 20 9/19/2006 14:45 264 20 9/19/2006 15:13 
121 20 9/19/2006 14:45 173 20 9/19/2006 15:13 
107 20 9/19/2006 14:45 103 20 9/19/2006 15:13 
89.6 20 9/19/2006 14:45 140 20 9/19/2006 15:13 
66 20 9/19/2006 14:45 93.7 20 9/19/2006 15:13 

58.5 20 9/19/2006 14:45 403 20 9/19/2006 15:13 
56.3 20 9/19/2006 14:45 263 20 9/19/2006 15:13 
52.1 20 9/19/2006 14:45 65.9 20 9/19/2006 15:13 
50.1 20 9/19/2006 14:45 205 20 9/19/2006 15:13 
49.7 20 9/19/2006 14:45 343 20 9/19/2006 15:13 
47.8 20 9/19/2006 14:45 604 20 9/19/2006 15:13 
46.1 20 9/19/2006 14:45 418 20 9/19/2006 15:13 
45.2 20 9/19/2006 14:45 283 20 9/19/2006 15:13 
44.1 20 9/19/2006 14:45 263 20 9/19/2006 15:13 
44.3 20 9/19/2006 14:45 263 20 9/19/2006 15:13 
44 20 9/19/2006 14:45 382 20 9/19/2006 15:13 

43.1 20 9/19/2006 14:45 360 20 9/19/2006 15:13 
43.1 20 9/19/2006 14:46 266 20 9/19/2006 15:13 
42.8 20 9/19/2006 14:46 245 20 9/19/2006 15:13 
42.6 20 9/19/2006 14:46 248 20 9/19/2006 15:13 
42.5 20 9/19/2006 14:46 239 20 9/19/2006 15:13 
65.6 20 9/19/2006 14:46 189 20 9/19/2006 15:13 
67.4 20 9/19/2006 14:46 172 20 9/19/2006 15:13 
60.4 20 9/19/2006 14:46 147 20 9/19/2006 15:13 
55.8 20 9/19/2006 14:46 111 20 9/19/2006 15:13 
56.3 20 9/19/2006 14:46 131 20 9/19/2006 15:14 
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Path Measurement Data 
Site 2 Path 3 

Path Measurement Data 
Site 2 Path 4 

ppm*m pathlength 
Timestamp 

(Mountain time) ppm*m pathlength 
Timestamp 

(Mountain time) 
61.8 20 9/19/2006 14:46 123 20 9/19/2006 15:14 
62.3 20 9/19/2006 14:46 67.6 20 9/19/2006 15:14 
50.8 20 9/19/2006 14:46 51.9 20 9/19/2006 15:14 
57.3 20 9/19/2006 14:46 43.3 20 9/19/2006 15:14 
65 20 9/19/2006 14:46 43 20 9/19/2006 15:14 

59.3 20 9/19/2006 14:46 42.9 20 9/19/2006 15:14 
80.7 20 9/19/2006 14:46 42.8 20 9/19/2006 15:14 
70.1 20 9/19/2006 14:46 42.8 20 9/19/2006 15:14 
68.8 20 9/19/2006 14:46 42.9 20 9/19/2006 15:14 
55.3 20 9/19/2006 14:46 42.4 20 9/19/2006 15:14 
48.4 20 9/19/2006 14:46 42.3 20 9/19/2006 15:14 
50.1 20 9/19/2006 14:46 42.2 20 9/19/2006 15:14 
55.3 20 9/19/2006 14:46 42.2 20 9/19/2006 15:14 
180 20 9/19/2006 14:46 42.2 20 9/19/2006 15:14 
94.9 20 9/19/2006 14:46 42.4 20 9/19/2006 15:14 
61.6 20 9/19/2006 14:46 42.1 20 9/19/2006 15:14 
242 20 9/19/2006 14:46 42.2 20 9/19/2006 15:14 
425 20 9/19/2006 14:46 42.4 20 9/19/2006 15:14 
455 20 9/19/2006 14:46 41.9 20 9/19/2006 15:14 
292 20 9/19/2006 14:46 42 20 9/19/2006 15:14 
262 20 9/19/2006 14:46 42 20 9/19/2006 15:14 
196 20 9/19/2006 14:46 41.9 20 9/19/2006 15:14 
154 20 9/19/2006 14:46 41.8 20 9/19/2006 15:14 
124 20 9/19/2006 14:46 42 20 9/19/2006 15:14 
50.6 20 9/19/2006 14:46 41.9 20 9/19/2006 15:14 
42.2 20 9/19/2006 14:46 42 20 9/19/2006 15:14 
41 20 9/19/2006 14:47 41.9 20 9/19/2006 15:14 

41.3 20 9/19/2006 14:47 42.2 20 9/19/2006 15:14 
41.2 20 9/19/2006 14:47 42.3 20 9/19/2006 15:14 
41.5 20 9/19/2006 14:47 42 20 9/19/2006 15:14 
41.2 20 9/19/2006 14:47 42.3 20 9/19/2006 15:14 
42.9 20 9/19/2006 14:47 42.4 20 9/19/2006 15:14 
44.4 20 9/19/2006 14:47 42.1 20 9/19/2006 15:14 
51.4 20 9/19/2006 14:47 42.2 20 9/19/2006 15:15 
69.3 20 9/19/2006 14:47 42.5 20 9/19/2006 15:15 
86.1 20 9/19/2006 14:47 42.2 20 9/19/2006 15:15 
100 20 9/19/2006 14:47 42.4 20 9/19/2006 15:15 
92.1 20 9/19/2006 14:47 43 20 9/19/2006 15:15 
87.9 20 9/19/2006 14:47 43.8 20 9/19/2006 15:15 
77.5 20 9/19/2006 14:47 64.8 20 9/19/2006 15:15 
93.5 20 9/19/2006 14:47 74.6 20 9/19/2006 15:15 
75.5 20 9/19/2006 14:47 108 20 9/19/2006 15:15 
64.9 20 9/19/2006 14:47 130 20 9/19/2006 15:15 
61.2 20 9/19/2006 14:47 220 20 9/19/2006 15:15 
63.4 20 9/19/2006 14:47 180 20 9/19/2006 15:15 
64.7 20 9/19/2006 14:47 197 20 9/19/2006 15:15 
60.4 20 9/19/2006 14:47 411 20 9/19/2006 15:15 
53.2 20 9/19/2006 14:47 1278 20 9/19/2006 15:15 
46.8 20 9/19/2006 14:47 1015 20 9/19/2006 15:15 
42.9 20 9/19/2006 14:47 373 20 9/19/2006 15:15 
41.1 20 9/19/2006 14:47 138 20 9/19/2006 15:15 
41.1 20 9/19/2006 14:47 159 20 9/19/2006 15:15 
41 20 9/19/2006 14:47 79.7 20 9/19/2006 15:15 
41 20 9/19/2006 14:47 86.2 20 9/19/2006 15:15 

41.2 20 9/19/2006 14:47 115 20 9/19/2006 15:15 
40.9 20 9/19/2006 14:47 221 20 9/19/2006 15:15 
40.7 20 9/19/2006 14:47 165 20 9/19/2006 15:15 
41.2 20 9/19/2006 14:47 67.4 20 9/19/2006 15:15 
41 20 9/19/2006 14:47 99 20 9/19/2006 15:15 

41.2 20 9/19/2006 14:48 60.5 20 9/19/2006 15:15 
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Path Measurement Data 
Site 2 Path 3 

Path Measurement Data 
Site 2 Path 4 

ppm*m pathlength 
Timestamp 

(Mountain time) ppm*m pathlength 
Timestamp 

(Mountain time) 
40.9 20 9/19/2006 14:48 44.9 20 9/19/2006 15:15 
41 20 9/19/2006 14:48 44 20 9/19/2006 15:15 
41 20 9/19/2006 14:48 50.4 20 9/19/2006 15:15 

41.3 20 9/19/2006 14:48 78.1 20 9/19/2006 15:15 
41.3 20 9/19/2006 14:48 97 20 9/19/2006 15:15 
41.1 20 9/19/2006 14:48 68.6 20 9/19/2006 15:15 
40.8 20 9/19/2006 14:48 52 20 9/19/2006 15:15 
41 20 9/19/2006 14:48 50.9 20 9/19/2006 15:16 

41.3 20 9/19/2006 14:48 48.4 20 9/19/2006 15:16 
41.3 20 9/19/2006 14:48 65.8 20 9/19/2006 15:16 
41.4 20 9/19/2006 14:48 64.8 20 9/19/2006 15:16 
41.2 20 9/19/2006 14:48 50.2 20 9/19/2006 15:16 
40.9 20 9/19/2006 14:48 42.7 20 9/19/2006 15:16 
40.6 20 9/19/2006 14:48 42.3 20 9/19/2006 15:16 
41.2 20 9/19/2006 14:48 42.4 20 9/19/2006 15:16 
41.1 20 9/19/2006 14:48 42.5 20 9/19/2006 15:16 
88.1 20 9/19/2006 14:48 42.8 20 9/19/2006 15:16 
279 20 9/19/2006 14:48 42.3 20 9/19/2006 15:16 
576 20 9/19/2006 14:48 42.2 20 9/19/2006 15:16 
550 20 9/19/2006 14:48 42.2 20 9/19/2006 15:16 
507 20 9/19/2006 14:48 42.9 20 9/19/2006 15:16 
406 20 9/19/2006 14:48 42.9 20 9/19/2006 15:16 
435 20 9/19/2006 14:48 42.9 20 9/19/2006 15:16 
382 20 9/19/2006 14:48 42.9 20 9/19/2006 15:16 
419 20 9/19/2006 14:48 42.9 20 9/19/2006 15:16 
426 20 9/19/2006 14:48 42.8 20 9/19/2006 15:16 
438 20 9/19/2006 14:48 43 20 9/19/2006 15:16 
343 20 9/19/2006 14:48 42.9 20 9/19/2006 15:16 
323 20 9/19/2006 14:48 42.8 20 9/19/2006 15:16 
244 20 9/19/2006 14:48 42.9 20 9/19/2006 15:16 
221 20 9/19/2006 14:48 42.8 20 9/19/2006 15:16 
198 20 9/19/2006 14:48 42.7 20 9/19/2006 15:16 
221 20 9/19/2006 14:49 42.8 20 9/19/2006 15:16 
196 20 9/19/2006 14:49 42.7 20 9/19/2006 15:16 
279 20 9/19/2006 14:49 42.7 20 9/19/2006 15:16 
589 20 9/19/2006 14:49 42.6 20 9/19/2006 15:16 
502 20 9/19/2006 14:49 42.9 20 9/19/2006 15:16 
399 20 9/19/2006 14:49 42.9 20 9/19/2006 15:16 
211 20 9/19/2006 14:49 42.8 20 9/19/2006 15:16 
246 20 9/19/2006 14:49 43 20 9/19/2006 15:16 
843 20 9/19/2006 14:49 43.1 20 9/19/2006 15:17 
501 20 9/19/2006 14:49 42.8 20 9/19/2006 15:17 
357 20 9/19/2006 14:49 43 20 9/19/2006 15:17 
256 20 9/19/2006 14:49 42.9 20 9/19/2006 15:17 
153 20 9/19/2006 14:49 42.9 20 9/19/2006 15:17 
94.3 20 9/19/2006 14:49 43 20 9/19/2006 15:17 
76.6 20 9/19/2006 14:49 42.3 20 9/19/2006 15:17 
69.3 20 9/19/2006 14:49 43 20 9/19/2006 15:17 
64.6 20 9/19/2006 14:49 43 20 9/19/2006 15:17 
62 20 9/19/2006 14:49 42.9 20 9/19/2006 15:17 
60 20 9/19/2006 14:49 42.6 20 9/19/2006 15:17 

127 20 9/19/2006 14:49 42.4 20 9/19/2006 15:17 
245 20 9/19/2006 14:49 42.8 20 9/19/2006 15:17 
117 20 9/19/2006 14:49 43 20 9/19/2006 15:17 
111 20 9/19/2006 14:49 42.8 20 9/19/2006 15:17 
133 20 9/19/2006 14:49 42.8 20 9/19/2006 15:17 
94 20 9/19/2006 14:49 42.7 20 9/19/2006 15:17 

78.4 20 9/19/2006 14:49 42.8 20 9/19/2006 15:17 
118 20 9/19/2006 14:49 42.7 20 9/19/2006 15:17 
154 20 9/19/2006 14:49 42.7 20 9/19/2006 15:17 
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Path Measurement Data 
Site 2 Path 3 

Path Measurement Data 
Site 2 Path 4 

ppm*m pathlength 
Timestamp 

(Mountain time) ppm*m pathlength 
Timestamp 

(Mountain time) 
596 20 9/19/2006 14:49 42.6 20 9/19/2006 15:17 
636 20 9/19/2006 14:49 42.9 20 9/19/2006 15:17 
505 20 9/19/2006 14:49 42.9 20 9/19/2006 15:17 
792 20 9/19/2006 14:49 42.4 20 9/19/2006 15:17 
371 20 9/19/2006 14:49 43 20 9/19/2006 15:17 
744 20 9/19/2006 14:49 42.8 20 9/19/2006 15:17 
574 20 9/19/2006 14:50 42.4 20 9/19/2006 15:17 
365 20 9/19/2006 14:50 42.6 20 9/19/2006 15:17 
259 20 9/19/2006 14:50 42.4 20 9/19/2006 15:17 
405 20 9/19/2006 14:50 42.9 20 9/19/2006 15:17 
280 20 9/19/2006 14:50 42.9 20 9/19/2006 15:17 
865 20 9/19/2006 14:50 43.2 20 9/19/2006 15:17 

1004 20 9/19/2006 14:50 43.5 20 9/19/2006 15:17 
721 20 9/19/2006 14:50 43.4 20 9/19/2006 15:18 
488 20 9/19/2006 14:50 43.1 20 9/19/2006 15:18 
254 20 9/19/2006 14:50 43.1 20 9/19/2006 15:18 
139 20 9/19/2006 14:50 43.5 20 9/19/2006 15:18 
119 20 9/19/2006 14:50 43.2 20 9/19/2006 15:18 
105 20 9/19/2006 14:50 43 20 9/19/2006 15:18 
106 20 9/19/2006 14:50 43.5 20 9/19/2006 15:18 
111 20 9/19/2006 14:50 43.5 20 9/19/2006 15:18 
149 20 9/19/2006 14:50 43.3 20 9/19/2006 15:18 
164 20 9/19/2006 14:50 43.1 20 9/19/2006 15:18 
145 20 9/19/2006 14:50 43.4 20 9/19/2006 15:18 
323 20 9/19/2006 14:50 43.3 20 9/19/2006 15:18 
417 20 9/19/2006 14:50 43.3 20 9/19/2006 15:18 
374 20 9/19/2006 14:50 43.3 20 9/19/2006 15:18 
456 20 9/19/2006 14:50 43.4 20 9/19/2006 15:18 
653 20 9/19/2006 14:50 43.4 20 9/19/2006 15:18 
664 20 9/19/2006 14:50 43.2 20 9/19/2006 15:18 
637 20 9/19/2006 14:50 43.5 20 9/19/2006 15:18 

1023 20 9/19/2006 14:50 43.3 20 9/19/2006 15:18 
1163 20 9/19/2006 14:50 43.4 20 9/19/2006 15:18 
397 20 9/19/2006 14:50 43.1 20 9/19/2006 15:18 
499 20 9/19/2006 14:50 43.4 20 9/19/2006 15:18 
890 20 9/19/2006 14:50 43.3 20 9/19/2006 15:18 
660 20 9/19/2006 14:50 43.5 20 9/19/2006 15:18 
317 20 9/19/2006 14:50 43.4 20 9/19/2006 15:18 
404 20 9/19/2006 14:50 43.6 20 9/19/2006 15:18 
683 20 9/19/2006 14:51 43.1 20 9/19/2006 15:18 
701 20 9/19/2006 14:51 43.2 20 9/19/2006 15:18 
391 20 9/19/2006 14:51 43 20 9/19/2006 15:18 
716 20 9/19/2006 14:51 43.4 20 9/19/2006 15:18 
553 20 9/19/2006 14:51 43.1 20 9/19/2006 15:18 
636 20 9/19/2006 14:51 43.1 20 9/19/2006 15:18 
574 20 9/19/2006 14:51 43.5 20 9/19/2006 15:18 
836 20 9/19/2006 14:51 43.8 20 9/19/2006 15:18 
884 20 9/19/2006 14:51    
375 20 9/19/2006 14:51 
214 20 9/19/2006 14:51 
145 20 9/19/2006 14:51 
111 20 9/19/2006 14:51 
127 20 9/19/2006 14:51 
163 20 9/19/2006 14:51 
108 20 9/19/2006 14:51 
80 20 9/19/2006 14:51 

89.3 20 9/19/2006 14:51 
71.4 20 9/19/2006 14:51 
58 20 9/19/2006 14:51 

60.8 20 9/19/2006 14:51 

198



Path Measurement Data 
Site 2 Path 3 

Path Measurement Data 
Site 2 Path 4 

ppm*m pathlength 
Timestamp 

(Mountain time) ppm*m pathlength 
Timestamp 

(Mountain time) 
55.6 20 9/19/2006 14:51 
66.3 20 9/19/2006 14:51 
91.7 20 9/19/2006 14:51 
123 20 9/19/2006 14:51 
114 20 9/19/2006 14:51 
109 20 9/19/2006 14:51 
96 20 9/19/2006 14:51 

92.8 20 9/19/2006 14:51 
96.6 20 9/19/2006 14:51 
84.8 20 9/19/2006 14:51 
77.1 20 9/19/2006 14:51 
68.5 20 9/19/2006 14:51 
73.2 20 9/19/2006 14:51 
71.7 20 9/19/2006 14:52 
76.7 20 9/19/2006 14:52 
78 20 9/19/2006 14:52 

91.9 20 9/19/2006 14:52 
125 20 9/19/2006 14:52 
117 20 9/19/2006 14:52 
149 20 9/19/2006 14:52 
262 20 9/19/2006 14:52 
279 20 9/19/2006 14:52 
469 20 9/19/2006 14:52 
495 20 9/19/2006 14:52 
260 20 9/19/2006 14:52 
260 20 9/19/2006 14:52 
528 20 9/19/2006 14:52 

1027 20 9/19/2006 14:52 
698 20 9/19/2006 14:52 
228 20 9/19/2006 14:52 
143 20 9/19/2006 14:52 
110 20 9/19/2006 14:52 
76.4 20 9/19/2006 14:52 
221 20 9/19/2006 14:52 
270 20 9/19/2006 14:52 
208 20 9/19/2006 14:52 
178 20 9/19/2006 14:52 
185 20 9/19/2006 14:52 
186 20 9/19/2006 14:52 
203 20 9/19/2006 14:52 
185 20 9/19/2006 14:52 
147 20 9/19/2006 14:52 
128 20 9/19/2006 14:52 
112 20 9/19/2006 14:52 
91.5 20 9/19/2006 14:52 
81.9 20 9/19/2006 14:52 
72.4 20 9/19/2006 14:52 
63.6 20 9/19/2006 14:53 
52.6 20 9/19/2006 14:53 
48.1 20 9/19/2006 14:53 
44.4 20 9/19/2006 14:53 
43.6 20 9/19/2006 14:53 
50.6 20 9/19/2006 14:53 
114 20 9/19/2006 14:53 
238 20 9/19/2006 14:53 
223 20 9/19/2006 14:53 
141 20 9/19/2006 14:53 
104 20 9/19/2006 14:53 
122 20 9/19/2006 14:53 
110 20 9/19/2006 14:53 
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Path Measurement Data 
Site 2 Path 3 

Path Measurement Data 
Site 2 Path 4 

ppm*m pathlength 
Timestamp 

(Mountain time) ppm*m pathlength 
Timestamp 

(Mountain time) 
114 20 9/19/2006 14:53 
184 20 9/19/2006 14:53 
316 20 9/19/2006 14:53 
277 20 9/19/2006 14:53 
192 20 9/19/2006 14:53 
178 20 9/19/2006 14:53 
95.6 20 9/19/2006 14:53 
83.2 20 9/19/2006 14:53 
47.6 20 9/19/2006 14:53 
78.6 20 9/19/2006 14:53 
104 20 9/19/2006 14:53 
48.4 20 9/19/2006 14:53 
196 20 9/19/2006 14:53 

1576 20 9/19/2006 14:53 
957 20 9/19/2006 14:53 
649 20 9/19/2006 14:53 
596 20 9/19/2006 14:53 
462 20 9/19/2006 14:53 
531 20 9/19/2006 14:53 
604 20 9/19/2006 14:53 
634 20 9/19/2006 14:54 
515 20 9/19/2006 14:54 
299 20 9/19/2006 14:54 
176 20 9/19/2006 14:54 
180 20 9/19/2006 14:54 
217 20 9/19/2006 14:54 
179 20 9/19/2006 14:54 

 

200



Path Measurement Data 
Site 3 Path 1 

Path Measurement Data 
Site 3 Path 2 

ppm*m pathlength 
Timestamp 

(mountain time) ppm*m pathlength 
Timestamp 

(mountain time) 
29.8 14.6 9/20/2006 8:03 2679 19 9/20/2006 8:29 
29.8 14.6 9/20/2006 8:03 2382 19 9/20/2006 8:29 
29.7 14.6 9/20/2006 8:03 1375 19 9/20/2006 8:29 
29.8 14.6 9/20/2006 8:03 834 19 9/20/2006 8:29 
29.6 14.6 9/20/2006 8:03 521 19 9/20/2006 8:29 
29.9 14.6 9/20/2006 8:03 675 19 9/20/2006 8:29 
29.8 14.6 9/20/2006 8:03 269 19 9/20/2006 8:29 
30 14.6 9/20/2006 8:03 89 19 9/20/2006 8:29 

29.9 14.6 9/20/2006 8:03 64.8 19 9/20/2006 8:30 
29.6 14.6 9/20/2006 8:03 60.9 19 9/20/2006 8:30 
29.7 14.6 9/20/2006 8:03 57.3 19 9/20/2006 8:30 
29.7 14.6 9/20/2006 8:03 49.2 19 9/20/2006 8:30 
29.7 14.6 9/20/2006 8:03 2654 19 9/20/2006 8:31 
29.9 14.6 9/20/2006 8:04 1633 19 9/20/2006 8:31 
29.7 14.6 9/20/2006 8:04 966 19 9/20/2006 8:31 
29.8 14.6 9/20/2006 8:04 853 19 9/20/2006 8:31 
29.8 14.6 9/20/2006 8:04 724 19 9/20/2006 8:31 
29.7 14.6 9/20/2006 8:04 646 19 9/20/2006 8:31 
29.9 14.6 9/20/2006 8:04 740 19 9/20/2006 8:31 
29.3 14.6 9/20/2006 8:04 613 19 9/20/2006 8:31 
29.4 14.6 9/20/2006 8:04 612 19 9/20/2006 8:31 
29.4 14.6 9/20/2006 8:04 744 19 9/20/2006 8:31 
29.5 14.6 9/20/2006 8:04 350 19 9/20/2006 8:31 
29.5 14.6 9/20/2006 8:04 76.1 19 9/20/2006 8:31 
29.6 14.6 9/20/2006 8:04 58.3 19 9/20/2006 8:31 
29.5 14.6 9/20/2006 8:04 43.4 19 9/20/2006 8:31 
29.6 14.6 9/20/2006 8:04 40.3 19 9/20/2006 8:31 
29.5 14.6 9/20/2006 8:04 39.9 19 9/20/2006 8:31 
29.6 14.6 9/20/2006 8:04 40 19 9/20/2006 8:31 
29.5 14.6 9/20/2006 8:04 41.9 19 9/20/2006 8:31 
29.4 14.6 9/20/2006 8:04 42.2 19 9/20/2006 8:31 
29.7 14.6 9/20/2006 8:04 42.9 19 9/20/2006 8:31 
29.3 14.6 9/20/2006 8:04 47.9 19 9/20/2006 8:31 
29.4 14.6 9/20/2006 8:04 51.2 19 9/20/2006 8:31 
29.4 14.6 9/20/2006 8:04 52 19 9/20/2006 8:31 
29.3 14.6 9/20/2006 8:04 50.5 19 9/20/2006 8:31 
29.4 14.6 9/20/2006 8:04 51.5 19 9/20/2006 8:31 
29.4 14.6 9/20/2006 8:04 52.8 19 9/20/2006 8:32 
29.5 14.6 9/20/2006 8:04 56 19 9/20/2006 8:32 
29.6 14.6 9/20/2006 8:04 57.3 19 9/20/2006 8:32 
29.6 14.6 9/20/2006 8:04 58.1 19 9/20/2006 8:32 
29.3 14.6 9/20/2006 8:04 56.1 19 9/20/2006 8:32 
29.7 14.6 9/20/2006 8:04 50.6 19 9/20/2006 8:32 
29.4 14.6 9/20/2006 8:04 50.5 19 9/20/2006 8:32 
29.4 14.6 9/20/2006 8:04 51.1 19 9/20/2006 8:32 
29.4 14.6 9/20/2006 8:04 49.8 19 9/20/2006 8:32 
29.6 14.6 9/20/2006 8:04 55.9 19 9/20/2006 8:32 
29.6 14.6 9/20/2006 8:04 56.3 19 9/20/2006 8:32 
29.5 14.6 9/20/2006 8:05 54.1 19 9/20/2006 8:32 
29.6 14.6 9/20/2006 8:05 52.7 19 9/20/2006 8:32 
30.4 14.6 9/20/2006 8:05 47.2 19 9/20/2006 8:32 
30.1 14.6 9/20/2006 8:05 1482 19 9/20/2006 8:32 
30 14.6 9/20/2006 8:05 461 19 9/20/2006 8:32 

30.1 14.6 9/20/2006 8:05 594 19 9/20/2006 8:32 
30.2 14.6 9/20/2006 8:05 474 19 9/20/2006 8:32 
30.3 14.6 9/20/2006 8:05 404 19 9/20/2006 8:32 
30.1 14.6 9/20/2006 8:05 463 19 9/20/2006 8:32 
30.2 14.6 9/20/2006 8:05 337 19 9/20/2006 8:32 
30.1 14.6 9/20/2006 8:05 165 19 9/20/2006 8:32 
30.1 14.6 9/20/2006 8:05 52.1 19 9/20/2006 8:32 
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Path Measurement Data 
Site 3 Path 1 

Path Measurement Data 
Site 3 Path 2 

ppm*m pathlength 
Timestamp 

(mountain time) ppm*m pathlength 
Timestamp 

(mountain time) 
30.4 14.6 9/20/2006 8:05 39.7 19 9/20/2006 8:32 
30.1 14.6 9/20/2006 8:05 39.6 19 9/20/2006 8:32 
30.3 14.6 9/20/2006 8:05 39.5 19 9/20/2006 8:32 
30.3 14.6 9/20/2006 8:05 39.1 19 9/20/2006 8:32 
30.1 14.6 9/20/2006 8:05 39.2 19 9/20/2006 8:32 
30.1 14.6 9/20/2006 8:05 39.3 19 9/20/2006 8:32 
30.2 14.6 9/20/2006 8:05 39.3 19 9/20/2006 8:32 
30.1 14.6 9/20/2006 8:05 39.3 19 9/20/2006 8:32 
30.4 14.6 9/20/2006 8:05 39.6 19 9/20/2006 8:32 
30 14.6 9/20/2006 8:05 39.4 19 9/20/2006 8:32 

30.2 14.6 9/20/2006 8:05 39.5 19 9/20/2006 8:33 
30 14.6 9/20/2006 8:05 39.3 19 9/20/2006 8:33 

30.3 14.6 9/20/2006 8:05 39.5 19 9/20/2006 8:33 
30.1 14.6 9/20/2006 8:05 39.3 19 9/20/2006 8:33 
30.2 14.6 9/20/2006 8:05 39.1 19 9/20/2006 8:33 
29.9 14.6 9/20/2006 8:05 39.5 19 9/20/2006 8:33 
30.3 14.6 9/20/2006 8:05 39.3 19 9/20/2006 8:33 
30.3 14.6 9/20/2006 8:05 39.5 19 9/20/2006 8:33 
30.3 14.6 9/20/2006 8:05 107 19 9/20/2006 8:33 
30.1 14.6 9/20/2006 8:05 120 19 9/20/2006 8:33 
30.2 14.6 9/20/2006 8:05 817 19 9/20/2006 8:33 
30.1 14.6 9/20/2006 8:05 1604 19 9/20/2006 8:33 
30.2 14.6 9/20/2006 8:06 638 19 9/20/2006 8:33 
30.1 14.6 9/20/2006 8:06 2385 19 9/20/2006 8:33 
30.1 14.6 9/20/2006 8:06 1763 19 9/20/2006 8:33 
30.3 14.6 9/20/2006 8:06 1258 19 9/20/2006 8:33 
30.3 14.6 9/20/2006 8:06 764 19 9/20/2006 8:33 
30.1 14.6 9/20/2006 8:06 393 19 9/20/2006 8:33 
30.1 14.6 9/20/2006 8:06 289 19 9/20/2006 8:33 
30.3 14.6 9/20/2006 8:06 225 19 9/20/2006 8:33 
30.2 14.6 9/20/2006 8:06 736 19 9/20/2006 8:33 
30.1 14.6 9/20/2006 8:06 2220 19 9/20/2006 8:33 
30.2 14.6 9/20/2006 8:06 2755 19 9/20/2006 8:33 
29.9 14.6 9/20/2006 8:06 1630 19 9/20/2006 8:33 
30.2 14.6 9/20/2006 8:06 1360 19 9/20/2006 8:33 
30.1 14.6 9/20/2006 8:06 2757 19 9/20/2006 8:33 
30.2 14.6 9/20/2006 8:06 2782 19 9/20/2006 8:33 
29.9 14.6 9/20/2006 8:06 2197 19 9/20/2006 8:33 
30 14.6 9/20/2006 8:06 1869 19 9/20/2006 8:33 

30.2 14.6 9/20/2006 8:06 1925 19 9/20/2006 8:33 
29.6 14.6 9/20/2006 8:06 1632 19 9/20/2006 8:33 
29.7 14.6 9/20/2006 8:06 1310 19 9/20/2006 8:33 
29.5 14.6 9/20/2006 8:06 1059 19 9/20/2006 8:33 
29.6 14.6 9/20/2006 8:06 957 19 9/20/2006 8:34 
29.6 14.6 9/20/2006 8:06 831 19 9/20/2006 8:34 
29.7 14.6 9/20/2006 8:06 666 19 9/20/2006 8:34 
29.6 14.6 9/20/2006 8:06 589 19 9/20/2006 8:34 
29.6 14.6 9/20/2006 8:06 801 19 9/20/2006 8:34 
29.6 14.6 9/20/2006 8:06 448 19 9/20/2006 8:34 
29.5 14.6 9/20/2006 8:06 133 19 9/20/2006 8:34 
29.7 14.6 9/20/2006 8:06 205 19 9/20/2006 8:34 
29.7 14.6 9/20/2006 8:06 205 19 9/20/2006 8:34 
29.8 14.6 9/20/2006 8:06 271 19 9/20/2006 8:34 
29.6 14.6 9/20/2006 8:06 256 19 9/20/2006 8:34 
142 14.6 9/20/2006 8:06 281 19 9/20/2006 8:34 

2141 14.6 9/20/2006 8:06 267 19 9/20/2006 8:34 
1128 14.6 9/20/2006 8:07 193 19 9/20/2006 8:34 
589 14.6 9/20/2006 8:07 227 19 9/20/2006 8:34 
376 14.6 9/20/2006 8:07 194 19 9/20/2006 8:34 
252 14.6 9/20/2006 8:07 172 19 9/20/2006 8:34 

202



Path Measurement Data 
Site 3 Path 1 

Path Measurement Data 
Site 3 Path 2 

ppm*m pathlength 
Timestamp 

(mountain time) ppm*m pathlength 
Timestamp 

(mountain time) 
251 14.6 9/20/2006 8:07 179 19 9/20/2006 8:34 
281 14.6 9/20/2006 8:07 178 19 9/20/2006 8:34 
111 14.6 9/20/2006 8:07 136 19 9/20/2006 8:34 
35.4 14.6 9/20/2006 8:07 155 19 9/20/2006 8:34 
29.7 14.6 9/20/2006 8:08 105 19 9/20/2006 8:34 
29.9 14.6 9/20/2006 8:08 325 19 9/20/2006 8:34 
30.1 14.6 9/20/2006 8:08 494 19 9/20/2006 8:34 
30.1 14.6 9/20/2006 8:08 630 19 9/20/2006 8:34 
30 14.6 9/20/2006 8:08 862 19 9/20/2006 8:34 

29.6 14.6 9/20/2006 8:08 879 19 9/20/2006 8:34 
29.9 14.6 9/20/2006 8:08 541 19 9/20/2006 8:34 
30.3 14.6 9/20/2006 8:08 855 19 9/20/2006 8:34 
29.8 14.6 9/20/2006 8:08 1671 19 9/20/2006 8:34 
30 14.6 9/20/2006 8:08 681 19 9/20/2006 8:34 

29.8 14.6 9/20/2006 8:09 1758 19 9/20/2006 8:34 
30.1 14.6 9/20/2006 8:09 1124 19 9/20/2006 8:34 
29.9 14.6 9/20/2006 8:09 1461 19 9/20/2006 8:35 
29.8 14.6 9/20/2006 8:09 1136 19 9/20/2006 8:35 
29.9 14.6 9/20/2006 8:09 999 19 9/20/2006 8:35 
29.7 14.6 9/20/2006 8:09 2120 19 9/20/2006 8:35 
29.9 14.6 9/20/2006 8:09 2553 19 9/20/2006 8:35 
29.6 14.6 9/20/2006 8:09 2488 19 9/20/2006 8:35 
29.9 14.6 9/20/2006 8:09 2359 19 9/20/2006 8:35 
29.8 14.6 9/20/2006 8:09 1905 19 9/20/2006 8:35 
29.8 14.6 9/20/2006 8:09 1699 19 9/20/2006 8:35 
30 14.6 9/20/2006 8:09 1834 19 9/20/2006 8:35 

29.9 14.6 9/20/2006 8:09 1210 19 9/20/2006 8:35 
29.9 14.6 9/20/2006 8:09 555 19 9/20/2006 8:35 
29.7 14.6 9/20/2006 8:09 414 19 9/20/2006 8:35 
31.7 14.6 9/20/2006 8:09 579 19 9/20/2006 8:35 
32.1 14.6 9/20/2006 8:09 794 19 9/20/2006 8:35 
33 14.6 9/20/2006 8:09 1119 19 9/20/2006 8:35 

34.9 14.6 9/20/2006 8:09 2049 19 9/20/2006 8:35 
34.7 14.6 9/20/2006 8:09 2258 19 9/20/2006 8:35 
34 14.6 9/20/2006 8:09 2122 19 9/20/2006 8:35 

33.7 14.6 9/20/2006 8:09 1033 19 9/20/2006 8:35 
33.8 14.6 9/20/2006 8:09 1347 19 9/20/2006 8:35 
34.4 14.6 9/20/2006 8:09 716 19 9/20/2006 8:35 
34.6 14.6 9/20/2006 8:09 495 19 9/20/2006 8:35 
32.8 14.6 9/20/2006 8:09 1502 19 9/20/2006 8:35 
30.1 14.6 9/20/2006 8:09 704 19 9/20/2006 8:35 
29.7 14.6 9/20/2006 8:09 507 19 9/20/2006 8:35 
29.4 14.6 9/20/2006 8:09 723 19 9/20/2006 8:35 
29.8 14.6 9/20/2006 8:09 1096 19 9/20/2006 8:35 
29.5 14.6 9/20/2006 8:09 976 19 9/20/2006 8:35 
29.5 14.6 9/20/2006 8:09 1677 19 9/20/2006 8:35 
29.7 14.6 9/20/2006 8:09 1159 19 9/20/2006 8:35 
29.5 14.6 9/20/2006 8:09 830 19 9/20/2006 8:35 
29.9 14.6 9/20/2006 8:10 645 19 9/20/2006 8:36 
29.5 14.6 9/20/2006 8:10 303 19 9/20/2006 8:36 
29.6 14.6 9/20/2006 8:10 234 19 9/20/2006 8:36 
29.7 14.6 9/20/2006 8:10 191 19 9/20/2006 8:36 
29.8 14.6 9/20/2006 8:10 54.3 19 9/20/2006 8:36 
29.9 14.6 9/20/2006 8:10 46.9 19 9/20/2006 8:36 
29.4 14.6 9/20/2006 8:10 44 19 9/20/2006 8:36 
29.4 14.6 9/20/2006 8:10 43.5 19 9/20/2006 8:36 
29.2 14.6 9/20/2006 8:10 42.7 19 9/20/2006 8:36 
29.4 14.6 9/20/2006 8:10 41.4 19 9/20/2006 8:36 
29.1 14.6 9/20/2006 8:10 41.8 19 9/20/2006 8:36 
29.5 14.6 9/20/2006 8:10 42.8 19 9/20/2006 8:36 
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Path Measurement Data 
Site 3 Path 1 

Path Measurement Data 
Site 3 Path 2 

ppm*m pathlength 
Timestamp 

(mountain time) ppm*m pathlength 
Timestamp 

(mountain time) 
29.2 14.6 9/20/2006 8:10 43.9 19 9/20/2006 8:36 
29.1 14.6 9/20/2006 8:10 49.1 19 9/20/2006 8:36 
29.1 14.6 9/20/2006 8:10 49.9 19 9/20/2006 8:36 
29.2 14.6 9/20/2006 8:10 50.5 19 9/20/2006 8:36 
29.4 14.6 9/20/2006 8:10 57.5 19 9/20/2006 8:36 
29.2 14.6 9/20/2006 8:10 60.5 19 9/20/2006 8:36 
29.3 14.6 9/20/2006 8:10 57.3 19 9/20/2006 8:36 
29.2 14.6 9/20/2006 8:10 49.7 19 9/20/2006 8:36 
29.3 14.6 9/20/2006 8:10 47.1 19 9/20/2006 8:36 
29.4 14.6 9/20/2006 8:10 53.6 19 9/20/2006 8:36 
29.4 14.6 9/20/2006 8:10 49.4 19 9/20/2006 8:36 
29 14.6 9/20/2006 8:10 43.1 19 9/20/2006 8:36 

29.2 14.6 9/20/2006 8:10 41 19 9/20/2006 8:36 
29.2 14.6 9/20/2006 8:10 40.6 19 9/20/2006 8:36 
29.4 14.6 9/20/2006 8:10 45 19 9/20/2006 8:36 
29 14.6 9/20/2006 8:10 121 19 9/20/2006 8:36 

29.1 14.6 9/20/2006 8:10 1927 19 9/20/2006 8:36 
29.1 14.6 9/20/2006 8:10 1691 19 9/20/2006 8:36 
29.3 14.6 9/20/2006 8:10 2000 19 9/20/2006 8:36 
29.2 14.6 9/20/2006 8:10 1402 19 9/20/2006 8:36 
29.2 14.6 9/20/2006 8:10 544 19 9/20/2006 8:36 
29.3 14.6 9/20/2006 8:10 256 19 9/20/2006 8:37 
29.3 14.6 9/20/2006 8:11 114 19 9/20/2006 8:37 
29.2 14.6 9/20/2006 8:11 286 19 9/20/2006 8:37 
29.3 14.6 9/20/2006 8:11 447 19 9/20/2006 8:37 
29.1 14.6 9/20/2006 8:11 1020 19 9/20/2006 8:37 
29.1 14.6 9/20/2006 8:11 1049 19 9/20/2006 8:37 
29.1 14.6 9/20/2006 8:11 429 19 9/20/2006 8:37 
29.4 14.6 9/20/2006 8:11 341 19 9/20/2006 8:37 
29.5 14.6 9/20/2006 8:11 286 19 9/20/2006 8:37 
29.3 14.6 9/20/2006 8:11 225 19 9/20/2006 8:37 
29.2 14.6 9/20/2006 8:11 147 19 9/20/2006 8:37 
29.2 14.6 9/20/2006 8:11 113 19 9/20/2006 8:37 
29.1 14.6 9/20/2006 8:11 108 19 9/20/2006 8:37 
29.3 14.6 9/20/2006 8:11 104 19 9/20/2006 8:37 
29.5 14.6 9/20/2006 8:11 100 19 9/20/2006 8:37 
29.4 14.6 9/20/2006 8:11 82.9 19 9/20/2006 8:37 
29.3 14.6 9/20/2006 8:11 72.1 19 9/20/2006 8:37 
29.2 14.6 9/20/2006 8:11 62.7 19 9/20/2006 8:37 
29.1 14.6 9/20/2006 8:11 60.4 19 9/20/2006 8:37 
29.2 14.6 9/20/2006 8:11 64.7 19 9/20/2006 8:37 
29.2 14.6 9/20/2006 8:11 61.1 19 9/20/2006 8:37 
29.2 14.6 9/20/2006 8:11 54.9 19 9/20/2006 8:37 
29.2 14.6 9/20/2006 8:11 54 19 9/20/2006 8:37 
28.9 14.6 9/20/2006 8:11 54.6 19 9/20/2006 8:37 
29.1 14.6 9/20/2006 8:11 52.1 19 9/20/2006 8:37 
29.1 14.6 9/20/2006 8:11 52.6 19 9/20/2006 8:37 
28.9 14.6 9/20/2006 8:11 109 19 9/20/2006 8:37 
28.9 14.6 9/20/2006 8:11 417 19 9/20/2006 8:37 
28.9 14.6 9/20/2006 8:11 442 19 9/20/2006 8:37 
28.8 14.6 9/20/2006 8:11 699 19 9/20/2006 8:37 
28.9 14.6 9/20/2006 8:11 569 19 9/20/2006 8:37 
29 14.6 9/20/2006 8:11 1535 19 9/20/2006 8:37 

28.9 14.6 9/20/2006 8:11 1141 19 9/20/2006 8:37 
29 14.6 9/20/2006 8:11 1436 19 9/20/2006 8:37 

28.8 14.6 9/20/2006 8:11 1933 19 9/20/2006 8:38 
28.9 14.6 9/20/2006 8:12 1576 19 9/20/2006 8:38 
29 14.6 9/20/2006 8:12 1704 19 9/20/2006 8:38 

28.9 14.6 9/20/2006 8:12 1115 19 9/20/2006 8:38 
28.9 14.6 9/20/2006 8:12 631 19 9/20/2006 8:38 
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Path Measurement Data 
Site 3 Path 1 

Path Measurement Data 
Site 3 Path 2 

ppm*m pathlength 
Timestamp 

(mountain time) ppm*m pathlength 
Timestamp 

(mountain time) 
29 14.6 9/20/2006 8:12 397 19 9/20/2006 8:38 
29 14.6 9/20/2006 8:12 479 19 9/20/2006 8:38 

28.9 14.6 9/20/2006 8:12 212 19 9/20/2006 8:38 
28.8 14.6 9/20/2006 8:12 372 19 9/20/2006 8:38 
29 14.6 9/20/2006 8:12 313 19 9/20/2006 8:38 
29 14.6 9/20/2006 8:12 105 19 9/20/2006 8:38 
29 14.6 9/20/2006 8:12 41 19 9/20/2006 8:38 
29 14.6 9/20/2006 8:12 42.5 19 9/20/2006 8:38 

28.9 14.6 9/20/2006 8:12 149 19 9/20/2006 8:38 
168 14.6 9/20/2006 8:12 440 19 9/20/2006 8:38 
29.6 14.6 9/20/2006 8:13 417 19 9/20/2006 8:38 
29.8 14.6 9/20/2006 8:13 125 19 9/20/2006 8:38 
29.7 14.6 9/20/2006 8:13 112 19 9/20/2006 8:38 
29.5 14.6 9/20/2006 8:13 139 19 9/20/2006 8:38 
29.6 14.6 9/20/2006 8:13 226 19 9/20/2006 8:38 
29.6 14.6 9/20/2006 8:13 188 19 9/20/2006 8:38 
29.6 14.6 9/20/2006 8:13 182 19 9/20/2006 8:38 
29.6 14.6 9/20/2006 8:13 221 19 9/20/2006 8:38 
29.4 14.6 9/20/2006 8:13 185 19 9/20/2006 8:38 
29.6 14.6 9/20/2006 8:13 168 19 9/20/2006 8:38 
29.6 14.6 9/20/2006 8:13 155 19 9/20/2006 8:38 
29.6 14.6 9/20/2006 8:13 135 19 9/20/2006 8:38 
29.4 14.6 9/20/2006 8:13 113 19 9/20/2006 8:38 
29.6 14.6 9/20/2006 8:13 95 19 9/20/2006 8:38 
29.5 14.6 9/20/2006 8:13 70.9 19 9/20/2006 8:38 
29.6 14.6 9/20/2006 8:13 55.9 19 9/20/2006 8:38 
29.5 14.6 9/20/2006 8:13 48.8 19 9/20/2006 8:38 
29.3 14.6 9/20/2006 8:13 44.7 19 9/20/2006 8:38 
29.6 14.6 9/20/2006 8:13 45.3 19 9/20/2006 8:39 
29.4 14.6 9/20/2006 8:13 51.1 19 9/20/2006 8:39 
29.3 14.6 9/20/2006 8:13 50.5 19 9/20/2006 8:39 
29.6 14.6 9/20/2006 8:13 49.1 19 9/20/2006 8:39 
29.6 14.6 9/20/2006 8:13 45.3 19 9/20/2006 8:39 
29.9 14.6 9/20/2006 8:14 47.7 19 9/20/2006 8:39 
29.3 14.6 9/20/2006 8:14 46.4 19 9/20/2006 8:39 
29.5 14.6 9/20/2006 8:14 47.4 19 9/20/2006 8:39 
29.7 14.6 9/20/2006 8:14 49.6 19 9/20/2006 8:39 
29.6 14.6 9/20/2006 8:14 48.8 19 9/20/2006 8:39 
29.5 14.6 9/20/2006 8:14 48.5 19 9/20/2006 8:39 
29.6 14.6 9/20/2006 8:14 49.5 19 9/20/2006 8:39 
29.8 14.6 9/20/2006 8:14 51.6 19 9/20/2006 8:39 
29.6 14.6 9/20/2006 8:14 52.7 19 9/20/2006 8:39 
29.5 14.6 9/20/2006 8:14 44.4 19 9/20/2006 8:39 
29.4 14.6 9/20/2006 8:14 45 19 9/20/2006 8:39 
29.6 14.6 9/20/2006 8:14 54.4 19 9/20/2006 8:39 
29.7 14.6 9/20/2006 8:14 273 19 9/20/2006 8:39 
29.6 14.6 9/20/2006 8:14 943 19 9/20/2006 8:39 
126 14.6 9/20/2006 8:14 663 19 9/20/2006 8:39 

1693 14.6 9/20/2006 8:14 176 19 9/20/2006 8:39 
1335 14.6 9/20/2006 8:14 88.5 19 9/20/2006 8:39 
930 14.6 9/20/2006 8:14 66.6 19 9/20/2006 8:39 
878 14.6 9/20/2006 8:14 40.3 19 9/20/2006 8:39 
725 14.6 9/20/2006 8:14 40.2 19 9/20/2006 8:39 
803 14.6 9/20/2006 8:14 40.4 19 9/20/2006 8:39 

1080 14.6 9/20/2006 8:14 40.2 19 9/20/2006 8:39 
551 14.6 9/20/2006 8:14 40.3 19 9/20/2006 8:39 
878 14.6 9/20/2006 8:14 40.2 19 9/20/2006 8:39 
765 14.6 9/20/2006 8:14 40 19 9/20/2006 8:39 
798 14.6 9/20/2006 8:14 40.3 19 9/20/2006 8:39 
577 14.6 9/20/2006 8:14 40.1 19 9/20/2006 8:39 
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Path Measurement Data 
Site 3 Path 1 

Path Measurement Data 
Site 3 Path 2 

ppm*m pathlength 
Timestamp 

(mountain time) ppm*m pathlength 
Timestamp 

(mountain time) 
1167 14.6 9/20/2006 8:14 40.2 19 9/20/2006 8:39 
1556 14.6 9/20/2006 8:14 40.2 19 9/20/2006 8:39 
1639 14.6 9/20/2006 8:14 40.3 19 9/20/2006 8:39 
2282 14.6 9/20/2006 8:14 40 19 9/20/2006 8:40 
1932 14.6 9/20/2006 8:14 40.5 19 9/20/2006 8:40 
1631 14.6 9/20/2006 8:14 40 19 9/20/2006 8:40 
1587 14.6 9/20/2006 8:15 40.4 19 9/20/2006 8:40 
1466 14.6 9/20/2006 8:15 40.6 19 9/20/2006 8:40 
882 14.6 9/20/2006 8:15 40.7 19 9/20/2006 8:40 
231 14.6 9/20/2006 8:15 40.6 19 9/20/2006 8:40 
31.1 14.6 9/20/2006 8:15 40.5 19 9/20/2006 8:40 
30 14.6 9/20/2006 8:15 40.4 19 9/20/2006 8:40 

29.9 14.6 9/20/2006 8:15 40.6 19 9/20/2006 8:40 
29.7 14.6 9/20/2006 8:15 40.6 19 9/20/2006 8:40 
30.1 14.6 9/20/2006 8:15 40.4 19 9/20/2006 8:40 
29.9 14.6 9/20/2006 8:15 40.6 19 9/20/2006 8:40 
29.9 14.6 9/20/2006 8:15 40.7 19 9/20/2006 8:40 
30 14.6 9/20/2006 8:15 40.4 19 9/20/2006 8:40 

30.1 14.6 9/20/2006 8:15 40.8 19 9/20/2006 8:40 
30 14.6 9/20/2006 8:15 42.1 19 9/20/2006 8:40 

30.2 14.6 9/20/2006 8:15 43 19 9/20/2006 8:40 
30.2 14.6 9/20/2006 8:15 40.4 19 9/20/2006 8:40 
30 14.6 9/20/2006 8:15 40.7 19 9/20/2006 8:40 
30 14.6 9/20/2006 8:15 41.3 19 9/20/2006 8:40 

29.9 14.6 9/20/2006 8:15 41.1 19 9/20/2006 8:40 
30 14.6 9/20/2006 8:15 40.6 19 9/20/2006 8:40 

29.9 14.6 9/20/2006 8:15 40.7 19 9/20/2006 8:40 
29.7 14.6 9/20/2006 8:15 40.8 19 9/20/2006 8:40 
29.9 14.6 9/20/2006 8:15 40.9 19 9/20/2006 8:40 
29.8 14.6 9/20/2006 8:15 40.8 19 9/20/2006 8:40 
30 14.6 9/20/2006 8:15 40.6 19 9/20/2006 8:40 
30 14.6 9/20/2006 8:15 40.5 19 9/20/2006 8:40 

29.9 14.6 9/20/2006 8:15 40.3 19 9/20/2006 8:40 
30.1 14.6 9/20/2006 8:15 40.4 19 9/20/2006 8:40 
29.9 14.6 9/20/2006 8:15 40.5 19 9/20/2006 8:40 
30 14.6 9/20/2006 8:15 40.4 19 9/20/2006 8:40 
30 14.6 9/20/2006 8:15 40.3 19 9/20/2006 8:40 

29.9 14.6 9/20/2006 8:15 40.7 19 9/20/2006 8:41 
30 14.6 9/20/2006 8:15 40.5 19 9/20/2006 8:41 

29.8 14.6 9/20/2006 8:15 40.2 19 9/20/2006 8:41 
30 14.6 9/20/2006 8:15 40.5 19 9/20/2006 8:41 

29.9 14.6 9/20/2006 8:16 40.6 19 9/20/2006 8:41 
29.8 14.6 9/20/2006 8:16 40.6 19 9/20/2006 8:41 
29.9 14.6 9/20/2006 8:16 40.3 19 9/20/2006 8:41 
29.9 14.6 9/20/2006 8:16 40.3 19 9/20/2006 8:41 
29.8 14.6 9/20/2006 8:16 40.5 19 9/20/2006 8:41 
29.9 14.6 9/20/2006 8:16 40.5 19 9/20/2006 8:41 
30 14.6 9/20/2006 8:16 40.7 19 9/20/2006 8:41 

29.9 14.6 9/20/2006 8:16 40.6 19 9/20/2006 8:41 
30.1 14.6 9/20/2006 8:16 40.7 19 9/20/2006 8:41 
29.9 14.6 9/20/2006 8:16 40.8 19 9/20/2006 8:41 
30 14.6 9/20/2006 8:16 40.7 19 9/20/2006 8:41 

29.9 14.6 9/20/2006 8:16 40.8 19 9/20/2006 8:41 
30 14.6 9/20/2006 8:16 40.4 19 9/20/2006 8:41 

30.1 14.6 9/20/2006 8:16 40.5 19 9/20/2006 8:41 
29.9 14.6 9/20/2006 8:16 40.6 19 9/20/2006 8:41 
29.8 14.6 9/20/2006 8:16 40.7 19 9/20/2006 8:41 
29.9 14.6 9/20/2006 8:16 40.5 19 9/20/2006 8:41 
30 14.6 9/20/2006 8:16 40.3 19 9/20/2006 8:41 

29.9 14.6 9/20/2006 8:16 40.7 19 9/20/2006 8:41 
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Path Measurement Data 
Site 3 Path 1 

Path Measurement Data 
Site 3 Path 2 

ppm*m pathlength 
Timestamp 

(mountain time) ppm*m pathlength 
Timestamp 

(mountain time) 
29.9 14.6 9/20/2006 8:16 40.7 19 9/20/2006 8:41 
30 14.6 9/20/2006 8:16 40.6 19 9/20/2006 8:41 
30 14.6 9/20/2006 8:16 40.5 19 9/20/2006 8:41 
30 14.6 9/20/2006 8:16 40.8 19 9/20/2006 8:41 

29.8 14.6 9/20/2006 8:16 40.8 19 9/20/2006 8:41 
29.9 14.6 9/20/2006 8:16 40.8 19 9/20/2006 8:41 
30 14.6 9/20/2006 8:16 40.4 19 9/20/2006 8:41 

29.8 14.6 9/20/2006 8:16 40.5 19 9/20/2006 8:41 
29.9 14.6 9/20/2006 8:16 40.8 19 9/20/2006 8:41 
30.1 14.6 9/20/2006 8:16 40.4 19 9/20/2006 8:41 
30 14.6 9/20/2006 8:16 40.5 19 9/20/2006 8:41 
30 14.6 9/20/2006 8:16 40.5 19 9/20/2006 8:42 

30.2 14.6 9/20/2006 8:16 40.6 19 9/20/2006 8:42 
29.8 14.6 9/20/2006 8:16 40.5 19 9/20/2006 8:42 
29.8 14.6 9/20/2006 8:16 40.7 19 9/20/2006 8:42 
30 14.6 9/20/2006 8:17 40.4 19 9/20/2006 8:42 

30.3 14.6 9/20/2006 8:17 40.6 19 9/20/2006 8:42 
29.9 14.6 9/20/2006 8:17 40.6 19 9/20/2006 8:42 
30.2 14.6 9/20/2006 8:17 40.4 19 9/20/2006 8:42 
29.9 14.6 9/20/2006 8:17 42.1 19 9/20/2006 8:42 
30.2 14.6 9/20/2006 8:17 76.8 19 9/20/2006 8:42 
30.1 14.6 9/20/2006 8:17 126 19 9/20/2006 8:42 
30 14.6 9/20/2006 8:17 143 19 9/20/2006 8:42 

29.9 14.6 9/20/2006 8:17 132 19 9/20/2006 8:42 
30.1 14.6 9/20/2006 8:17 116 19 9/20/2006 8:42 
30.2 14.6 9/20/2006 8:17 120 19 9/20/2006 8:42 
29.9 14.6 9/20/2006 8:17 126 19 9/20/2006 8:42 
36.8 14.6 9/20/2006 8:17 61.7 19 9/20/2006 8:42 
30 14.6 9/20/2006 8:17 43.3 19 9/20/2006 8:42 

30.1 14.6 9/20/2006 8:17 44.8 19 9/20/2006 8:42 
29.9 14.6 9/20/2006 8:17 59 19 9/20/2006 8:42 
30 14.6 9/20/2006 8:17 42.7 19 9/20/2006 8:42 

30.1 14.6 9/20/2006 8:17 40.8 19 9/20/2006 8:42 
30 14.6 9/20/2006 8:17 40.3 19 9/20/2006 8:42 
30 14.6 9/20/2006 8:17 40.4 19 9/20/2006 8:42 

30.1 14.6 9/20/2006 8:17 40.4 19 9/20/2006 8:42 
30 14.6 9/20/2006 8:17 40.4 19 9/20/2006 8:42 

29.8 14.6 9/20/2006 8:17 40.2 19 9/20/2006 8:42 
29.9 14.6 9/20/2006 8:17 40.5 19 9/20/2006 8:42 
30.2 14.6 9/20/2006 8:17 40.4 19 9/20/2006 8:42 
30.3 14.6 9/20/2006 8:17 40.2 19 9/20/2006 8:42 
30.1 14.6 9/20/2006 8:17 40.5 19 9/20/2006 8:42 
30.3 14.6 9/20/2006 8:17 40.4 19 9/20/2006 8:42 
30.2 14.6 9/20/2006 8:17 40.4 19 9/20/2006 8:42 
30.2 14.6 9/20/2006 8:17 40.6 19 9/20/2006 8:42 
30 14.6 9/20/2006 8:17 40.4 19 9/20/2006 8:43 

30.3 14.6 9/20/2006 8:17 40.6 19 9/20/2006 8:43 
30.1 14.6 9/20/2006 8:17 40.5 19 9/20/2006 8:43 
30.2 14.6 9/20/2006 8:17 40.5 19 9/20/2006 8:43 
30.3 14.6 9/20/2006 8:18 40.4 19 9/20/2006 8:43 
30.2 14.6 9/20/2006 8:18 40.6 19 9/20/2006 8:43 
30.1 14.6 9/20/2006 8:18 40.6 19 9/20/2006 8:43 
30.3 14.6 9/20/2006 8:18 40.4 19 9/20/2006 8:43 
30.1 14.6 9/20/2006 8:18 40.8 19 9/20/2006 8:43 
30 14.6 9/20/2006 8:18 40.3 19 9/20/2006 8:43 

30.1 14.6 9/20/2006 8:18 40.7 19 9/20/2006 8:43 
29.9 14.6 9/20/2006 8:18 40.5 19 9/20/2006 8:43 
30.1 14.6 9/20/2006 8:18 40.4 19 9/20/2006 8:43 
30.2 14.6 9/20/2006 8:18 40.5 19 9/20/2006 8:43 
30.2 14.6 9/20/2006 8:18 40.8 19 9/20/2006 8:43 
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Path Measurement Data 
Site 3 Path 1 

Path Measurement Data 
Site 3 Path 2 

ppm*m pathlength 
Timestamp 

(mountain time) ppm*m pathlength 
Timestamp 

(mountain time) 
30 14.6 9/20/2006 8:18 40.6 19 9/20/2006 8:43 

30.3 14.6 9/20/2006 8:18 40.5 19 9/20/2006 8:43 
30.3 14.6 9/20/2006 8:18 40.6 19 9/20/2006 8:43 
30.2 14.6 9/20/2006 8:18 40.3 19 9/20/2006 8:43 
30.2 14.6 9/20/2006 8:18 40.7 19 9/20/2006 8:43 
30.1 14.6 9/20/2006 8:18 40.4 19 9/20/2006 8:43 
30.2 14.6 9/20/2006 8:18 40.7 19 9/20/2006 8:43 
30.2 14.6 9/20/2006 8:18 40.6 19 9/20/2006 8:43 
30.1 14.6 9/20/2006 8:18 40.5 19 9/20/2006 8:43 
30.1 14.6 9/20/2006 8:18 40.6 19 9/20/2006 8:43 
30.2 14.6 9/20/2006 8:18 40.2 19 9/20/2006 8:43 
30 14.6 9/20/2006 8:18 40.5 19 9/20/2006 8:43 

30.2 14.6 9/20/2006 8:18 40.6 19 9/20/2006 8:43 
30.1 14.6 9/20/2006 8:18 40.5 19 9/20/2006 8:43 
30.1 14.6 9/20/2006 8:18 41.4 19 9/20/2006 8:43 
30.2 14.6 9/20/2006 8:18 42.7 19 9/20/2006 8:43 
30.2 14.6 9/20/2006 8:18 48.3 19 9/20/2006 8:43 
30.3 14.6 9/20/2006 8:18 45.1 19 9/20/2006 8:43 
30.2 14.6 9/20/2006 8:18 41.1 19 9/20/2006 8:43 
30.1 14.6 9/20/2006 8:18 40.5 19 9/20/2006 8:44 
30.2 14.6 9/20/2006 8:18 40.5 19 9/20/2006 8:44 
30.1 14.6 9/20/2006 8:18 40.4 19 9/20/2006 8:44 
30.1 14.6 9/20/2006 8:18 40.8 19 9/20/2006 8:44 
30 14.6 9/20/2006 8:19 40.4 19 9/20/2006 8:44 

30.3 14.6 9/20/2006 8:19 40.6 19 9/20/2006 8:44 
30.1 14.6 9/20/2006 8:19 40.6 19 9/20/2006 8:44 
30.3 14.6 9/20/2006 8:19 40.5 19 9/20/2006 8:44 
30.1 14.6 9/20/2006 8:19 40.7 19 9/20/2006 8:44 
30.2 14.6 9/20/2006 8:19 40.6 19 9/20/2006 8:44 
30 14.6 9/20/2006 8:19 40.7 19 9/20/2006 8:44 

30.3 14.6 9/20/2006 8:19 40.6 19 9/20/2006 8:44 
30.4 14.6 9/20/2006 8:19 40.1 19 9/20/2006 8:44 
30.1 14.6 9/20/2006 8:19 40.4 19 9/20/2006 8:44 
30.2 14.6 9/20/2006 8:19 40.3 19 9/20/2006 8:44 
30.3 14.6 9/20/2006 8:19 40.3 19 9/20/2006 8:44 
97.8 14.6 9/20/2006 8:19 40.3 19 9/20/2006 8:44 
156 14.6 9/20/2006 8:19 40.6 19 9/20/2006 8:44 
157 14.6 9/20/2006 8:19 40.5 19 9/20/2006 8:44 
879 14.6 9/20/2006 8:19 40.9 19 9/20/2006 8:44 

1209 14.6 9/20/2006 8:19 40.7 19 9/20/2006 8:44 
1293 14.6 9/20/2006 8:19 40.5 19 9/20/2006 8:44 
1627 14.6 9/20/2006 8:19 40.4 19 9/20/2006 8:44 
902 14.6 9/20/2006 8:19 40.5 19 9/20/2006 8:44 
48.4 14.6 9/20/2006 8:19 40.6 19 9/20/2006 8:44 
34.9 14.6 9/20/2006 8:19 40.6 19 9/20/2006 8:44 
31.3 14.6 9/20/2006 8:19 40.3 19 9/20/2006 8:44 
31 14.6 9/20/2006 8:19 41 19 9/20/2006 8:44 

30.2 14.6 9/20/2006 8:19 56.3 19 9/20/2006 8:44 
30.4 14.6 9/20/2006 8:19 356 19 9/20/2006 8:44 
30.1 14.6 9/20/2006 8:19 2149 19 9/20/2006 8:44 
30.1 14.6 9/20/2006 8:19 2109 19 9/20/2006 8:44 
30.3 14.6 9/20/2006 8:19 1354 19 9/20/2006 8:44 
30.2 14.6 9/20/2006 8:19 1069 19 9/20/2006 8:44 
30.1 14.6 9/20/2006 8:19 335 19 9/20/2006 8:45 
30.5 14.6 9/20/2006 8:19 92.1 19 9/20/2006 8:45 
36.5 14.6 9/20/2006 8:19 449 19 9/20/2006 8:45 
47.5 14.6 9/20/2006 8:19 243 19 9/20/2006 8:45 
141 14.6 9/20/2006 8:20 389 19 9/20/2006 8:45 
156 14.6 9/20/2006 8:20 476 19 9/20/2006 8:45 
778 14.6 9/20/2006 8:20 360 19 9/20/2006 8:45 
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Path Measurement Data 
Site 3 Path 1 

Path Measurement Data 
Site 3 Path 2 

ppm*m pathlength 
Timestamp 

(mountain time) ppm*m pathlength 
Timestamp 

(mountain time) 
1806 14.6 9/20/2006 8:20 78.6 19 9/20/2006 8:45 
1580 14.6 9/20/2006 8:20 189 19 9/20/2006 8:45 
1344 14.6 9/20/2006 8:20 206 19 9/20/2006 8:45 
778 14.6 9/20/2006 8:20 715 19 9/20/2006 8:45 
222 14.6 9/20/2006 8:20 952 19 9/20/2006 8:45 
38.8 14.6 9/20/2006 8:20 1159 19 9/20/2006 8:45 
31.2 14.6 9/20/2006 8:20 1574 19 9/20/2006 8:45 
30.6 14.6 9/20/2006 8:20 1887 19 9/20/2006 8:45 
30.2 14.6 9/20/2006 8:20 2434 19 9/20/2006 8:45 
30.1 14.6 9/20/2006 8:20 2182 19 9/20/2006 8:45 
30.4 14.6 9/20/2006 8:20 1643 19 9/20/2006 8:45 
30.1 14.6 9/20/2006 8:20 1901 19 9/20/2006 8:45 
30.2 14.6 9/20/2006 8:20 2028 19 9/20/2006 8:45 
30 14.6 9/20/2006 8:20 1451 19 9/20/2006 8:45 
30 14.6 9/20/2006 8:20 1118 19 9/20/2006 8:45 

30.1 14.6 9/20/2006 8:20 1259 19 9/20/2006 8:45 
30 14.6 9/20/2006 8:20 2753 19 9/20/2006 8:45 

30.2 14.6 9/20/2006 8:20 1732 19 9/20/2006 8:45 
30.2 14.6 9/20/2006 8:20 1737 19 9/20/2006 8:45 
30.2 14.6 9/20/2006 8:20 1179 19 9/20/2006 8:45 
30.2 14.6 9/20/2006 8:20 407 19 9/20/2006 8:45 
30.3 14.6 9/20/2006 8:20 289 19 9/20/2006 8:45 
30.5 14.6 9/20/2006 8:20 201 19 9/20/2006 8:45 
30.6 14.6 9/20/2006 8:20 378 19 9/20/2006 8:45 
30.6 14.6 9/20/2006 8:20 1498 19 9/20/2006 8:45 
30.6 14.6 9/20/2006 8:20 1405 19 9/20/2006 8:45 
30.5 14.6 9/20/2006 8:20 1505 19 9/20/2006 8:46 
30.5 14.6 9/20/2006 8:20 1214 19 9/20/2006 8:46 
30.2 14.6 9/20/2006 8:20 1293 19 9/20/2006 8:46 
30.1 14.6 9/20/2006 8:20 897 19 9/20/2006 8:46 
30.3 14.6 9/20/2006 8:21 476 19 9/20/2006 8:46 
30.4 14.6 9/20/2006 8:21 284 19 9/20/2006 8:46 
30.2 14.6 9/20/2006 8:21 167 19 9/20/2006 8:46 
30.2 14.6 9/20/2006 8:21 233 19 9/20/2006 8:46 
30.2 14.6 9/20/2006 8:21 279 19 9/20/2006 8:46 
30.4 14.6 9/20/2006 8:21 276 19 9/20/2006 8:46 
30.4 14.6 9/20/2006 8:21 162 19 9/20/2006 8:46 
30.5 14.6 9/20/2006 8:21 240 19 9/20/2006 8:46 
30.5 14.6 9/20/2006 8:21 324 19 9/20/2006 8:46 
30.3 14.6 9/20/2006 8:21 467 19 9/20/2006 8:46 
30.4 14.6 9/20/2006 8:21 481 19 9/20/2006 8:46 
30.3 14.6 9/20/2006 8:21 382 19 9/20/2006 8:46 
30.4 14.6 9/20/2006 8:21 317 19 9/20/2006 8:46 
30.1 14.6 9/20/2006 8:21 211 19 9/20/2006 8:46 
30.2 14.6 9/20/2006 8:21 114 19 9/20/2006 8:46 
30.2 14.6 9/20/2006 8:21 77.3 19 9/20/2006 8:46 
30.1 14.6 9/20/2006 8:21 62.7 19 9/20/2006 8:46 
30.1 14.6 9/20/2006 8:21 54.4 19 9/20/2006 8:46 
30.4 14.6 9/20/2006 8:21 51.2 19 9/20/2006 8:46 
30.2 14.6 9/20/2006 8:21 53.6 19 9/20/2006 8:46 
30.2 14.6 9/20/2006 8:21 62.3 19 9/20/2006 8:46 
30.1 14.6 9/20/2006 8:21 81.4 19 9/20/2006 8:46 
30.3 14.6 9/20/2006 8:21 117 19 9/20/2006 8:46 
30.3 14.6 9/20/2006 8:21 117 19 9/20/2006 8:46 
30.2 14.6 9/20/2006 8:21 104 19 9/20/2006 8:46 
30.5 14.6 9/20/2006 8:21 99.4 19 9/20/2006 8:46 
30.3 14.6 9/20/2006 8:21 83.5 19 9/20/2006 8:46 
30.2 14.6 9/20/2006 8:21 69.1 19 9/20/2006 8:46 
30.2 14.6 9/20/2006 8:21 58.4 19 9/20/2006 8:47 
30.2 14.6 9/20/2006 8:21 49.6 19 9/20/2006 8:47 
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Path Measurement Data 
Site 3 Path 1 

Path Measurement Data 
Site 3 Path 2 

ppm*m pathlength 
Timestamp 

(mountain time) ppm*m pathlength 
Timestamp 

(mountain time) 
30.3 14.6 9/20/2006 8:21 49.4 19 9/20/2006 8:47 
30.3 14.6 9/20/2006 8:21 48.1 19 9/20/2006 8:47 
30.3 14.6 9/20/2006 8:21 49 19 9/20/2006 8:47 
30.5 14.6 9/20/2006 8:21 47.9 19 9/20/2006 8:47 
30.4 14.6 9/20/2006 8:21 47.3 19 9/20/2006 8:47 
30.3 14.6 9/20/2006 8:22 46.7 19 9/20/2006 8:47 
30.4 14.6 9/20/2006 8:22 47.4 19 9/20/2006 8:47 
30.4 14.6 9/20/2006 8:22 48.1 19 9/20/2006 8:47 
30.4 14.6 9/20/2006 8:22 51.8 19 9/20/2006 8:47 
30.4 14.6 9/20/2006 8:22 513 19 9/20/2006 8:47 
39.8 14.6 9/20/2006 8:22 1059 19 9/20/2006 8:47 
30.2 14.6 9/20/2006 8:22 952 19 9/20/2006 8:47 
30.1 14.6 9/20/2006 8:22 1162 19 9/20/2006 8:47 
30.1 14.6 9/20/2006 8:22 2230 19 9/20/2006 8:47 
30.1 14.6 9/20/2006 8:22 1434 19 9/20/2006 8:47 
30.1 14.6 9/20/2006 8:22 767 19 9/20/2006 8:47 
30.1 14.6 9/20/2006 8:22 708 19 9/20/2006 8:47 
30.2 14.6 9/20/2006 8:22 424 19 9/20/2006 8:47 
30.2 14.6 9/20/2006 8:22 402 19 9/20/2006 8:47 
30.2 14.6 9/20/2006 8:22 617 19 9/20/2006 8:47 
30.2 14.6 9/20/2006 8:22 1184 19 9/20/2006 8:47 
30.3 14.6 9/20/2006 8:22 1623 19 9/20/2006 8:47 
30.2 14.6 9/20/2006 8:22 1871 19 9/20/2006 8:47 
30.3 14.6 9/20/2006 8:22 1946 19 9/20/2006 8:47 
30.2 14.6 9/20/2006 8:22 1566 19 9/20/2006 8:47 
30.2 14.6 9/20/2006 8:22 801 19 9/20/2006 8:47 
30.2 14.6 9/20/2006 8:22 458 19 9/20/2006 8:47 
30.3 14.6 9/20/2006 8:22 521 19 9/20/2006 8:47 
30.3 14.6 9/20/2006 8:22 956 19 9/20/2006 8:47 
29.9 14.6 9/20/2006 8:22 969 19 9/20/2006 8:47 
30.1 14.6 9/20/2006 8:22 860 19 9/20/2006 8:47 
30.3 14.6 9/20/2006 8:22 793 19 9/20/2006 8:47 
30.1 14.6 9/20/2006 8:22 1410 19 9/20/2006 8:48 
30.1 14.6 9/20/2006 8:22 871 19 9/20/2006 8:48 
30.1 14.6 9/20/2006 8:22 587 19 9/20/2006 8:48 
30.2 14.6 9/20/2006 8:22 897 19 9/20/2006 8:48 
30 14.6 9/20/2006 8:22 618 19 9/20/2006 8:48 
30 14.6 9/20/2006 8:23 820 19 9/20/2006 8:48 

29.9 14.6 9/20/2006 8:23 1496 19 9/20/2006 8:48 
30 14.6 9/20/2006 8:23 1213 19 9/20/2006 8:48 

30.3 14.6 9/20/2006 8:23 963 19 9/20/2006 8:48 
30 14.6 9/20/2006 8:23 1901 19 9/20/2006 8:48 

30.2 14.6 9/20/2006 8:23 940 19 9/20/2006 8:48 
30.2 14.6 9/20/2006 8:23 522 19 9/20/2006 8:48 
30.1 14.6 9/20/2006 8:23 1446 19 9/20/2006 8:48 
30.2 14.6 9/20/2006 8:23 1863 19 9/20/2006 8:48 
30.1 14.6 9/20/2006 8:23 1569 19 9/20/2006 8:48 
29.9 14.6 9/20/2006 8:23 1902 19 9/20/2006 8:48 
30.1 14.6 9/20/2006 8:23 1630 19 9/20/2006 8:48 
30 14.6 9/20/2006 8:23 1723 19 9/20/2006 8:48 
30 14.6 9/20/2006 8:23 1405 19 9/20/2006 8:48 
30 14.6 9/20/2006 8:23 285 19 9/20/2006 8:48 
30 14.6 9/20/2006 8:23 613 19 9/20/2006 8:48 

30.2 14.6 9/20/2006 8:23 598 19 9/20/2006 8:48 
30.2 14.6 9/20/2006 8:23 518 19 9/20/2006 8:48 
30.3 14.6 9/20/2006 8:23 383 19 9/20/2006 8:48 
30.2 14.6 9/20/2006 8:23 345 19 9/20/2006 8:48 
30.2 14.6 9/20/2006 8:23 216 19 9/20/2006 8:48 
30.1 14.6 9/20/2006 8:23 199 19 9/20/2006 8:48 
30.1 14.6 9/20/2006 8:23 152 19 9/20/2006 8:48 
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Path Measurement Data 
Site 3 Path 1 

Path Measurement Data 
Site 3 Path 2 

ppm*m pathlength 
Timestamp 

(mountain time) ppm*m pathlength 
Timestamp 

(mountain time) 
30.2 14.6 9/20/2006 8:23 86.1 19 9/20/2006 8:48 
30.3 14.6 9/20/2006 8:23 65.1 19 9/20/2006 8:48 
30.2 14.6 9/20/2006 8:24 57.6 19 9/20/2006 8:48 
30.5 14.6 9/20/2006 8:24 46.8 19 9/20/2006 8:48 
30.4 14.6 9/20/2006 8:24 44.4 19 9/20/2006 8:48 
30.6 14.6 9/20/2006 8:24 42.9 19 9/20/2006 8:49 
30.3 14.6 9/20/2006 8:24 43.8 19 9/20/2006 8:49 

   42.6 19 9/20/2006 8:49 
   45.5 19 9/20/2006 8:49 
   45.6 19 9/20/2006 8:49 
   42.8 19 9/20/2006 8:49 
   41.3 19 9/20/2006 8:49 
   40.6 19 9/20/2006 8:49 
   41.5 19 9/20/2006 8:49 
   40.8 19 9/20/2006 8:49 
   39.8 19 9/20/2006 8:49 
   40 19 9/20/2006 8:49 
   39.9 19 9/20/2006 8:49 
   39.9 19 9/20/2006 8:49 
   40 19 9/20/2006 8:49 
   44.4 19 9/20/2006 8:49 
   117 19 9/20/2006 8:49 
   276 19 9/20/2006 8:49 
   418 19 9/20/2006 8:49 
   343 19 9/20/2006 8:49 
   287 19 9/20/2006 8:49 
   211 19 9/20/2006 8:49 
   227 19 9/20/2006 8:49 
   301 19 9/20/2006 8:49 
   178 19 9/20/2006 8:49 
   168 19 9/20/2006 8:49 
   140 19 9/20/2006 8:49 
   187 19 9/20/2006 8:49 
   152 19 9/20/2006 8:49 
   131 19 9/20/2006 8:49 
   144 19 9/20/2006 8:49 
   102 19 9/20/2006 8:49 
   92.7 19 9/20/2006 8:49 
   78.1 19 9/20/2006 8:49 
   58.6 19 9/20/2006 8:50 
   49.8 19 9/20/2006 8:50 
   44 19 9/20/2006 8:50 
   41.1 19 9/20/2006 8:50 
   41.1 19 9/20/2006 8:50 
   41.4 19 9/20/2006 8:50 
   42 19 9/20/2006 8:50 
   42 19 9/20/2006 8:50 
   41.7 19 9/20/2006 8:50 
   41.6 19 9/20/2006 8:50 
   41.6 19 9/20/2006 8:50 
   40.8 19 9/20/2006 8:50 
   40.8 19 9/20/2006 8:50 
   40.4 19 9/20/2006 8:50 
   40 19 9/20/2006 8:50 
   39.8 19 9/20/2006 8:50 
   40 19 9/20/2006 8:50 
   39.8 19 9/20/2006 8:50 
   186 19 9/20/2006 8:50 
   335 19 9/20/2006 8:50 
   713 19 9/20/2006 8:50 
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Path Measurement Data 
Site 3 Path 1 

Path Measurement Data 
Site 3 Path 2 

ppm*m pathlength 
Timestamp 

(mountain time) ppm*m pathlength 
Timestamp 

(mountain time) 
   1228 19 9/20/2006 8:50 
   2162 19 9/20/2006 8:50 
   482 19 9/20/2006 8:50 
   322 19 9/20/2006 8:50 
   591 19 9/20/2006 8:50 
   1180 19 9/20/2006 8:50 
   562 19 9/20/2006 8:50 
   700 19 9/20/2006 8:50 
   764 19 9/20/2006 8:50 
   1997 19 9/20/2006 8:50 
   1837 19 9/20/2006 8:50 
   2197 19 9/20/2006 8:50 
   1461 19 9/20/2006 8:50 
   1668 19 9/20/2006 8:51 
   1399 19 9/20/2006 8:51 
   1799 19 9/20/2006 8:51 
   992 19 9/20/2006 8:51 
   951 19 9/20/2006 8:51 
   896 19 9/20/2006 8:51 
   1365 19 9/20/2006 8:51 
   1459 19 9/20/2006 8:51 
   1601 19 9/20/2006 8:51 
   1161 19 9/20/2006 8:51 
   1005 19 9/20/2006 8:51 
   777 19 9/20/2006 8:51 
   548 19 9/20/2006 8:51 
   710 19 9/20/2006 8:51 
   671 19 9/20/2006 8:51 
   703 19 9/20/2006 8:51 
   635 19 9/20/2006 8:51 
   981 19 9/20/2006 8:51 
   901 19 9/20/2006 8:51 
   765 19 9/20/2006 8:51 
   557 19 9/20/2006 8:51 
   158 19 9/20/2006 8:51 
   64.5 19 9/20/2006 8:51 
   42.3 19 9/20/2006 8:51 
   40 19 9/20/2006 8:51 
   39.9 19 9/20/2006 8:51 
   40 19 9/20/2006 8:51 
   40.4 19 9/20/2006 8:51 
   40.3 19 9/20/2006 8:51 
   40.4 19 9/20/2006 8:51 
   40.4 19 9/20/2006 8:51 
   41 19 9/20/2006 8:51 
   43.1 19 9/20/2006 8:51 
   45.1 19 9/20/2006 8:51 
   45.3 19 9/20/2006 8:52 
   47.6 19 9/20/2006 8:52 
   48.6 19 9/20/2006 8:52 
   42.7 19 9/20/2006 8:52 
   41.1 19 9/20/2006 8:52 
   41.5 19 9/20/2006 8:52 
   44.6 19 9/20/2006 8:52 
   47.8 19 9/20/2006 8:52 
   48.9 19 9/20/2006 8:52 
   49 19 9/20/2006 8:52 
   47.5 19 9/20/2006 8:52 
   45.7 19 9/20/2006 8:52 
   43.6 19 9/20/2006 8:52 
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Path Measurement Data 
Site 3 Path 1 

Path Measurement Data 
Site 3 Path 2 

ppm*m pathlength 
Timestamp 

(mountain time) ppm*m pathlength 
Timestamp 

(mountain time) 
   41.8 19 9/20/2006 8:52 
   41.1 19 9/20/2006 8:52 
   40.7 19 9/20/2006 8:52 
   40.2 19 9/20/2006 8:52 
   40.3 19 9/20/2006 8:52 
   40.1 19 9/20/2006 8:52 
   40.2 19 9/20/2006 8:52 
   40.1 19 9/20/2006 8:52 
   39.9 19 9/20/2006 8:52 
   39.9 19 9/20/2006 8:52 
   39.9 19 9/20/2006 8:52 
   40.1 19 9/20/2006 8:52 
   40.2 19 9/20/2006 8:52 
   40.2 19 9/20/2006 8:52 
   39.9 19 9/20/2006 8:52 
   39.7 19 9/20/2006 8:52 
   40.2 19 9/20/2006 8:52 
   40 19 9/20/2006 8:52 
   40 19 9/20/2006 8:52 
   39.6 19 9/20/2006 8:52 
   39.9 19 9/20/2006 8:52 
   39.9 19 9/20/2006 8:53 
   39.8 19 9/20/2006 8:53 
   40 19 9/20/2006 8:53 
   40 19 9/20/2006 8:53 
   40 19 9/20/2006 8:53 
   40 19 9/20/2006 8:53 
   40 19 9/20/2006 8:53 
   39.7 19 9/20/2006 8:53 
   39.9 19 9/20/2006 8:53 
   39.9 19 9/20/2006 8:53 
   40.1 19 9/20/2006 8:53 
   39.9 19 9/20/2006 8:53 
   40.1 19 9/20/2006 8:53 
   39.8 19 9/20/2006 8:53 
   40.2 19 9/20/2006 8:53 
   40 19 9/20/2006 8:53 
   40 19 9/20/2006 8:53 
   39.9 19 9/20/2006 8:53 
   40.1 19 9/20/2006 8:53 
   40 19 9/20/2006 8:53 
   39.9 19 9/20/2006 8:53 
   41.3 19 9/20/2006 8:53 
   56.5 19 9/20/2006 8:53 
   131 19 9/20/2006 8:53 
   328 19 9/20/2006 8:53 
   671 19 9/20/2006 8:53 
   821 19 9/20/2006 8:53 
   1058 19 9/20/2006 8:53 
   1216 19 9/20/2006 8:53 
   1439 19 9/20/2006 8:53 
   1907 19 9/20/2006 8:53 
   1782 19 9/20/2006 8:53 
   1181 19 9/20/2006 8:53 
   861 19 9/20/2006 8:53 
   1312 19 9/20/2006 8:54 
   1208 19 9/20/2006 8:54 
   1743 19 9/20/2006 8:54 
   1815 19 9/20/2006 8:54 
   2338 19 9/20/2006 8:54 
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Path Measurement Data 
Site 3 Path 1 

Path Measurement Data 
Site 3 Path 2 

ppm*m pathlength 
Timestamp 

(mountain time) ppm*m pathlength 
Timestamp 

(mountain time) 
   2334 19 9/20/2006 8:54 
   2186 19 9/20/2006 8:54 
   1081 19 9/20/2006 8:54 
   1267 19 9/20/2006 8:54 
   1130 19 9/20/2006 8:54 
   1166 19 9/20/2006 8:54 
   319 19 9/20/2006 8:54 
   276 19 9/20/2006 8:54 
   185 19 9/20/2006 8:54 
   97.8 19 9/20/2006 8:54 
   227 19 9/20/2006 8:54 
   346 19 9/20/2006 8:54 
   246 19 9/20/2006 8:54 
   189 19 9/20/2006 8:54 
   220 19 9/20/2006 8:54 
   196 19 9/20/2006 8:54 
   328 19 9/20/2006 8:54 
   1038 19 9/20/2006 8:54 
   1148 19 9/20/2006 8:54 
   888 19 9/20/2006 8:54 
   535 19 9/20/2006 8:54 
   466 19 9/20/2006 8:54 
   403 19 9/20/2006 8:54 
   342 19 9/20/2006 8:54 
   104 19 9/20/2006 8:54 
   73.3 19 9/20/2006 8:54 
   61.1 19 9/20/2006 8:54 
   40.7 19 9/20/2006 8:54 
   40.3 19 9/20/2006 8:55 
   40.6 19 9/20/2006 8:55 
   40.5 19 9/20/2006 8:55 
   40.5 19 9/20/2006 8:55 
   40.5 19 9/20/2006 8:55 
   40.3 19 9/20/2006 8:55 
   40.2 19 9/20/2006 8:55 
   40.4 19 9/20/2006 8:55 
   40.4 19 9/20/2006 8:55 
   42.1 19 9/20/2006 8:55 
   41.1 19 9/20/2006 8:55 
   48.6 19 9/20/2006 8:55 
   53.4 19 9/20/2006 8:55 
   55.1 19 9/20/2006 8:55 
   58.2 19 9/20/2006 8:55 
   64.5 19 9/20/2006 8:55 
   49.2 19 9/20/2006 8:55 
   48.6 19 9/20/2006 8:55 
   42 19 9/20/2006 8:55 
   40.4 19 9/20/2006 8:55 
   40.6 19 9/20/2006 8:55 
   40.3 19 9/20/2006 8:55 
   40.6 19 9/20/2006 8:55 
   40.3 19 9/20/2006 8:55 
   40.2 19 9/20/2006 8:55 
   40.3 19 9/20/2006 8:55 
   40.3 19 9/20/2006 8:55 
   40.2 19 9/20/2006 8:55 
   40.4 19 9/20/2006 8:55 
   40.3 19 9/20/2006 8:55 
   40.3 19 9/20/2006 8:55 
   40.2 19 9/20/2006 8:55 
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Path Measurement Data 
Site 3 Path 1 

Path Measurement Data 
Site 3 Path 2 

ppm*m pathlength 
Timestamp 

(mountain time) ppm*m pathlength 
Timestamp 

(mountain time) 
   40.3 19 9/20/2006 8:55 
   40.5 19 9/20/2006 8:55 
   40.1 19 9/20/2006 8:55 
   40.5 19 9/20/2006 8:56 
   40.2 19 9/20/2006 8:56 
   40.3 19 9/20/2006 8:56 
   40.3 19 9/20/2006 8:56 
   40.4 19 9/20/2006 8:56 
   40.4 19 9/20/2006 8:56 
   40.2 19 9/20/2006 8:56 
   40.2 19 9/20/2006 8:56 
   40.5 19 9/20/2006 8:56 
   40.3 19 9/20/2006 8:56 
   40.3 19 9/20/2006 8:56 
   40.3 19 9/20/2006 8:56 
   40.4 19 9/20/2006 8:56 
   40.7 19 9/20/2006 8:56 
   40.2 19 9/20/2006 8:56 
   40.1 19 9/20/2006 8:56 
   40.2 19 9/20/2006 8:56 
   40.1 19 9/20/2006 8:56 
   40.2 19 9/20/2006 8:56 
   40.2 19 9/20/2006 8:56 
   40.1 19 9/20/2006 8:56 
   40.1 19 9/20/2006 8:56 
   40.1 19 9/20/2006 8:56 
   40.2 19 9/20/2006 8:56 
   142 19 9/20/2006 8:56 
   976 19 9/20/2006 8:56 
   1592 19 9/20/2006 8:56 
   306 19 9/20/2006 8:56 
   516 19 9/20/2006 8:56 
   574 19 9/20/2006 8:56 
   1944 19 9/20/2006 8:56 
   743 19 9/20/2006 8:56 
   299 19 9/20/2006 8:56 
   204 19 9/20/2006 8:57 
   276 19 9/20/2006 8:57 
   165 19 9/20/2006 8:57 
   167 19 9/20/2006 8:57 
   161 19 9/20/2006 8:57 
   130 19 9/20/2006 8:57 
   110 19 9/20/2006 8:57 
   122 19 9/20/2006 8:57 
   100 19 9/20/2006 8:57 
   86.8 19 9/20/2006 8:57 
   71.5 19 9/20/2006 8:57 
   63.6 19 9/20/2006 8:57 
   61.3 19 9/20/2006 8:57 
   51.7 19 9/20/2006 8:57 
   69 19 9/20/2006 8:57 
   316 19 9/20/2006 8:57 
   534 19 9/20/2006 8:57 
   637 19 9/20/2006 8:57 
   111 19 9/20/2006 8:57 
   116 19 9/20/2006 8:57 
   373 19 9/20/2006 8:57 
   439 19 9/20/2006 8:57 
   105 19 9/20/2006 8:57 
   66.2 19 9/20/2006 8:57 
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Path Measurement Data 
Site 3 Path 1 

Path Measurement Data 
Site 3 Path 2 

ppm*m pathlength 
Timestamp 

(mountain time) ppm*m pathlength 
Timestamp 

(mountain time) 
   56.3 19 9/20/2006 8:57 
   41.6 19 9/20/2006 8:57 
   50.2 19 9/20/2006 8:57 
   55 19 9/20/2006 8:57 
   120 19 9/20/2006 8:57 
   52.1 19 9/20/2006 8:57 
   42.4 19 9/20/2006 8:57 
   40.8 19 9/20/2006 8:57 
   40.2 19 9/20/2006 8:57 
   40.3 19 9/20/2006 8:57 
   40.2 19 9/20/2006 8:58 
   40 19 9/20/2006 8:58 
   40.3 19 9/20/2006 8:58 
   40.3 19 9/20/2006 8:58 
   40.7 19 9/20/2006 8:58 
   41 19 9/20/2006 8:58 
   41.9 19 9/20/2006 8:58 
   40.5 19 9/20/2006 8:58 
   40 19 9/20/2006 8:58 
   39.8 19 9/20/2006 8:58 
   39.8 19 9/20/2006 8:58 
   40.2 19 9/20/2006 8:58 
   39.8 19 9/20/2006 8:58 
   40 19 9/20/2006 8:58 
   40 19 9/20/2006 8:58 
   40.2 19 9/20/2006 8:58 
   39.9 19 9/20/2006 8:58 
   40 19 9/20/2006 8:58 
   39.9 19 9/20/2006 8:58 
   40.1 19 9/20/2006 8:58 
   39.7 19 9/20/2006 8:58 
   39.9 19 9/20/2006 8:58 
   39.9 19 9/20/2006 8:58 
   39.8 19 9/20/2006 8:58 
   40 19 9/20/2006 8:58 
   40 19 9/20/2006 8:58 
   39.9 19 9/20/2006 8:58 
   40 19 9/20/2006 8:58 
   39.9 19 9/20/2006 8:58 
   40.1 19 9/20/2006 8:58 
   40.1 19 9/20/2006 8:58 
   39.9 19 9/20/2006 8:58 
   40.5 19 9/20/2006 8:58 
   40.3 19 9/20/2006 8:58 
   40.4 19 9/20/2006 8:59 
   40.1 19 9/20/2006 8:59 
   39.9 19 9/20/2006 8:59 
   40.2 19 9/20/2006 8:59 
   40.3 19 9/20/2006 8:59 
   40 19 9/20/2006 8:59 
   39.9 19 9/20/2006 8:59 
   40.2 19 9/20/2006 8:59 
   40.1 19 9/20/2006 8:59 
   40 19 9/20/2006 8:59 
   40.1 19 9/20/2006 8:59 
   40.1 19 9/20/2006 8:59 
   40 19 9/20/2006 8:59 
   40.1 19 9/20/2006 8:59 
   40.1 19 9/20/2006 8:59 
   40.3 19 9/20/2006 8:59 
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Path Measurement Data 
Site 3 Path 1 

Path Measurement Data 
Site 3 Path 2 

ppm*m pathlength 
Timestamp 

(mountain time) ppm*m pathlength 
Timestamp 

(mountain time) 
   40 19 9/20/2006 8:59 
   40.2 19 9/20/2006 8:59 
   40.1 19 9/20/2006 8:59 
   40.2 19 9/20/2006 8:59 
   40.2 19 9/20/2006 8:59 
   40.2 19 9/20/2006 8:59 
   40.1 19 9/20/2006 8:59 
   39.8 19 9/20/2006 8:59 
   40.1 19 9/20/2006 8:59 
   39.9 19 9/20/2006 8:59 
   39.9 19 9/20/2006 8:59 
   40.2 19 9/20/2006 8:59 
   40 19 9/20/2006 8:59 
   40.1 19 9/20/2006 8:59 
   40.2 19 9/20/2006 8:59 
   40.2 19 9/20/2006 8:59 
   40.1 19 9/20/2006 8:59 
   39.9 19 9/20/2006 8:59 
   40 19 9/20/2006 9:00 
   40 19 9/20/2006 9:00 
   40 19 9/20/2006 9:00 
   40.3 19 9/20/2006 9:00 
   40.2 19 9/20/2006 9:00 
   40.1 19 9/20/2006 9:00 
   40.1 19 9/20/2006 9:00 
   39.8 19 9/20/2006 9:00 
   40.1 19 9/20/2006 9:00 
   40.1 19 9/20/2006 9:00 
   40.1 19 9/20/2006 9:00 
   40 19 9/20/2006 9:00 
   40 19 9/20/2006 9:00 
   40.1 19 9/20/2006 9:00 
   40 19 9/20/2006 9:00 
   40.2 19 9/20/2006 9:00 
   40.1 19 9/20/2006 9:00 
   40.1 19 9/20/2006 9:00 
   39.9 19 9/20/2006 9:00 
   39.8 19 9/20/2006 9:00 
   39.7 19 9/20/2006 9:00 
   40 19 9/20/2006 9:00 
   40 19 9/20/2006 9:00 
   40 19 9/20/2006 9:00 
   39.9 19 9/20/2006 9:00 
   39.9 19 9/20/2006 9:00 
   39.9 19 9/20/2006 9:00 
   40 19 9/20/2006 9:00 
   39.7 19 9/20/2006 9:00 
   40.2 19 9/20/2006 9:00 
   40 19 9/20/2006 9:00 
   40.3 19 9/20/2006 9:00 
   40 19 9/20/2006 9:00 
   39.9 19 9/20/2006 9:01 
   40.1 19 9/20/2006 9:01 
   40.2 19 9/20/2006 9:01 
   40.1 19 9/20/2006 9:01 
   40.1 19 9/20/2006 9:01 
   40 19 9/20/2006 9:01 
   39.9 19 9/20/2006 9:01 
   40.1 19 9/20/2006 9:01 
   40.2 19 9/20/2006 9:01 
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Path Measurement Data 
Site 3 Path 1 

Path Measurement Data 
Site 3 Path 2 

ppm*m pathlength 
Timestamp 

(mountain time) ppm*m pathlength 
Timestamp 

(mountain time) 
   40.2 19 9/20/2006 9:01 
   39.9 19 9/20/2006 9:01 
   40.1 19 9/20/2006 9:01 
   40.1 19 9/20/2006 9:01 
   40.2 19 9/20/2006 9:01 
   40.2 19 9/20/2006 9:01 
   40.2 19 9/20/2006 9:01 
   40.1 19 9/20/2006 9:01 
   40 19 9/20/2006 9:01 
   40.2 19 9/20/2006 9:01 
   40.2 19 9/20/2006 9:01 
   40.2 19 9/20/2006 9:01 
   39.9 19 9/20/2006 9:01 
   40.1 19 9/20/2006 9:01 
   40.3 19 9/20/2006 9:01 
   40.4 19 9/20/2006 9:01 
   39.9 19 9/20/2006 9:01 
   39.9 19 9/20/2006 9:01 
   40 19 9/20/2006 9:01 
   40 19 9/20/2006 9:01 
   40.1 19 9/20/2006 9:01 
   39.7 19 9/20/2006 9:01 
   39.9 19 9/20/2006 9:01 
   40.1 19 9/20/2006 9:01 
   40 19 9/20/2006 9:01 
   40 19 9/20/2006 9:02 
   39.9 19 9/20/2006 9:02 
   40.1 19 9/20/2006 9:02 
   40.3 19 9/20/2006 9:02 
   40.1 19 9/20/2006 9:02 
   40 19 9/20/2006 9:02 
   40.3 19 9/20/2006 9:02 
   40.4 19 9/20/2006 9:02 
   40.3 19 9/20/2006 9:02 
   40.1 19 9/20/2006 9:02 
   40.3 19 9/20/2006 9:02 
   40 19 9/20/2006 9:02 
   39.9 19 9/20/2006 9:02 
   40 19 9/20/2006 9:02 
   40 19 9/20/2006 9:02 
   40.1 19 9/20/2006 9:02 
   39.9 19 9/20/2006 9:02 
   39.8 19 9/20/2006 9:02 
   39.8 19 9/20/2006 9:02 
   39.8 19 9/20/2006 9:02 
   39.8 19 9/20/2006 9:02 
   40.1 19 9/20/2006 9:02 
   40 19 9/20/2006 9:02 
   40 19 9/20/2006 9:02 
   40.3 19 9/20/2006 9:02 
   52.9 19 9/20/2006 9:02 
   110 19 9/20/2006 9:02 
   105 19 9/20/2006 9:02 
   240 19 9/20/2006 9:02 
   396 19 9/20/2006 9:02 
   820 19 9/20/2006 9:02 
   1298 19 9/20/2006 9:02 
   981 19 9/20/2006 9:02 
   754 19 9/20/2006 9:02 
   521 19 9/20/2006 9:03 
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Path Measurement Data 
Site 3 Path 1 

Path Measurement Data 
Site 3 Path 2 

ppm*m pathlength 
Timestamp 

(mountain time) ppm*m pathlength 
Timestamp 

(mountain time) 
   421 19 9/20/2006 9:03 
   312 19 9/20/2006 9:03 
   344 19 9/20/2006 9:03 
   743 19 9/20/2006 9:03 
   1182 19 9/20/2006 9:03 
   2247 19 9/20/2006 9:03 
   2322 19 9/20/2006 9:03 
   2577 19 9/20/2006 9:03 
   852 19 9/20/2006 9:03 
   944 19 9/20/2006 9:03 
   1459 19 9/20/2006 9:03 
   1098 19 9/20/2006 9:03 
   1407 19 9/20/2006 9:03 
   1819 19 9/20/2006 9:03 
   2772 19 9/20/2006 9:03 
   2375 19 9/20/2006 9:03 
   1639 19 9/20/2006 9:03 
   915 19 9/20/2006 9:03 
   994 19 9/20/2006 9:03 
   1084 19 9/20/2006 9:03 
   1585 19 9/20/2006 9:03 
   2750 19 9/20/2006 9:03 
   2412 19 9/20/2006 9:03 
   2279 19 9/20/2006 9:03 
   2651 19 9/20/2006 9:03 
   2210 19 9/20/2006 9:03 
   2618 19 9/20/2006 9:03 
   2607 19 9/20/2006 9:03 
   2259 19 9/20/2006 9:03 
   2634 19 9/20/2006 9:03 
   2108 19 9/20/2006 9:03 
   538 19 9/20/2006 9:04 
   244 19 9/20/2006 9:04 
   1470 19 9/20/2006 9:04 
   1105 19 9/20/2006 9:04 
   1295 19 9/20/2006 9:04 
   912 19 9/20/2006 9:04 
   2379 19 9/20/2006 9:04 
   1969 19 9/20/2006 9:04 

3   1777 19 9/20/2006 9:04 
   1329 19 9/20/2006 9:04 
   1054 19 9/20/2006 9:04 
   1356 19 9/20/2006 9:04 
   860 19 9/20/2006 9:04 
   427 19 9/20/2006 9:04 
   255 19 9/20/2006 9:04 
   213 19 9/20/2006 9:04 
   1310 19 9/20/2006 9:04 
   2621 19 9/20/2006 9:04 
   2376 19 9/20/2006 9:04 
   2575 19 9/20/2006 9:04 
   2586 19 9/20/2006 9:04 
   2277 19 9/20/2006 9:04 
   2192 19 9/20/2006 9:04 
   1044 19 9/20/2006 9:04 
   135 19 9/20/2006 9:04 
   89.1 19 9/20/2006 9:04 
   97.3 19 9/20/2006 9:04 
   86.8 19 9/20/2006 9:04 
   81.8 19 9/20/2006 9:04 
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Path Measurement Data 
Site 3 Path 1 

Path Measurement Data 
Site 3 Path 2 

ppm*m pathlength 
Timestamp 

(mountain time) ppm*m pathlength 
Timestamp 

(mountain time) 
   84 19 9/20/2006 9:04 
   236 19 9/20/2006 9:04 
   384 19 9/20/2006 9:04 
   121 19 9/20/2006 9:04 
   82.9 19 9/20/2006 9:05 
   81.9 19 9/20/2006 9:05 
   79.4 19 9/20/2006 9:05 
   79.5 19 9/20/2006 9:05 
   65.5 19 9/20/2006 9:05 
   65 19 9/20/2006 9:05 
   72.5 19 9/20/2006 9:05 
   96.7 19 9/20/2006 9:05 
   163 19 9/20/2006 9:05 
   151 19 9/20/2006 9:05 
   105 19 9/20/2006 9:05 
   102 19 9/20/2006 9:05 
   95.7 19 9/20/2006 9:05 
   69.1 19 9/20/2006 9:05 
   72.6 19 9/20/2006 9:05 
   65.1 19 9/20/2006 9:05 
   59.2 19 9/20/2006 9:05 
   50.6 19 9/20/2006 9:05 
   43.6 19 9/20/2006 9:05 
   43 19 9/20/2006 9:05 
   40.5 19 9/20/2006 9:05 
   40.5 19 9/20/2006 9:05 
   40.1 19 9/20/2006 9:05 
   149 19 9/20/2006 9:05 
   736 19 9/20/2006 9:05 
   2053 19 9/20/2006 9:05 
   1673 19 9/20/2006 9:05 
   1454 19 9/20/2006 9:05 
   1800 19 9/20/2006 9:05 
   2512 19 9/20/2006 9:05 
   2701 19 9/20/2006 9:05 
   2333 19 9/20/2006 9:05 
   1090 19 9/20/2006 9:05 
   1247 19 9/20/2006 9:06 
   1263 19 9/20/2006 9:06 
   1159 19 9/20/2006 9:06 
   2099 19 9/20/2006 9:06 
   1850 19 9/20/2006 9:06 
   1996 19 9/20/2006 9:06 
   2233 19 9/20/2006 9:06 
   1841 19 9/20/2006 9:06 
   2164 19 9/20/2006 9:06 
   1593 19 9/20/2006 9:06 
   1858 19 9/20/2006 9:06 
   2353 19 9/20/2006 9:06 
   1747 19 9/20/2006 9:06 
   1197 19 9/20/2006 9:06 
   2868 19 9/20/2006 9:06 
   2935 19 9/20/2006 9:06 
   2405 19 9/20/2006 9:06 
   1928 19 9/20/2006 9:06 
   1218 19 9/20/2006 9:06 
   1363 19 9/20/2006 9:06 
   1373 19 9/20/2006 9:06 
   1161 19 9/20/2006 9:06 
   1366 19 9/20/2006 9:06 
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Path Measurement Data 
Site 3 Path 1 

Path Measurement Data 
Site 3 Path 2 

ppm*m pathlength 
Timestamp 

(mountain time) ppm*m pathlength 
Timestamp 

(mountain time) 
   1492 19 9/20/2006 9:06 
   1575 19 9/20/2006 9:06 
   1586 19 9/20/2006 9:06 
   1677 19 9/20/2006 9:06 
   1948 19 9/20/2006 9:06 
   1790 19 9/20/2006 9:06 
   1177 19 9/20/2006 9:06 
   737 19 9/20/2006 9:07 
   509 19 9/20/2006 9:07 
   462 19 9/20/2006 9:07 
   308 19 9/20/2006 9:07 
   148 19 9/20/2006 9:07 
   107 19 9/20/2006 9:07 
   76.2 19 9/20/2006 9:07 
   67.7 19 9/20/2006 9:07 
   89.5 19 9/20/2006 9:07 
   61 19 9/20/2006 9:07 
   45.9 19 9/20/2006 9:07 
   43.2 19 9/20/2006 9:07 
   43 19 9/20/2006 9:07 
   52.1 19 9/20/2006 9:07 
   45 19 9/20/2006 9:07 
   44.3 19 9/20/2006 9:07 
   44.5 19 9/20/2006 9:07 
   41.8 19 9/20/2006 9:07 
   45.1 19 9/20/2006 9:07 
   41.8 19 9/20/2006 9:07 
   41.7 19 9/20/2006 9:07 
   42 19 9/20/2006 9:07 
   40.8 19 9/20/2006 9:07 
   43.1 19 9/20/2006 9:07 
   42.2 19 9/20/2006 9:07 
   41.8 19 9/20/2006 9:07 
   41.8 19 9/20/2006 9:07 
   41.4 19 9/20/2006 9:07 
   41.6 19 9/20/2006 9:07 
   41.2 19 9/20/2006 9:07 
   41 19 9/20/2006 9:07 
   40.6 19 9/20/2006 9:07 
   41 19 9/20/2006 9:07 
   41.4 19 9/20/2006 9:07 
   40.9 19 9/20/2006 9:08 
   41 19 9/20/2006 9:08 
   40.6 19 9/20/2006 9:08 
   41 19 9/20/2006 9:08 
   40.6 19 9/20/2006 9:08 
   40.2 19 9/20/2006 9:08 
   40.2 19 9/20/2006 9:08 
   40.5 19 9/20/2006 9:08 
   40.5 19 9/20/2006 9:08 
   40.3 19 9/20/2006 9:08 
   40.3 19 9/20/2006 9:08 
   40.2 19 9/20/2006 9:08 
   40 19 9/20/2006 9:08 
   40.1 19 9/20/2006 9:08 
   39.8 19 9/20/2006 9:08 
   39.9 19 9/20/2006 9:08 
   40.2 19 9/20/2006 9:08 
   39.9 19 9/20/2006 9:08 
   40.1 19 9/20/2006 9:08 
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Path Measurement Data 
Site 3 Path 1 

Path Measurement Data 
Site 3 Path 2 

ppm*m pathlength 
Timestamp 

(mountain time) ppm*m pathlength 
Timestamp 

(mountain time) 
   39.9 19 9/20/2006 9:08 
   40 19 9/20/2006 9:08 
   39.9 19 9/20/2006 9:08 
   39.9 19 9/20/2006 9:08 
   39.8 19 9/20/2006 9:08 
   39.9 19 9/20/2006 9:08 
   40 19 9/20/2006 9:08 
   39.9 19 9/20/2006 9:08 
   39.8 19 9/20/2006 9:08 
   39.7 19 9/20/2006 9:08 
   39.9 19 9/20/2006 9:08 
   40 19 9/20/2006 9:08 
   40 19 9/20/2006 9:08 
   39.6 19 9/20/2006 9:08 
   40 19 9/20/2006 9:08 
   39.7 19 9/20/2006 9:09 
   39.9 19 9/20/2006 9:09 
   40 19 9/20/2006 9:09 
   39.7 19 9/20/2006 9:09 
   39.9 19 9/20/2006 9:09 
   40 19 9/20/2006 9:09 
   40 19 9/20/2006 9:09 
   40 19 9/20/2006 9:09 
   39.9 19 9/20/2006 9:09 
   39.8 19 9/20/2006 9:09 
   39.8 19 9/20/2006 9:09 
   40 19 9/20/2006 9:09 
   39.9 19 9/20/2006 9:09 
   40.1 19 9/20/2006 9:09 
   39.9 19 9/20/2006 9:09 
   40 19 9/20/2006 9:09 
   40 19 9/20/2006 9:09 
   39.8 19 9/20/2006 9:09 
   39.9 19 9/20/2006 9:09 
   39.9 19 9/20/2006 9:09 
   40 19 9/20/2006 9:09 
   40.1 19 9/20/2006 9:09 
   40.1 19 9/20/2006 9:09 
   40.1 19 9/20/2006 9:09 
   40.3 19 9/20/2006 9:09 
   40.2 19 9/20/2006 9:09 
   183 19 9/20/2006 9:09 
   103 19 9/20/2006 9:09 
   2137 19 9/20/2006 9:09 
   1553 19 9/20/2006 9:09 
   337 19 9/20/2006 9:09 
   297 19 9/20/2006 9:09 
   139 19 9/20/2006 9:09 
   65.8 19 9/20/2006 9:10 
   100 19 9/20/2006 9:10 
   191 19 9/20/2006 9:10 
   268 19 9/20/2006 9:10 
   202 19 9/20/2006 9:10 
   251 19 9/20/2006 9:10 
   1215 19 9/20/2006 9:10 
   900 19 9/20/2006 9:10 
   1055 19 9/20/2006 9:10 
   694 19 9/20/2006 9:10 
   441 19 9/20/2006 9:10 
   454 19 9/20/2006 9:10 
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Path Measurement Data 
Site 3 Path 1 

Path Measurement Data 
Site 3 Path 2 

ppm*m pathlength 
Timestamp 

(mountain time) ppm*m pathlength 
Timestamp 

(mountain time) 
   475 19 9/20/2006 9:10 
   272 19 9/20/2006 9:10 
   77.3 19 9/20/2006 9:10 
   584 19 9/20/2006 9:10 
   751 19 9/20/2006 9:10 
   1013 19 9/20/2006 9:10 
   463 19 9/20/2006 9:10 
   431 19 9/20/2006 9:10 
   1327 19 9/20/2006 9:10 
   972 19 9/20/2006 9:10 
   493 19 9/20/2006 9:10 
   271 19 9/20/2006 9:10 
   1100 19 9/20/2006 9:10 
   548 19 9/20/2006 9:10 
   1625 19 9/20/2006 9:10 
   1743 19 9/20/2006 9:10 
   1614 19 9/20/2006 9:10 
   656 19 9/20/2006 9:10 
   334 19 9/20/2006 9:10 
   198 19 9/20/2006 9:10 
   838 19 9/20/2006 9:10 
   934 19 9/20/2006 9:11 
   182 19 9/20/2006 9:11 
   300 19 9/20/2006 9:11 
   202 19 9/20/2006 9:11 
   991 19 9/20/2006 9:11 
   168 19 9/20/2006 9:11 
   931 19 9/20/2006 9:11 
   1207 19 9/20/2006 9:11 
   1205 19 9/20/2006 9:11 
   630 19 9/20/2006 9:11 
   871 19 9/20/2006 9:11 
   618 19 9/20/2006 9:11 
   322 19 9/20/2006 9:11 
   244 19 9/20/2006 9:11 
   455 19 9/20/2006 9:11 
   819 19 9/20/2006 9:11 
   306 19 9/20/2006 9:11 
   2341 19 9/20/2006 9:11 
   1816 19 9/20/2006 9:11 
   997 19 9/20/2006 9:11 
   355 19 9/20/2006 9:11 
   1340 19 9/20/2006 9:11 
   2438 19 9/20/2006 9:11 
   2323 19 9/20/2006 9:11 
   1497 19 9/20/2006 9:11 
   1432 19 9/20/2006 9:11 
   1156 19 9/20/2006 9:11 
   1246 19 9/20/2006 9:11 
   1248 19 9/20/2006 9:11 
   772 19 9/20/2006 9:11 
   1884 19 9/20/2006 9:11 
   1898 19 9/20/2006 9:11 
   2430 19 9/20/2006 9:11 
   2267 19 9/20/2006 9:12 
   2427 19 9/20/2006 9:12 
   2405 19 9/20/2006 9:12 
   1518 19 9/20/2006 9:12 
   1942 19 9/20/2006 9:12 
   1358 19 9/20/2006 9:12 
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Path Measurement Data 
Site 3 Path 1 

Path Measurement Data 
Site 3 Path 2 

ppm*m pathlength 
Timestamp 

(mountain time) ppm*m pathlength 
Timestamp 

(mountain time) 
   352 19 9/20/2006 9:12 
   283 19 9/20/2006 9:12 
   1993 19 9/20/2006 9:12 
   716 19 9/20/2006 9:12 
   1029 19 9/20/2006 9:12 
   533 19 9/20/2006 9:12 
   2594 19 9/20/2006 9:12 
   2228 19 9/20/2006 9:12 
   942 19 9/20/2006 9:12 
   223 19 9/20/2006 9:12 
   74.3 19 9/20/2006 9:12 
   95.4 19 9/20/2006 9:12 
   78 19 9/20/2006 9:12 
   1225 19 9/20/2006 9:12 
   1728 19 9/20/2006 9:12 
   2417 19 9/20/2006 9:12 
   2144 19 9/20/2006 9:12 
   2175 19 9/20/2006 9:12 
   2054 19 9/20/2006 9:12 
   2434 19 9/20/2006 9:12 
   2101 19 9/20/2006 9:12 
   1539 19 9/20/2006 9:12 
   1210 19 9/20/2006 9:12 
   1851 19 9/20/2006 9:13 
   297 19 9/20/2006 9:13 
   283 19 9/20/2006 9:13 
   414 19 9/20/2006 9:13 
   136 19 9/20/2006 9:13 
   113 19 9/20/2006 9:13 
   119 19 9/20/2006 9:13 
   101 19 9/20/2006 9:13 
   82.3 19 9/20/2006 9:13 
   150 19 9/20/2006 9:13 
   183 19 9/20/2006 9:13 
   194 19 9/20/2006 9:13 
   212 19 9/20/2006 9:13 
   201 19 9/20/2006 9:13 
   197 19 9/20/2006 9:13 
   202 19 9/20/2006 9:13 
   169 19 9/20/2006 9:13 
   255 19 9/20/2006 9:13 
   1138 19 9/20/2006 9:13 
   2496 19 9/20/2006 9:13 
   1517 19 9/20/2006 9:13 
   400 19 9/20/2006 9:13 
   957 19 9/20/2006 9:13 
   1856 19 9/20/2006 9:13 
   1752 19 9/20/2006 9:13 
   728 19 9/20/2006 9:13 
   706 19 9/20/2006 9:13 
   447 19 9/20/2006 9:13 
   111 19 9/20/2006 9:13 
   291 19 9/20/2006 9:13 
   50.1 19 9/20/2006 9:13 
   41.1 19 9/20/2006 9:13 
   40 19 9/20/2006 9:13 
   41.2 19 9/20/2006 9:13 
   40.1 19 9/20/2006 9:14 
   39.8 19 9/20/2006 9:14 
   40 19 9/20/2006 9:14 
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Path Measurement Data 
Site 3 Path 1 

Path Measurement Data 
Site 3 Path 2 

ppm*m pathlength 
Timestamp 

(mountain time) ppm*m pathlength 
Timestamp 

(mountain time) 
   39.8 19 9/20/2006 9:14 
   39.6 19 9/20/2006 9:14 
   40 19 9/20/2006 9:14 
   40.5 19 9/20/2006 9:14 
   50 19 9/20/2006 9:14 
   187 19 9/20/2006 9:14 
   258 19 9/20/2006 9:14 
   308 19 9/20/2006 9:14 
   156 19 9/20/2006 9:14 
   75.4 19 9/20/2006 9:14 
   50.3 19 9/20/2006 9:14 
   45.2 19 9/20/2006 9:14 
   43.2 19 9/20/2006 9:14 
   40.6 19 9/20/2006 9:14 
   40.1 19 9/20/2006 9:14 
   40.2 19 9/20/2006 9:14 
   40.2 19 9/20/2006 9:14 
   40 19 9/20/2006 9:14 
   40.2 19 9/20/2006 9:14 
   40.2 19 9/20/2006 9:14 
   40.3 19 9/20/2006 9:14 
   40 19 9/20/2006 9:14 
   40 19 9/20/2006 9:14 
   39.9 19 9/20/2006 9:14 
   40 19 9/20/2006 9:14 
   40.3 19 9/20/2006 9:14 
   42.5 19 9/20/2006 9:14 
   45.5 19 9/20/2006 9:14 
   46 19 9/20/2006 9:14 
   49.9 19 9/20/2006 9:14 
   52.4 19 9/20/2006 9:14 
   50.4 19 9/20/2006 9:15 
   47.3 19 9/20/2006 9:15 
   45.7 19 9/20/2006 9:15 
   41.7 19 9/20/2006 9:15 
   40.5 19 9/20/2006 9:15 
   39.9 19 9/20/2006 9:15 
   39.9 19 9/20/2006 9:15 
   39.9 19 9/20/2006 9:15 
   40.1 19 9/20/2006 9:15 
   40 19 9/20/2006 9:15 
   40.4 19 9/20/2006 9:15 
   40.7 19 9/20/2006 9:15 
   40.9 19 9/20/2006 9:15 
   40.9 19 9/20/2006 9:15 
   41 19 9/20/2006 9:15 
   40.5 19 9/20/2006 9:15 
   41 19 9/20/2006 9:15 
   40.8 19 9/20/2006 9:15 
   43.5 19 9/20/2006 9:15 
   176 19 9/20/2006 9:15 
   619 19 9/20/2006 9:15 
   1028 19 9/20/2006 9:15 
   1170 19 9/20/2006 9:15 
   1132 19 9/20/2006 9:15 
   1655 19 9/20/2006 9:15 
   872 19 9/20/2006 9:15 
   109 19 9/20/2006 9:15 
   68.6 19 9/20/2006 9:15 
   41.5 19 9/20/2006 9:15 
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Path Measurement Data 
Site 3 Path 1 

Path Measurement Data 
Site 3 Path 2 

ppm*m pathlength 
Timestamp 

(mountain time) ppm*m pathlength 
Timestamp 

(mountain time) 
   39.9 19 9/20/2006 9:15 
   39.5 19 9/20/2006 9:15 
   39.7 19 9/20/2006 9:15 
   40 19 9/20/2006 9:16 
   39.9 19 9/20/2006 9:16 
   39.7 19 9/20/2006 9:16 
   39.9 19 9/20/2006 9:16 
   39.7 19 9/20/2006 9:16 
   39.9 19 9/20/2006 9:16 
   39.9 19 9/20/2006 9:16 
   39.9 19 9/20/2006 9:16 
   40 19 9/20/2006 9:16 
   39.7 19 9/20/2006 9:16 
   39.8 19 9/20/2006 9:16 
   41.1 19 9/20/2006 9:16 
   41.3 19 9/20/2006 9:16 
   45.2 19 9/20/2006 9:16 
   88.1 19 9/20/2006 9:16 
   84.8 19 9/20/2006 9:16 
   358 19 9/20/2006 9:16 
   935 19 9/20/2006 9:16 
   1178 19 9/20/2006 9:16 
   591 19 9/20/2006 9:16 
   253 19 9/20/2006 9:16 
   301 19 9/20/2006 9:16 
   620 19 9/20/2006 9:16 
   406 19 9/20/2006 9:16 
   772 19 9/20/2006 9:16 
   589 19 9/20/2006 9:16 
   824 19 9/20/2006 9:16 
   1165 19 9/20/2006 9:16 
   760 19 9/20/2006 9:16 
   506 19 9/20/2006 9:16 
   263 19 9/20/2006 9:16 
   94.8 19 9/20/2006 9:16 
   77.6 19 9/20/2006 9:16 
   91.3 19 9/20/2006 9:16 
   115 19 9/20/2006 9:17 
   246 19 9/20/2006 9:17 
   260 19 9/20/2006 9:17 
   181 19 9/20/2006 9:17 
   175 19 9/20/2006 9:17 
   144 19 9/20/2006 9:17 
   122 19 9/20/2006 9:17 
   107 19 9/20/2006 9:17 
   258 19 9/20/2006 9:17 
   726 19 9/20/2006 9:17 
   1055 19 9/20/2006 9:17 
   1704 19 9/20/2006 9:17 
   1438 19 9/20/2006 9:17 
   467 19 9/20/2006 9:17 
   187 19 9/20/2006 9:17 
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Path Measurement Data 
Site 4 Path 1 

Path Measurement Data 
Site 4 Path 2 

ppm*m pathlength 
Timestamp 

(mountain time) ppm*m pathlength 
Timestamp 

(mountain time) 
27.8 10.7 9/21/2006 9:26 48.6 12.8 9/21/2006 9:54 
21.7 10.7 9/21/2006 9:26 47.4 12.8 9/21/2006 9:54 
21.5 10.7 9/21/2006 9:26 45.5 12.8 9/21/2006 9:54 
21.1 10.7 9/21/2006 9:26 49.9 12.8 9/21/2006 9:54 
71.7 10.7 9/21/2006 9:26 50.9 12.8 9/21/2006 9:54 
49.7 10.7 9/21/2006 9:26 47.5 12.8 9/21/2006 9:54 
38.8 10.7 9/21/2006 9:26 43.2 12.8 9/21/2006 9:54 
51.5 10.7 9/21/2006 9:26 44.1 12.8 9/21/2006 9:54 
51.2 10.7 9/21/2006 9:26 60.6 12.8 9/21/2006 9:54 
31.6 10.7 9/21/2006 9:26 57.6 12.8 9/21/2006 9:54 
21.8 10.7 9/21/2006 9:26 45.8 12.8 9/21/2006 9:54 
28.4 10.7 9/21/2006 9:26 39.1 12.8 9/21/2006 9:54 
42.5 10.7 9/21/2006 9:26 39.3 12.8 9/21/2006 9:54 
42.9 10.7 9/21/2006 9:26 38.1 12.8 9/21/2006 9:54 
31.5 10.7 9/21/2006 9:26 47.2 12.8 9/21/2006 9:54 
27.9 10.7 9/21/2006 9:26 39.4 12.8 9/21/2006 9:54 
29.1 10.7 9/21/2006 9:26 42.3 12.8 9/21/2006 9:54 
34.3 10.7 9/21/2006 9:26 39.3 12.8 9/21/2006 9:55 
29.8 10.7 9/21/2006 9:26 35.8 12.8 9/21/2006 9:55 
21.5 10.7 9/21/2006 9:26 33.6 12.8 9/21/2006 9:55 
21.2 10.7 9/21/2006 9:26 28.9 12.8 9/21/2006 9:55 
21.5 10.7 9/21/2006 9:26 55.3 12.8 9/21/2006 9:55 
34.3 10.7 9/21/2006 9:26 307 12.8 9/21/2006 9:55 
21.1 10.7 9/21/2006 9:26 31.3 12.8 9/21/2006 9:55 
21.2 10.7 9/21/2006 9:26 84.9 12.8 9/21/2006 9:55 
28.5 10.7 9/21/2006 9:26 209 12.8 9/21/2006 9:55 
38.5 10.7 9/21/2006 9:27 264 12.8 9/21/2006 9:55 
24.6 10.7 9/21/2006 9:27 221 12.8 9/21/2006 9:55 
21.7 10.7 9/21/2006 9:27 436 12.8 9/21/2006 9:55 
30.7 10.7 9/21/2006 9:27 468 12.8 9/21/2006 9:55 
23.7 10.7 9/21/2006 9:27 113 12.8 9/21/2006 9:55 
26.6 10.7 9/21/2006 9:27 83.8 12.8 9/21/2006 9:55 
31.3 10.7 9/21/2006 9:27 73.2 12.8 9/21/2006 9:55 
29.2 10.7 9/21/2006 9:27 146 12.8 9/21/2006 9:55 
23.9 10.7 9/21/2006 9:27 84.3 12.8 9/21/2006 9:55 
29 10.7 9/21/2006 9:27 85.8 12.8 9/21/2006 9:55 

33.8 10.7 9/21/2006 9:27 48.6 12.8 9/21/2006 9:55 
35.3 10.7 9/21/2006 9:27 41.3 12.8 9/21/2006 9:55 
57.6 10.7 9/21/2006 9:27 45.9 12.8 9/21/2006 9:55 
61.4 10.7 9/21/2006 9:27 43 12.8 9/21/2006 9:55 
29 10.7 9/21/2006 9:27 28.3 12.8 9/21/2006 9:55 

22.7 10.7 9/21/2006 9:27 38.5 12.8 9/21/2006 9:55 
23.3 10.7 9/21/2006 9:27 36.4 12.8 9/21/2006 9:55 
22.3 10.7 9/21/2006 9:27 44.7 12.8 9/21/2006 9:55 
22.8 10.7 9/21/2006 9:27 78.3 12.8 9/21/2006 9:55 
23.1 10.7 9/21/2006 9:27 47.2 12.8 9/21/2006 9:55 
23.8 10.7 9/21/2006 9:27 36.2 12.8 9/21/2006 9:55 
25.8 10.7 9/21/2006 9:27 96.3 12.8 9/21/2006 9:55 
29.8 10.7 9/21/2006 9:27 37.5 12.8 9/21/2006 9:55 
30.5 10.7 9/21/2006 9:27 61.9 12.8 9/21/2006 9:55 
29.6 10.7 9/21/2006 9:27 43.8 12.8 9/21/2006 9:56 
27.6 10.7 9/21/2006 9:27 62.2 12.8 9/21/2006 9:56 
27.4 10.7 9/21/2006 9:27 123 12.8 9/21/2006 9:56 
26.5 10.7 9/21/2006 9:27 223 12.8 9/21/2006 9:56 
28 10.7 9/21/2006 9:27 166 12.8 9/21/2006 9:56 

36.9 10.7 9/21/2006 9:27 96 12.8 9/21/2006 9:56 
60.3 10.7 9/21/2006 9:27 96.4 12.8 9/21/2006 9:56 
38.7 10.7 9/21/2006 9:27 128 12.8 9/21/2006 9:56 
34.5 10.7 9/21/2006 9:27 232 12.8 9/21/2006 9:56 
33.4 10.7 9/21/2006 9:27 498 12.8 9/21/2006 9:56 
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Path Measurement Data 
Site 4 Path 1 

Path Measurement Data 
Site 4 Path 2 

ppm*m pathlength 
Timestamp 

(mountain time) ppm*m pathlength 
Timestamp 

(mountain time) 
34.5 10.7 9/21/2006 9:28 218 12.8 9/21/2006 9:56 
37.4 10.7 9/21/2006 9:28 293 12.8 9/21/2006 9:56 
73.1 10.7 9/21/2006 9:28 311 12.8 9/21/2006 9:56 
82 10.7 9/21/2006 9:28 169 12.8 9/21/2006 9:56 

57.4 10.7 9/21/2006 9:28 50.4 12.8 9/21/2006 9:56 
45.4 10.7 9/21/2006 9:28 62.9 12.8 9/21/2006 9:56 
43.6 10.7 9/21/2006 9:28 54.9 12.8 9/21/2006 9:56 
45.9 10.7 9/21/2006 9:28 259 12.8 9/21/2006 9:56 
49.1 10.7 9/21/2006 9:28 89.9 12.8 9/21/2006 9:56 
45.4 10.7 9/21/2006 9:28 63 12.8 9/21/2006 9:56 
57.6 10.7 9/21/2006 9:28 51.1 12.8 9/21/2006 9:56 
75.6 10.7 9/21/2006 9:28 62 12.8 9/21/2006 9:56 
90 10.7 9/21/2006 9:28 126 12.8 9/21/2006 9:56 

63.7 10.7 9/21/2006 9:28 68.1 12.8 9/21/2006 9:56 
67.7 10.7 9/21/2006 9:28 38.2 12.8 9/21/2006 9:56 
69.5 10.7 9/21/2006 9:28 54.4 12.8 9/21/2006 9:56 
77.4 10.7 9/21/2006 9:28 187 12.8 9/21/2006 9:56 
73.1 10.7 9/21/2006 9:28 89.3 12.8 9/21/2006 9:56 
117 10.7 9/21/2006 9:28 63.1 12.8 9/21/2006 9:56 
83.5 10.7 9/21/2006 9:28 96.8 12.8 9/21/2006 9:56 
83.8 10.7 9/21/2006 9:28 100 12.8 9/21/2006 9:56 
89.5 10.7 9/21/2006 9:28 128 12.8 9/21/2006 9:56 
56 10.7 9/21/2006 9:28 40.4 12.8 9/21/2006 9:56 

70.9 10.7 9/21/2006 9:28 41.5 12.8 9/21/2006 9:57 
51.8 10.7 9/21/2006 9:28 35.1 12.8 9/21/2006 9:57 
103 10.7 9/21/2006 9:28 48.5 12.8 9/21/2006 9:57 
161 10.7 9/21/2006 9:28 39.9 12.8 9/21/2006 9:57 
536 10.7 9/21/2006 9:28 53 12.8 9/21/2006 9:57 
728 10.7 9/21/2006 9:28 49.3 12.8 9/21/2006 9:57 

1165 10.7 9/21/2006 9:28 58.2 12.8 9/21/2006 9:57 
95.2 10.7 9/21/2006 9:28 93.9 12.8 9/21/2006 9:57 
134 10.7 9/21/2006 9:28 50.8 12.8 9/21/2006 9:57 
54.8 10.7 9/21/2006 9:28 48.3 12.8 9/21/2006 9:57 
54.9 10.7 9/21/2006 9:28 75 12.8 9/21/2006 9:57 
51.1 10.7 9/21/2006 9:29 83.3 12.8 9/21/2006 9:57 
59.6 10.7 9/21/2006 9:29 58.3 12.8 9/21/2006 9:57 
46 10.7 9/21/2006 9:29 47.4 12.8 9/21/2006 9:57 

43.3 10.7 9/21/2006 9:29 42 12.8 9/21/2006 9:57 
36.5 10.7 9/21/2006 9:29 41.2 12.8 9/21/2006 9:57 
32.2 10.7 9/21/2006 9:29 42.2 12.8 9/21/2006 9:57 
27.3 10.7 9/21/2006 9:29 149 12.8 9/21/2006 9:57 
30.4 10.7 9/21/2006 9:29 599 12.8 9/21/2006 9:57 
33.8 10.7 9/21/2006 9:29 587 12.8 9/21/2006 9:57 
30 10.7 9/21/2006 9:29 1437 12.8 9/21/2006 9:57 

26.6 10.7 9/21/2006 9:29 732 12.8 9/21/2006 9:57 
27.6 10.7 9/21/2006 9:29 70.8 12.8 9/21/2006 9:57 
25.4 10.7 9/21/2006 9:29 143 12.8 9/21/2006 9:57 
30.1 10.7 9/21/2006 9:29 259 12.8 9/21/2006 9:57 
27.9 10.7 9/21/2006 9:29 34.7 12.8 9/21/2006 9:57 
28 10.7 9/21/2006 9:29 38.3 12.8 9/21/2006 9:57 

26.3 10.7 9/21/2006 9:29 72.8 12.8 9/21/2006 9:57 
29.1 10.7 9/21/2006 9:29 86 12.8 9/21/2006 9:57 
29.5 10.7 9/21/2006 9:29 87.1 12.8 9/21/2006 9:57 
28.7 10.7 9/21/2006 9:29 141 12.8 9/21/2006 9:57 
28.8 10.7 9/21/2006 9:29 178 12.8 9/21/2006 9:57 
29.5 10.7 9/21/2006 9:29 107 12.8 9/21/2006 9:57 
31.7 10.7 9/21/2006 9:29 60.6 12.8 9/21/2006 9:57 
29.6 10.7 9/21/2006 9:29 47.3 12.8 9/21/2006 9:58 
35.2 10.7 9/21/2006 9:29 52.3 12.8 9/21/2006 9:58 
37.6 10.7 9/21/2006 9:29 57.5 12.8 9/21/2006 9:58 
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Path Measurement Data 
Site 4 Path 1 

Path Measurement Data 
Site 4 Path 2 

ppm*m pathlength 
Timestamp 

(mountain time) ppm*m pathlength 
Timestamp 

(mountain time) 
40 10.7 9/21/2006 9:29 53.5 12.8 9/21/2006 9:58 

42.2 10.7 9/21/2006 9:29 46.1 12.8 9/21/2006 9:58 
48.5 10.7 9/21/2006 9:29 42 12.8 9/21/2006 9:58 
42.6 10.7 9/21/2006 9:29 40.2 12.8 9/21/2006 9:58 
48.9 10.7 9/21/2006 9:29 45.5 12.8 9/21/2006 9:58 
52.8 10.7 9/21/2006 9:29 45.2 12.8 9/21/2006 9:58 
66.2 10.7 9/21/2006 9:29 45.2 12.8 9/21/2006 9:58 
79.3 10.7 9/21/2006 9:29 44.8 12.8 9/21/2006 9:58 
76.9 10.7 9/21/2006 9:30 38.5 12.8 9/21/2006 9:58 
84.2 10.7 9/21/2006 9:30 36.3 12.8 9/21/2006 9:58 
129 10.7 9/21/2006 9:30 37.4 12.8 9/21/2006 9:58 
181 10.7 9/21/2006 9:30 38.9 12.8 9/21/2006 9:58 
253 10.7 9/21/2006 9:30 44.6 12.8 9/21/2006 9:58 
214 10.7 9/21/2006 9:30 44.3 12.8 9/21/2006 9:58 
213 10.7 9/21/2006 9:30 41.7 12.8 9/21/2006 9:58 
210 10.7 9/21/2006 9:30 40.7 12.8 9/21/2006 9:58 
191 10.7 9/21/2006 9:30 38.1 12.8 9/21/2006 9:58 
196 10.7 9/21/2006 9:30 36.2 12.8 9/21/2006 9:58 
189 10.7 9/21/2006 9:30 30.7 12.8 9/21/2006 9:58 
162 10.7 9/21/2006 9:30 29 12.8 9/21/2006 9:58 
150 10.7 9/21/2006 9:30 29.2 12.8 9/21/2006 9:58 
122 10.7 9/21/2006 9:30 28.1 12.8 9/21/2006 9:58 
129 10.7 9/21/2006 9:30 27.8 12.8 9/21/2006 9:58 
132 10.7 9/21/2006 9:30 29 12.8 9/21/2006 9:58 
172 10.7 9/21/2006 9:30 26.8 12.8 9/21/2006 9:58 
134 10.7 9/21/2006 9:30 24.9 12.8 9/21/2006 9:58 
112 10.7 9/21/2006 9:30 25.5 12.8 9/21/2006 9:58 
99.6 10.7 9/21/2006 9:30 25 12.8 9/21/2006 9:58 
85.6 10.7 9/21/2006 9:30 24.9 12.8 9/21/2006 9:58 
47.7 10.7 9/21/2006 9:30 25.4 12.8 9/21/2006 9:58 
50.2 10.7 9/21/2006 9:30 25.2 12.8 9/21/2006 9:58 
83.6 10.7 9/21/2006 9:30 25.2 12.8 9/21/2006 9:59 
55.4 10.7 9/21/2006 9:30 25.1 12.8 9/21/2006 9:59 
44 10.7 9/21/2006 9:30 25.2 12.8 9/21/2006 9:59 

44.5 10.7 9/21/2006 9:30 25.2 12.8 9/21/2006 9:59 
31.4 10.7 9/21/2006 9:30 25 12.8 9/21/2006 9:59 
32.7 10.7 9/21/2006 9:30 25.3 12.8 9/21/2006 9:59 
39.2 10.7 9/21/2006 9:30 25.1 12.8 9/21/2006 9:59 
45.6 10.7 9/21/2006 9:30 25.1 12.8 9/21/2006 9:59 
36.7 10.7 9/21/2006 9:30 25.4 12.8 9/21/2006 9:59 
26.9 10.7 9/21/2006 9:30 25.4 12.8 9/21/2006 9:59 
35.8 10.7 9/21/2006 9:30 25.1 12.8 9/21/2006 9:59 
34.6 10.7 9/21/2006 9:31 25 12.8 9/21/2006 9:59 
22.9 10.7 9/21/2006 9:31 25.3 12.8 9/21/2006 9:59 
39.5 10.7 9/21/2006 9:31 25.2 12.8 9/21/2006 9:59 
36.3 10.7 9/21/2006 9:31 25.1 12.8 9/21/2006 9:59 
24.4 10.7 9/21/2006 9:31 25 12.8 9/21/2006 9:59 
25.3 10.7 9/21/2006 9:31 25.1 12.8 9/21/2006 9:59 
41 10.7 9/21/2006 9:31 25.2 12.8 9/21/2006 9:59 

45.8 10.7 9/21/2006 9:31 25.2 12.8 9/21/2006 9:59 
32.3 10.7 9/21/2006 9:31 25.2 12.8 9/21/2006 9:59 
33.2 10.7 9/21/2006 9:31 25.1 12.8 9/21/2006 9:59 
37.2 10.7 9/21/2006 9:31 24.9 12.8 9/21/2006 9:59 
24.6 10.7 9/21/2006 9:31 25 12.8 9/21/2006 9:59 
33.7 10.7 9/21/2006 9:31 25 12.8 9/21/2006 9:59 
37.8 10.7 9/21/2006 9:31 25.1 12.8 9/21/2006 9:59 
26.8 10.7 9/21/2006 9:31 25.3 12.8 9/21/2006 9:59 
34.4 10.7 9/21/2006 9:31 25.3 12.8 9/21/2006 9:59 
28.9 10.7 9/21/2006 9:31 25.4 12.8 9/21/2006 9:59 
27.4 10.7 9/21/2006 9:31 25 12.8 9/21/2006 9:59 

229



Path Measurement Data 
Site 4 Path 1 

Path Measurement Data 
Site 4 Path 2 

ppm*m pathlength 
Timestamp 

(mountain time) ppm*m pathlength 
Timestamp 

(mountain time) 
38.8 10.7 9/21/2006 9:31 24.8 12.8 9/21/2006 9:59 
34.9 10.7 9/21/2006 9:31 25.1 12.8 9/21/2006 9:59 
26.5 10.7 9/21/2006 9:31 25 12.8 9/21/2006 9:59 
28.9 10.7 9/21/2006 9:31 25.1 12.8 9/21/2006 9:59 
27.7 10.7 9/21/2006 9:31 25.1 12.8 9/21/2006 9:59 
37.2 10.7 9/21/2006 9:31 24.8 12.8 9/21/2006 10:00 
29.2 10.7 9/21/2006 9:31 24.7 12.8 9/21/2006 10:00 
28.1 10.7 9/21/2006 9:31 24.9 12.8 9/21/2006 10:00 
21.4 10.7 9/21/2006 9:31 24.8 12.8 9/21/2006 10:00 
32.1 10.7 9/21/2006 9:31 24.7 12.8 9/21/2006 10:00 
27.2 10.7 9/21/2006 9:31 24.8 12.8 9/21/2006 10:00 
30.7 10.7 9/21/2006 9:31 24.9 12.8 9/21/2006 10:00 
38.1 10.7 9/21/2006 9:31 24.7 12.8 9/21/2006 10:00 
29.8 10.7 9/21/2006 9:31 24.8 12.8 9/21/2006 10:00 
33.3 10.7 9/21/2006 9:31 24.8 12.8 9/21/2006 10:00 
35.6 10.7 9/21/2006 9:31 25.3 12.8 9/21/2006 10:00 
29.5 10.7 9/21/2006 9:31 24.7 12.8 9/21/2006 10:00 
23.9 10.7 9/21/2006 9:32 25 12.8 9/21/2006 10:00 
26.4 10.7 9/21/2006 9:32 25.1 12.8 9/21/2006 10:00 
33.6 10.7 9/21/2006 9:32 25.8 12.8 9/21/2006 10:00 
28.8 10.7 9/21/2006 9:32 25.1 12.8 9/21/2006 10:00 
35.6 10.7 9/21/2006 9:32 25.3 12.8 9/21/2006 10:00 
27.7 10.7 9/21/2006 9:32 25.7 12.8 9/21/2006 10:00 
23.5 10.7 9/21/2006 9:32 25 12.8 9/21/2006 10:00 
27.8 10.7 9/21/2006 9:32 24.9 12.8 9/21/2006 10:00 
29.8 10.7 9/21/2006 9:32 25 12.8 9/21/2006 10:00 
29.4 10.7 9/21/2006 9:32 25 12.8 9/21/2006 10:00 
29.9 10.7 9/21/2006 9:32 25 12.8 9/21/2006 10:00 
25.8 10.7 9/21/2006 9:32 25 12.8 9/21/2006 10:00 
28.4 10.7 9/21/2006 9:32 25.1 12.8 9/21/2006 10:00 
29.2 10.7 9/21/2006 9:32 24.8 12.8 9/21/2006 10:00 
27.6 10.7 9/21/2006 9:32 24.8 12.8 9/21/2006 10:00 
27.3 10.7 9/21/2006 9:32 24.8 12.8 9/21/2006 10:00 
21.2 10.7 9/21/2006 9:32 24.9 12.8 9/21/2006 10:00 
23.3 10.7 9/21/2006 9:32 24.8 12.8 9/21/2006 10:00 
38.4 10.7 9/21/2006 9:32 24.8 12.8 9/21/2006 10:00 
34.4 10.7 9/21/2006 9:32 25 12.8 9/21/2006 10:00 
24.6 10.7 9/21/2006 9:32 24.9 12.8 9/21/2006 10:00 
28.3 10.7 9/21/2006 9:32 25 12.8 9/21/2006 10:00 
34.3 10.7 9/21/2006 9:32 24.9 12.8 9/21/2006 10:01 
30.6 10.7 9/21/2006 9:32 24.7 12.8 9/21/2006 10:01 
33.8 10.7 9/21/2006 9:32 24.8 12.8 9/21/2006 10:01 
30.3 10.7 9/21/2006 9:32 24.6 12.8 9/21/2006 10:01 
20.9 10.7 9/21/2006 9:32 24.6 12.8 9/21/2006 10:01 
22 10.7 9/21/2006 9:32 24.6 12.8 9/21/2006 10:01 

26.7 10.7 9/21/2006 9:32 24.5 12.8 9/21/2006 10:01 
30.3 10.7 9/21/2006 9:32 25.2 12.8 9/21/2006 10:01 
30.5 10.7 9/21/2006 9:32 24.7 12.8 9/21/2006 10:01 
34.6 10.7 9/21/2006 9:32 24.4 12.8 9/21/2006 10:01 
26 10.7 9/21/2006 9:32 24.3 12.8 9/21/2006 10:01 

28.4 10.7 9/21/2006 9:32 24.5 12.8 9/21/2006 10:01 
41.4 10.7 9/21/2006 9:33 24.7 12.8 9/21/2006 10:01 
35 10.7 9/21/2006 9:33 24.4 12.8 9/21/2006 10:01 

33.9 10.7 9/21/2006 9:33 24.8 12.8 9/21/2006 10:01 
25.6 10.7 9/21/2006 9:33 24.9 12.8 9/21/2006 10:01 
35.2 10.7 9/21/2006 9:33 24.4 12.8 9/21/2006 10:01 
27.7 10.7 9/21/2006 9:33 24.4 12.8 9/21/2006 10:01 
38.1 10.7 9/21/2006 9:33 24.6 12.8 9/21/2006 10:01 
35.6 10.7 9/21/2006 9:33 24.6 12.8 9/21/2006 10:01 
25.4 10.7 9/21/2006 9:33 24.8 12.8 9/21/2006 10:01 
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Path Measurement Data 
Site 4 Path 1 

Path Measurement Data 
Site 4 Path 2 

ppm*m pathlength 
Timestamp 

(mountain time) ppm*m pathlength 
Timestamp 

(mountain time) 
32.1 10.7 9/21/2006 9:33 24.4 12.8 9/21/2006 10:01 
37.3 10.7 9/21/2006 9:33 24.6 12.8 9/21/2006 10:01 
28.1 10.7 9/21/2006 9:33 24.8 12.8 9/21/2006 10:01 
35.3 10.7 9/21/2006 9:33 24.9 12.8 9/21/2006 10:01 
39 10.7 9/21/2006 9:33 24.8 12.8 9/21/2006 10:01 

25.2 10.7 9/21/2006 9:33 24.8 12.8 9/21/2006 10:01 
33.9 10.7 9/21/2006 9:33 24.8 12.8 9/21/2006 10:01 
42.6 10.7 9/21/2006 9:33 24.6 12.8 9/21/2006 10:01 
40.8 10.7 9/21/2006 9:33 24.7 12.8 9/21/2006 10:01 
37.9 10.7 9/21/2006 9:33 24.9 12.8 9/21/2006 10:01 
31.7 10.7 9/21/2006 9:33 25.3 12.8 9/21/2006 10:01 
21 10.7 9/21/2006 9:33 25.7 12.8 9/21/2006 10:01 

37.2 10.7 9/21/2006 9:33 25 12.8 9/21/2006 10:01 
21.2 10.7 9/21/2006 9:33 24.6 12.8 9/21/2006 10:02 
21.3 10.7 9/21/2006 9:33 24.5 12.8 9/21/2006 10:02 
23.7 10.7 9/21/2006 9:33 25.1 12.8 9/21/2006 10:02 
36 10.7 9/21/2006 9:33 24.8 12.8 9/21/2006 10:02 

54.3 10.7 9/21/2006 9:33 25 12.8 9/21/2006 10:02 
38.6 10.7 9/21/2006 9:33 25.1 12.8 9/21/2006 10:02 
57.8 10.7 9/21/2006 9:33 24.5 12.8 9/21/2006 10:02 
43.3 10.7 9/21/2006 9:33 25.1 12.8 9/21/2006 10:02 
29.5 10.7 9/21/2006 9:33 24.7 12.8 9/21/2006 10:02 
25.4 10.7 9/21/2006 9:33 24.7 12.8 9/21/2006 10:02 
23.2 10.7 9/21/2006 9:33 24.6 12.8 9/21/2006 10:02 
25.1 10.7 9/21/2006 9:33 24.6 12.8 9/21/2006 10:02 
31.5 10.7 9/21/2006 9:34 24.7 12.8 9/21/2006 10:02 
32 10.7 9/21/2006 9:34 24.5 12.8 9/21/2006 10:02 

34.6 10.7 9/21/2006 9:34 24.6 12.8 9/21/2006 10:02 
24.8 10.7 9/21/2006 9:34 24.7 12.8 9/21/2006 10:02 
23.3 10.7 9/21/2006 9:34 25.2 12.8 9/21/2006 10:02 
26.1 10.7 9/21/2006 9:34 24.5 12.8 9/21/2006 10:02 
23 10.7 9/21/2006 9:34 24.9 12.8 9/21/2006 10:02 

22.2 10.7 9/21/2006 9:34 24.3 12.8 9/21/2006 10:02 
21.6 10.7 9/21/2006 9:34 24.3 12.8 9/21/2006 10:02 
21.4 10.7 9/21/2006 9:34 24.4 12.8 9/21/2006 10:02 
21.2 10.7 9/21/2006 9:34 24.2 12.8 9/21/2006 10:02 
21.4 10.7 9/21/2006 9:34 24.8 12.8 9/21/2006 10:02 
22.6 10.7 9/21/2006 9:34 24.8 12.8 9/21/2006 10:02 
24.1 10.7 9/21/2006 9:34 24.5 12.8 9/21/2006 10:02 
28.6 10.7 9/21/2006 9:34 24.5 12.8 9/21/2006 10:02 
710 10.7 9/21/2006 9:34 24.5 12.8 9/21/2006 10:02 
24.2 10.7 9/21/2006 9:34 24.4 12.8 9/21/2006 10:02 
22.3 10.7 9/21/2006 9:34 24.4 12.8 9/21/2006 10:02 
21.9 10.7 9/21/2006 9:34 24.4 12.8 9/21/2006 10:02 
23.7 10.7 9/21/2006 9:34 24.3 12.8 9/21/2006 10:02 
28.1 10.7 9/21/2006 9:34 24.4 12.8 9/21/2006 10:02 
47.1 10.7 9/21/2006 9:34 24.4 12.8 9/21/2006 10:02 
39.8 10.7 9/21/2006 9:34 24.5 12.8 9/21/2006 10:02 
39.3 10.7 9/21/2006 9:34 24.4 12.8 9/21/2006 10:03 
40 10.7 9/21/2006 9:34 24.7 12.8 9/21/2006 10:03 

113 10.7 9/21/2006 9:34 24.9 12.8 9/21/2006 10:03 
424 10.7 9/21/2006 9:34 24.7 12.8 9/21/2006 10:03 

1081 10.7 9/21/2006 9:34 24.6 12.8 9/21/2006 10:03 
1067 10.7 9/21/2006 9:34 24.5 12.8 9/21/2006 10:03 
2319 10.7 9/21/2006 9:34 24.8 12.8 9/21/2006 10:03 
1581 10.7 9/21/2006 9:34 24.5 12.8 9/21/2006 10:03 
1097 10.7 9/21/2006 9:34 24.7 12.8 9/21/2006 10:03 
734 10.7 9/21/2006 9:34 24.5 12.8 9/21/2006 10:03 
213 10.7 9/21/2006 9:34 24.3 12.8 9/21/2006 10:03 
98.9 10.7 9/21/2006 9:35 24.2 12.8 9/21/2006 10:03 
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Path Measurement Data 
Site 4 Path 1 

Path Measurement Data 
Site 4 Path 2 

ppm*m pathlength 
Timestamp 

(mountain time) ppm*m pathlength 
Timestamp 

(mountain time) 
79.2 10.7 9/21/2006 9:35 24.1 12.8 9/21/2006 10:03 
919 10.7 9/21/2006 9:35 24.2 12.8 9/21/2006 10:03 
900 10.7 9/21/2006 9:35 24.1 12.8 9/21/2006 10:03 
173 10.7 9/21/2006 9:35 23.9 12.8 9/21/2006 10:03 
56.8 10.7 9/21/2006 9:35 24.1 12.8 9/21/2006 10:03 
45.2 10.7 9/21/2006 9:35 24.2 12.8 9/21/2006 10:03 
44.7 10.7 9/21/2006 9:35 24.1 12.8 9/21/2006 10:03 
46.8 10.7 9/21/2006 9:35 24.1 12.8 9/21/2006 10:03 
43.6 10.7 9/21/2006 9:35 23.9 12.8 9/21/2006 10:03 
51.8 10.7 9/21/2006 9:35 23.9 12.8 9/21/2006 10:03 
22.5 10.7 9/21/2006 9:35 23.9 12.8 9/21/2006 10:03 
28.5 10.7 9/21/2006 9:35 24.1 12.8 9/21/2006 10:03 
32 10.7 9/21/2006 9:35 24.1 12.8 9/21/2006 10:03 

25.2 10.7 9/21/2006 9:35 23.9 12.8 9/21/2006 10:03 
24.3 10.7 9/21/2006 9:35 23.7 12.8 9/21/2006 10:03 
26 10.7 9/21/2006 9:35 24 12.8 9/21/2006 10:03 

22.4 10.7 9/21/2006 9:35 24 12.8 9/21/2006 10:03 
25.1 10.7 9/21/2006 9:35 24.1 12.8 9/21/2006 10:03 
34.2 10.7 9/21/2006 9:35 24 12.8 9/21/2006 10:03 
27.7 10.7 9/21/2006 9:35 24 12.8 9/21/2006 10:03 
26.4 10.7 9/21/2006 9:35 23.9 12.8 9/21/2006 10:03 
27.5 10.7 9/21/2006 9:35 24 12.8 9/21/2006 10:03 
25.4 10.7 9/21/2006 9:35 24 12.8 9/21/2006 10:04 
27.3 10.7 9/21/2006 9:35 24.1 12.8 9/21/2006 10:04 
34.2 10.7 9/21/2006 9:35 23.8 12.8 9/21/2006 10:04 
25.3 10.7 9/21/2006 9:35 23.9 12.8 9/21/2006 10:04 
30.6 10.7 9/21/2006 9:35 24 12.8 9/21/2006 10:04 
27.7 10.7 9/21/2006 9:35 24.1 12.8 9/21/2006 10:04 
25.6 10.7 9/21/2006 9:35 24.1 12.8 9/21/2006 10:04 
31.7 10.7 9/21/2006 9:35 24 12.8 9/21/2006 10:04 
29.2 10.7 9/21/2006 9:35 24.1 12.8 9/21/2006 10:04 
22.3 10.7 9/21/2006 9:35 24.2 12.8 9/21/2006 10:04 
29.5 10.7 9/21/2006 9:35 24.1 12.8 9/21/2006 10:04 
39.6 10.7 9/21/2006 9:36 24.2 12.8 9/21/2006 10:04 
33.9 10.7 9/21/2006 9:36 24.2 12.8 9/21/2006 10:04 
37.7 10.7 9/21/2006 9:36 24 12.8 9/21/2006 10:04 
26.8 10.7 9/21/2006 9:36 24.4 12.8 9/21/2006 10:04 
28.2 10.7 9/21/2006 9:36 24.4 12.8 9/21/2006 10:04 
24.5 10.7 9/21/2006 9:36 24.4 12.8 9/21/2006 10:04 
25.4 10.7 9/21/2006 9:36 24.5 12.8 9/21/2006 10:04 
24.1 10.7 9/21/2006 9:36 24.3 12.8 9/21/2006 10:04 
28.8 10.7 9/21/2006 9:36 24.4 12.8 9/21/2006 10:04 
25.6 10.7 9/21/2006 9:36 24.4 12.8 9/21/2006 10:04 
28.9 10.7 9/21/2006 9:36 24.4 12.8 9/21/2006 10:04 
27 10.7 9/21/2006 9:36 24.5 12.8 9/21/2006 10:04 

32.2 10.7 9/21/2006 9:36 24.7 12.8 9/21/2006 10:04 
42.7 10.7 9/21/2006 9:36 24.8 12.8 9/21/2006 10:04 
30.7 10.7 9/21/2006 9:36 24.5 12.8 9/21/2006 10:04 
23.9 10.7 9/21/2006 9:36 24.3 12.8 9/21/2006 10:04 
24.9 10.7 9/21/2006 9:36 24.3 12.8 9/21/2006 10:04 
30.9 10.7 9/21/2006 9:36 24 12.8 9/21/2006 10:04 
32.3 10.7 9/21/2006 9:36 24.2 12.8 9/21/2006 10:04 
38.3 10.7 9/21/2006 9:36 24.3 12.8 9/21/2006 10:04 
38 10.7 9/21/2006 9:36 24.3 12.8 9/21/2006 10:04 

23.9 10.7 9/21/2006 9:36 24.1 12.8 9/21/2006 10:04 
22.3 10.7 9/21/2006 9:36 24.1 12.8 9/21/2006 10:04 
32.6 10.7 9/21/2006 9:36 24.3 12.8 9/21/2006 10:05 
33.1 10.7 9/21/2006 9:36 24.2 12.8 9/21/2006 10:05 
36.9 10.7 9/21/2006 9:36 24.3 12.8 9/21/2006 10:05 
41.2 10.7 9/21/2006 9:36 24.3 12.8 9/21/2006 10:05 
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Path Measurement Data 
Site 4 Path 1 

Path Measurement Data 
Site 4 Path 2 

ppm*m pathlength 
Timestamp 

(mountain time) ppm*m pathlength 
Timestamp 

(mountain time) 
29.5 10.7 9/21/2006 9:36 24.1 12.8 9/21/2006 10:05 
42.3 10.7 9/21/2006 9:36 24.2 12.8 9/21/2006 10:05 
43.8 10.7 9/21/2006 9:36 24.1 12.8 9/21/2006 10:05 
30.6 10.7 9/21/2006 9:36 24.1 12.8 9/21/2006 10:05 
43.9 10.7 9/21/2006 9:36 24.1 12.8 9/21/2006 10:05 
58 10.7 9/21/2006 9:36 24 12.8 9/21/2006 10:05 
28 10.7 9/21/2006 9:36 24.3 12.8 9/21/2006 10:05 

22.6 10.7 9/21/2006 9:37 24.2 12.8 9/21/2006 10:05 
24.1 10.7 9/21/2006 9:37 24.2 12.8 9/21/2006 10:05 
24.4 10.7 9/21/2006 9:37 24 12.8 9/21/2006 10:05 
33.7 10.7 9/21/2006 9:37 24.1 12.8 9/21/2006 10:05 
34 10.7 9/21/2006 9:37 24.3 12.8 9/21/2006 10:05 

34.8 10.7 9/21/2006 9:37 23.9 12.8 9/21/2006 10:05 
37.1 10.7 9/21/2006 9:37 24.1 12.8 9/21/2006 10:05 
36.9 10.7 9/21/2006 9:37 26.3 12.8 9/21/2006 10:05 
36.3 10.7 9/21/2006 9:37 67.1 12.8 9/21/2006 10:05 
35.3 10.7 9/21/2006 9:37 51.9 12.8 9/21/2006 10:05 
34.8 10.7 9/21/2006 9:37 49.4 12.8 9/21/2006 10:05 
32.6 10.7 9/21/2006 9:37 64.8 12.8 9/21/2006 10:05 
44.6 10.7 9/21/2006 9:37 80.6 12.8 9/21/2006 10:05 
49.2 10.7 9/21/2006 9:37 48.8 12.8 9/21/2006 10:05 
37.6 10.7 9/21/2006 9:37 35.4 12.8 9/21/2006 10:05 
48.6 10.7 9/21/2006 9:37 30.5 12.8 9/21/2006 10:05 
44.4 10.7 9/21/2006 9:37 46.1 12.8 9/21/2006 10:05 
47.4 10.7 9/21/2006 9:37 45.7 12.8 9/21/2006 10:05 
42.1 10.7 9/21/2006 9:37 51.5 12.8 9/21/2006 10:05 
34.6 10.7 9/21/2006 9:37 32.7 12.8 9/21/2006 10:05 
45.9 10.7 9/21/2006 9:37 31 12.8 9/21/2006 10:05 
41.5 10.7 9/21/2006 9:37 31.2 12.8 9/21/2006 10:05 
35 10.7 9/21/2006 9:37 33 12.8 9/21/2006 10:05 

33.2 10.7 9/21/2006 9:37 30.1 12.8 9/21/2006 10:06 
43.3 10.7 9/21/2006 9:37 28.9 12.8 9/21/2006 10:06 
42 10.7 9/21/2006 9:37 28 12.8 9/21/2006 10:06 

36.7 10.7 9/21/2006 9:37 25.7 12.8 9/21/2006 10:06 
33.7 10.7 9/21/2006 9:37 24.8 12.8 9/21/2006 10:06 
37.8 10.7 9/21/2006 9:37 25.1 12.8 9/21/2006 10:06 
52.3 10.7 9/21/2006 9:37 24.7 12.8 9/21/2006 10:06 
45.4 10.7 9/21/2006 9:37 24.3 12.8 9/21/2006 10:06 
50.3 10.7 9/21/2006 9:37 25.3 12.8 9/21/2006 10:06 
36.2 10.7 9/21/2006 9:37 24.2 12.8 9/21/2006 10:06 
44.1 10.7 9/21/2006 9:37 23.8 12.8 9/21/2006 10:06 
40.7 10.7 9/21/2006 9:38 23.7 12.8 9/21/2006 10:06 
54.2 10.7 9/21/2006 9:38 23.8 12.8 9/21/2006 10:06 
74.6 10.7 9/21/2006 9:38 24 12.8 9/21/2006 10:06 
70 10.7 9/21/2006 9:38 24 12.8 9/21/2006 10:06 

36.6 10.7 9/21/2006 9:38 23.8 12.8 9/21/2006 10:06 
30.4 10.7 9/21/2006 9:38 24 12.8 9/21/2006 10:06 
57.2 10.7 9/21/2006 9:38 23.8 12.8 9/21/2006 10:06 
41.3 10.7 9/21/2006 9:38 23.9 12.8 9/21/2006 10:06 
43.7 10.7 9/21/2006 9:38 24.1 12.8 9/21/2006 10:06 
35.4 10.7 9/21/2006 9:38 24.1 12.8 9/21/2006 10:06 
44.9 10.7 9/21/2006 9:38 24 12.8 9/21/2006 10:06 
29.1 10.7 9/21/2006 9:38 23.9 12.8 9/21/2006 10:06 
45.3 10.7 9/21/2006 9:38 24.3 12.8 9/21/2006 10:06 
43.4 10.7 9/21/2006 9:38 24.2 12.8 9/21/2006 10:06 
35.7 10.7 9/21/2006 9:38 24.1 12.8 9/21/2006 10:06 
23.6 10.7 9/21/2006 9:38 24.2 12.8 9/21/2006 10:06 
33.3 10.7 9/21/2006 9:38 30.6 12.8 9/21/2006 10:06 
24.9 10.7 9/21/2006 9:38 31.1 12.8 9/21/2006 10:06 
25.4 10.7 9/21/2006 9:38 26.7 12.8 9/21/2006 10:06 
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Path Measurement Data 
Site 4 Path 1 

Path Measurement Data 
Site 4 Path 2 

ppm*m pathlength 
Timestamp 

(mountain time) ppm*m pathlength 
Timestamp 

(mountain time) 
24.9 10.7 9/21/2006 9:38 29.8 12.8 9/21/2006 10:06 
49.6 10.7 9/21/2006 9:38 82.2 12.8 9/21/2006 10:06 
30.8 10.7 9/21/2006 9:38 170 12.8 9/21/2006 10:06 
27.9 10.7 9/21/2006 9:38 184 12.8 9/21/2006 10:06 
24.8 10.7 9/21/2006 9:38 736 12.8 9/21/2006 10:07 
24.2 10.7 9/21/2006 9:38 1134 12.8 9/21/2006 10:07 
24.3 10.7 9/21/2006 9:38 665 12.8 9/21/2006 10:07 
27.5 10.7 9/21/2006 9:38 1269 12.8 9/21/2006 10:07 
26.8 10.7 9/21/2006 9:38 717 12.8 9/21/2006 10:07 
24.1 10.7 9/21/2006 9:38 692 12.8 9/21/2006 10:07 
24 10.7 9/21/2006 9:38 388 12.8 9/21/2006 10:07 

24.7 10.7 9/21/2006 9:38 620 12.8 9/21/2006 10:07 
26.4 10.7 9/21/2006 9:38 678 12.8 9/21/2006 10:07 
28.7 10.7 9/21/2006 9:38 431 12.8 9/21/2006 10:07 
52.2 10.7 9/21/2006 9:38 576 12.8 9/21/2006 10:07 
46 10.7 9/21/2006 9:38 561 12.8 9/21/2006 10:07 

32.3 10.7 9/21/2006 9:39 281 12.8 9/21/2006 10:07 
37.3 10.7 9/21/2006 9:39 217 12.8 9/21/2006 10:07 
31 10.7 9/21/2006 9:39 107 12.8 9/21/2006 10:07 

22.1 10.7 9/21/2006 9:39 65.9 12.8 9/21/2006 10:07 
24.4 10.7 9/21/2006 9:39 78.2 12.8 9/21/2006 10:07 
27.1 10.7 9/21/2006 9:39 88.3 12.8 9/21/2006 10:07 
54.7 10.7 9/21/2006 9:39 63 12.8 9/21/2006 10:07 
32 10.7 9/21/2006 9:39 41.8 12.8 9/21/2006 10:07 

62.1 10.7 9/21/2006 9:39 51.3 12.8 9/21/2006 10:07 
37.7 10.7 9/21/2006 9:39 53.5 12.8 9/21/2006 10:07 
35.9 10.7 9/21/2006 9:39 44.2 12.8 9/21/2006 10:07 
32.4 10.7 9/21/2006 9:39 41.7 12.8 9/21/2006 10:07 
29.1 10.7 9/21/2006 9:39 39.7 12.8 9/21/2006 10:07 
21.5 10.7 9/21/2006 9:39 31.8 12.8 9/21/2006 10:07 
27.1 10.7 9/21/2006 9:39 28.1 12.8 9/21/2006 10:07 
21.1 10.7 9/21/2006 9:39 28.9 12.8 9/21/2006 10:07 
23.3 10.7 9/21/2006 9:39 30.2 12.8 9/21/2006 10:07 
29.9 10.7 9/21/2006 9:39 36.5 12.8 9/21/2006 10:07 
21.3 10.7 9/21/2006 9:39 40.4 12.8 9/21/2006 10:07 
21.3 10.7 9/21/2006 9:39 39.1 12.8 9/21/2006 10:07 
36.7 10.7 9/21/2006 9:39 39.2 12.8 9/21/2006 10:07 
33.2 10.7 9/21/2006 9:39 35.4 12.8 9/21/2006 10:07 
27.4 10.7 9/21/2006 9:39 35.5 12.8 9/21/2006 10:08 
22.2 10.7 9/21/2006 9:39 36.3 12.8 9/21/2006 10:08 
37.5 10.7 9/21/2006 9:39 47 12.8 9/21/2006 10:08 
28.4 10.7 9/21/2006 9:39 61.1 12.8 9/21/2006 10:08 
24.8 10.7 9/21/2006 9:39 56 12.8 9/21/2006 10:08 
26 10.7 9/21/2006 9:39 48.4 12.8 9/21/2006 10:08 

35.3 10.7 9/21/2006 9:39 107 12.8 9/21/2006 10:08 
26.2 10.7 9/21/2006 9:39 463 12.8 9/21/2006 10:08 
29.2 10.7 9/21/2006 9:39 480 12.8 9/21/2006 10:08 
25.2 10.7 9/21/2006 9:39 349 12.8 9/21/2006 10:08 
28.4 10.7 9/21/2006 9:39 191 12.8 9/21/2006 10:08 
25.7 10.7 9/21/2006 9:39 187 12.8 9/21/2006 10:08 
23.4 10.7 9/21/2006 9:40 148 12.8 9/21/2006 10:08 
40.6 10.7 9/21/2006 9:40 121 12.8 9/21/2006 10:08 
24.5 10.7 9/21/2006 9:40 78.2 12.8 9/21/2006 10:08 
31.3 10.7 9/21/2006 9:40 63.4 12.8 9/21/2006 10:08 
24.9 10.7 9/21/2006 9:40 59.2 12.8 9/21/2006 10:08 
21.8 10.7 9/21/2006 9:40 75 12.8 9/21/2006 10:08 
22.2 10.7 9/21/2006 9:40 138 12.8 9/21/2006 10:08 
22.5 10.7 9/21/2006 9:40 1488 12.8 9/21/2006 10:08 
31 10.7 9/21/2006 9:40 1156 12.8 9/21/2006 10:08 

33.1 10.7 9/21/2006 9:40 757 12.8 9/21/2006 10:08 
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Path Measurement Data 
Site 4 Path 1 

Path Measurement Data 
Site 4 Path 2 

ppm*m pathlength 
Timestamp 

(mountain time) ppm*m pathlength 
Timestamp 

(mountain time) 
36.8 10.7 9/21/2006 9:40 800 12.8 9/21/2006 10:08 
27.8 10.7 9/21/2006 9:40 346 12.8 9/21/2006 10:08 
23.6 10.7 9/21/2006 9:40 324 12.8 9/21/2006 10:08 
24 10.7 9/21/2006 9:40 335 12.8 9/21/2006 10:08 

35.8 10.7 9/21/2006 9:40 495 12.8 9/21/2006 10:08 
30 10.7 9/21/2006 9:40 224 12.8 9/21/2006 10:08 

27.7 10.7 9/21/2006 9:40 190 12.8 9/21/2006 10:08 
39.2 10.7 9/21/2006 9:40 216 12.8 9/21/2006 10:08 
34.7 10.7 9/21/2006 9:40 276 12.8 9/21/2006 10:08 
29.5 10.7 9/21/2006 9:40 885 12.8 9/21/2006 10:08 
30.5 10.7 9/21/2006 9:40 496 12.8 9/21/2006 10:08 
30.7 10.7 9/21/2006 9:40 626 12.8 9/21/2006 10:08 
30.6 10.7 9/21/2006 9:40 415 12.8 9/21/2006 10:09 
33.3 10.7 9/21/2006 9:40 956 12.8 9/21/2006 10:09 
30.3 10.7 9/21/2006 9:40 1019 12.8 9/21/2006 10:09 
46.9 10.7 9/21/2006 9:40 901 12.8 9/21/2006 10:09 
41.4 10.7 9/21/2006 9:40 850 12.8 9/21/2006 10:09 
37.6 10.7 9/21/2006 9:40 494 12.8 9/21/2006 10:09 
30.6 10.7 9/21/2006 9:40 1801 12.8 9/21/2006 10:09 
35.6 10.7 9/21/2006 9:40 1579 12.8 9/21/2006 10:09 
35.9 10.7 9/21/2006 9:40 1175 12.8 9/21/2006 10:09 
33.9 10.7 9/21/2006 9:40 991 12.8 9/21/2006 10:09 
36.6 10.7 9/21/2006 9:41 801 12.8 9/21/2006 10:09 
38.5 10.7 9/21/2006 9:41 634 12.8 9/21/2006 10:09 
43.6 10.7 9/21/2006 9:41 558 12.8 9/21/2006 10:09 
43.2 10.7 9/21/2006 9:41 490 12.8 9/21/2006 10:09 
36.4 10.7 9/21/2006 9:41 411 12.8 9/21/2006 10:09 
35.7 10.7 9/21/2006 9:41 327 12.8 9/21/2006 10:09 
38.4 10.7 9/21/2006 9:41 331 12.8 9/21/2006 10:09 
72.8 10.7 9/21/2006 9:41 376 12.8 9/21/2006 10:09 
31.9 10.7 9/21/2006 9:41 295 12.8 9/21/2006 10:09 
24.9 10.7 9/21/2006 9:41 327 12.8 9/21/2006 10:09 
25 10.7 9/21/2006 9:41 377 12.8 9/21/2006 10:09 

45.5 10.7 9/21/2006 9:41 361 12.8 9/21/2006 10:09 
23.8 10.7 9/21/2006 9:41 382 12.8 9/21/2006 10:09 
36.7 10.7 9/21/2006 9:41 313 12.8 9/21/2006 10:09 
26.3 10.7 9/21/2006 9:41 253 12.8 9/21/2006 10:09 
34.9 10.7 9/21/2006 9:41 279 12.8 9/21/2006 10:09 
32.2 10.7 9/21/2006 9:41 312 12.8 9/21/2006 10:09 
51.5 10.7 9/21/2006 9:41 243 12.8 9/21/2006 10:09 
24.4 10.7 9/21/2006 9:41 122 12.8 9/21/2006 10:09 
36.5 10.7 9/21/2006 9:41 91.2 12.8 9/21/2006 10:09 
25.8 10.7 9/21/2006 9:41 83.1 12.8 9/21/2006 10:09 
30.4 10.7 9/21/2006 9:41 51.3 12.8 9/21/2006 10:09 
35 10.7 9/21/2006 9:41 33.3 12.8 9/21/2006 10:10 

33.4 10.7 9/21/2006 9:41 42.8 12.8 9/21/2006 10:10 
32.6 10.7 9/21/2006 9:41 39.1 12.8 9/21/2006 10:10 
33.4 10.7 9/21/2006 9:41 115 12.8 9/21/2006 10:10 
55.4 10.7 9/21/2006 9:41 158 12.8 9/21/2006 10:10 
41.8 10.7 9/21/2006 9:41 45.4 12.8 9/21/2006 10:10 
40.6 10.7 9/21/2006 9:41 30.1 12.8 9/21/2006 10:10 
35.2 10.7 9/21/2006 9:41 75.6 12.8 9/21/2006 10:10 
50.8 10.7 9/21/2006 9:41 146 12.8 9/21/2006 10:10 
34.2 10.7 9/21/2006 9:41 294 12.8 9/21/2006 10:10 
24.3 10.7 9/21/2006 9:41 640 12.8 9/21/2006 10:10 
22.1 10.7 9/21/2006 9:41 1476 12.8 9/21/2006 10:10 
22 10.7 9/21/2006 9:41 879 12.8 9/21/2006 10:10 

21.7 10.7 9/21/2006 9:42 182 12.8 9/21/2006 10:10 
22 10.7 9/21/2006 9:42 105 12.8 9/21/2006 10:10 

31.1 10.7 9/21/2006 9:42 40.7 12.8 9/21/2006 10:10 
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Path Measurement Data 
Site 4 Path 1 

Path Measurement Data 
Site 4 Path 2 

ppm*m pathlength 
Timestamp 

(mountain time) ppm*m pathlength 
Timestamp 

(mountain time) 
30.9 10.7 9/21/2006 9:42 115 12.8 9/21/2006 10:10 
32.2 10.7 9/21/2006 9:42 1098 12.8 9/21/2006 10:10 
49 10.7 9/21/2006 9:42 122 12.8 9/21/2006 10:10 

45.6 10.7 9/21/2006 9:42 119 12.8 9/21/2006 10:10 
29.2 10.7 9/21/2006 9:42 1097 12.8 9/21/2006 10:10 
25.9 10.7 9/21/2006 9:42 1052 12.8 9/21/2006 10:10 
26.4 10.7 9/21/2006 9:42 426 12.8 9/21/2006 10:10 
27.7 10.7 9/21/2006 9:42 1011 12.8 9/21/2006 10:10 
31.6 10.7 9/21/2006 9:42 156 12.8 9/21/2006 10:10 
26.7 10.7 9/21/2006 9:42 80 12.8 9/21/2006 10:10 
70.4 10.7 9/21/2006 9:42 94.2 12.8 9/21/2006 10:10 
90.9 10.7 9/21/2006 9:42 124 12.8 9/21/2006 10:10 
36.7 10.7 9/21/2006 9:42 114 12.8 9/21/2006 10:10 
32.5 10.7 9/21/2006 9:42 58.3 12.8 9/21/2006 10:10 
23.3 10.7 9/21/2006 9:42 53.4 12.8 9/21/2006 10:10 
21.4 10.7 9/21/2006 9:42 43.2 12.8 9/21/2006 10:10 
37.3 10.7 9/21/2006 9:42 37.1 12.8 9/21/2006 10:10 
32.5 10.7 9/21/2006 9:42 34.6 12.8 9/21/2006 10:11 
26.8 10.7 9/21/2006 9:42 179 12.8 9/21/2006 10:11 
25.4 10.7 9/21/2006 9:42 532 12.8 9/21/2006 10:11 
21.9 10.7 9/21/2006 9:42 468 12.8 9/21/2006 10:11 
25.5 10.7 9/21/2006 9:42 559 12.8 9/21/2006 10:11 
24.7 10.7 9/21/2006 9:42 283 12.8 9/21/2006 10:11 
23.5 10.7 9/21/2006 9:42 232 12.8 9/21/2006 10:11 
21.7 10.7 9/21/2006 9:42 184 12.8 9/21/2006 10:11 
25 10.7 9/21/2006 9:42 190 12.8 9/21/2006 10:11 

31.2 10.7 9/21/2006 9:42 220 12.8 9/21/2006 10:11 
26.1 10.7 9/21/2006 9:42 239 12.8 9/21/2006 10:11 
23.7 10.7 9/21/2006 9:42 272 12.8 9/21/2006 10:11 
23.4 10.7 9/21/2006 9:42 274 12.8 9/21/2006 10:11 
23.9 10.7 9/21/2006 9:42 235 12.8 9/21/2006 10:11 
24 10.7 9/21/2006 9:43 209 12.8 9/21/2006 10:11 

25.8 10.7 9/21/2006 9:43 151 12.8 9/21/2006 10:11 
31.1 10.7 9/21/2006 9:43 142 12.8 9/21/2006 10:11 
29.2 10.7 9/21/2006 9:43 122 12.8 9/21/2006 10:11 
31.8 10.7 9/21/2006 9:43 207 12.8 9/21/2006 10:11 
40.2 10.7 9/21/2006 9:43 75.8 12.8 9/21/2006 10:11 
34.1 10.7 9/21/2006 9:43 49.2 12.8 9/21/2006 10:11 
29.9 10.7 9/21/2006 9:43 52.5 12.8 9/21/2006 10:11 
25.8 10.7 9/21/2006 9:43 51.5 12.8 9/21/2006 10:11 
27.3 10.7 9/21/2006 9:43 64.9 12.8 9/21/2006 10:11 
28.7 10.7 9/21/2006 9:43 70.1 12.8 9/21/2006 10:11 
28.4 10.7 9/21/2006 9:43 71.4 12.8 9/21/2006 10:11 
26.4 10.7 9/21/2006 9:43 43.9 12.8 9/21/2006 10:11 
26.9 10.7 9/21/2006 9:43 63.6 12.8 9/21/2006 10:11 
27.4 10.7 9/21/2006 9:43 49 12.8 9/21/2006 10:11 
25.8 10.7 9/21/2006 9:43 58.4 12.8 9/21/2006 10:11 
26.5 10.7 9/21/2006 9:43 60.8 12.8 9/21/2006 10:11 
26 10.7 9/21/2006 9:43 45.6 12.8 9/21/2006 10:11 

26.5 10.7 9/21/2006 9:43 56.9 12.8 9/21/2006 10:11 
24.7 10.7 9/21/2006 9:43 55.2 12.8 9/21/2006 10:11 
22.2 10.7 9/21/2006 9:43 44.6 12.8 9/21/2006 10:12 
24.1 10.7 9/21/2006 9:43 62.8 12.8 9/21/2006 10:12 
27.4 10.7 9/21/2006 9:43 52.1 12.8 9/21/2006 10:12 
25.4 10.7 9/21/2006 9:43 54.7 12.8 9/21/2006 10:12 
23.5 10.7 9/21/2006 9:43 67.6 12.8 9/21/2006 10:12 
23.7 10.7 9/21/2006 9:43 82.9 12.8 9/21/2006 10:12 
22.7 10.7 9/21/2006 9:43 49.2 12.8 9/21/2006 10:12 
23.4 10.7 9/21/2006 9:43 44.9 12.8 9/21/2006 10:12 
27.5 10.7 9/21/2006 9:43 51.1 12.8 9/21/2006 10:12 
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Path Measurement Data 
Site 4 Path 1 

Path Measurement Data 
Site 4 Path 2 

ppm*m pathlength 
Timestamp 

(mountain time) ppm*m pathlength 
Timestamp 

(mountain time) 
26.7 10.7 9/21/2006 9:43 38.8 12.8 9/21/2006 10:12 
26.7 10.7 9/21/2006 9:43 29.9 12.8 9/21/2006 10:12 
23.2 10.7 9/21/2006 9:43 46.4 12.8 9/21/2006 10:12 
26.3 10.7 9/21/2006 9:43 47 12.8 9/21/2006 10:12 
83.8 10.7 9/21/2006 9:43 42.5 12.8 9/21/2006 10:12 
40 10.7 9/21/2006 9:44 37.8 12.8 9/21/2006 10:12 

118 10.7 9/21/2006 9:44 53 12.8 9/21/2006 10:12 
284 10.7 9/21/2006 9:44 111 12.8 9/21/2006 10:12 
94.8 10.7 9/21/2006 9:44 138 12.8 9/21/2006 10:12 
22.9 10.7 9/21/2006 9:44 104 12.8 9/21/2006 10:12 
21.9 10.7 9/21/2006 9:44 43.8 12.8 9/21/2006 10:12 
25.9 10.7 9/21/2006 9:44 86 12.8 9/21/2006 10:12 
23.9 10.7 9/21/2006 9:44 53.1 12.8 9/21/2006 10:12 
25.8 10.7 9/21/2006 9:44 116 12.8 9/21/2006 10:12 
32.3 10.7 9/21/2006 9:44 51.1 12.8 9/21/2006 10:12 
31.2 10.7 9/21/2006 9:44 49.9 12.8 9/21/2006 10:12 
27.2 10.7 9/21/2006 9:44 101 12.8 9/21/2006 10:12 
27.6 10.7 9/21/2006 9:44 44.2 12.8 9/21/2006 10:12 
24.3 10.7 9/21/2006 9:44 30.8 12.8 9/21/2006 10:12 
27.1 10.7 9/21/2006 9:44 34.2 12.8 9/21/2006 10:12 
25.3 10.7 9/21/2006 9:44 44.5 12.8 9/21/2006 10:12 
23.4 10.7 9/21/2006 9:44 44.1 12.8 9/21/2006 10:12 
24 10.7 9/21/2006 9:44 29.7 12.8 9/21/2006 10:12 

24.3 10.7 9/21/2006 9:44 27.2 12.8 9/21/2006 10:12 
25.6 10.7 9/21/2006 9:44 29.2 12.8 9/21/2006 10:12 
22.2 10.7 9/21/2006 9:44 40.3 12.8 9/21/2006 10:13 
21.9 10.7 9/21/2006 9:44 43.1 12.8 9/21/2006 10:13 
22.4 10.7 9/21/2006 9:44 45.3 12.8 9/21/2006 10:13 
26.8 10.7 9/21/2006 9:44 32.1 12.8 9/21/2006 10:13 
23.4 10.7 9/21/2006 9:44 40.2 12.8 9/21/2006 10:13 
26 10.7 9/21/2006 9:44 45 12.8 9/21/2006 10:13 

24.7 10.7 9/21/2006 9:44 47.2 12.8 9/21/2006 10:13 
22.1 10.7 9/21/2006 9:44 32.6 12.8 9/21/2006 10:13 
26.3 10.7 9/21/2006 9:44 30.5 12.8 9/21/2006 10:13 
27.6 10.7 9/21/2006 9:44 43.3 12.8 9/21/2006 10:13 
27.3 10.7 9/21/2006 9:44 59 12.8 9/21/2006 10:13 
25.2 10.7 9/21/2006 9:44 43 12.8 9/21/2006 10:13 
27.6 10.7 9/21/2006 9:44 28.2 12.8 9/21/2006 10:13 
23.6 10.7 9/21/2006 9:44 24.7 12.8 9/21/2006 10:13 
23.8 10.7 9/21/2006 9:45 29.3 12.8 9/21/2006 10:13 
23.8 10.7 9/21/2006 9:45 29.3 12.8 9/21/2006 10:13 
139 10.7 9/21/2006 9:45 27.1 12.8 9/21/2006 10:13 
515 10.7 9/21/2006 9:45 24.5 12.8 9/21/2006 10:13 
330 10.7 9/21/2006 9:45 36.5 12.8 9/21/2006 10:13 
230 10.7 9/21/2006 9:45 33 12.8 9/21/2006 10:13 
38.8 10.7 9/21/2006 9:45 29.7 12.8 9/21/2006 10:13 
38.8 10.7 9/21/2006 9:45 29.5 12.8 9/21/2006 10:13 
656 10.7 9/21/2006 9:45 37 12.8 9/21/2006 10:13 

1921 10.7 9/21/2006 9:45 39.3 12.8 9/21/2006 10:13 
2284 10.7 9/21/2006 9:45 33 12.8 9/21/2006 10:13 
1180 10.7 9/21/2006 9:45 26.6 12.8 9/21/2006 10:13 
1511 10.7 9/21/2006 9:45 24.4 12.8 9/21/2006 10:13 
1648 10.7 9/21/2006 9:45 24.4 12.8 9/21/2006 10:13 
2413 10.7 9/21/2006 9:45 24.6 12.8 9/21/2006 10:13 
1595 10.7 9/21/2006 9:45 25.9 12.8 9/21/2006 10:13 
1860 10.7 9/21/2006 9:45 37.4 12.8 9/21/2006 10:13 
92.8 10.7 9/21/2006 9:45 42.6 12.8 9/21/2006 10:13 
39.7 10.7 9/21/2006 9:45 39.7 12.8 9/21/2006 10:13 
37.9 10.7 9/21/2006 9:45 31.6 12.8 9/21/2006 10:13 
32.7 10.7 9/21/2006 9:45 27.3 12.8 9/21/2006 10:14 
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Path Measurement Data 
Site 4 Path 1 

Path Measurement Data 
Site 4 Path 2 

ppm*m pathlength 
Timestamp 

(mountain time) ppm*m pathlength 
Timestamp 

(mountain time) 
57.1 10.7 9/21/2006 9:45 27.9 12.8 9/21/2006 10:14 
1038 10.7 9/21/2006 9:45 29 12.8 9/21/2006 10:14 
300 10.7 9/21/2006 9:45 43.5 12.8 9/21/2006 10:14 
39.9 10.7 9/21/2006 9:45 29 12.8 9/21/2006 10:14 
35.7 10.7 9/21/2006 9:45 24.8 12.8 9/21/2006 10:14 
252 10.7 9/21/2006 9:45 24.5 12.8 9/21/2006 10:14 
387 10.7 9/21/2006 9:45 24.8 12.8 9/21/2006 10:14 
338 10.7 9/21/2006 9:45 29.2 12.8 9/21/2006 10:14 
183 10.7 9/21/2006 9:45 41.1 12.8 9/21/2006 10:14 
215 10.7 9/21/2006 9:45 60.3 12.8 9/21/2006 10:14 
176 10.7 9/21/2006 9:45 36 12.8 9/21/2006 10:14 
130 10.7 9/21/2006 9:45 51.2 12.8 9/21/2006 10:14 
134 10.7 9/21/2006 9:46 62.2 12.8 9/21/2006 10:14 
86.1 10.7 9/21/2006 9:46 43.2 12.8 9/21/2006 10:14 
46.6 10.7 9/21/2006 9:46 94.3 12.8 9/21/2006 10:14 
24.1 10.7 9/21/2006 9:46 89.9 12.8 9/21/2006 10:14 
22.2 10.7 9/21/2006 9:46 102 12.8 9/21/2006 10:14 
32.6 10.7 9/21/2006 9:46 181 12.8 9/21/2006 10:14 
21.6 10.7 9/21/2006 9:46 123 12.8 9/21/2006 10:14 
21.9 10.7 9/21/2006 9:46 113 12.8 9/21/2006 10:14 
22.6 10.7 9/21/2006 9:46 146 12.8 9/21/2006 10:14 
21.8 10.7 9/21/2006 9:46 116 12.8 9/21/2006 10:14 
22.6 10.7 9/21/2006 9:46 87 12.8 9/21/2006 10:14 
36.8 10.7 9/21/2006 9:46 85.9 12.8 9/21/2006 10:14 
29.6 10.7 9/21/2006 9:46 83 12.8 9/21/2006 10:14 
45.6 10.7 9/21/2006 9:46 79 12.8 9/21/2006 10:14 
34.6 10.7 9/21/2006 9:46 77.6 12.8 9/21/2006 10:14 
32.9 10.7 9/21/2006 9:46 67.7 12.8 9/21/2006 10:14 
30.4 10.7 9/21/2006 9:46 66 12.8 9/21/2006 10:14 
27.7 10.7 9/21/2006 9:46 64.3 12.8 9/21/2006 10:14 
23.7 10.7 9/21/2006 9:46 112 12.8 9/21/2006 10:14 
25.6 10.7 9/21/2006 9:46 77.3 12.8 9/21/2006 10:14 
23.6 10.7 9/21/2006 9:46 45.9 12.8 9/21/2006 10:14 
24 10.7 9/21/2006 9:46 54.8 12.8 9/21/2006 10:15 

22.5 10.7 9/21/2006 9:46 32.9 12.8 9/21/2006 10:15 
22.7 10.7 9/21/2006 9:46 38.5 12.8 9/21/2006 10:15 
22.9 10.7 9/21/2006 9:46 37.7 12.8 9/21/2006 10:15 
22.6 10.7 9/21/2006 9:46 39.3 12.8 9/21/2006 10:15 
22.2 10.7 9/21/2006 9:46 41 12.8 9/21/2006 10:15 
22.2 10.7 9/21/2006 9:46 132 12.8 9/21/2006 10:15 
22 10.7 9/21/2006 9:46 61.6 12.8 9/21/2006 10:15 

21.8 10.7 9/21/2006 9:46 88.6 12.8 9/21/2006 10:15 
21.7 10.7 9/21/2006 9:46 121 12.8 9/21/2006 10:15 
21.4 10.7 9/21/2006 9:46 605 12.8 9/21/2006 10:15 
21.4 10.7 9/21/2006 9:46 407 12.8 9/21/2006 10:15 
21.6 10.7 9/21/2006 9:46 46.4 12.8 9/21/2006 10:15 
21.5 10.7 9/21/2006 9:47 174 12.8 9/21/2006 10:15 
25.2 10.7 9/21/2006 9:47 137 12.8 9/21/2006 10:15 
33.8 10.7 9/21/2006 9:47 39.1 12.8 9/21/2006 10:15 
29.5 10.7 9/21/2006 9:47 37.3 12.8 9/21/2006 10:15 
35 10.7 9/21/2006 9:47 37 12.8 9/21/2006 10:15 

22.1 10.7 9/21/2006 9:47 37.1 12.8 9/21/2006 10:15 
23.2 10.7 9/21/2006 9:47 31.6 12.8 9/21/2006 10:15 
22.7 10.7 9/21/2006 9:47 41 12.8 9/21/2006 10:15 
21.8 10.7 9/21/2006 9:47 59.7 12.8 9/21/2006 10:15 
22.1 10.7 9/21/2006 9:47 557 12.8 9/21/2006 10:15 
23.3 10.7 9/21/2006 9:47 904 12.8 9/21/2006 10:15 
25.2 10.7 9/21/2006 9:47 220 12.8 9/21/2006 10:15 
23.1 10.7 9/21/2006 9:47 398 12.8 9/21/2006 10:15 
23.4 10.7 9/21/2006 9:47 348 12.8 9/21/2006 10:15 
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Path Measurement Data 
Site 4 Path 1 

Path Measurement Data 
Site 4 Path 2 

ppm*m pathlength 
Timestamp 

(mountain time) ppm*m pathlength 
Timestamp 

(mountain time) 
22.7 10.7 9/21/2006 9:47 318 12.8 9/21/2006 10:15 
22.9 10.7 9/21/2006 9:47 540 12.8 9/21/2006 10:15 
22.2 10.7 9/21/2006 9:47 382 12.8 9/21/2006 10:15 
23.9 10.7 9/21/2006 9:47 310 12.8 9/21/2006 10:15 
23.9 10.7 9/21/2006 9:47 205 12.8 9/21/2006 10:15 
25.8 10.7 9/21/2006 9:47 418 12.8 9/21/2006 10:15 
27.8 10.7 9/21/2006 9:47 361 12.8 9/21/2006 10:15 

   341 12.8 9/21/2006 10:16 
   296 12.8 9/21/2006 10:16 
   328 12.8 9/21/2006 10:16 
   498 12.8 9/21/2006 10:16 
   373 12.8 9/21/2006 10:16 
   265 12.8 9/21/2006 10:16 
   700 12.8 9/21/2006 10:16 
   1624 12.8 9/21/2006 10:16 
   1645 12.8 9/21/2006 10:16 
   870 12.8 9/21/2006 10:16 
   560 12.8 9/21/2006 10:16 
   292 12.8 9/21/2006 10:16 
   2308 12.8 9/21/2006 10:16 
   1030 12.8 9/21/2006 10:16 
   416 12.8 9/21/2006 10:16 
   253 12.8 9/21/2006 10:16 
   77.6 12.8 9/21/2006 10:16 
   26.2 12.8 9/21/2006 10:16 
   27.5 12.8 9/21/2006 10:16 
   30.6 12.8 9/21/2006 10:16 
   34.9 12.8 9/21/2006 10:16 
   967 12.8 9/21/2006 10:16 
   484 12.8 9/21/2006 10:16 
   1108 12.8 9/21/2006 10:16 
   1234 12.8 9/21/2006 10:16 
   990 12.8 9/21/2006 10:16 
   435 12.8 9/21/2006 10:16 
   163 12.8 9/21/2006 10:16 
   78.2 12.8 9/21/2006 10:16 
   41.8 12.8 9/21/2006 10:16 
   43.9 12.8 9/21/2006 10:16 
   65.8 12.8 9/21/2006 10:16 
   407 12.8 9/21/2006 10:16 
   1302 12.8 9/21/2006 10:17 
   1312 12.8 9/21/2006 10:17 
   1365 12.8 9/21/2006 10:17 
   840 12.8 9/21/2006 10:17 
   1196 12.8 9/21/2006 10:17 
   55.9 12.8 9/21/2006 10:17 
   166 12.8 9/21/2006 10:17 
   434 12.8 9/21/2006 10:17 
   68.9 12.8 9/21/2006 10:17 
   44.3 12.8 9/21/2006 10:17 
   44 12.8 9/21/2006 10:17 
   49.3 12.8 9/21/2006 10:17 
   43.1 12.8 9/21/2006 10:17 
   36.9 12.8 9/21/2006 10:17 
   46.8 12.8 9/21/2006 10:17 
   33.5 12.8 9/21/2006 10:17 
   35.8 12.8 9/21/2006 10:17 
   36 12.8 9/21/2006 10:17 
   36.6 12.8 9/21/2006 10:17 
   34.6 12.8 9/21/2006 10:17 
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Path Measurement Data 
Site 4 Path 1 

Path Measurement Data 
Site 4 Path 2 

ppm*m pathlength 
Timestamp 

(mountain time) ppm*m pathlength 
Timestamp 

(mountain time) 
   37.5 12.8 9/21/2006 10:17 
   44.9 12.8 9/21/2006 10:17 
   43.4 12.8 9/21/2006 10:17 
   37.9 12.8 9/21/2006 10:17 
   39.3 12.8 9/21/2006 10:17 
   37.5 12.8 9/21/2006 10:17 
   45.7 12.8 9/21/2006 10:17 
   107 12.8 9/21/2006 10:17 
   280 12.8 9/21/2006 10:17 
   46.6 12.8 9/21/2006 10:17 
   82.6 12.8 9/21/2006 10:17 
   43.9 12.8 9/21/2006 10:17 
   472 12.8 9/21/2006 10:17 
   80.4 12.8 9/21/2006 10:17 
   34 12.8 9/21/2006 10:18 
   27.1 12.8 9/21/2006 10:18 
   95 12.8 9/21/2006 10:18 
   128 12.8 9/21/2006 10:18 
   63.3 12.8 9/21/2006 10:18 
   46.8 12.8 9/21/2006 10:18 
   60.1 12.8 9/21/2006 10:18 
   137 12.8 9/21/2006 10:18 
   110 12.8 9/21/2006 10:18 
   1259 12.8 9/21/2006 10:18 
   98.8 12.8 9/21/2006 10:18 
   33 12.8 9/21/2006 10:18 
   39 12.8 9/21/2006 10:18 
   46.5 12.8 9/21/2006 10:18 
   121 12.8 9/21/2006 10:18 
   359 12.8 9/21/2006 10:18 
   184 12.8 9/21/2006 10:18 
   681 12.8 9/21/2006 10:18 
   1079 12.8 9/21/2006 10:18 
   482 12.8 9/21/2006 10:18 
   648 12.8 9/21/2006 10:18 
   619 12.8 9/21/2006 10:18 
   295 12.8 9/21/2006 10:18 
   1068 12.8 9/21/2006 10:18 
   1517 12.8 9/21/2006 10:18 
   1623 12.8 9/21/2006 10:18 
   1211 12.8 9/21/2006 10:18 
   1308 12.8 9/21/2006 10:18 
   813 12.8 9/21/2006 10:18 
   298 12.8 9/21/2006 10:18 
   221 12.8 9/21/2006 10:18 
   147 12.8 9/21/2006 10:18 
   77.5 12.8 9/21/2006 10:18 
   75.8 12.8 9/21/2006 10:19 
   53.9 12.8 9/21/2006 10:19 
   58.9 12.8 9/21/2006 10:19 
   43.9 12.8 9/21/2006 10:19 
   54.2 12.8 9/21/2006 10:19 
   40.5 12.8 9/21/2006 10:19 
   50.8 12.8 9/21/2006 10:19 
   34.5 12.8 9/21/2006 10:19 
   59.4 12.8 9/21/2006 10:19 
   49 12.8 9/21/2006 10:19 
   59.1 12.8 9/21/2006 10:19 
   46.6 12.8 9/21/2006 10:19 
   40.4 12.8 9/21/2006 10:19 
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Path Measurement Data 
Site 4 Path 1 

Path Measurement Data 
Site 4 Path 2 

ppm*m pathlength 
Timestamp 

(mountain time) ppm*m pathlength 
Timestamp 

(mountain time) 
   35.8 12.8 9/21/2006 10:19 
   66.4 12.8 9/21/2006 10:19 
   1013 12.8 9/21/2006 10:19 
   647 12.8 9/21/2006 10:19 
   1212 12.8 9/21/2006 10:19 
   1543 12.8 9/21/2006 10:19 
   868 12.8 9/21/2006 10:19 
   692 12.8 9/21/2006 10:19 
   93.2 12.8 9/21/2006 10:19 
   47.4 12.8 9/21/2006 10:19 
   33.3 12.8 9/21/2006 10:19 
   28.2 12.8 9/21/2006 10:19 
   25.5 12.8 9/21/2006 10:19 
   27.4 12.8 9/21/2006 10:19 
   58.9 12.8 9/21/2006 10:19 
   38.4 12.8 9/21/2006 10:19 
   38.5 12.8 9/21/2006 10:19 
   46.9 12.8 9/21/2006 10:19 
   46.8 12.8 9/21/2006 10:19 
   45.5 12.8 9/21/2006 10:19 
   40 12.8 9/21/2006 10:20 
   61.8 12.8 9/21/2006 10:20 
   54.9 12.8 9/21/2006 10:20 
   53.4 12.8 9/21/2006 10:20 
   37 12.8 9/21/2006 10:20 
   29.6 12.8 9/21/2006 10:20 
   39.3 12.8 9/21/2006 10:20 
   41.3 12.8 9/21/2006 10:20 
   52.2 12.8 9/21/2006 10:20 
   60 12.8 9/21/2006 10:20 
   60.1 12.8 9/21/2006 10:20 
   37.3 12.8 9/21/2006 10:20 
   30.7 12.8 9/21/2006 10:20 
   32.1 12.8 9/21/2006 10:20 
   73.4 12.8 9/21/2006 10:20 
   47.6 12.8 9/21/2006 10:20 
   25.6 12.8 9/21/2006 10:20 
   40.8 12.8 9/21/2006 10:20 
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Path Measurement Data 
Site 4 Path 3 

Path Measurement Data 
Site 4 Path 4 

ppm*m pathlength 
Timestamp 

(mountain time) ppm*m pathlength 
Timestamp 

(mountain time) 
57.1 18 9/21/2006 10:24 28.2 15 9/21/2006 10:52 
302 18 9/21/2006 10:24 28.2 15 9/21/2006 10:52 
497 18 9/21/2006 10:24 28.1 15 9/21/2006 10:52 
472 18 9/21/2006 10:24 28.1 15 9/21/2006 10:52 

1108 18 9/21/2006 10:24 28.3 15 9/21/2006 10:52 
921 18 9/21/2006 10:24 28.1 15 9/21/2006 10:52 
821 18 9/21/2006 10:24 28 15 9/21/2006 10:52 
719 18 9/21/2006 10:24 28 15 9/21/2006 10:52 
484 18 9/21/2006 10:24 28.2 15 9/21/2006 10:52 
224 18 9/21/2006 10:24 28.2 15 9/21/2006 10:52 
62.6 18 9/21/2006 10:25 28.2 15 9/21/2006 10:52 
39 18 9/21/2006 10:25 28 15 9/21/2006 10:52 

37.4 18 9/21/2006 10:25 28 15 9/21/2006 10:52 
37.5 18 9/21/2006 10:25 28.2 15 9/21/2006 10:52 
37.3 18 9/21/2006 10:25 27.9 15 9/21/2006 10:52 
37.5 18 9/21/2006 10:25 28 15 9/21/2006 10:52 
37.4 18 9/21/2006 10:25 28.2 15 9/21/2006 10:52 
37.3 18 9/21/2006 10:25 27.9 15 9/21/2006 10:53 
37.3 18 9/21/2006 10:25 27.9 15 9/21/2006 10:53 
37.6 18 9/21/2006 10:25 28 15 9/21/2006 10:53 
37.6 18 9/21/2006 10:25 28 15 9/21/2006 10:53 
37.4 18 9/21/2006 10:25 27.9 15 9/21/2006 10:53 
37.4 18 9/21/2006 10:25 28 15 9/21/2006 10:53 
37.3 18 9/21/2006 10:25 28.1 15 9/21/2006 10:53 
37.6 18 9/21/2006 10:25 28 15 9/21/2006 10:53 
37.2 18 9/21/2006 10:25 28 15 9/21/2006 10:53 
37.3 18 9/21/2006 10:25 28 15 9/21/2006 10:53 
37.4 18 9/21/2006 10:25 28 15 9/21/2006 10:53 
37.4 18 9/21/2006 10:25 28 15 9/21/2006 10:53 
37.4 18 9/21/2006 10:25 28 15 9/21/2006 10:53 
37.2 18 9/21/2006 10:25 28 15 9/21/2006 10:53 
37.6 18 9/21/2006 10:25 28 15 9/21/2006 10:53 
37.5 18 9/21/2006 10:25 27.9 15 9/21/2006 10:53 
37.7 18 9/21/2006 10:25 27.9 15 9/21/2006 10:53 
37.4 18 9/21/2006 10:25 27.9 15 9/21/2006 10:53 
37.6 18 9/21/2006 10:25 28.1 15 9/21/2006 10:53 
37.5 18 9/21/2006 10:25 28.2 15 9/21/2006 10:53 
37.5 18 9/21/2006 10:25 28.2 15 9/21/2006 10:53 
37.5 18 9/21/2006 10:25 27.8 15 9/21/2006 10:53 
37.4 18 9/21/2006 10:25 27.9 15 9/21/2006 10:53 
37.4 18 9/21/2006 10:25 28 15 9/21/2006 10:53 
37.4 18 9/21/2006 10:25 27.9 15 9/21/2006 10:53 
37.6 18 9/21/2006 10:25 28.1 15 9/21/2006 10:53 
37.9 18 9/21/2006 10:25 28.1 15 9/21/2006 10:53 
38 18 9/21/2006 10:26 27.9 15 9/21/2006 10:53 

37.8 18 9/21/2006 10:26 28.1 15 9/21/2006 10:53 
38.1 18 9/21/2006 10:26 28.1 15 9/21/2006 10:53 
37.8 18 9/21/2006 10:26 29.8 15 9/21/2006 10:53 
38 18 9/21/2006 10:26 30.3 15 9/21/2006 10:53 

37.5 18 9/21/2006 10:26 30.5 15 9/21/2006 10:53 
38.7 18 9/21/2006 10:26 29.2 15 9/21/2006 10:53 
38.7 18 9/21/2006 10:26 30.4 15 9/21/2006 10:54 
38.4 18 9/21/2006 10:26 31.3 15 9/21/2006 10:54 
38.7 18 9/21/2006 10:26 30 15 9/21/2006 10:54 
38.7 18 9/21/2006 10:26 29.3 15 9/21/2006 10:54 
38.6 18 9/21/2006 10:26 28.7 15 9/21/2006 10:54 
38.6 18 9/21/2006 10:26 28.5 15 9/21/2006 10:54 
38.5 18 9/21/2006 10:26 28.5 15 9/21/2006 10:54 
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Path Measurement Data 
Site 4 Path 3 

Path Measurement Data 
Site 4 Path 4 

ppm*m pathlength 
Timestamp 

(mountain time) ppm*m pathlength 
Timestamp 

(mountain time) 
38.4 18 9/21/2006 10:26 28.7 15 9/21/2006 10:54 
38.5 18 9/21/2006 10:26 28.6 15 9/21/2006 10:54 
38.4 18 9/21/2006 10:26 28.5 15 9/21/2006 10:54 
38.4 18 9/21/2006 10:26 28.6 15 9/21/2006 10:54 
38.6 18 9/21/2006 10:26 28.5 15 9/21/2006 10:54 
38.8 18 9/21/2006 10:26 28.8 15 9/21/2006 10:54 
38.5 18 9/21/2006 10:26 29.5 15 9/21/2006 10:54 
38.6 18 9/21/2006 10:26 29.4 15 9/21/2006 10:54 
38.4 18 9/21/2006 10:26 28.9 15 9/21/2006 10:54 
38.8 18 9/21/2006 10:26 29.3 15 9/21/2006 10:54 
38.7 18 9/21/2006 10:26 28.7 15 9/21/2006 10:54 
38.4 18 9/21/2006 10:26 28.7 15 9/21/2006 10:54 
38.5 18 9/21/2006 10:26 28.8 15 9/21/2006 10:54 
38.7 18 9/21/2006 10:26 28.8 15 9/21/2006 10:54 
38.7 18 9/21/2006 10:26 28.7 15 9/21/2006 10:54 
40.5 18 9/21/2006 10:26 28.6 15 9/21/2006 10:54 
42.5 18 9/21/2006 10:26 28.9 15 9/21/2006 10:54 
45.1 18 9/21/2006 10:26 29.5 15 9/21/2006 10:54 
45.3 18 9/21/2006 10:26 28.9 15 9/21/2006 10:54 
45.7 18 9/21/2006 10:26 28.8 15 9/21/2006 10:54 
47.7 18 9/21/2006 10:27 28.9 15 9/21/2006 10:54 
48.3 18 9/21/2006 10:27 32 15 9/21/2006 10:54 
51.4 18 9/21/2006 10:27 30.2 15 9/21/2006 10:54 
53.4 18 9/21/2006 10:27 29.3 15 9/21/2006 10:54 
54.6 18 9/21/2006 10:27 28.8 15 9/21/2006 10:54 
55.7 18 9/21/2006 10:27 28.8 15 9/21/2006 10:54 
56.9 18 9/21/2006 10:27 28.7 15 9/21/2006 10:54 
62.8 18 9/21/2006 10:27 28.7 15 9/21/2006 10:54 
69.9 18 9/21/2006 10:27 28.5 15 9/21/2006 10:55 
71.3 18 9/21/2006 10:27 28.7 15 9/21/2006 10:55 
66 18 9/21/2006 10:27 28.6 15 9/21/2006 10:55 

66.2 18 9/21/2006 10:27 28.7 15 9/21/2006 10:55 
64.3 18 9/21/2006 10:27 28.6 15 9/21/2006 10:55 
64.4 18 9/21/2006 10:27 28.7 15 9/21/2006 10:55 
62.5 18 9/21/2006 10:27 28.7 15 9/21/2006 10:55 
61.5 18 9/21/2006 10:27 28.7 15 9/21/2006 10:55 
76.9 18 9/21/2006 10:27 28.7 15 9/21/2006 10:55 
91 18 9/21/2006 10:27 28.8 15 9/21/2006 10:55 

91.8 18 9/21/2006 10:27 28.6 15 9/21/2006 10:55 
101 18 9/21/2006 10:27 28.6 15 9/21/2006 10:55 
76.4 18 9/21/2006 10:27 28.6 15 9/21/2006 10:55 
65.4 18 9/21/2006 10:27 28.8 15 9/21/2006 10:55 
60 18 9/21/2006 10:27 28.2 15 9/21/2006 10:55 

61.9 18 9/21/2006 10:27 28.6 15 9/21/2006 10:55 
67.5 18 9/21/2006 10:27 28.3 15 9/21/2006 10:55 
69.1 18 9/21/2006 10:27 28.4 15 9/21/2006 10:55 
62.9 18 9/21/2006 10:27 28.4 15 9/21/2006 10:55 
63.1 18 9/21/2006 10:27 28.6 15 9/21/2006 10:55 
61.3 18 9/21/2006 10:27 28.4 15 9/21/2006 10:55 
57.3 18 9/21/2006 10:27 28.6 15 9/21/2006 10:55 
57.6 18 9/21/2006 10:27 28.5 15 9/21/2006 10:55 
63.3 18 9/21/2006 10:27 28.7 15 9/21/2006 10:55 
64.7 18 9/21/2006 10:27 28.5 15 9/21/2006 10:55 
62.1 18 9/21/2006 10:27 28.5 15 9/21/2006 10:55 
61.3 18 9/21/2006 10:28 28.3 15 9/21/2006 10:55 
57.1 18 9/21/2006 10:28 28.3 15 9/21/2006 10:55 
54.4 18 9/21/2006 10:28 28.5 15 9/21/2006 10:55 
54.9 18 9/21/2006 10:28 28.5 15 9/21/2006 10:55 
57.9 18 9/21/2006 10:28 28.5 15 9/21/2006 10:55 
61 18 9/21/2006 10:28 28.8 15 9/21/2006 10:55 
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Path Measurement Data 
Site 4 Path 3 

Path Measurement Data 
Site 4 Path 4 

ppm*m pathlength 
Timestamp 

(mountain time) ppm*m pathlength 
Timestamp 

(mountain time) 
61.3 18 9/21/2006 10:28 40.9 15 9/21/2006 10:55 
63.7 18 9/21/2006 10:28 133 15 9/21/2006 10:55 
66.1 18 9/21/2006 10:28 37.9 15 9/21/2006 10:56 
68.1 18 9/21/2006 10:28 43.4 15 9/21/2006 10:56 
68.6 18 9/21/2006 10:28 33.5 15 9/21/2006 10:56 
68.5 18 9/21/2006 10:28 32.1 15 9/21/2006 10:56 
70.1 18 9/21/2006 10:28 30.3 15 9/21/2006 10:56 
70.1 18 9/21/2006 10:28 31.1 15 9/21/2006 10:56 
72.7 18 9/21/2006 10:28 31.1 15 9/21/2006 10:56 
77.6 18 9/21/2006 10:28 30.5 15 9/21/2006 10:56 
81.9 18 9/21/2006 10:28 29.8 15 9/21/2006 10:56 
84.2 18 9/21/2006 10:28 77.9 15 9/21/2006 10:56 
84.9 18 9/21/2006 10:28 68.1 15 9/21/2006 10:56 
89.1 18 9/21/2006 10:28 64.2 15 9/21/2006 10:56 
88.4 18 9/21/2006 10:28 55 15 9/21/2006 10:56 
85.5 18 9/21/2006 10:28 29.7 15 9/21/2006 10:56 
85.6 18 9/21/2006 10:28 28.5 15 9/21/2006 10:56 
83.5 18 9/21/2006 10:28 28.4 15 9/21/2006 10:56 
89.2 18 9/21/2006 10:28 28.5 15 9/21/2006 10:56 
96.5 18 9/21/2006 10:28 28.5 15 9/21/2006 10:56 
103 18 9/21/2006 10:28 28.5 15 9/21/2006 10:56 
95.4 18 9/21/2006 10:28 28.4 15 9/21/2006 10:56 
87.8 18 9/21/2006 10:28 28.4 15 9/21/2006 10:56 
78.1 18 9/21/2006 10:28 28.5 15 9/21/2006 10:56 
71.8 18 9/21/2006 10:28 28.5 15 9/21/2006 10:56 
68.8 18 9/21/2006 10:28 28.3 15 9/21/2006 10:56 
66.1 18 9/21/2006 10:28 28.6 15 9/21/2006 10:56 
64.5 18 9/21/2006 10:28 28.4 15 9/21/2006 10:56 
59.7 18 9/21/2006 10:28 28.6 15 9/21/2006 10:56 
67.1 18 9/21/2006 10:29 28.5 15 9/21/2006 10:56 
61.5 18 9/21/2006 10:29 28.5 15 9/21/2006 10:56 
63.6 18 9/21/2006 10:29 28.5 15 9/21/2006 10:56 
137 18 9/21/2006 10:29 28.6 15 9/21/2006 10:56 
184 18 9/21/2006 10:29 29.2 15 9/21/2006 10:56 
225 18 9/21/2006 10:29 63.3 15 9/21/2006 10:56 
156 18 9/21/2006 10:29 762 15 9/21/2006 10:57 
72.1 18 9/21/2006 10:29 1280 15 9/21/2006 10:57 
80.1 18 9/21/2006 10:29 341 15 9/21/2006 10:57 
147 18 9/21/2006 10:29 69.7 15 9/21/2006 10:57 
128 18 9/21/2006 10:29 52.8 15 9/21/2006 10:57 
112 18 9/21/2006 10:29 38.9 15 9/21/2006 10:57 
84.9 18 9/21/2006 10:29 52.6 15 9/21/2006 10:57 
71.1 18 9/21/2006 10:29 44.3 15 9/21/2006 10:57 
44.5 18 9/21/2006 10:29 30.7 15 9/21/2006 10:57 
45.1 18 9/21/2006 10:29 29.4 15 9/21/2006 10:57 
60.2 18 9/21/2006 10:29 30 15 9/21/2006 10:57 
344 18 9/21/2006 10:29 28.7 15 9/21/2006 10:57 
337 18 9/21/2006 10:29 28.7 15 9/21/2006 10:57 
172 18 9/21/2006 10:29 28.5 15 9/21/2006 10:57 
141 18 9/21/2006 10:29 28.6 15 9/21/2006 10:57 
100 18 9/21/2006 10:29 28.5 15 9/21/2006 10:57 
53.1 18 9/21/2006 10:29 28.5 15 9/21/2006 10:57 
107 18 9/21/2006 10:29 28.6 15 9/21/2006 10:57 
152 18 9/21/2006 10:29 28.6 15 9/21/2006 10:57 
77.8 18 9/21/2006 10:29 28.4 15 9/21/2006 10:57 
65.2 18 9/21/2006 10:29 28.6 15 9/21/2006 10:57 
59 18 9/21/2006 10:29 28.6 15 9/21/2006 10:57 

80.5 18 9/21/2006 10:29 28.5 15 9/21/2006 10:57 
55.7 18 9/21/2006 10:29 28.3 15 9/21/2006 10:57 
60.8 18 9/21/2006 10:29 28.5 15 9/21/2006 10:57 
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Path Measurement Data 
Site 4 Path 3 

Path Measurement Data 
Site 4 Path 4 

ppm*m pathlength 
Timestamp 

(mountain time) ppm*m pathlength 
Timestamp 

(mountain time) 
149 18 9/21/2006 10:29 28.4 15 9/21/2006 10:57 
149 18 9/21/2006 10:29 28.4 15 9/21/2006 10:57 
363 18 9/21/2006 10:29 28.4 15 9/21/2006 10:57 
467 18 9/21/2006 10:30 28.4 15 9/21/2006 10:57 
70.4 18 9/21/2006 10:30 28.5 15 9/21/2006 10:57 
58.4 18 9/21/2006 10:30 28.5 15 9/21/2006 10:57 
74.2 18 9/21/2006 10:30 28.7 15 9/21/2006 10:57 
59.1 18 9/21/2006 10:30 28.5 15 9/21/2006 10:57 
73.8 18 9/21/2006 10:30 28.6 15 9/21/2006 10:57 
51.8 18 9/21/2006 10:30 28.6 15 9/21/2006 10:57 
113 18 9/21/2006 10:30 28.6 15 9/21/2006 10:58 
330 18 9/21/2006 10:30 28.6 15 9/21/2006 10:58 
141 18 9/21/2006 10:30 28.6 15 9/21/2006 10:58 
871 18 9/21/2006 10:30 28.6 15 9/21/2006 10:58 
207 18 9/21/2006 10:30 28.6 15 9/21/2006 10:58 
305 18 9/21/2006 10:30 28.5 15 9/21/2006 10:58 
366 18 9/21/2006 10:30 28.5 15 9/21/2006 10:58 
174 18 9/21/2006 10:30 28.5 15 9/21/2006 10:58 
892 18 9/21/2006 10:30 28.5 15 9/21/2006 10:58 

1601 18 9/21/2006 10:30 28.5 15 9/21/2006 10:58 
1274 18 9/21/2006 10:30 28.6 15 9/21/2006 10:58 
847 18 9/21/2006 10:30 28.4 15 9/21/2006 10:58 
465 18 9/21/2006 10:30 28.6 15 9/21/2006 10:58 
138 18 9/21/2006 10:30 28.8 15 9/21/2006 10:58 
481 18 9/21/2006 10:30 28.7 15 9/21/2006 10:58 
114 18 9/21/2006 10:30 28.6 15 9/21/2006 10:58 
195 18 9/21/2006 10:30 28.7 15 9/21/2006 10:58 
226 18 9/21/2006 10:30 28.5 15 9/21/2006 10:58 
108 18 9/21/2006 10:30 28.6 15 9/21/2006 10:58 
198 18 9/21/2006 10:30 28.6 15 9/21/2006 10:58 
475 18 9/21/2006 10:30 28.6 15 9/21/2006 10:58 
593 18 9/21/2006 10:30 28.7 15 9/21/2006 10:58 
429 18 9/21/2006 10:30 28.7 15 9/21/2006 10:58 
714 18 9/21/2006 10:30 28.7 15 9/21/2006 10:58 
882 18 9/21/2006 10:30 28.8 15 9/21/2006 10:58 
792 18 9/21/2006 10:30 28.7 15 9/21/2006 10:58 
553 18 9/21/2006 10:31 28.8 15 9/21/2006 10:58 
310 18 9/21/2006 10:31 28.7 15 9/21/2006 10:58 
270 18 9/21/2006 10:31 28.8 15 9/21/2006 10:58 
443 18 9/21/2006 10:31 28.7 15 9/21/2006 10:58 
530 18 9/21/2006 10:31 28.6 15 9/21/2006 10:58 
309 18 9/21/2006 10:31 28.7 15 9/21/2006 10:58 
243 18 9/21/2006 10:31 28.7 15 9/21/2006 10:58 
163 18 9/21/2006 10:31 28.6 15 9/21/2006 10:58 
112 18 9/21/2006 10:31 28.7 15 9/21/2006 10:59 
102 18 9/21/2006 10:31 28.7 15 9/21/2006 10:59 
101 18 9/21/2006 10:31 28.6 15 9/21/2006 10:59 
120 18 9/21/2006 10:31 28.8 15 9/21/2006 10:59 
217 18 9/21/2006 10:31 28.7 15 9/21/2006 10:59 

2770 18 9/21/2006 10:31 28.6 15 9/21/2006 10:59 
2157 18 9/21/2006 10:31 28.7 15 9/21/2006 10:59 
1547 18 9/21/2006 10:31 28.8 15 9/21/2006 10:59 
1344 18 9/21/2006 10:31 28.4 15 9/21/2006 10:59 
1458 18 9/21/2006 10:31 28.6 15 9/21/2006 10:59 
1158 18 9/21/2006 10:31 28.7 15 9/21/2006 10:59 
738 18 9/21/2006 10:31 28.7 15 9/21/2006 10:59 
608 18 9/21/2006 10:31 28.9 15 9/21/2006 10:59 
655 18 9/21/2006 10:31 28.6 15 9/21/2006 10:59 
569 18 9/21/2006 10:31 28.6 15 9/21/2006 10:59 
440 18 9/21/2006 10:31 28.5 15 9/21/2006 10:59 
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Path Measurement Data 
Site 4 Path 3 

Path Measurement Data 
Site 4 Path 4 

ppm*m pathlength 
Timestamp 

(mountain time) ppm*m pathlength 
Timestamp 

(mountain time) 
246 18 9/21/2006 10:31 28.4 15 9/21/2006 10:59 
75.1 18 9/21/2006 10:31 28.5 15 9/21/2006 10:59 
52.9 18 9/21/2006 10:31 28.6 15 9/21/2006 10:59 
50.9 18 9/21/2006 10:31 28.7 15 9/21/2006 10:59 
48.8 18 9/21/2006 10:31 28.7 15 9/21/2006 10:59 
47.6 18 9/21/2006 10:31 28.5 15 9/21/2006 10:59 
167 18 9/21/2006 10:31 28.6 15 9/21/2006 10:59 
265 18 9/21/2006 10:31 28.7 15 9/21/2006 10:59 

1016 18 9/21/2006 10:31 28.8 15 9/21/2006 10:59 
997 18 9/21/2006 10:31 28.6 15 9/21/2006 10:59 
505 18 9/21/2006 10:32 28.8 15 9/21/2006 10:59 
177 18 9/21/2006 10:32 28.8 15 9/21/2006 10:59 

1343 18 9/21/2006 10:32 28.7 15 9/21/2006 10:59 
1468 18 9/21/2006 10:32 28.6 15 9/21/2006 10:59 
301 18 9/21/2006 10:32 28.5 15 9/21/2006 10:59 
97.5 18 9/21/2006 10:32 28.7 15 9/21/2006 10:59 
56.1 18 9/21/2006 10:32 28.6 15 9/21/2006 10:59 
49 18 9/21/2006 10:32 28.7 15 9/21/2006 10:59 

46.8 18 9/21/2006 10:32 28.7 15 9/21/2006 11:00 
60.2 18 9/21/2006 10:32 28.6 15 9/21/2006 11:00 
329 18 9/21/2006 10:32 28.7 15 9/21/2006 11:00 
472 18 9/21/2006 10:32 28.8 15 9/21/2006 11:00 
356 18 9/21/2006 10:32 28.8 15 9/21/2006 11:00 
231 18 9/21/2006 10:32 28.7 15 9/21/2006 11:00 
151 18 9/21/2006 10:32 28.8 15 9/21/2006 11:00 
108 18 9/21/2006 10:32 28.8 15 9/21/2006 11:00 
102 18 9/21/2006 10:32 28.5 15 9/21/2006 11:00 
153 18 9/21/2006 10:32 28.7 15 9/21/2006 11:00 
308 18 9/21/2006 10:32 28.7 15 9/21/2006 11:00 

1526 18 9/21/2006 10:32 28.8 15 9/21/2006 11:00 
1056 18 9/21/2006 10:32 28.7 15 9/21/2006 11:00 
372 18 9/21/2006 10:32 28.7 15 9/21/2006 11:00 
180 18 9/21/2006 10:32 28.7 15 9/21/2006 11:00 
128 18 9/21/2006 10:32 28.6 15 9/21/2006 11:00 
180 18 9/21/2006 10:32 28.8 15 9/21/2006 11:00 
184 18 9/21/2006 10:32 28.7 15 9/21/2006 11:00 
78.4 18 9/21/2006 10:32 28.6 15 9/21/2006 11:00 
80.3 18 9/21/2006 10:32 28.8 15 9/21/2006 11:00 
71.2 18 9/21/2006 10:32 28.9 15 9/21/2006 11:00 
54.6 18 9/21/2006 10:32 28.7 15 9/21/2006 11:00 
68 18 9/21/2006 10:32 28.8 15 9/21/2006 11:00 

77.2 18 9/21/2006 10:32 28.8 15 9/21/2006 11:00 
87.3 18 9/21/2006 10:32 28.8 15 9/21/2006 11:00 
51.2 18 9/21/2006 10:33 28.8 15 9/21/2006 11:00 
45.1 18 9/21/2006 10:33 28.7 15 9/21/2006 11:00 
43.1 18 9/21/2006 10:33 28.8 15 9/21/2006 11:00 
48.7 18 9/21/2006 10:33 28.7 15 9/21/2006 11:00 
51.1 18 9/21/2006 10:33 28.9 15 9/21/2006 11:00 
47.4 18 9/21/2006 10:33 28.7 15 9/21/2006 11:00 
41.1 18 9/21/2006 10:33 28.8 15 9/21/2006 11:00 
40.5 18 9/21/2006 10:33 28.8 15 9/21/2006 11:00 
40.3 18 9/21/2006 10:33 28.7 15 9/21/2006 11:00 
39 18 9/21/2006 10:33 28.6 15 9/21/2006 11:01 

37.6 18 9/21/2006 10:33 28.7 15 9/21/2006 11:01 
37.6 18 9/21/2006 10:33 28.5 15 9/21/2006 11:01 
37.8 18 9/21/2006 10:33 28.8 15 9/21/2006 11:01 
37.5 18 9/21/2006 10:33 28.7 15 9/21/2006 11:01 
37.5 18 9/21/2006 10:33 28.7 15 9/21/2006 11:01 
37.5 18 9/21/2006 10:33 28.8 15 9/21/2006 11:01 
37.3 18 9/21/2006 10:33 28.9 15 9/21/2006 11:01 
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Path Measurement Data 
Site 4 Path 3 

Path Measurement Data 
Site 4 Path 4 

ppm*m pathlength 
Timestamp 

(mountain time) ppm*m pathlength 
Timestamp 

(mountain time) 
37.6 18 9/21/2006 10:33 28.6 15 9/21/2006 11:01 
37.6 18 9/21/2006 10:33 28.8 15 9/21/2006 11:01 
37.4 18 9/21/2006 10:33 28.7 15 9/21/2006 11:01 
37.5 18 9/21/2006 10:33 28.6 15 9/21/2006 11:01 
37.1 18 9/21/2006 10:33 28.8 15 9/21/2006 11:01 
37.2 18 9/21/2006 10:33 28.7 15 9/21/2006 11:01 
37.3 18 9/21/2006 10:33 28.7 15 9/21/2006 11:01 
37.6 18 9/21/2006 10:33 28.8 15 9/21/2006 11:01 
37.4 18 9/21/2006 10:33 28.8 15 9/21/2006 11:01 
37.3 18 9/21/2006 10:33 28.7 15 9/21/2006 11:01 
37.2 18 9/21/2006 10:33 28.7 15 9/21/2006 11:01 
37.2 18 9/21/2006 10:33 28.8 15 9/21/2006 11:01 
37.5 18 9/21/2006 10:33 28.6 15 9/21/2006 11:01 
37.4 18 9/21/2006 10:33 28.8 15 9/21/2006 11:01 
37.4 18 9/21/2006 10:33 28.6 15 9/21/2006 11:01 
37.1 18 9/21/2006 10:33 28.7 15 9/21/2006 11:01 
37.3 18 9/21/2006 10:33 28.7 15 9/21/2006 11:01 
37.4 18 9/21/2006 10:33 28.7 15 9/21/2006 11:01 
37.5 18 9/21/2006 10:34 28.7 15 9/21/2006 11:01 
37.4 18 9/21/2006 10:34 28.7 15 9/21/2006 11:01 
37.4 18 9/21/2006 10:34 28.7 15 9/21/2006 11:01 
37.6 18 9/21/2006 10:34 28.8 15 9/21/2006 11:01 
37.3 18 9/21/2006 10:34 28.8 15 9/21/2006 11:01 
37.5 18 9/21/2006 10:34 28.7 15 9/21/2006 11:01 
37.5 18 9/21/2006 10:34 28.8 15 9/21/2006 11:01 
37.3 18 9/21/2006 10:34 28.8 15 9/21/2006 11:01 
37.5 18 9/21/2006 10:34 28.7 15 9/21/2006 11:02 
37.4 18 9/21/2006 10:34 28.9 15 9/21/2006 11:02 
37.5 18 9/21/2006 10:34 28.7 15 9/21/2006 11:02 
37.2 18 9/21/2006 10:34 28.7 15 9/21/2006 11:02 
37.3 18 9/21/2006 10:34 28.8 15 9/21/2006 11:02 
37.2 18 9/21/2006 10:34 28.7 15 9/21/2006 11:02 
37.3 18 9/21/2006 10:34 28.7 15 9/21/2006 11:02 
37 18 9/21/2006 10:34 28.4 15 9/21/2006 11:02 

37.1 18 9/21/2006 10:34 28.7 15 9/21/2006 11:02 
37.2 18 9/21/2006 10:34 28.7 15 9/21/2006 11:02 
37.3 18 9/21/2006 10:34 28.8 15 9/21/2006 11:02 
37.6 18 9/21/2006 10:34 28.8 15 9/21/2006 11:02 
37.6 18 9/21/2006 10:34 28.6 15 9/21/2006 11:02 
37.6 18 9/21/2006 10:34 28.7 15 9/21/2006 11:02 
38.1 18 9/21/2006 10:34 28.9 15 9/21/2006 11:02 
38.3 18 9/21/2006 10:34 28.7 15 9/21/2006 11:02 
38.4 18 9/21/2006 10:34 28.6 15 9/21/2006 11:02 
38.4 18 9/21/2006 10:34 28.7 15 9/21/2006 11:02 
39 18 9/21/2006 10:34 28.6 15 9/21/2006 11:02 
39 18 9/21/2006 10:34 28.8 15 9/21/2006 11:02 

38.9 18 9/21/2006 10:34 28.7 15 9/21/2006 11:02 
39 18 9/21/2006 10:34 28.6 15 9/21/2006 11:02 

39.5 18 9/21/2006 10:34 28.8 15 9/21/2006 11:02 
39.3 18 9/21/2006 10:34 28.8 15 9/21/2006 11:02 
38.7 18 9/21/2006 10:34 28.7 15 9/21/2006 11:02 
38.1 18 9/21/2006 10:34 28.6 15 9/21/2006 11:02 
38.1 18 9/21/2006 10:35 28.8 15 9/21/2006 11:02 
38.1 18 9/21/2006 10:35 28.6 15 9/21/2006 11:02 
38 18 9/21/2006 10:35 28.7 15 9/21/2006 11:02 
38 18 9/21/2006 10:35 28.7 15 9/21/2006 11:02 
38 18 9/21/2006 10:35 28.6 15 9/21/2006 11:02 
38 18 9/21/2006 10:35 28.7 15 9/21/2006 11:02 
38 18 9/21/2006 10:35 28.6 15 9/21/2006 11:02 
38 18 9/21/2006 10:35 28.5 15 9/21/2006 11:02 
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Path Measurement Data 
Site 4 Path 3 

Path Measurement Data 
Site 4 Path 4 

ppm*m pathlength 
Timestamp 

(mountain time) ppm*m pathlength 
Timestamp 

(mountain time) 
38.3 18 9/21/2006 10:35 28.5 15 9/21/2006 11:03 
41 18 9/21/2006 10:35 28.7 15 9/21/2006 11:03 

40.5 18 9/21/2006 10:35 28.5 15 9/21/2006 11:03 
42.4 18 9/21/2006 10:35 28.6 15 9/21/2006 11:03 
40.2 18 9/21/2006 10:35 28.8 15 9/21/2006 11:03 
125 18 9/21/2006 10:35 28.6 15 9/21/2006 11:03 
350 18 9/21/2006 10:35 28.6 15 9/21/2006 11:03 
615 18 9/21/2006 10:35 28.6 15 9/21/2006 11:03 
490 18 9/21/2006 10:35 28.6 15 9/21/2006 11:03 
700 18 9/21/2006 10:35 28.6 15 9/21/2006 11:03 
573 18 9/21/2006 10:35 28.7 15 9/21/2006 11:03 
380 18 9/21/2006 10:35 28.7 15 9/21/2006 11:03 
91.6 18 9/21/2006 10:35 28.8 15 9/21/2006 11:03 
65.7 18 9/21/2006 10:35 28.7 15 9/21/2006 11:03 
81.8 18 9/21/2006 10:35 28.8 15 9/21/2006 11:03 
99.7 18 9/21/2006 10:35 28.7 15 9/21/2006 11:03 
65.6 18 9/21/2006 10:35 28.8 15 9/21/2006 11:03 
45.1 18 9/21/2006 10:35 28.9 15 9/21/2006 11:03 
44.9 18 9/21/2006 10:35 28.7 15 9/21/2006 11:03 
40.9 18 9/21/2006 10:35 28.8 15 9/21/2006 11:03 
39.4 18 9/21/2006 10:35 28.6 15 9/21/2006 11:03 
39.7 18 9/21/2006 10:35 28.8 15 9/21/2006 11:03 
38.9 18 9/21/2006 10:35 28.9 15 9/21/2006 11:03 
38.9 18 9/21/2006 10:35 28.9 15 9/21/2006 11:03 
44 18 9/21/2006 10:35 28.8 15 9/21/2006 11:03 

66.5 18 9/21/2006 10:35 28.8 15 9/21/2006 11:03 
129 18 9/21/2006 10:36 28.9 15 9/21/2006 11:03 
162 18 9/21/2006 10:36 28.7 15 9/21/2006 11:03 
164 18 9/21/2006 10:36 28.8 15 9/21/2006 11:03 
202 18 9/21/2006 10:36 28.8 15 9/21/2006 11:03 
136 18 9/21/2006 10:36 28.8 15 9/21/2006 11:03 
111 18 9/21/2006 10:36 28.9 15 9/21/2006 11:03 
66.3 18 9/21/2006 10:36 28.7 15 9/21/2006 11:03 
47.4 18 9/21/2006 10:36 28.8 15 9/21/2006 11:03 
49.2 18 9/21/2006 10:36 28.9 15 9/21/2006 11:03 
52.1 18 9/21/2006 10:36 28.9 15 9/21/2006 11:04 
57.8 18 9/21/2006 10:36 28.9 15 9/21/2006 11:04 
61.6 18 9/21/2006 10:36 28.9 15 9/21/2006 11:04 
79.2 18 9/21/2006 10:36 29 15 9/21/2006 11:04 
143 18 9/21/2006 10:36 29 15 9/21/2006 11:04 
144 18 9/21/2006 10:36 28.8 15 9/21/2006 11:04 
120 18 9/21/2006 10:36 28.7 15 9/21/2006 11:04 
88.8 18 9/21/2006 10:36 28.9 15 9/21/2006 11:04 
75.5 18 9/21/2006 10:36 28.8 15 9/21/2006 11:04 
59.5 18 9/21/2006 10:36 28.9 15 9/21/2006 11:04 
47.1 18 9/21/2006 10:36 28.8 15 9/21/2006 11:04 
42.5 18 9/21/2006 10:36 28.7 15 9/21/2006 11:04 
46.4 18 9/21/2006 10:36 28.9 15 9/21/2006 11:04 
46.8 18 9/21/2006 10:36 28.9 15 9/21/2006 11:04 
46.8 18 9/21/2006 10:36 29 15 9/21/2006 11:04 
49 18 9/21/2006 10:36 28.7 15 9/21/2006 11:04 

50.6 18 9/21/2006 10:36 28.9 15 9/21/2006 11:04 
50.7 18 9/21/2006 10:36 28.8 15 9/21/2006 11:04 
50.3 18 9/21/2006 10:36 28.9 15 9/21/2006 11:04 
46.6 18 9/21/2006 10:36 28.9 15 9/21/2006 11:04 
46.3 18 9/21/2006 10:36 28.7 15 9/21/2006 11:04 
45.4 18 9/21/2006 10:36 28.7 15 9/21/2006 11:04 
46.1 18 9/21/2006 10:36 28.8 15 9/21/2006 11:04 
43.1 18 9/21/2006 10:36 28.6 15 9/21/2006 11:04 
42.6 18 9/21/2006 10:36 28.9 15 9/21/2006 11:04 
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Path Measurement Data 
Site 4 Path 3 

Path Measurement Data 
Site 4 Path 4 

ppm*m pathlength 
Timestamp 

(mountain time) ppm*m pathlength 
Timestamp 

(mountain time) 
41.5 18 9/21/2006 10:37 28.8 15 9/21/2006 11:04 
40 18 9/21/2006 10:37 28.8 15 9/21/2006 11:04 

39.6 18 9/21/2006 10:37 28.6 15 9/21/2006 11:04 
39.4 18 9/21/2006 10:37 28.8 15 9/21/2006 11:04 
39.4 18 9/21/2006 10:37 28.9 15 9/21/2006 11:04 
38.9 18 9/21/2006 10:37 28.8 15 9/21/2006 11:04 
39.2 18 9/21/2006 10:37 29 15 9/21/2006 11:04 
38.9 18 9/21/2006 10:37 28.7 15 9/21/2006 11:04 
38.9 18 9/21/2006 10:37 28.8 15 9/21/2006 11:04 
38.9 18 9/21/2006 10:37 28.7 15 9/21/2006 11:05 
38.6 18 9/21/2006 10:37 28.7 15 9/21/2006 11:05 
38.9 18 9/21/2006 10:37 29 15 9/21/2006 11:05 
38.6 18 9/21/2006 10:37 28.6 15 9/21/2006 11:05 
39 18 9/21/2006 10:37 28.8 15 9/21/2006 11:05 
39 18 9/21/2006 10:37 28.7 15 9/21/2006 11:05 

39.2 18 9/21/2006 10:37 28.7 15 9/21/2006 11:05 
39.5 18 9/21/2006 10:37 28.8 15 9/21/2006 11:05 
39.7 18 9/21/2006 10:37 28.8 15 9/21/2006 11:05 
39.7 18 9/21/2006 10:37 28.9 15 9/21/2006 11:05 
39.6 18 9/21/2006 10:37 28.7 15 9/21/2006 11:05 
39.4 18 9/21/2006 10:37 28.8 15 9/21/2006 11:05 
39.9 18 9/21/2006 10:37 29 15 9/21/2006 11:05 
39.5 18 9/21/2006 10:37 28.8 15 9/21/2006 11:05 
39.4 18 9/21/2006 10:37 28.7 15 9/21/2006 11:05 
39.8 18 9/21/2006 10:37 28.7 15 9/21/2006 11:05 
40.5 18 9/21/2006 10:37 28.9 15 9/21/2006 11:05 
40.8 18 9/21/2006 10:37 28.7 15 9/21/2006 11:05 
40.8 18 9/21/2006 10:37 28.7 15 9/21/2006 11:05 
40.7 18 9/21/2006 10:37 28.9 15 9/21/2006 11:05 
40.5 18 9/21/2006 10:37 28.8 15 9/21/2006 11:05 
40.8 18 9/21/2006 10:37 28.8 15 9/21/2006 11:05 
41.6 18 9/21/2006 10:37 28.7 15 9/21/2006 11:05 
41.1 18 9/21/2006 10:37 28.8 15 9/21/2006 11:05 
41 18 9/21/2006 10:37 28.9 15 9/21/2006 11:05 

41.1 18 9/21/2006 10:38 28.7 15 9/21/2006 11:05 
40.4 18 9/21/2006 10:38 28.6 15 9/21/2006 11:05 
40.6 18 9/21/2006 10:38 28.5 15 9/21/2006 11:05 
40.2 18 9/21/2006 10:38 28.7 15 9/21/2006 11:05 
39.8 18 9/21/2006 10:38 28.8 15 9/21/2006 11:05 
39.3 18 9/21/2006 10:38 28.7 15 9/21/2006 11:05 
39.1 18 9/21/2006 10:38 28.6 15 9/21/2006 11:05 
38.7 18 9/21/2006 10:38 28.8 15 9/21/2006 11:05 
38.4 18 9/21/2006 10:38 28.7 15 9/21/2006 11:05 
38.1 18 9/21/2006 10:38 28.5 15 9/21/2006 11:06 
38.4 18 9/21/2006 10:38 28.7 15 9/21/2006 11:06 
38.2 18 9/21/2006 10:38 28.5 15 9/21/2006 11:06 
38.3 18 9/21/2006 10:38 28.6 15 9/21/2006 11:06 
38.2 18 9/21/2006 10:38 28.7 15 9/21/2006 11:06 
38.2 18 9/21/2006 10:38 28.7 15 9/21/2006 11:06 
38.4 18 9/21/2006 10:38 28.6 15 9/21/2006 11:06 
38 18 9/21/2006 10:38 28.6 15 9/21/2006 11:06 

38.1 18 9/21/2006 10:38 28.7 15 9/21/2006 11:06 
38.1 18 9/21/2006 10:38 28.7 15 9/21/2006 11:06 
38.1 18 9/21/2006 10:38 28.7 15 9/21/2006 11:06 
38.1 18 9/21/2006 10:38 28.5 15 9/21/2006 11:06 
38.1 18 9/21/2006 10:38 28.7 15 9/21/2006 11:06 
38.2 18 9/21/2006 10:38 28.7 15 9/21/2006 11:06 
38.3 18 9/21/2006 10:38 28.7 15 9/21/2006 11:06 
38.1 18 9/21/2006 10:38 28.7 15 9/21/2006 11:06 
38.1 18 9/21/2006 10:38 28.8 15 9/21/2006 11:06 
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Path Measurement Data 
Site 4 Path 3 

Path Measurement Data 
Site 4 Path 4 

ppm*m pathlength 
Timestamp 

(mountain time) ppm*m pathlength 
Timestamp 

(mountain time) 
38.2 18 9/21/2006 10:38 28.8 15 9/21/2006 11:06 
38 18 9/21/2006 10:38 28.8 15 9/21/2006 11:06 

38.3 18 9/21/2006 10:38 28.5 15 9/21/2006 11:06 
38.1 18 9/21/2006 10:38 28.7 15 9/21/2006 11:06 
38 18 9/21/2006 10:38 28.6 15 9/21/2006 11:06 

165 18 9/21/2006 10:38 28.7 15 9/21/2006 11:06 
234 18 9/21/2006 10:38 28.6 15 9/21/2006 11:06 
296 18 9/21/2006 10:38 28.7 15 9/21/2006 11:06 
287 18 9/21/2006 10:38 28.7 15 9/21/2006 11:06 
264 18 9/21/2006 10:39 28.6 15 9/21/2006 11:06 
252 18 9/21/2006 10:39 28.8 15 9/21/2006 11:06 
251 18 9/21/2006 10:39 28.6 15 9/21/2006 11:06 
364 18 9/21/2006 10:39 28.8 15 9/21/2006 11:06 
368 18 9/21/2006 10:39 28.6 15 9/21/2006 11:06 
362 18 9/21/2006 10:39 28.8 15 9/21/2006 11:06 
175 18 9/21/2006 10:39 28.7 15 9/21/2006 11:06 
95.1 18 9/21/2006 10:39 28.7 15 9/21/2006 11:06 
53.9 18 9/21/2006 10:39 28.5 15 9/21/2006 11:07 
45 18 9/21/2006 10:39 28.6 15 9/21/2006 11:07 

47.3 18 9/21/2006 10:39 28.6 15 9/21/2006 11:07 
53.2 18 9/21/2006 10:39 28.7 15 9/21/2006 11:07 
61.8 18 9/21/2006 10:39 28.7 15 9/21/2006 11:07 
65.4 18 9/21/2006 10:39 28.1 15 9/21/2006 11:07 
61.7 18 9/21/2006 10:39 28.4 15 9/21/2006 11:07 
58.6 18 9/21/2006 10:39 28.1 15 9/21/2006 11:07 
54 18 9/21/2006 10:39 28.4 15 9/21/2006 11:07 

60.7 18 9/21/2006 10:39 28.1 15 9/21/2006 11:07 
83.2 18 9/21/2006 10:39 28.1 15 9/21/2006 11:07 
55.1 18 9/21/2006 10:39 28.2 15 9/21/2006 11:07 
48.6 18 9/21/2006 10:39 28.4 15 9/21/2006 11:07 
87.5 18 9/21/2006 10:39 28.2 15 9/21/2006 11:07 
72 18 9/21/2006 10:39 28.2 15 9/21/2006 11:07 

54.3 18 9/21/2006 10:39 28.2 15 9/21/2006 11:07 
63.9 18 9/21/2006 10:39 28.1 15 9/21/2006 11:07 
151 18 9/21/2006 10:39 28.2 15 9/21/2006 11:07 
149 18 9/21/2006 10:39 28.2 15 9/21/2006 11:07 
74.7 18 9/21/2006 10:39 28.1 15 9/21/2006 11:07 
117 18 9/21/2006 10:39 28.2 15 9/21/2006 11:07 
134 18 9/21/2006 10:39 28.1 15 9/21/2006 11:07 
183 18 9/21/2006 10:39 28.2 15 9/21/2006 11:07 
122 18 9/21/2006 10:39 28.2 15 9/21/2006 11:07 
93.2 18 9/21/2006 10:40 28.1 15 9/21/2006 11:07 
68.2 18 9/21/2006 10:40 28.2 15 9/21/2006 11:07 
55.6 18 9/21/2006 10:40 28.1 15 9/21/2006 11:07 
48.6 18 9/21/2006 10:40 28.1 15 9/21/2006 11:07 
56.4 18 9/21/2006 10:40 28.1 15 9/21/2006 11:07 
57.4 18 9/21/2006 10:40 28.2 15 9/21/2006 11:07 
58 18 9/21/2006 10:40 28.2 15 9/21/2006 11:07 

56.9 18 9/21/2006 10:40 28.2 15 9/21/2006 11:07 
55 18 9/21/2006 10:40 28.3 15 9/21/2006 11:07 

58.9 18 9/21/2006 10:40 28.1 15 9/21/2006 11:08 
59.7 18 9/21/2006 10:40 28.4 15 9/21/2006 11:08 
59.4 18 9/21/2006 10:40 28.3 15 9/21/2006 11:08 
52.9 18 9/21/2006 10:40 28.3 15 9/21/2006 11:08 
52.1 18 9/21/2006 10:40 28.1 15 9/21/2006 11:08 
52.9 18 9/21/2006 10:40 28.2 15 9/21/2006 11:08 
52.8 18 9/21/2006 10:40 28.3 15 9/21/2006 11:08 
56.5 18 9/21/2006 10:40 28.1 15 9/21/2006 11:08 
63.6 18 9/21/2006 10:40 28.1 15 9/21/2006 11:08 
47.9 18 9/21/2006 10:40 28.1 15 9/21/2006 11:08 
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Path Measurement Data 
Site 4 Path 3 

Path Measurement Data 
Site 4 Path 4 

ppm*m pathlength 
Timestamp 

(mountain time) ppm*m pathlength 
Timestamp 

(mountain time) 
44.6 18 9/21/2006 10:40 28.3 15 9/21/2006 11:08 
46.1 18 9/21/2006 10:40 28.1 15 9/21/2006 11:08 
47 18 9/21/2006 10:40 28.3 15 9/21/2006 11:08 

47.1 18 9/21/2006 10:40 28.1 15 9/21/2006 11:08 
46.9 18 9/21/2006 10:40 28.2 15 9/21/2006 11:08 
43.5 18 9/21/2006 10:40 28.1 15 9/21/2006 11:08 
42.4 18 9/21/2006 10:40 28.2 15 9/21/2006 11:08 
43.4 18 9/21/2006 10:40 28.2 15 9/21/2006 11:08 
41.5 18 9/21/2006 10:40 28.1 15 9/21/2006 11:08 
41 18 9/21/2006 10:40 28.2 15 9/21/2006 11:08 

46.2 18 9/21/2006 10:40 28.3 15 9/21/2006 11:08 
49.7 18 9/21/2006 10:40 28.2 15 9/21/2006 11:08 
47.4 18 9/21/2006 10:40 28.3 15 9/21/2006 11:08 
60.5 18 9/21/2006 10:40 28.5 15 9/21/2006 11:08 
69.6 18 9/21/2006 10:40 28.3 15 9/21/2006 11:08 
65.2 18 9/21/2006 10:41 28.3 15 9/21/2006 11:08 
69.6 18 9/21/2006 10:41 28.4 15 9/21/2006 11:08 
80.2 18 9/21/2006 10:41 28.2 15 9/21/2006 11:08 
86.6 18 9/21/2006 10:41 28.3 15 9/21/2006 11:08 
70.3 18 9/21/2006 10:41 28.2 15 9/21/2006 11:08 
66.3 18 9/21/2006 10:41 28.5 15 9/21/2006 11:08 
65.1 18 9/21/2006 10:41 28.2 15 9/21/2006 11:08 
67 18 9/21/2006 10:41 28.3 15 9/21/2006 11:08 

65.8 18 9/21/2006 10:41 28.4 15 9/21/2006 11:08 
63.6 18 9/21/2006 10:41 28.5 15 9/21/2006 11:09 
64 18 9/21/2006 10:41 28.3 15 9/21/2006 11:09 

58.9 18 9/21/2006 10:41 28.1 15 9/21/2006 11:09 
57.2 18 9/21/2006 10:41 28.3 15 9/21/2006 11:09 
55.1 18 9/21/2006 10:41 28.2 15 9/21/2006 11:09 
56 18 9/21/2006 10:41 28.2 15 9/21/2006 11:09 

55.5 18 9/21/2006 10:41 28.3 15 9/21/2006 11:09 
55.7 18 9/21/2006 10:41 28.3 15 9/21/2006 11:09 
56.4 18 9/21/2006 10:41 28.2 15 9/21/2006 11:09 
56.7 18 9/21/2006 10:41 28.3 15 9/21/2006 11:09 
56.8 18 9/21/2006 10:41 28.2 15 9/21/2006 11:09 
56.4 18 9/21/2006 10:41 28.2 15 9/21/2006 11:09 
56.6 18 9/21/2006 10:41 28.4 15 9/21/2006 11:09 
56.5 18 9/21/2006 10:41 28.4 15 9/21/2006 11:09 
56.6 18 9/21/2006 10:41 28.2 15 9/21/2006 11:09 
56.5 18 9/21/2006 10:41 28.3 15 9/21/2006 11:09 
58.4 18 9/21/2006 10:41 28.2 15 9/21/2006 11:09 
60.2 18 9/21/2006 10:41 28.5 15 9/21/2006 11:09 
60.3 18 9/21/2006 10:41 28.1 15 9/21/2006 11:09 
61.2 18 9/21/2006 10:41 28.3 15 9/21/2006 11:09 
62.2 18 9/21/2006 10:41 28.4 15 9/21/2006 11:09 
62.9 18 9/21/2006 10:41 28.2 15 9/21/2006 11:09 
64.8 18 9/21/2006 10:41 28.3 15 9/21/2006 11:09 
64.7 18 9/21/2006 10:41 28.4 15 9/21/2006 11:09 
61.8 18 9/21/2006 10:41 28.4 15 9/21/2006 11:09 
59.5 18 9/21/2006 10:41 28.3 15 9/21/2006 11:09 
58.4 18 9/21/2006 10:42 28.1 15 9/21/2006 11:09 
58 18 9/21/2006 10:42 28.4 15 9/21/2006 11:09 

57.5 18 9/21/2006 10:42 28.3 15 9/21/2006 11:09 
57.9 18 9/21/2006 10:42 28.2 15 9/21/2006 11:09 
57.9 18 9/21/2006 10:42 28.3 15 9/21/2006 11:09 
58.9 18 9/21/2006 10:42 28.3 15 9/21/2006 11:09 
60.1 18 9/21/2006 10:42 28.2 15 9/21/2006 11:09 
61.4 18 9/21/2006 10:42 28.4 15 9/21/2006 11:09 
61.6 18 9/21/2006 10:42 28.2 15 9/21/2006 11:09 
61 18 9/21/2006 10:42 28.2 15 9/21/2006 11:10 
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Path Measurement Data 
Site 4 Path 3 

Path Measurement Data 
Site 4 Path 4 

ppm*m pathlength 
Timestamp 

(mountain time) ppm*m pathlength 
Timestamp 

(mountain time) 
61.3 18 9/21/2006 10:42 28.4 15 9/21/2006 11:10 
61.3 18 9/21/2006 10:42 28.3 15 9/21/2006 11:10 
61.2 18 9/21/2006 10:42 28.2 15 9/21/2006 11:10 
61 18 9/21/2006 10:42 28 15 9/21/2006 11:10 

61.2 18 9/21/2006 10:42 28.2 15 9/21/2006 11:10 
60.7 18 9/21/2006 10:42 28.3 15 9/21/2006 11:10 
60.8 18 9/21/2006 10:42 28.1 15 9/21/2006 11:10 
60.4 18 9/21/2006 10:42 28.1 15 9/21/2006 11:10 
59.5 18 9/21/2006 10:42 28.3 15 9/21/2006 11:10 
58.7 18 9/21/2006 10:42 28.1 15 9/21/2006 11:10 
58.1 18 9/21/2006 10:42 28.3 15 9/21/2006 11:10 
57.5 18 9/21/2006 10:42 28.1 15 9/21/2006 11:10 
56.8 18 9/21/2006 10:42 28 15 9/21/2006 11:10 
56.5 18 9/21/2006 10:42 28.2 15 9/21/2006 11:10 
58 18 9/21/2006 10:42 28 15 9/21/2006 11:10 

59.3 18 9/21/2006 10:42 28.3 15 9/21/2006 11:10 
60.5 18 9/21/2006 10:42 28.2 15 9/21/2006 11:10 
71 18 9/21/2006 10:42 28.2 15 9/21/2006 11:10 

78.1 18 9/21/2006 10:42 28.2 15 9/21/2006 11:10 
76.5 18 9/21/2006 10:42 28.1 15 9/21/2006 11:10 
67 18 9/21/2006 10:42 28 15 9/21/2006 11:10 
65 18 9/21/2006 10:42 28 15 9/21/2006 11:10 

60.6 18 9/21/2006 10:42    
58.8 18 9/21/2006 10:42    
60.4 18 9/21/2006 10:43    
62.4 18 9/21/2006 10:43    
64.3 18 9/21/2006 10:43    
64.1 18 9/21/2006 10:43    
67.3 18 9/21/2006 10:43    
63.6 18 9/21/2006 10:43    
59.9 18 9/21/2006 10:43    
60.7 18 9/21/2006 10:43    
57.2 18 9/21/2006 10:43    
52.5 18 9/21/2006 10:43    
48 18 9/21/2006 10:43    

45.5 18 9/21/2006 10:43    
44 18 9/21/2006 10:43    

43.4 18 9/21/2006 10:43    
46.3 18 9/21/2006 10:43    
47.8 18 9/21/2006 10:43    
47.7 18 9/21/2006 10:43    
44.5 18 9/21/2006 10:43    
43.4 18 9/21/2006 10:43    
75.3 18 9/21/2006 10:43    
266 18 9/21/2006 10:43    

1318 18 9/21/2006 10:43    
1790 18 9/21/2006 10:43    
1782 18 9/21/2006 10:43    
1628 18 9/21/2006 10:43    
1258 18 9/21/2006 10:43    
1093 18 9/21/2006 10:43    
754 18 9/21/2006 10:43    
438 18 9/21/2006 10:43    
381 18 9/21/2006 10:43    
908 18 9/21/2006 10:43    

1415 18 9/21/2006 10:43    
1275 18 9/21/2006 10:43    
1045 18 9/21/2006 10:43    
1058 18 9/21/2006 10:44    
1157 18 9/21/2006 10:44    
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Path Measurement Data 
Site 4 Path 3 

Path Measurement Data 
Site 4 Path 4 

ppm*m pathlength 
Timestamp 

(mountain time) ppm*m pathlength 
Timestamp 

(mountain time) 
975 18 9/21/2006 10:44    
858 18 9/21/2006 10:44    
544 18 9/21/2006 10:44    
412 18 9/21/2006 10:44    
195 18 9/21/2006 10:44    
76.8 18 9/21/2006 10:44    
59.3 18 9/21/2006 10:44    
53.6 18 9/21/2006 10:44    
48.1 18 9/21/2006 10:44    
45 18 9/21/2006 10:44    

86.2 18 9/21/2006 10:44    
229 18 9/21/2006 10:44    
326 18 9/21/2006 10:44    
221 18 9/21/2006 10:44    
268 18 9/21/2006 10:44    
82.3 18 9/21/2006 10:44    
56.3 18 9/21/2006 10:44    
57.7 18 9/21/2006 10:44    
63.7 18 9/21/2006 10:44    
60.6 18 9/21/2006 10:44    
74 18 9/21/2006 10:44    

89.6 18 9/21/2006 10:44    
70.9 18 9/21/2006 10:44    
71.8 18 9/21/2006 10:44    
66.1 18 9/21/2006 10:44    
64.6 18 9/21/2006 10:44    
62.4 18 9/21/2006 10:44    
62.6 18 9/21/2006 10:44    
60.6 18 9/21/2006 10:44    
57.4 18 9/21/2006 10:44    
49.4 18 9/21/2006 10:44    
60.4 18 9/21/2006 10:44    
54.5 18 9/21/2006 10:45    
69.3 18 9/21/2006 10:45    
46.1 18 9/21/2006 10:45    
51 18 9/21/2006 10:45    

41.2 18 9/21/2006 10:45    
46.2 18 9/21/2006 10:45    
45.8 18 9/21/2006 10:45    
50 18 9/21/2006 10:45    

47.6 18 9/21/2006 10:45    
48.1 18 9/21/2006 10:45    
54.9 18 9/21/2006 10:45    
60.8 18 9/21/2006 10:45    
58.5 18 9/21/2006 10:45    
54.5 18 9/21/2006 10:45    
51.6 18 9/21/2006 10:45    
58.5 18 9/21/2006 10:45    
66.9 18 9/21/2006 10:45    
48.7 18 9/21/2006 10:45    
40.9 18 9/21/2006 10:45    
38.2 18 9/21/2006 10:45    
46.9 18 9/21/2006 10:45    
43.8 18 9/21/2006 10:45    
43 18 9/21/2006 10:45    

45.9 18 9/21/2006 10:45    
38.8 18 9/21/2006 10:45    
40.4 18 9/21/2006 10:45    
43.8 18 9/21/2006 10:45    
42.4 18 9/21/2006 10:45    

253



Path Measurement Data 
Site 4 Path 3 

Path Measurement Data 
Site 4 Path 4 

ppm*m pathlength 
Timestamp 

(mountain time) ppm*m pathlength 
Timestamp 

(mountain time) 
42.6 18 9/21/2006 10:45    
40.3 18 9/21/2006 10:45    
39.6 18 9/21/2006 10:45    
39.5 18 9/21/2006 10:45    
41.3 18 9/21/2006 10:45    
42.8 18 9/21/2006 10:45    
44.4 18 9/21/2006 10:46    
50 18 9/21/2006 10:46    

50.4 18 9/21/2006 10:46    
46.7 18 9/21/2006 10:46    
44.5 18 9/21/2006 10:46    
50.5 18 9/21/2006 10:46    
52.5 18 9/21/2006 10:46    
46.7 18 9/21/2006 10:46    
43.1 18 9/21/2006 10:46    
40.4 18 9/21/2006 10:46    
44 18 9/21/2006 10:46    

50.7 18 9/21/2006 10:46    
52.8 18 9/21/2006 10:46    
50.3 18 9/21/2006 10:46    
44 18 9/21/2006 10:46    

41.4 18 9/21/2006 10:46    
39.8 18 9/21/2006 10:46    
39.1 18 9/21/2006 10:46    
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Path Measurement Data 
Site 4 Path 5 

ppm*m pathlength 
Timestamp 

(mountain time) 
38.6 19 9/21/2006 11:14 
38.5 19 9/21/2006 11:14 
38.3 19 9/21/2006 11:14 
38.4 19 9/21/2006 11:14 
38.3 19 9/21/2006 11:15 
38.5 19 9/21/2006 11:15 
38.2 19 9/21/2006 11:15 
38.3 19 9/21/2006 11:15 
38.3 19 9/21/2006 11:15 
38.3 19 9/21/2006 11:15 
38.5 19 9/21/2006 11:15 
38.7 19 9/21/2006 11:15 
38.5 19 9/21/2006 11:15 
38.1 19 9/21/2006 11:15 
38.4 19 9/21/2006 11:15 
38.6 19 9/21/2006 11:15 
38.6 19 9/21/2006 11:15 
38.3 19 9/21/2006 11:15 
38.2 19 9/21/2006 11:15 
38.7 19 9/21/2006 11:15 
38.7 19 9/21/2006 11:15 
38.4 19 9/21/2006 11:15 
38.5 19 9/21/2006 11:15 
38.7 19 9/21/2006 11:15 
38.7 19 9/21/2006 11:15 
38.6 19 9/21/2006 11:15 
38.5 19 9/21/2006 11:15 
38.6 19 9/21/2006 11:15 
38.9 19 9/21/2006 11:15 
38.4 19 9/21/2006 11:15 
38.4 19 9/21/2006 11:15 
38.6 19 9/21/2006 11:15 
38.8 19 9/21/2006 11:15 
38.6 19 9/21/2006 11:15 
38.5 19 9/21/2006 11:15 
38.6 19 9/21/2006 11:15 
38.4 19 9/21/2006 11:15 
38.6 19 9/21/2006 11:15 
38.6 19 9/21/2006 11:16 
38.8 19 9/21/2006 11:16 
38.8 19 9/21/2006 11:16 
38.6 19 9/21/2006 11:16 
38.6 19 9/21/2006 11:16 
38.8 19 9/21/2006 11:16 
38.8 19 9/21/2006 11:16 
38.5 19 9/21/2006 11:16 
38.8 19 9/21/2006 11:16 
38.5 19 9/21/2006 11:16 
38.8 19 9/21/2006 11:16 
38.8 19 9/21/2006 11:16 
38.4 19 9/21/2006 11:16 
38.1 19 9/21/2006 11:16 
38.5 19 9/21/2006 11:16 
38.4 19 9/21/2006 11:16 
38.4 19 9/21/2006 11:16 
38.1 19 9/21/2006 11:16 
38.5 19 9/21/2006 11:16 
38.2 19 9/21/2006 11:16 
38.3 19 9/21/2006 11:16 
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Path Measurement Data 
Site 4 Path 5 

ppm*m pathlength 
Timestamp 

(mountain time) 
38.3 19 9/21/2006 11:16 
38.3 19 9/21/2006 11:16 
38.4 19 9/21/2006 11:16 
38.2 19 9/21/2006 11:16 
38.5 19 9/21/2006 11:16 
38.5 19 9/21/2006 11:16 
38.4 19 9/21/2006 11:16 
38.1 19 9/21/2006 11:16 
38.2 19 9/21/2006 11:16 
38.1 19 9/21/2006 11:16 
38.1 19 9/21/2006 11:16 
38.2 19 9/21/2006 11:16 
38.4 19 9/21/2006 11:16 
38.1 19 9/21/2006 11:16 
38.3 19 9/21/2006 11:17 
38.2 19 9/21/2006 11:17 
38.1 19 9/21/2006 11:17 
38.3 19 9/21/2006 11:17 
38.2 19 9/21/2006 11:17 
38.2 19 9/21/2006 11:17 
38.8 19 9/21/2006 11:17 
39.7 19 9/21/2006 11:17 
39.5 19 9/21/2006 11:17 
38.7 19 9/21/2006 11:17 
38.3 19 9/21/2006 11:17 
38.9 19 9/21/2006 11:17 
39.2 19 9/21/2006 11:17 
38.4 19 9/21/2006 11:17 
40.6 19 9/21/2006 11:17 
42.1 19 9/21/2006 11:17 
40.2 19 9/21/2006 11:17 
40 19 9/21/2006 11:17 

40.6 19 9/21/2006 11:17 
40.3 19 9/21/2006 11:17 
41 19 9/21/2006 11:17 

40.9 19 9/21/2006 11:17 
39.1 19 9/21/2006 11:17 
39.5 19 9/21/2006 11:17 
45.1 19 9/21/2006 11:17 
42 19 9/21/2006 11:17 

42.5 19 9/21/2006 11:17 
44.7 19 9/21/2006 11:17 
50.4 19 9/21/2006 11:17 
54.1 19 9/21/2006 11:17 
58.7 19 9/21/2006 11:17 
51.4 19 9/21/2006 11:17 
162 19 9/21/2006 11:17 
45.2 19 9/21/2006 11:17 
595 19 9/21/2006 11:18 
65 19 9/21/2006 11:18 

131 19 9/21/2006 11:18 
156 19 9/21/2006 11:18 
51.6 19 9/21/2006 11:18 
70.7 19 9/21/2006 11:18 
315 19 9/21/2006 11:18 

1566 19 9/21/2006 11:18 
629 19 9/21/2006 11:18 
275 19 9/21/2006 11:18 
365 19 9/21/2006 11:18 
840 19 9/21/2006 11:18 

2027 19 9/21/2006 11:18 

256



Path Measurement Data 
Site 4 Path 5 

ppm*m pathlength 
Timestamp 

(mountain time) 
1400 19 9/21/2006 11:18 
1222 19 9/21/2006 11:18 
984 19 9/21/2006 11:18 
575 19 9/21/2006 11:18 
201 19 9/21/2006 11:18 
101 19 9/21/2006 11:18 
63.1 19 9/21/2006 11:18 
61.2 19 9/21/2006 11:18 
58.7 19 9/21/2006 11:18 
41.6 19 9/21/2006 11:18 
39.5 19 9/21/2006 11:18 
38.7 19 9/21/2006 11:18 
38.5 19 9/21/2006 11:18 
38.8 19 9/21/2006 11:18 
38.8 19 9/21/2006 11:18 
38.8 19 9/21/2006 11:18 
38.6 19 9/21/2006 11:18 
38.8 19 9/21/2006 11:18 
38.8 19 9/21/2006 11:18 
38.9 19 9/21/2006 11:18 
38.7 19 9/21/2006 11:18 
38.7 19 9/21/2006 11:19 
38.8 19 9/21/2006 11:19 
38.8 19 9/21/2006 11:19 
38.6 19 9/21/2006 11:19 
38.8 19 9/21/2006 11:19 
38.7 19 9/21/2006 11:19 
38.7 19 9/21/2006 11:19 
39.1 19 9/21/2006 11:19 
38.9 19 9/21/2006 11:19 
85.6 19 9/21/2006 11:19 
159 19 9/21/2006 11:19 
130 19 9/21/2006 11:19 
110 19 9/21/2006 11:19 
248 19 9/21/2006 11:19 
426 19 9/21/2006 11:19 
41 19 9/21/2006 11:19 

47.3 19 9/21/2006 11:19 
44.2 19 9/21/2006 11:19 
42.2 19 9/21/2006 11:19 
43.5 19 9/21/2006 11:19 
41.7 19 9/21/2006 11:19 
42.6 19 9/21/2006 11:19 
44.3 19 9/21/2006 11:19 
45.5 19 9/21/2006 11:19 
43.4 19 9/21/2006 11:19 
40.6 19 9/21/2006 11:19 
39.5 19 9/21/2006 11:19 
39 19 9/21/2006 11:19 
39 19 9/21/2006 11:19 
39 19 9/21/2006 11:19 

38.8 19 9/21/2006 11:19 
42.2 19 9/21/2006 11:19 
39.4 19 9/21/2006 11:19 
39.1 19 9/21/2006 11:20 
38.7 19 9/21/2006 11:20 
39.5 19 9/21/2006 11:20 
39.3 19 9/21/2006 11:20 
38.7 19 9/21/2006 11:20 
39.2 19 9/21/2006 11:20 
40 19 9/21/2006 11:20 
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Path Measurement Data 
Site 4 Path 5 

ppm*m pathlength 
Timestamp 

(mountain time) 
40.3 19 9/21/2006 11:20 
40.2 19 9/21/2006 11:20 
39.9 19 9/21/2006 11:20 
39.8 19 9/21/2006 11:20 
38.5 19 9/21/2006 11:20 
38.1 19 9/21/2006 11:20 
38.4 19 9/21/2006 11:20 
38.5 19 9/21/2006 11:20 
38.5 19 9/21/2006 11:20 
38.5 19 9/21/2006 11:20 
38.4 19 9/21/2006 11:20 
38.6 19 9/21/2006 11:20 
38.4 19 9/21/2006 11:20 
38.2 19 9/21/2006 11:20 
38.4 19 9/21/2006 11:20 
38.4 19 9/21/2006 11:20 
38.5 19 9/21/2006 11:20 
38.5 19 9/21/2006 11:20 
38.4 19 9/21/2006 11:20 
38.4 19 9/21/2006 11:20 
38.3 19 9/21/2006 11:20 
37.9 19 9/21/2006 11:20 
38.4 19 9/21/2006 11:20 
38.3 19 9/21/2006 11:20 
38.2 19 9/21/2006 11:20 
38.1 19 9/21/2006 11:20 
38.1 19 9/21/2006 11:20 
38.2 19 9/21/2006 11:21 
38.3 19 9/21/2006 11:21 
38.5 19 9/21/2006 11:21 
38.3 19 9/21/2006 11:21 
38.4 19 9/21/2006 11:21 
38.3 19 9/21/2006 11:21 
38.3 19 9/21/2006 11:21 
38.3 19 9/21/2006 11:21 
38 19 9/21/2006 11:21 

38.2 19 9/21/2006 11:21 
38.2 19 9/21/2006 11:21 
38.1 19 9/21/2006 11:21 
38.2 19 9/21/2006 11:21 
38.1 19 9/21/2006 11:21 
38.3 19 9/21/2006 11:21 
38.3 19 9/21/2006 11:21 
38.1 19 9/21/2006 11:21 
38.2 19 9/21/2006 11:21 
38.2 19 9/21/2006 11:21 
38 19 9/21/2006 11:21 

38.3 19 9/21/2006 11:21 
38.4 19 9/21/2006 11:21 
38.5 19 9/21/2006 11:21 
38.4 19 9/21/2006 11:21 
38.3 19 9/21/2006 11:21 
38.3 19 9/21/2006 11:21 
38.3 19 9/21/2006 11:21 
38.2 19 9/21/2006 11:21 
38.2 19 9/21/2006 11:21 
38.4 19 9/21/2006 11:21 
38.2 19 9/21/2006 11:21 
38.3 19 9/21/2006 11:21 
38.2 19 9/21/2006 11:21 
38.2 19 9/21/2006 11:21 
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Path Measurement Data 
Site 4 Path 5 

ppm*m pathlength 
Timestamp 

(mountain time) 
38.3 19 9/21/2006 11:21 
38.3 19 9/21/2006 11:22 
38.2 19 9/21/2006 11:22 
38.1 19 9/21/2006 11:22 
38.3 19 9/21/2006 11:22 
38.1 19 9/21/2006 11:22 
38.4 19 9/21/2006 11:22 
38.1 19 9/21/2006 11:22 
38 19 9/21/2006 11:22 

37.9 19 9/21/2006 11:22 
38.2 19 9/21/2006 11:22 
38.2 19 9/21/2006 11:22 
38.1 19 9/21/2006 11:22 
38.1 19 9/21/2006 11:22 
38.2 19 9/21/2006 11:22 
38.1 19 9/21/2006 11:22 
38.1 19 9/21/2006 11:22 
38.1 19 9/21/2006 11:22 
38 19 9/21/2006 11:22 

38.1 19 9/21/2006 11:22 
37.9 19 9/21/2006 11:22 
37.9 19 9/21/2006 11:22 
38.1 19 9/21/2006 11:22 
38.2 19 9/21/2006 11:22 
37.9 19 9/21/2006 11:22 
38.1 19 9/21/2006 11:22 
38 19 9/21/2006 11:22 
38 19 9/21/2006 11:22 

38.2 19 9/21/2006 11:22 
37.9 19 9/21/2006 11:22 
37.8 19 9/21/2006 11:22 
37.9 19 9/21/2006 11:22 
37.8 19 9/21/2006 11:22 
37.8 19 9/21/2006 11:22 
37.8 19 9/21/2006 11:22 
38 19 9/21/2006 11:23 

37.8 19 9/21/2006 11:23 
38 19 9/21/2006 11:23 

38.1 19 9/21/2006 11:23 
38 19 9/21/2006 11:23 

37.8 19 9/21/2006 11:23 
38.1 19 9/21/2006 11:23 
37.8 19 9/21/2006 11:23 
37.8 19 9/21/2006 11:23 
38.1 19 9/21/2006 11:23 
37.8 19 9/21/2006 11:23 
37.9 19 9/21/2006 11:23 
37.8 19 9/21/2006 11:23 
37.6 19 9/21/2006 11:23 
37.6 19 9/21/2006 11:23 
37.9 19 9/21/2006 11:23 
38 19 9/21/2006 11:23 
38 19 9/21/2006 11:23 

38.2 19 9/21/2006 11:23 
38.1 19 9/21/2006 11:23 
38 19 9/21/2006 11:23 

38.1 19 9/21/2006 11:23 
38 19 9/21/2006 11:23 

37.9 19 9/21/2006 11:23 
38.1 19 9/21/2006 11:23 
38.1 19 9/21/2006 11:23 
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Path Measurement Data 
Site 4 Path 5 

ppm*m pathlength 
Timestamp 

(mountain time) 
37.9 19 9/21/2006 11:23 
37.9 19 9/21/2006 11:23 
38.1 19 9/21/2006 11:23 
38 19 9/21/2006 11:23 

38.1 19 9/21/2006 11:23 
38.1 19 9/21/2006 11:23 
38 19 9/21/2006 11:23 

38.1 19 9/21/2006 11:23 
38.3 19 9/21/2006 11:24 
38.1 19 9/21/2006 11:24 
38.3 19 9/21/2006 11:24 
38.1 19 9/21/2006 11:24 
37.9 19 9/21/2006 11:24 
38 19 9/21/2006 11:24 

38.1 19 9/21/2006 11:24 
38 19 9/21/2006 11:24 
38 19 9/21/2006 11:24 

37.9 19 9/21/2006 11:24 
38.2 19 9/21/2006 11:24 
37.9 19 9/21/2006 11:24 
38 19 9/21/2006 11:24 

38.1 19 9/21/2006 11:24 
37.8 19 9/21/2006 11:24 
38.4 19 9/21/2006 11:24 
38.1 19 9/21/2006 11:24 
38.2 19 9/21/2006 11:24 
38 19 9/21/2006 11:24 

38.1 19 9/21/2006 11:24 
38 19 9/21/2006 11:24 

38.1 19 9/21/2006 11:24 
37.8 19 9/21/2006 11:24 
38.2 19 9/21/2006 11:24 
38.4 19 9/21/2006 11:24 
38.6 19 9/21/2006 11:24 
38.2 19 9/21/2006 11:24 
38 19 9/21/2006 11:24 

38.1 19 9/21/2006 11:24 
38.1 19 9/21/2006 11:24 
38 19 9/21/2006 11:24 

38.2 19 9/21/2006 11:24 
38.1 19 9/21/2006 11:24 
37.9 19 9/21/2006 11:24 
38 19 9/21/2006 11:24 

37.9 19 9/21/2006 11:25 
37.9 19 9/21/2006 11:25 
38 19 9/21/2006 11:25 
38 19 9/21/2006 11:25 

38.1 19 9/21/2006 11:25 
37.8 19 9/21/2006 11:25 
38.3 19 9/21/2006 11:25 
38 19 9/21/2006 11:25 

38.1 19 9/21/2006 11:25 
38 19 9/21/2006 11:25 

37.9 19 9/21/2006 11:25 
37.6 19 9/21/2006 11:25 
38.2 19 9/21/2006 11:25 
38.3 19 9/21/2006 11:25 
37.8 19 9/21/2006 11:25 
37.9 19 9/21/2006 11:25 
37.9 19 9/21/2006 11:25 
38 19 9/21/2006 11:25 
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Path Measurement Data 
Site 4 Path 5 

ppm*m pathlength 
Timestamp 

(mountain time) 
37.8 19 9/21/2006 11:25 
37.9 19 9/21/2006 11:25 
38 19 9/21/2006 11:25 

37.9 19 9/21/2006 11:25 
37.9 19 9/21/2006 11:25 
38.1 19 9/21/2006 11:25 
37.9 19 9/21/2006 11:25 
38.2 19 9/21/2006 11:25 
37.6 19 9/21/2006 11:25 
38.1 19 9/21/2006 11:25 
37.8 19 9/21/2006 11:25 
38 19 9/21/2006 11:25 

38.1 19 9/21/2006 11:25 
38.2 19 9/21/2006 11:25 
38 19 9/21/2006 11:25 

38.2 19 9/21/2006 11:25 
37.9 19 9/21/2006 11:26 
37.8 19 9/21/2006 11:26 
38.1 19 9/21/2006 11:26 
38.1 19 9/21/2006 11:26 
37.9 19 9/21/2006 11:26 
38 19 9/21/2006 11:26 

37.9 19 9/21/2006 11:26 
38 19 9/21/2006 11:26 

37.9 19 9/21/2006 11:26 
38.3 19 9/21/2006 11:26 
37.9 19 9/21/2006 11:26 
38 19 9/21/2006 11:26 

37.9 19 9/21/2006 11:26 
42 19 9/21/2006 11:26 

377 19 9/21/2006 11:26 
649 19 9/21/2006 11:26 
183 19 9/21/2006 11:26 
217 19 9/21/2006 11:26 
211 19 9/21/2006 11:26 
230 19 9/21/2006 11:26 

1253 19 9/21/2006 11:26 
306 19 9/21/2006 11:26 
158 19 9/21/2006 11:26 
135 19 9/21/2006 11:26 
114 19 9/21/2006 11:26 
95.8 19 9/21/2006 11:26 
90 19 9/21/2006 11:26 

88.2 19 9/21/2006 11:26 
330 19 9/21/2006 11:26 
842 19 9/21/2006 11:26 
114 19 9/21/2006 11:26 
82.4 19 9/21/2006 11:26 
220 19 9/21/2006 11:26 
317 19 9/21/2006 11:26 
231 19 9/21/2006 11:27 
173 19 9/21/2006 11:27 
130 19 9/21/2006 11:27 
94.3 19 9/21/2006 11:27 
66.4 19 9/21/2006 11:27 
62.7 19 9/21/2006 11:27 
62.5 19 9/21/2006 11:27 
64.6 19 9/21/2006 11:27 
62.6 19 9/21/2006 11:27 
67.6 19 9/21/2006 11:27 
63.4 19 9/21/2006 11:27 
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Path Measurement Data 
Site 4 Path 5 

ppm*m pathlength 
Timestamp 

(mountain time) 
62.8 19 9/21/2006 11:27 
70.9 19 9/21/2006 11:27 
64.6 19 9/21/2006 11:27 
62.7 19 9/21/2006 11:27 
63.2 19 9/21/2006 11:27 
59.1 19 9/21/2006 11:27 
51.8 19 9/21/2006 11:27 
52.6 19 9/21/2006 11:27 
48.5 19 9/21/2006 11:27 
43.6 19 9/21/2006 11:27 
41.6 19 9/21/2006 11:27 
40.5 19 9/21/2006 11:27 
40.3 19 9/21/2006 11:27 
40.5 19 9/21/2006 11:27 
39.4 19 9/21/2006 11:27 
38 19 9/21/2006 11:27 
38 19 9/21/2006 11:27 
38 19 9/21/2006 11:27 

37.9 19 9/21/2006 11:27 
37.8 19 9/21/2006 11:27 
38 19 9/21/2006 11:27 
38 19 9/21/2006 11:27 

40.2 19 9/21/2006 11:27 
40.4 19 9/21/2006 11:28 
39.6 19 9/21/2006 11:28 
41.2 19 9/21/2006 11:28 
40 19 9/21/2006 11:28 

38.3 19 9/21/2006 11:28 
38 19 9/21/2006 11:28 

37.9 19 9/21/2006 11:28 
38.2 19 9/21/2006 11:28 
38.1 19 9/21/2006 11:28 
37.8 19 9/21/2006 11:28 
37.8 19 9/21/2006 11:28 
38 19 9/21/2006 11:28 

37.9 19 9/21/2006 11:28 
37.9 19 9/21/2006 11:28 
38.2 19 9/21/2006 11:28 
37.8 19 9/21/2006 11:28 
37.8 19 9/21/2006 11:28 
38 19 9/21/2006 11:28 
38 19 9/21/2006 11:28 

37.9 19 9/21/2006 11:28 
38.2 19 9/21/2006 11:28 
38 19 9/21/2006 11:28 

38.1 19 9/21/2006 11:28 
38.1 19 9/21/2006 11:28 
38.3 19 9/21/2006 11:28 
38 19 9/21/2006 11:28 

38.1 19 9/21/2006 11:28 
38.3 19 9/21/2006 11:28 
38.1 19 9/21/2006 11:28 
37.6 19 9/21/2006 11:28 
38.2 19 9/21/2006 11:28 
38.1 19 9/21/2006 11:28 
37.8 19 9/21/2006 11:28 
38.2 19 9/21/2006 11:28 
38 19 9/21/2006 11:29 
38 19 9/21/2006 11:29 

37.8 19 9/21/2006 11:29 
37.8 19 9/21/2006 11:29 
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Path Measurement Data 
Site 4 Path 5 

ppm*m pathlength 
Timestamp 

(mountain time) 
38 19 9/21/2006 11:29 

37.9 19 9/21/2006 11:29 
38.1 19 9/21/2006 11:29 
38.1 19 9/21/2006 11:29 
38.1 19 9/21/2006 11:29 
38.1 19 9/21/2006 11:29 
38.1 19 9/21/2006 11:29 
38 19 9/21/2006 11:29 

37.7 19 9/21/2006 11:29 
38.1 19 9/21/2006 11:29 
37.9 19 9/21/2006 11:29 
37.9 19 9/21/2006 11:29 
37.9 19 9/21/2006 11:29 
37.9 19 9/21/2006 11:29 
38.1 19 9/21/2006 11:29 
38.2 19 9/21/2006 11:29 
38.4 19 9/21/2006 11:29 
38.2 19 9/21/2006 11:29 
38.2 19 9/21/2006 11:29 
38.1 19 9/21/2006 11:29 
38 19 9/21/2006 11:29 
38 19 9/21/2006 11:29 

38.4 19 9/21/2006 11:29 
38.3 19 9/21/2006 11:29 
38 19 9/21/2006 11:29 

38.1 19 9/21/2006 11:29 
38.3 19 9/21/2006 11:29 
38 19 9/21/2006 11:29 
38 19 9/21/2006 11:29 

38.1 19 9/21/2006 11:30 
38.1 19 9/21/2006 11:30 
38.2 19 9/21/2006 11:30 
38.1 19 9/21/2006 11:30 
37.8 19 9/21/2006 11:30 
37.9 19 9/21/2006 11:30 
38.1 19 9/21/2006 11:30 
38.1 19 9/21/2006 11:30 
38.2 19 9/21/2006 11:30 
38.1 19 9/21/2006 11:30 
38.1 19 9/21/2006 11:30 
38.3 19 9/21/2006 11:30 
38.1 19 9/21/2006 11:30 
38.1 19 9/21/2006 11:30 
38.2 19 9/21/2006 11:30 
38.1 19 9/21/2006 11:30 
37.9 19 9/21/2006 11:30 
38.1 19 9/21/2006 11:30 
38.2 19 9/21/2006 11:30 
38.1 19 9/21/2006 11:30 
38.1 19 9/21/2006 11:30 
38.1 19 9/21/2006 11:30 
37.9 19 9/21/2006 11:30 
37.9 19 9/21/2006 11:30 
38 19 9/21/2006 11:30 

38.3 19 9/21/2006 11:30 
38.2 19 9/21/2006 11:30 
37.9 19 9/21/2006 11:30 
38.3 19 9/21/2006 11:30 
38.2 19 9/21/2006 11:30 
37.9 19 9/21/2006 11:30 
38.3 19 9/21/2006 11:30 
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Path Measurement Data 
Site 4 Path 5 

ppm*m pathlength 
Timestamp 

(mountain time) 
37.5 19 9/21/2006 11:30 
38.2 19 9/21/2006 11:30 
37.9 19 9/21/2006 11:31 
38.3 19 9/21/2006 11:31 
38.2 19 9/21/2006 11:31 
38.4 19 9/21/2006 11:31 
38.1 19 9/21/2006 11:31 
38.2 19 9/21/2006 11:31 
37.9 19 9/21/2006 11:31 
38.2 19 9/21/2006 11:31 
38.3 19 9/21/2006 11:31 
38.5 19 9/21/2006 11:31 
38.2 19 9/21/2006 11:31 
38.4 19 9/21/2006 11:31 
38.1 19 9/21/2006 11:31 
38.1 19 9/21/2006 11:31 
38.4 19 9/21/2006 11:31 
38.1 19 9/21/2006 11:31 
38 19 9/21/2006 11:31 

38.1 19 9/21/2006 11:31 
38.2 19 9/21/2006 11:31 
38.4 19 9/21/2006 11:31 
38.2 19 9/21/2006 11:31 
37.7 19 9/21/2006 11:31 
38 19 9/21/2006 11:31 

38.4 19 9/21/2006 11:31 
38.4 19 9/21/2006 11:31 
37.9 19 9/21/2006 11:31 
37.9 19 9/21/2006 11:31 
38.1 19 9/21/2006 11:31 
38.3 19 9/21/2006 11:31 
38.4 19 9/21/2006 11:31 
38.3 19 9/21/2006 11:31 
38.4 19 9/21/2006 11:31 
38.2 19 9/21/2006 11:31 
38.2 19 9/21/2006 11:31 
37.9 19 9/21/2006 11:31 
38.4 19 9/21/2006 11:32 
38 19 9/21/2006 11:32 

38.2 19 9/21/2006 11:32 
38.1 19 9/21/2006 11:32 
38 19 9/21/2006 11:32 

38.2 19 9/21/2006 11:32 
38 19 9/21/2006 11:32 

38.5 19 9/21/2006 11:32 
38.4 19 9/21/2006 11:32 
38.1 19 9/21/2006 11:32 
38.1 19 9/21/2006 11:32 
38 19 9/21/2006 11:32 

38.1 19 9/21/2006 11:32 
38.6 19 9/21/2006 11:32 
38.2 19 9/21/2006 11:32 
38.5 19 9/21/2006 11:32 
38.3 19 9/21/2006 11:32 
38.3 19 9/21/2006 11:32 
37.9 19 9/21/2006 11:32 
38 19 9/21/2006 11:32 

38.5 19 9/21/2006 11:32 
38.3 19 9/21/2006 11:32 
38.5 19 9/21/2006 11:32 
37.9 19 9/21/2006 11:32 
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Path Measurement Data 
Site 4 Path 5 

ppm*m pathlength 
Timestamp 

(mountain time) 
38.4 19 9/21/2006 11:32 
38.1 19 9/21/2006 11:32 
37.9 19 9/21/2006 11:32 
38.1 19 9/21/2006 11:32 
38.2 19 9/21/2006 11:32 
38.2 19 9/21/2006 11:32 
38 19 9/21/2006 11:32 
38 19 9/21/2006 11:32 

38.4 19 9/21/2006 11:32 
38.1 19 9/21/2006 11:32 
38.3 19 9/21/2006 11:33 
38.2 19 9/21/2006 11:33 
38.1 19 9/21/2006 11:33 
37.8 19 9/21/2006 11:33 
38.3 19 9/21/2006 11:33 
38.3 19 9/21/2006 11:33 
38.2 19 9/21/2006 11:33 
38 19 9/21/2006 11:33 

38.2 19 9/21/2006 11:33 
38.4 19 9/21/2006 11:33 
38.4 19 9/21/2006 11:33 
38.3 19 9/21/2006 11:33 
38.2 19 9/21/2006 11:33 
38.2 19 9/21/2006 11:33 
38.5 19 9/21/2006 11:33 
38.1 19 9/21/2006 11:33 
38.5 19 9/21/2006 11:33 
38.7 19 9/21/2006 11:33 
38 19 9/21/2006 11:33 
38 19 9/21/2006 11:33 

38.2 19 9/21/2006 11:33 
38 19 9/21/2006 11:33 

38.2 19 9/21/2006 11:33 
38.5 19 9/21/2006 11:33 
38.2 19 9/21/2006 11:33 
38.6 19 9/21/2006 11:33 
38.2 19 9/21/2006 11:33 
38.3 19 9/21/2006 11:33 
38.4 19 9/21/2006 11:33 
38.3 19 9/21/2006 11:33 
38.2 19 9/21/2006 11:33 
38.1 19 9/21/2006 11:33 
38.2 19 9/21/2006 11:33 
37.9 19 9/21/2006 11:33 
38.6 19 9/21/2006 11:34 
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Path Measurement Data 
Site 5 Path 1 

Path Measurement Data 
Site 5 Path 2 

ppm*m pathlength 
Timestamp 

(mountain time) ppm*m pathlength 
Timestamp 

(mountain time) 
79.5 15 9/21/2006 13:03 30.7 15 9/21/2006 13:22 
93.5 15 9/21/2006 13:03 30.6 15 9/21/2006 13:22 
68.8 15 9/21/2006 13:03 39.5 15 9/21/2006 13:22 
47.3 15 9/21/2006 13:03 35.9 15 9/21/2006 13:22 
36.1 15 9/21/2006 13:03 32.7 15 9/21/2006 13:22 
32.5 15 9/21/2006 13:03 36.6 15 9/21/2006 13:22 
30.7 15 9/21/2006 13:03 41.8 15 9/21/2006 13:22 
31.2 15 9/21/2006 13:03 80.7 15 9/21/2006 13:22 
30.8 15 9/21/2006 13:04 87.8 15 9/21/2006 13:22 
29.8 15 9/21/2006 13:04 74.2 15 9/21/2006 13:22 
29 15 9/21/2006 13:04 74.3 15 9/21/2006 13:22 

29.2 15 9/21/2006 13:04 65 15 9/21/2006 13:22 
29.2 15 9/21/2006 13:04 45.2 15 9/21/2006 13:22 
29.1 15 9/21/2006 13:04 53 15 9/21/2006 13:22 
28.4 15 9/21/2006 13:04 61.4 15 9/21/2006 13:22 
28.1 15 9/21/2006 13:04 51.8 15 9/21/2006 13:23 
28 15 9/21/2006 13:04 41.8 15 9/21/2006 13:23 

27.9 15 9/21/2006 13:04 36.4 15 9/21/2006 13:23 
27.8 15 9/21/2006 13:04 33.6 15 9/21/2006 13:23 
28 15 9/21/2006 13:04 35.4 15 9/21/2006 13:23 

27.8 15 9/21/2006 13:04 35.2 15 9/21/2006 13:23 
27.8 15 9/21/2006 13:04 35.3 15 9/21/2006 13:23 
27.8 15 9/21/2006 13:04 33.2 15 9/21/2006 13:23 
27.8 15 9/21/2006 13:04 32.4 15 9/21/2006 13:23 
27.7 15 9/21/2006 13:04 34.3 15 9/21/2006 13:23 
27.6 15 9/21/2006 13:04 36.5 15 9/21/2006 13:23 
27.6 15 9/21/2006 13:04 34 15 9/21/2006 13:23 
27.4 15 9/21/2006 13:04 33.5 15 9/21/2006 13:23 
27.7 15 9/21/2006 13:04 34.3 15 9/21/2006 13:23 
27.5 15 9/21/2006 13:04 35 15 9/21/2006 13:23 
27.5 15 9/21/2006 13:04 37.1 15 9/21/2006 13:23 
27.6 15 9/21/2006 13:04 35.4 15 9/21/2006 13:23 
27.6 15 9/21/2006 13:04 35.7 15 9/21/2006 13:23 
27.6 15 9/21/2006 13:04 37.9 15 9/21/2006 13:23 
27.5 15 9/21/2006 13:04 36.7 15 9/21/2006 13:23 
27.7 15 9/21/2006 13:04 41.3 15 9/21/2006 13:23 
27.5 15 9/21/2006 13:04 39.8 15 9/21/2006 13:23 
27.5 15 9/21/2006 13:04 36.4 15 9/21/2006 13:23 
27.4 15 9/21/2006 13:04 33.8 15 9/21/2006 13:23 
27.6 15 9/21/2006 13:04 34.1 15 9/21/2006 13:23 
27.6 15 9/21/2006 13:04 33.1 15 9/21/2006 13:23 
27.7 15 9/21/2006 13:04 32.4 15 9/21/2006 13:23 
27.7 15 9/21/2006 13:04 31.1 15 9/21/2006 13:23 
27.6 15 9/21/2006 13:05 30.5 15 9/21/2006 13:23 
27.6 15 9/21/2006 13:05 30.4 15 9/21/2006 13:23 
28.9 15 9/21/2006 13:05 30.5 15 9/21/2006 13:23 
50 15 9/21/2006 13:05 30.4 15 9/21/2006 13:23 

60.7 15 9/21/2006 13:05 30.5 15 9/21/2006 13:23 
44.3 15 9/21/2006 13:05 30.5 15 9/21/2006 13:23 
48.6 15 9/21/2006 13:05 30.5 15 9/21/2006 13:23 
76 15 9/21/2006 13:05 30.5 15 9/21/2006 13:24 

79.7 15 9/21/2006 13:05 30.7 15 9/21/2006 13:24 
58.9 15 9/21/2006 13:05 30.8 15 9/21/2006 13:24 
56.9 15 9/21/2006 13:05 30.9 15 9/21/2006 13:24 
36.7 15 9/21/2006 13:05 30.8 15 9/21/2006 13:24 
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Path Measurement Data 
Site 5 Path 1 

Path Measurement Data 
Site 5 Path 2 

ppm*m pathlength 
Timestamp 

(mountain time) ppm*m pathlength 
Timestamp 

(mountain time) 
63.9 15 9/21/2006 13:05 30.6 15 9/21/2006 13:24 
87.5 15 9/21/2006 13:05 30.6 15 9/21/2006 13:24 
90.9 15 9/21/2006 13:05 30.6 15 9/21/2006 13:24 
55.2 15 9/21/2006 13:05 30.7 15 9/21/2006 13:24 
56.7 15 9/21/2006 13:05 30.6 15 9/21/2006 13:24 
98.1 15 9/21/2006 13:05 30.6 15 9/21/2006 13:24 
60.3 15 9/21/2006 13:05 30.8 15 9/21/2006 13:24 
55.7 15 9/21/2006 13:05 30.7 15 9/21/2006 13:24 
53.9 15 9/21/2006 13:05 30.6 15 9/21/2006 13:24 
55.2 15 9/21/2006 13:05 30.4 15 9/21/2006 13:24 
44.1 15 9/21/2006 13:05 30.5 15 9/21/2006 13:24 
111 15 9/21/2006 13:05 30.7 15 9/21/2006 13:24 
79.6 15 9/21/2006 13:05 30.5 15 9/21/2006 13:24 
96.9 15 9/21/2006 13:05 30.6 15 9/21/2006 13:24 
92.8 15 9/21/2006 13:05 57.8 15 9/21/2006 13:24 
53 15 9/21/2006 13:05 124 15 9/21/2006 13:24 

36.7 15 9/21/2006 13:05 45.4 15 9/21/2006 13:24 
82.8 15 9/21/2006 13:05 39 15 9/21/2006 13:24 
54.6 15 9/21/2006 13:05 36.9 15 9/21/2006 13:24 
41.5 15 9/21/2006 13:05 32.6 15 9/21/2006 13:24 
35.2 15 9/21/2006 13:05 35.9 15 9/21/2006 13:24 
31.2 15 9/21/2006 13:06 32.8 15 9/21/2006 13:24 
31.8 15 9/21/2006 13:06 30.6 15 9/21/2006 13:24 
30.7 15 9/21/2006 13:06 31 15 9/21/2006 13:24 
30.7 15 9/21/2006 13:06 31.4 15 9/21/2006 13:24 
28.2 15 9/21/2006 13:06 34.5 15 9/21/2006 13:24 
28.2 15 9/21/2006 13:06 53 15 9/21/2006 13:24 
27.8 15 9/21/2006 13:06 48.3 15 9/21/2006 13:24 
28.4 15 9/21/2006 13:06 45 15 9/21/2006 13:24 
27.9 15 9/21/2006 13:06 51 15 9/21/2006 13:25 
27.8 15 9/21/2006 13:06 50 15 9/21/2006 13:25 
28.8 15 9/21/2006 13:06 54.3 15 9/21/2006 13:25 
28.8 15 9/21/2006 13:06 37.3 15 9/21/2006 13:25 
28.3 15 9/21/2006 13:06 31.1 15 9/21/2006 13:25 
30.1 15 9/21/2006 13:06 30.6 15 9/21/2006 13:25 
40.8 15 9/21/2006 13:06 30.9 15 9/21/2006 13:25 
44.6 15 9/21/2006 13:06 32 15 9/21/2006 13:25 
75.6 15 9/21/2006 13:06 32.8 15 9/21/2006 13:25 
124 15 9/21/2006 13:06 30.9 15 9/21/2006 13:25 
103 15 9/21/2006 13:06 30.6 15 9/21/2006 13:25 
75.5 15 9/21/2006 13:06 30.8 15 9/21/2006 13:25 
83.3 15 9/21/2006 13:06 30.6 15 9/21/2006 13:25 
62.5 15 9/21/2006 13:06 30.4 15 9/21/2006 13:25 
43.2 15 9/21/2006 13:06 30.4 15 9/21/2006 13:25 
51.5 15 9/21/2006 13:06 30.4 15 9/21/2006 13:25 
33.5 15 9/21/2006 13:06 30.9 15 9/21/2006 13:25 
33.4 15 9/21/2006 13:06 30.7 15 9/21/2006 13:25 
42.6 15 9/21/2006 13:06 30.9 15 9/21/2006 13:25 
42.8 15 9/21/2006 13:06 30.8 15 9/21/2006 13:25 
51.2 15 9/21/2006 13:06 30.8 15 9/21/2006 13:25 
54.1 15 9/21/2006 13:06 30.9 15 9/21/2006 13:25 
47.2 15 9/21/2006 13:06 30.7 15 9/21/2006 13:25 
38.5 15 9/21/2006 13:06 30.9 15 9/21/2006 13:25 
40.1 15 9/21/2006 13:06 30.7 15 9/21/2006 13:25 
43.7 15 9/21/2006 13:06 30.9 15 9/21/2006 13:25 
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Path Measurement Data 
Site 5 Path 1 

Path Measurement Data 
Site 5 Path 2 

ppm*m pathlength 
Timestamp 

(mountain time) ppm*m pathlength 
Timestamp 

(mountain time) 
53.9 15 9/21/2006 13:07 30.8 15 9/21/2006 13:25 
74.6 15 9/21/2006 13:07 31 15 9/21/2006 13:25 
81.7 15 9/21/2006 13:07 30.6 15 9/21/2006 13:25 
45.6 15 9/21/2006 13:07 30.9 15 9/21/2006 13:25 
31.3 15 9/21/2006 13:07 30.8 15 9/21/2006 13:25 
48.1 15 9/21/2006 13:07 30.6 15 9/21/2006 13:25 
36.8 15 9/21/2006 13:07 30.9 15 9/21/2006 13:25 
35 15 9/21/2006 13:07 30.7 15 9/21/2006 13:25 

50.6 15 9/21/2006 13:07 30.9 15 9/21/2006 13:26 
107 15 9/21/2006 13:07 30.7 15 9/21/2006 13:26 
99.5 15 9/21/2006 13:07 30.8 15 9/21/2006 13:26 
78.5 15 9/21/2006 13:07 31 15 9/21/2006 13:26 
54.3 15 9/21/2006 13:07 53.1 15 9/21/2006 13:26 
55.8 15 9/21/2006 13:07 64 15 9/21/2006 13:26 
34.8 15 9/21/2006 13:07 47.4 15 9/21/2006 13:26 
33.5 15 9/21/2006 13:07 31.7 15 9/21/2006 13:26 
54.1 15 9/21/2006 13:07 31.2 15 9/21/2006 13:26 
41.4 15 9/21/2006 13:07 30.7 15 9/21/2006 13:26 
36.8 15 9/21/2006 13:07 30.7 15 9/21/2006 13:26 
41.6 15 9/21/2006 13:07 30.9 15 9/21/2006 13:26 
38.5 15 9/21/2006 13:07 30.6 15 9/21/2006 13:26 
33.6 15 9/21/2006 13:07 30.6 15 9/21/2006 13:26 
36.9 15 9/21/2006 13:07 30.7 15 9/21/2006 13:26 
32 15 9/21/2006 13:07 30.8 15 9/21/2006 13:26 

28.3 15 9/21/2006 13:07 30.8 15 9/21/2006 13:26 
28 15 9/21/2006 13:07 30.7 15 9/21/2006 13:26 

28.1 15 9/21/2006 13:07 30.7 15 9/21/2006 13:26 
29.5 15 9/21/2006 13:07 30.8 15 9/21/2006 13:26 
33.9 15 9/21/2006 13:07 30.9 15 9/21/2006 13:26 
46.1 15 9/21/2006 13:07 30.7 15 9/21/2006 13:26 
32.4 15 9/21/2006 13:07 30.9 15 9/21/2006 13:26 
35.7 15 9/21/2006 13:07 30.9 15 9/21/2006 13:26 
36.7 15 9/21/2006 13:07 30.8 15 9/21/2006 13:26 
40.5 15 9/21/2006 13:07 30.8 15 9/21/2006 13:26 
32.2 15 9/21/2006 13:07 30.9 15 9/21/2006 13:26 
40.1 15 9/21/2006 13:08 30.8 15 9/21/2006 13:26 
36.2 15 9/21/2006 13:08 30.9 15 9/21/2006 13:26 
32.5 15 9/21/2006 13:08 30.7 15 9/21/2006 13:26 
33.4 15 9/21/2006 13:08 30.9 15 9/21/2006 13:26 
31.7 15 9/21/2006 13:08 30.9 15 9/21/2006 13:26 
33.3 15 9/21/2006 13:08 31 15 9/21/2006 13:26 
34.3 15 9/21/2006 13:08 30.9 15 9/21/2006 13:26 
31.6 15 9/21/2006 13:08 30.8 15 9/21/2006 13:27 
29.3 15 9/21/2006 13:08 30.8 15 9/21/2006 13:27 
30.1 15 9/21/2006 13:08 31 15 9/21/2006 13:27 
30.5 15 9/21/2006 13:08 30.9 15 9/21/2006 13:27 
32.9 15 9/21/2006 13:08 31.1 15 9/21/2006 13:27 
31 15 9/21/2006 13:08 31.2 15 9/21/2006 13:27 

30.6 15 9/21/2006 13:08 31 15 9/21/2006 13:27 
27.9 15 9/21/2006 13:08 31 15 9/21/2006 13:27 
27.8 15 9/21/2006 13:08 31.1 15 9/21/2006 13:27 
29.5 15 9/21/2006 13:08 31 15 9/21/2006 13:27 
31.5 15 9/21/2006 13:08 31 15 9/21/2006 13:27 
35.3 15 9/21/2006 13:08 31.1 15 9/21/2006 13:27 
41 15 9/21/2006 13:08 31.2 15 9/21/2006 13:27 
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Path Measurement Data 
Site 5 Path 1 

Path Measurement Data 
Site 5 Path 2 

ppm*m pathlength 
Timestamp 

(mountain time) ppm*m pathlength 
Timestamp 

(mountain time) 
41.2 15 9/21/2006 13:08 31.2 15 9/21/2006 13:27 
39.7 15 9/21/2006 13:08 30.9 15 9/21/2006 13:27 
38.3 15 9/21/2006 13:08 31 15 9/21/2006 13:27 
50.1 15 9/21/2006 13:08 31 15 9/21/2006 13:27 
42.8 15 9/21/2006 13:08 30.8 15 9/21/2006 13:27 
44.4 15 9/21/2006 13:08 31 15 9/21/2006 13:27 
36 15 9/21/2006 13:08 31 15 9/21/2006 13:27 

36.8 15 9/21/2006 13:08 31 15 9/21/2006 13:27 
32.8 15 9/21/2006 13:08 30.7 15 9/21/2006 13:27 
45.4 15 9/21/2006 13:08 31 15 9/21/2006 13:27 
28.8 15 9/21/2006 13:09 31 15 9/21/2006 13:27 
31.6 15 9/21/2006 13:10 30.9 15 9/21/2006 13:27 
31.1 15 9/21/2006 13:10 31 15 9/21/2006 13:27 
31.5 15 9/21/2006 13:10 30.9 15 9/21/2006 13:27 
33.4 15 9/21/2006 13:10 31 15 9/21/2006 13:27 
30.4 15 9/21/2006 13:10 31.1 15 9/21/2006 13:27 
32 15 9/21/2006 13:10 30.9 15 9/21/2006 13:27 

32.2 15 9/21/2006 13:10 31 15 9/21/2006 13:27 
29.8 15 9/21/2006 13:10 30.8 15 9/21/2006 13:27 
30.5 15 9/21/2006 13:10 30.8 15 9/21/2006 13:27 
28.6 15 9/21/2006 13:10 31.1 15 9/21/2006 13:27 
30.3 15 9/21/2006 13:10 31 15 9/21/2006 13:27 
32 15 9/21/2006 13:10 31 15 9/21/2006 13:28 

32.5 15 9/21/2006 13:10 31.1 15 9/21/2006 13:28 
31.3 15 9/21/2006 13:10 31 15 9/21/2006 13:28 
29.5 15 9/21/2006 13:10 31 15 9/21/2006 13:28 
32.2 15 9/21/2006 13:10 30.9 15 9/21/2006 13:28 
32.4 15 9/21/2006 13:10 31.2 15 9/21/2006 13:28 
31.6 15 9/21/2006 13:10 31 15 9/21/2006 13:28 
29.6 15 9/21/2006 13:10 31.1 15 9/21/2006 13:28 
29.3 15 9/21/2006 13:10 30.9 15 9/21/2006 13:28 
28.9 15 9/21/2006 13:10 30.9 15 9/21/2006 13:28 
31.7 15 9/21/2006 13:10 30.9 15 9/21/2006 13:28 
30 15 9/21/2006 13:10 31 15 9/21/2006 13:28 

27.8 15 9/21/2006 13:10 31 15 9/21/2006 13:28 
27.7 15 9/21/2006 13:10 30.9 15 9/21/2006 13:28 
27.8 15 9/21/2006 13:10 30.9 15 9/21/2006 13:28 
29.7 15 9/21/2006 13:10 30.7 15 9/21/2006 13:28 
39.9 15 9/21/2006 13:10 30.8 15 9/21/2006 13:28 
36.3 15 9/21/2006 13:10 31 15 9/21/2006 13:28 
41.6 15 9/21/2006 13:10 30.9 15 9/21/2006 13:28 
69.2 15 9/21/2006 13:10 30.7 15 9/21/2006 13:28 
89.6 15 9/21/2006 13:10 30.8 15 9/21/2006 13:28 
89.6 15 9/21/2006 13:10 30.8 15 9/21/2006 13:28 
59.8 15 9/21/2006 13:10 30.9 15 9/21/2006 13:28 
29.5 15 9/21/2006 13:11 30.9 15 9/21/2006 13:28 
30 15 9/21/2006 13:11 30.8 15 9/21/2006 13:28 

30.1 15 9/21/2006 13:11 31 15 9/21/2006 13:28 
38.6 15 9/21/2006 13:11 31.2 15 9/21/2006 13:28 
28.6 15 9/21/2006 13:11 33.6 15 9/21/2006 13:28 
29.3 15 9/21/2006 13:11 54.5 15 9/21/2006 13:28 
29.7 15 9/21/2006 13:11 65.9 15 9/21/2006 13:28 
31 15 9/21/2006 13:11 74.5 15 9/21/2006 13:28 

29.6 15 9/21/2006 13:11 100 15 9/21/2006 13:28 
30.3 15 9/21/2006 13:11 109 15 9/21/2006 13:28 
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Path Measurement Data 
Site 5 Path 1 

Path Measurement Data 
Site 5 Path 2 

ppm*m pathlength 
Timestamp 

(mountain time) ppm*m pathlength 
Timestamp 

(mountain time) 
30 15 9/21/2006 13:11 88.3 15 9/21/2006 13:28 

31.8 15 9/21/2006 13:11 141 15 9/21/2006 13:29 
32.2 15 9/21/2006 13:11 171 15 9/21/2006 13:29 
30.5 15 9/21/2006 13:11 157 15 9/21/2006 13:29 
32.3 15 9/21/2006 13:11 72.9 15 9/21/2006 13:29 
28.5 15 9/21/2006 13:11 91.3 15 9/21/2006 13:29 
28.5 15 9/21/2006 13:11 62.5 15 9/21/2006 13:29 
29.4 15 9/21/2006 13:11 67.5 15 9/21/2006 13:29 
31 15 9/21/2006 13:11 90.8 15 9/21/2006 13:29 

31.9 15 9/21/2006 13:11 104 15 9/21/2006 13:29 
30.1 15 9/21/2006 13:11 82.4 15 9/21/2006 13:29 
28.5 15 9/21/2006 13:11 65.3 15 9/21/2006 13:29 
27.7 15 9/21/2006 13:11 56.1 15 9/21/2006 13:29 
28.2 15 9/21/2006 13:11 40.2 15 9/21/2006 13:29 
31.4 15 9/21/2006 13:11 50.6 15 9/21/2006 13:29 
32.4 15 9/21/2006 13:11 67.9 15 9/21/2006 13:29 
31 15 9/21/2006 13:11 134 15 9/21/2006 13:29 

32.6 15 9/21/2006 13:11 109 15 9/21/2006 13:29 
30.3 15 9/21/2006 13:11 122 15 9/21/2006 13:29 
30.3 15 9/21/2006 13:11 110 15 9/21/2006 13:29 
31.4 15 9/21/2006 13:11 116 15 9/21/2006 13:29 
29 15 9/21/2006 13:11 125 15 9/21/2006 13:29 

31.2 15 9/21/2006 13:11 173 15 9/21/2006 13:29 
28.4 15 9/21/2006 13:11 172 15 9/21/2006 13:29 
31.2 15 9/21/2006 13:12 129 15 9/21/2006 13:29 
31.4 15 9/21/2006 13:12 96.6 15 9/21/2006 13:29 
31.3 15 9/21/2006 13:12 84.5 15 9/21/2006 13:29 
31.4 15 9/21/2006 13:12 91.7 15 9/21/2006 13:29 
30.5 15 9/21/2006 13:12 91.4 15 9/21/2006 13:29 
29.5 15 9/21/2006 13:12 182 15 9/21/2006 13:29 
30.3 15 9/21/2006 13:12 110 15 9/21/2006 13:29 
31.3 15 9/21/2006 13:12 109 15 9/21/2006 13:29 
28.4 15 9/21/2006 13:12 73.8 15 9/21/2006 13:29 
29.7 15 9/21/2006 13:12 80 15 9/21/2006 13:29 
27.7 15 9/21/2006 13:12 83.1 15 9/21/2006 13:29 
28.3 15 9/21/2006 13:12 154 15 9/21/2006 13:30 
31.5 15 9/21/2006 13:12 67.6 15 9/21/2006 13:30 
30.5 15 9/21/2006 13:12 85.2 15 9/21/2006 13:30 
30.5 15 9/21/2006 13:12 106 15 9/21/2006 13:30 
30.5 15 9/21/2006 13:12 38.1 15 9/21/2006 13:30 
30.4 15 9/21/2006 13:12 46.9 15 9/21/2006 13:30 
30.1 15 9/21/2006 13:12 49.8 15 9/21/2006 13:30 
31.2 15 9/21/2006 13:12 69.4 15 9/21/2006 13:30 
29.8 15 9/21/2006 13:12 36.2 15 9/21/2006 13:30 
30.2 15 9/21/2006 13:12 45.7 15 9/21/2006 13:30 
30.1 15 9/21/2006 13:12 33.5 15 9/21/2006 13:30 
29.5 15 9/21/2006 13:12 44 15 9/21/2006 13:30 
30.4 15 9/21/2006 13:12 40.4 15 9/21/2006 13:30 
28.2 15 9/21/2006 13:12 54.8 15 9/21/2006 13:30 
27.6 15 9/21/2006 13:12 85.1 15 9/21/2006 13:30 
28.2 15 9/21/2006 13:12 86.8 15 9/21/2006 13:30 
32.5 15 9/21/2006 13:12 55.8 15 9/21/2006 13:30 
56.5 15 9/21/2006 13:12 39.4 15 9/21/2006 13:30 
48.3 15 9/21/2006 13:12 40.4 15 9/21/2006 13:30 
35.1 15 9/21/2006 13:12 37.7 15 9/21/2006 13:30 
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Path Measurement Data 
Site 5 Path 1 

Path Measurement Data 
Site 5 Path 2 

ppm*m pathlength 
Timestamp 

(mountain time) ppm*m pathlength 
Timestamp 

(mountain time) 
39.2 15 9/21/2006 13:12 76.1 15 9/21/2006 13:30 
37.4 15 9/21/2006 13:12 80.8 15 9/21/2006 13:30 
30.4 15 9/21/2006 13:12 48.2 15 9/21/2006 13:30 
29.3 15 9/21/2006 13:13 60.3 15 9/21/2006 13:30 
33.1 15 9/21/2006 13:13 82.5 15 9/21/2006 13:30 
29.9 15 9/21/2006 13:13    
28.6 15 9/21/2006 13:13    
28.1 15 9/21/2006 13:13    
27.7 15 9/21/2006 13:13    
28.3 15 9/21/2006 13:13    
35.4 15 9/21/2006 13:13    
37.4 15 9/21/2006 13:13    
36.4 15 9/21/2006 13:13    
52.4 15 9/21/2006 13:13    
76.2 15 9/21/2006 13:13    
36.6 15 9/21/2006 13:13    
29.7 15 9/21/2006 13:13    
90.9 15 9/21/2006 13:13    
55.5 15 9/21/2006 13:13    
28.9 15 9/21/2006 13:13    
28.9 15 9/21/2006 13:13    
30.1 15 9/21/2006 13:13    
38.8 15 9/21/2006 13:13    
80.4 15 9/21/2006 13:13    
66.8 15 9/21/2006 13:13    
62.5 15 9/21/2006 13:13    
36.4 15 9/21/2006 13:13    
38.4 15 9/21/2006 13:13    
45.8 15 9/21/2006 13:13    
33.7 15 9/21/2006 13:13    
37 15 9/21/2006 13:13    

108 15 9/21/2006 13:13    
40.5 15 9/21/2006 13:13    
34 15 9/21/2006 13:13    

33.1 15 9/21/2006 13:13    
43.4 15 9/21/2006 13:13    
37.3 15 9/21/2006 13:13    
33.4 15 9/21/2006 13:14    
33.9 15 9/21/2006 13:14    
35.9 15 9/21/2006 13:14    
30.5 15 9/21/2006 13:14    
31.8 15 9/21/2006 13:14    
28.9 15 9/21/2006 13:14    
29.5 15 9/21/2006 13:14    
29.2 15 9/21/2006 13:14    
30.7 15 9/21/2006 13:14    
31.2 15 9/21/2006 13:14    
31.7 15 9/21/2006 13:14    
29.4 15 9/21/2006 13:14    
39.8 15 9/21/2006 13:14    
130 15 9/21/2006 13:14    
39.7 15 9/21/2006 13:14    
48.7 15 9/21/2006 13:14    
30 15 9/21/2006 13:14    
30 15 9/21/2006 13:14    

271



Path Measurement Data 
Site 5 Path 1 

Path Measurement Data 
Site 5 Path 2 

ppm*m pathlength 
Timestamp 

(mountain time) ppm*m pathlength 
Timestamp 

(mountain time) 
29.8 15 9/21/2006 13:14    
29.8 15 9/21/2006 13:14    
35.4 15 9/21/2006 13:14    
40.1 15 9/21/2006 13:14    
36.4 15 9/21/2006 13:14    
44.8 15 9/21/2006 13:14    
49.4 15 9/21/2006 13:14    
40.6 15 9/21/2006 13:14    
54.4 15 9/21/2006 13:14    
70.6 15 9/21/2006 13:14    
174 15 9/21/2006 13:14    
231 15 9/21/2006 13:14    
214 15 9/21/2006 13:14    
269 15 9/21/2006 13:14    
132 15 9/21/2006 13:14    
126 15 9/21/2006 13:14    
117 15 9/21/2006 13:15    
93 15 9/21/2006 13:15    

65.8 15 9/21/2006 13:15    
107 15 9/21/2006 13:15    
109 15 9/21/2006 13:15    
83.3 15 9/21/2006 13:15    
80.6 15 9/21/2006 13:15    
56 15 9/21/2006 13:15    

66.4 15 9/21/2006 13:15    
73.3 15 9/21/2006 13:15    
57.7 15 9/21/2006 13:15    
39.4 15 9/21/2006 13:15    
36.7 15 9/21/2006 13:15    
44.2 15 9/21/2006 13:15    
45.7 15 9/21/2006 13:15    
37.4 15 9/21/2006 13:15    
43.7 15 9/21/2006 13:15    
53.3 15 9/21/2006 13:15    
41 15 9/21/2006 13:15    

40.3 15 9/21/2006 13:15    
36.7 15 9/21/2006 13:15    
39.8 15 9/21/2006 13:15    
38.3 15 9/21/2006 13:15    
41.8 15 9/21/2006 13:15    
78.2 15 9/21/2006 13:15    
180 15 9/21/2006 13:15    
59.2 15 9/21/2006 13:15    
32.2 15 9/21/2006 13:15    
35.3 15 9/21/2006 13:15    
34.5 15 9/21/2006 13:15    
31.6 15 9/21/2006 13:15    
31.3 15 9/21/2006 13:15    
31.2 15 9/21/2006 13:15    
61.1 15 9/21/2006 13:15    
42.4 15 9/21/2006 13:16    
62.4 15 9/21/2006 13:16    
54.7 15 9/21/2006 13:16    
50.6 15 9/21/2006 13:16    
39.2 15 9/21/2006 13:16    
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Path Measurement Data 
Site 5 Path 1 

Path Measurement Data 
Site 5 Path 2 

ppm*m pathlength 
Timestamp 

(mountain time) ppm*m pathlength 
Timestamp 

(mountain time) 
32.7 15 9/21/2006 13:16    
33.9 15 9/21/2006 13:16    
33.3 15 9/21/2006 13:16    
29.3 15 9/21/2006 13:16    
29.3 15 9/21/2006 13:16    
28.9 15 9/21/2006 13:16    
28.8 15 9/21/2006 13:16    
28.5 15 9/21/2006 13:16    
28.7 15 9/21/2006 13:16    
28.9 15 9/21/2006 13:16    
31.6 15 9/21/2006 13:16    
32.2 15 9/21/2006 13:16    
30.2 15 9/21/2006 13:16    
35.6 15 9/21/2006 13:16    
44.3 15 9/21/2006 13:16    
97.6 15 9/21/2006 13:16    
62.3 15 9/21/2006 13:16    
141 15 9/21/2006 13:16    
186 15 9/21/2006 13:16    
299 15 9/21/2006 13:16    
162 15 9/21/2006 13:16    
59.7 15 9/21/2006 13:16    
51.7 15 9/21/2006 13:16    
42.1 15 9/21/2006 13:16    
130 15 9/21/2006 13:16    
96 15 9/21/2006 13:16    

43.2 15 9/21/2006 13:16    
48.9 15 9/21/2006 13:16    
51.3 15 9/21/2006 13:16    
57.1 15 9/21/2006 13:16    
69.7 15 9/21/2006 13:17    
82.3 15 9/21/2006 13:17    
99.5 15 9/21/2006 13:17    
118 15 9/21/2006 13:17    
119 15 9/21/2006 13:17    
104 15 9/21/2006 13:17    
108 15 9/21/2006 13:17    
126 15 9/21/2006 13:17    
114 15 9/21/2006 13:17    
96 15 9/21/2006 13:17    

118 15 9/21/2006 13:17    
116 15 9/21/2006 13:17    
107 15 9/21/2006 13:17    
80.5 15 9/21/2006 13:17    
60.4 15 9/21/2006 13:17    
44.5 15 9/21/2006 13:17    
75.8 15 9/21/2006 13:17    
107 15 9/21/2006 13:17    
97.4 15 9/21/2006 13:17    
73.5 15 9/21/2006 13:17    
50.2 15 9/21/2006 13:17    
44 15 9/21/2006 13:17    

42.2 15 9/21/2006 13:17    
49.7 15 9/21/2006 13:17    
69.7 15 9/21/2006 13:17    

273



Path Measurement Data 
Site 5 Path 1 

Path Measurement Data 
Site 5 Path 2 

ppm*m pathlength 
Timestamp 

(mountain time) ppm*m pathlength 
Timestamp 

(mountain time) 
78.4 15 9/21/2006 13:17    
63.9 15 9/21/2006 13:17    
57.8 15 9/21/2006 13:17    
71.2 15 9/21/2006 13:17    
53.3 15 9/21/2006 13:17    
37.1 15 9/21/2006 13:17    
32.5 15 9/21/2006 13:17    
34.1 15 9/21/2006 13:17    
35.2 15 9/21/2006 13:17    
45 15 9/21/2006 13:18    

85.4 15 9/21/2006 13:18    
107 15 9/21/2006 13:18    
96.3 15 9/21/2006 13:18    
41.2 15 9/21/2006 13:18    
32.2 15 9/21/2006 13:18    
32.6 15 9/21/2006 13:18    
34.2 15 9/21/2006 13:18    
28.9 15 9/21/2006 13:18    
28.2 15 9/21/2006 13:18    
28 15 9/21/2006 13:18    

28.1 15 9/21/2006 13:18    
27.9 15 9/21/2006 13:18    
28.1 15 9/21/2006 13:18    
28.2 15 9/21/2006 13:18    
28.2 15 9/21/2006 13:18    
28.3 15 9/21/2006 13:18    
28.1 15 9/21/2006 13:18    
28.2 15 9/21/2006 13:18    
28.1 15 9/21/2006 13:18    
28.2 15 9/21/2006 13:18    
28 15 9/21/2006 13:18    
28 15 9/21/2006 13:18    

28.3 15 9/21/2006 13:18    
31.9 15 9/21/2006 13:18    
28.3 15 9/21/2006 13:18    
28.6 15 9/21/2006 13:18    
28.5 15 9/21/2006 13:18    
28.5 15 9/21/2006 13:18    
28.8 15 9/21/2006 13:18    
31.1 15 9/21/2006 13:18    
29.4 15 9/21/2006 13:18    
28.7 15 9/21/2006 13:18    
28.4 15 9/21/2006 13:18    
28.4 15 9/21/2006 13:19    
28.4 15 9/21/2006 13:19    
28.5 15 9/21/2006 13:19    
28.6 15 9/21/2006 13:19    
28.6 15 9/21/2006 13:19    
28.6 15 9/21/2006 13:19    
30.1 15 9/21/2006 13:19    
30.5 15 9/21/2006 13:19    
29.2 15 9/21/2006 13:19    
28.8 15 9/21/2006 13:19    
28.5 15 9/21/2006 13:19    
29.2 15 9/21/2006 13:19    
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Path Measurement Data 
Site 5 Path 1 

Path Measurement Data 
Site 5 Path 2 

ppm*m pathlength 
Timestamp 

(mountain time) ppm*m pathlength 
Timestamp 

(mountain time) 
29.9 15 9/21/2006 13:19    
32.4 15 9/21/2006 13:19    
62.6 15 9/21/2006 13:19    
105 15 9/21/2006 13:19    
104 15 9/21/2006 13:19    
61 15 9/21/2006 13:19    

48.9 15 9/21/2006 13:19    
50.3 15 9/21/2006 13:19    
83.3 15 9/21/2006 13:19    
94 15 9/21/2006 13:19    

89.9 15 9/21/2006 13:19    
82.1 15 9/21/2006 13:19    
75.8 15 9/21/2006 13:19    
78.4 15 9/21/2006 13:19    
70 15 9/21/2006 13:19    
51 15 9/21/2006 13:19    

40.5 15 9/21/2006 13:19    
61.9 15 9/21/2006 13:19    
112 15 9/21/2006 13:19    
81.8 15 9/21/2006 13:19    
84.7 15 9/21/2006 13:19    
108 15 9/21/2006 13:19    
100 15 9/21/2006 13:20    
87.5 15 9/21/2006 13:20    
95.1 15 9/21/2006 13:20    
128 15 9/21/2006 13:20    
118 15 9/21/2006 13:20    
84.3 15 9/21/2006 13:20    
61.2 15 9/21/2006 13:20    
52.7 15 9/21/2006 13:20    
45.8 15 9/21/2006 13:20    
48.9 15 9/21/2006 13:20    
83 15 9/21/2006 13:20    

100 15 9/21/2006 13:20    
50.7 15 9/21/2006 13:20    
32.7 15 9/21/2006 13:20    
30.5 15 9/21/2006 13:20    
29.2 15 9/21/2006 13:20    
29 15 9/21/2006 13:20    

28.5 15 9/21/2006 13:20    
28.4 15 9/21/2006 13:20    
28.6 15 9/21/2006 13:20    
28.5 15 9/21/2006 13:20    
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Path Measurement Data 

Site 5 Path 3 
  

ppm*m pathlength 
Timestamp 

(mountain time)    
54.3 16 9/21/2006 13:33    
83.2 16 9/21/2006 13:33    
44.6 16 9/21/2006 13:33    
58.8 16 9/21/2006 13:34    
84.7 16 9/21/2006 13:34    
72.3 16 9/21/2006 13:34    
56.1 16 9/21/2006 13:34    
54.6 16 9/21/2006 13:34    
53.1 16 9/21/2006 13:34    
48.4 16 9/21/2006 13:34    
49.7 16 9/21/2006 13:34    
46.5 16 9/21/2006 13:34    
42 16 9/21/2006 13:34    

33.9 16 9/21/2006 13:34    
34.1 16 9/21/2006 13:34    
34.1 16 9/21/2006 13:34    
33.8 16 9/21/2006 13:34    
36.6 16 9/21/2006 13:34    
39.5 16 9/21/2006 13:34    
37.2 16 9/21/2006 13:34    
37.2 16 9/21/2006 13:34    
41.9 16 9/21/2006 13:34    
61.6 16 9/21/2006 13:34    
55.7 16 9/21/2006 13:34    
75.4 16 9/21/2006 13:34    
84.7 16 9/21/2006 13:34    
65.3 16 9/21/2006 13:34    
58.2 16 9/21/2006 13:34    
63.9 16 9/21/2006 13:34    
55.5 16 9/21/2006 13:34    
41.2 16 9/21/2006 13:34    
38.4 16 9/21/2006 13:34    
37.9 16 9/21/2006 13:34    
32.5 16 9/21/2006 13:34    
31.5 16 9/21/2006 13:34    
31.4 16 9/21/2006 13:34    
31.5 16 9/21/2006 13:34    
31.5 16 9/21/2006 13:34    
31.6 16 9/21/2006 13:35    
31.3 16 9/21/2006 13:35    
31.5 16 9/21/2006 13:35    
31.1 16 9/21/2006 13:35    
31.3 16 9/21/2006 13:35    
31.3 16 9/21/2006 13:35    
31.5 16 9/21/2006 13:35    
31.3 16 9/21/2006 13:35    
31.3 16 9/21/2006 13:35    
31.3 16 9/21/2006 13:35    
31.5 16 9/21/2006 13:35    
31.3 16 9/21/2006 13:35    
31 16 9/21/2006 13:35    

31.2 16 9/21/2006 13:35    
31.3 16 9/21/2006 13:35    
31.2 16 9/21/2006 13:35    

276



Path Measurement Data 
Site 5 Path 3 

  

ppm*m pathlength 
Timestamp 

(mountain time)    
31.3 16 9/21/2006 13:35    
31.2 16 9/21/2006 13:35    
31.3 16 9/21/2006 13:35    
31.6 16 9/21/2006 13:35    
31.3 16 9/21/2006 13:35    
31.4 16 9/21/2006 13:35    
32 16 9/21/2006 13:35    

36.7 16 9/21/2006 13:35    
46.4 16 9/21/2006 13:35    
40.2 16 9/21/2006 13:35    
46.2 16 9/21/2006 13:35    
56.1 16 9/21/2006 13:35    
81.2 16 9/21/2006 13:35    
83.2 16 9/21/2006 13:35    
88.4 16 9/21/2006 13:35    
70.3 16 9/21/2006 13:35    
60.2 16 9/21/2006 13:35    
65.2 16 9/21/2006 13:35    
59 16 9/21/2006 13:36    
65 16 9/21/2006 13:36    
67 16 9/21/2006 13:36    

48.8 16 9/21/2006 13:36    
40.1 16 9/21/2006 13:36    
37 16 9/21/2006 13:36    

34.1 16 9/21/2006 13:36    
33.1 16 9/21/2006 13:36    
33.6 16 9/21/2006 13:36    
34.3 16 9/21/2006 13:36    
33.3 16 9/21/2006 13:36    
32.9 16 9/21/2006 13:36    
32.7 16 9/21/2006 13:36    
33 16 9/21/2006 13:36    
34 16 9/21/2006 13:36    

34.9 16 9/21/2006 13:36    
35.1 16 9/21/2006 13:36    
36.6 16 9/21/2006 13:36    
37.1 16 9/21/2006 13:36    
36.2 16 9/21/2006 13:36    
36.7 16 9/21/2006 13:36    
34 16 9/21/2006 13:36    

32.9 16 9/21/2006 13:36    
32.7 16 9/21/2006 13:36    
32.5 16 9/21/2006 13:36    
33.2 16 9/21/2006 13:36    
33 16 9/21/2006 13:36    

32.4 16 9/21/2006 13:36    
32.8 16 9/21/2006 13:36    
32.5 16 9/21/2006 13:36    
32.6 16 9/21/2006 13:36    
35.6 16 9/21/2006 13:36    
40.6 16 9/21/2006 13:36    
48.8 16 9/21/2006 13:36    
73.9 16 9/21/2006 13:37    
86.5 16 9/21/2006 13:37    
82.6 16 9/21/2006 13:37    
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Path Measurement Data 
Site 5 Path 3 

  

ppm*m pathlength 
Timestamp 

(mountain time)    
74.7 16 9/21/2006 13:37    
68 16 9/21/2006 13:37    

62.7 16 9/21/2006 13:37    
76.4 16 9/21/2006 13:37    
87.3 16 9/21/2006 13:37    
88.1 16 9/21/2006 13:37    
77.2 16 9/21/2006 13:37    
79 16 9/21/2006 13:37    

68.8 16 9/21/2006 13:37    
72.3 16 9/21/2006 13:37    
88.3 16 9/21/2006 13:37    
77.8 16 9/21/2006 13:37    
63.2 16 9/21/2006 13:37    
48.2 16 9/21/2006 13:37    
52.5 16 9/21/2006 13:37    
69.9 16 9/21/2006 13:37    
82.3 16 9/21/2006 13:37    
91.8 16 9/21/2006 13:37    
87 16 9/21/2006 13:37    
70 16 9/21/2006 13:37    

56.1 16 9/21/2006 13:37    
53.8 16 9/21/2006 13:37    
50.7 16 9/21/2006 13:37    
50.3 16 9/21/2006 13:37    
48.9 16 9/21/2006 13:37    
49.3 16 9/21/2006 13:37    
42.7 16 9/21/2006 13:37    
40.3 16 9/21/2006 13:37    
36.6 16 9/21/2006 13:37    
33.1 16 9/21/2006 13:37    
32.7 16 9/21/2006 13:37    
32.5 16 9/21/2006 13:38    
31.5 16 9/21/2006 13:38    
31.6 16 9/21/2006 13:38    
31.6 16 9/21/2006 13:38    
31.3 16 9/21/2006 13:38    
31.5 16 9/21/2006 13:38    
31.4 16 9/21/2006 13:38    
31.5 16 9/21/2006 13:38    
31.6 16 9/21/2006 13:38    
31.4 16 9/21/2006 13:38    
31.5 16 9/21/2006 13:38    
31.6 16 9/21/2006 13:38    
31.5 16 9/21/2006 13:38    
31.6 16 9/21/2006 13:38    
31.7 16 9/21/2006 13:38    
31.6 16 9/21/2006 13:38    
31.7 16 9/21/2006 13:38    
31.7 16 9/21/2006 13:38    
31.9 16 9/21/2006 13:38    
31.7 16 9/21/2006 13:38    
31.5 16 9/21/2006 13:38    
31.6 16 9/21/2006 13:38    
31.5 16 9/21/2006 13:38    
31.4 16 9/21/2006 13:38    

278



Path Measurement Data 
Site 5 Path 3 

  

ppm*m pathlength 
Timestamp 

(mountain time)    
31.4 16 9/21/2006 13:38    
31.6 16 9/21/2006 13:38    
31.7 16 9/21/2006 13:38    
31.6 16 9/21/2006 13:38    
31.7 16 9/21/2006 13:38    
31.6 16 9/21/2006 13:38    
31.5 16 9/21/2006 13:38    
31.7 16 9/21/2006 13:38    
31.6 16 9/21/2006 13:38    
31.4 16 9/21/2006 13:38    
31.6 16 9/21/2006 13:39    
31.6 16 9/21/2006 13:39    
31.7 16 9/21/2006 13:39    
31.7 16 9/21/2006 13:39    
31.7 16 9/21/2006 13:39    
31.4 16 9/21/2006 13:39    
31.6 16 9/21/2006 13:39    
31.7 16 9/21/2006 13:39    
31.5 16 9/21/2006 13:39    
31.4 16 9/21/2006 13:39    
31.7 16 9/21/2006 13:39    
31.6 16 9/21/2006 13:39    
31.5 16 9/21/2006 13:39    
31.6 16 9/21/2006 13:39    
31.5 16 9/21/2006 13:39    
31.4 16 9/21/2006 13:39    
31.6 16 9/21/2006 13:39    
31.7 16 9/21/2006 13:39    
31.6 16 9/21/2006 13:39    
31.6 16 9/21/2006 13:39    
31.6 16 9/21/2006 13:39    
31.7 16 9/21/2006 13:39    
31.6 16 9/21/2006 13:39    
31.7 16 9/21/2006 13:39    
31.6 16 9/21/2006 13:39    
31.7 16 9/21/2006 13:39    
31.7 16 9/21/2006 13:39    
31.6 16 9/21/2006 13:39    
31.6 16 9/21/2006 13:39    
31.7 16 9/21/2006 13:39    
31.6 16 9/21/2006 13:39    
31.6 16 9/21/2006 13:39    
31.6 16 9/21/2006 13:39    
31.6 16 9/21/2006 13:39    
31.6 16 9/21/2006 13:40    
31.6 16 9/21/2006 13:40    
31.6 16 9/21/2006 13:40    
31.5 16 9/21/2006 13:40    
31.6 16 9/21/2006 13:40    
31.5 16 9/21/2006 13:40    
31.5 16 9/21/2006 13:40    
31.7 16 9/21/2006 13:40    
31.5 16 9/21/2006 13:40    
31.6 16 9/21/2006 13:40    
31.7 16 9/21/2006 13:40    
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Path Measurement Data 
Site 5 Path 3 

  

ppm*m pathlength 
Timestamp 

(mountain time)    
31.5 16 9/21/2006 13:40    
31.5 16 9/21/2006 13:40    
31.6 16 9/21/2006 13:40    
31.4 16 9/21/2006 13:40    
31.5 16 9/21/2006 13:40    
31.4 16 9/21/2006 13:40    
31.4 16 9/21/2006 13:40    
31.7 16 9/21/2006 13:40    
31.5 16 9/21/2006 13:40    
31.5 16 9/21/2006 13:40    
31.5 16 9/21/2006 13:40    
31.6 16 9/21/2006 13:40    
31.7 16 9/21/2006 13:40    
31.6 16 9/21/2006 13:40    
31.6 16 9/21/2006 13:40    
31.5 16 9/21/2006 13:40    
31.4 16 9/21/2006 13:40    
31.4 16 9/21/2006 13:40    
31.6 16 9/21/2006 13:40    
31.5 16 9/21/2006 13:40    
31.5 16 9/21/2006 13:40    
31.6 16 9/21/2006 13:40    
31.5 16 9/21/2006 13:40    
31.6 16 9/21/2006 13:40    
31.5 16 9/21/2006 13:41    
31.6 16 9/21/2006 13:41    
31.8 16 9/21/2006 13:41    
31.6 16 9/21/2006 13:41    
31.5 16 9/21/2006 13:41    
31.7 16 9/21/2006 13:41    
31.4 16 9/21/2006 13:41    
31.6 16 9/21/2006 13:41    
31.6 16 9/21/2006 13:41    
31.5 16 9/21/2006 13:41    
31.7 16 9/21/2006 13:41    
31.6 16 9/21/2006 13:41    
31.7 16 9/21/2006 13:41    
31.5 16 9/21/2006 13:41    
31.9 16 9/21/2006 13:41    
31.7 16 9/21/2006 13:41    
31.9 16 9/21/2006 13:41    
33 16 9/21/2006 13:41    

34.4 16 9/21/2006 13:41    
37.1 16 9/21/2006 13:41    
41.1 16 9/21/2006 13:41    
60.1 16 9/21/2006 13:41    
70.8 16 9/21/2006 13:41    
63.1 16 9/21/2006 13:41    
50.2 16 9/21/2006 13:41    
54.9 16 9/21/2006 13:41    
55.1 16 9/21/2006 13:41    
55.3 16 9/21/2006 13:41    
50.8 16 9/21/2006 13:41    
43.9 16 9/21/2006 13:41    
40.2 16 9/21/2006 13:41    

280



Path Measurement Data 
Site 5 Path 3 

  

ppm*m pathlength 
Timestamp 

(mountain time)    
38 16 9/21/2006 13:41    

36.7 16 9/21/2006 13:41    
33.5 16 9/21/2006 13:41    
32.2 16 9/21/2006 13:42    
32 16 9/21/2006 13:42    

31.7 16 9/21/2006 13:42    
31.7 16 9/21/2006 13:42    
31.8 16 9/21/2006 13:42    
32 16 9/21/2006 13:42    
32 16 9/21/2006 13:42    

31.8 16 9/21/2006 13:42    
31.7 16 9/21/2006 13:42    
31.8 16 9/21/2006 13:42    
31.7 16 9/21/2006 13:42    
31.5 16 9/21/2006 13:42    
31.6 16 9/21/2006 13:42    
31.7 16 9/21/2006 13:42    
31.7 16 9/21/2006 13:42    
31.5 16 9/21/2006 13:42    
31.6 16 9/21/2006 13:42    
31.6 16 9/21/2006 13:42    
31.6 16 9/21/2006 13:42    
31.6 16 9/21/2006 13:42    
31.6 16 9/21/2006 13:42    
31.5 16 9/21/2006 13:42    
31.5 16 9/21/2006 13:42    
31.4 16 9/21/2006 13:42    
31.4 16 9/21/2006 13:42    
31.3 16 9/21/2006 13:42    
31.6 16 9/21/2006 13:42    
31.7 16 9/21/2006 13:42    
31.8 16 9/21/2006 13:42    
31.6 16 9/21/2006 13:42    
32 16 9/21/2006 13:42    

33.9 16 9/21/2006 13:42    
36.5 16 9/21/2006 13:42    
41.6 16 9/21/2006 13:42    
45.6 16 9/21/2006 13:43    
42.1 16 9/21/2006 13:43    
37.5 16 9/21/2006 13:43    
34.8 16 9/21/2006 13:43    
38 16 9/21/2006 13:43    
52 16 9/21/2006 13:43    

48.9 16 9/21/2006 13:43    
92.6 16 9/21/2006 13:43    
97.7 16 9/21/2006 13:43    
105 16 9/21/2006 13:43    
63.6 16 9/21/2006 13:43    
54.2 16 9/21/2006 13:43    
71 16 9/21/2006 13:43    

80.1 16 9/21/2006 13:43    
70.5 16 9/21/2006 13:43    
92.2 16 9/21/2006 13:43    
67.5 16 9/21/2006 13:43    
63.7 16 9/21/2006 13:43    
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Path Measurement Data 
Site 5 Path 3 

  

ppm*m pathlength 
Timestamp 

(mountain time)    
62.8 16 9/21/2006 13:43    
56.7 16 9/21/2006 13:43    
60.9 16 9/21/2006 13:43    
52.6 16 9/21/2006 13:43    
46.7 16 9/21/2006 13:43    
43.6 16 9/21/2006 13:43    
42.5 16 9/21/2006 13:43    
41.6 16 9/21/2006 13:43    
44.6 16 9/21/2006 13:43    
43.8 16 9/21/2006 13:43    
42.2 16 9/21/2006 13:43    
41.8 16 9/21/2006 13:43    
41.5 16 9/21/2006 13:43    
41.2 16 9/21/2006 13:43    
44.5 16 9/21/2006 13:43    
50.3 16 9/21/2006 13:43    
45.1 16 9/21/2006 13:44    
46.5 16 9/21/2006 13:44    
43.6 16 9/21/2006 13:44    
39.1 16 9/21/2006 13:44    
37.8 16 9/21/2006 13:44    
39.6 16 9/21/2006 13:44    
52.8 16 9/21/2006 13:44    
54.5 16 9/21/2006 13:44    
60 16 9/21/2006 13:44    
58 16 9/21/2006 13:44    

55.3 16 9/21/2006 13:44    
53.5 16 9/21/2006 13:44    
54.2 16 9/21/2006 13:44    
51.5 16 9/21/2006 13:44    
46.9 16 9/21/2006 13:44    
38.7 16 9/21/2006 13:44    
34.3 16 9/21/2006 13:44    
33.5 16 9/21/2006 13:44    
43.9 16 9/21/2006 13:44    
45.1 16 9/21/2006 13:44    
44.2 16 9/21/2006 13:44    
58.5 16 9/21/2006 13:44    
97.8 16 9/21/2006 13:44    
111 16 9/21/2006 13:44    
81.8 16 9/21/2006 13:44    
65.3 16 9/21/2006 13:44    
53.6 16 9/21/2006 13:44    
43.6 16 9/21/2006 13:44    
35 16 9/21/2006 13:44    

34.6 16 9/21/2006 13:44    
39.9 16 9/21/2006 13:44    
40.4 16 9/21/2006 13:44    
44.6 16 9/21/2006 13:44    
115 16 9/21/2006 13:44    
173 16 9/21/2006 13:45    
118 16 9/21/2006 13:45    
75.1 16 9/21/2006 13:45    
89.1 16 9/21/2006 13:45    
110 16 9/21/2006 13:45    

282



Path Measurement Data 
Site 5 Path 3 

  

ppm*m pathlength 
Timestamp 

(mountain time)    
69 16 9/21/2006 13:45    

90.6 16 9/21/2006 13:45    
121 16 9/21/2006 13:45    
72.8 16 9/21/2006 13:45    
41.5 16 9/21/2006 13:45    
38.6 16 9/21/2006 13:45    
59.3 16 9/21/2006 13:45    
55 16 9/21/2006 13:45    

44.2 16 9/21/2006 13:45    
43.5 16 9/21/2006 13:45    
43.8 16 9/21/2006 13:45    
50.7 16 9/21/2006 13:45    
47.8 16 9/21/2006 13:45    
50.6 16 9/21/2006 13:45    
57.8 16 9/21/2006 13:45    
59.9 16 9/21/2006 13:45    
55.7 16 9/21/2006 13:45    
52.6 16 9/21/2006 13:45    
46.3 16 9/21/2006 13:45    
41.5 16 9/21/2006 13:45    
39.6 16 9/21/2006 13:45    
35.8 16 9/21/2006 13:45    
35.5 16 9/21/2006 13:45    
35.5 16 9/21/2006 13:45    
37.7 16 9/21/2006 13:45    
43 16 9/21/2006 13:45    

48.5 16 9/21/2006 13:45    
56.2 16 9/21/2006 13:45    
55.8 16 9/21/2006 13:45    
46.3 16 9/21/2006 13:46    
48 16 9/21/2006 13:46    

48.4 16 9/21/2006 13:46    
44.7 16 9/21/2006 13:46    
53.4 16 9/21/2006 13:46    
74.5 16 9/21/2006 13:46    
80.5 16 9/21/2006 13:46    
81.4 16 9/21/2006 13:46    
96.7 16 9/21/2006 13:46    
94 16 9/21/2006 13:46    

79.3 16 9/21/2006 13:46    
67 16 9/21/2006 13:46    

64.9 16 9/21/2006 13:46    
56.5 16 9/21/2006 13:46    
56.6 16 9/21/2006 13:46    
50.8 16 9/21/2006 13:46    
43.8 16 9/21/2006 13:46    
40.5 16 9/21/2006 13:46    
41.9 16 9/21/2006 13:46    
40.4 16 9/21/2006 13:46    
38.9 16 9/21/2006 13:46    
37.5 16 9/21/2006 13:46    
35.4 16 9/21/2006 13:46    
34.8 16 9/21/2006 13:46    
33.6 16 9/21/2006 13:46    
33.1 16 9/21/2006 13:46    

283



Path Measurement Data 
Site 5 Path 3 

  

ppm*m pathlength 
Timestamp 

(mountain time)    
32.2 16 9/21/2006 13:46    
32.1 16 9/21/2006 13:46    
32 16 9/21/2006 13:46    

32.3 16 9/21/2006 13:46    
32.2 16 9/21/2006 13:46    
32.1 16 9/21/2006 13:46    
32 16 9/21/2006 13:46    
32 16 9/21/2006 13:46    

32.2 16 9/21/2006 13:47    
31.9 16 9/21/2006 13:47    
36.5 16 9/21/2006 13:47    
54.1 16 9/21/2006 13:47    
56.6 16 9/21/2006 13:47    
58.1 16 9/21/2006 13:47    
66.2 16 9/21/2006 13:47    
75.8 16 9/21/2006 13:47    
109 16 9/21/2006 13:47    
73.3 16 9/21/2006 13:47    
55.1 16 9/21/2006 13:47    
58.9 16 9/21/2006 13:47    
55.8 16 9/21/2006 13:47    
54.2 16 9/21/2006 13:47    
47 16 9/21/2006 13:47    

35.4 16 9/21/2006 13:47    
34.7 16 9/21/2006 13:47    
36.9 16 9/21/2006 13:47    
40.7 16 9/21/2006 13:47    
43.2 16 9/21/2006 13:47    
38.3 16 9/21/2006 13:47    
40.4 16 9/21/2006 13:47    
41.6 16 9/21/2006 13:47    
43.4 16 9/21/2006 13:47    
48.5 16 9/21/2006 13:47    
52.9 16 9/21/2006 13:47    
65.2 16 9/21/2006 13:47    
69.9 16 9/21/2006 13:47    
57.9 16 9/21/2006 13:47    
44.2 16 9/21/2006 13:47    
44 16 9/21/2006 13:47    

41.9 16 9/21/2006 13:47    
45.2 16 9/21/2006 13:47    
44.2 16 9/21/2006 13:47    
36.8 16 9/21/2006 13:48    
36.9 16 9/21/2006 13:48    
36.8 16 9/21/2006 13:48    
34.5 16 9/21/2006 13:48    
34.6 16 9/21/2006 13:48    
34.3 16 9/21/2006 13:48    
34.5 16 9/21/2006 13:48    
37.8 16 9/21/2006 13:48    
47.5 16 9/21/2006 13:48    
59.6 16 9/21/2006 13:48    
56.8 16 9/21/2006 13:48    
60.5 16 9/21/2006 13:48    
105 16 9/21/2006 13:48    
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Path Measurement Data 
Site 5 Path 3 

  

ppm*m pathlength 
Timestamp 

(mountain time)    
73.6 16 9/21/2006 13:48    
37 16 9/21/2006 13:48    

62.9 16 9/21/2006 13:48    
55.4 16 9/21/2006 13:48    
56.8 16 9/21/2006 13:48    
37.9 16 9/21/2006 13:48    
34.6 16 9/21/2006 13:48    
40.6 16 9/21/2006 13:48    
70.9 16 9/21/2006 13:48    
53.4 16 9/21/2006 13:48    
41.5 16 9/21/2006 13:48    
41 16 9/21/2006 13:48    

54.1 16 9/21/2006 13:48    
59.5 16 9/21/2006 13:48    
69.5 16 9/21/2006 13:48    
64.1 16 9/21/2006 13:48    
50.5 16 9/21/2006 13:48    
51.4 16 9/21/2006 13:48    
68.5 16 9/21/2006 13:48    
71.1 16 9/21/2006 13:48    
67.4 16 9/21/2006 13:49    
62.8 16 9/21/2006 13:49    
52.3 16 9/21/2006 13:49    
48.5 16 9/21/2006 13:49    
50.8 16 9/21/2006 13:49    
52.3 16 9/21/2006 13:49    
51.8 16 9/21/2006 13:49    
49.2 16 9/21/2006 13:49    
46.1 16 9/21/2006 13:49    
41.2 16 9/21/2006 13:49    
38.4 16 9/21/2006 13:49    
38.4 16 9/21/2006 13:49    
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Path Measurement Data 
Site 6 Path 1 

Path Measurement Data 
Site 6 Path 2 

ppm*m pathlength 
Timestamp 

(mountain time) ppm*m pathlength 
Timestamp 

(mountain time) 
39.8 10 9/22/2006 8:09 23.9 11 9/22/2006 8:39 
86.8 10 9/22/2006 8:09 24.1 11 9/22/2006 8:39 
317 10 9/22/2006 8:09 23.8 11 9/22/2006 8:39 
191 10 9/22/2006 8:09 23.9 11 9/22/2006 8:39 
102 10 9/22/2006 8:09 26.2 11 9/22/2006 8:39 
30.7 10 9/22/2006 8:10 29.5 11 9/22/2006 8:39 
21.8 10 9/22/2006 8:10 30.3 11 9/22/2006 8:39 
22.2 10 9/22/2006 8:10 28 11 9/22/2006 8:39 
22 10 9/22/2006 8:10 27.5 11 9/22/2006 8:39 

25.2 10 9/22/2006 8:10 31.1 11 9/22/2006 8:39 
23.2 10 9/22/2006 8:10 37 11 9/22/2006 8:40 
22.3 10 9/22/2006 8:10 30.8 11 9/22/2006 8:40 
21.5 10 9/22/2006 8:10 29 11 9/22/2006 8:40 
21.4 10 9/22/2006 8:10 26.9 11 9/22/2006 8:40 
20.4 10 9/22/2006 8:11 27.1 11 9/22/2006 8:40 
20.4 10 9/22/2006 8:11 27.6 11 9/22/2006 8:40 
20.3 10 9/22/2006 8:11 27.5 11 9/22/2006 8:40 
20.5 10 9/22/2006 8:11 28 11 9/22/2006 8:40 
20.5 10 9/22/2006 8:11 28.6 11 9/22/2006 8:40 
20.5 10 9/22/2006 8:11 28.3 11 9/22/2006 8:40 
20.4 10 9/22/2006 8:11 29.7 11 9/22/2006 8:40 
20.3 10 9/22/2006 8:11 27.9 11 9/22/2006 8:40 
21.3 10 9/22/2006 8:11 27.5 11 9/22/2006 8:40 
24.1 10 9/22/2006 8:12 29.8 11 9/22/2006 8:40 
25.4 10 9/22/2006 8:12 31.2 11 9/22/2006 8:40 
213 10 9/22/2006 8:12 30.6 11 9/22/2006 8:40 
127 10 9/22/2006 8:12 30.2 11 9/22/2006 8:40 
144 10 9/22/2006 8:12 27.5 11 9/22/2006 8:40 
174 10 9/22/2006 8:12 25.4 11 9/22/2006 8:40 
228 10 9/22/2006 8:12 25.3 11 9/22/2006 8:40 
99.3 10 9/22/2006 8:12 25.7 11 9/22/2006 8:40 
49.8 10 9/22/2006 8:12 24.1 11 9/22/2006 8:40 
109 10 9/22/2006 8:12 24 11 9/22/2006 8:40 
36.7 10 9/22/2006 8:12 24 11 9/22/2006 8:40 
30.5 10 9/22/2006 8:12 23.5 11 9/22/2006 8:40 
24.4 10 9/22/2006 8:12 23.5 11 9/22/2006 8:40 
23.6 10 9/22/2006 8:12 23.6 11 9/22/2006 8:40 
23.1 10 9/22/2006 8:12 24.3 11 9/22/2006 8:40 
23.4 10 9/22/2006 8:12 24.4 11 9/22/2006 8:40 
63 10 9/22/2006 8:12 24.8 11 9/22/2006 8:40 

59.1 10 9/22/2006 8:12 25.5 11 9/22/2006 8:40 
31.5 10 9/22/2006 8:12 21.8 11 9/22/2006 8:41 
35.3 10 9/22/2006 8:12 22 11 9/22/2006 8:41 
37.5 10 9/22/2006 8:12 21.9 11 9/22/2006 8:41 
20.1 10 9/22/2006 8:12 21.7 11 9/22/2006 8:42 
20.3 10 9/22/2006 8:12 21.7 11 9/22/2006 8:42 
20 10 9/22/2006 8:12 21.7 11 9/22/2006 8:42 

20.2 10 9/22/2006 8:12 21.6 11 9/22/2006 8:42 
20.1 10 9/22/2006 8:12 21.5 11 9/22/2006 8:42 
20.2 10 9/22/2006 8:12 21.5 11 9/22/2006 8:42 
20.1 10 9/22/2006 8:12 21.5 11 9/22/2006 8:42 
20.1 10 9/22/2006 8:12 21.4 11 9/22/2006 8:42 
20 10 9/22/2006 8:12 21.5 11 9/22/2006 8:42 

20.7 10 9/22/2006 8:12 21.7 11 9/22/2006 8:42 
24.1 10 9/22/2006 8:12 21.6 11 9/22/2006 8:42 
26.5 10 9/22/2006 8:12 21.6 11 9/22/2006 8:42 
23.2 10 9/22/2006 8:12 21.6 11 9/22/2006 8:42 
22.6 10 9/22/2006 8:13 21.7 11 9/22/2006 8:42 
22.4 10 9/22/2006 8:13 21.6 11 9/22/2006 8:42 
23 10 9/22/2006 8:13 21.6 11 9/22/2006 8:42 
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Path Measurement Data 
Site 6 Path 1 

Path Measurement Data 
Site 6 Path 2 

ppm*m pathlength 
Timestamp 

(mountain time) ppm*m pathlength 
Timestamp 

(mountain time) 
26.1 10 9/22/2006 8:13 21.5 11 9/22/2006 8:42 
24.4 10 9/22/2006 8:13 21.7 11 9/22/2006 8:42 
22.3 10 9/22/2006 8:13 22.5 11 9/22/2006 8:42 
21.6 10 9/22/2006 8:13 38.3 11 9/22/2006 8:42 
20.6 10 9/22/2006 8:13 186 11 9/22/2006 8:42 
20.4 10 9/22/2006 8:13 102 11 9/22/2006 8:42 
37.9 10 9/22/2006 8:13 148 11 9/22/2006 8:42 
25.8 10 9/22/2006 8:13 109 11 9/22/2006 8:42 
23.2 10 9/22/2006 8:13 137 11 9/22/2006 8:42 
29.6 10 9/22/2006 8:13 75.7 11 9/22/2006 8:42 
64.8 10 9/22/2006 8:13 26.5 11 9/22/2006 8:42 
150 10 9/22/2006 8:13 43.9 11 9/22/2006 8:42 
272 10 9/22/2006 8:13 50.1 11 9/22/2006 8:42 
191 10 9/22/2006 8:13 92.9 11 9/22/2006 8:42 
137 10 9/22/2006 8:13 55.6 11 9/22/2006 8:42 
97.1 10 9/22/2006 8:13 26.2 11 9/22/2006 8:42 
41.9 10 9/22/2006 8:13 24.2 11 9/22/2006 8:42 
23.1 10 9/22/2006 8:13 36.2 11 9/22/2006 8:42 
20.6 10 9/22/2006 8:13 77.5 11 9/22/2006 8:43 
20.3 10 9/22/2006 8:13 45.3 11 9/22/2006 8:43 
20.2 10 9/22/2006 8:13 73.9 11 9/22/2006 8:43 
20.4 10 9/22/2006 8:13 24.9 11 9/22/2006 8:43 
20.3 10 9/22/2006 8:13 21.6 11 9/22/2006 8:43 
20.3 10 9/22/2006 8:13 30.9 11 9/22/2006 8:43 
20.4 10 9/22/2006 8:13 23.5 11 9/22/2006 8:43 
20.3 10 9/22/2006 8:13 42.7 11 9/22/2006 8:43 
20.4 10 9/22/2006 8:13 22.5 11 9/22/2006 8:43 
20.4 10 9/22/2006 8:13 33.9 11 9/22/2006 8:43 
20.8 10 9/22/2006 8:13 30.1 11 9/22/2006 8:43 
20.2 10 9/22/2006 8:13 63.2 11 9/22/2006 8:43 
20.3 10 9/22/2006 8:13 54.3 11 9/22/2006 8:43 
20.7 10 9/22/2006 8:14 29.6 11 9/22/2006 8:43 
21.3 10 9/22/2006 8:14 23.2 11 9/22/2006 8:43 
21.8 10 9/22/2006 8:14 26.4 11 9/22/2006 8:43 
20.5 10 9/22/2006 8:14 44.8 11 9/22/2006 8:43 
20.5 10 9/22/2006 8:14 55.5 11 9/22/2006 8:43 
38.9 10 9/22/2006 8:14 34.7 11 9/22/2006 8:43 
56.1 10 9/22/2006 8:14 27.9 11 9/22/2006 8:43 
51.3 10 9/22/2006 8:14 49.9 11 9/22/2006 8:43 
57.6 10 9/22/2006 8:14 41 11 9/22/2006 8:43 
58.9 10 9/22/2006 8:14 31.8 11 9/22/2006 8:43 
58.3 10 9/22/2006 8:14 43.5 11 9/22/2006 8:43 
59.5 10 9/22/2006 8:14 76.7 11 9/22/2006 8:43 
51.9 10 9/22/2006 8:14 42.1 11 9/22/2006 8:43 
50.2 10 9/22/2006 8:14 74.3 11 9/22/2006 8:43 
43.5 10 9/22/2006 8:14 30.6 11 9/22/2006 8:43 
43.8 10 9/22/2006 8:14 29.8 11 9/22/2006 8:43 
73.9 10 9/22/2006 8:14 39.7 11 9/22/2006 8:43 
47.6 10 9/22/2006 8:14 31.8 11 9/22/2006 8:43 
32.1 10 9/22/2006 8:14 26.5 11 9/22/2006 8:43 
26.1 10 9/22/2006 8:14 24.4 11 9/22/2006 8:43 
22 10 9/22/2006 8:14 23 11 9/22/2006 8:43 

22.1 10 9/22/2006 8:14 22.5 11 9/22/2006 8:44 
23.7 10 9/22/2006 8:14 22.1 11 9/22/2006 8:44 
21 10 9/22/2006 8:14 22 11 9/22/2006 8:44 

20.6 10 9/22/2006 8:14 22.2 11 9/22/2006 8:44 
20.8 10 9/22/2006 8:14 22.2 11 9/22/2006 8:44 
20.6 10 9/22/2006 8:14 22.4 11 9/22/2006 8:44 
20.4 10 9/22/2006 8:14 22 11 9/22/2006 8:44 
20.5 10 9/22/2006 8:14 21.8 11 9/22/2006 8:44 
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Path Measurement Data 
Site 6 Path 1 

Path Measurement Data 
Site 6 Path 2 

ppm*m pathlength 
Timestamp 

(mountain time) ppm*m pathlength 
Timestamp 

(mountain time) 
20.2 10 9/22/2006 8:14 21.6 11 9/22/2006 8:44 
20.2 10 9/22/2006 8:14 21.6 11 9/22/2006 8:44 
20.2 10 9/22/2006 8:14 21.5 11 9/22/2006 8:44 
20.3 10 9/22/2006 8:14 21.6 11 9/22/2006 8:44 
20.2 10 9/22/2006 8:14 21.6 11 9/22/2006 8:44 
20.3 10 9/22/2006 8:15 21.6 11 9/22/2006 8:44 
20.2 10 9/22/2006 8:15 21.7 11 9/22/2006 8:44 
20.3 10 9/22/2006 8:15 21.4 11 9/22/2006 8:44 
20.2 10 9/22/2006 8:15 21.5 11 9/22/2006 8:44 
20.3 10 9/22/2006 8:15 21.6 11 9/22/2006 8:44 
20.3 10 9/22/2006 8:15 21.6 11 9/22/2006 8:44 
20.2 10 9/22/2006 8:15 21.6 11 9/22/2006 8:44 
20.2 10 9/22/2006 8:15 24.9 11 9/22/2006 8:44 
20.3 10 9/22/2006 8:15 89.4 11 9/22/2006 8:44 
20.2 10 9/22/2006 8:15 64 11 9/22/2006 8:44 
20.8 10 9/22/2006 8:15 107 11 9/22/2006 8:44 
21.8 10 9/22/2006 8:15 98.2 11 9/22/2006 8:44 
22.7 10 9/22/2006 8:15 288 11 9/22/2006 8:44 
21 10 9/22/2006 8:15 91.7 11 9/22/2006 8:44 

21.5 10 9/22/2006 8:15 69.1 11 9/22/2006 8:44 
23.4 10 9/22/2006 8:15 63.8 11 9/22/2006 8:44 
53 10 9/22/2006 8:15 55 11 9/22/2006 8:44 

77.3 10 9/22/2006 8:15 51.9 11 9/22/2006 8:44 
109 10 9/22/2006 8:15 34.5 11 9/22/2006 8:44 
52.3 10 9/22/2006 8:15 27.2 11 9/22/2006 8:44 
52.5 10 9/22/2006 8:15 121 11 9/22/2006 8:44 
41.4 10 9/22/2006 8:15 83.8 11 9/22/2006 8:45 
46 10 9/22/2006 8:15 25.3 11 9/22/2006 8:45 

29.5 10 9/22/2006 8:15 82.1 11 9/22/2006 8:45 
22.1 10 9/22/2006 8:15 48.9 11 9/22/2006 8:45 
20.9 10 9/22/2006 8:15 56.4 11 9/22/2006 8:45 
22.2 10 9/22/2006 8:15 194 11 9/22/2006 8:45 
23.5 10 9/22/2006 8:15 70.2 11 9/22/2006 8:45 
22.5 10 9/22/2006 8:15 72 11 9/22/2006 8:45 
21.9 10 9/22/2006 8:15 36.3 11 9/22/2006 8:45 
20.4 10 9/22/2006 8:15 103 11 9/22/2006 8:45 
21 10 9/22/2006 8:15 93.6 11 9/22/2006 8:45 
34 10 9/22/2006 8:15 135 11 9/22/2006 8:45 

79.7 10 9/22/2006 8:15 69.5 11 9/22/2006 8:45 
324 10 9/22/2006 8:15 109 11 9/22/2006 8:45 
83.4 10 9/22/2006 8:16 102 11 9/22/2006 8:45 
20.3 10 9/22/2006 8:16 125 11 9/22/2006 8:45 
20.1 10 9/22/2006 8:16 133 11 9/22/2006 8:45 
20.2 10 9/22/2006 8:16 79.6 11 9/22/2006 8:45 
20.7 10 9/22/2006 8:16 62.8 11 9/22/2006 8:45 
21.2 10 9/22/2006 8:16 38.3 11 9/22/2006 8:45 
24.8 10 9/22/2006 8:16 32.5 11 9/22/2006 8:45 
23.5 10 9/22/2006 8:16 31 11 9/22/2006 8:45 
30 10 9/22/2006 8:16 30.3 11 9/22/2006 8:45 

27.5 10 9/22/2006 8:16 28.8 11 9/22/2006 8:45 
105 10 9/22/2006 8:16 28.9 11 9/22/2006 8:45 
35.1 10 9/22/2006 8:16 30.8 11 9/22/2006 8:45 
79.8 10 9/22/2006 8:16 37.5 11 9/22/2006 8:45 
310 10 9/22/2006 8:16 29.1 11 9/22/2006 8:45 
54.4 10 9/22/2006 8:16 26.7 11 9/22/2006 8:45 
37.8 10 9/22/2006 8:16 45.1 11 9/22/2006 8:45 
34.1 10 9/22/2006 8:16 127 11 9/22/2006 8:45 
24.4 10 9/22/2006 8:16 24.3 11 9/22/2006 8:45 
22.5 10 9/22/2006 8:16 42.3 11 9/22/2006 8:45 
22.1 10 9/22/2006 8:16 84.1 11 9/22/2006 8:45 
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Path Measurement Data 
Site 6 Path 1 

Path Measurement Data 
Site 6 Path 2 

ppm*m pathlength 
Timestamp 

(mountain time) ppm*m pathlength 
Timestamp 

(mountain time) 
20.9 10 9/22/2006 8:16 70.9 11 9/22/2006 8:46 
20.7 10 9/22/2006 8:16 45.4 11 9/22/2006 8:46 
20.7 10 9/22/2006 8:16 69.8 11 9/22/2006 8:46 
20.3 10 9/22/2006 8:16 45.3 11 9/22/2006 8:46 
20.4 10 9/22/2006 8:16 82.6 11 9/22/2006 8:46 
20.3 10 9/22/2006 8:16 86 11 9/22/2006 8:46 
20.3 10 9/22/2006 8:16 71.2 11 9/22/2006 8:46 
21.6 10 9/22/2006 8:16 47.1 11 9/22/2006 8:46 
20.4 10 9/22/2006 8:16 38.8 11 9/22/2006 8:46 
20.1 10 9/22/2006 8:16 33.8 11 9/22/2006 8:46 
19.9 10 9/22/2006 8:16 30.6 11 9/22/2006 8:46 
20.1 10 9/22/2006 8:16 28.9 11 9/22/2006 8:46 
19.9 10 9/22/2006 8:16 30 11 9/22/2006 8:46 
19.9 10 9/22/2006 8:16 32.6 11 9/22/2006 8:46 
20 10 9/22/2006 8:17 31.3 11 9/22/2006 8:46 
20 10 9/22/2006 8:17 31.9 11 9/22/2006 8:46 
20 10 9/22/2006 8:17 30.8 11 9/22/2006 8:46 

19.9 10 9/22/2006 8:17 30.3 11 9/22/2006 8:46 
19.8 10 9/22/2006 8:17 30.6 11 9/22/2006 8:46 
19.9 10 9/22/2006 8:17 26.6 11 9/22/2006 8:46 
19.9 10 9/22/2006 8:17 25.6 11 9/22/2006 8:46 
19.8 10 9/22/2006 8:17 24.7 11 9/22/2006 8:46 
20 10 9/22/2006 8:17 24.1 11 9/22/2006 8:46 

24.2 10 9/22/2006 8:17 26.8 11 9/22/2006 8:46 
21.5 10 9/22/2006 8:17 41 11 9/22/2006 8:46 
22.4 10 9/22/2006 8:17 42.5 11 9/22/2006 8:46 
22.3 10 9/22/2006 8:17 43.6 11 9/22/2006 8:46 
22 10 9/22/2006 8:17 31.4 11 9/22/2006 8:46 

21.4 10 9/22/2006 8:17 38.9 11 9/22/2006 8:46 
21.5 10 9/22/2006 8:17 73.8 11 9/22/2006 8:46 
21.2 10 9/22/2006 8:17 121 11 9/22/2006 8:46 
22.7 10 9/22/2006 8:17 176 11 9/22/2006 8:46 
21.3 10 9/22/2006 8:17 178 11 9/22/2006 8:46 
20.9 10 9/22/2006 8:17 134 11 9/22/2006 8:46 
21 10 9/22/2006 8:17 129 11 9/22/2006 8:47 

20.2 10 9/22/2006 8:17 108 11 9/22/2006 8:47 
20.6 10 9/22/2006 8:17 77.7 11 9/22/2006 8:47 
79.3 10 9/22/2006 8:17 92.4 11 9/22/2006 8:47 
336 10 9/22/2006 8:17 56.9 11 9/22/2006 8:47 
57.6 10 9/22/2006 8:17 33.5 11 9/22/2006 8:47 
243 10 9/22/2006 8:17 27.4 11 9/22/2006 8:47 
92.9 10 9/22/2006 8:17 27.3 11 9/22/2006 8:47 
98.6 10 9/22/2006 8:17 26.5 11 9/22/2006 8:47 
102 10 9/22/2006 8:17 43.2 11 9/22/2006 8:47 
182 10 9/22/2006 8:17 27.7 11 9/22/2006 8:47 
146 10 9/22/2006 8:17 27.1 11 9/22/2006 8:47 
173 10 9/22/2006 8:17 25.8 11 9/22/2006 8:47 
241 10 9/22/2006 8:17 33.2 11 9/22/2006 8:47 
151 10 9/22/2006 8:18 24.3 11 9/22/2006 8:47 
45.3 10 9/22/2006 8:18 41.6 11 9/22/2006 8:47 
39.5 10 9/22/2006 8:18 59.1 11 9/22/2006 8:47 
41.7 10 9/22/2006 8:18 27.7 11 9/22/2006 8:47 
119 10 9/22/2006 8:18 26.4 11 9/22/2006 8:47 
88.9 10 9/22/2006 8:18 24.7 11 9/22/2006 8:47 
61.6 10 9/22/2006 8:18 25.9 11 9/22/2006 8:47 
76.7 10 9/22/2006 8:18 38.5 11 9/22/2006 8:47 
93.6 10 9/22/2006 8:18 29.5 11 9/22/2006 8:47 
86.6 10 9/22/2006 8:18 32.9 11 9/22/2006 8:47 
89.9 10 9/22/2006 8:18 86 11 9/22/2006 8:47 
60.3 10 9/22/2006 8:18 194 11 9/22/2006 8:47 
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Path Measurement Data 
Site 6 Path 1 

Path Measurement Data 
Site 6 Path 2 

ppm*m pathlength 
Timestamp 

(mountain time) ppm*m pathlength 
Timestamp 

(mountain time) 
53.8 10 9/22/2006 8:18 37.4 11 9/22/2006 8:47 
49.5 10 9/22/2006 8:18 31.8 11 9/22/2006 8:47 
47.2 10 9/22/2006 8:18 23.3 11 9/22/2006 8:47 
45.1 10 9/22/2006 8:18 23.2 11 9/22/2006 8:47 
45.9 10 9/22/2006 8:18 23.1 11 9/22/2006 8:47 
59.8 10 9/22/2006 8:18 23 11 9/22/2006 8:47 
142 10 9/22/2006 8:18 22.9 11 9/22/2006 8:47 
90.2 10 9/22/2006 8:18 22.9 11 9/22/2006 8:47 
43.9 10 9/22/2006 8:18 23.5 11 9/22/2006 8:48 
25.3 10 9/22/2006 8:18 23.2 11 9/22/2006 8:48 
26 10 9/22/2006 8:18 23.2 11 9/22/2006 8:48 

22.9 10 9/22/2006 8:18 23.9 11 9/22/2006 8:48 
21.3 10 9/22/2006 8:18 23.5 11 9/22/2006 8:48 
20.8 10 9/22/2006 8:18 23.8 11 9/22/2006 8:48 
24.9 10 9/22/2006 8:18 25 11 9/22/2006 8:48 
29.4 10 9/22/2006 8:18 24 11 9/22/2006 8:48 
63 10 9/22/2006 8:18 23.4 11 9/22/2006 8:48 

23.6 10 9/22/2006 8:18 23.6 11 9/22/2006 8:48 
20.5 10 9/22/2006 8:18 23.1 11 9/22/2006 8:48 
20.2 10 9/22/2006 8:18 22.8 11 9/22/2006 8:48 
20.2 10 9/22/2006 8:18 22.9 11 9/22/2006 8:48 
21.5 10 9/22/2006 8:18 22.8 11 9/22/2006 8:48 
20.7 10 9/22/2006 8:19 23 11 9/22/2006 8:48 
20.4 10 9/22/2006 8:19 23.4 11 9/22/2006 8:48 
21.6 10 9/22/2006 8:19 23.3 11 9/22/2006 8:48 
21.7 10 9/22/2006 8:19 23.2 11 9/22/2006 8:48 
23.1 10 9/22/2006 8:19 23.4 11 9/22/2006 8:48 
22.8 10 9/22/2006 8:19 23.8 11 9/22/2006 8:48 
22.3 10 9/22/2006 8:19 24.4 11 9/22/2006 8:48 
21.5 10 9/22/2006 8:19 24.4 11 9/22/2006 8:48 
21.3 10 9/22/2006 8:19 24.2 11 9/22/2006 8:48 
29.8 10 9/22/2006 8:19 24.2 11 9/22/2006 8:48 
20.6 10 9/22/2006 8:19 23.8 11 9/22/2006 8:48 
19.9 10 9/22/2006 8:19 24.1 11 9/22/2006 8:48 
20 10 9/22/2006 8:19 24.6 11 9/22/2006 8:48 

20.1 10 9/22/2006 8:19 24.3 11 9/22/2006 8:48 
19.9 10 9/22/2006 8:19 23.7 11 9/22/2006 8:48 
20 10 9/22/2006 8:19 23.7 11 9/22/2006 8:48 
21 10 9/22/2006 8:19 23.6 11 9/22/2006 8:48 

21.6 10 9/22/2006 8:19 23.6 11 9/22/2006 8:48 
20.7 10 9/22/2006 8:19 23.1 11 9/22/2006 8:48 
20.3 10 9/22/2006 8:19 22.9 11 9/22/2006 8:48 
20.2 10 9/22/2006 8:19 22.8 11 9/22/2006 8:49 
19.9 10 9/22/2006 8:19 23 11 9/22/2006 8:49 
31.5 10 9/22/2006 8:19 23.1 11 9/22/2006 8:49 
30.7 10 9/22/2006 8:19 24.4 11 9/22/2006 8:49 
21.5 10 9/22/2006 8:19 26.3 11 9/22/2006 8:49 
20.3 10 9/22/2006 8:19 22.7 11 9/22/2006 8:49 
19.8 10 9/22/2006 8:19 22.5 11 9/22/2006 8:49 
19.8 10 9/22/2006 8:19 22.5 11 9/22/2006 8:49 
20.2 10 9/22/2006 8:19 22.6 11 9/22/2006 8:49 
20.1 10 9/22/2006 8:19 22.1 11 9/22/2006 8:49 
19.9 10 9/22/2006 8:19 22.3 11 9/22/2006 8:49 
19.8 10 9/22/2006 8:19 22 11 9/22/2006 8:49 
19.9 10 9/22/2006 8:19 22.3 11 9/22/2006 8:49 
20.4 10 9/22/2006 8:19 22.4 11 9/22/2006 8:49 
21.2 10 9/22/2006 8:20 22.4 11 9/22/2006 8:49 
20.3 10 9/22/2006 8:20 22.5 11 9/22/2006 8:49 
21.4 10 9/22/2006 8:20 23.5 11 9/22/2006 8:49 
21.7 10 9/22/2006 8:20 30.9 11 9/22/2006 8:49 
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Path Measurement Data 
Site 6 Path 1 

Path Measurement Data 
Site 6 Path 2 

ppm*m pathlength 
Timestamp 

(mountain time) ppm*m pathlength 
Timestamp 

(mountain time) 
21.6 10 9/22/2006 8:20 47 11 9/22/2006 8:49 
23.6 10 9/22/2006 8:20 24.3 11 9/22/2006 8:49 
23.5 10 9/22/2006 8:20 25.3 11 9/22/2006 8:49 
25.1 10 9/22/2006 8:20 26.3 11 9/22/2006 8:49 
33.4 10 9/22/2006 8:20 34.4 11 9/22/2006 8:49 
26.4 10 9/22/2006 8:20 35.7 11 9/22/2006 8:49 
21.3 10 9/22/2006 8:20 26.4 11 9/22/2006 8:49 
20.3 10 9/22/2006 8:20 58.9 11 9/22/2006 8:49 
20.6 10 9/22/2006 8:20 73 11 9/22/2006 8:49 
32.3 10 9/22/2006 8:20 83 11 9/22/2006 8:49 
67.9 10 9/22/2006 8:20 88.1 11 9/22/2006 8:49 
38.3 10 9/22/2006 8:20 108 11 9/22/2006 8:49 
109 10 9/22/2006 8:20 35.2 11 9/22/2006 8:49 
95.9 10 9/22/2006 8:20 44.8 11 9/22/2006 8:49 
33.7 10 9/22/2006 8:20 52.2 11 9/22/2006 8:49 
25 10 9/22/2006 8:20 39.8 11 9/22/2006 8:49 

21.1 10 9/22/2006 8:20 53.8 11 9/22/2006 8:50 
20.4 10 9/22/2006 8:20 93.6 11 9/22/2006 8:50 
20.4 10 9/22/2006 8:20 62.3 11 9/22/2006 8:50 
21.5 10 9/22/2006 8:20 63.7 11 9/22/2006 8:50 
72.1 10 9/22/2006 8:20 100 11 9/22/2006 8:50 
57.3 10 9/22/2006 8:20 35.9 11 9/22/2006 8:50 
50.7 10 9/22/2006 8:20 44.9 11 9/22/2006 8:50 
62.4 10 9/22/2006 8:20 53.2 11 9/22/2006 8:50 
32.1 10 9/22/2006 8:20 37.7 11 9/22/2006 8:50 
46.7 10 9/22/2006 8:20 90.5 11 9/22/2006 8:50 
86.3 10 9/22/2006 8:20 25.8 11 9/22/2006 8:50 
26.1 10 9/22/2006 8:20 23.1 11 9/22/2006 8:50 
24 10 9/22/2006 8:20 22.5 11 9/22/2006 8:50 

23.5 10 9/22/2006 8:20 22.7 11 9/22/2006 8:50 
100 10 9/22/2006 8:21 23.1 11 9/22/2006 8:50 
184 10 9/22/2006 8:21 24.1 11 9/22/2006 8:50 
129 10 9/22/2006 8:21 22 11 9/22/2006 8:50 
102 10 9/22/2006 8:21 21.9 11 9/22/2006 8:50 
33.1 10 9/22/2006 8:21 21.9 11 9/22/2006 8:50 
22.5 10 9/22/2006 8:21 22.4 11 9/22/2006 8:50 
147 10 9/22/2006 8:21 22.6 11 9/22/2006 8:50 
44 10 9/22/2006 8:21 22.9 11 9/22/2006 8:50 
58 10 9/22/2006 8:21 23.1 11 9/22/2006 8:50 

91.9 10 9/22/2006 8:21 22.7 11 9/22/2006 8:50 
32.3 10 9/22/2006 8:21 22 11 9/22/2006 8:50 
27.3 10 9/22/2006 8:21 22 11 9/22/2006 8:50 
26 10 9/22/2006 8:21 22 11 9/22/2006 8:50 
22 10 9/22/2006 8:21 22.3 11 9/22/2006 8:50 

20.9 10 9/22/2006 8:21 26 11 9/22/2006 8:50 
21.2 10 9/22/2006 8:21 22.2 11 9/22/2006 8:50 
21.7 10 9/22/2006 8:21 21.8 11 9/22/2006 8:50 
21.1 10 9/22/2006 8:21 21.8 11 9/22/2006 8:50 
25.2 10 9/22/2006 8:21 22 11 9/22/2006 8:50 
21.4 10 9/22/2006 8:21 21.9 11 9/22/2006 8:50 
22.6 10 9/22/2006 8:21 21.9 11 9/22/2006 8:51 
24.6 10 9/22/2006 8:21 23 11 9/22/2006 8:51 
26.4 10 9/22/2006 8:21 23.6 11 9/22/2006 8:51 
24.1 10 9/22/2006 8:21 27.1 11 9/22/2006 8:51 
21.7 10 9/22/2006 8:21 30.3 11 9/22/2006 8:51 
21.4 10 9/22/2006 8:21 28.9 11 9/22/2006 8:51 
21.2 10 9/22/2006 8:21 27.2 11 9/22/2006 8:51 
21.1 10 9/22/2006 8:21 26 11 9/22/2006 8:51 
20.6 10 9/22/2006 8:21 30.2 11 9/22/2006 8:51 
20.4 10 9/22/2006 8:21 38 11 9/22/2006 8:51 
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Path Measurement Data 
Site 6 Path 1 

Path Measurement Data 
Site 6 Path 2 

ppm*m pathlength 
Timestamp 

(mountain time) ppm*m pathlength 
Timestamp 

(mountain time) 
20.2 10 9/22/2006 8:21 37.5 11 9/22/2006 8:51 
20.2 10 9/22/2006 8:21 31.1 11 9/22/2006 8:51 
20.3 10 9/22/2006 8:21 26.3 11 9/22/2006 8:51 
20.5 10 9/22/2006 8:21 23.2 11 9/22/2006 8:51 
22.1 10 9/22/2006 8:22 25 11 9/22/2006 8:51 
28.6 10 9/22/2006 8:22 24.9 11 9/22/2006 8:51 
58.8 10 9/22/2006 8:22 28.1 11 9/22/2006 8:51 
43.3 10 9/22/2006 8:22 36.9 11 9/22/2006 8:51 
73.1 10 9/22/2006 8:22 30.8 11 9/22/2006 8:51 
44.7 10 9/22/2006 8:22 27.5 11 9/22/2006 8:51 
595 10 9/22/2006 8:22 25.7 11 9/22/2006 8:51 
190 10 9/22/2006 8:22 25.8 11 9/22/2006 8:51 
71.1 10 9/22/2006 8:22 27.9 11 9/22/2006 8:51 
56 10 9/22/2006 8:22 42.8 11 9/22/2006 8:51 

58.7 10 9/22/2006 8:22 30.8 11 9/22/2006 8:51 
24.4 10 9/22/2006 8:22 36 11 9/22/2006 8:51 
22.6 10 9/22/2006 8:22 42.5 11 9/22/2006 8:51 
22 10 9/22/2006 8:22 37.4 11 9/22/2006 8:51 

26.7 10 9/22/2006 8:22 36.4 11 9/22/2006 8:51 
35.9 10 9/22/2006 8:22 37.7 11 9/22/2006 8:51 
114 10 9/22/2006 8:22 39.6 11 9/22/2006 8:51 
118 10 9/22/2006 8:22 38.8 11 9/22/2006 8:51 
505 10 9/22/2006 8:22 40.1 11 9/22/2006 8:51 
235 10 9/22/2006 8:22 38.2 11 9/22/2006 8:51 
102 10 9/22/2006 8:22 36.4 11 9/22/2006 8:51 
36.3 10 9/22/2006 8:22 35.3 11 9/22/2006 8:52 
35.7 10 9/22/2006 8:22 41.1 11 9/22/2006 8:52 
23.9 10 9/22/2006 8:22 81.3 11 9/22/2006 8:52 
79.7 10 9/22/2006 8:22 96.3 11 9/22/2006 8:52 
103 10 9/22/2006 8:22 84 11 9/22/2006 8:52 
92.5 10 9/22/2006 8:22 36.9 11 9/22/2006 8:52 
139 10 9/22/2006 8:22 23 11 9/22/2006 8:52 
163 10 9/22/2006 8:22 22.7 11 9/22/2006 8:52 
31 10 9/22/2006 8:22 22.4 11 9/22/2006 8:52 

20.7 10 9/22/2006 8:22 22.3 11 9/22/2006 8:52 
20.6 10 9/22/2006 8:22 22 11 9/22/2006 8:52 
21 10 9/22/2006 8:22 83.4 11 9/22/2006 8:52 

20.8 10 9/22/2006 8:22 48.4 11 9/22/2006 8:52 
20.8 10 9/22/2006 8:23 156 11 9/22/2006 8:52 
20.9 10 9/22/2006 8:23 143 11 9/22/2006 8:52 
21 10 9/22/2006 8:23 104 11 9/22/2006 8:52 

21.4 10 9/22/2006 8:23 45.8 11 9/22/2006 8:52 
21.5 10 9/22/2006 8:23 33 11 9/22/2006 8:52 
21.8 10 9/22/2006 8:23 31.2 11 9/22/2006 8:52 
21.8 10 9/22/2006 8:23 38.3 11 9/22/2006 8:52 
21.5 10 9/22/2006 8:23 68.7 11 9/22/2006 8:52 
21.3 10 9/22/2006 8:23 48.8 11 9/22/2006 8:52 
21.2 10 9/22/2006 8:23 43.9 11 9/22/2006 8:52 
21.3 10 9/22/2006 8:23 23.6 11 9/22/2006 8:52 
21.3 10 9/22/2006 8:23 22.5 11 9/22/2006 8:52 
21.4 10 9/22/2006 8:23 21.9 11 9/22/2006 8:52 
21.2 10 9/22/2006 8:23 22.9 11 9/22/2006 8:52 
22.1 10 9/22/2006 8:23 23.7 11 9/22/2006 8:52 
133 10 9/22/2006 8:23 29 11 9/22/2006 8:52 
481 10 9/22/2006 8:23 43.3 11 9/22/2006 8:52 
269 10 9/22/2006 8:23 54.3 11 9/22/2006 8:52 
167 10 9/22/2006 8:23 65.2 11 9/22/2006 8:52 
121 10 9/22/2006 8:23 110 11 9/22/2006 8:52 
98.7 10 9/22/2006 8:23 108 11 9/22/2006 8:53 
84.8 10 9/22/2006 8:23 73.4 11 9/22/2006 8:53 
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Path Measurement Data 
Site 6 Path 1 

Path Measurement Data 
Site 6 Path 2 

ppm*m pathlength 
Timestamp 

(mountain time) ppm*m pathlength 
Timestamp 

(mountain time) 
183 10 9/22/2006 8:23 54 11 9/22/2006 8:53 
186 10 9/22/2006 8:23 41.5 11 9/22/2006 8:53 
211 10 9/22/2006 8:23 51.6 11 9/22/2006 8:53 
164 10 9/22/2006 8:23 242 11 9/22/2006 8:53 
200 10 9/22/2006 8:23 132 11 9/22/2006 8:53 
175 10 9/22/2006 8:23 125 11 9/22/2006 8:53 
177 10 9/22/2006 8:23 135 11 9/22/2006 8:53 
160 10 9/22/2006 8:23 117 11 9/22/2006 8:53 
137 10 9/22/2006 8:23 132 11 9/22/2006 8:53 
127 10 9/22/2006 8:23 52.3 11 9/22/2006 8:53 
118 10 9/22/2006 8:23 31.6 11 9/22/2006 8:53 
96.8 10 9/22/2006 8:23 26.8 11 9/22/2006 8:53 
82.6 10 9/22/2006 8:24 25.7 11 9/22/2006 8:53 
54.6 10 9/22/2006 8:24 29.7 11 9/22/2006 8:53 
37.4 10 9/22/2006 8:24 24.8 11 9/22/2006 8:53 
29.5 10 9/22/2006 8:24 26 11 9/22/2006 8:53 
25.5 10 9/22/2006 8:24 27.7 11 9/22/2006 8:53 
24 10 9/22/2006 8:24 27.5 11 9/22/2006 8:53 

23.4 10 9/22/2006 8:24 23.5 11 9/22/2006 8:53 
24 10 9/22/2006 8:24 21.7 11 9/22/2006 8:53 

23.1 10 9/22/2006 8:24 21.8 11 9/22/2006 8:53 
22.7 10 9/22/2006 8:24 22.4 11 9/22/2006 8:53 
23.4 10 9/22/2006 8:24 22.2 11 9/22/2006 8:53 
24.9 10 9/22/2006 8:24 22.3 11 9/22/2006 8:53 
27.5 10 9/22/2006 8:24 22.4 11 9/22/2006 8:53 
29.8 10 9/22/2006 8:24 22.4 11 9/22/2006 8:53 
32.1 10 9/22/2006 8:24 22.4 11 9/22/2006 8:53 
50.5 10 9/22/2006 8:24 22.3 11 9/22/2006 8:53 
780 10 9/22/2006 8:24 22.4 11 9/22/2006 8:53 
263 10 9/22/2006 8:24 23.1 11 9/22/2006 8:53 
201 10 9/22/2006 8:24 23.3 11 9/22/2006 8:53 
216 10 9/22/2006 8:24 22.9 11 9/22/2006 8:53 
139 10 9/22/2006 8:24 22.7 11 9/22/2006 8:54 
180 10 9/22/2006 8:24 23.5 11 9/22/2006 8:54 
170 10 9/22/2006 8:24 25.2 11 9/22/2006 8:54 
105 10 9/22/2006 8:24 27.2 11 9/22/2006 8:54 
92 10 9/22/2006 8:24 28.5 11 9/22/2006 8:54 

77.1 10 9/22/2006 8:24 29.4 11 9/22/2006 8:54 
56.5 10 9/22/2006 8:24 28.1 11 9/22/2006 8:54 
48.5 10 9/22/2006 8:24 27 11 9/22/2006 8:54 
45.3 10 9/22/2006 8:24 26.3 11 9/22/2006 8:54 
46.1 10 9/22/2006 8:24 26.1 11 9/22/2006 8:54 
38.7 10 9/22/2006 8:24 24.8 11 9/22/2006 8:54 
32.1 10 9/22/2006 8:24 48.8 11 9/22/2006 8:54 
27.3 10 9/22/2006 8:24 86.7 11 9/22/2006 8:54 
26.8 10 9/22/2006 8:25 145 11 9/22/2006 8:54 
27.3 10 9/22/2006 8:25 105 11 9/22/2006 8:54 
27.4 10 9/22/2006 8:25 120 11 9/22/2006 8:54 
32.5 10 9/22/2006 8:25 57.1 11 9/22/2006 8:54 
28.2 10 9/22/2006 8:25 57.4 11 9/22/2006 8:54 
21.6 10 9/22/2006 8:25 39.7 11 9/22/2006 8:54 
21.4 10 9/22/2006 8:25 41 11 9/22/2006 8:54 
22.1 10 9/22/2006 8:25 33.3 11 9/22/2006 8:54 
23.5 10 9/22/2006 8:25 28.5 11 9/22/2006 8:54 
24.2 10 9/22/2006 8:25 26.2 11 9/22/2006 8:54 
24.3 10 9/22/2006 8:25 26 11 9/22/2006 8:54 
22.9 10 9/22/2006 8:25 26.8 11 9/22/2006 8:54 
25.5 10 9/22/2006 8:25 40.9 11 9/22/2006 8:54 
27.7 10 9/22/2006 8:25 34.8 11 9/22/2006 8:54 
30.3 10 9/22/2006 8:25 42.5 11 9/22/2006 8:54 
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Path Measurement Data 
Site 6 Path 1 

Path Measurement Data 
Site 6 Path 2 

ppm*m pathlength 
Timestamp 

(mountain time) ppm*m pathlength 
Timestamp 

(mountain time) 
38 10 9/22/2006 8:25 39.5 11 9/22/2006 8:54 

33.2 10 9/22/2006 8:25 54.2 11 9/22/2006 8:54 
27.1 10 9/22/2006 8:25 37.6 11 9/22/2006 8:54 
32.9 10 9/22/2006 8:25 68.3 11 9/22/2006 8:54 
29.2 10 9/22/2006 8:25 104 11 9/22/2006 8:54 
27.2 10 9/22/2006 8:25 51.1 11 9/22/2006 8:54 
23.7 10 9/22/2006 8:25 79.8 11 9/22/2006 8:54 
22.6 10 9/22/2006 8:25 109 11 9/22/2006 8:55 
22.5 10 9/22/2006 8:25 82.6 11 9/22/2006 8:55 
22.9 10 9/22/2006 8:25 109 11 9/22/2006 8:55 
22.2 10 9/22/2006 8:25 81.9 11 9/22/2006 8:55 
21.9 10 9/22/2006 8:25 49.1 11 9/22/2006 8:55 
21.2 10 9/22/2006 8:25 45.7 11 9/22/2006 8:55 
21 10 9/22/2006 8:25 33.9 11 9/22/2006 8:55 

21.4 10 9/22/2006 8:25 29.6 11 9/22/2006 8:55 
23.7 10 9/22/2006 8:25 27.6 11 9/22/2006 8:55 
43.9 10 9/22/2006 8:25 25.1 11 9/22/2006 8:55 
32.2 10 9/22/2006 8:25 24.5 11 9/22/2006 8:55 
66.3 10 9/22/2006 8:25 24.1 11 9/22/2006 8:55 
35.2 10 9/22/2006 8:25 24 11 9/22/2006 8:55 
36.5 10 9/22/2006 8:26 38.9 11 9/22/2006 8:55 
34.3 10 9/22/2006 8:26 25.1 11 9/22/2006 8:55 
26.5 10 9/22/2006 8:26 25.1 11 9/22/2006 8:55 
25.5 10 9/22/2006 8:26 23.7 11 9/22/2006 8:55 
39.6 10 9/22/2006 8:26 23.7 11 9/22/2006 8:55 
35.3 10 9/22/2006 8:26 31.5 11 9/22/2006 8:55 
30.4 10 9/22/2006 8:26 43.8 11 9/22/2006 8:55 
106 10 9/22/2006 8:26 31.1 11 9/22/2006 8:55 
40.3 10 9/22/2006 8:26 43.2 11 9/22/2006 8:55 
23.3 10 9/22/2006 8:26 32.4 11 9/22/2006 8:55 
50.4 10 9/22/2006 8:26 75.1 11 9/22/2006 8:55 
45.7 10 9/22/2006 8:26 94.3 11 9/22/2006 8:55 
144 10 9/22/2006 8:26 44.4 11 9/22/2006 8:55 
170 10 9/22/2006 8:26 36.7 11 9/22/2006 8:55 
86.7 10 9/22/2006 8:26 54.6 11 9/22/2006 8:55 
124 10 9/22/2006 8:26 96.5 11 9/22/2006 8:55 
74.1 10 9/22/2006 8:26 63 11 9/22/2006 8:55 
75.4 10 9/22/2006 8:26 32.2 11 9/22/2006 8:55 
102 10 9/22/2006 8:26 45.8 11 9/22/2006 8:55 
98.1 10 9/22/2006 8:26 25.4 11 9/22/2006 8:55 
69.1 10 9/22/2006 8:26 33.6 11 9/22/2006 8:56 
56.9 10 9/22/2006 8:26 36.3 11 9/22/2006 8:56 
40.4 10 9/22/2006 8:26 46.7 11 9/22/2006 8:56 
33.5 10 9/22/2006 8:26 24 11 9/22/2006 8:56 
32.1 10 9/22/2006 8:26 23.6 11 9/22/2006 8:56 
31.5 10 9/22/2006 8:26 22.3 11 9/22/2006 8:56 
25.2 10 9/22/2006 8:26 69.2 11 9/22/2006 8:56 
20.9 10 9/22/2006 8:26 41.4 11 9/22/2006 8:56 
20.3 10 9/22/2006 8:26 81 11 9/22/2006 8:56 
20.5 10 9/22/2006 8:26 43.3 11 9/22/2006 8:56 
20.7 10 9/22/2006 8:26 32.5 11 9/22/2006 8:56 
20.5 10 9/22/2006 8:26 35.3 11 9/22/2006 8:56 
20.4 10 9/22/2006 8:26 121 11 9/22/2006 8:56 
20.5 10 9/22/2006 8:27 75.5 11 9/22/2006 8:56 
20.4 10 9/22/2006 8:27 59.6 11 9/22/2006 8:56 
20.5 10 9/22/2006 8:27 34.9 11 9/22/2006 8:56 
20.6 10 9/22/2006 8:27 27.3 11 9/22/2006 8:56 
20.4 10 9/22/2006 8:27 25.7 11 9/22/2006 8:56 
20.8 10 9/22/2006 8:27 22.8 11 9/22/2006 8:56 
21.8 10 9/22/2006 8:27 22.6 11 9/22/2006 8:56 
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Path Measurement Data 
Site 6 Path 1 

Path Measurement Data 
Site 6 Path 2 

ppm*m pathlength 
Timestamp 

(mountain time) ppm*m pathlength 
Timestamp 

(mountain time) 
23.7 10 9/22/2006 8:27 22.4 11 9/22/2006 8:56 
28.2 10 9/22/2006 8:27 26.6 11 9/22/2006 8:56 
30.9 10 9/22/2006 8:27 22.1 11 9/22/2006 8:56 
32.3 10 9/22/2006 8:27 52.1 11 9/22/2006 8:56 
33.1 10 9/22/2006 8:27 48.1 11 9/22/2006 8:56 
33.3 10 9/22/2006 8:27 24.7 11 9/22/2006 8:56 
34.4 10 9/22/2006 8:27 23 11 9/22/2006 8:56 
33.9 10 9/22/2006 8:27 21.8 11 9/22/2006 8:56 
32.8 10 9/22/2006 8:27 23.4 11 9/22/2006 8:56 
31.5 10 9/22/2006 8:27 24 11 9/22/2006 8:56 
31.1 10 9/22/2006 8:27 24.3 11 9/22/2006 8:56 
30.2 10 9/22/2006 8:27 23.6 11 9/22/2006 8:56 
31.1 10 9/22/2006 8:27 26.7 11 9/22/2006 8:56 
32.2 10 9/22/2006 8:27 81 11 9/22/2006 8:57 
31.3 10 9/22/2006 8:27 61.6 11 9/22/2006 8:57 
29.3 10 9/22/2006 8:27 61 11 9/22/2006 8:57 
28 10 9/22/2006 8:27 50.7 11 9/22/2006 8:57 

27.4 10 9/22/2006 8:27 37.7 11 9/22/2006 8:57 
27 10 9/22/2006 8:27 24 11 9/22/2006 8:57 

26.5 10 9/22/2006 8:27 23.1 11 9/22/2006 8:57 
26.2 10 9/22/2006 8:27 23.2 11 9/22/2006 8:57 
25.5 10 9/22/2006 8:27 26 11 9/22/2006 8:57 
25.5 10 9/22/2006 8:27 25.5 11 9/22/2006 8:57 
25.6 10 9/22/2006 8:27 30.2 11 9/22/2006 8:57 
26.2 10 9/22/2006 8:27 28 11 9/22/2006 8:57 
26.3 10 9/22/2006 8:27 26 11 9/22/2006 8:57 
25.2 10 9/22/2006 8:27 25.6 11 9/22/2006 8:57 
25.1 10 9/22/2006 8:28 26.1 11 9/22/2006 8:57 
25.5 10 9/22/2006 8:28 27.5 11 9/22/2006 8:57 
25.4 10 9/22/2006 8:28 27.2 11 9/22/2006 8:57 
25 10 9/22/2006 8:28 27.4 11 9/22/2006 8:57 

24.6 10 9/22/2006 8:28 26.4 11 9/22/2006 8:57 
24.5 10 9/22/2006 8:28 24.9 11 9/22/2006 8:57 
24.4 10 9/22/2006 8:28 26.8 11 9/22/2006 8:57 
24.6 10 9/22/2006 8:28 79.7 11 9/22/2006 8:57 
24.6 10 9/22/2006 8:28 26.7 11 9/22/2006 8:57 
24.9 10 9/22/2006 8:28 31.6 11 9/22/2006 8:57 
24.7 10 9/22/2006 8:28 23.9 11 9/22/2006 8:57 
24.8 10 9/22/2006 8:28 23.3 11 9/22/2006 8:57 
25.9 10 9/22/2006 8:28 23.7 11 9/22/2006 8:57 
28.2 10 9/22/2006 8:28 45.9 11 9/22/2006 8:57 
32.5 10 9/22/2006 8:28 86 11 9/22/2006 8:57 
40.4 10 9/22/2006 8:28 133 11 9/22/2006 8:57 
39.7 10 9/22/2006 8:28 71.3 11 9/22/2006 8:57 
46.2 10 9/22/2006 8:28 96.2 11 9/22/2006 8:57 
95.5 10 9/22/2006 8:28 77.5 11 9/22/2006 8:57 
163 10 9/22/2006 8:28 52.5 11 9/22/2006 8:57 
175 10 9/22/2006 8:28 39.6 11 9/22/2006 8:58 
237 10 9/22/2006 8:28 47.6 11 9/22/2006 8:58 
231 10 9/22/2006 8:28 45.1 11 9/22/2006 8:58 
167 10 9/22/2006 8:28 35.3 11 9/22/2006 8:58 
212 10 9/22/2006 8:28 47.7 11 9/22/2006 8:58 
289 10 9/22/2006 8:28 56.6 11 9/22/2006 8:58 
250 10 9/22/2006 8:28 81.1 11 9/22/2006 8:58 
174 10 9/22/2006 8:28 71.9 11 9/22/2006 8:58 
101 10 9/22/2006 8:28 62.2 11 9/22/2006 8:58 
96.1 10 9/22/2006 8:28 271 11 9/22/2006 8:58 
73.1 10 9/22/2006 8:28 150 11 9/22/2006 8:58 
83.5 10 9/22/2006 8:28 61.2 11 9/22/2006 8:58 
74.6 10 9/22/2006 8:28 86.2 11 9/22/2006 8:58 
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Path Measurement Data 
Site 6 Path 1 

Path Measurement Data 
Site 6 Path 2 

ppm*m pathlength 
Timestamp 

(mountain time) ppm*m pathlength 
Timestamp 

(mountain time) 
77.5 10 9/22/2006 8:28 68.9 11 9/22/2006 8:58 
66 10 9/22/2006 8:29 60.3 11 9/22/2006 8:58 

71.4 10 9/22/2006 8:29 23.5 11 9/22/2006 8:58 
65.1 10 9/22/2006 8:29 23 11 9/22/2006 8:58 
59 10 9/22/2006 8:29 23.7 11 9/22/2006 8:58 

60.6 10 9/22/2006 8:29 23.9 11 9/22/2006 8:58 
59.2 10 9/22/2006 8:29 29 11 9/22/2006 8:58 
67.7 10 9/22/2006 8:29 26 11 9/22/2006 8:58 
74.6 10 9/22/2006 8:29 23.9 11 9/22/2006 8:58 
77.5 10 9/22/2006 8:29 25.2 11 9/22/2006 8:58 
84.9 10 9/22/2006 8:29 34.6 11 9/22/2006 8:58 
96.6 10 9/22/2006 8:29 130 11 9/22/2006 8:58 
97.8 10 9/22/2006 8:29 34 11 9/22/2006 8:58 
77.8 10 9/22/2006 8:29 52.3 11 9/22/2006 8:58 
63 10 9/22/2006 8:29 103 11 9/22/2006 8:58 

64.8 10 9/22/2006 8:29 23 11 9/22/2006 8:58 
66.6 10 9/22/2006 8:29 52.9 11 9/22/2006 8:58 
64.8 10 9/22/2006 8:29 56.8 11 9/22/2006 8:58 
69.9 10 9/22/2006 8:29 21.9 11 9/22/2006 8:58 
61.5 10 9/22/2006 8:29 21.6 11 9/22/2006 8:58 
59.6 10 9/22/2006 8:29 22.1 11 9/22/2006 8:58 
63.3 10 9/22/2006 8:29 23.2 11 9/22/2006 8:59 
68 10 9/22/2006 8:29 22.1 11 9/22/2006 8:59 

70.3 10 9/22/2006 8:29 23.7 11 9/22/2006 8:59 
82.3 10 9/22/2006 8:29 25.6 11 9/22/2006 8:59 
355 10 9/22/2006 8:29 25.8 11 9/22/2006 8:59 
495 10 9/22/2006 8:29 23.9 11 9/22/2006 8:59 
695 10 9/22/2006 8:29 24.6 11 9/22/2006 8:59 
345 10 9/22/2006 8:29 23.2 11 9/22/2006 8:59 
174 10 9/22/2006 8:29 24.1 11 9/22/2006 8:59 
128 10 9/22/2006 8:29 26.8 11 9/22/2006 8:59 
56.9 10 9/22/2006 8:29 26.1 11 9/22/2006 8:59 
85.8 10 9/22/2006 8:29 25.1 11 9/22/2006 8:59 
306 10 9/22/2006 8:29 27.7 11 9/22/2006 8:59 
365 10 9/22/2006 8:29 30.3 11 9/22/2006 8:59 
258 10 9/22/2006 8:30 35.5 11 9/22/2006 8:59 
258 10 9/22/2006 8:30 31.2 11 9/22/2006 8:59 
91.4 10 9/22/2006 8:30 26.3 11 9/22/2006 8:59 
135 10 9/22/2006 8:30 24.7 11 9/22/2006 8:59 
52.8 10 9/22/2006 8:30 25.5 11 9/22/2006 8:59 
42.7 10 9/22/2006 8:30 26.3 11 9/22/2006 8:59 
38.9 10 9/22/2006 8:30 23.6 11 9/22/2006 8:59 
34.2 10 9/22/2006 8:30 24.1 11 9/22/2006 8:59 
38.8 10 9/22/2006 8:30 24.8 11 9/22/2006 8:59 
56.2 10 9/22/2006 8:30 30.3 11 9/22/2006 8:59 
86.2 10 9/22/2006 8:30 25.9 11 9/22/2006 8:59 
103 10 9/22/2006 8:30 25.5 11 9/22/2006 8:59 
112 10 9/22/2006 8:30 26.9 11 9/22/2006 8:59 
121 10 9/22/2006 8:30 27.5 11 9/22/2006 8:59 
97.9 10 9/22/2006 8:30 26.9 11 9/22/2006 8:59 
81.3 10 9/22/2006 8:30 26 11 9/22/2006 8:59 
76 10 9/22/2006 8:30 27.3 11 9/22/2006 8:59 

69.4 10 9/22/2006 8:30 27.4 11 9/22/2006 8:59 
59.3 10 9/22/2006 8:30 27.6 11 9/22/2006 8:59 
81.4 10 9/22/2006 8:30 28.6 11 9/22/2006 8:59 
65.6 10 9/22/2006 8:30 27.7 11 9/22/2006 9:00 
68.4 10 9/22/2006 8:30 28.6 11 9/22/2006 9:00 
28.6 10 9/22/2006 8:30 31 11 9/22/2006 9:00 
23.5 10 9/22/2006 8:30 31.8 11 9/22/2006 9:00 
24.1 10 9/22/2006 8:30 31.6 11 9/22/2006 9:00 
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Path Measurement Data 
Site 6 Path 1 

Path Measurement Data 
Site 6 Path 2 

ppm*m pathlength 
Timestamp 

(mountain time) ppm*m pathlength 
Timestamp 

(mountain time) 
24.8 10 9/22/2006 8:30 28.8 11 9/22/2006 9:00 
21.4 10 9/22/2006 8:30 27.7 11 9/22/2006 9:00 
21.1 10 9/22/2006 8:30 27.6 11 9/22/2006 9:00 
21.3 10 9/22/2006 8:30 29 11 9/22/2006 9:00 
21 10 9/22/2006 8:30 31.6 11 9/22/2006 9:00 

21.8 10 9/22/2006 8:30 33.8 11 9/22/2006 9:00 
21.3 10 9/22/2006 8:30 33.7 11 9/22/2006 9:00 
21.5 10 9/22/2006 8:30 42.6 11 9/22/2006 9:00 
21.6 10 9/22/2006 8:31 402 11 9/22/2006 9:00 
22.1 10 9/22/2006 8:31 375 11 9/22/2006 9:00 
22.4 10 9/22/2006 8:31 44.3 11 9/22/2006 9:00 
23.2 10 9/22/2006 8:31 70.2 11 9/22/2006 9:00 
23.7 10 9/22/2006 8:31 258 11 9/22/2006 9:00 
22.6 10 9/22/2006 8:31 44 11 9/22/2006 9:00 
22.3 10 9/22/2006 8:31 36.4 11 9/22/2006 9:00 
22.1 10 9/22/2006 8:31 35.6 11 9/22/2006 9:00 
22.4 10 9/22/2006 8:31 29.3 11 9/22/2006 9:00 
22.7 10 9/22/2006 8:31 30.6 11 9/22/2006 9:00 
22.4 10 9/22/2006 8:31 33.2 11 9/22/2006 9:00 
22.4 10 9/22/2006 8:31 22.2 11 9/22/2006 9:00 
23.1 10 9/22/2006 8:31 21.4 11 9/22/2006 9:00 
23.9 10 9/22/2006 8:31 21.2 11 9/22/2006 9:00 
28.2 10 9/22/2006 8:31 21.2 11 9/22/2006 9:00 
43.5 10 9/22/2006 8:31 61.2 11 9/22/2006 9:00 
130 10 9/22/2006 8:31 365 11 9/22/2006 9:00 
83.6 10 9/22/2006 8:31 580 11 9/22/2006 9:00 
86.5 10 9/22/2006 8:31 444 11 9/22/2006 9:00 
96.6 10 9/22/2006 8:31 208 11 9/22/2006 9:00 
78.7 10 9/22/2006 8:31 88.1 11 9/22/2006 9:00 
54.7 10 9/22/2006 8:31 88 11 9/22/2006 9:01 
44.9 10 9/22/2006 8:31 30.1 11 9/22/2006 9:01 
91.2 10 9/22/2006 8:31 74.8 11 9/22/2006 9:01 
55.4 10 9/22/2006 8:31 56.4 11 9/22/2006 9:01 
328 10 9/22/2006 8:31 92.2 11 9/22/2006 9:01 
86.7 10 9/22/2006 8:31 51.4 11 9/22/2006 9:01 
45.4 10 9/22/2006 8:31 82.2 11 9/22/2006 9:01 
33.1 10 9/22/2006 8:31 79.4 11 9/22/2006 9:01 
140 10 9/22/2006 8:31 42.5 11 9/22/2006 9:01 
106 10 9/22/2006 8:31 30.1 11 9/22/2006 9:01 
61.8 10 9/22/2006 8:31 38.9 11 9/22/2006 9:01 
31.2 10 9/22/2006 8:31 46.4 11 9/22/2006 9:01 
29.3 10 9/22/2006 8:31 22.3 11 9/22/2006 9:01 
29.6 10 9/22/2006 8:31 22 11 9/22/2006 9:01 
29.6 10 9/22/2006 8:32 21.4 11 9/22/2006 9:01 
34.1 10 9/22/2006 8:32 21.5 11 9/22/2006 9:01 
36.6 10 9/22/2006 8:32 21.8 11 9/22/2006 9:01 
32.8 10 9/22/2006 8:32 22.9 11 9/22/2006 9:01 
27 10 9/22/2006 8:32 28.8 11 9/22/2006 9:01 
27 10 9/22/2006 8:32 27.7 11 9/22/2006 9:01 

25.3 10 9/22/2006 8:32 25.2 11 9/22/2006 9:01 
28.3 10 9/22/2006 8:32 24.3 11 9/22/2006 9:01 
107 10 9/22/2006 8:32    
34.5 10 9/22/2006 8:32    
31.5 10 9/22/2006 8:32    
94.4 10 9/22/2006 8:32    
198 10 9/22/2006 8:32    
141 10 9/22/2006 8:32    
448 10 9/22/2006 8:32    
113 10 9/22/2006 8:32    
159 10 9/22/2006 8:32    
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Path Measurement Data 
Site 6 Path 1 

Path Measurement Data 
Site 6 Path 2 

ppm*m pathlength 
Timestamp 

(mountain time) ppm*m pathlength 
Timestamp 

(mountain time) 
65.7 10 9/22/2006 8:32    
199 10 9/22/2006 8:32    
72.8 10 9/22/2006 8:32    
25.1 10 9/22/2006 8:32    
31.5 10 9/22/2006 8:32    
223 10 9/22/2006 8:32    
299 10 9/22/2006 8:32    
80 10 9/22/2006 8:32    

29.5 10 9/22/2006 8:32    
25.8 10 9/22/2006 8:32    
29.1 10 9/22/2006 8:32    
26.9 10 9/22/2006 8:32    
27.2 10 9/22/2006 8:32    
31.1 10 9/22/2006 8:32    
24.9 10 9/22/2006 8:32    
52.7 10 9/22/2006 8:32    
39.2 10 9/22/2006 8:33    
33.8 10 9/22/2006 8:33    
35.4 10 9/22/2006 8:33    
42.6 10 9/22/2006 8:33    
43.3 10 9/22/2006 8:33    
61.5 10 9/22/2006 8:33    
86.9 10 9/22/2006 8:33    
68.2 10 9/22/2006 8:33    
76.1 10 9/22/2006 8:33    
78.4 10 9/22/2006 8:33    
65.8 10 9/22/2006 8:33    
60.5 10 9/22/2006 8:33    
55 10 9/22/2006 8:33    

60.9 10 9/22/2006 8:33    
81.5 10 9/22/2006 8:33    
58.1 10 9/22/2006 8:33    
44.8 10 9/22/2006 8:33    
61.5 10 9/22/2006 8:33    
65.9 10 9/22/2006 8:33    
112 10 9/22/2006 8:33    
112 10 9/22/2006 8:33    
78.5 10 9/22/2006 8:33    
92 10 9/22/2006 8:33    

89.6 10 9/22/2006 8:33    
47.2 10 9/22/2006 8:33    
33.1 10 9/22/2006 8:33    
48.9 10 9/22/2006 8:33    
78 10 9/22/2006 8:33    

136 10 9/22/2006 8:33    
168 10 9/22/2006 8:33    
216 10 9/22/2006 8:33    
186 10 9/22/2006 8:33    
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Path Measurement Data 
Site 6 Path 3 

Path Measurement Data 
Site 6 Path 4 

ppm*m pathlength 
Timestamp 

(mountain time) ppm*m pathlength 
Timestamp 

(mountain time) 
30.4 11 9/22/2006 9:04 28.3 11 9/22/2006 9:30 
26 11 9/22/2006 9:04 41.1 11 9/22/2006 9:30 

58.1 11 9/22/2006 9:04 72.5 11 9/22/2006 9:30 
89.5 11 9/22/2006 9:04 73.9 11 9/22/2006 9:30 
279 11 9/22/2006 9:04 195 11 9/22/2006 9:30 
42.1 11 9/22/2006 9:04 27.3 11 9/22/2006 9:30 
47.6 11 9/22/2006 9:04 25.8 11 9/22/2006 9:30 
38.8 11 9/22/2006 9:04 28.1 11 9/22/2006 9:30 
34.4 11 9/22/2006 9:04 26.9 11 9/22/2006 9:30 
29 11 9/22/2006 9:04 24.7 11 9/22/2006 9:30 

25.2 11 9/22/2006 9:04 25 11 9/22/2006 9:30 
25.5 11 9/22/2006 9:04 25.1 11 9/22/2006 9:30 
27.5 11 9/22/2006 9:04 23.4 11 9/22/2006 9:30 
28 11 9/22/2006 9:04 23.9 11 9/22/2006 9:30 

26.3 11 9/22/2006 9:05 22.8 11 9/22/2006 9:30 
23.9 11 9/22/2006 9:05 23.7 11 9/22/2006 9:30 
24.7 11 9/22/2006 9:05 24.5 11 9/22/2006 9:30 
24.3 11 9/22/2006 9:05 22.8 11 9/22/2006 9:30 
34.6 11 9/22/2006 9:05 22.6 11 9/22/2006 9:30 
43.8 11 9/22/2006 9:05 22.8 11 9/22/2006 9:30 
31.9 11 9/22/2006 9:05 22.8 11 9/22/2006 9:30 
41.8 11 9/22/2006 9:05 23 11 9/22/2006 9:30 
28.8 11 9/22/2006 9:05 22.8 11 9/22/2006 9:30 
29.5 11 9/22/2006 9:05 22.7 11 9/22/2006 9:30 
25.8 11 9/22/2006 9:05 22.6 11 9/22/2006 9:30 
23.8 11 9/22/2006 9:05 22.6 11 9/22/2006 9:30 
23.7 11 9/22/2006 9:05 22.7 11 9/22/2006 9:30 
22.1 11 9/22/2006 9:05 22.6 11 9/22/2006 9:30 
21.3 11 9/22/2006 9:05 29.6 11 9/22/2006 9:30 
21.3 11 9/22/2006 9:05 62.8 11 9/22/2006 9:30 
21.5 11 9/22/2006 9:05 138 11 9/22/2006 9:31 
21.7 11 9/22/2006 9:05 192 11 9/22/2006 9:31 
21.9 11 9/22/2006 9:05 88.2 11 9/22/2006 9:31 
22.1 11 9/22/2006 9:05 127 11 9/22/2006 9:31 
22.2 11 9/22/2006 9:05 119 11 9/22/2006 9:31 
22.3 11 9/22/2006 9:05 105 11 9/22/2006 9:31 
22 11 9/22/2006 9:05 227 11 9/22/2006 9:31 
22 11 9/22/2006 9:05 328 11 9/22/2006 9:31 

22.1 11 9/22/2006 9:05 256 11 9/22/2006 9:31 
21.7 11 9/22/2006 9:05 127 11 9/22/2006 9:31 
21.3 11 9/22/2006 9:05 88.1 11 9/22/2006 9:31 
21.3 11 9/22/2006 9:05 42 11 9/22/2006 9:31 
21.3 11 9/22/2006 9:05 22.8 11 9/22/2006 9:31 
21.2 11 9/22/2006 9:05 22.8 11 9/22/2006 9:31 
21.2 11 9/22/2006 9:05 22.7 11 9/22/2006 9:31 
21.2 11 9/22/2006 9:05 23.8 11 9/22/2006 9:31 
22.4 11 9/22/2006 9:05 70.5 11 9/22/2006 9:31 
21.9 11 9/22/2006 9:05 372 11 9/22/2006 9:31 
22.4 11 9/22/2006 9:06 682 11 9/22/2006 9:31 
29.3 11 9/22/2006 9:06 348 11 9/22/2006 9:31 
23.9 11 9/22/2006 9:06 365 11 9/22/2006 9:31 
23.9 11 9/22/2006 9:06 214 11 9/22/2006 9:31 
24.1 11 9/22/2006 9:06 67.3 11 9/22/2006 9:31 
24.8 11 9/22/2006 9:06 46.3 11 9/22/2006 9:31 
33.4 11 9/22/2006 9:06 44 11 9/22/2006 9:31 
62.2 11 9/22/2006 9:06 45.2 11 9/22/2006 9:31 
21.9 11 9/22/2006 9:06 60.9 11 9/22/2006 9:31 
21.6 11 9/22/2006 9:06 89.7 11 9/22/2006 9:31 
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Path Measurement Data 
Site 6 Path 3 

Path Measurement Data 
Site 6 Path 4 

ppm*m pathlength 
Timestamp 

(mountain time) ppm*m pathlength 
Timestamp 

(mountain time) 
21.5 11 9/22/2006 9:06 32.8 11 9/22/2006 9:31 
21.6 11 9/22/2006 9:06 40 11 9/22/2006 9:31 
21.5 11 9/22/2006 9:06 42.6 11 9/22/2006 9:31 
21.5 11 9/22/2006 9:06 41.2 11 9/22/2006 9:31 
21.5 11 9/22/2006 9:06 42.1 11 9/22/2006 9:31 
21.6 11 9/22/2006 9:06 42.6 11 9/22/2006 9:32 
21.5 11 9/22/2006 9:06 43.8 11 9/22/2006 9:32 
21.4 11 9/22/2006 9:06 31.1 11 9/22/2006 9:32 
21.6 11 9/22/2006 9:06 27.7 11 9/22/2006 9:32 
21.7 11 9/22/2006 9:06 32.9 11 9/22/2006 9:32 
21.6 11 9/22/2006 9:06 28.4 11 9/22/2006 9:32 
21.5 11 9/22/2006 9:06 24.4 11 9/22/2006 9:32 
21.8 11 9/22/2006 9:06 28.5 11 9/22/2006 9:32 
21.6 11 9/22/2006 9:06 25.1 11 9/22/2006 9:32 
21.8 11 9/22/2006 9:06 23.9 11 9/22/2006 9:32 
21.7 11 9/22/2006 9:06 23 11 9/22/2006 9:32 
21.6 11 9/22/2006 9:06 22.6 11 9/22/2006 9:32 
21.7 11 9/22/2006 9:06 22.4 11 9/22/2006 9:32 
21.5 11 9/22/2006 9:06 22.2 11 9/22/2006 9:32 
21.6 11 9/22/2006 9:06 22.1 11 9/22/2006 9:32 
21.5 11 9/22/2006 9:06 22.2 11 9/22/2006 9:32 
21.5 11 9/22/2006 9:06 22.1 11 9/22/2006 9:32 
21.4 11 9/22/2006 9:06 22.2 11 9/22/2006 9:32 
21.6 11 9/22/2006 9:06 22.3 11 9/22/2006 9:32 
21.4 11 9/22/2006 9:07 22.1 11 9/22/2006 9:32 
21.5 11 9/22/2006 9:07 22.2 11 9/22/2006 9:32 
21.5 11 9/22/2006 9:07 22.2 11 9/22/2006 9:32 
21.6 11 9/22/2006 9:07 22.2 11 9/22/2006 9:32 
21.5 11 9/22/2006 9:07 26.3 11 9/22/2006 9:32 
21.6 11 9/22/2006 9:07 24.1 11 9/22/2006 9:32 
32.5 11 9/22/2006 9:07 34.6 11 9/22/2006 9:32 
27.2 11 9/22/2006 9:07 62 11 9/22/2006 9:32 
25.6 11 9/22/2006 9:07 79 11 9/22/2006 9:32 
27.4 11 9/22/2006 9:07 215 11 9/22/2006 9:32 
24.7 11 9/22/2006 9:07 247 11 9/22/2006 9:32 
26.9 11 9/22/2006 9:07 179 11 9/22/2006 9:32 
26.9 11 9/22/2006 9:07 273 11 9/22/2006 9:32 
26.5 11 9/22/2006 9:07 108 11 9/22/2006 9:32 
27.6 11 9/22/2006 9:07 58.2 11 9/22/2006 9:32 
24.1 11 9/22/2006 9:07 97.4 11 9/22/2006 9:32 
22.9 11 9/22/2006 9:07 103 11 9/22/2006 9:33 
21.9 11 9/22/2006 9:07 120 11 9/22/2006 9:33 
32.8 11 9/22/2006 9:07 193 11 9/22/2006 9:33 
56.5 11 9/22/2006 9:07 151 11 9/22/2006 9:33 
37.3 11 9/22/2006 9:07 119 11 9/22/2006 9:33 
25.7 11 9/22/2006 9:07 86.4 11 9/22/2006 9:33 
29.4 11 9/22/2006 9:07 58.1 11 9/22/2006 9:33 
38.4 11 9/22/2006 9:07 75.3 11 9/22/2006 9:33 
29.8 11 9/22/2006 9:07 208 11 9/22/2006 9:33 
29.1 11 9/22/2006 9:07 68.6 11 9/22/2006 9:33 
30.4 11 9/22/2006 9:07 31.3 11 9/22/2006 9:33 
32.6 11 9/22/2006 9:07 29.5 11 9/22/2006 9:33 
25.2 11 9/22/2006 9:07 47.5 11 9/22/2006 9:33 
33.4 11 9/22/2006 9:07 49 11 9/22/2006 9:33 
24.2 11 9/22/2006 9:07 33.9 11 9/22/2006 9:33 
21.9 11 9/22/2006 9:07 29.7 11 9/22/2006 9:33 
22.7 11 9/22/2006 9:07 29.1 11 9/22/2006 9:33 
25.8 11 9/22/2006 9:07 28 11 9/22/2006 9:33 
24.1 11 9/22/2006 9:08 26.3 11 9/22/2006 9:33 
32.2 11 9/22/2006 9:08 31.6 11 9/22/2006 9:33 
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Path Measurement Data 
Site 6 Path 3 

Path Measurement Data 
Site 6 Path 4 

ppm*m pathlength 
Timestamp 

(mountain time) ppm*m pathlength 
Timestamp 

(mountain time) 
23.9 11 9/22/2006 9:08 30 11 9/22/2006 9:33 
23.4 11 9/22/2006 9:08 28.6 11 9/22/2006 9:33 
25.7 11 9/22/2006 9:08 29.1 11 9/22/2006 9:33 
26.4 11 9/22/2006 9:08 32 11 9/22/2006 9:33 
23.8 11 9/22/2006 9:08 33.5 11 9/22/2006 9:33 
25.2 11 9/22/2006 9:08 30.9 11 9/22/2006 9:33 
27.4 11 9/22/2006 9:08 26.3 11 9/22/2006 9:33 
25.2 11 9/22/2006 9:08 29.7 11 9/22/2006 9:33 
28.6 11 9/22/2006 9:08 34.4 11 9/22/2006 9:33 
29.3 11 9/22/2006 9:08 28.8 11 9/22/2006 9:33 
28.7 11 9/22/2006 9:08 29.9 11 9/22/2006 9:33 
26.9 11 9/22/2006 9:08 27.7 11 9/22/2006 9:33 
22.8 11 9/22/2006 9:08 25.9 11 9/22/2006 9:33 
23.1 11 9/22/2006 9:08 23.5 11 9/22/2006 9:34 
23.2 11 9/22/2006 9:08 25.4 11 9/22/2006 9:34 
26.1 11 9/22/2006 9:08 23.5 11 9/22/2006 9:34 
23.1 11 9/22/2006 9:08 24.2 11 9/22/2006 9:34 
21.3 11 9/22/2006 9:08 23.4 11 9/22/2006 9:34 
21.2 11 9/22/2006 9:08 23.6 11 9/22/2006 9:34 
21.3 11 9/22/2006 9:08 25 11 9/22/2006 9:34 
21.3 11 9/22/2006 9:08 24.4 11 9/22/2006 9:34 
21.1 11 9/22/2006 9:08 24.7 11 9/22/2006 9:34 
21.3 11 9/22/2006 9:08 24 11 9/22/2006 9:34 
21.4 11 9/22/2006 9:08 23.2 11 9/22/2006 9:34 
21.8 11 9/22/2006 9:08 23.3 11 9/22/2006 9:34 
21.6 11 9/22/2006 9:08 22.9 11 9/22/2006 9:34 
21.4 11 9/22/2006 9:08 22.7 11 9/22/2006 9:34 
21.2 11 9/22/2006 9:08 23.8 11 9/22/2006 9:34 
21.2 11 9/22/2006 9:08 32.5 11 9/22/2006 9:34 
21 11 9/22/2006 9:08 26.1 11 9/22/2006 9:34 

21.2 11 9/22/2006 9:08 24.8 11 9/22/2006 9:34 
21.2 11 9/22/2006 9:08 24.6 11 9/22/2006 9:34 
21.1 11 9/22/2006 9:09 31.9 11 9/22/2006 9:34 
21 11 9/22/2006 9:09 77.4 11 9/22/2006 9:34 

21.1 11 9/22/2006 9:09 65.9 11 9/22/2006 9:34 
21 11 9/22/2006 9:09 120 11 9/22/2006 9:34 

21.2 11 9/22/2006 9:09 299 11 9/22/2006 9:34 
21.1 11 9/22/2006 9:09 760 11 9/22/2006 9:34 
21 11 9/22/2006 9:09 900 11 9/22/2006 9:34 

21.3 11 9/22/2006 9:09 883 11 9/22/2006 9:34 
21 11 9/22/2006 9:09 101 11 9/22/2006 9:34 

21.2 11 9/22/2006 9:09 50.6 11 9/22/2006 9:34 
21.1 11 9/22/2006 9:09 46.4 11 9/22/2006 9:34 
24.1 11 9/22/2006 9:09 31.3 11 9/22/2006 9:34 
24.1 11 9/22/2006 9:09 41 11 9/22/2006 9:34 
26.6 11 9/22/2006 9:09 66.9 11 9/22/2006 9:34 
26.3 11 9/22/2006 9:09 63 11 9/22/2006 9:34 
26.3 11 9/22/2006 9:09 29.9 11 9/22/2006 9:35 
27.3 11 9/22/2006 9:09 31 11 9/22/2006 9:35 
26 11 9/22/2006 9:09 26.8 11 9/22/2006 9:35 

23.9 11 9/22/2006 9:09 26.1 11 9/22/2006 9:35 
25.2 11 9/22/2006 9:09 29 11 9/22/2006 9:35 
30.7 11 9/22/2006 9:09 36.7 11 9/22/2006 9:35 
24.3 11 9/22/2006 9:09 32.1 11 9/22/2006 9:35 
24.7 11 9/22/2006 9:09 51.1 11 9/22/2006 9:35 
21.6 11 9/22/2006 9:09 38.9 11 9/22/2006 9:35 
23.3 11 9/22/2006 9:09 35.2 11 9/22/2006 9:35 
24 11 9/22/2006 9:09 33.6 11 9/22/2006 9:35 
21 11 9/22/2006 9:09 31.3 11 9/22/2006 9:35 

21.1 11 9/22/2006 9:09 28.6 11 9/22/2006 9:35 
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Path Measurement Data 
Site 6 Path 3 

Path Measurement Data 
Site 6 Path 4 

ppm*m pathlength 
Timestamp 

(mountain time) ppm*m pathlength 
Timestamp 

(mountain time) 
26.7 11 9/22/2006 9:09 27.3 11 9/22/2006 9:35 
22.7 11 9/22/2006 9:09 35.4 11 9/22/2006 9:35 
21.9 11 9/22/2006 9:09 31.3 11 9/22/2006 9:35 
60.8 11 9/22/2006 9:09 29.8 11 9/22/2006 9:35 
27.2 11 9/22/2006 9:09 29 11 9/22/2006 9:35 
25.4 11 9/22/2006 9:09 26 11 9/22/2006 9:35 
23.8 11 9/22/2006 9:09 25.5 11 9/22/2006 9:35 
24.7 11 9/22/2006 9:10 25.5 11 9/22/2006 9:35 
23.2 11 9/22/2006 9:10 26.9 11 9/22/2006 9:35 
27.3 11 9/22/2006 9:10 44.4 11 9/22/2006 9:35 
28.6 11 9/22/2006 9:10 286 11 9/22/2006 9:35 
21.3 11 9/22/2006 9:10 574 11 9/22/2006 9:35 
21.4 11 9/22/2006 9:10 315 11 9/22/2006 9:35 
21.2 11 9/22/2006 9:10 88.6 11 9/22/2006 9:35 
21.5 11 9/22/2006 9:10 100 11 9/22/2006 9:35 
22 11 9/22/2006 9:10 195 11 9/22/2006 9:35 
24 11 9/22/2006 9:10 37.8 11 9/22/2006 9:35 

23.8 11 9/22/2006 9:10 36.2 11 9/22/2006 9:35 
24.2 11 9/22/2006 9:10 143 11 9/22/2006 9:35 
37.3 11 9/22/2006 9:10 205 11 9/22/2006 9:35 
95.1 11 9/22/2006 9:10 209 11 9/22/2006 9:35 
45.9 11 9/22/2006 9:10 172 11 9/22/2006 9:36 
24.5 11 9/22/2006 9:10 53.5 11 9/22/2006 9:36 
25.1 11 9/22/2006 9:10 36.6 11 9/22/2006 9:36 
23.3 11 9/22/2006 9:10 37.5 11 9/22/2006 9:36 
23 11 9/22/2006 9:10 34.3 11 9/22/2006 9:36 

23.2 11 9/22/2006 9:10 26 11 9/22/2006 9:36 
27.4 11 9/22/2006 9:10 28.6 11 9/22/2006 9:36 
26.9 11 9/22/2006 9:10 40.1 11 9/22/2006 9:36 
25.7 11 9/22/2006 9:10 40.7 11 9/22/2006 9:36 
23.5 11 9/22/2006 9:10 39 11 9/22/2006 9:36 
23.3 11 9/22/2006 9:10 39.8 11 9/22/2006 9:36 
22.6 11 9/22/2006 9:10 36.8 11 9/22/2006 9:36 
22.5 11 9/22/2006 9:10 34.7 11 9/22/2006 9:36 
24.1 11 9/22/2006 9:10 32.2 11 9/22/2006 9:36 
96.6 11 9/22/2006 9:10 28.5 11 9/22/2006 9:36 
284 11 9/22/2006 9:10 30.7 11 9/22/2006 9:36 
82.9 11 9/22/2006 9:10 28.1 11 9/22/2006 9:36 
95.2 11 9/22/2006 9:10 25.9 11 9/22/2006 9:36 
29.5 11 9/22/2006 9:10 31.3 11 9/22/2006 9:36 
23 11 9/22/2006 9:10 27.1 11 9/22/2006 9:36 

25.7 11 9/22/2006 9:11 26.9 11 9/22/2006 9:36 
28 11 9/22/2006 9:11 25.7 11 9/22/2006 9:36 

52.5 11 9/22/2006 9:11 25.2 11 9/22/2006 9:36 
37.7 11 9/22/2006 9:11 25.9 11 9/22/2006 9:36 
22 11 9/22/2006 9:11 26.6 11 9/22/2006 9:36 

22.8 11 9/22/2006 9:11 29 11 9/22/2006 9:36 
25.3 11 9/22/2006 9:11 42.6 11 9/22/2006 9:36 
25.3 11 9/22/2006 9:11 94.6 11 9/22/2006 9:36 
22.5 11 9/22/2006 9:11 146 11 9/22/2006 9:36 
23 11 9/22/2006 9:11 176 11 9/22/2006 9:36 

24.6 11 9/22/2006 9:11 112 11 9/22/2006 9:36 
25.2 11 9/22/2006 9:11 100 11 9/22/2006 9:36 
26.3 11 9/22/2006 9:11 99.9 11 9/22/2006 9:36 
26.4 11 9/22/2006 9:11 103 11 9/22/2006 9:36 
34.7 11 9/22/2006 9:11 114 11 9/22/2006 9:37 
93.9 11 9/22/2006 9:11 128 11 9/22/2006 9:37 
214 11 9/22/2006 9:11 138 11 9/22/2006 9:37 
133 11 9/22/2006 9:11 141 11 9/22/2006 9:37 
93.6 11 9/22/2006 9:11 141 11 9/22/2006 9:37 
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Path Measurement Data 
Site 6 Path 3 

Path Measurement Data 
Site 6 Path 4 

ppm*m pathlength 
Timestamp 

(mountain time) ppm*m pathlength 
Timestamp 

(mountain time) 
59.1 11 9/22/2006 9:11 137 11 9/22/2006 9:37 
40.2 11 9/22/2006 9:11 129 11 9/22/2006 9:37 
27.1 11 9/22/2006 9:11 106 11 9/22/2006 9:37 
21.9 11 9/22/2006 9:11 94.7 11 9/22/2006 9:37 
21.8 11 9/22/2006 9:11 89.1 11 9/22/2006 9:37 
21.7 11 9/22/2006 9:11 58.9 11 9/22/2006 9:37 
21.6 11 9/22/2006 9:11 39.2 11 9/22/2006 9:37 
21.5 11 9/22/2006 9:11 34 11 9/22/2006 9:37 
21.4 11 9/22/2006 9:11 32.4 11 9/22/2006 9:37 
21.5 11 9/22/2006 9:11 27.1 11 9/22/2006 9:37 
21.3 11 9/22/2006 9:11 42.7 11 9/22/2006 9:37 
25.7 11 9/22/2006 9:11 93 11 9/22/2006 9:37 
23 11 9/22/2006 9:11 105 11 9/22/2006 9:37 

23.6 11 9/22/2006 9:11 109 11 9/22/2006 9:37 
40.6 11 9/22/2006 9:12 115 11 9/22/2006 9:37 
26.8 11 9/22/2006 9:12 69.1 11 9/22/2006 9:37 
25.4 11 9/22/2006 9:12 62.6 11 9/22/2006 9:37 
27 11 9/22/2006 9:12 41.7 11 9/22/2006 9:37 

25.5 11 9/22/2006 9:12 34.8 11 9/22/2006 9:37 
27 11 9/22/2006 9:12 36.8 11 9/22/2006 9:37 

31.7 11 9/22/2006 9:12 33.6 11 9/22/2006 9:37 
37.4 11 9/22/2006 9:12 29.3 11 9/22/2006 9:37 
31.7 11 9/22/2006 9:12 30.2 11 9/22/2006 9:37 
31.5 11 9/22/2006 9:12 27.9 11 9/22/2006 9:37 
36.4 11 9/22/2006 9:12 24.8 11 9/22/2006 9:37 
37.8 11 9/22/2006 9:12 22.5 11 9/22/2006 9:37 
41.3 11 9/22/2006 9:12 22.4 11 9/22/2006 9:37 
60.5 11 9/22/2006 9:12 22.4 11 9/22/2006 9:37 
47.5 11 9/22/2006 9:12 22.5 11 9/22/2006 9:38 
37.1 11 9/22/2006 9:12 22.4 11 9/22/2006 9:38 
25.5 11 9/22/2006 9:12 22.6 11 9/22/2006 9:38 
22.5 11 9/22/2006 9:12 22.5 11 9/22/2006 9:38 
24.3 11 9/22/2006 9:12 22.6 11 9/22/2006 9:38 
25.7 11 9/22/2006 9:12 22.5 11 9/22/2006 9:38 
32.6 11 9/22/2006 9:12 22.4 11 9/22/2006 9:38 
37.4 11 9/22/2006 9:12 22.5 11 9/22/2006 9:38 
39 11 9/22/2006 9:12 22.6 11 9/22/2006 9:38 

37.2 11 9/22/2006 9:12 22.5 11 9/22/2006 9:38 
40.2 11 9/22/2006 9:12 22.6 11 9/22/2006 9:38 
38.4 11 9/22/2006 9:12 22.9 11 9/22/2006 9:38 
35 11 9/22/2006 9:12 23.1 11 9/22/2006 9:38 

38.3 11 9/22/2006 9:12 23 11 9/22/2006 9:38 
45.1 11 9/22/2006 9:12 23.4 11 9/22/2006 9:38 
56.6 11 9/22/2006 9:12 23.5 11 9/22/2006 9:38 
73.4 11 9/22/2006 9:12 23.6 11 9/22/2006 9:38 
92.3 11 9/22/2006 9:12 23.4 11 9/22/2006 9:38 
52.6 11 9/22/2006 9:12 23.2 11 9/22/2006 9:38 
50.5 11 9/22/2006 9:12 22.9 11 9/22/2006 9:38 
49 11 9/22/2006 9:12 23 11 9/22/2006 9:38 

53.5 11 9/22/2006 9:13 22.7 11 9/22/2006 9:38 
44.6 11 9/22/2006 9:13 22.8 11 9/22/2006 9:38 
35.2 11 9/22/2006 9:13 23.3 11 9/22/2006 9:38 
34.4 11 9/22/2006 9:13 23.3 11 9/22/2006 9:38 
36.1 11 9/22/2006 9:13 23.9 11 9/22/2006 9:38 
32.1 11 9/22/2006 9:13 24.1 11 9/22/2006 9:38 
33.8 11 9/22/2006 9:13 24.7 11 9/22/2006 9:38 
30.6 11 9/22/2006 9:13 25 11 9/22/2006 9:38 
28.5 11 9/22/2006 9:13 25 11 9/22/2006 9:38 
28 11 9/22/2006 9:13 24.8 11 9/22/2006 9:38 

92.7 11 9/22/2006 9:13 24.3 11 9/22/2006 9:38 
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Path Measurement Data 
Site 6 Path 3 

Path Measurement Data 
Site 6 Path 4 

ppm*m pathlength 
Timestamp 

(mountain time) ppm*m pathlength 
Timestamp 

(mountain time) 
393 11 9/22/2006 9:13 24 11 9/22/2006 9:38 
222 11 9/22/2006 9:13 23.5 11 9/22/2006 9:38 
435 11 9/22/2006 9:13 22.8 11 9/22/2006 9:38 
519 11 9/22/2006 9:13 22.7 11 9/22/2006 9:39 
372 11 9/22/2006 9:13 22.5 11 9/22/2006 9:39 
296 11 9/22/2006 9:13 22.6 11 9/22/2006 9:39 
74.7 11 9/22/2006 9:13 22.5 11 9/22/2006 9:39 
56.2 11 9/22/2006 9:13 22.7 11 9/22/2006 9:39 
51.2 11 9/22/2006 9:13 22.7 11 9/22/2006 9:39 
48.1 11 9/22/2006 9:13 22.6 11 9/22/2006 9:39 
36.5 11 9/22/2006 9:13 22.8 11 9/22/2006 9:39 
30.3 11 9/22/2006 9:13 22.5 11 9/22/2006 9:39 
27 11 9/22/2006 9:13 22.5 11 9/22/2006 9:39 

23.3 11 9/22/2006 9:13 22.7 11 9/22/2006 9:39 
22 11 9/22/2006 9:13 22.9 11 9/22/2006 9:39 

21.7 11 9/22/2006 9:13 22.3 11 9/22/2006 9:39 
21.7 11 9/22/2006 9:13 22.7 11 9/22/2006 9:39 
21.6 11 9/22/2006 9:13 22.6 11 9/22/2006 9:39 
21.8 11 9/22/2006 9:13 22.7 11 9/22/2006 9:39 
22.5 11 9/22/2006 9:13 22.9 11 9/22/2006 9:39 
30.9 11 9/22/2006 9:13 23 11 9/22/2006 9:39 
32.1 11 9/22/2006 9:13 23 11 9/22/2006 9:39 
34.6 11 9/22/2006 9:13 22.9 11 9/22/2006 9:39 
37.2 11 9/22/2006 9:14 22.8 11 9/22/2006 9:39 
34.1 11 9/22/2006 9:14 23 11 9/22/2006 9:39 
34.7 11 9/22/2006 9:14 22.8 11 9/22/2006 9:39 
35.1 11 9/22/2006 9:14 22.7 11 9/22/2006 9:39 
30.9 11 9/22/2006 9:14 22.7 11 9/22/2006 9:39 
28.5 11 9/22/2006 9:14 22.6 11 9/22/2006 9:39 
29.1 11 9/22/2006 9:14 22.8 11 9/22/2006 9:39 
30.8 11 9/22/2006 9:14 22.6 11 9/22/2006 9:39 
28.3 11 9/22/2006 9:14 22.7 11 9/22/2006 9:39 
34 11 9/22/2006 9:14 22.7 11 9/22/2006 9:39 

35.1 11 9/22/2006 9:14 22.7 11 9/22/2006 9:39 
49 11 9/22/2006 9:14 22.6 11 9/22/2006 9:39 

40.8 11 9/22/2006 9:14 22.7 11 9/22/2006 9:39 
31.5 11 9/22/2006 9:14 22.7 11 9/22/2006 9:39 
35.9 11 9/22/2006 9:14 22.8 11 9/22/2006 9:40 
37.9 11 9/22/2006 9:14 22.8 11 9/22/2006 9:40 
34.1 11 9/22/2006 9:14 22.6 11 9/22/2006 9:40 
29 11 9/22/2006 9:14 22.4 11 9/22/2006 9:40 

28.8 11 9/22/2006 9:14 22.7 11 9/22/2006 9:40 
27.7 11 9/22/2006 9:14 22.5 11 9/22/2006 9:40 
29.1 11 9/22/2006 9:14 22.5 11 9/22/2006 9:40 
26.9 11 9/22/2006 9:14 22.4 11 9/22/2006 9:40 
25.7 11 9/22/2006 9:14 22.6 11 9/22/2006 9:40 
24.8 11 9/22/2006 9:14 22.8 11 9/22/2006 9:40 
24 11 9/22/2006 9:14 22.5 11 9/22/2006 9:40 

25.9 11 9/22/2006 9:14 22.6 11 9/22/2006 9:40 
335 11 9/22/2006 9:14 22.7 11 9/22/2006 9:40 

1220 11 9/22/2006 9:14 24 11 9/22/2006 9:40 
2012 11 9/22/2006 9:14 31.1 11 9/22/2006 9:40 
2312 11 9/22/2006 9:14 28.4 11 9/22/2006 9:40 
2151 11 9/22/2006 9:14 30.9 11 9/22/2006 9:40 
1273 11 9/22/2006 9:14 33.6 11 9/22/2006 9:40 
551 11 9/22/2006 9:14 37.5 11 9/22/2006 9:40 
320 11 9/22/2006 9:14 35.8 11 9/22/2006 9:40 
207 11 9/22/2006 9:15 34.9 11 9/22/2006 9:40 
93.7 11 9/22/2006 9:15 32 11 9/22/2006 9:40 
28.6 11 9/22/2006 9:15 34.5 11 9/22/2006 9:40 
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Path Measurement Data 
Site 6 Path 3 

Path Measurement Data 
Site 6 Path 4 

ppm*m pathlength 
Timestamp 

(mountain time) ppm*m pathlength 
Timestamp 

(mountain time) 
29.6 11 9/22/2006 9:15 31.2 11 9/22/2006 9:40 
29.3 11 9/22/2006 9:15 40.6 11 9/22/2006 9:40 
27.2 11 9/22/2006 9:15 45.2 11 9/22/2006 9:40 
28.7 11 9/22/2006 9:15 152 11 9/22/2006 9:40 
29.6 11 9/22/2006 9:15 575 11 9/22/2006 9:40 
34.2 11 9/22/2006 9:15 85.8 11 9/22/2006 9:40 
35.2 11 9/22/2006 9:15 37.1 11 9/22/2006 9:40 
32.2 11 9/22/2006 9:15 51.8 11 9/22/2006 9:40 
34.3 11 9/22/2006 9:15 43 11 9/22/2006 9:40 
33.1 11 9/22/2006 9:15 40.2 11 9/22/2006 9:40 
32 11 9/22/2006 9:15 103 11 9/22/2006 9:40 

35.7 11 9/22/2006 9:15 86.7 11 9/22/2006 9:41 
34.8 11 9/22/2006 9:15 73.6 11 9/22/2006 9:41 
86.4 11 9/22/2006 9:15 405 11 9/22/2006 9:41 
40.4 11 9/22/2006 9:15 212 11 9/22/2006 9:41 
35.4 11 9/22/2006 9:15 234 11 9/22/2006 9:41 
35.6 11 9/22/2006 9:15 282 11 9/22/2006 9:41 
35.6 11 9/22/2006 9:15 259 11 9/22/2006 9:41 
30.5 11 9/22/2006 9:15 258 11 9/22/2006 9:41 
25.9 11 9/22/2006 9:15 360 11 9/22/2006 9:41 
23 11 9/22/2006 9:15 180 11 9/22/2006 9:41 

22.7 11 9/22/2006 9:15 146 11 9/22/2006 9:41 
24.6 11 9/22/2006 9:15 438 11 9/22/2006 9:41 
34.7 11 9/22/2006 9:15 471 11 9/22/2006 9:41 
30.5 11 9/22/2006 9:15 342 11 9/22/2006 9:41 
24.3 11 9/22/2006 9:15 185 11 9/22/2006 9:41 
24.4 11 9/22/2006 9:15 43.6 11 9/22/2006 9:41 
28.9 11 9/22/2006 9:15 37 11 9/22/2006 9:41 
25.5 11 9/22/2006 9:15 33.6 11 9/22/2006 9:41 
25.4 11 9/22/2006 9:15 42 11 9/22/2006 9:41 
22.7 11 9/22/2006 9:15 32.9 11 9/22/2006 9:41 
22.5 11 9/22/2006 9:16 31.4 11 9/22/2006 9:41 
22.8 11 9/22/2006 9:16 33.3 11 9/22/2006 9:41 
22 11 9/22/2006 9:16 36 11 9/22/2006 9:41 
22 11 9/22/2006 9:16 45.3 11 9/22/2006 9:41 

22.8 11 9/22/2006 9:16 41.3 11 9/22/2006 9:41 
24.1 11 9/22/2006 9:16 38.8 11 9/22/2006 9:41 
26 11 9/22/2006 9:16 39.2 11 9/22/2006 9:41 

38.7 11 9/22/2006 9:16 67.4 11 9/22/2006 9:41 
37.7 11 9/22/2006 9:16 101 11 9/22/2006 9:41 
109 11 9/22/2006 9:16 120 11 9/22/2006 9:41 
83.1 11 9/22/2006 9:16 217 11 9/22/2006 9:41 
371 11 9/22/2006 9:16 161 11 9/22/2006 9:41 
434 11 9/22/2006 9:16 66.8 11 9/22/2006 9:41 
266 11 9/22/2006 9:16 29.3 11 9/22/2006 9:42 
173 11 9/22/2006 9:16 26.7 11 9/22/2006 9:42 
460 11 9/22/2006 9:16 25.9 11 9/22/2006 9:42 
554 11 9/22/2006 9:16 25 11 9/22/2006 9:42 
289 11 9/22/2006 9:16 25.1 11 9/22/2006 9:42 
276 11 9/22/2006 9:16 27.1 11 9/22/2006 9:42 
264 11 9/22/2006 9:16 26.8 11 9/22/2006 9:42 
358 11 9/22/2006 9:16 28.8 11 9/22/2006 9:42 
733 11 9/22/2006 9:16 33 11 9/22/2006 9:42 
610 11 9/22/2006 9:16 30.1 11 9/22/2006 9:42 
995 11 9/22/2006 9:16 31.8 11 9/22/2006 9:42 
408 11 9/22/2006 9:16 32.7 11 9/22/2006 9:42 
166 11 9/22/2006 9:16 32.9 11 9/22/2006 9:42 
134 11 9/22/2006 9:16 32.2 11 9/22/2006 9:42 
125 11 9/22/2006 9:16 30.3 11 9/22/2006 9:42 
131 11 9/22/2006 9:16 28.5 11 9/22/2006 9:42 
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Path Measurement Data 
Site 6 Path 3 

Path Measurement Data 
Site 6 Path 4 

ppm*m pathlength 
Timestamp 

(mountain time) ppm*m pathlength 
Timestamp 

(mountain time) 
187 11 9/22/2006 9:16 27.8 11 9/22/2006 9:42 
104 11 9/22/2006 9:16 27.2 11 9/22/2006 9:42 
481 11 9/22/2006 9:16 27.1 11 9/22/2006 9:42 
394 11 9/22/2006 9:16 27.5 11 9/22/2006 9:42 
130 11 9/22/2006 9:17 29.3 11 9/22/2006 9:42 
203 11 9/22/2006 9:17 26.2 11 9/22/2006 9:42 
181 11 9/22/2006 9:17 25.2 11 9/22/2006 9:42 
150 11 9/22/2006 9:17 24.4 11 9/22/2006 9:42 
137 11 9/22/2006 9:17 24.1 11 9/22/2006 9:42 
95.4 11 9/22/2006 9:17 24.2 11 9/22/2006 9:42 
54.2 11 9/22/2006 9:17 23.6 11 9/22/2006 9:42 
51.1 11 9/22/2006 9:17 23.1 11 9/22/2006 9:42 
48.9 11 9/22/2006 9:17 23.1 11 9/22/2006 9:42 
47.2 11 9/22/2006 9:17 23.2 11 9/22/2006 9:42 
50.6 11 9/22/2006 9:17 24 11 9/22/2006 9:42 
54.4 11 9/22/2006 9:17 23.9 11 9/22/2006 9:42 
45.7 11 9/22/2006 9:17 24.3 11 9/22/2006 9:42 
44.4 11 9/22/2006 9:17 24.7 11 9/22/2006 9:42 
43.1 11 9/22/2006 9:17 26 11 9/22/2006 9:42 
40.6 11 9/22/2006 9:17 105 11 9/22/2006 9:43 
38.9 11 9/22/2006 9:17 162 11 9/22/2006 9:43 
39.4 11 9/22/2006 9:17 57.1 11 9/22/2006 9:43 
39.5 11 9/22/2006 9:17 86.7 11 9/22/2006 9:43 
39.6 11 9/22/2006 9:17 74.5 11 9/22/2006 9:43 
36.5 11 9/22/2006 9:17 68.6 11 9/22/2006 9:43 
34.1 11 9/22/2006 9:17 47.9 11 9/22/2006 9:43 
31.8 11 9/22/2006 9:17 42.9 11 9/22/2006 9:43 
31.2 11 9/22/2006 9:17 40.2 11 9/22/2006 9:43 
31.1 11 9/22/2006 9:17 33.8 11 9/22/2006 9:43 
31.2 11 9/22/2006 9:17 24.2 11 9/22/2006 9:43 
31.3 11 9/22/2006 9:17 23.4 11 9/22/2006 9:43 
31.5 11 9/22/2006 9:17 22.9 11 9/22/2006 9:43 
30.6 11 9/22/2006 9:17 23.2 11 9/22/2006 9:43 
31.2 11 9/22/2006 9:17 23.3 11 9/22/2006 9:43 
30.7 11 9/22/2006 9:17 23.2 11 9/22/2006 9:43 
30.3 11 9/22/2006 9:17 23.4 11 9/22/2006 9:43 
29.2 11 9/22/2006 9:17 23.8 11 9/22/2006 9:43 
27.7 11 9/22/2006 9:17 23.5 11 9/22/2006 9:43 
37 11 9/22/2006 9:18 23.2 11 9/22/2006 9:43 

40.4 11 9/22/2006 9:18 23.3 11 9/22/2006 9:43 
35.1 11 9/22/2006 9:18 23 11 9/22/2006 9:43 
33.5 11 9/22/2006 9:18 23.3 11 9/22/2006 9:43 
28.8 11 9/22/2006 9:18 23.3 11 9/22/2006 9:43 
38.6 11 9/22/2006 9:18 23.2 11 9/22/2006 9:43 
126 11 9/22/2006 9:18 23.1 11 9/22/2006 9:43 
167 11 9/22/2006 9:18 23.3 11 9/22/2006 9:43 
81.4 11 9/22/2006 9:18 23.4 11 9/22/2006 9:43 
151 11 9/22/2006 9:18 23.3 11 9/22/2006 9:43 
203 11 9/22/2006 9:18 23.1 11 9/22/2006 9:43 
88.7 11 9/22/2006 9:18 23.7 11 9/22/2006 9:43 
44.6 11 9/22/2006 9:18 23.6 11 9/22/2006 9:43 
30.9 11 9/22/2006 9:18 23.3 11 9/22/2006 9:43 
36.7 11 9/22/2006 9:18 23.3 11 9/22/2006 9:44 
33.7 11 9/22/2006 9:18 23.4 11 9/22/2006 9:44 
34.8 11 9/22/2006 9:18 23.6 11 9/22/2006 9:44 
27.8 11 9/22/2006 9:18 23.6 11 9/22/2006 9:44 
270 11 9/22/2006 9:18 23.6 11 9/22/2006 9:44 
663 11 9/22/2006 9:18 23.2 11 9/22/2006 9:44 
103 11 9/22/2006 9:18 22.8 11 9/22/2006 9:44 
32.3 11 9/22/2006 9:18 23.5 11 9/22/2006 9:44 
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Path Measurement Data 
Site 6 Path 3 

Path Measurement Data 
Site 6 Path 4 

ppm*m pathlength 
Timestamp 

(mountain time) ppm*m pathlength 
Timestamp 

(mountain time) 
30.5 11 9/22/2006 9:18 23.3 11 9/22/2006 9:44 
25.6 11 9/22/2006 9:18 23.3 11 9/22/2006 9:44 
27.8 11 9/22/2006 9:18 23.1 11 9/22/2006 9:44 
31.1 11 9/22/2006 9:18 24 11 9/22/2006 9:44 
57.7 11 9/22/2006 9:18 23 11 9/22/2006 9:44 
55.3 11 9/22/2006 9:18 23.7 11 9/22/2006 9:44 
45 11 9/22/2006 9:18 23.1 11 9/22/2006 9:44 

41.3 11 9/22/2006 9:18 23.4 11 9/22/2006 9:44 
49.7 11 9/22/2006 9:18 23.5 11 9/22/2006 9:44 
51 11 9/22/2006 9:18 23.5 11 9/22/2006 9:44 

54.6 11 9/22/2006 9:18 23 11 9/22/2006 9:44 
49.9 11 9/22/2006 9:18 23.2 11 9/22/2006 9:44 
48.3 11 9/22/2006 9:18 23.3 11 9/22/2006 9:44 
45.7 11 9/22/2006 9:19 23 11 9/22/2006 9:44 
53.5 11 9/22/2006 9:19 22.9 11 9/22/2006 9:44 
46.1 11 9/22/2006 9:19 22.8 11 9/22/2006 9:44 
43.8 11 9/22/2006 9:19 23.1 11 9/22/2006 9:44 
43.1 11 9/22/2006 9:19 23.4 11 9/22/2006 9:44 
46.1 11 9/22/2006 9:19 23.3 11 9/22/2006 9:44 
45.4 11 9/22/2006 9:19 24.3 11 9/22/2006 9:44 
47.3 11 9/22/2006 9:19 26.7 11 9/22/2006 9:44 
46.5 11 9/22/2006 9:19 26.8 11 9/22/2006 9:44 
43.7 11 9/22/2006 9:19 45.3 11 9/22/2006 9:44 
56 11 9/22/2006 9:19 62 11 9/22/2006 9:44 

118 11 9/22/2006 9:19 63.1 11 9/22/2006 9:44 
459 11 9/22/2006 9:19 35.5 11 9/22/2006 9:45 
383 11 9/22/2006 9:19 38.7 11 9/22/2006 9:45 
385 11 9/22/2006 9:19 46.9 11 9/22/2006 9:45 

1587 11 9/22/2006 9:19 31.6 11 9/22/2006 9:45 
969 11 9/22/2006 9:19 26.1 11 9/22/2006 9:45 
701 11 9/22/2006 9:19 23.4 11 9/22/2006 9:45 
384 11 9/22/2006 9:19 23.1 11 9/22/2006 9:45 
52.8 11 9/22/2006 9:19 23.2 11 9/22/2006 9:45 
40.6 11 9/22/2006 9:19 23.1 11 9/22/2006 9:45 
104 11 9/22/2006 9:19 22.8 11 9/22/2006 9:45 
47.5 11 9/22/2006 9:19 23.5 11 9/22/2006 9:45 
28.5 11 9/22/2006 9:19 22.6 11 9/22/2006 9:45 
24.6 11 9/22/2006 9:19 23.1 11 9/22/2006 9:45 
24.1 11 9/22/2006 9:19 23.5 11 9/22/2006 9:45 
22.9 11 9/22/2006 9:19 23.2 11 9/22/2006 9:45 
21.6 11 9/22/2006 9:19 23.2 11 9/22/2006 9:45 
21.5 11 9/22/2006 9:19 23.3 11 9/22/2006 9:45 
21.7 11 9/22/2006 9:19 23.3 11 9/22/2006 9:45 
22.9 11 9/22/2006 9:19 23 11 9/22/2006 9:45 
30.2 11 9/22/2006 9:19 23.1 11 9/22/2006 9:45 
34.3 11 9/22/2006 9:20 23 11 9/22/2006 9:45 
36.1 11 9/22/2006 9:20 23.2 11 9/22/2006 9:45 
48.1 11 9/22/2006 9:20 23.1 11 9/22/2006 9:45 
41 11 9/22/2006 9:20 23 11 9/22/2006 9:45 

44.7 11 9/22/2006 9:20 23.1 11 9/22/2006 9:45 
47.8 11 9/22/2006 9:20 22.9 11 9/22/2006 9:45 
44.1 11 9/22/2006 9:20 23 11 9/22/2006 9:45 
43 11 9/22/2006 9:20 23.1 11 9/22/2006 9:45 

40.2 11 9/22/2006 9:20 23 11 9/22/2006 9:45 
38 11 9/22/2006 9:20 23 11 9/22/2006 9:45 

35.3 11 9/22/2006 9:20 22.9 11 9/22/2006 9:45 
33.9 11 9/22/2006 9:20 22.8 11 9/22/2006 9:45 
36.3 11 9/22/2006 9:20 23 11 9/22/2006 9:45 
40.1 11 9/22/2006 9:20 23.2 11 9/22/2006 9:45 
73.6 11 9/22/2006 9:20 23 11 9/22/2006 9:45 
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Path Measurement Data 
Site 6 Path 3 

Path Measurement Data 
Site 6 Path 4 

ppm*m pathlength 
Timestamp 

(mountain time) ppm*m pathlength 
Timestamp 

(mountain time) 
41.8 11 9/22/2006 9:20 23.3 11 9/22/2006 9:46 
71.3 11 9/22/2006 9:20 23 11 9/22/2006 9:46 
99.9 11 9/22/2006 9:20 23.1 11 9/22/2006 9:46 
104 11 9/22/2006 9:20 22.7 11 9/22/2006 9:46 
88.9 11 9/22/2006 9:20 22.7 11 9/22/2006 9:46 
91.6 11 9/22/2006 9:20 22.9 11 9/22/2006 9:46 
303 11 9/22/2006 9:20 22.9 11 9/22/2006 9:46 
363 11 9/22/2006 9:20 23 11 9/22/2006 9:46 
56 11 9/22/2006 9:20 23.1 11 9/22/2006 9:46 

28.3 11 9/22/2006 9:20 22.9 11 9/22/2006 9:46 
27.4 11 9/22/2006 9:20 22.7 11 9/22/2006 9:46 
25.8 11 9/22/2006 9:20 22.9 11 9/22/2006 9:46 
24.7 11 9/22/2006 9:20 22.8 11 9/22/2006 9:46 
26.5 11 9/22/2006 9:20 23 11 9/22/2006 9:46 
26.1 11 9/22/2006 9:20 22.7 11 9/22/2006 9:46 
22.6 11 9/22/2006 9:20 23 11 9/22/2006 9:46 
26.5 11 9/22/2006 9:20 23.2 11 9/22/2006 9:46 
23.4 11 9/22/2006 9:20 23.4 11 9/22/2006 9:46 
23.1 11 9/22/2006 9:20 27.9 11 9/22/2006 9:46 
23.4 11 9/22/2006 9:21 30.2 11 9/22/2006 9:46 
23.6 11 9/22/2006 9:21 37.7 11 9/22/2006 9:46 
28.6 11 9/22/2006 9:21 31.9 11 9/22/2006 9:46 
23.9 11 9/22/2006 9:21 28.6 11 9/22/2006 9:46 
23.9 11 9/22/2006 9:21 30.3 11 9/22/2006 9:46 
78.1 11 9/22/2006 9:21 29.5 11 9/22/2006 9:46 
58.6 11 9/22/2006 9:21 34.1 11 9/22/2006 9:46 
79.9 11 9/22/2006 9:21 27.7 11 9/22/2006 9:46 
81.1 11 9/22/2006 9:21 24.6 11 9/22/2006 9:46 
53.2 11 9/22/2006 9:21 23.2 11 9/22/2006 9:46 
24.6 11 9/22/2006 9:21 23 11 9/22/2006 9:46 
24.5 11 9/22/2006 9:21 23.1 11 9/22/2006 9:46 
26.4 11 9/22/2006 9:21 23 11 9/22/2006 9:46 
23.7 11 9/22/2006 9:21 23.1 11 9/22/2006 9:46 
25 11 9/22/2006 9:21 23.1 11 9/22/2006 9:46 

22.8 11 9/22/2006 9:21 22.9 11 9/22/2006 9:47 
22.7 11 9/22/2006 9:21 23 11 9/22/2006 9:47 
22.2 11 9/22/2006 9:21 23 11 9/22/2006 9:47 
22.5 11 9/22/2006 9:21 23.1 11 9/22/2006 9:47 
25.6 11 9/22/2006 9:21 22.9 11 9/22/2006 9:47 
27.3 11 9/22/2006 9:21 23 11 9/22/2006 9:47 
26.6 11 9/22/2006 9:21 23 11 9/22/2006 9:47 
26.8 11 9/22/2006 9:21 23 11 9/22/2006 9:47 
25.7 11 9/22/2006 9:21 22.9 11 9/22/2006 9:47 
23.6 11 9/22/2006 9:21 22.9 11 9/22/2006 9:47 
22.9 11 9/22/2006 9:21 23.1 11 9/22/2006 9:47 
22.7 11 9/22/2006 9:21 22.8 11 9/22/2006 9:47 
29.2 11 9/22/2006 9:21 23 11 9/22/2006 9:47 
469 11 9/22/2006 9:21 23 11 9/22/2006 9:47 
215 11 9/22/2006 9:21 22.9 11 9/22/2006 9:47 
238 11 9/22/2006 9:21 23 11 9/22/2006 9:47 
140 11 9/22/2006 9:21 23.1 11 9/22/2006 9:47 
38.1 11 9/22/2006 9:21 23.1 11 9/22/2006 9:47 
32.2 11 9/22/2006 9:21 25 11 9/22/2006 9:47 
27.5 11 9/22/2006 9:22 35.7 11 9/22/2006 9:47 
25.8 11 9/22/2006 9:22 35.1 11 9/22/2006 9:47 
24.5 11 9/22/2006 9:22 35.9 11 9/22/2006 9:47 
61.7 11 9/22/2006 9:22 30.6 11 9/22/2006 9:47 
66.7 11 9/22/2006 9:22 23.8 11 9/22/2006 9:47 
69.3 11 9/22/2006 9:22 22.9 11 9/22/2006 9:47 
132 11 9/22/2006 9:22 22.8 11 9/22/2006 9:47 
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Path Measurement Data 
Site 6 Path 3 

Path Measurement Data 
Site 6 Path 4 

ppm*m pathlength 
Timestamp 

(mountain time) ppm*m pathlength 
Timestamp 

(mountain time) 
154 11 9/22/2006 9:22 22.8 11 9/22/2006 9:47 
114 11 9/22/2006 9:22 22.9 11 9/22/2006 9:47 
295 11 9/22/2006 9:22 23.2 11 9/22/2006 9:47 

1130 11 9/22/2006 9:22 23.1 11 9/22/2006 9:47 
863 11 9/22/2006 9:22 23.2 11 9/22/2006 9:47 
718 11 9/22/2006 9:22 23.3 11 9/22/2006 9:47 
326 11 9/22/2006 9:22 23.2 11 9/22/2006 9:47 
295 11 9/22/2006 9:22 23.4 11 9/22/2006 9:48 
440 11 9/22/2006 9:22 23.2 11 9/22/2006 9:48 

1304 11 9/22/2006 9:22 23.3 11 9/22/2006 9:48 
801 11 9/22/2006 9:22 23.3 11 9/22/2006 9:48 
462 11 9/22/2006 9:22 77.1 11 9/22/2006 9:48 
299 11 9/22/2006 9:22 36.4 11 9/22/2006 9:48 
186 11 9/22/2006 9:22 23.4 11 9/22/2006 9:48 
172 11 9/22/2006 9:22 23.3 11 9/22/2006 9:48 
145 11 9/22/2006 9:22 23.4 11 9/22/2006 9:48 
114 11 9/22/2006 9:22 23.4 11 9/22/2006 9:48 
94.2 11 9/22/2006 9:22 23.2 11 9/22/2006 9:48 
80.6 11 9/22/2006 9:22 23.3 11 9/22/2006 9:48 
62.9 11 9/22/2006 9:22 23.2 11 9/22/2006 9:48 
65.9 11 9/22/2006 9:22 23.4 11 9/22/2006 9:48 
57.4 11 9/22/2006 9:22 23.1 11 9/22/2006 9:48 
45.9 11 9/22/2006 9:22 23.3 11 9/22/2006 9:48 
40.2 11 9/22/2006 9:22 23.2 11 9/22/2006 9:48 
53.5 11 9/22/2006 9:22 23.3 11 9/22/2006 9:48 
50.7 11 9/22/2006 9:22 23.2 11 9/22/2006 9:48 
34.3 11 9/22/2006 9:22 23.2 11 9/22/2006 9:48 
30.2 11 9/22/2006 9:23 23.3 11 9/22/2006 9:48 
31.6 11 9/22/2006 9:23 23.3 11 9/22/2006 9:48 
29.1 11 9/22/2006 9:23 23.3 11 9/22/2006 9:48 
25.8 11 9/22/2006 9:23 23.9 11 9/22/2006 9:48 
25.5 11 9/22/2006 9:23 26.3 11 9/22/2006 9:48 
26.2 11 9/22/2006 9:23 24.3 11 9/22/2006 9:48 
26.1 11 9/22/2006 9:23 23.4 11 9/22/2006 9:48 
25.5 11 9/22/2006 9:23 23.4 11 9/22/2006 9:48 
25.6 11 9/22/2006 9:23 23.5 11 9/22/2006 9:48 
25.6 11 9/22/2006 9:23 23.9 11 9/22/2006 9:48 
26.1 11 9/22/2006 9:23 25.6 11 9/22/2006 9:48 
25.6 11 9/22/2006 9:23 28.4 11 9/22/2006 9:48 
32.4 11 9/22/2006 9:23 24.4 11 9/22/2006 9:48 
34.4 11 9/22/2006 9:23 24 11 9/22/2006 9:48 
30.1 11 9/22/2006 9:23 23.8 11 9/22/2006 9:48 
26.9 11 9/22/2006 9:23 23.8 11 9/22/2006 9:49 
26.1 11 9/22/2006 9:23 24.1 11 9/22/2006 9:49 
30.6 11 9/22/2006 9:23 23.8 11 9/22/2006 9:49 
30.1 11 9/22/2006 9:23 24.3 11 9/22/2006 9:49 
28.5 11 9/22/2006 9:23 23.9 11 9/22/2006 9:49 
29.1 11 9/22/2006 9:23 23.6 11 9/22/2006 9:49 
34.3 11 9/22/2006 9:23 24.3 11 9/22/2006 9:49 
143 11 9/22/2006 9:23 24.8 11 9/22/2006 9:49 
305 11 9/22/2006 9:23 24.8 11 9/22/2006 9:49 
292 11 9/22/2006 9:23 25.6 11 9/22/2006 9:49 
478 11 9/22/2006 9:23 24.5 11 9/22/2006 9:49 
721 11 9/22/2006 9:23 24.1 11 9/22/2006 9:49 
384 11 9/22/2006 9:23 23.7 11 9/22/2006 9:49 
356 11 9/22/2006 9:23 24 11 9/22/2006 9:49 
143 11 9/22/2006 9:23 23.7 11 9/22/2006 9:49 
174 11 9/22/2006 9:23 23.7 11 9/22/2006 9:49 
82.6 11 9/22/2006 9:23 23.9 11 9/22/2006 9:49 
26.9 11 9/22/2006 9:23 24.1 11 9/22/2006 9:49 
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Path Measurement Data 
Site 6 Path 3 

Path Measurement Data 
Site 6 Path 4 

ppm*m pathlength 
Timestamp 

(mountain time) ppm*m pathlength 
Timestamp 

(mountain time) 
27.2 11 9/22/2006 9:23 24.2 11 9/22/2006 9:49 
24.2 11 9/22/2006 9:24 24 11 9/22/2006 9:49 
28.4 11 9/22/2006 9:24 23.8 11 9/22/2006 9:49 
26 11 9/22/2006 9:24 23.7 11 9/22/2006 9:49 

24.7 11 9/22/2006 9:24 23.6 11 9/22/2006 9:49 
24.1 11 9/22/2006 9:24 23.7 11 9/22/2006 9:49 
23.7 11 9/22/2006 9:24 23.5 11 9/22/2006 9:49 
29.7 11 9/22/2006 9:24 23.6 11 9/22/2006 9:49 
40.3 11 9/22/2006 9:24 23.6 11 9/22/2006 9:49 
29.1 11 9/22/2006 9:24 23.6 11 9/22/2006 9:49 
33 11 9/22/2006 9:24 23.7 11 9/22/2006 9:49 

23.8 11 9/22/2006 9:24 23.7 11 9/22/2006 9:49 
23.4 11 9/22/2006 9:24 23.6 11 9/22/2006 9:49 
23.1 11 9/22/2006 9:24 23.6 11 9/22/2006 9:49 
23.2 11 9/22/2006 9:24 23.7 11 9/22/2006 9:49 
23.2 11 9/22/2006 9:24 23.6 11 9/22/2006 9:49 
23.1 11 9/22/2006 9:24 23.6 11 9/22/2006 9:50 
22.6 11 9/22/2006 9:24 23.8 11 9/22/2006 9:50 
23 11 9/22/2006 9:24 23.6 11 9/22/2006 9:50 

23.7 11 9/22/2006 9:24 23.8 11 9/22/2006 9:50 
23.4 11 9/22/2006 9:24 23.6 11 9/22/2006 9:50 
23.3 11 9/22/2006 9:24 25.7 11 9/22/2006 9:50 
23.8 11 9/22/2006 9:24 26.2 11 9/22/2006 9:50 
25.4 11 9/22/2006 9:24 44.7 11 9/22/2006 9:50 
25.1 11 9/22/2006 9:24 122 11 9/22/2006 9:50 
23.8 11 9/22/2006 9:24 154 11 9/22/2006 9:50 
22.3 11 9/22/2006 9:24 38 11 9/22/2006 9:50 
25 11 9/22/2006 9:24 27.2 11 9/22/2006 9:50 

39.7 11 9/22/2006 9:24 28.7 11 9/22/2006 9:50 
51.5 11 9/22/2006 9:24 30.1 11 9/22/2006 9:50 
49.3 11 9/22/2006 9:24 36.1 11 9/22/2006 9:50 
51.7 11 9/22/2006 9:24 44.5 11 9/22/2006 9:50 
35.6 11 9/22/2006 9:24 29.4 11 9/22/2006 9:50 
42.2 11 9/22/2006 9:24 26.4 11 9/22/2006 9:50 
57.3 11 9/22/2006 9:24 24.7 11 9/22/2006 9:50 
48.6 11 9/22/2006 9:25 25 11 9/22/2006 9:50 
37.5 11 9/22/2006 9:25 24.6 11 9/22/2006 9:50 
33.1 11 9/22/2006 9:25 24.4 11 9/22/2006 9:50 
25.4 11 9/22/2006 9:25 24.3 11 9/22/2006 9:50 
25.7 11 9/22/2006 9:25 23.8 11 9/22/2006 9:50 
24.7 11 9/22/2006 9:25 24.1 11 9/22/2006 9:50 
106 11 9/22/2006 9:25 24 11 9/22/2006 9:50 
267 11 9/22/2006 9:25 23.4 11 9/22/2006 9:50 
177 11 9/22/2006 9:25 23.6 11 9/22/2006 9:50 
135 11 9/22/2006 9:25 23.4 11 9/22/2006 9:50 
226 11 9/22/2006 9:25 24.2 11 9/22/2006 9:50 
83.7 11 9/22/2006 9:25 39.9 11 9/22/2006 9:50 
35.4 11 9/22/2006 9:25 87.6 11 9/22/2006 9:50 
27.8 11 9/22/2006 9:25 92.4 11 9/22/2006 9:50 
33.2 11 9/22/2006 9:25 67.6 11 9/22/2006 9:51 
28.6 11 9/22/2006 9:25 38.7 11 9/22/2006 9:51 
26.2 11 9/22/2006 9:25 34.3 11 9/22/2006 9:51 
26.4 11 9/22/2006 9:25 30.4 11 9/22/2006 9:51 
27.2 11 9/22/2006 9:25 25.6 11 9/22/2006 9:51 
25.6 11 9/22/2006 9:25 23.9 11 9/22/2006 9:51 
24.4 11 9/22/2006 9:25 24.2 11 9/22/2006 9:51 
38.7 11 9/22/2006 9:25 24.5 11 9/22/2006 9:51 
102 11 9/22/2006 9:25 24.6 11 9/22/2006 9:51 
48.8 11 9/22/2006 9:25 23.6 11 9/22/2006 9:51 
36.9 11 9/22/2006 9:25 23.3 11 9/22/2006 9:51 
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Path Measurement Data 
Site 6 Path 3 

Path Measurement Data 
Site 6 Path 4 

ppm*m pathlength 
Timestamp 

(mountain time) ppm*m pathlength 
Timestamp 

(mountain time) 
39.1 11 9/22/2006 9:25 23.6 11 9/22/2006 9:51 
31 11 9/22/2006 9:25 23.5 11 9/22/2006 9:51 
27 11 9/22/2006 9:25 23.5 11 9/22/2006 9:51 

29.3 11 9/22/2006 9:25 23.6 11 9/22/2006 9:51 
137 11 9/22/2006 9:25 23.7 11 9/22/2006 9:51 

1027 11 9/22/2006 9:25 23.8 11 9/22/2006 9:51 
793 11 9/22/2006 9:25 23.7 11 9/22/2006 9:51 
391 11 9/22/2006 9:25 23.6 11 9/22/2006 9:51 
99.5 11 9/22/2006 9:25 23.5 11 9/22/2006 9:51 
56.3 11 9/22/2006 9:26 23.5 11 9/22/2006 9:51 
99.9 11 9/22/2006 9:26    
139 11 9/22/2006 9:26    
114 11 9/22/2006 9:26    
286 11 9/22/2006 9:26    
192 11 9/22/2006 9:26    
55.2 11 9/22/2006 9:26    
27.5 11 9/22/2006 9:26    
26.2 11 9/22/2006 9:26    
24.1 11 9/22/2006 9:26    
23.9 11 9/22/2006 9:26    
29.7 11 9/22/2006 9:26    
148 11 9/22/2006 9:26    
690 11 9/22/2006 9:26    
254 11 9/22/2006 9:26    
162 11 9/22/2006 9:26    
146 11 9/22/2006 9:26    
210 11 9/22/2006 9:26    
118 11 9/22/2006 9:26    
45 11 9/22/2006 9:26    

31.1 11 9/22/2006 9:26    
28.6 11 9/22/2006 9:26    
27.3 11 9/22/2006 9:26    
29.2 11 9/22/2006 9:26    
118 11 9/22/2006 9:26    
443 11 9/22/2006 9:26    
444 11 9/22/2006 9:26    
232 11 9/22/2006 9:26    
205 11 9/22/2006 9:26    
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Path Measurement Data 

Site 6 Path 5 

ppm*m pathlength 
Timestamp 

(mountain time) 
23.1 12 9/22/2006 9:53 
23.1 12 9/22/2006 9:53 
23.2 12 9/22/2006 9:53 
23.2 12 9/22/2006 9:53 
23.2 12 9/22/2006 9:53 
23.2 12 9/22/2006 9:53 
23.2 12 9/22/2006 9:53 
23.2 12 9/22/2006 9:53 
23.2 12 9/22/2006 9:53 
23.2 12 9/22/2006 9:53 
23.2 12 9/22/2006 9:53 
23.2 12 9/22/2006 9:53 
23.2 12 9/22/2006 9:54 
23.3 12 9/22/2006 9:54 
23.2 12 9/22/2006 9:54 
23.3 12 9/22/2006 9:54 
23.3 12 9/22/2006 9:54 
23.4 12 9/22/2006 9:54 
23.4 12 9/22/2006 9:54 
23.4 12 9/22/2006 9:54 
23.5 12 9/22/2006 9:54 
23.4 12 9/22/2006 9:54 
23.4 12 9/22/2006 9:54 
23.5 12 9/22/2006 9:54 
23.4 12 9/22/2006 9:54 
23.5 12 9/22/2006 9:54 
23.6 12 9/22/2006 9:54 
23.4 12 9/22/2006 9:54 
23.7 12 9/22/2006 9:54 
23.6 12 9/22/2006 9:54 
23.5 12 9/22/2006 9:54 
23.4 12 9/22/2006 9:54 
23.5 12 9/22/2006 9:54 
23.4 12 9/22/2006 9:54 
23.5 12 9/22/2006 9:54 
23.5 12 9/22/2006 9:54 
23.4 12 9/22/2006 9:54 
23.4 12 9/22/2006 9:54 
23.3 12 9/22/2006 9:54 
23.5 12 9/22/2006 9:54 
23.4 12 9/22/2006 9:54 
23.4 12 9/22/2006 9:54 
23.2 12 9/22/2006 9:54 
23.2 12 9/22/2006 9:54 
23.3 12 9/22/2006 9:54 
23.4 12 9/22/2006 9:55 
23.2 12 9/22/2006 9:55 
23.4 12 9/22/2006 9:55 
23.3 12 9/22/2006 9:55 
23.4 12 9/22/2006 9:55 
23.3 12 9/22/2006 9:55 
23.4 12 9/22/2006 9:55 
23.4 12 9/22/2006 9:55 
23.4 12 9/22/2006 9:55 
23.3 12 9/22/2006 9:55 
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Path Measurement Data 
Site 6 Path 5 

ppm*m pathlength 
Timestamp 

(mountain time) 
23.2 12 9/22/2006 9:55 
23.4 12 9/22/2006 9:55 
23.2 12 9/22/2006 9:55 
23.1 12 9/22/2006 9:55 
23 12 9/22/2006 9:55 

23.1 12 9/22/2006 9:55 
23.3 12 9/22/2006 9:55 
23.2 12 9/22/2006 9:55 
23.1 12 9/22/2006 9:55 
23.3 12 9/22/2006 9:55 
23.4 12 9/22/2006 9:55 
23.9 12 9/22/2006 9:55 
25.3 12 9/22/2006 9:55 
27.9 12 9/22/2006 9:55 
27.2 12 9/22/2006 9:55 
30.2 12 9/22/2006 9:55 
27.9 12 9/22/2006 9:55 
24.9 12 9/22/2006 9:55 
23.2 12 9/22/2006 9:55 
23.2 12 9/22/2006 9:55 
23.2 12 9/22/2006 9:55 
23.2 12 9/22/2006 9:55 
23.4 12 9/22/2006 9:55 
23.2 12 9/22/2006 9:55 
23.1 12 9/22/2006 9:56 
23.1 12 9/22/2006 9:56 
23.1 12 9/22/2006 9:56 
23.1 12 9/22/2006 9:56 
23.1 12 9/22/2006 9:56 
23.1 12 9/22/2006 9:56 
23 12 9/22/2006 9:56 

23.1 12 9/22/2006 9:56 
22.9 12 9/22/2006 9:56 
22.9 12 9/22/2006 9:56 
23.1 12 9/22/2006 9:56 
23.1 12 9/22/2006 9:56 
23 12 9/22/2006 9:56 

22.9 12 9/22/2006 9:56 
22.9 12 9/22/2006 9:56 
22.9 12 9/22/2006 9:56 
23 12 9/22/2006 9:56 
23 12 9/22/2006 9:56 
23 12 9/22/2006 9:56 

23.3 12 9/22/2006 9:56 
23.3 12 9/22/2006 9:56 
23.4 12 9/22/2006 9:56 
23.3 12 9/22/2006 9:56 
23.5 12 9/22/2006 9:56 
23.6 12 9/22/2006 9:56 
23.4 12 9/22/2006 9:56 
23.4 12 9/22/2006 9:56 
23.3 12 9/22/2006 9:56 
23.4 12 9/22/2006 9:56 
23.4 12 9/22/2006 9:56 
23.3 12 9/22/2006 9:56 
23.6 12 9/22/2006 9:56 
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Path Measurement Data 
Site 6 Path 5 

ppm*m pathlength 
Timestamp 

(mountain time) 
23.4 12 9/22/2006 9:56 
23.5 12 9/22/2006 9:56 
23.5 12 9/22/2006 9:57 
24 12 9/22/2006 9:57 

30.1 12 9/22/2006 9:57 
33.8 12 9/22/2006 9:57 
32.4 12 9/22/2006 9:57 
30 12 9/22/2006 9:57 

33.2 12 9/22/2006 9:57 
23.3 12 9/22/2006 9:57 
23.4 12 9/22/2006 9:57 
23.3 12 9/22/2006 9:57 
23.3 12 9/22/2006 9:57 
23.5 12 9/22/2006 9:57 
23.3 12 9/22/2006 9:57 
23.4 12 9/22/2006 9:57 
23.3 12 9/22/2006 9:57 
23.4 12 9/22/2006 9:57 
23.5 12 9/22/2006 9:57 
23.3 12 9/22/2006 9:57 
24.3 12 9/22/2006 9:57 
25.2 12 9/22/2006 9:57 
25.5 12 9/22/2006 9:57 
25.9 12 9/22/2006 9:57 
26.4 12 9/22/2006 9:57 
27.2 12 9/22/2006 9:57 
28.8 12 9/22/2006 9:57 
27.2 12 9/22/2006 9:57 
27.7 12 9/22/2006 9:57 
28.4 12 9/22/2006 9:57 
28.2 12 9/22/2006 9:57 
26.5 12 9/22/2006 9:57 
25.3 12 9/22/2006 9:57 
24.7 12 9/22/2006 9:57 
24.6 12 9/22/2006 9:57 
24.2 12 9/22/2006 9:57 
23.7 12 9/22/2006 9:57 
23.7 12 9/22/2006 9:58 
23.5 12 9/22/2006 9:58 
23.4 12 9/22/2006 9:58 
23.4 12 9/22/2006 9:58 
23.4 12 9/22/2006 9:58 
23.3 12 9/22/2006 9:58 
23.5 12 9/22/2006 9:58 
23.7 12 9/22/2006 9:58 
23.3 12 9/22/2006 9:58 
23.3 12 9/22/2006 9:58 
23.6 12 9/22/2006 9:58 
24.4 12 9/22/2006 9:58 
24.2 12 9/22/2006 9:58 
23.8 12 9/22/2006 9:58 
23.3 12 9/22/2006 9:58 
23.4 12 9/22/2006 9:58 
23.4 12 9/22/2006 9:58 
23.7 12 9/22/2006 9:58 
30.5 12 9/22/2006 9:58 
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Path Measurement Data 
Site 6 Path 5 

ppm*m pathlength 
Timestamp 

(mountain time) 
116 12 9/22/2006 9:58 
74.8 12 9/22/2006 9:58 
33.7 12 9/22/2006 9:58 
26 12 9/22/2006 9:58 

24.2 12 9/22/2006 9:58 
25 12 9/22/2006 9:58 

23.6 12 9/22/2006 9:58 
23.4 12 9/22/2006 9:58 
23.4 12 9/22/2006 9:58 
23.4 12 9/22/2006 9:58 
23.3 12 9/22/2006 9:58 
23.4 12 9/22/2006 9:58 
23.4 12 9/22/2006 9:58 
23.4 12 9/22/2006 9:58 
23.4 12 9/22/2006 9:58 
24.3 12 9/22/2006 9:59 
26.8 12 9/22/2006 9:59 
24.2 12 9/22/2006 9:59 
25.1 12 9/22/2006 9:59 
24.1 12 9/22/2006 9:59 
24.1 12 9/22/2006 9:59 
24 12 9/22/2006 9:59 

27.3 12 9/22/2006 9:59 
27.2 12 9/22/2006 9:59 
24.6 12 9/22/2006 9:59 
25.2 12 9/22/2006 9:59 
28.5 12 9/22/2006 9:59 
25.1 12 9/22/2006 9:59 
24.2 12 9/22/2006 9:59 
23.5 12 9/22/2006 9:59 
23.5 12 9/22/2006 9:59 
23.3 12 9/22/2006 9:59 
23.3 12 9/22/2006 9:59 
23.4 12 9/22/2006 9:59 
23.3 12 9/22/2006 9:59 
23.5 12 9/22/2006 9:59 
23.7 12 9/22/2006 9:59 
23.4 12 9/22/2006 9:59 
23.6 12 9/22/2006 9:59 
23.4 12 9/22/2006 9:59 
23.6 12 9/22/2006 9:59 
23.7 12 9/22/2006 9:59 
23.6 12 9/22/2006 9:59 
23.5 12 9/22/2006 9:59 
23.7 12 9/22/2006 9:59 
23.6 12 9/22/2006 9:59 
23.5 12 9/22/2006 9:59 
23.4 12 9/22/2006 9:59 
23.4 12 9/22/2006 9:59 
23.7 12 9/22/2006 10:00 
23.6 12 9/22/2006 10:00 
23.5 12 9/22/2006 10:00 
23.7 12 9/22/2006 10:00 
23.5 12 9/22/2006 10:00 
23.5 12 9/22/2006 10:00 
23.5 12 9/22/2006 10:00 

315



Path Measurement Data 
Site 6 Path 5 

ppm*m pathlength 
Timestamp 

(mountain time) 
23.7 12 9/22/2006 10:00 
23.7 12 9/22/2006 10:00 
23.6 12 9/22/2006 10:00 
23.7 12 9/22/2006 10:00 
23.6 12 9/22/2006 10:00 
23.7 12 9/22/2006 10:00 
23.7 12 9/22/2006 10:00 
23.7 12 9/22/2006 10:00 
23.6 12 9/22/2006 10:00 
23.7 12 9/22/2006 10:00 
23.7 12 9/22/2006 10:00 
23.5 12 9/22/2006 10:00 
23.7 12 9/22/2006 10:00 
23.6 12 9/22/2006 10:00 
23.7 12 9/22/2006 10:00 
23.6 12 9/22/2006 10:00 
23.9 12 9/22/2006 10:00 
23.8 12 9/22/2006 10:00 
23.8 12 9/22/2006 10:00 
23.7 12 9/22/2006 10:00 
23.5 12 9/22/2006 10:00 
23.6 12 9/22/2006 10:00 
23.7 12 9/22/2006 10:00 
23.8 12 9/22/2006 10:00 
23.9 12 9/22/2006 10:00 
23.8 12 9/22/2006 10:00 
23.9 12 9/22/2006 10:01 
23.6 12 9/22/2006 10:01 
23.6 12 9/22/2006 10:01 
23.6 12 9/22/2006 10:01 
23.4 12 9/22/2006 10:01 
23.9 12 9/22/2006 10:01 
23.8 12 9/22/2006 10:01 
23.8 12 9/22/2006 10:01 
23.7 12 9/22/2006 10:01 
23.7 12 9/22/2006 10:01 
23.9 12 9/22/2006 10:01 
24.8 12 9/22/2006 10:01 
23.8 12 9/22/2006 10:01 
23.9 12 9/22/2006 10:01 
23.8 12 9/22/2006 10:01 
23.8 12 9/22/2006 10:01 
23.8 12 9/22/2006 10:01 
23.7 12 9/22/2006 10:01 
24 12 9/22/2006 10:01 

23.8 12 9/22/2006 10:01 
23.9 12 9/22/2006 10:01 
24 12 9/22/2006 10:01 

24.1 12 9/22/2006 10:01 
24.2 12 9/22/2006 10:01 
24.3 12 9/22/2006 10:01 
24.2 12 9/22/2006 10:01 
25.6 12 9/22/2006 10:01 
24.6 12 9/22/2006 10:01 
24.4 12 9/22/2006 10:01 
23.8 12 9/22/2006 10:01 
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Path Measurement Data 
Site 6 Path 5 

ppm*m pathlength 
Timestamp 

(mountain time) 
23.8 12 9/22/2006 10:01 
24.3 12 9/22/2006 10:01 
24.6 12 9/22/2006 10:01 
24.3 12 9/22/2006 10:01 
24.1 12 9/22/2006 10:01 
24.2 12 9/22/2006 10:02 
24.1 12 9/22/2006 10:02 
24 12 9/22/2006 10:02 

24.1 12 9/22/2006 10:02 
24.1 12 9/22/2006 10:02 
24.1 12 9/22/2006 10:02 
24 12 9/22/2006 10:02 
24 12 9/22/2006 10:02 
24 12 9/22/2006 10:02 

24.2 12 9/22/2006 10:02 
24 12 9/22/2006 10:02 

23.9 12 9/22/2006 10:02 
23.9 12 9/22/2006 10:02 
24 12 9/22/2006 10:02 

23.7 12 9/22/2006 10:02 
23.7 12 9/22/2006 10:02 
23.8 12 9/22/2006 10:02 
23.8 12 9/22/2006 10:02 
23.6 12 9/22/2006 10:02 
23.5 12 9/22/2006 10:02 
23.7 12 9/22/2006 10:02 
23.6 12 9/22/2006 10:02 
23.6 12 9/22/2006 10:02 
23.6 12 9/22/2006 10:02 
23.8 12 9/22/2006 10:02 
23.5 12 9/22/2006 10:02 
23.6 12 9/22/2006 10:02 
23.6 12 9/22/2006 10:02 
23.6 12 9/22/2006 10:02 
23.8 12 9/22/2006 10:02 
116 12 9/22/2006 10:02 
90.8 12 9/22/2006 10:02 
24.6 12 9/22/2006 10:02 
24.9 12 9/22/2006 10:02 
25.6 12 9/22/2006 10:03 
26.1 12 9/22/2006 10:03 
34.4 12 9/22/2006 10:03 
33.2 12 9/22/2006 10:03 
27.5 12 9/22/2006 10:03 
126 12 9/22/2006 10:03 
268 12 9/22/2006 10:03 
280 12 9/22/2006 10:03 
87.8 12 9/22/2006 10:03 
29.2 12 9/22/2006 10:03 
45.7 12 9/22/2006 10:03 
132 12 9/22/2006 10:03 
111 12 9/22/2006 10:03 
98.6 12 9/22/2006 10:03 
65.3 12 9/22/2006 10:03 
54.4 12 9/22/2006 10:03 
42.5 12 9/22/2006 10:03 
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Path Measurement Data 
Site 6 Path 5 

ppm*m pathlength 
Timestamp 

(mountain time) 
37.7 12 9/22/2006 10:03 
32.5 12 9/22/2006 10:03 
36.7 12 9/22/2006 10:03 
40.7 12 9/22/2006 10:03 
40.8 12 9/22/2006 10:03 
37.7 12 9/22/2006 10:03 
37.1 12 9/22/2006 10:03 
33.9 12 9/22/2006 10:03 
26.4 12 9/22/2006 10:03 
25.8 12 9/22/2006 10:03 
23.6 12 9/22/2006 10:03 
23.8 12 9/22/2006 10:03 
23.8 12 9/22/2006 10:03 
23.8 12 9/22/2006 10:03 
24 12 9/22/2006 10:03 

23.7 12 9/22/2006 10:03 
23.6 12 9/22/2006 10:04 
23.8 12 9/22/2006 10:04 
23.7 12 9/22/2006 10:04 
23.7 12 9/22/2006 10:04 
23.7 12 9/22/2006 10:04 
23.5 12 9/22/2006 10:04 
23.6 12 9/22/2006 10:04 
23.6 12 9/22/2006 10:04 
23.6 12 9/22/2006 10:04 
23.7 12 9/22/2006 10:04 
23.8 12 9/22/2006 10:04 
23.8 12 9/22/2006 10:04 
24 12 9/22/2006 10:04 

24.6 12 9/22/2006 10:04 
24 12 9/22/2006 10:04 

23.7 12 9/22/2006 10:04 
23.6 12 9/22/2006 10:04 
23.7 12 9/22/2006 10:04 
23.6 12 9/22/2006 10:04 
23.5 12 9/22/2006 10:04 
23.4 12 9/22/2006 10:04 
23.6 12 9/22/2006 10:04 
23.5 12 9/22/2006 10:04 
23.5 12 9/22/2006 10:04 
23.3 12 9/22/2006 10:04 
23.6 12 9/22/2006 10:04 
23.4 12 9/22/2006 10:04 
23.6 12 9/22/2006 10:04 
23.5 12 9/22/2006 10:04 
23.3 12 9/22/2006 10:04 
23.4 12 9/22/2006 10:04 
23.4 12 9/22/2006 10:04 
23.4 12 9/22/2006 10:04 
23.6 12 9/22/2006 10:04 
24 12 9/22/2006 10:04 

120 12 9/22/2006 10:05 
386 12 9/22/2006 10:05 
157 12 9/22/2006 10:05 
132 12 9/22/2006 10:05 
183 12 9/22/2006 10:05 
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Path Measurement Data 
Site 6 Path 5 

ppm*m pathlength 
Timestamp 

(mountain time) 
162 12 9/22/2006 10:05 
111 12 9/22/2006 10:05 
36.7 12 9/22/2006 10:05 
32.1 12 9/22/2006 10:05 
27.5 12 9/22/2006 10:05 
33.4 12 9/22/2006 10:05 
61.4 12 9/22/2006 10:05 
48.6 12 9/22/2006 10:05 
66.3 12 9/22/2006 10:05 
36.8 12 9/22/2006 10:05 
27.4 12 9/22/2006 10:05 
24.1 12 9/22/2006 10:05 
23.7 12 9/22/2006 10:05 
24.2 12 9/22/2006 10:05 
24.8 12 9/22/2006 10:05 
24.9 12 9/22/2006 10:05 
25.3 12 9/22/2006 10:05 
26.9 12 9/22/2006 10:05 
31.4 12 9/22/2006 10:05 
38.4 12 9/22/2006 10:05 
45.6 12 9/22/2006 10:05 
55.8 12 9/22/2006 10:05 
55.1 12 9/22/2006 10:05 
33.4 12 9/22/2006 10:05 
28.2 12 9/22/2006 10:05 
25 12 9/22/2006 10:05 

24.5 12 9/22/2006 10:05 
24.8 12 9/22/2006 10:05 
25.5 12 9/22/2006 10:06 
26.2 12 9/22/2006 10:06 
31.3 12 9/22/2006 10:06 
48 12 9/22/2006 10:06 
47 12 9/22/2006 10:06 

49.2 12 9/22/2006 10:06 
56.8 12 9/22/2006 10:06 
48.8 12 9/22/2006 10:06 
46.3 12 9/22/2006 10:06 
30.6 12 9/22/2006 10:06 
24.2 12 9/22/2006 10:06 
23.8 12 9/22/2006 10:06 
23.6 12 9/22/2006 10:06 
23.6 12 9/22/2006 10:06 
23.5 12 9/22/2006 10:06 
23.6 12 9/22/2006 10:06 
24 12 9/22/2006 10:06 

23.6 12 9/22/2006 10:06 
23.9 12 9/22/2006 10:06 
23.8 12 9/22/2006 10:06 
23.7 12 9/22/2006 10:06 
24 12 9/22/2006 10:06 

23.5 12 9/22/2006 10:06 
23.7 12 9/22/2006 10:06 
23.5 12 9/22/2006 10:06 
23.7 12 9/22/2006 10:06 
23.2 12 9/22/2006 10:06 
23.7 12 9/22/2006 10:06 

319



Path Measurement Data 
Site 6 Path 5 

ppm*m pathlength 
Timestamp 

(mountain time) 
23.7 12 9/22/2006 10:06 
23.5 12 9/22/2006 10:06 
23.4 12 9/22/2006 10:06 
23.4 12 9/22/2006 10:06 
23.4 12 9/22/2006 10:06 
23.6 12 9/22/2006 10:06 
23.6 12 9/22/2006 10:07 
23.5 12 9/22/2006 10:07 
23.6 12 9/22/2006 10:07 
24.6 12 9/22/2006 10:07 
25.1 12 9/22/2006 10:07 
23.5 12 9/22/2006 10:07 
23.6 12 9/22/2006 10:07 
23.3 12 9/22/2006 10:07 
23.5 12 9/22/2006 10:07 
23.4 12 9/22/2006 10:07 
23.5 12 9/22/2006 10:07 
23.4 12 9/22/2006 10:07 
23.5 12 9/22/2006 10:07 
23.6 12 9/22/2006 10:07 
23.4 12 9/22/2006 10:07 
23.4 12 9/22/2006 10:07 
23.5 12 9/22/2006 10:07 
23.4 12 9/22/2006 10:07 
25.4 12 9/22/2006 10:07 
38 12 9/22/2006 10:07 

75.8 12 9/22/2006 10:07 
137 12 9/22/2006 10:07 
255 12 9/22/2006 10:07 
169 12 9/22/2006 10:07 
124 12 9/22/2006 10:07 
134 12 9/22/2006 10:07 
106 12 9/22/2006 10:07 
50.6 12 9/22/2006 10:07 
27.5 12 9/22/2006 10:07 
25.1 12 9/22/2006 10:07 
23.7 12 9/22/2006 10:07 
23.6 12 9/22/2006 10:07 
24 12 9/22/2006 10:07 

23.5 12 9/22/2006 10:07 
23.5 12 9/22/2006 10:07 
24 12 9/22/2006 10:08 

23.8 12 9/22/2006 10:08 
23.5 12 9/22/2006 10:08 
23.7 12 9/22/2006 10:08 
24 12 9/22/2006 10:08 

23.5 12 9/22/2006 10:08 
24 12 9/22/2006 10:08 

23.7 12 9/22/2006 10:08 
23.7 12 9/22/2006 10:08 
24 12 9/22/2006 10:08 

24.4 12 9/22/2006 10:08 
24.1 12 9/22/2006 10:08 
23.8 12 9/22/2006 10:08 
23.9 12 9/22/2006 10:08 
23.9 12 9/22/2006 10:08 
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Path Measurement Data 
Site 6 Path 5 

ppm*m pathlength 
Timestamp 

(mountain time) 
23.8 12 9/22/2006 10:08 
24.1 12 9/22/2006 10:08 
24.2 12 9/22/2006 10:08 
23.9 12 9/22/2006 10:08 
24 12 9/22/2006 10:08 

24.5 12 9/22/2006 10:08 
24.1 12 9/22/2006 10:08 
24.3 12 9/22/2006 10:08 
24.2 12 9/22/2006 10:08 
24.3 12 9/22/2006 10:08 
24.4 12 9/22/2006 10:08 
24.6 12 9/22/2006 10:08 
25.1 12 9/22/2006 10:08 
25.5 12 9/22/2006 10:08 
26.2 12 9/22/2006 10:08 
29.5 12 9/22/2006 10:08 
28.5 12 9/22/2006 10:08 
29.2 12 9/22/2006 10:09 
27.9 12 9/22/2006 10:09 
25.9 12 9/22/2006 10:09 
25 12 9/22/2006 10:09 

24.6 12 9/22/2006 10:09 
24.3 12 9/22/2006 10:09 
24.3 12 9/22/2006 10:09 
24 12 9/22/2006 10:09 

23.9 12 9/22/2006 10:09 
23.9 12 9/22/2006 10:09 
23.9 12 9/22/2006 10:09 
24 12 9/22/2006 10:09 

23.9 12 9/22/2006 10:09 
24.1 12 9/22/2006 10:09 
24 12 9/22/2006 10:09 

24.2 12 9/22/2006 10:09 
24.2 12 9/22/2006 10:09 
24.1 12 9/22/2006 10:09 
24.1 12 9/22/2006 10:09 
24.3 12 9/22/2006 10:09 
24.2 12 9/22/2006 10:09 
24.2 12 9/22/2006 10:09 
24.1 12 9/22/2006 10:09 
24.1 12 9/22/2006 10:09 
24.2 12 9/22/2006 10:09 
24.2 12 9/22/2006 10:09 
24.1 12 9/22/2006 10:09 
25.7 12 9/22/2006 10:09 
26.5 12 9/22/2006 10:09 
30.7 12 9/22/2006 10:09 
26 12 9/22/2006 10:09 

24.6 12 9/22/2006 10:09 
24.4 12 9/22/2006 10:09 
24.5 12 9/22/2006 10:09 
24.3 12 9/22/2006 10:10 
24.3 12 9/22/2006 10:10 
24.9 12 9/22/2006 10:10 
24.3 12 9/22/2006 10:10 
24.2 12 9/22/2006 10:10 
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Path Measurement Data 
Site 6 Path 5 

ppm*m pathlength 
Timestamp 

(mountain time) 
24 12 9/22/2006 10:10 

24.1 12 9/22/2006 10:10 
24 12 9/22/2006 10:10 
24 12 9/22/2006 10:10 

23.9 12 9/22/2006 10:10 
24.1 12 9/22/2006 10:10 
23.9 12 9/22/2006 10:10 
24 12 9/22/2006 10:10 

24.1 12 9/22/2006 10:10 
23.9 12 9/22/2006 10:10 
24 12 9/22/2006 10:10 

24.1 12 9/22/2006 10:10 
24.1 12 9/22/2006 10:10 
24.1 12 9/22/2006 10:10 
24 12 9/22/2006 10:10 

24.3 12 9/22/2006 10:10 
24.3 12 9/22/2006 10:10 
23.8 12 9/22/2006 10:10 
23.9 12 9/22/2006 10:10 
23.8 12 9/22/2006 10:10 
24 12 9/22/2006 10:10 
24 12 9/22/2006 10:10 
24 12 9/22/2006 10:10 
24 12 9/22/2006 10:10 

24.1 12 9/22/2006 10:10 
24 12 9/22/2006 10:10 
24 12 9/22/2006 10:10 

24.2 12 9/22/2006 10:10 
24 12 9/22/2006 10:10 
24 12 9/22/2006 10:10 

24.3 12 9/22/2006 10:11 
31.1 12 9/22/2006 10:11 
25.1 12 9/22/2006 10:11 
24 12 9/22/2006 10:11 

24.2 12 9/22/2006 10:11 
24.3 12 9/22/2006 10:11 
24.3 12 9/22/2006 10:11 
24.9 12 9/22/2006 10:11 
24.4 12 9/22/2006 10:11 
24.1 12 9/22/2006 10:11 
24 12 9/22/2006 10:11 
24 12 9/22/2006 10:11 

24.1 12 9/22/2006 10:11 
24 12 9/22/2006 10:11 

24.1 12 9/22/2006 10:11 
24.2 12 9/22/2006 10:11 
24 12 9/22/2006 10:11 

24.1 12 9/22/2006 10:11 
24.2 12 9/22/2006 10:11 
24.1 12 9/22/2006 10:11 
24 12 9/22/2006 10:11 

24.1 12 9/22/2006 10:11 
24.1 12 9/22/2006 10:11 
23.9 12 9/22/2006 10:11 
24 12 9/22/2006 10:11 

24.1 12 9/22/2006 10:11 
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Path Measurement Data 
Site 6 Path 5 

ppm*m pathlength 
Timestamp 

(mountain time) 
24 12 9/22/2006 10:11 
24 12 9/22/2006 10:11 

23.9 12 9/22/2006 10:11 
24 12 9/22/2006 10:11 

23.9 12 9/22/2006 10:11 
24 12 9/22/2006 10:11 
24 12 9/22/2006 10:11 
24 12 9/22/2006 10:11 
24 12 9/22/2006 10:12 

24.3 12 9/22/2006 10:12 
24.1 12 9/22/2006 10:12 
24.1 12 9/22/2006 10:12 
24.1 12 9/22/2006 10:12 
24.2 12 9/22/2006 10:12 
24.1 12 9/22/2006 10:12 
24.1 12 9/22/2006 10:12 
24.1 12 9/22/2006 10:12 
24.2 12 9/22/2006 10:12 
24.1 12 9/22/2006 10:12 
24.1 12 9/22/2006 10:12 
24.1 12 9/22/2006 10:12 
24.2 12 9/22/2006 10:12 
24.2 12 9/22/2006 10:12 
24.2 12 9/22/2006 10:12 
24.3 12 9/22/2006 10:12 
24.2 12 9/22/2006 10:12 
24.1 12 9/22/2006 10:12 
24.2 12 9/22/2006 10:12 
24.1 12 9/22/2006 10:12 
24.1 12 9/22/2006 10:12 
24.4 12 9/22/2006 10:12 
24.3 12 9/22/2006 10:12 
24.4 12 9/22/2006 10:12 
28 12 9/22/2006 10:12 

47.9 12 9/22/2006 10:12 
40.7 12 9/22/2006 10:12 
31.4 12 9/22/2006 10:12 
24.6 12 9/22/2006 10:12 
24.3 12 9/22/2006 10:12 
24 12 9/22/2006 10:12 

24.1 12 9/22/2006 10:12 
24.2 12 9/22/2006 10:13 
24.3 12 9/22/2006 10:13 
24.4 12 9/22/2006 10:13 
24.6 12 9/22/2006 10:13 
24.4 12 9/22/2006 10:13 
24.4 12 9/22/2006 10:13 
24.4 12 9/22/2006 10:13 
24.4 12 9/22/2006 10:13 
24.5 12 9/22/2006 10:13 
24.4 12 9/22/2006 10:13 
24.5 12 9/22/2006 10:13 
24.4 12 9/22/2006 10:13 
24.3 12 9/22/2006 10:13 
64.1 12 9/22/2006 10:13 
74.1 12 9/22/2006 10:13 
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Path Measurement Data 
Site 6 Path 5 

ppm*m pathlength 
Timestamp 

(mountain time) 
164 12 9/22/2006 10:13 
203 12 9/22/2006 10:13 
180 12 9/22/2006 10:13 
183 12 9/22/2006 10:13 
306 12 9/22/2006 10:13 
140 12 9/22/2006 10:13 
55.6 12 9/22/2006 10:13 
128 12 9/22/2006 10:13 
153 12 9/22/2006 10:13 
201 12 9/22/2006 10:13 
130 12 9/22/2006 10:13 
108 12 9/22/2006 10:13 
52 12 9/22/2006 10:13 

31.8 12 9/22/2006 10:13 
25.7 12 9/22/2006 10:13 
26.2 12 9/22/2006 10:13 
27.3 12 9/22/2006 10:13 
29.1 12 9/22/2006 10:13 
30.5 12 9/22/2006 10:13 
29.2 12 9/22/2006 10:13 
25.7 12 9/22/2006 10:14 
25 12 9/22/2006 10:14 

24.7 12 9/22/2006 10:14 
24.7 12 9/22/2006 10:14 
24.8 12 9/22/2006 10:14 
24.9 12 9/22/2006 10:14 
25.3 12 9/22/2006 10:14 
26.7 12 9/22/2006 10:14 
25.9 12 9/22/2006 10:14 
27 12 9/22/2006 10:14 

25.1 12 9/22/2006 10:14 
24.8 12 9/22/2006 10:14 
24.4 12 9/22/2006 10:14 
25.1 12 9/22/2006 10:14 
25.3 12 9/22/2006 10:14 
24.9 12 9/22/2006 10:14 
24.9 12 9/22/2006 10:14 
24.7 12 9/22/2006 10:14 
24.7 12 9/22/2006 10:14 
24.8 12 9/22/2006 10:14 
24.8 12 9/22/2006 10:14 
24.5 12 9/22/2006 10:14 
24.3 12 9/22/2006 10:14 
24.4 12 9/22/2006 10:14 
24.4 12 9/22/2006 10:14 
24.3 12 9/22/2006 10:14 
24.4 12 9/22/2006 10:14 
24.3 12 9/22/2006 10:14 
24.5 12 9/22/2006 10:14 
24.4 12 9/22/2006 10:14 
24.3 12 9/22/2006 10:14 
24.3 12 9/22/2006 10:14 
24.5 12 9/22/2006 10:14 
24.4 12 9/22/2006 10:14 
24.5 12 9/22/2006 10:15 
24.3 12 9/22/2006 10:15 
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Path Measurement Data 
Site 6 Path 5 

ppm*m pathlength 
Timestamp 

(mountain time) 
24.4 12 9/22/2006 10:15 
24.8 12 9/22/2006 10:15 
24.5 12 9/22/2006 10:15 
25 12 9/22/2006 10:15 

36.5 12 9/22/2006 10:15 
395 12 9/22/2006 10:15 
589 12 9/22/2006 10:15 
178 12 9/22/2006 10:15 
44.4 12 9/22/2006 10:15 
36.6 12 9/22/2006 10:15 
35.5 12 9/22/2006 10:15 
40.3 12 9/22/2006 10:15 
26.2 12 9/22/2006 10:15 
27.2 12 9/22/2006 10:15 
24.4 12 9/22/2006 10:15 
24.2 12 9/22/2006 10:15 
24.4 12 9/22/2006 10:15 
24.3 12 9/22/2006 10:15 
24.2 12 9/22/2006 10:15 
24.4 12 9/22/2006 10:15 
24.3 12 9/22/2006 10:15 
24.5 12 9/22/2006 10:15 
24.4 12 9/22/2006 10:15 
24.4 12 9/22/2006 10:15 
24.5 12 9/22/2006 10:15 
24.5 12 9/22/2006 10:15 
24.5 12 9/22/2006 10:15 
24.4 12 9/22/2006 10:15 
24.3 12 9/22/2006 10:15 
24.4 12 9/22/2006 10:15 
24.3 12 9/22/2006 10:15 
24.3 12 9/22/2006 10:16 
24.5 12 9/22/2006 10:16 
24.3 12 9/22/2006 10:16 
24.7 12 9/22/2006 10:16 
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Meteorological Data  
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Site 1 Met Data 
 

Year Date Time 
(hhmm) 

Average 
Wind 

Speed 
(mph) 

Average 
Wind 

Direction 
(Deg.) 

Average 
Standard 
Deviation 

Resultant 
Wind 

Speed 

Resultant 
Wind 

Direction 

Resultant 
Standard 
Deviation 

Wind 
Gust 
(mph) 

Tempera
-ture      
(F) 

2006 9/19/06 950 0.9 182 0.1 0.9 182.2 0.10 4.2 4.0 
2006 9/19/06 955 1.4 183 5.0 1.4 183.9 5.60 2.5 59.0 
2006 9/19/06 1000 1.9 208 53.4 1.3 207.8 46.43 3.0 58.7 
2006 9/19/06 1005 2.5 231 54.0 1.7 234.1 45.37 5.3 58.3 
2006 9/19/06 1020 2.8 245 59.8 1.8 241.6 47.67 7.4 58.2 
2006 9/19/06 1025 2.7 142 57.6 1.8 144.1 48.16 12.9 59.1 
2006 9/19/06 1030 2.6 101 40.5 2.1 102.4 35.81 13.2 59.9 
2006 9/19/06 1035 2.9 85 31.0 2.5 83.2 29.65 4.3 60.9 
2006 9/19/06 1040 2.8 134 20.7 2.7 136.9 17.13 4.9 60.5 
2006 9/19/06 1045 2.8 116 56.7 1.7 120.2 50.25 5.2 60.8 
2006 9/19/06 1050 2.4 130 23.0 2.2 130.5 21.88 3.6 61.2 
2006 9/19/06 1055 2.4 109 39.7 1.9 110.3 36.05 3.6 62.2 
2006 9/19/06 1100 2.3 110 42.3 1.7 111.8 40.80 13.1 63.2 
2006 9/19/06 1105 2.3 65 38.8 1.8 59.2 38.57 3.7 62.6 
2006 9/19/06 1110 2.6 69 31.4 2.2 63.6 31.51 5.8 62.8 
2006 9/19/06 1115 2.5 118 45.1 1.7 128.4 44.75 5.3 63.3 
2006 9/19/06 1120 2.5 112 37.9 2.0 114.7 35.69 4.7 64.4 
2006 9/19/06 1125 2.7 150 39.1 2.1 153.3 37.05 4.7 64.6 
2006 9/19/06 1130 2.7 52 46.1 2.1 47.7 39.49 11.2 64.7 
2006 9/19/06 1135 2.9 121 45.5 2.1 122.7 42.37 5.0 64.4 
2006 9/19/06 1140 2.6 142 84.9 0.8 144.1 67.24 4.5 64.7 
2006 9/19/06 1145 2.8 122 15.8 2.7 122.2 14.35 4.2 64.0 
2006 9/19/06 1150 2.2 126 44.2 1.6 130.1 41.85 4.5 64.1 
2006 9/19/06 1155 2.0 121 50.8 1.4 121.2 43.45 3.0 65.5 
2006 9/19/06 1200 2.3 111 29.5 2.0 110.1 28.56 3.2 66.1 
2006 9/19/06 1205 2.8 123 61.7 1.5 121.8 55.03 5.1 66.1 
2006 9/19/06 1210 2.4 15 72.6 1.2 2.8 57.25 6.1 66.6 
2006 9/19/06 1215 2.9 132 79.0 0.9 129.0 67.66 6.0 67.2 
2006 9/19/06 1220 3.2 153 93.2 0.3 132.1 76.50 5.6 66.4 
2006 9/19/06 1225 2.8 116 71.1 1.4 122.3 58.60 4.2 65.8 
2006 9/19/06 1230 2.2 92 45.2 1.6 89.7 40.50 3.1 66.0 
2006 9/19/06 1235 2.5 27 68.9 0.8 19.3 66.39 7.7 67.2 
2006 9/19/06 1240 2.4 109 54.9 1.4 109.9 52.05 4.9 67.1 
2006 9/19/06 1245 2.8 137 64.9 1.2 151.4 60.51 7.1 67.2 
2006 9/19/06 1250 3.0 104 59.6 1.7 105.8 54.59 5.0 67.1 
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Site 2 Met Data 
 

Year Date Time 
(hhmm) 

Average 
Wind 

Speed 
(mph) 

Average 
Wind 

Direction 
(Deg.) 

Average 
Standard 
Deviation 

Resultant 
Wind 

Speed 

Resultant 
Wind 

Direction 

Resultant 
Standard 
Deviation 

Wind 
Gust 
(mph) 

Tempera
-ture      
(F) 

2006 9/19/06 1510 3.1 134 62.5 1.7 138.2 55.02 9.4 67.2 
2006 9/19/06 1515 1.5 82 41.1 1.1 78.1 39.52 6.1 64.7 
2006 9/19/06 1520 2.0 126 53.5 1.2 127.0 50.06 3.8 66.3 
2006 9/19/06 1525 3.0 88 66.9 1.6 69.0 55.27 9.1 67.7 
2006 9/19/06 1530 2.3 104 65.0 1.1 100.0 59.34 4.9 68.7 
2006 9/19/06 1531 1.4 148 0.0 1.4 148.0 0.00 1.4 69.3 
2006 9/19/06 1532 2.9 63 59.0 1.8 52.6 49.77 10.8 69.2 
2006 9/19/06 1533 2.9 80 24.7 2.6 77.9 23.68 3.9 69.2 
2006 9/19/06 1534 2.7 80 40.7 2.0 79.0 39.55 4.0 69.3 
2006 9/19/06 1535 3.3 73 74.7 1.3 68.9 63.15 4.2 68.8 
2006 9/19/06 1536 3.1 69 87.6 0.6 62.7 72.10 3.8 68.7 
2006 9/19/06 1537 2.8 326 47.5 2.0 324.4 44.13 3.7 68.4 
2006 9/19/06 1538 2.8 73 50.7 2.0 67.4 41.97 4.4 68.7 
2006 9/19/06 1539 2.3 102 44.9 1.6 93.9 43.58 4.0 68.9 
2006 9/19/06 1540 3.6 52 58.3 2.3 45.4 49.55 7.0 68.6 
2006 9/19/06 1541 2.5 105 47.0 1.7 105.4 45.08 3.1 69.0 
2006 9/19/06 1542 2.6 132 59.3 1.5 136.9 53.88 4.0 69.1 
2006 9/19/06 1543 2.4 105 56.8 1.6 94.9 47.59 13.3 69.1 
2006 9/19/06 1544 2.3 79 44.9 1.8 78.1 36.96 3.1 69.2 
2006 9/19/06 1545 2.4 82 60.2 1.5 74.0 48.49 5.4 69.3 
2006 9/19/06 1546 2.5 51 43.4 1.8 54.5 43.13 5.2 69.3 
2006 9/19/06 1547 2.5 95 29.3 2.3 92.8 26.53 3.2 69.3 
2006 9/19/06 1548 2.0 61 39.1 1.5 64.2 41.90 3.2 69.5 
2006 9/19/06 1549 3.0 125 57.8 1.8 135.0 50.88 4.1 68.7 
2006 9/19/06 1550 2.9 38 44.1 2.1 39.5 40.91 3.6 68.1 
2006 9/19/06 1551 2.7 76 28.5 2.4 81.2 27.32 3.8 67.5 
2006 9/19/06 1552 2.2 39 53.1 1.4 39.8 49.42 2.9 67.0 
2006 9/19/06 1553 2.5 66 18.7 2.4 69.7 18.68 3.6 66.6 
2006 9/19/06 1554 1.7 80 13.2 1.6 78.7 13.85 2.4 66.3 
2006 9/19/06 1555 1.8 55 18.0 1.7 54.0 17.34 2.4 65.9 
2006 9/19/06 1556 2.1 84 31.1 1.8 82.9 29.75 2.6 65.7 
2006 9/19/06 1557 2.2 98 90.0 0.1 40.0 79.30 3.6 65.5 
2006 9/19/06 1558 1.8 127 18.2 1.7 125.3 18.42 2.1 65.3 
2006 9/19/06 1559 0.9 134 14.4 0.9 133.2 14.02 1.4 65.3 
2006 9/19/06 1600 1.8 80 58.2 0.9 75.7 53.58 2.7 65.3 
2006 9/19/06 1601 1.9 141 63.7 1.1 142.7 53.19 2.7 65.2 
2006 9/19/06 1602 1.8 90 41.9 1.3 80.8 43.14 2.7 65.7 
2006 9/19/06 1603 2.1 104 39.4 1.7 104.5 38.05 2.7 66.1 
2006 9/19/06 1604 2.0 182 67.6 0.9 186.2 59.34 2.5 66.1 
2006 9/19/06 1605 3.1 268 85.7 0.8 268.6 69.71 4.4 65.9 
2006 9/19/06 1606 2.4 105 63.1 1.4 116.0 53.83 3.6 65.7 
2006 9/19/06 1607 2.8 307 54.9 1.9 304.9 47.87 4.0 65.7 
2006 9/19/06 1608 2.4 149 67.1 0.8 171.7 65.46 3.9 65.5 
2006 9/19/06 1609 1.2 118 7.9 1.2 117.1 7.88 1.8 65.7 
2006 9/19/06 1610 1.7 85 38.1 1.4 74.1 34.59 3.0 65.8 
2006 9/19/06 1611 1.7 133 24.0 1.5 134.0 24.21 2.2 66.0 
2006 9/19/06 1612 1.7 111 67.9 0.9 127.9 55.66 2.9 66.1 

328



2006 9/19/06 1613 1.5 98 20.8 1.4 99.0 20.50 2.1 66.1 
2006 9/19/06 1614 1.6 128 31.8 1.4 127.0 30.03 1.9 66.2 
2006 9/19/06 1615 3.0 183 78.3 1.2 229.2 62.02 7.0 65.8 
2006 9/19/06 1616 1.9 134 51.9 1.2 133.5 48.27 2.4 65.5 
2006 9/19/06 1617 2.2 88 36.2 1.8 81.8 31.80 3.1 65.2 
2006 9/19/06 1618 1.9 104 45.0 1.4 101.5 39.92 2.7 65.0 
2006 9/19/06 1619 1.6 129 18.9 1.5 129.7 18.85 1.9 64.7 
2006 9/19/06 1620 1.5 148 15.6 1.4 148.7 15.38 1.8 64.5 
2006 9/19/06 1621 1.7 111 13.1 1.7 110.5 12.84 2.2 64.2 
2006 9/19/06 1622 1.5 101 16.1 1.5 99.4 15.17 2.3 64.0 
2006 9/19/06 1623 2.2 82 11.8 2.1 81.5 11.91 2.5 63.8 
2006 9/19/06 1624 1.9 78 25.2 1.7 78.4 24.20 2.2 64.0 
2006 9/19/06 1625 2.4 92 9.8 2.3 91.0 9.74 3.4 64.2 
2006 9/19/06 1626 1.9 105 18.7 1.8 102.6 19.41 2.6 64.3 
2006 9/19/06 1627 1.1 101 33.4 0.9 101.2 32.42 1.2 64.4 
2006 9/19/06 1628 1.3 114 21.4 1.2 112.4 21.27 1.9 64.3 
2006 9/19/06 1629 2.3 57 30.8 2.1 58.2 26.20 3.4 64.3 
2006 9/19/06 1630 2.5 91 23.1 2.3 89.2 19.86 3.2 64.4 
2006 9/19/06 1631 2.4 66 12.8 2.3 66.3 13.25 3.1 64.5 
2006 9/19/06 1632 2.0 68 18.3 1.9 69.4 17.56 3.0 64.8 
2006 9/19/06 1633 2.2 76 13.5 2.1 75.5 13.36 2.7 65.0 
2006 9/19/06 1634 2.0 41 22.9 1.9 41.3 21.63 2.8 65.1 
2006 9/19/06 1635 2.6 19 59.5 1.5 15.3 52.13 3.6 65.3 
2006 9/19/06 1636 1.9 114 81.0 0.5 105.7 69.29 2.7 65.6 
2006 9/19/06 1637 2.0 91 48.9 1.4 92.7 45.72 2.7 65.8 
2006 9/19/06 1638 1.9 71 36.1 1.5 68.0 35.07 2.4 65.7 
2006 9/19/06 1639 1.8 78 39.2 1.4 74.6 36.67 2.2 65.6 
2006 9/19/06 1640 1.8 168 19.4 1.7 167.2 18.98 2.1 65.5 
2006 9/19/06 1641 1.2 119 14.8 1.1 118.6 14.02 1.8 65.4 
2006 9/19/06 1642 1.9 140 41.7 1.5 142.8 39.27 2.5 65.1 
2006 9/19/06 1643 1.6 100 34.4 1.3 102.4 34.70 2.1 65.0 
2006 9/19/06 1644 1.2 107 19.3 1.1 107.8 20.08 1.7 65.0 
2006 9/19/06 1645 1.6 124 24.2 1.4 120.2 24.57 2.6 64.8 
2006 9/19/06 1646 1.9 88 37.9 1.6 90.3 34.32 2.7 64.4 
2006 9/19/06 1647 1.7 111 19.0 1.6 109.5 19.70 2.7 64.2 
2006 9/19/06 1648 1.9 108 24.8 1.7 109.1 24.43 3.3 64.0 
2006 9/19/06 1649 1.8 28 78.7 0.7 46.7 61.26 2.5 63.8 
2006 9/19/06 1650 1.8 103 18.3 1.7 99.6 18.90 2.4 63.8 
2006 9/19/06 1651 0.5 114 4.2 0.5 114.3 4.15 1.0 64.1 
2006 9/19/06 1652 1.0 91 20.3 1.0 89.9 19.52 1.3 64.2 
2006 9/19/06 1653 1.3 93 26.7 1.2 96.8 26.68 2.1 64.4 
2006 9/19/06 1654 0.7 99 31.9 0.6 102.2 29.89 1.6 64.6 
2006 9/19/06 1655 1.2 184 48.6 0.8 191.7 45.02 2.1 64.8 
2006 9/19/06 1656 2.2 45 14.5 2.2 44.8 14.12 3.0 64.9 
2006 9/19/06 1657 1.7 113 21.8 1.6 108.4 21.76 2.3 64.9 
2006 9/19/06 1658 1.0 113 3.8 1.0 113.1 3.94 1.2 64.9 
2006 9/19/06 1659 1.2 103 10.5 1.2 100.1 11.95 2.4 64.8 
2006 9/19/06 1700 2.1 100 17.8 2.0 95.3 16.74 2.7 64.7 
2006 9/19/06 1701 1.5 144 59.5 0.7 160.6 59.97 2.5 64.4 
2006 9/19/06 1702 1.7 138 60.9 0.9 139.7 55.43 2.1 64.3 
2006 9/19/06 1703 1.1 131 25.3 1.0 130.4 25.19 1.3 64.2 
2006 9/19/06 1704 1.6 145 14.5 1.5 145.2 13.54 2.1 64.0 
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2006 9/19/06 1705 1.5 123 13.2 1.5 123.7 12.66 2.0 63.8 
2006 9/19/06 1706 1.4 130 9.5 1.4 129.7 9.41 1.9 63.7 
2006 9/19/06 1707 1.5 131 9.9 1.5 130.5 9.76 1.9 63.5 
2006 9/19/06 1708 2.3 81 17.0 2.2 80.3 17.29 3.5 63.1 
2006 9/19/06 1709 2.4 92 23.3 2.3 88.9 19.60 3.6 62.9 

330



Site 3 Met Data 
 

Year Date Time 
(hhmm) 

Average 
Wind 

Speed 
(mph) 

Average 
Wind 

Direction 
(Deg.) 

Average 
Standard 
Deviation 

Resultant 
Wind 

Speed 

Resultant 
Wind 

Direction 

Resultant 
Standard 
Deviation 

Wind 
Gust 
(mph) 

Tempera
-ture      
(F) 

           
2006 9/20/06 956 1.6 74 15.4 1.5 74.4 14.61 8.4 61.9 
2006 9/20/06 957 2.4 78 0.2 2.4 77.5 0.24 2.5 51.5 
2006 9/20/06 958 1.9 102 21.6 1.8 102.5 20.72 9.7 51.6 
2006 9/20/06 959 1.8 83 27.6 1.6 80.1 25.15 2.7 51.9 
2006 9/20/06 1000 1.8 46 33.2 1.5 50.1 33.12 2.8 51.8 
2006 9/20/06 1001 2.0 57 23.2 1.8 57.9 22.22 2.5 51.8 
2006 9/20/06 1002 2.0 107 17.6 1.9 105.6 17.07 2.6 51.8 
2006 9/20/06 1003 1.8 126 11.7 1.8 125.8 11.14 2.5 51.7 
2006 9/20/06 1004 1.9 71 35.9 1.5 75.8 35.08 2.3 51.6 
2006 9/20/06 1005 1.9 113 53.0 1.2 112.3 49.11 2.2 51.4 
2006 9/20/06 1006 2.1 87 49.6 1.5 79.4 42.20 3.0 51.4 
2006 9/20/06 1007 1.8 82 21.0 1.6 84.7 20.75 2.2 51.2 
2006 9/20/06 1008 2.6 122 9.3 2.6 121.6 9.14 3.1 51.0 
2006 9/20/06 1009 1.8 93 16.1 1.7 93.0 15.96 2.3 50.9 
2006 9/20/06 1010 1.7 113 30.2 1.5 113.0 27.67 2.9 50.9 
2006 9/20/06 1011 3.1 113 45.5 2.4 112.2 38.84 4.2 50.7 
2006 9/20/06 1012 2.5 59 41.6 1.9 58.1 39.68 2.9 50.6 
2006 9/20/06 1013 2.5 112 16.9 2.4 113.3 15.65 3.6 50.6 
2006 9/20/06 1014 1.9 97 12.0 1.8 97.1 11.77 2.2 50.6 
2006 9/20/06 1015 1.3 84 17.9 1.2 85.2 17.24 1.8 50.6 
2006 9/20/06 1016 1.8 62 12.7 1.8 62.7 11.85 2.4 50.5 
2006 9/20/06 1017 1.4 98 15.1 1.4 97.3 15.71 2.3 50.5 
2006 9/20/06 1018 2.2 116 28.1 1.9 114.9 26.92 2.4 50.6 
2006 9/20/06 1019 1.8 92 25.0 1.7 92.8 23.48 2.6 50.6 
2006 9/20/06 1020 1.6 83 20.1 1.5 81.9 19.63 1.9 50.6 
2006 9/20/06 1021 1.7 101 27.2 1.5 99.4 26.22 2.2 50.6 
2006 9/20/06 1022 1.4 99 18.2 1.3 98.1 18.38 1.7 50.6 
2006 9/20/06 1023 1.4 113 7.6 1.4 111.1 7.81 2.1 50.6 
2006 9/20/06 1024 1.3 108 17.3 1.3 107.3 17.05 1.6 50.8 
2006 9/20/06 1025 1.4 96 9.7 1.4 93.9 10.04 2.5 50.8 
2006 9/20/06 1026 1.7 84 24.5 1.5 81.8 23.93 2.4 50.9 
2006 9/20/06 1027 1.6 112 15.8 1.6 109.7 14.45 2.1 51.0 
2006 9/20/06 1028 2.4 106 45.2 1.9 104.9 37.59 3.7 50.8 
2006 9/20/06 1029 2.0 92 5.1 2.0 91.9 5.30 2.4 51.0 
2006 9/20/06 1030 1.4 94 23.6 1.3 99.9 23.43 2.0 51.0 
2006 9/20/06 1031 1.7 106 13.8 1.7 105.6 13.54 2.0 51.1 
2006 9/20/06 1032 2.1 133 17.1 2.0 133.1 16.82 2.4 51.0 
2006 9/20/06 1033 2.4 123 19.2 2.2 122.1 18.89 2.7 50.9 
2006 9/20/06 1034 2.3 117 18.6 2.2 117.2 18.13 2.8 50.9 
2006 9/20/06 1035 1.6 103 6.4 1.5 103.0 6.78 1.9 51.0 
2006 9/20/06 1036 2.2 68 27.2 2.0 70.4 24.73 2.7 50.9 
2006 9/20/06 1037 2.2 95 38.9 1.8 91.5 35.50 2.8 50.8 
2006 9/20/06 1038 1.9 122 37.6 1.5 120.3 35.76 2.5 50.8 
2006 9/20/06 1039 1.9 54 32.8 1.6 54.1 31.33 2.2 50.6 
2006 9/20/06 1040 2.3 150 29.2 2.0 150.9 28.91 3.8 50.4 
2006 9/20/06 1041 2.4 111 47.1 1.8 111.7 41.28 3.2 50.3 
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2006 9/20/06 1042 2.2 91 24.7 2.0 90.6 24.49 2.7 50.2 
2006 9/20/06 1043 2.0 138 19.3 1.9 139.4 19.48 2.7 50.2 
2006 9/20/06 1044 2.0 216 54.0 1.3 213.1 48.02 2.7 50.0 
2006 9/20/06 1045 1.6 71 46.0 1.1 70.7 42.86 1.8 50.0 
2006 9/20/06 1046 1.5 102 12.1 1.5 103.1 12.07 1.9 50.0 
2006 9/20/06 1047 2.1 109 18.4 2.0 109.2 18.52 2.7 50.0 
2006 9/20/06 1048 1.6 94 49.5 1.0 94.0 49.49 2.3 50.0 
2006 9/20/06 1049 2.1 153 37.0 1.7 152.9 36.14 2.5 50.0 
2006 9/20/06 1050 2.0 172 31.0 1.7 174.0 30.89 2.4 49.9 
2006 9/20/06 1051 2.0 135 18.6 1.9 134.4 16.83 2.5 49.7 
2006 9/20/06 1052 2.5 136 15.5 2.4 136.2 15.22 2.9 49.7 
2006 9/20/06 1053 1.8 110 21.3 1.6 112.8 22.25 2.7 49.8 
2006 9/20/06 1054 1.6 86 17.5 1.5 85.5 17.23 1.9 49.9 
2006 9/20/06 1055 1.8 94 34.8 1.5 93.9 34.18 2.2 49.9 
2006 9/20/06 1056 2.0 143 46.1 1.4 148.7 44.53 2.5 50.1 
2006 9/20/06 1057 1.5 79 11.2 1.5 79.2 10.54 2.0 50.1 
2006 9/20/06 1058 1.1 143 36.3 0.9 146.3 35.74 1.4 50.2 
2006 9/20/06 1059 1.3 187 9.4 1.3 187.0 9.42 1.5 50.3 
2006 9/20/06 1100 1.5 143 25.2 1.4 142.6 25.26 1.9 50.3 
2006 9/20/06 1101 2.5 45 27.4 2.3 44.0 25.58 3.2 50.4 
2006 9/20/06 1102 1.8 67 5.3 1.8 66.9 5.13 2.2 50.3 
2006 9/20/06 1103 1.5 72 4.9 1.5 71.4 4.89 1.8 50.4 
2006 9/20/06 1104 1.7 73 15.6 1.6 74.4 16.47 2.7 50.5 
2006 9/20/06 1105 3.4 141 38.7 2.8 142.1 34.75 5.2 50.5 
2006 9/20/06 1106 2.9 130 22.9 2.7 132.6 22.63 4.4 51.0 
2006 9/20/06 1107 2.5 154 51.8 1.8 157.7 42.21 3.5 50.9 
2006 9/20/06 1108 2.2 96 17.9 2.1 96.2 17.24 2.6 51.0 
2006 9/20/06 1109 2.8 118 87.4 0.4 128.4 74.30 4.0 51.1 
2006 9/20/06 1110 2.5 144 8.8 2.5 143.4 9.63 4.3 51.4 
2006 9/20/06 1111 2.0 126 13.7 1.9 123.9 12.79 2.4 51.3 
2006 9/20/06 1112 2.6 117 30.6 2.3 114.9 27.93 3.3 51.3 
2006 9/20/06 1113 2.6 156 83.4 0.9 143.1 66.06 3.6 51.3 
2006 9/20/06 1114 1.8 63 39.2 1.5 58.6 36.29 2.6 51.4 
2006 9/20/06 1115 1.8 153 75.9 0.6 160.4 64.60 2.2 51.3 

332



Site 4 Met Data 
 

Year Date Time 
(hhmm) 

Average 
Wind 

Speed 
(mph) 

Average 
Wind 

Direction 
(Deg.) 

Average 
Standard 
Deviation 

Resultant 
Wind 

Speed 

Resultant 
Wind 

Direction 

Resultant 
Standard 
Deviation 

Wind 
Gust 
(mph) 

Tempera
-ture      
(F) 

2006 09/21/06 1110 2.7 155 46.5 1.7 147.9 49.05 5.7 51.9 
2006 09/21/06 1111 1.3 67 17.2 1.2 68.3 17.34 1.4 54.1 
2006 09/21/06 1112 1.3 120 42.2 1.0 119.7 40.42 1.5 54.0 
2006 09/21/06 1113 1.5 131 24.1 1.4 134.4 25.31 2.1 54.0 
2006 09/21/06 1114 2.3 183 25.6 2.1 183.4 25.43 2.9 53.9 
2006 09/21/06 1115 3.4 166 8.5 3.3 165.0 7.93 14.9 53.5 
2006 09/21/06 1116 1.3 141 6.8 1.3 143.3 11.49 5.7 53.6 
2006 09/21/06 1117 1.9 319 53.4 1.5 317.9 36.81 2.9 53.5 
2006 09/21/06 1118 2.1 316 19.5 2.0 318.6 18.36 2.9 53.5 
2006 09/21/06 1119 0.5 276 0.0 0.5 276.4 0.00 1.3 53.6 
2006 09/21/06 1120 0.2 191 1.5 0.2 190.8 1.49 0.8 53.7 
2006 09/21/06 1121 0.9 328 53.6 0.6 334.1 40.22 1.7 53.7 
2006 09/21/06 1122 2.8 339 7.1 2.7 338.6 7.11 3.3 53.7 
2006 09/21/06 1123 3.2 345 14.6 3.1 344.3 13.67 4.5 53.6 
2006 09/21/06 1124 1.7 344 23.6 1.5 347.3 23.15 2.1 53.5 
2006 09/21/06 1125 2.2 227 41.8 1.8 216.8 34.45 3.3 53.5 
2006 09/21/06 1126 3.1 290 50.9 2.4 300.0 37.06 4.4 53.4 
2006 09/21/06 1127 2.6 303 18.3 2.5 301.2 19.06 3.9 53.3 
2006 09/21/06 1128 1.4 303 6.5 1.3 303.4 6.79 1.7 53.4 
2006 09/21/06 1129 1.8 274 61.9 1.2 274.2 43.60 3.2 53.4 
2006 09/21/06 1130 1.8 333 23.0 1.6 335.2 22.54 2.7 53.4 
2006 09/21/06 1131 2.3 329 10.0 2.3 329.0 10.07 2.8 53.4 
2006 09/21/06 1132 2.1 338 15.6 2.0 338.4 15.13 2.4 53.5 
2006 09/21/06 1133 2.1 245 46.0 1.6 239.4 41.92 3.6 53.7 
2006 09/21/06 1134 1.8 231 23.1 1.7 229.0 23.37 2.5 54.0 
2006 09/21/06 1135 2.6 187 21.4 2.4 187.5 20.95 3.2 54.3 
2006 09/21/06 1136 2.8 181 25.1 2.5 177.3 22.22 3.6 54.7 
2006 09/21/06 1137 1.1 316 41.5 0.8 304.8 43.90 2.3 55.0 
2006 09/21/06 1138 1.6 248 18.2 1.5 247.6 17.74 2.2 55.4 
2006 09/21/06 1139 1.9 286 13.7 1.9 285.3 13.57 2.1 55.5 
2006 09/21/06 1140 1.7 266 8.9 1.7 266.4 8.71 1.9 55.7 
2006 09/21/06 1141 1.3 246 31.1 1.1 244.4 32.40 2.0 56.3 
2006 09/21/06 1142 1.7 127 47.4 1.2 129.2 40.94 2.1 56.7 
2006 09/21/06 1143 0.9 140 48.2 0.6 143.4 43.53 1.6 57.2 
2006 09/21/06 1144 1.3 64 59.0 0.7 69.3 53.34 1.8 57.6 
2006 09/21/06 1145 0.9 50 17.6 0.8 48.1 19.20 1.4 57.8 
2006 09/21/06 1146 2.7 147 17.8 2.6 150.1 15.03 3.6 57.6 
2006 09/21/06 1147 2.4 146 9.4 2.4 147.1 9.34 2.9 57.3 
2006 09/21/06 1148 2.0 158 18.8 1.9 158.9 18.53 2.6 57.1 
2006 09/21/06 1149 1.6 62 54.6 1.0 60.1 47.58 1.9 56.9 
2006 09/21/06 1150 1.9 36 7.1 1.9 36.1 7.17 2.2 56.6 
2006 09/21/06 1151 1.5 41 15.2 1.5 41.0 15.48 1.9 56.5 
2006 09/21/06 1152 1.4 69 18.7 1.4 72.0 18.46 2.0 56.6 
2006 09/21/06 1153 1.1 61 15.0 1.1 61.5 14.88 1.2 56.6 
2006 09/21/06 1154 1.9 8 9.8 1.9 7.3 9.90 3.0 56.7 
2006 09/21/06 1155 3.3 338 11.4 3.3 339.6 11.26 4.4 56.1 
2006 09/21/06 1156 2.0 314 20.3 1.8 312.0 19.78 2.2 56.0 
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2006 09/21/06 1157 1.5 297 49.1 1.0 293.1 48.00 2.0 55.9 
2006 09/21/06 1158 1.1 179 82.1 0.4 186.5 63.19 2.0 55.9 
2006 09/21/06 1159 1.1 238 39.1 0.9 236.5 35.35 1.4 55.9 
2006 09/21/06 1200 1.2 89 67.5 0.6 100.4 57.87 1.6 56.0 
2006 09/21/06 1201 1.8 159 15.1 1.7 160.3 14.85 2.1 56.0 
2006 09/21/06 1202 1.9 133 12.1 1.9 133.9 12.00 2.3 55.9 
2006 09/21/06 1203 2.7 154 12.0 2.7 155.3 11.84 3.2 55.9 
2006 09/21/06 1204 2.0 192 47.4 1.5 185.8 40.37 3.2 55.9 
2006 09/21/06 1205 1.0 131 33.1 0.9 133.6 32.36 1.6 56.0 
2006 09/21/06 1206 2.0 156 30.5 1.8 161.7 25.79 2.4 56.1 
2006 09/21/06 1207 2.3 157 13.4 2.2 157.0 13.33 2.9 55.9 
2006 09/21/06 1208 2.7 180 10.4 2.6 179.6 10.61 3.2 55.6 
2006 09/21/06 1209 1.8 174 52.7 1.3 172.7 44.15 2.7 55.6 
2006 09/21/06 1210 1.9 185 16.7 1.8 186.0 16.71 2.6 55.6 
2006 09/21/06 1211 2.5 198 20.5 2.4 196.4 20.23 3.1 55.4 
2006 09/21/06 1212 2.1 305 45.9 1.5 300.1 42.24 2.7 55.3 
2006 09/21/06 1213 1.4 223 36.6 1.1 224.6 36.13 1.7 55.3 
2006 09/21/06 1214 1.3 215 20.9 1.2 214.1 20.62 1.4 55.4 
2006 09/21/06 1215 1.0 256 37.5 0.8 257.0 36.94 1.2 55.5 
2006 09/21/06 1216 1.2 1 30.6 1.1 358.3 25.90 1.7 55.5 
2006 09/21/06 1217 0.4 73 28.2 0.3 75.1 25.62 1.0 55.8 
2006 09/21/06 1218 1.3 100 32.1 1.1 111.6 31.05 2.1 55.9 
2006 09/21/06 1219 1.8 122 20.3 1.7 124.8 19.55 2.2 56.0 
2006 09/21/06 1220 2.6 169 14.0 2.5 169.1 13.78 2.8 56.1 
2006 09/21/06 1221 2.7 187 20.9 2.5 188.2 21.16 3.3 56.0 
2006 09/21/06 1222 2.2 172 27.3 2.0 171.3 26.77 2.6 56.1 
2006 09/21/06 1223 1.5 143 30.6 1.3 147.5 28.14 2.2 56.4 
2006 09/21/06 1224 1.1 14 62.1 0.5 3.0 54.19 1.9 56.5 
2006 09/21/06 1225 1.4 302 29.2 1.3 296.0 26.61 2.0 56.4 
2006 09/21/06 1226 1.6 263 4.2 1.6 262.6 4.23 2.0 56.4 
2006 09/21/06 1227 0.5 259 0.9 0.5 259.5 0.97 1.3 56.5 
2006 09/21/06 1228 1.3 52 24.9 1.1 58.1 22.76 1.8 56.4 
2006 09/21/06 1229 1.3 105 12.4 1.3 104.1 12.02 1.8 56.3 
2006 09/21/06 1230 1.6 152 7.1 1.6 152.5 7.09 1.9 56.2 
2006 09/21/06 1231 1.0 153 2.1 1.0 153.1 2.35 1.5 56.2 
2006 09/21/06 1232 0.7 138 56.3 0.3 135.2 50.45 1.2 56.2 
2006 09/21/06 1233 0.6 353 6.8 0.6 352.2 6.31 1.1 56.2 
2006 09/21/06 1234 0.7 146 11.4 0.7 148.3 10.74 1.4 56.2 
2006 09/21/06 1235 1.5 163 8.1 1.5 163.7 8.24 1.8 56.0 
2006 09/21/06 1236 1.3 174 0.0 1.3 174.3 0.00 1.6 55.9 
2006 09/21/06 1237 1.1 133 41.6 0.9 140.5 36.74 1.6 55.8 
2006 09/21/06 1238 1.7 168 6.0 1.7 168.0 5.90 1.9 55.8 
2006 09/21/06 1239 1.6 183 15.5 1.5 181.0 14.62 1.9 55.6 
2006 09/21/06 1240 1.0 225 17.0 1.0 223.1 16.83 1.3 55.6 
2006 09/21/06 1241 0.9 205 0.5 0.9 205.1 0.46 1.0 55.7 
2006 09/21/06 1242 0.9 243 29.0 0.8 244.7 27.28 1.0 55.6 
2006 09/21/06 1243 0.8 283 0.0 0.8 283.3 0.00 1.0 55.6 
2006 09/21/06 1244 0.9 179 38.3 0.8 178.4 35.23 1.2 55.6 
2006 09/21/06 1245 0.9 178 30.2 0.8 180.5 31.11 1.2 55.6 
2006 09/21/06 1246 1.1 222 49.1 0.8 225.3 42.79 1.3 55.6 
2006 09/21/06 1247 0.6 117 0.0 0.6 116.8 0.00 1.1 55.8 
2006 09/21/06 1248 0.3 151 16.6 0.3 154.9 15.72 1.0 55.8 

334



2006 09/21/06 1249 0.9 202 4.4 0.9 202.2 4.21 1.2 55.9 
2006 09/21/06 1250 1.9 153 13.5 1.9 154.0 13.17 2.5 55.9 
2006 09/21/06 1251 1.5 172 1.2 1.5 172.2 1.40 2.3 55.7 
2006 09/21/06 1252 0.5 172 0.0 0.5 171.9 0.00 1.0 55.8 
2006 09/21/06 1253 1.3 160 8.5 1.3 156.5 8.65 2.7 55.8 
2006 09/21/06 1254 2.0 149 4.7 2.0 148.9 4.76 2.3 55.7 
2006 09/21/06 1255 1.3 144 14.4 1.2 146.4 14.72 1.9 55.8 
2006 09/21/06 1256 1.4 175 9.3 1.3 174.7 9.55 1.9 55.9 
2006 09/21/06 1257 1.8 153 9.9 1.8 152.8 9.71 2.0 55.8 
2006 09/21/06 1258 2.3 148 4.7 2.3 147.7 4.65 2.6 55.7 
2006 09/21/06 1259 1.8 151 6.6 1.8 151.3 6.21 2.2 55.7 
2006 09/21/06 1300 1.3 154 3.5 1.3 154.5 3.44 1.6 55.7 
2006 09/21/06 1301 1.6 157 9.1 1.6 157.3 9.00 1.9 55.8 
2006 09/21/06 1302 1.5 162 9.1 1.5 161.6 9.14 1.7 55.8 
2006 09/21/06 1303 1.5 160 12.1 1.5 160.2 12.18 1.7 55.8 
2006 09/21/06 1304 1.3 165 0.5 1.3 165.0 0.52 1.4 55.6 
2006 09/21/06 1305 1.1 172 1.5 1.1 171.8 1.57 1.2 55.7 
2006 09/21/06 1306 0.1 173 0.0 0.1 172.5 0.00 0.8 55.6 
2006 09/21/06 1307 1.0 176 2.9 1.0 176.4 2.81 1.5 55.6 
2006 09/21/06 1308 1.1 196 31.5 0.9 198.9 32.23 1.4 55.6 
2006 09/21/06 1309 1.3 234 52.4 0.8 238.1 46.56 1.5 55.5 
2006 09/21/06 1310 1.3 195 34.1 1.1 197.0 33.64 1.7 55.6 
2006 09/21/06 1311 1.1 178 18.5 1.0 176.5 17.44 1.5 55.6 
2006 09/21/06 1312 0.7 165 8.0 0.7 165.4 7.26 1.3 55.6 
2006 09/21/06 1313 1.4 180 15.4 1.3 180.5 14.09 1.9 55.6 
2006 09/21/06 1314 1.4 150 23.5 1.3 146.5 20.95 1.9 55.8 
2006 09/21/06 1315 1.4 149 20.2 1.3 151.1 20.44 1.9 55.8 
2006 09/21/06 1316 1.7 137 9.7 1.7 137.1 9.53 2.4 55.8 
2006 09/21/06 1317 2.3 233 48.6 1.6 234.3 45.31 2.7 55.9 
2006 09/21/06 1318 2.2 223 43.6 1.6 228.1 40.84 2.9 56.2 
2006 09/21/06 1319 2.0 227 37.0 1.6 229.5 35.15 2.5 56.5 
2006 09/21/06 1320 1.8 166 18.9 1.7 167.3 18.90 2.1 56.7 
2006 09/21/06 1321 1.5 79 48.4 1.0 95.6 44.23 2.3 56.9 
2006 09/21/06 1322 2.5 142 4.0 2.5 142.8 3.99 3.5 57.1 
2006 09/21/06 1323 3.2 163 10.9 3.2 163.1 10.57 4.0 57.1 
2006 09/21/06 1324 3.8 199 48.1 2.7 198.6 43.81 6.2 57.1 
2006 09/21/06 1325 3.2 199 62.4 2.0 194.8 48.85 4.4 57.0 
2006 09/21/06 1326 1.6 49 15.0 1.5 48.7 16.12 2.1 56.9 
2006 09/21/06 1327 1.5 92 18.8 1.4 93.9 19.50 1.9 56.8 
2006 09/21/06 1328 1.4 158 52.8 0.9 168.1 49.59 2.3 57.0 
2006 09/21/06 1329 1.4 340 83.4 0.3 332.6 70.40 1.8 57.3 
2006 09/21/06 1330 1.5 57 28.5 1.3 59.9 29.79 2.0 57.7 
2006 09/21/06 1331 2.0 359 22.9 1.9 359.2 22.67 2.4 58.1 
2006 09/21/06 1332 1.9 65 22.2 1.7 63.5 21.44 2.0 58.3 
2006 09/21/06 1333 1.7 87 12.1 1.7 88.0 12.48 2.3 58.6 
2006 09/21/06 1334 2.0 94 13.1 2.0 94.5 13.14 2.5 58.6 
2006 09/21/06 1335 2.5 126 24.7 2.3 132.1 24.23 4.5 58.7 
2006 09/21/06 1336 3.0 153 12.6 2.9 153.5 11.48 4.1 58.9 
2006 09/21/06 1337 2.1 120 19.1 2.0 121.5 17.49 2.7 59.1 
2006 09/21/06 1338 2.4 151 9.5 2.3 152.0 9.14 3.3 59.1 
2006 09/21/06 1339 2.4 156 22.9 2.2 155.8 20.36 3.0 59.1 
2006 09/21/06 1340 2.7 147 15.4 2.6 147.4 15.15 3.6 58.8 
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2006 09/21/06 1341 2.6 191 39.2 2.1 183.8 33.17 3.4 58.6 
2006 09/21/06 1342 2.7 161 11.4 2.7 161.3 10.55 3.3 58.4 
2006 09/21/06 1343 1.9 168 12.3 1.8 166.9 12.05 2.4 58.3 
2006 09/21/06 1344 1.6 152 8.3 1.6 151.2 8.02 1.9 58.2 
2006 09/21/06 1345 1.9 171 13.1 1.9 171.1 12.42 2.4 57.9 
2006 09/21/06 1346 1.4 182 13.1 1.4 180.9 12.61 1.8 57.8 
2006 09/21/06 1347 1.4 168 7.3 1.4 167.9 7.24 1.7 57.7 
2006 09/21/06 1348 2.0 174 4.9 2.0 174.4 4.83 2.5 57.5 
2006 09/21/06 1349 1.7 176 7.7 1.6 176.2 7.54 2.1 57.4 
2006 09/21/06 1350 1.6 169 7.4 1.5 168.7 7.59 1.9 57.3 
2006 09/21/06 1351 2.4 177 17.4 2.3 177.8 16.54 2.9 57.2 
2006 09/21/06 1352 1.8 208 33.3 1.5 208.3 32.56 2.1 57.2 
2006 09/21/06 1353 1.8 183 18.4 1.7 183.8 19.93 2.9 57.1 
2006 09/21/06 1354 1.5 238 37.8 1.2 236.9 35.76 1.9 57.1 
2006 09/21/06 1355 1.3 219 56.5 0.8 222.9 50.85 1.6 57.1 
2006 09/21/06 1356 1.4 219 85.5 0.5 178.3 64.67 2.2 57.1 
2006 09/21/06 1357 1.8 170 14.4 1.7 169.5 14.51 2.0 57.1 
2006 09/21/06 1358 1.9 173 11.3 1.9 175.2 11.31 2.8 57.0 
2006 09/21/06 1359 1.7 181 2.0 1.7 180.7 2.00 2.0 56.9 
2006 09/21/06 1400 1.7 195 9.2 1.6 193.6 9.35 2.3 56.8 
2006 09/21/06 1401 1.5 195 16.1 1.5 195.3 15.85 1.9 56.8 
2006 09/21/06 1402 1.8 185 7.4 1.8 185.2 7.42 2.1 56.8 
2006 09/21/06 1403 1.6 176 10.4 1.6 177.2 9.87 1.9 56.7 
2006 09/21/06 1404 1.3 173 17.1 1.3 179.0 17.62 2.2 56.8 
2006 09/21/06 1405 1.6 209 24.7 1.4 209.6 24.15 1.9 56.8 
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Site 5 Met Data 
 

Year Date Time 
(hhmm) 

Average 
Wind 

Speed 
(mph) 

Average 
Wind 

Direction 
(Deg.) 

Average 
Standard 
Deviation 

Resultant 
Wind 

Speed 

Resultant 
Wind 

Direction 

Resultant 
Standard 
Deviation 

Wind 
Gust 
(mph) 

Tempera
-ture      
(F) 

2006 09/22/06 955 0.1 182 0.0 0.1 181.5 0.02 6.1 -95.4 
2006 09/22/06 956 2.1 182 0.1 2.1 181.5 0.12 2.1 54.7 
2006 09/22/06 957 2.7 182 0.1 2.7 181.5 0.12 12.7 54.7 
2006 09/22/06 958 2.3 182 0.1 2.3 181.5 0.13 2.7 54.6 
2006 09/22/06 959 4.7 181 29.2 0.6 78.8 75.40 39.7 54.8 
2006 09/22/06 1000 2.9 320 18.2 2.7 322.6 22.20 6.5 54.5 
2006 09/22/06 1001 3.0 308 67.7 1.0 285.9 66.06 20.5 54.6 
2006 09/22/06 1002 2.7 313 52.3 1.7 310.6 49.45 4.5 54.5 
2006 09/22/06 1003 2.7 353 71.6 0.9 11.2 66.63 4.4 54.4 
2006 09/22/06 1004 2.5 297 32.1 2.1 299.5 31.21 3.6 54.5 
2006 09/22/06 1005 1.5 299 20.0 1.4 300.3 21.02 2.0 54.5 
2006 09/22/06 1006 2.4 302 39.3 1.9 306.4 36.78 3.3 54.5 
2006 09/22/06 1007 2.7 304 65.3 1.2 305.1 59.96 4.0 54.6 
2006 09/22/06 1008 3.0 359 59.8 1.8 5.3 51.44 4.0 54.8 
2006 09/22/06 1009 1.9 314 61.5 1.1 321.7 52.72 3.2 55.0 
2006 09/22/06 1010 2.2 279 43.5 1.7 282.9 39.83 3.1 55.1 
2006 09/22/06 1011 3.4 16 71.2 1.6 27.1 59.35 5.1 55.1 
2006 09/22/06 1012 2.3 318 38.3 1.9 321.2 35.50 3.6 55.2 
2006 09/22/06 1013 2.6 63 37.7 2.1 66.2 34.21 2.9 55.4 
2006 09/22/06 1014 2.2 60 90.8 0.9 90.5 61.59 3.7 55.7 
2006 09/22/06 1015 1.9 184 75.4 0.6 173.7 66.94 2.7 55.7 
2006 09/22/06 1016 1.4 22 48.2 0.9 24.3 48.42 2.3 55.7 
2006 09/22/06 1017 2.8 96 62.6 1.5 83.6 56.35 4.7 55.7 
2006 09/22/06 1018 2.3 255 31.1 1.9 253.1 32.65 3.5 55.6 
2006 09/22/06 1019 1.1 339 62.3 0.6 315.2 54.16 1.8 55.6 
2006 09/22/06 1020 1.2 71 35.2 1.1 77.9 30.37 2.1 55.7 
2006 09/22/06 1021 1.9 112 59.5 0.9 134.6 57.36 3.4 55.7 
2006 09/22/06 1022 2.4 105 83.8 0.6 79.3 69.22 3.4 55.8 
2006 09/22/06 1023 2.6 32 26.4 2.4 33.4 23.86 3.7 55.8 
2006 09/22/06 1024 1.3 310 33.3 1.0 310.3 33.97 1.7 55.8 
2006 09/22/06 1025 2.2 347 77.6 0.9 326.7 62.03 3.6 55.7 
2006 09/22/06 1026 2.3 188 58.2 1.5 182.1 47.60 3.5 55.8 
2006 09/22/06 1027 2.4 46 50.3 1.6 45.4 46.23 3.1 55.9 
2006 09/22/06 1028 3.1 62 48.9 2.3 71.8 42.49 4.6 56.0 
2006 09/22/06 1029 2.8 70 37.4 2.2 64.1 36.03 4.1 56.2 
2006 09/22/06 1030 1.6 68 49.1 1.1 76.9 45.40 2.2 56.3 
2006 09/22/06 1031 1.7 220 68.6 0.7 213.8 61.86 2.5 56.3 
2006 09/22/06 1032 2.2 98 30.7 1.9 96.2 28.84 2.7 56.4 
2006 09/22/06 1033 4.1 81 58.2 2.6 58.5 49.63 11.0 56.7 
2006 09/22/06 1034 6.8 51 40.7 5.7 42.7 32.95 11.5 56.7 
2006 09/22/06 1035 3.9 66 65.4 2.2 69.4 53.32 5.3 56.7 
2006 09/22/06 1036 3.8 36 47.7 2.9 34.4 39.38 8.3 56.8 
2006 09/22/06 1037 3.3 25 57.4 2.3 27.3 45.97 6.7 56.9 
2006 09/22/06 1038 2.1 334 40.8 1.6 338.4 38.17 2.8 56.9 
2006 09/22/06 1039 1.4 289 25.4 1.3 289.8 25.05 1.7 56.9 
2006 09/22/06 1040 2.1 341 58.1 1.2 359.0 51.75 3.5 56.9 
2006 09/22/06 1041 4.1 337 39.9 3.2 356.9 37.55 8.6 57.2 
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2006 09/22/06 1042 2.8 270 67.5 1.1 272.3 62.40 4.1 57.3 
2006 09/22/06 1043 4.2 32 54.2 2.8 32.8 46.40 10.2 57.5 
2006 09/22/06 1044 3.8 64 59.4 2.4 67.6 49.27 5.4 57.6 
2006 09/22/06 1045 3.3 294 60.7 1.8 309.2 53.60 7.0 57.6 
2006 09/22/06 1046 6.4 2 45.0 5.3 14.0 34.22 14.6 57.4 
2006 09/22/06 1047 7.1 22 19.4 6.8 25.2 17.87 12.8 57.2 
2006 09/22/06 1048 3.3 320 56.9 2.0 319.7 50.73 4.2 57.0 
2006 09/22/06 1049 3.8 11 59.3 2.5 17.8 47.47 7.0 56.9 
2006 09/22/06 1050 2.5 280 77.8 1.0 288.1 63.54 3.1 56.9 
2006 09/22/06 1051 2.3 338 45.3 1.7 346.8 43.63 8.3 56.8 
2006 09/22/06 1052 5.2 50 53.2 3.8 44.6 43.05 8.3 57.0 
2006 09/22/06 1053 3.9 40 43.7 2.9 38.1 40.42 6.7 57.1 
2006 09/22/06 1054 4.6 52 47.9 3.3 42.9 42.79 12.2 57.3 
2006 09/22/06 1055 2.7 36 35.5 2.2 36.0 34.36 3.0 57.6 
2006 09/22/06 1056 2.2 309 22.2 2.0 311.6 21.88 2.7 57.5 
2006 09/22/06 1057 2.2 284 30.2 1.9 282.3 28.74 3.2 57.5 
2006 09/22/06 1058 2.7 342 38.9 2.1 341.7 38.23 3.6 57.6 
2006 09/22/06 1059 3.2 348 48.8 2.3 353.0 43.29 4.6 57.7 
2006 09/22/06 1100 3.0 348 47.8 2.2 355.9 42.67 4.3 57.8 
2006 09/22/06 1101 4.1 333 49.7 3.0 345.8 41.45 7.7 57.8 
2006 09/22/06 1102 2.7 11 70.6 1.4 34.8 56.87 4.9 58.0 
2006 09/22/06 1103 1.4 299 21.3 1.3 302.0 22.24 1.9 58.0 
2006 09/22/06 1104 1.4 300 43.7 1.1 295.6 39.66 1.9 58.0 
2006 09/22/06 1105 1.4 9 42.8 1.1 15.4 39.81 1.9 58.1 
2006 09/22/06 1106 2.1 90 26.2 1.9 91.8 27.26 4.2 58.3 
2006 09/22/06 1107 4.5 107 44.8 3.3 90.1 42.24 8.8 58.5 
2006 09/22/06 1108 1.6 302 18.2 1.5 303.0 20.01 2.3 58.5 
2006 09/22/06 1109 2.0 47 48.8 1.4 56.0 42.76 2.9 58.6 
2006 09/22/06 1110 1.6 152 72.8 0.9 148.1 55.91 2.2 58.7 
2006 09/22/06 1111 2.0 339 28.8 1.6 1.5 33.29 6.7 58.7 
2006 09/22/06 1112 5.1 19 51.4 3.9 24.0 39.32 8.0 58.8 
2006 09/22/06 1113 2.6 324 89.7 0.1 217.6 79.00 5.2 58.8 
2006 09/22/06 1114 2.3 348 78.3 0.9 352.3 63.75 2.9 58.7 
2006 09/22/06 1115 2.0 13 36.2 1.7 9.5 32.90 3.2 58.9 
2006 09/22/06 1116 2.2 9 28.7 1.9 4.6 28.29 3.2 59.0 
2006 09/22/06 1117 2.3 341 48.3 1.6 341.5 42.37 3.6 59.0 
2006 09/22/06 1118 2.5 277 32.9 2.2 276.5 31.16 3.8 59.0 
2006 09/22/06 1119 2.7 344 45.2 2.0 349.6 41.41 4.7 59.1 
2006 09/22/06 1120 2.9 281 34.1 2.4 281.2 32.95 3.6 59.1 
2006 09/22/06 1121 2.8 309 28.4 2.5 308.0 27.84 3.6 59.1 
2006 09/22/06 1122 2.9 281 58.0 1.8 285.2 51.47 3.9 59.0 
2006 09/22/06 1123 3.2 354 95.3 0.9 126.4 69.18 6.9 59.0 
2006 09/22/06 1124 2.7 265 44.2 1.6 258.4 50.79 5.3 58.9 
2006 09/22/06 1125 2.0 315 19.5 1.9 314.2 19.46 2.6 59.0 
2006 09/22/06 1126 1.9 292 20.7 1.8 291.2 20.71 2.5 59.0 
2006 09/22/06 1127 1.7 326 46.6 1.2 327.8 43.75 2.2 59.0 
2006 09/22/06 1128 1.6 324 39.4 1.3 327.8 36.96 2.7 59.1 
2006 09/22/06 1129 2.6 60 53.1 1.6 53.2 49.54 3.6 59.2 
2006 09/22/06 1130 2.1 84 55.9 1.3 81.5 51.37 2.5 59.4 
2006 09/22/06 1131 2.0 87 63.9 1.0 86.1 58.11 2.5 59.7 
2006 09/22/06 1132 2.5 176 52.3 1.9 167.1 40.32 4.5 59.8 
2006 09/22/06 1133 2.2 348 68.9 1.4 7.7 49.72 5.3 59.8 
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2006 09/22/06 1134 3.7 28 26.1 3.4 30.6 25.27 7.2 59.8 
2006 09/22/06 1135 3.1 88 31.8 2.6 90.7 30.86 5.2 60.3 
2006 09/22/06 1136 2.9 87 30.9 2.5 86.9 29.62 3.9 60.4 
2006 09/22/06 1137 2.9 356 48.9 2.0 4.2 45.32 5.9 60.3 
2006 09/22/06 1138 3.8 49 39.1 3.2 43.7 32.13 7.7 60.1 
2006 09/22/06 1139 6.5 74 59.3 3.6 63.3 53.80 12.2 60.2 
2006 09/22/06 1140 4.3 49 53.9 2.7 45.4 48.56 6.0 60.0 
2006 09/22/06 1141 3.2 10 58.3 1.6 18.9 57.61 6.0 60.0 
2006 09/22/06 1142 3.5 113 51.2 2.4 108.2 45.87 5.3 60.0 
2006 09/22/06 1143 3.4 61 50.4 2.3 52.7 46.37 5.3 60.0 
2006 09/22/06 1144 3.1 49 27.6 2.7 45.1 27.53 4.4 59.8 
2006 09/22/06 1145 4.4 52 34.5 3.6 48.1 34.05 7.2 59.9 
2006 09/22/06 1146 4.9 61 60.6 2.9 52.9 51.86 7.5 59.8 
2006 09/22/06 1147 4.1 54 50.8 2.7 49.8 47.39 7.0 59.9 
2006 09/22/06 1148 3.0 78 64.0 1.5 83.4 56.88 4.5 59.9 
2006 09/22/06 1149 4.4 7 50.2 3.0 10.1 46.16 7.3 59.7 
2006 09/22/06 1150 4.5 346 69.9 1.9 12.2 62.00 8.8 59.7 
2006 09/22/06 1151 4.7 28 40.8 3.6 29.9 38.39 7.7 59.6 
2006 09/22/06 1152 5.8 357 58.6 4.3 13.0 41.82 15.1 59.5 
2006 09/22/06 1153 2.8 6 49.6 1.9 358.2 46.81 4.4 59.3 
2006 09/22/06 1154 3.5 351 77.8 1.6 348.4 59.61 8.6 59.3 
2006 09/22/06 1155 4.2 9 57.1 2.7 16.2 48.47 8.4 59.3 
2006 09/22/06 1156 2.7 62 98.7 0.3 141.3 76.10 5.2 59.4 
2006 09/22/06 1157 5.1 21 63.8 2.7 21.7 56.24 8.6 59.4 
2006 09/22/06 1158 4.2 111 71.0 1.5 101.2 65.28 6.9 59.5 
2006 09/22/06 1159 2.3 107 52.9 1.6 98.6 44.75 3.9 59.6 
2006 09/22/06 1200 4.8 67 65.2 2.9 38.1 51.72 11.5 59.9 
2006 09/22/06 1201 3.8 67 38.5 3.0 66.6 36.17 9.3 59.8 
2006 09/22/06 1202 3.2 71 60.3 1.7 68.2 55.29 4.6 59.9 
2006 09/22/06 1203 2.7 83 49.2 1.8 85.1 46.31 4.5 60.1 
2006 09/22/06 1204 4.0 43 55.0 2.8 34.7 43.06 7.4 60.2 
2006 09/22/06 1205 3.0 33 39.6 2.3 33.5 37.28 3.8 60.4 
2006 09/22/06 1206 3.9 348 43.4 3.2 2.0 35.98 7.9 60.4 
2006 09/22/06 1207 6.0 26 58.0 3.8 30.6 49.24 8.9 60.2 
2006 09/22/06 1208 6.6 32 28.1 5.9 35.1 27.15 12.8 59.9 
2006 09/22/06 1209 3.2 29 48.9 2.2 19.1 44.81 6.1 59.9 

 
 
 
 
 
Site 6 Met Data 
 No met data were taken at this spot check measurement site. 
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Chapter 1: Introducing CHARM Version 9 

Radian's Complex Hazardous Air Release Model (CHARM®) is a modeling 
software program that calculates and predicts: 

• the movement and concentration of airborne plumes from released 
chemicals; 

• mechanical overpressures from pressurized vessels and explosion 
overpressures from ignition of vapor clouds; 

• thermal radiation footprints associated with jet fires, pool fires, and 
boiling liquid expanding vapor explosions (BLEVE); and 

• population impacts associated with any one of the footprints 
described above. 

The CHARM program is useful for preparing for or responding to the 
occurrence of an accidental release, designing response plans, and 
implementing training programs.  Whether you are developing an 
emergency response plan or responding to an actual event, the CHARM 
program provides a quick and accurate method for assessing the 
potential impacts of airborne chemical releases, overpressures, and 
thermal radiation. 

Planning Mode 

Planning for emergency response involves describing the potential 
release.  You can define maps with the CHARM Editor for use in CHARM 
displays.  In the planning mode, CHARM guides you through a list of 
input fields that describe a particular release and the present 
meteorological conditions.  When you request a Plume display, CHARM 
requests a release time to use in the calculations which enable 
simulation of the release.  The various graphic displays can be altered 
with a variety of options, and the release information can be stored in a 
scenario file for use with CHARM's emergency response mode. 

Emergency Response Mode 

In the emergency response mode, CHARM quickly accesses pre-stored 
input in one or more scenario files. To save time in an emergency 
situation, CHARM enables you to define and store a base map that will 
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be displayed automatically whenever the CHARM program is started.  
Ideally, the map display will have icons that can be selected to show 
release scenarios and other maps.   

CHARM generates plume displays, radiation and overpressure footprint 
displays, plots, tables, and site information.  Emergency response 
procedures for a particular chemical release, local sources of help, and 
important phone numbers stored in the CHARM Editor (CHARMED) can 
be retrieved quickly in the emergency response mode.  

CHARM Input 

The Main CHARM Input Window guides you through a list of 
characteristics that describe the release and the meteorological 
conditions.   The selected species and release type determine which data 
fields are displayed for input.  Although default data values are provided 
for the input fields, any data in the input window can be changed, 
including all of the default values (see “CHARM.INI File Description” in 
Chapter 3). 

To assess the effects of an actual or potential accident, CHARM needs 
information about the toxicity of the released substance and how it 
disperses under different conditions.  CHARM provides data on the 
physical, chemical, and toxic properties of over 180 chemical 
compounds.  The chemical database can be expanded or modified 
through the CHARM editor (CHARMED).  If you are unable to locate 
those chemical properties associated with a desired chemical which is 
not in CHARM’s chemical database, Radian does provide services to 
gather necessary data to be used with CHARM. 

A release can be described as a liquid or gas escaping from a container, 
or a liquid pool/lagoon.  In either case, the conditions are defined right at 
or just prior to the release.  CHARM also has the capability of defining 
release conditions right at or after the release has occurred, called “User-
Specified After-Release Condition”.  You can describe a release that is 
heavier or lighter than air, a ground-level or elevated release, and the 
type of surface on which a spill occurred.  CHARM also allows you to 
describe liquid pool fires, Boiling Liquid Expanding Vapor Explosions 
(BLEVE), and jet fires.  For a flammable vapor cloud, overpressures from 
the detonation or deflagration of the cloud can be estimated.  In addition 
to explosion overpressures, CHARM can calculate mechanical 
overpressures from failures of pressurized vessels.  Once an impacted 
area from any one of the available footprints has been identified, CHARM 
can estimate population impacts based on U.S. Census Bureau 
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Tiger/LineTM 1992 Data. 

Meteorological data for input to CHARM can be obtained from 
instruments brought to the site, from a nearby meteorological station(s), 
or from estimates prepared by a remote weather center.  CHARM can 
also be set up permanently as part of a facilities operation to 
automatically receive continuous data from a meteorological station, or 
from multiple data collection sites.  For automatic meteorological data 
retrieval, CHARM requires an additional program called METINTER 
which is custom designed to integrate with the protocol sent by your met 
station hardware. 

Map Displays 

Maps cannot be created in CHARM or CHARMED.  Drawings must be 
created with some type of third-party software and then defined in the 
Map Definition Editor in CHARMED before the map can be utilized in 
CHARM.  The Map Definition Utility in CHARMED can import properly 
scaled, site-specific or area maps created with the Microsoft® Windows 
Paint Program or other more sophisticated Windows-compatible drawing 
programs.  Detailed maps of areas may be found on and downloaded 
from the internet.  Maps can be read from the clipboard or from files.  
Maps must be read and edited with the CHARM Editor before they can be 
used in CHARM.  During a CHARM run, you can overlay displays of 
concentration, thermal radiation, and overpressure levels on a selected 
map to identify local impact areas.  Icons representing release locations 
and other maps can also be defined on a map display.   

Population Impacts 

CHARM has the ability to calculate the number of people affected by 
footprints of desired concentrations, radiation fluxes, or overpressures.  
The number of people is determined from the population information 
available on U.S. Census Bureau Tiger/LineTM 1992 Data.  To use 
population data with CHARM, the U.S. Census Bureau data files must be 
preprocessed with the CHARM TigerMap Utility.  After preprocessing, the 
data files must be defined in the CHARM Editor.  Once a footprint is 
displayed, CHARM uses one of three different methods to calculate 
population impacts.  For more information defining and displaying 
population data, see “Population Data” in Chapter 4.  To order Census 
Bureau data, contact: 

 U.S. Department of Commerce 
 BUREAU OF THE CENSUS 
 Data User Service Division 
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 Washington, DC 20233-8300 
 301-673-4100 

CHARM Calculations 

When the required input has been entered, CHARM calculates the 
radiation footprint, overpressure footprint, or concentration of a chemical 
plume, and predicts the dispersion of the release.  CHARM is a Gaussian 
puff model that considers any release to be a series of puffs.  CHARM 
determines the number of puffs in a release and the initial 
characteristics of each puff.  

CHARM creates a source term based on the user input then proceeds to 
generate the transport/dispersion, radiation, or overpressure 
calculations to describe an impact.  The resulting displays simulate the 
release according to the specified input and the calculations.  For 
information on CHARM algorithms, refer to the “CHARM Technical 
Reference Documentation.” 

Graphic Displays 

CHARM provides plume displays to show the locations, shapes, and up 
to three concentration isopleths of the chemical plume resulting from a 
release.  Footprint displays show up to three values each for thermal 
radiation and overpressures.  Any footprint display may overlay a map.  
Vertical cross-sections, tables, and two-dimensional plots are also 
provided. 

The CHARM displays include: 

• An instantaneous plume view showing the concentrations at the 
specified time since release; 

• An integrated plume view showing a minute-by-minute (or second-by-
second) time history of the impact area; 

• A time-averaged plume based on a user-defined averaging interval 
and a user-defined grid size; 

• A dose display showing the time history of concentration at any 
point; 

• A vertical cross-section of the plume or footprint; 

• Thermal radiation footprints from liquid pool and jet fires; 
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• Overpressure footprints resulting from mechanical failure of a 
pressurized vessel; 

• Overpressure footprints resulting from ignition of a vapor cloud at a 
specified time; 

• A table showing the location of maximum concentrations as a 
function of time; 

• A plot and table showing the maximum downwind distance from the 
source of a specific concentration level as a function of time; 

• A plot and table showing the concentrations through the centerline of 
the plume; 

• A plot and table showing the maximum crosswind width of a user-
specified concentration as a function of time; 

• A plot and table showing the crosswind half-width down the 
centerline of the plume as a function of concentration; 

• A 3-Dimensional view of a single user-specified concentration; 

• Population impacts of a plume or footprint (requires 1992 Tiger/Line 
Census Bureau Data); 

• Circular Population impacts associated with a radial distance from 
the source (requires 1992 Tiger/Line Census Bureau Data); 

• A plot and table illustrating emission rates from both the container 
and the pool; 

• A detailed report (Source/Puff Calculation) showing the output of the 
source term calculation performed by CHARM. The data consists 
mainly of the numbers used to describe the source term, emission 
out of the container, emission of each puff into the atmosphere 
during the release, etc.; 

• Displays showing chemical data and emergency response action to be 
taken in association with the species being modeled; and 

• User-definable site specific information. 
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The CHARM Environment 

CHARM operates in the Microsoft Windows environment.  The Windows 
program comes with thorough documentation for using the menus and 
dialog boxes with and without a mouse.  CHARM  menus and dialog 
boxes follow the same style.  CHARM comes with a complete on-line help 
system.  A help command is available for every CHARM window and 
dialog box.  The on-line help screens provide additional information to 
describe the window or explain the type of data requested. 

Within the Windows environment, a single CHARM run can display 
several scenarios of the same or a different chemical under different 
meteorological and/or time-release conditions simultaneously.  In 
addition, both text and graphic displays can be sent to the clipboard for 
use with Windows-compatible word processors. 

Hardware Requirements 

The hardware requirement for the CHARM program depends on the type 
of processor (CPU) in the computer. 

The minimum hardware requirements are a computer with a 80486 CPU 
and 8 megabytes (M) RAM. 

In addition, the hardware requirements include: 

• A 20M hard disk; 

• A 1.44M, 3.5 inch diskette drive; 

• Graphics card/monitor with a Microsoft Windows software driver; 
(Many drivers come with Windows.  Some manufacturers supply 
drivers with their products.  You may have to check with the 
manufacturer.) 

• A math co-processor; 

• A mouse is highly recommended, although not required.  The mouse 
requires a Windows driver; 
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Software Requirements 

CHARM 9 requires Microsoft Windows95 or WindowsNT as the operating 
system.  CHARM does not include a run-time version of the Windows 
program; it must be purchased separately. 

About This Manual 

The CHARM User's Manual is divided into the following sections: 

Chapter 1 "Introducing CHARM" is an overview of the features of the 
CHARM program. It also includes the hardware and 
software requirements, and a description of the contents 
of this book. 

Chapter 2 "Installing CHARM" provides the steps for installing 
CHARM and information for updating a previous CHARM 
version.  This chapter also explains how CHARM is 
protected from unauthorized use and how to solve 
insufficient memory problems. 

Chapter 3 "Getting Started" describes how to start and stop the 
CHARM program and provides general conventions for 
running the program. 

Chapter 4 "Using the CHARM Editor" explains how to use the editors 
to modify CHARM file location information; modify and 
update the chemical database; enter site-specific 
information;  specify 1992 Tiger/Line Census Bureau data 
for determining population impacts;  and set the 
parameters for communication with a meteorological 
tower(s).  This chapter also describes how to edit the maps 
you want to use with CHARM. 

Chapter 5 "The Main CHARM Input Window" explains how to use 
CHARM in the planning mode and describes the input for 
creating a release scenario. 

Chapter 6 "Understanding CHARM Displays" describes the displays 
that CHARM generates for a release scenario. 

Chapter 7 "Using CHARM for Emergency Response" describes how to 
use CHARM in the emergency response mode.  

Chapter 8 "Using the TigerMap Utility" explains how to preprocess 
U.S. Census Bureau Tiger/LineTM 1992 Data for 
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preparation for use with the CHARM Editor and CHARM 
in determining population impacts. 

Chapter 9 "Menus and Commands Reference" is an alphabetical 
listing of the CHARM menus and their commands.  This 
chapter functions as a reference for quickly accessing 
detailed information in the CHARM User's Manual. 

This manual also provides a list of figures for each screen in the manual 
and an index for locating specific information quickly. 

Manual Conventions 
This manual uses the conventions for terminology and typography 
discussed in the following paragraphs. 

Key Names 
The names of keys on the computer keyboard appear capitalized and 
enclosed in angle brackets.  For example, the Enter key is represented as 
<Enter> in this manual.  The actual key names seen on your particular 
keyboard may be a little different. 

Key Combinations 
In some cases, two keys must be pressed at the same time to achieve the 
intended result.  In these cases, the two key names are hyphenated.  For 
example, <Ctrl-Del> means hold <Ctrl> while pressing <Del>. 

Arrow Keys 
The four arrow keys on the computer keypad refer to the directions in 
which you can move the selection, the pointer, or the insertion point on 
your screen.  The arrow keys are also used to position icons on a map 
display.  These keys are particularly useful if you are using the keyboard 
instead of the mouse. 

Menu and Command Names 
The names of menu commands and their commands are capitalized in 
this manual.  They appear in text just as they appear on the screen. 

What You Type 
Whenever this manual presents something you should type verbatim, the 
characters are shown in bold typeface.  If the letter case is significant, 
uppercase or lowercase information is specified in the directions. 
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Terms 
Many of the computer terms used in this manual are equivalent to the 
terms used by Windows documentation.  When a term is defined, it 
appears in bold typeface.  Italics indicate emphasis. 

Notes and Cautions 
A note provides information that is specific to certain circumstances or is 
of special interest.  A caution contains information about actions that 
can cause you to lose or damage your data.  Notes and cautions are 
shown in italics. 

Figures 
CHARM windows are shown as numbered figures throughout this 
manual.  A complete list of figures is provided immediately following the 
Table of Contents.  The appropriate dialog box is shown for each CHARM 
data entry field.  These graphics are not numbered, but the field names 
are listed in the Table of Contents.  Window examples are generated from 
Windows95, and may differ if you are running another Windows 
Operating System 
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Chapter 2:  Installing CHARM 

The initial steps to use for installation depend on whether you are 
installing CHARM for the first time or updating a previous version of 
CHARM.  After installation, you must install the parallel port key to 
indicate to CHARM that this license of CHARM is authorized for use.  
This chapter also contains suggestions for handling insufficient memory 
problems. 

Updating a Previous CHARM Version 

CHARM is backward compatible as far as reading scenario and 
meteorological files from a previous version of CHARM.  However, you 
may have added chemical data to the chemical database, in which case 
you do not want to overwrite CHMDAT8 files.  Be sure to backup 
CHMDAT8 files before installating CHARM version 9, or simply install 
CHARM version 9 in another directory. (see “Updating Chemical 
Database from a Previous Version” in Chapter 3). 

Installing CHARM for the First Time 

Use the following steps to install CHARM for the first time: 

1. Turn on or boot your computer. 

2. If a Microsoft Windows operating system is not already installed on 
your PC, install Microsoft Windows version Windows95 or 
WindowsNT. 

3. If Microsoft Windows is not already running, start MS Windows by 
typing the following command at the DOS prompt:  

WIN 
 

4. Select the ‘Run’ option from the appropriate Windows OS.    The 
following window is  displayed: 
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5. Place the CHARM diskette labeled “Disk 1” in the diskette drive, and 
enter the following command at the Command Line prompt of the 
‘Run’ window: 

A:\SETUP 

If you are using a diskette drive other than A, use its name in place of 
the A shown in the command above.  Alternatively, you may initiate 
the CHARM installation procedure by executing My Computer or 
Windows Explorer from the desktop, and executing SETUP.EXE from 
your floppy drive. 

6.  Once the Setup program is running, follow the instructions on the 
screen to continue or exit the installation. 

Handling Insufficient Memory Problems 

Several conditions may cause a "Not enough memory" message to be 
displayed.  Some conditions to check for and their possible remedies are 
described here. 

1. The Windows program must be started before the CHARM program is 
started.  CHARM requires Microsoft Windows to run.  This means 
that CHARM cannot be started from the DOS command prompt like 
other DOS programs.  If you enter CHARM at the command prompt, 
an insufficient memory message is generated because the size of the 
CHARM program is greater than 640K.  

2. Start Windows as described in the Windows documentation for your 
computer system.  CHARM can then be started by selecting the 

CHARM icon from the CHARM group in the Program Manager. 
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3. Other programs may be running and taking up memory needed by 
CHARM.  These programs are called Terminate but Stay Resident 
(TSR) programs, and they reduce the amount of memory available to 
CHARM.  For example, the programs necessary for computer 
networking require memory.  Another example is a utility program, 
such as Sidekick, that requires memory.  A mouse driver need not be 
loaded, because Windows provides its own.  TSRs and some drivers 
are normally loaded with the AUTOEXEC.BAT file.  Most drivers are 
loaded with the CONFIG.SYS file. 

4. The AUTOEXEC.BAT and the CONFIG.SYS files must always allow 
Windows and CHARM to operate.  Some sample AUTOEXEC.BAT and 
CONFIG.SYS files that represent the simplest cases are provided 
below.  It is possible that other directives have been added to these 
files to the extent that memory is no longer available for completing a 
CHARM run. 

Example 1 shows the contents of one of the simplest AUTOEXEC.BAT 
files that can be used.  The example creates a prompt of the default 
directory and identifies the PATH directive.  The PATH directive tells 
the computer where to look for programs named in a command that 
are not in the default directory (the directory from which the 
command is issued). 

Example 1: 
ECHO OFF 
PROMPT $P$G 
PATH C:\WIN;C:\DOS;C:\BIN;C:\UTIL;C:\CHARM 

Example 2 shows the minimum requirements for a  CONFIG.SYS file 
to operate correctly with Windows. 

Example 2: 
FILES=30 
BUFFERS=10 
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Protecting CHARM from Unauthorized Use 

The CHARM software is protected from unauthorized use by a hardware 
device called a key, which is supplied as a part of the purchase of 
CHARM.  This key must be installed before CHARM is run or the 
program will not perform any calculations.  If no key is present, a 
warning is displayed, and calculation is halted, and CHARM terminates. 

The type of key CHARM uses is a parallel port (LPT) key.  The standard 
key being sent with CHARM Version 9 software is the printer port key.  
This key connects in line with the parallel port and the printer cable. 

Use the following steps to install the printer port key: 

1. Disconnect any cable connected to the designated LPT output 
(printer) port of your computer.   

2. Connect the parallel port key to the designated LPT output port.   

3.  Connect the printer cable to the other side of the key.  The male end 
of the key attaches to the female end of the LPT port. 

You are now ready to execute CHARM. 

 

358



Getting Started   

 

14

 

Chapter 3:  Getting Started 

This chapter provides information for starting and stopping the CHARM 
program and CHARM utilities, and understanding the general 
conventions used throughout the CHARM program. 

Starting and Stopping the CHARM Program 

After the CHARM program is installed as described in Chapter 2, use the 
following steps to start CHARM. 

5. Turn on the computer, if necessary. 

6. Start Microsoft Windows, if necessary. 

7. Double click the CHARM icon in the CHARM Group of select CHARM 
from the Start menu. 

To stop CHARM or a CHARM utility program, select the Exit command 
from the File menu.  CHARM can also be stopped by double-clicking the 
icon at the upper left corner of the CHARM window, or by single-clicking 
the X icon at the upper right corner of the window. 

General CHARM Conventions 

The general conventions used by the CHARM program involve file names, 
on-line help, dialog boxes, and the search function.  Familiarity with the 
Windows program is helpful in understanding these features. 

CHARM uses a Windows application style that is common for large-scale 
software programs.  This application style is called a Multiple Document 
Interface, or MDI.  This particular style allows the application to display 
multiple windows in a single CHARM window.  The user can view and 
move among multiple windows, but every window is bounded by the 
extents of the single larger CHARM window frame.  A standard MDI 
window frame usually contains a menu bar, an optional toolbar, and 
microhelp in the lower left portion of the window.  Using the MDI 
application style also dictates that only the single larger CHARM window 
frame contain the menu bar, the toolbar, and the microhelp; that is, the 
multitude of windows that may be generated in the MDI frame do NOT 
contain menus, as the menu bar and the toolbar on the MDI frame 
dynamically change when a child window is selected. 
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CHARM Menus and Commands 
All CHARM commands are organized in menus on the menu bar on the 
CHARM MDI frame.  A menu lists all the available commands for a 
selected window, but only those that are not grayed are executable at a 
particular time.  Since CHARM operates in the Microsoft Windows 
environment, many of the conventions are similar.  For example, CHARM 
provides drop-down menus, icons, and the choice of using the mouse, 
the keyboard, or both. 

The File, Edit, and Window menus represented in the CHARM program 
are similar to the Windows menus of the same names.  Refer to the 
Microsoft Windows User's Guide for a more detailed description of the 
standard Windows menus and commands.  The CHARM program 
provides additional menus and commands. 

CHARM provides menus for displaying and altering text and graphics.  
These menus include the File, MetFile, Options, and Displays menus.  
The commands on these menus change depending on the currently 
displayed window and user input.   Refer to Chapter 8, "Menu and 
Command Reference" for a complete listing of all CHARM menus and 
commands.  

The CHARM editor (CHARMED) has special menus and commands that 
are described in Chapter 4, "Using the CHARM Editor." 

CHARM File Names 
When you save a file in CHARM or CHARMED, you can assign the base 
file name and let CHARM assign the default extension, or you can assign 
the base name and the extension.  CHARM uses the file name extension 
for identifying the names to display for selection lists.   

CHARM uses several default file name extensions that are assigned 
according to the file type.  Some file type extensions are user-definable 
(see “CHARM.INI File Description” in this chapter).  The default 
extensions used by CHARM and a brief description of each file type 
follows: 

.IND A file containing subdirectory information 
that CHARM uses to locate .EMG files.  
Files with .IND extensions are created by 
the user with a text editor and are only 
used in accordance with the Scenario 
command under the File menu. 
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.EMG A file containing release scenario data.  
When you save a release scenario without 
specifying a file name extension, CHARM 
assigns the .EMG default extension. 

.MET A file containing meteorological data.  
When you save met data without 
specifying a file name extension, CHARM 
assigns the .MET default extension. 

.MAP A file containing a map.  When you save a 
map without specifying a file name 
extension, CHARM assigns the .MAP 
default extension. 

.MFD A file containing a map definition.  
CHARM automatically creates this file 
when you save a map.  A file with the 
.MFD extension should not be deleted 
unless its corresponding .MAP file is also 
deleted.  Likewise, if the .MAP file is 
moved to a different location (subdirectory) 
on the PC disk, the .MFD file should also 
be moved to the same location. 

.TPY A file containing population information to 
be used in determining population 
impacts for a plume or footprint.  This file 
is initially generated from the TIGERMAP 
Utility program.  The user then specifies in 
CHARMED under ‘Edit/Select Population 
Files’ which population files are to be used 
to calculate population impacts in 
CHARM. 

.TGR A map file initially generated from the 
TIGERMAP Utility program.  The file is 
merely graphic information processed 
from 1992 Tiger Line Census Bureau data.  
The format is not readable from within 
CHARM or CHARMED, and is only 
displayed in the TIGER MAP Utility. 

.PLM An ascii text file that contains the 
Cartesian x, y, and z coordinates and 
other pertinent information that define the 
extents of a plume or footprint. 
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.SHP A file which describes a footprint of impact 
(concentration, thermal radiation, or 
overpressure) which can be transferred to 
ArcView for display. An ArcView shape file 
is actually three files: the main file, an 
index file, and a dBase file with attributes.  
These three files all have the same names 
and locations except for their extensions.  
The main file extension is .SHP. The index 
file extension is .SHX and the dBase file 
extension is .DBF. 

 

Files with .EMG, .MET, .MAP, TPY, TGR, and PLM extensions are used in 
selection lists when no other extension is specified. Files with .IND and 
.MFD extensions have exclusive purposes in CHARM.  Files with the .IND 
extension are user-created ascii files that identify the locations of certain 
.EMG files.  Files with .MFD extensions are created by CHARM to 
accompany a .MAP file and provide the necessary map definition 
information specified with the map editor.  These file name extensions 
should not be used for other purposes. 

Creating .IND Files 
Files with the .IND extension are index files that point to subdirectories 
containing .EMG files.   You can create .IND files with a text editor.  
When the Scenarios command is selected from the File menu in the Main 
CHARM Input Window, CHARM initially searches the initial lookup 
directory for files that have the .EMG extension.   This initial lookup 
directory is defined in CHARMED under the File Locations command of 
the Edit menu labeled ‘Scenario Files’.  If no .EMG files are found, 
CHARM searches for an .IND file for directions.  Files with .EMG and 
.IND extensions should not exist in the same directory, because only the 
.EMG files will be accessed.  Additionally, only the first. IND file CHARM 
encounters in a directory is used and any others are ignored.  Therefore, 
only one .IND file should exist per directory. 

An .IND file can have multiple pairs of subdirectory listings.  Each 
subdirectory can have subdirectories.  A subdirectory that has .EMG files 
can multiple .EMG files associated with that subdirectory. 

To create an .IND file, use a text editor to open a new file.  Enter a pair of 
lines for each subdirectory. The first line of the pair can have up to 60 
characters naming the subdirectory.  Full path names are not required, 
because the named subdirectory is added to the full path name of the 
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previous directory searched.  The second line of the pair provides 
CHARM with a detailed description of the subdirectory when the 
directory is listed to the user for selection. 

Steps for creating IND Files: 

1) The user must define the location of the initial .IND file under the File 
Locations command in the CHARM editor (CHARMED) in the field labeled 
‘Scenario Files’. 

2) From Windows Explorer, create subdirectories which layout, for 
example, geographical aspects of possible release sites.  Other 
alternatives for organizing your data may be by process or chemical 
inventory. 

 

3) From Notepad (or some other text editor), create a file with the .IND 
extension and format the file as follows: 

Format 

  <Subdirectory Name> 
  <Description associated with subdirectory name> 
  <Subdirectory Name> 
  <Description associated with subdirectory name> 
  <Subdirectory Name> 
  <Description associated with subdirectory name> 
 

Example 

The EXAMPLE.IND would read as follows and reside in the 
C:\CHARM\PLANT subdirectory: 

   EAST 
   Relase occurred in east side of plant 
   NORTH 
   Relase occurred in north side of plant   
 SOUTH 
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   Relase occurred in south side of plant 
   WEST 
   Relase occurred in west side of plant 
 

NOTE: The above file should reside in the initial Emergency Response file 
location defined by the CHARM editor (CHARMED).  No prestored data files 
(.EMG) should reside in the same directory as .IND files.  CHARM attempts 
to locate EMG files first.  If EMG files are located and read, no attempt is 
made to locate IND files. 

4) Repeat Step 3 for all directories. 

Creating .EMG Files 
CHARM creates files with the .EMG extension when you save the release 
input data.  Initially, this file type extension is .EMG.  However, refer to 
“CHARM.INI File Description” later in this chapter for information about 
redefining this default extension.  You must specify a base name for the 
file.  Unless you specify a different file name extension, CHARM 
automatically adds the default extension.  Files with the default 
extension can be created with the Save and Save As commands on the 
File menu.  

On-line Help 
CHARM provides on-line help that explains each window and field in the 
program.  On-line help is available in both CHARM and CHARMED.  
Press <F1> for a description of the contents of the current window or 
dialog box.  When you select a field for data input, the dialog box 
contains a Help command button that displays field information and the 
data entry requirements.  To select help on a menu or topic, select 
<Shift-F1>.  The cursor will change to a pointer with a question mark.  
Simply point to the menu item or the editable text and click the left 
mouse button.  CHARM will attempt to locate on-line help for the 
selected menu or topic.  If CHARM cannot locate the menu or topic, it 
will display an index into on-line help. 

Dialog Boxes 
CHARM displays a dialog box whenever it needs additional information to 
carry out a command.  Dialog boxes typically contain text, lists of 
available choices, command buttons, and option buttons.  You may be 
required to make a selection or enter text or values.  Normally, default 
values are provided.  Any units of measure that are acceptable for the 
entry are available in drop-down lists.  The OK, Cancel, and Help 
command buttons are also available in dialog boxes. 

364



Getting Started   

 

20

Many of the values solicited in a CHARM dialog box require you to make 
an entry.  If you try to select the OK command button when the entry 
field is blank, CHARM displays a message saying an entry is required.  
However, in some cases, it may be OK to leave the field blank, whereby 
CHARM will accept the blank entry. 

CHARM often accepts only those values that are within certain limits.   
For example, relative humidity must be less than or equal to 99.  If you 
try to enter an unacceptable value, CHARM displays a message showing 
the acceptable range of values. 

Default Input Values 
On some occasions, you may need to estimate a release incident about 
which you have little data.  In an emergency situation, you may not only 
have little data, but you need to enter the data quickly.  To address this, 
CHARM provides default values for data fields that are essential to the 
calculations.  Default values appear on the screen as already entered 
data.  In some cases, these default values may be user-definable (see 
“CHARM.INI File Description” in this chapter). These values may 
represent the worst-case conditions or some typical situation.  You can 
accept the default values or replace them with more accurate data.   

CHARM.INI File Description 
The file CHARM.INI is used to store information which CHARM reads and 
uses as defaults upon starting the program.  The file is divided into two 
sections: [Directories] and [Default settings]. The [Directories] section 
associates types of files with physical subdirectory locations on your 
hard disk.  Currently, CHARM differentiates between fifteen types of files.  
Initially, upon installation, all subdirectories default to the setup 
directory.  Thirteen of these fifteen subdirectories may and should be 
modified from CHARM or CHARMED.  The two file types (HelpDir and 
WinchDir) can only be changed by modifying the CHARM.INI file itself. In 
order to do this, use the following instructions: 

1) Exit CHARM. 

2) Open your CHARM.INI file using a text editor such as Notepad. 

3) Find the [Directories] section of the file.  It should be the first section. 

4. Change the subdirectory associated with any one of the following: 

(NOTE: Make sure the subdirectory truly exists.) 
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HelpDir - this subdirectory will contain CHARM help files (.HLP files). 

 For example, HelpDir=c:\charm\help\; 

WinchDir - this subdirectory will contain your encrypted hidden 
password file for access to the CHARM Editor. 

 For example, WinchDir=c:\charm\winch\; 

NOTE: Any other modifications to the following should be made from 
within CHARM or CHARMED. 

DataDir - this subdirectory will contain CHMDAT*.* files (chemical 
database files). 

 For example, DataDir=c:\charm\data\; 

SiteDir - This subdirectory will contain site specific information in the a 
file labeled USRMSG. 

 For example, SiteDir=c:\charm\site\; 

CommDir - this subdirectory contains files (METINTER.EXE, 
METINTER.INI, and METDAT*.*) necessary to establish and maintain 
communication with a data logger (if available). 

 For example, CommDir=c:\charm\comm\; 

ScenDir - this subdirectory contains a *.IND file or *.EMG files. 

 For example, ScenDir=c:\charm\scenario\; 

MapDir - this subdirectory is the default for saving or displaying map 
files with the extensions associated with the keyword MapExt under the 
section labeled [Default settings] in CHARM.INI. 

 For example, MapDir=c:\charm\maps\; 

EmgDir - this subdirectory is the default for saving or displaying pre-
stored scenario data files with the extensions associated with the 
keyword EmgExt under the section labeled [Default Settings] in 
CHARM.INI. 

 For Example, EmgDir=c:\charm\emgs\; 

366



Getting Started   

 

22

MetDir - this subdirectory is the default for saving or displaying pre-
stored met data files with the extensions associated with the keyword 
MetExt under the section labeled [Default settings] in CHARM.INI. 

 For Example, MetDir=c:\charm\mets\; 

AsciiDir - this subdirectory is the default for storing data files  
containing real-world coordinates of plume, thermal radiation, or 
overpressure footprints generated by CHARM.  The default extension for 
listing these data files is associated with the keyword AsciiExt under the 
section labeled [Default settings]. 

 For Example, AsciiDir=c:\charm\ascii\; 

ShapeFileDir - this subdirectory is the default for storing ArcView shape 
files containing plume, thermal radiation, or overpressure footprints 
generated by CHARM.  The default extension for listing these data files is 
associated with the keyword ShapeFileExt under the section labeled 
[Default Settings].  A set of files for an ArcView shape file also consist of 
files containing the SHX and DBF extensions. 

 For Example, ShapeFileDir=c:\charm\shapes; 

DIPPRDir - this subdirectory is the default where CHARMED looks to 
find the DIPPR database for importing chemical data into CHARM’s 
chemical database. 

 For Example, DIPPRDir=c:\charm\dippr\; 

PopFiles - this keyword contains a list of comma delimited files 
(including paths) of those population files that were processed from 
CHARM’s TIGERMAP Utility for use with population impacts. 

 For Example,      
 PopFiles=c:\charm\popfiles\county1.tpy,county2,tpy; 

RelDir - this subdirectory is the default from which CHARMED displays 
scenario data files when using the BROWSE button upon selecting files 
associated with a release icon.  The default extension for listing these 
scenario files is associated with the keyword RelExt under the selection 
labeled [Default settings]. 

 For Example, RelDir=c:\charm\emgs\; 

PopDir - this subdirectory is the default where CHARMED displays 
population files when using the BROWSE button upon selecting files 
used for population impacts.  The default extension for listing these 
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population files is associated with the keyword PopExt under the 
selection labeled [Default settings]. 

 For Example, PopDir=c:\charm\popdata\; 

5) Save your CHARM.INI file. 

6) Restart CHARM. 

The [Default settings] section contains default values for variables within 
CHARM itself.  DO NOT CHANGE ANY OF THESE VALUES AS THEY 
ALL MAY BE CHANGED FROM WITHIN CHARM.  CHANGING A 
VALUE MAY CAUSE CHARM TO RUN IN AN INCORRECT MANNER OR 
POSSIBLY CRASH THE SYSTEM.  You may change some variables 
without having severe effects on CHARM: MapExt, EMGExt, MetExt, 
AsciiExt, ShapeFileExt, PopExt, and RelExt.  MapExt contains the 
default extension for map files; EMGExt contains the default extension 
for prestored scenario files; MetExt contains the default extension for met 
data files; AsciiExt contains the default extension for text files that 
contain x,y, and z real world coordinates of a plume or footprint;  
ShapeFileExt contains the default extension for plume or footprint 
datafiles formatted to import into ArcView; PopExt contains the default 
extension to browse for when selecting population files in CHARMED; 
RelExt contains the default extension to browse for when associating 
emergency response files with release icons in Map Definition in 
CHARMED. 

Search Function 
When the chemical selection list is being displayed, you can perform a 
forward or backward search through the chemical database.  First, select 
Set String and enter the character string for which you want to search.  
Then, select Up to search backward or Down to search forward through 
the database. 

When you specify the character string, you can use the wild card 
characters, * (asterisk) and ? (question mark).  The * represents zero or 
more characters.  The ? represents a character location within the string 
rather than a special character. 

Using the Mouse 
The mouse can be used to move icons, expand and shrink windows, and 
select menus and commands.  The mouse techniques used in CHARM 
include pointing, dragging, clicking, and double-clicking.   
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The CHARM program responds to left mouse button clicks and 
combining keys (e.g. Shift, Ctrl, and Alt) with left mouse button clicks.  
Menus and commands are selected in the same manner in CHARM as in 
the Windows program.  Clicking the left mouse button highlights a field 
or selects a location pointed to by the cursor.  Double-clicking the left 
mouse button on a field displays a dialog box for data input. 

The CHARM dialog boxes display command buttons that can be selected 
with the mouse.  You can select the OK command button to complete an 
action, or select the Cancel command button to ignore the attempted 
action.  These are standard techniques for Windows applications. 

Using the Keyboard 
The keyboard can be used to achieve the same results as the mouse.  
The following keys are standard for the CHARM application: 

<Alt> Moves the inverse video bar to the 
menu bar.  Use the arrow keys to 
position the inverse video bar. 

<Esc> Clears a menu from the screen. 

Arrow keys  Move the inverse video bar 
(highlighted selection) up, down, 
right, or left.  In CHARM and 
CHARMED, the arrow keys can 
also be used to move the crosshair 
cursor on graphic displays, define a 
zoom area, define a map scale, and 
reposition plumes, footprints, and 
icons. 

<Enter> Selects the highlighted item or map 
location represented by the cursor.  
On a map display, <Enter> can be 
used to select an icon or generate a 
dose display at a specific location.  
In a dialog box, <Enter> directs 
CHARM to accept the displayed 
values or cancel the operation, 
depending on which command 
button is highlighted. 
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Page Up Scrolls a window display up.  In 
CHARMED, after an option from 
the Define menu of the Map 
Definition window is selected, 
<Page Up> moves the cursor 
instead of the map display. 

Page Down Scrolls a window display down.  In 
CHARMED, after an option from 
the Define menu of the Map 
Definition windows is selected, 
<Page Down> moves the cursor 
instead of the map display. 

<Ctrl-Arrow key> Changes the position of the plume, 
overpressure, or radiation footprint 
within the viewport by virtually 
moving the solid circle on the CHARM 
display. 

<Shift-Enter> In CHARM, when the cursor is on a 
map location icon on a snapshot 
footprint view, <Shift-Enter> displays 
the enlarged map represented by the 
icon.  When the cursor is on a release 
icon, <Shift-Enter> displays a 
selection list of release scenarios for 
the location.  In CHARMED, <Shift-
Enter> selects an icon to be 
repositioned. 

<Shift-Arrow  key> In CHARMED, <Shift-Arrow key> 
moves an icon that has been selected 
with <Shift-Enter>. 
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Chapter 4:  Using the CHARM Editor 

Use the CHARM editor (CHARMED) to identify the locations of the files 
that CHARM uses; add, modify, or delete data from the chemical 
database; update chemical data from a previous version of a CHARM 
database; enter site-specific information; set up communication with a 
meteorological tower(s); select population data files to determine 
population impacts; and define maps for display with the CHARM 
program. 

Use the following steps to run the CHARM editor: 

1. Double click the CHARMED icon in the CHARM Group in Program 
Manager, or 

Select CHARMED.EXE from the CHARM installation directory using 
the Windows Explorer or My Computer from the desktop. The 
CHARMED window is displayed.   

The CHARMED window shown in Figure 4.1 is displayed. 

 

 

The CHARMED Window 

The main CHARM editor window has several menus, the most significant 
one where the user will spend most of the time is the Edit menu.  The 
Edit menu provides a command for each of the following CHARM editors: 

Chemical Database Add, modify, or delete data in 
the chemical database. 

Figure 4.1 
Main CHARM 
Editor 
Window 
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Import Previous 
Database 

Displays a dialog box 
requesting the path to the 
previous version of the CHARM 
database.  Once the path is 
entered, CHARM will attempt to 
update the current database 
from those records in the 
previous database.  The user 
will be prompted to add or 
modify any data that exists in 
the previous database and not 
in the most recent database. 

Update Plot 
Concentrations 

Displays a dialog box 
requesting the path to the 
previous version of the CHARM 
database.  Once the path is 
entered, CHARM will attempt to 
update the default plot 
concentrations in the current 
database from those records in 
the previous database.  The 
user will be prompted for 
verification. 

Pack Chemical 
Database 

Physically removes logically 
deleted records from the 
chemical database.  Records 
are logically deleted from 
within the Chemical Database 
editor using the Delete button. 

Local Met Comm 
Parameters 

Sets the parameters for 
communications with a 
meteorological tower.  Another 
Radian software program 
(METINTER.EXE) is required 
for the implementation of 
communication with a tower. 
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Network Met Server 
Location 

Sets the logical name of the 
server to where a network 
version of the Meteorological 
Interface (METINTER.EXE) will 
reside for LAN/WAN access. 

File Location Specifies where CHARM can 
find necessary files. 

Site Information Specifies site-specific 
information for a release in a 
file labeled USRMSG. 

Map Definition Reads maps and provides 
commands to edit them for use 
with CHARM. 

Select Population 
Files 

Select population files to be 
used in determining population 
impacts for a plume or 
footprint.  These files are 
initially generated from the 
TIGERMAP Utility program. 

Change Password Defines CHARM/System 
password to regulate 
CHARMED entry.  This menu 
item may be grayed and 
optional to the user.  Contact 
Radian to allow password 
access. 

Exit Exits CHARMED. 

 

Only one editor can be used at a time.  When you exit from an editor, you 
are returned to the CHARMED window. 

Editing File Locations for CHARM 

Use the File Location command on the Edit menu of the CHARMED 
window to identify the directory locations for the chemical database, site 
specific information, meteorological communication parameters, as 
well as the location of the emergency response files.  Emergency 
response files have  default .EMG extensions, unless you specify a 
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different extension (see Chapter 3: CHARM.INI File Description).  CHARM 
uses this directory information to locate necessary files.  Figure 4.2 
shows the CHARMED File Location Editor. 

 

 

To identify directory locations: 

1. Run the CHARM editor by selecting the CHARMED.EXE file.  The 
CHARMED window is displayed. 

2. Select the File Locations command on the Edit menu of the 
CHARMED window. 

3. Enter the full path names for the directories containing the Chemical 
Database, Site Specific Information, Meteorological Communication 
Parameters, and Scenario files.  Alternatively, use the Browse button 
associated with each file directory to input full path names. 

4. Select OK or press <Enter>. 

Maintaining the Chemical Database 

The chemical database provides over 180 chemical species and their 
characteristics for use with the CHARM program.  Information from the 
chemical database is displayed in the Chemical Selection and Chemical 
Editor windows of the CHARM editor. 

The Chemical Selection Window 
After you select the Chemical Database command from the Edit menu, 
the Chemical Selection window shown in Figure 4.3 is displayed.  This 
window contains a list of all the chemicals in the database.  The 

Figure 4.2 
File Location 
Editor 
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Change Name, Delete, and Modify commands require you to select the 
chemical name first.  To select a chemical, simply highlight the desired 
compound by left mouse clicking on the chemical name.  You can use 
the search or scroll functions to look for a particular chemical species. 

 

Using the Search Function 
Use the Search function to look for a particular chemical in the chemical 
database.  This function can be used to find entire chemical names 
quickly or to find a chemical whose name is only partially known.  The 
Search function is also available in CHARM when the chemical species is 
selected for input.  The following dialog box is displayed when you select 
the Set Search String command button from the Chemical Selection 
window. 

 

To perform a search on the list of chemical names: 

1. Run the CHARM editor by selecting the CHARMED icon from the 
CHARM group or by executing the CHARMED.EXE file from the 
Windows Explorer or My Computer on the desktop.  The CHARMED 
window is displayed. 

2. Select the Chemical Database command on the Edit menu.  The 

Figure 4.3 
Chemical 
Selection 
Window 
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Chemical Selection window is displayed. 

3. Select the Set string radio button from within the Search group box.   

4. Type a character string for the search and include one of the wild 
card characters, * (asterisk) or ? (question mark). 

The * represents zero or more characters. The ? represents the 
position of a character in the string, rather than a particular 
character. 

A search allows for multiple order-dependent strings to be used.  For 
example, a search for the character string "di*meth*e?e" retrieves all 
strings with the substrings "di," followed by "meth," and then followed 
by "e?e."  The ? represents any character with an "e" on either side. 

5. Select OK or press <Enter>. 

6. Specify whether to search backward or forward from the currently 
highlighted species by selecting the Up or Down button.  Either the 
highlight bar moves to the first name that matches the search string, 
or a message displays saying no matches were found. 

Chemical Species 
The chemicals available with CHARM are listed below.  (NOTE:  Your copy 
of CHARM may actually contain more than the names listed below, since 
new chemicals are periodically added to this list). 

Acetaldehyde 
Acetic Acid 
Acetone 
Acetonitrile 
Acetylene 
Acrolein 
Acrylic Acid 
Acrylonitrile 
Aerozine (50% solution) 
Allyl Alcohol 
Allylamine 
Allyl Chloride (3-Chloropropene) 
Ammonia 
Ammonia 25% 
Ammonia (15% solution) 
Ammonia (20% solution) 
Ammonia (29% solution) 
Ammonia (3.6% solution) 
Ammonia (49.9% solution) 
Ammonia (5% solution) 
Aniline 
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Arsine 
Benzene 
Benzyl Chloride (Tolyl Chloride) 
Benzyl Cyanide 
Boron Trichloride 
Boron Trifluoride 
Bromine 
2-Bromoproprionic Acid 
1,3-Butadiene 
Butane 
1-Butene(a-Butylene) 
2-Butene-cis 
2-Butene-trans 
Carbon Dioxide 
Carbon Disulfide 
Carbon Monoxide 
Carbon Tetrachloride 
Chlorine 
2-Chloroethanol 
Chloroform 
Chloromethly Ether 
Chloromethly Methyl Ether 
2-Chloropropolene 
Crotonaldehyde, (E) 
Cyanogen Bromide 
Cyanogen Chloride 
Cyclohexylamine 
Cyclopropane 
Diallylamine 
Diborane 
Dibutyl Phthalate 
2,3 Dichloropropene 
Dichlorosilane 
Diethylene Triamine 
Difluoroethane 
Diisopropylaminoethanol 
Diisopropylcarbonate 
Dimethylamine 
Dimethyldichlorosilane 
Dimethyl Disulfide 
2,2-Dimethylpropane 
Dimethyl Sulfate 
Di-tert-butylethyldiamine 
Epichlorohydrin 
Ethane 
Ethanol 
Ethyl Acetylene 
Ethyl Acrylate 
Ethylamine 
Ethyl Chloride 
Ethylene 
Ethylenediamine 
Ethylene Dibromide(1,2-Dibromoethane) 
Ethylene Dichloride(1,2-Dichloroethane) 
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Ethylene Glycol 
Ethyleneimine 
Ethylene Oxide 
Ethyl Ether 
2-Ethyl-1-Hexanol 
Ethyl Mercaptan 
Fluorine 
Formaldehyde 
Formaldehyde (37% solution) 
Formaldehyde (56% solution) 
Formic Acid 
Freon 12 (Dichlorodifluoromethane) 
Freon 14 (Carbon Tetrafluoride) 
Freon 16 (Hexafluoroethane) 
Furan 
Furfural 
Hexamethylenediamine 
37% Hydrochoric Acid 
Hydrazine 
Hydrazine Monohydrate (35% Solution) 
Hydrazine (54% Solution) 
Hydrochloric Acid (30% Solution) 
Hydrogen 
Hydrogen Bromide 
Hydrogen Chloride 
Hydrogen Cyanide 
Hydrogen Fluoride 
Hydrogen Fluoride (30% Solution) 
Hydrogen Selenide 
Hydrogen Sulfide 
IRFNA (Inhibited Red Fuming Nitric Acid) 
Isoamylene (2-Methyl-2-Butene) 
Isobutane 
Isobutyronitrile 
Isopentane 
Isoprene 
Isopropanol 
Isopropylamine 
Isopropyl Benzene (Cumene) 
Isopropyl Chloride 
Isopropyl Ether 
Mesityl Oxide 
Methacrylonitrile 
Methane 
Methanol 
2-Methyl-1-Butene 
3-Methyl-1-Butene 
Methyl Chloride 
Methyl Diisocyanate 
Methylene Chloride (Dichloromethane) 
Methyl Ether 
Methyl Ethyl Ketone 
Methyl Formate 
Methyl Hydrazine 
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Methyl Isobutyl Ketone 
Methyl Isocyanate 
Methyl Mercaptan 
Methyl Methacrylate 
Methyl Phosphonic Dichloride 
Methyl Phosphonic Difluoride 
2-Methylpropene 
Methyltrichlorosilane 
Morpholine 
Mustard Gas 
m-Xylene 
n-Butane 
n-Butyl Acetate 
n-Butyl Acrylate 
n-Butyl Alcohol (1-Butanol) 
n-Decane 
n-Hexane 
Nitric Acid (70% Solution) 
Nitric Acid (98Solution) 
Nitric Oxide 
Nitrogen Dioxide 
Nitrogen Dioxide/ Dinitrogen Tetroxide 
Nitrogen Tetroxide 
Nitrogen Trifluoride 
N,N-DimethylFormamide 
o-Cresol 
o-Dichlorobenzene 
Oleum (35%) 
Oxygen 
Parathion 
Pentane 
1-Pentene 
2-Pentene,(E) 
2-Pentene,(Z) 
Phenol 
Phosgene 
Phosphine 
Phosphorous Oxychloride 
Phosphorous Trichloride 
Pinacolyl Alcohol 
Piperidine 
Propadiene 
Propane 
Propionic Acid (Methylacetic Acid) 
Propionitrile 
Propylene 
Propyleneimine 
Propylene Oxide 
Sarin 
Silane 
Soman 
Styrene 
Sulfur Dioxide 
Sulfuric Acid (98% solution) 
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Sulfur Trioxide 
tert-Butyl Alcohol (2-Methyl-2-Propanol) 
tert-Butylamine 
Tetrachloroethylene (Perchloroethylene) 
Tetraethyl Lead 
Tetrafluoroethylene 
Tetrahydrofuran 
Tetramethylsilane 
Tetranitromethane 
Thionyl Chloride 
Thiophenl (Benzenethiol) 
Toluene 
Toluene Diisocyanate 
Toluene 2,4-Diisocyanate 
1,1,1-Trichloroethane (Methyl Chloroform) 
Trichloroethylene 
Trichlorosilane 
Trifluorochloroethylene 
Trimethylamine 
TriMethylChloroSilane 
Unsymmetrical Dimethyl Hydrazine 
Vinyl Acetate 
Vinyl Chloride 
Vinyl Ethyl Ether 
Vinyl Fluoride 
Vinylidene Choride 
Vinylidene Fluoride 
Vinyl Methyl Ether 
VX 

The Chemical Editor Window 
The Chemical Editor Window contains the thermodynamic data that 
define the chemical in the database.  The window shown in Figures 
4.4,4.5, and 4.6 is displayed when you select the Add or Modify 
command buttons in the Chemical Selection window. 

 
Figure 4.4 
Chemical 
Editor 
Window (top) 
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To edit chemical data, move the highlight bar over the field and double-
click the left mouse button or press <Enter>.  A dialog box is displayed in 
which you can change the value.  When you edit chemical data, the 
database is updated only if you select Close or Save from the File menu.  
If you select Close after making changes to the data, CHARMED will 
prompt the user to save changes to the chemical database. 

Figure 4.5 
Chemical 
Editor 
Window 
(Temperature 
Dependent 
Equations) 

Figure 4.6 
Chemical 
Editor 
Window 
(Bottom) 
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When you are running the CHARM program, you can display chemical 
data for the selected species by selecting the Chemical Data command on 
the Displays menu of the Main CHARM Input Window and the Displays 
menu of plan view windows.  You can also display the Emergency 
response text from the database by selecting the Emergency Response 
command on the Displays menu. 

File Menu 
The File menu in the Chemical Editor closes the chemical data window, 
saves any changes to the database, edits emergency response text, prints 
the text in a window, previews the data before printing, configures the 
printer, or exits the CHARM Editor. 

Edit Menu 
The Edit menu in the Chemical Editor window allows the user to export 
the chemical data currently displayed in the window.  To accomplish 
this, select the Copy Data command from the Edit Menu.  The chemical 
data are copied to Window’s Clipboard in an ordered, comma delimited 
format.  Likewise, chemical data may be imported in the same manner.  
Once comma delimited data exists in the Clipboard, select the Paste Data 
command from the Edit menu, and the data is copied from the Clipboard 
into the Chemical Database window into the appropriate data fields. 

Another method of importing data involves CHARM’s interface to the 
DIPPR database.  For this option, select Import From DIPPR under the 
Edit menu.  CHARMED displays a selection list of all the species in the 
DIPPR chemical database (see Figure 4.7).  The display window is much 
like the CHARM Chemical Species selection window.  The user may build 
a search string containing wild card characters * (asterisk) or ? (question 
mark).  The * wild card character represents zero or more character, and 
the ? wild card character represents the position of a single character 
(see Using the Search Function in this chapter). 

The user may search by name or by CAS number.  After selecting a 
chemical, the DIPPR database is read and the data in the original data 
display window is replaced.  To exit the Chemical Selection window 
without choosing a chemical, select the Cancel command button.  
CHARMED will inform the user if any values required by CHARM were 
not located in the DIPPR database.  The missing data values will be 
reported as zeros (0.00) in the CHARMED Chemical Data sheet. 

The Copy menu item simply copies the contents of the Chemical 
Database window, including field description text, into the clipboard. 
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Chemical Data 
The chemical database includes the following thermodynamic data for 
each chemical:  

Molecular Weight 
The molecular weight (grams per mole) of the species. 

 

Normal Boiling Point (NBP) 
The temperature (Kelvin) at which the vapor pressure of the liquid is 
equal to one atmosphere. 

 

Melting Point 

Figure 4.7 
DIPPR 
Selection 
Window 
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This is the temperature (Kelvin) at 1 atmosphere of pressure at which the 
solid phase of the species changes to liquid. 

 

Triple Point Temperature 
This is the temperature (Kelvin) at the triple point pressure which all 
three phases (solid, liquid, and vapor) of the species exist. 

 

Triple Point Pressure 
This is the pressure (atmospheres) at the triple point temperature which 
all three phases (solid, liquid, and vapor) of the species exist. 

 

Critical Temperature 
The temperature (Kelvin) above which a gas cannot be liquefied, 
regardless of pressure. 
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Critical Pressure 
The lowest pressure (atmospheres) required to liquefy the gas at the 
critical temperature. 

 

Critical Volume 
The molar volume (cubic centimeters) at the critical point.  The critical 
point is the temperature and pressure at which the liquid and vapor 
states of a material have the same density. 

 

Heat of Vaporization at Normal Boiling Point  
The heat of vaporization (Joules per kilogram) at normal boiling point 
(NBP).  This value is used to determine the heat required (ambient air to 
be entrained) to evaporate any droplets of the released species. 
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Surface Tension of Liquid Phase at NBP 
A measure (Newtons per meter) of the lateral elasticity of a liquid surface.  
This is a measure of the resistance of a fluid to flow. 

 

Viscosity of Liquid Phase at NBP 
A measure (kilograms per meter seconds) of the resistance of a fluid to 
flow. 

 

Gamma (Cp/Cv) 
The ratio of the vapor state heat capacity at constant pressure to the 
vapor state heat capacity at constant volume.  This is a dimensionless 
value. 
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Energy of Molecular Interaction 
Energy divided by the Boltzman constant (hence Kelvin units).  The value 
can be estimated with the following equation: 

E/K = 1.15 TB 

where Tb is the normal boiling point.  The energy of molecular interaction 

is used in calculating the rate at which molecules of an evaporating 
liquid leave the surface.   

 

Effective Diameter of Molecule 
The diameter (Angstroms) of an average molecule.  This diameter is 
determined from the volume of an average molecule, which is the molar 
volume divided by Avogadros number, and then solved for the diameter.  
Normally, the liquid molar volume used is at normal boiling point.  The 
diameter can be computed from the liquid molar volume (V) at the 
normal boiling point using the following equation: 

D = 1.18 (V / N)(1/3) 

where N is Avogadros number. 
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Liquid Heat Capacity Equation 
This is the form of the equation used to calculate the liquid phase heat 
capacity (J/kmole K).  Two forms are allowed.  After selecting the form, 
the parameters in the equation must entered.  The two forms of the 
equation are: 

Cp = A + B*T + C*T2 + D*T3 + E*(T2) 2 

Cp = A2/T+B-2*A*C*T-A*D*T2-C2*T3/3-C*D*(T2) 2/2-D2*T2*T3/5 

where 
T = temperature (K)  
A, B, C, D, and possibly E = parameters to be input. 

 

Liquid Heat Capacity Coefficient A 
This is the A term of the equation used to calculate the liquid phase heat 
capacity (J/kmole K).  The equation takes one of the two forms described 
in the section above labeled ‘Liquid Heat Capacity Equation’.  Depending 
on the form of the Liquid Heat Capacity Equation, the coefficients A, B, 
C, D, and possibly E are required to be input.   
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Liquid Heat Capacity Coefficient B 
This is the B term of the equation used to calculate the liquid phase heat 
capacity (J/kmole K).  The equation takes one of the two forms described 
in the section above labeled ‘Liquid Heat Capacity Equation’.  Depending 
on the form of the Liquid Heat Capacity Equation, the coefficients A, B, 
C, D, and possibly E are required to be input.  

 

Liquid Heat Capacity Coefficient C 
This is the C term of the equation used to calculate the liquid phase heat 
capacity (J/kmole K).  The equation takes one of the two forms described 
in the section above labeled ‘Liquid Heat Capacity Equation’.  Depending 
on the form of the Liquid Heat Capacity Equation, the coefficients A, B, 
C, D, and possibly E are required to be input.  

 

Liquid Heat Capacity Coefficient D 
This is the D term of the equation used to calculate the liquid phase heat 
capacity (J/kmole K).  The equation takes one of the two forms 
described in the section above labeled ‘Liquid Heat Capacity Equation’.  
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Depending on the form of the Liquid Heat Capacity Equation, the 
coefficients A, B, C, D, and possibly E are required to be input.  

 

Liquid Heat Capacity Coefficient E 
This is the E term of the equation used to calculate the liquid phase heat 
capacity (J/kmole K).  This coefficient is only required if the form of the 
Liquid Heat Capacity Equation described in the section above labeled 
‘Liquid Heat Capacity Equation’ is of the form 

Cp = A + B*T + C*T2 + D*T3 + E*(T2) 2 

The coefficients A, B, C, and D are required to be input. 

 

Liquid Density Equation 
This is the form of the equation used for calculation of liquid density (d).  
Three forms are allowed.  After selecting the form, the parameters in the 
equation must be entered.  The three forms of the equation are: 

d = (MW/Vc)*(1+A*(1-Tr)(1/3)+B*(1-Tr)) 
d = A/B^(1 + (1-T/C)D) 
d = A + B*T + C*T2 + D*T3 + E*(T2) 2 

where 
MW = molecular weight (kg/kmole) 
Vc = critical volume (m3/kmole) 
T = temperature (K) 
Tr = T / Tc 
Tc = critical temperature (K) 
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A, B, and possibly C, D, and E = parameters to be input, depending 
on the form of the equation chosen. 

 

Liquid Density Equation Coefficient A 
This is the A term (units depend on the equation form) of the equation 
used to calculate the liquid density (d).  The equation takes one of the 
three forms described in the section above labeled ‘Liquid Density 
Equation’.  In any form of the Liquid Density Equation, the coefficient A 
is required.   

 

Liquid Density Equation Coefficient B 
This is the B term (units depend on the equation form) of the equation 
used to calculate the liquid density (d).  The equation takes one of the 
three forms described in the section above labeled ‘Liquid Density 
Equation’.  In any form of the Liquid Density Equation, the coefficient B 
is required.   

 

Liquid Density Equation Coefficient C 
This is the C term (units depend on the equation form) of the equation 
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used to calculate the liquid density (d).  The equation takes one of the 
three forms described in the section above labeled ‘Liquid Density 
Equation’.  If the Liquid Density Equation is of the form 

d = A/B^(1 + (1-T/C)D), or 
d = A + B*T + C*T2 + D*T3 + E*(T2) 2, 

the coefficient C is required.  Otherwise, set C=0.   

 

Liquid Density Equation Coefficient D 
This is the D term of the equation used to calculate the liquid density (d).  
The equation may only take one of three forms described in the section 
above labeled ‘Liquid Density Equation’.  If the Liquid Density Equation 
is of the form 

d = A + B*T + C*T2 + D*T3 + E*(T2) 2, 

the coefficient D is required.  Otherwise, set D=0.   

 

Liquid Density Equation Coefficient E 
This is the E term of the equation used to calculate the liquid density (d).  
The equation may only take one of three forms described in the section 
above labeled ‘Liquid Density Equation’.  If the Liquid Density Equation 
is of the form 

d = A + B*T + C*T2 + D*T3 + E*(T2) 2, 

the coefficient E is required.  Otherwise, set E=0.   
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Vapor Phase Heat Capacity Equation 
This is the form of the equation used for calculation of vapor phase heat 
capacity (Cp).  Three forms are allowed.  After selecting the form, the 
parameters in the equation must be entered.  The three forms of the 
equation are: 

Cp = A + B*exp[-C/TE] 
Cp = A + B*[C/T*sinh(C/T)]2 + D*[E/T*cosh(E/T)] 2 
Cp = A + B*T + C*T2 + D*T3 + E*(T2) 2 

where 
T = temperature (K) 
A, B, C, D, and possibly E = parameters to be input, depending on 
the form of the equation chosen. 

 

Vapor Phase Heat Capacity Equation Coefficient A 
This is the A term of the equation used to calculate the vapor phase heat 
capacity (J/kmole K).  The equation takes one of the three forms 
described in the section above labeled ‘Vapor Phase Heat Capacity 
Equation’.  In any form of the Liquid Density Equation, the coefficient A 
is required.   
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Vapor Phase Heat Capacity Equation Coefficient B 
This is the B term of the equation used to calculate the vapor phase heat 
capacity (J/kmole K).  The equation takes one of the three forms 
described in the section above labeled ‘Vapor Phase Heat Capacity 
Equation’.  In any form of the Liquid Density Equation, the coefficient B 
is required.   

 

Vapor Phase Heat Capacity Equation Coefficient C 
This is the C term of the equation used to calculate the vapor phase heat 
capacity (J/kmole K).  The equation takes one of the three forms 
described in the section above labeled ‘Vapor Phase Heat Capacity 
Equation’.  In any form of the Liquid Density Equation, the coefficient C 
is required.   

 

Vapor Phase Heat Capacity Equation Coefficient D 
This is the D term of the equation used to calculate the vapor phase heat 
capacity (J/kmole K).  The equation takes one of the three forms 
described in the section above labeled ‘Vapor Phase Heat Capacity 
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Equation’. If the Vapor Phase Heat Capacity Equation is of the form 

Cp = A + B*[C/T*sinh(C/T)]2 + D*[E/T*cosh(E/T)] 2 
   or 
Cp = A + B*T + C*T2 + D*T3 + E*(T2) 2, 

the coefficient D is required.  Otherwise, set D=0.   

 

Vapor Phase Heat Capacity Equation Coefficient E 
This is the E term of the equation used to calculate the vapor phase heat 
capacity (J/kmole K).  The equation may takes two of the three forms 
described in the section above labeled ‘Vapor Phase Heat Capacity 
Equation’.  If the Vapor Phase Heat Capacity Equation is of the form 

Cp = A + B*[C/T*sinh(C/T)]2 + D*[E/T*cosh(E/T)] 2 
   or 
Cp = A + B*T + C*T2 + D*T3 + E*(T2) 2, 

the coefficient E is required.  Otherwise, set E=0.   

 

First Default Concentration for plotting 
The first of three isopleth concentrations (parts per million) to be used as 
defaults for plotting the plume.  The defaults can be changed while you 
are running or storing a scenario. 

395



Using The CHARM Editor   

 

51

 

Second Default Concentration for plotting  
The second of three isopleth concentrations (parts per million) to be used 
as defaults for plotting the plume.  The defaults can be changed while 
you are running or storing a scenario. 

 

Third Default Concentration for plotting 
The third of three isopleth concentrations (parts per million) to be used 
as defaults for plotting the plume. The defaults can be changed while you 
are running or storing a scenario. 

 

Reported Fraction 
If the emission entering the atmosphere as a gas is actually a mixture 
this parameter allows you to allocate only part of the concentration to a 
single species.  If 20% of the emission were species A and 40% species B, 
two chemicals could be added to the database.  All the parameters would 
be the same for the two species except the name and this parameter.  For 
species A to be reported correctly, this parameter should be 0.20.  For 
species B it should be 0.40.  Most species will have this parameter as 
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1.0.  If it is set to zero, it is assumed to be 1.0. 

 

Parameter A for Concentration Probit Equation 
The A term in the probit equation, which has the following form: 

P = A + B log N(TCN) 

where C is the concentration (parts per million) and T is the exposure 
time (minutes).  The probit is used to determine the probability of 
fatality. 

 

Parameter B for Concentration Probit Equation 
The B term in the probit equation shown previously for Parameter A for 
Concentration Probit Equation. 

 

Parameter N for Concentration Probit Equation 
The N term in the probit equation shown previously for Parameter A for 
Concentration Probit Equation. 
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Net Heat of Combustion 
The amount of energy released (Joules per gram) when the material is 
burned. 

 

Flash Point Temperature 
The lowest temperature (degrees Kelvin) at which the vapor in air can be 
made to ignite momentarily. 

 

Upper Flammability Limit 
The highest concentration (percent) at which the vapor will burn. 

398



Using The CHARM Editor   

 

54

 

Lower Flammability Limit 
The lowest concentration (percent) at which the vapor will burn. 

 

Auto-Ignition Temperature 
The lowest temperature (Kelvin) at which the vapor in air can be made to 
ignite and burn. 

 

Free Energy of Formation at 25°C 
The amount of energy (kilocalories per mole) required to bring together 
the individual atoms in the molecule. 
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Flame Speed 
The speed (Mach) at which the flame will spread if a vapor cloud of the 
material is ignited.  If the speed is greater than Mach 1, it is assumed to 
be a detonation.  If the speed is less than Mach 1, it is assumed to be a 
deflagration. 

 

Below is a table of flame speeds from Quentin A. Baker, Ming Jun Tang, 
Ephraim Scheier, and Gustavo J. Silva, Vapor Cloud Explosion Analysis, 
Process Safety Progress, Vol. 15, No. 2, Summer 1996. 

Type of Flame 
Expansion 

Mixture 
Reactivity 

 Obstacle 
Density 

 

  High Medium Low 

 High 5.2 5.2 5.2 

1-D Medium 2.265 1.765 1.029 

 Low 2.265 1.029 0.294 

 High 1.765 1.029 0.588 

2-D Medium 1.235 0.662 0.118 

 Low 0.662 0.471 0.079 
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 High 0.588 0.153 0.071 

3-D Medium 0.206 0.100 0.037 

 Low 0.147 0.100 0.037 

Table Explanation 

Type of Flame Expansion refers to the geometry associated with the 
propagating (expanding) flame front.  Propagation of the flame front in a 
long pipe corresponds to 1-D.   

Propagation of the flame front between two flat plates corresponds to 2-
D.  Propagation of the flame front in three dimensions corresponds to 3-
D.  Note: Multi-deck, open framework structures should be treated as 2-
D. 

Reactivity is classified as low, average (medium), or high according to the 
recommendations of TNO (Methods for the Calculation of Physical Effects 
Resulting from Releases of Hazardous Materials (Liquids and Gases), 
CPR 14E, Second Edition 1992.)  Ammonia, carbon monoxide, methane, 
and natural gas are the only materials regarded as having low reactivity.  
Hydrogen, acetylene, ethylene, ethylene oxide, and propylene oxide are 
considered highly reactive.  All other fuels (ethane, propane, propylene, 
butane, isobutane, etc.) are classified as average (medium) reactivity. 

Obstacle Density refers to the presence of obstacles that may enhance 
flame propagation.  Low obstacle density is applicable when there are few 
obstacles in the flames path, or the obstacles are widely spaced (blockage 
ratio [see below] < 10 %) and only 1 or 2 layers of obstacles are present.  
High obstacle density is applicable when there are 3 or more fairly 
closely-spaced layers of obstacles with a blockage ratio of > 40 % per 
layer (e.g., closely-spaced structural members, pipes, valves, and pipe 
racks). Medium obstacle density is that which falls between the low and 
high categories. 

This table assumes that the vapor cloud explosion is initiated from soft 
ignition sources.  Soft ignition sources include open flames, spark, or hot 
surfaces (i.e., sources that do not significantly affect the flame speed).  
The above table would not apply to ignition of highly turbulent jets or to 
high energy ignition sources (i.e., high explosives); the maximum flame 
speed (Mach number 5.2) should be assumed for these situations. 

Blockage ratio is defined as the ratio of the are blocked by obstacles to 
the total cross-sectional area. 
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Explosion Efficiency 
The fraction of material actually consumed if a vapor cloud is ignited.  
The explosion efficiency is normally about 0.10. 

 

Flame Temperature 
The temperature (Kelvin) at which the flame will burn when a vapor 
cloud is ignited.  Typical values are 2000°K to 2500°K. 

 

Number of Carbon Atoms 
This is the number of carbon atoms in a single molecule of the species. If 
-1 is entered, CHARM ignores this material as being flammable for liquid 
pool fires.  

 

Number of Hydrogen Atoms 
The number of hydrogen atoms in a single molecule of the species. 
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Number of Oxygen Atoms 
The number of oxygen atoms in a single molecule of the species. 

 

Number of Halogen Atoms 
The number of halogen atoms in a single molecule of the species. 

 

Halogen Atoms Being Chlorine 
This field indicates whether the halogen atoms are chlorine.  If the 
halogen atoms are chlorine, an emission rate of phosgene gas will be 
calculated for the burn.  The phosgene emission rate and concentration 
are reported in the Source/Puff Calculation display. These values can be 
used in a separate run. 
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Editing the Chemical Database 
Use the Chemical Database command on the Edit menu of the 
CHARMED window to edit the chemical database.  You can add a 
chemical and its data, change a chemical name, modify the chemical 
data, or logically/physically delete a chemical.  You can also edit the 
Emergency Response Text for the selected chemical.  On-line help is 
available for each CHARMED window and input field to guide you 
through entering the appropriate information. 

Adding a Chemical to the Database 
Use the Add command button in the Chemical Selection window to add 
new chemicals to the database.   

To add a chemical species: 

1. Run the CHARM editor by selecting the CHARMED icon from the 
CHARM group or by executing the CHARMED.EXE file from the 
Windows Explorer or My Computer on the desktop.  The CHARMED 
window is displayed. 

2. Select the Chemical Database command on the Edit menu.  The 
Chemical Selection window is displayed. 

3. Select the Add command button.  A dialog box requesting the name 
of the chemical is displayed. 

 

4. Type the name of the chemical to add and select OK or press 
<Enter>.  The Chemical Editor window is displayed. 
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5. Enter the requested data for the chemical. 

To do this, place the highlight bar over the desired field, and double-
click the mouse or press <Enter>.  Then type the appropriate value in 
the dialog box, and select OK or press <Enter> to close the dialog 
box. 

6. Select Save and then Close from the File menu to save the addition.  
The Chemical Selection window is again displayed. 

Changing a Chemical Name 
Use the Change Name command button in the Chemical Selection 
window to change the name of a chemical species in the database.  The 
dialog box for changing a chemical name is the same as the dialog box 
for adding a new chemical. 

To change the name of a chemical: 

1. Run the CHARM editor by selecting the CHARMED icon from the 
CHARM group or by executing the CHARMED.EXE file from the 
Windows Explorer or My Computer on the desktop.  The CHARMED 
window is displayed. 

2. Select the Chemical Database command on the Edit menu.  The 
Chemical Selection window is displayed. 

3. Place the highlight bar over the name of the chemical in the list to 
change.  You can use the scroll or search function to locate the 
chemical name. 

4. Select the Change Name command button.  A dialog box requesting 
the new name is displayed. 

 

5. Type the new chemical name, and select OK or press <Enter>.  The 
Chemical Selection window is again displayed. 

Modifying Chemical Data 
Use the Modify command button in the Chemical Selection window to 
modify chemical data and emergency response text stored in the 
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database.  The chemical data window is shown in Figures 4.4,  4.5, and 
4.6 earlier in this chapter. 

To modify the data for a chemical: 

1. Run the CHARM editor by selecting the CHARMED icon from the 
CHARM group or by executing the CHARMED.EXE file from the 
Windows Explorer or My Computer on the desktop.  The CHARMED 
window is displayed. 

2. Select the Chemical Database command on the Edit menu.  The 
Chemical Selection window is displayed. 

3. Place the highlight bar over the name of the chemical in the list.  You 
can use the scroll or search function to locate the chemical name. 

4. Double-click the left mouse button or select the Modify command 
button.  The Chemical Editor window is displayed with data for the 
selected chemical. 

5. Move the highlight bar over the field you want to modify and select it.  
A dialog box showing the current value is displayed. 

6. Change the value in the dialog box.   

7. Select OK or press <Enter> to close the dialog box. 

8. If you want to edit the emergency response information for a 
chemical, select the Emergency Response Text command from the 
File menu while the chemical data are displayed.  The text editor 
window is displayed and you can change the text. Select Save and 
Close from the File menu to return to the Chemical Editor window. 

9. Select Save and Close from the File menu of the Chemical Editor 
window to save the changes.  The Chemical Selection window is 
displayed. 

Modifying Emergency Response Text 
Use the Emergency Response Text command on the File menu of the 
Chemical Editor window to display the text editor window.  Emergency 
response text is provided for each chemical species in the database.  You 
can add, delete, or modify this information using the text editor. 
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The text editor is similar to the Windows Notepad.  Use the Print 
command from the File menu to print all the text in a window.  To return 
to the Chemical Editor window, select the Save and Close commands 
from the File Menu.  Use the Edit menu to undo the most recent action, 
cut and paste text, clear selected text, and select all text in the file.  
Unlike other windows in the application, the File menu has no New, 
Open, or Save commands, because the file being edited is known and 
specific to CHARM. 

The Emergency Response Text command and the Site Information 
command use the same text editor.  However, the methods for saving 
emergency response text and site information text are different.  If you 
use the Save command on the File menu of the Emergency Response 
Text window, the text changes are flagged.  The changes are not saved 
until you select the Exit command on the File menu of the Chemical 
Editor window. 

To edit the Emergency Response Text: 

1. Run the CHARM editor by selecting the CHARMED.EXE file.  The 
CHARMED window is displayed. 

2. Select the Chemical Database command on the Edit menu of the 
CHARMED window. 

3. Place the highlight bar over the name of the chemical whose 
information you want to change.  You can use the scroll or search 

407



Using The CHARM Editor   

 

63

function to locate the chemical name. 

4. Select the Modify command button.  The Chemical Editor window is 
displayed. 

5. Select Emergency Response Text from the File menu.  The text editor 
window is displayed. 

6. Modify the Emergency Response Text as needed.   You can enter a 
maximum of 32,000 characters of information.  

7. Select Save and Close from the File menu of the text editor window. 

8.  Select Save and Close from the File menu of the Chemical Editor to 
save the changes.  The Chemical Selection window is displayed. 

Deleting a Chemical 
Use the Delete command button on the Chemical Selection window to 
logically delete a chemical.  Deleting a chemical does not actually remove 
the data from the database; it simply flags the data in the database and 
does not display the chemical name in CHARM selection lists.  To 
physically remove the data from the database, delete the chemical and 
then run the Pack Database command. 

To delete a chemical: 

1. Run the CHARM editor by selecting the CHARMED.EXE file.  The 
CHARMED window is displayed. 

2. Select the Chemical Database command on the Edit menu of the 
CHARMED window.  The Chemical Selection window is displayed. 

3. Place the highlight bar over the chemical name in the list and select 
the name.  You can use the scroll or search function to locate the 
chemical name. 

4. Select the Delete button.  CHARM will prompt the user to verify 
deletion of the desired chemical. 

 

If you inadvertently delete a chemical from the database with the 
Delete command button, you can retrieve the data by adding the 
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chemical.  Use the Add command button in the Chemical Selection 
window and enter the chemical name.  CHARMED displays the chemical 
data for that chemical as they appeared before the delete operation.  In 
fact, any chemical that was logically deleted using the Delete button from 
the Chemical Selection window can be retrieved simply by adding 
chemicals back into the database.  The rule that CHARM follows is 
simply this:  The last chemical that was logically deleted from the 
Chemical Selection window is the data which is used as the default data 
when a chemical is added. 

Packing the Chemical Database 
Packing the chemical database actually removes from the database all 
records that have been previously deleted.  Figure 4.6 shows the 
confirmation window for packing the chemical database. 

To pack the database: 

1. Run the CHARM editor by selecting the CHARMED icon from the 
CHARM group or by executing the CHARMED.EXE file from the 
Windows Explorer or My Computer on the desktop.  The CHARMED 
window is displayed. 

2. Select the Pack Chemical Database command on the Edit menu of 
the CHARMED window.  CHARMED displays a dialog box that asks 
you to confirm the deletion. 

 

3. To confirm the deletion, select the Yes command button or press 
<Enter>.  All deleted records are removed from the database and the 
CHARMED window is displayed. 

To cancel the deletion, select the No command button.  No changes 
are made to the database and the CHARMED window is displayed. 

Entering Site Information 
Use the Site Information command on the Edit menu of the CHARMED 
window to enter and edit site-specific information such as names and 
telephone numbers.  This information can be displayed while you are 
running CHARM.  Figure 4.8 shows an example of a site information 
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text editor window. 

 

The Site Information command and the Emergency Response Text 
command use the same text editor.  However, the method by which the 
information is saved is different.  Site information is saved when you 
select Save and Close from the File menu of the text editor window.  If 
you select Exit from the File menu after making changes to the text, 
CHARMED will prompt you to save the changes, and then proceed to exit 
the CHARM Editor.  Conversely, emergency response text is not saved 
until you select Save and Close from the Chemical Editor Window (See 
‘Modifying Emergency Response Text’ previously mentioned in this 
Chapter). 

The text editor is similar to the Windows Notepad.  Use the File menu to 
print all the text in a window, save changes to the text, or close the 
window.  Use the Edit menu to Undo the most recent action, or Copy, 
Cut and Paste text in the file.  Unlike Windows, the File menu has no 
New, Open, or Save commands, because the file being edited is known 
and specific to CHARM. 

When you are running the CHARM program, you can display site 
information for the current release by selecting the Site Information 
command on the Displays menu of the Main CHARM Input Window, or 
any subsequent footprint display. 

To enter site information: 

1. Run the CHARM editor by selecting the CHARMED icon from the 
CHARM group or by executing the CHARMED.EXE file from the 
Windows Explorer or My Computer on the desktop.  The CHARMED 
window is displayed. 

2. Select the Site Information command on the Edit menu of the 
CHARMED window.  The text editor window is displayed. 

Figure 4.8 
Site 
Information 
Editor 
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3. Enter up to 32,000 characters of site-specific information. 

4. Select Save and Close from the File menu in the text editor to save 
the site information.  The CHARMED window is displayed. 

Setting the Communication Parameters 
Use the Communications Parameters command on the Edit menu of the 
CHARMED window to define the communications port, the polling 
interval, and other configuration items for communication with a 
meteorological tower.  This editor is only useful if the CHARM 
meteorological interface program (supplied by Radian) is on the 
computer.  The meteorological  interface program (METINTER.EXE) 
provides the tower-specific interface to CHARM.  Figure 4.9 shows the 
Communications Parameters Editor window. 

 

 

The communications parameters consist of defining and configuring the 
Automatic Met Interface Port, specifying the Met Polling Interval, saving 
Data Daily, and defining station connectivity.  The choices for 
communication ports are COM1, COM2, COM3, and COM4.  One of 
these specifies connection with the meteorological tower.  Accurate port 
specification is required for proper information exchange. Select the Port 
Configuration button to specify additional information, including the 
baud rate, data bits, parity, stop bits, and flow control type for the 
selected communication port. 

Figure 4.9 
Communica-
tions 
Parameters 
Editor 
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The Met Polling Interval defines the frequency with which meteorological 
tower communications take place.  The time interval should be the same 
as the averaging time interval for the data. 

To set the parameters for communication with a meteorological tower: 

1. Run the CHARM editor by selecting the CHARMED icon from the 
CHARM group or by executing the CHARMED.EXE file from the 
Windows Explorer or My Computer on the desktop.  The CHARMED 
window is displayed. 

2. Select the Local Met Comm Parameters command on the Edit menu 
of the CHARMED window.  The text editor window is displayed. 

3. Specify the communications port (COM1, COM2, COM3, or COM4) to 
use. 

4. Select the Port Configuration button to specify additional port 
configuration information.  Select OK or press <Enter>. 

5. Enter the interval for polling the met tower in minutes. 

6. Check the Save Data Daily checkbox if you want CHARM to archive 
meteorological data from your data logger on a daily basis into a file 
which timestamped with a Julian date.  [NOTE: This feature is strictly 
for archival purposes.  CHARM cannot read these files back into the 
model as a source for meteorological data input.  This feature is simply 
an add-on feature as some data loggers are not capable of archiving 
data.] 

7. Select OK or press <Enter>.  The CHARMED window is displayed. 

Defining Station ID’s 
Select the Station ID button to define multiple station names and means 
of communication (i.e. direct connection with the PC or remote 
connection via modem).  Input up to 30 characters describing a 
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meteorological station to be used by CHARM to acquire real-time met 
data.  Also, type in a phone number that will be used to access the met 
tower remotely if communications between the PC and the datalogger are 
to be connected via dial-up modems.  The phone number is optional.  If 
no phone number is specified, CHARM will assume direct connection 
between the PC and the data logger. 

 

Adding a Station ID 
Upon entering the Station ID and Phone Number (optional), press the 
Add button to enter the Station ID/Phone Number input into the list of 
possible stations.  Currently, the user may define up to 100 stations. 

Deleting a Station ID 
Select the Delete button to delete the highlighted Station ID from the list 
of possible stations.  All associated sites and their information will also 
be deleted.  Select the Delete All button to delete all Station IDs and 
associated Phone Numbers in the list of possible stations.  Again, all 
associated sites and their information will also be deleted. 

Modifying a Station ID 
Select the Change button to change the highlighted Station ID character 
name or associated phone number.  The highlighted information will be 
placed in the Station ID and Phone Number input boxes.  Make the 
appropriate changes and then select the Save Change button.  The 
changes will be reflected in the list of stations. 

Site ID 
Select the Site ID button to define multiple site names associated with 
the highlighted station. 

Defining Site ID’s 
Input up to 30 characters describing a site associated with the 
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specified station. 

 

Adding a Site ID 
Upon entering the Site ID, select Add to enter the Site ID input into the 
list of possible sites.  Currently, the user may define up to 100 sites. 

Deleting a Site ID 
Select the Delete button to delete the highlighted Site ID from the list of 
possible sites.  All associated site information will also be deleted.  Select 
the Delete All button to delete all Site IDs and associated site information 
from the list of possible sites. 

Modifying a Site ID 
Select the Change button to change the highlighted Site ID character 
name.  The highlighted information will be placed in the Site ID input 
boxes.  Make the appropriate changes and then select Save Change.  The 
changes will be reflected in the list of possible sites. 

Specifying Site Information 
Select the Site Information button to display the Cartesian coordinates 
(x,y,z) and some default parameters associated with the highlighted site. 

Defining Site Information 
Define default parameters specific to a site. 
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Defining Site Coordinates 
Input the site location in Cartesian coordinates (x,y,z) and the associated 
units.  Accurate site location relative to the source will ensure proper met 
conditions will be utilized correctly in CHARM. 

Defining Relative Humidity 
Enter the default ambient relative humidity in percent.  Acceptable 
values are greater than 0 and less than 99.  If relative humidity is not 
available to CHARM real-time, CHARM will use this value as the default. 

Defining Ambient Pressure 
Enter the default ambient atmospheric pressure at ground level.  The 
pressure can be entered in atmospheres, pounds/square inch, inches of 
Mercury, millimeters of Mercury, or millibars.  If pressure is not available 
to CHARM real-time, CHARM will use this value as the default. 

Normal atmospheric pressure at sea level has the following equivalents: 

• 1 atmosphere (atm) 
• 14.7 pounds/square inch (psi) 
• 1013.25 millibars (mb) 
• 29.92 inches of Mercury (in Hg) 
• 760 millimeters of Mercury (mm Hg) 

Defining Surface Roughness 
Surface roughness is a measure of the interaction between the wind and 
surface.  It affects wind speed with altitude and thus the amount of 
mixing that can occur.  The units are inches, feet, centimeters, or 
meters.  If the field is left blank, no surface roughness is assumed and 
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the wind is assumed constant with height.  See “Surface Roughness” in 
Chapter 5 “The Main CHARM Input Window” for some examples of 
surface roughness. 

Defining Maps for Use With CHARM 
Use the Map Definition command on the Edit menu of the CHARMED 
window to read a map from the clipboard or a file.  After the map is 
displayed, you must define a scale and location with respect to some 
point of origin.  You can also define release locations and map locations.  
You can define an area to zoom or unzoom, and name a larger-scaled 
map that will replace the current map in CHARM.  You can also 
associate textual information to, perhaps, indicate when the map was 
created, evacuation routes, etc. 

All maps used in CHARM are assumed to be created outside of 
CHARMED but accessible by CHARMED.  The map definition editor can 
read maps from the clipboard, from Windows metafiles, Tagged 
Information File Format (TIFF} files, device independent bitmap (DIB) 
files, or from previously edited and stored files. 

Improved internet browsing and downloading allows you to examine and 
extract map files directly from the internet.  In many cases, you can 
simply download a file into a form that CHARM can read directly.  In 
other instances, however, you may have to read the file into third-party 
software, copy the map to the clipboard, and then paste the image into 
the Map Definition Editor. 

Reading Maps From the Clipboard 
The Map Definition command can be used with other Windows programs 
that create metafiles, picture files, or bitmaps and place them on the 
clipboard.  For example, MicroGrafx Draw Plus, MicroGrafx Designer, 
and Microsoft Windows Paint programs can generate maps for use with 
CHARM.  AutoCAD's DXF (drawing interchange) file formats can be read 
into a program such as Designer® or Hijaak®, copied to the clipboard, 
and then read into the CHARM map editor.  Refer to the Microsoft 
Windows user's guide for details on sending a drawing to the clipboard. 

When a map has been created and placed on the clipboard, it can be 
accessed and displayed by the Map Definition Editor.  Simply use the 
Paste command from the Edit menu and the map will be displayed. 

Reading Maps From Files 
The Map Definition command can also read previously stored files.  For 
example, the map editor can read files stored in the Micrografx Draw 
Plus or PageMaker format directly instead of reading them through the 
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clipboard.  These files must have the Windows metafile, TIFF, or windows 
bitmap format.  Maps that have been edited and saved in CHARMED can 
also be read again. 

To read a file into the Map Definition Editor, use the Open command on 
the File menu and select the name of the file to display.  The Open 
command works the same in CHARM as in other Windows applications. 

Caution:  When you edit a metafile or TIFF file, be sure to rename the 
edited version when saving the map or the original file will be overwritten.  
Map information, such as scaling and map location, requires CHARM to 
use a different file format. 

The Map Definition Command 
Use the Map Definition command to edit maps for use in CHARM.  After 
a map has been displayed in the Map Definition Editor either by opening 
a file or pasting an image in from the clipboard, you must perform a 
minimum of two operations before the map can be used from within 
CHARM proper.  Select the Define Point command or the Define Scale 
command from the Define menu.  It is irrelevant which operation is 
performed first, but a point of reference and scale must be defined to 
ensure that a footprint is overlayed properly on the map when displayed 
in CHARM proper.  Other options include defining detailed map and 
release location icons, associating textual information with the map, and 
associating an expanded map to use with the Auto Map Change and 
Larger Scale Map options in CHARM.  The map must be saved for recall 
when running CHARM  

While a map is displayed, you can move the cursor with the mouse or the 
keyboard.  To scroll the map, use the mouse and the scroll bars or use 
<Page Up>, <Page Down>, and the arrow keys.  The keys are used to 
move the map until an option from the Define menu is selected.  After a 
define option is selected, the keys move the cursor. 

Figure 4.8 shows a sample map display.  The sample shows three map 
location icons,  

 

which can be selected to display a smaller scaled, or more detailed, 
version of the map area.  Likewise, the sample illustrates three possible 
release sites with release locations icons 
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. 

 

 

The Define Menu 
Use the Define menu in the Map Definition window to define a point and 
scale.  After the Map Definition Editor displays a map from the clipboard 
or a file, you must define a point location and a map scale.  The point 
and scale together identify the point of origin.  The origin should be the 
same for all maps that you intend to use with the Zoom or Automap 
functions.  You can also use the Define menu to define zoom area, 
detailed map location, release location, map description, default size, 
and/or an expanded map name. 

Using the Zoom Command 
Use the Zoom command on the Define menu to define an area (zoom box) 
on the displayed map for enlargement.  Notice that the cursor is 
transformed to a magnifying glass.  The size of the zoom box determines 
the degree of zoom.  The upper left corner of the box is used to determine 
the region that will be displayed.  There may not be a one-to-one 
correspondence between the box and the displayed zoom area since the 
x,y aspect is maintained.  To return a zoomed map to its original size 
when the window was opened, use the Unzoom command on the Define 
menu. 

After you decide on the area to zoom in on, follow these steps: 

1. Run the CHARM editor by selecting the CHARMED icon from the 
CHARM group or by executing the CHARMED.EXE file from the 
Windows Explorer or My Computer on the desktop.  The 

Figure 4.8 
Map Definition
Editor 
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CHARMED window is displayed. 

2. Select the Map Definition command on the Edit menu of the 
CHARMED window.  The map editor window is displayed.   

Use the Open command on the File menu or use the Paste command 
on the Edit menu to select and display a map. 

3. While the map is displayed, select the Zoom command on the Define 
menu. 

4. Move the cursor to the location of one corner of the area to be 
zoomed.  This location represents one corner of the zoom box. 

5. Define the zoom box by creating a rubberband box around the 
intended area to zoom.  This can be done by using the mouse, or by 
using keyboard strokes. 

If you are using a mouse, hold the left mouse button down, drag the 
cursor to the opposite corner of the box, and release the button.   

If you are not using a mouse, press <Enter> to define the first corner 
of the zoom box.  Next, use the arrow keys to draw the zoom box, and 
press <Enter> again to complete the drawing. 

To return the map to its initial size when the window was opened, select 
the Unzoom command on the Define menu. 

Defining a Point 
Use the Define Point command on the Define menu to define a point of 
reference for a map.  Notice that the cursor is transformed to an axial 
representation of a 3D coordinate system.  You must define a point and 
scale for each map you use.  To ensure proper placement of the plume on 
the map, the origin should be the same for all related maps.  You can 
redefine the point location by repeating the steps for defining a point. 

Defining a point involves identifying the location for the point on the 
displayed map and specifying the X and Y coordinates for the point.  

Use the following steps to define a point: 

1. Run the CHARM editor by selecting the CHARMED icon from the 
CHARM group or by executing the CHARMED.EXE file from the 
Windows Explorer or My Computer on the desktop.  The CHARMED 
window is displayed. 

2. Select the Map Definition command on the Edit menu of the 
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CHARMED window.  The Map Definition window is displayed.   

Use the Open command on the File menu or use the Paste command 
on the Edit menu to select and display a map. 

3. While a map is displayed, select the Define Point command on the 
Define menu. 

4. Move the cursor to the location for the point on the map. 

If you are using a mouse, click the left button to identify the point 
location. 

If you are not using a mouse, press <Enter> to identify the point 
location.   CHARMED prompts the user for the point of reference. 

 

5. Enter the X and Y coordinates for the point in the dialog box.  The 
units are feet, miles, kilometers, or meters.  A positive (+) X number 
is East of the origin and a negative (-) X number is West.  A positive Y 
number is North of the origin and a negative Y number is South. 

6. Select the OK command button or press <Enter>. 

Defining a Scale 
Use the Define Scale command on the Define menu to define a map 
scale.  Notice that the cursor is transformed into a scale pointer.  
CHARM uses this scale to automatically expand or contract the map 
when a plume is displayed.  You must define a point and scale for each 
map you use.  You should use the measurement between two known 
points, which are preferably as far apart as possible. 

A scale definition involves drawing a line on the displayed map and 
specifying the length of the line.  After the line is drawn, CHARMED 
prompts the user to specify the line length. 
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Use the following steps to define a scale: 

1. Run the CHARM editor by selecting the CHARMED icon from the 
CHARM group or by executing the CHARMED.EXE file from the 
Windows Explorer or My Computer on the desktop.  The CHARMED 
window is displayed. 

2. Select the Map Definition command on the Edit menu of the 
CHARMED window.  The Map Definition window is displayed.   

Use the Open command on the File menu or use the Paste command 
on the Edit menu to select and display a map. 

3. While a map is displayed, select the Define Scale command on the 
Define menu. 

4. Draw a line between two points on the map. 

To draw the line with a mouse, move the cursor to the beginning 
point for the line.  Press and hold the left mouse button,  drag the 
cursor to the end point of the line, and then release the button.   

To draw the line with the keyboard, move the cursor to the beginning 
point for the line.  Press <Enter> to mark the beginning point of the 
line, extend the line with the arrow keys, and press <Enter> again to 
mark the end point of the line.   CHARMED prompts the user for the 
length of the line. 

NOTE: Bitmaps only allow a horizontal line to be drawn.  Vector maps 
allows the user to draw the line at any angle. 

 

5. Enter the length of the line in the dialog box.  The units are feet, 
miles, kilometers, or meters.  Alternatively, if latitude/longitude 
coordinates are known at the line endpoints, you may enter those 
coordinates by selecting the Lat/Long button. 
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6. Select the OK command button or press <Enter>.  CHARMED returns 
to the Scale Length dialog box.  Select the OK command button or 
press <Enter>.  CHARMED returns to the Map Definition window. 

Defining a Map Location 
Use the Define a Map Location command to define and edit the location 
of an icon that represents another map.  The icon looks like boxes within 
boxes on the map. 

 

Notice that the cursor is transformed to a representation of this icon.  
The map is a smaller-scaled map to be used with the zoom feature in 
CHARM.  Defining a map location involves positioning the icon on the 
map and specifying the name of the map to be displayed when the icon is 
selected in CHARM. 

Use the following steps to define a map location: 

1. Run the CHARM editor by selecting the CHARMED icon from the 
CHARM group or by executing the CHARMED.EXE file from the 
Windows Explorer or My Computer on the desktop.  The CHARMED 
window is displayed. 

2. Select the Map Definition command on the Edit menu of the 
CHARMED window.  The Map Definition window is displayed.   

Paste an image from Windows clipboard, or use the Open command 
on the File menu to select and display a map. 

3. While a map is displayed, select the Define Map Location command 
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on the Define menu. 

4. Move the cursor to the point at which you want to place the icon on 
the displayed map.   

If you are using a mouse, press the left or right mouse button to 
locate the icon.  If you are not using a mouse, press <Enter> to locate 
the icon.  CHARMED prompts the user for complete path and file 
name of the associated map file. 

 

5. In the dialog box, enter the file name for the map that is represented 
by the icon.  Include the full path name, including the drive, so that 
the file can be located  anywhere in the system.  Alternative, use the 
Browse button to scan and select the desired map file.   

6. Select the OK command button or press <Enter>.  CHARMED returns 
to the Map Definition window. 

Defining a Release Location 
Use the Define Release Location command on the Define menu define 
and edit the location of an icon that represents the location of one or 
more release scenarios.  The icon looks like a plume within a box. 

 

The release scenarios must be created and stored in CHARM using the 
Main CHARM Input Window.  Defining a release location involves 
positioning the icon and specifying the scenarios whose titles will be 
displayed when the icon is selected in CHARM. 

To define a release location, use the following steps: 

1. Run the CHARM editor by selecting the CHARMED icon from the 
CHARM group or by executing the CHARMED.EXE file from the 
Windows Explorer or My Computer on the desktop.  The CHARMED 
window is displayed. 
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2. Select the Map Definition command on the Edit menu of the 
CHARMED window.  The Map Definition window is displayed.   

Paste an image from Windows clipboard, or use the Open command 
on the File menu to select and display a map. 

3. While a map is displayed, select the Define Map Location command 
on the Define menu. 

4. Move the cursor to the point at which you want to place the icon.   

If you are using a mouse, press the left or right mouse button to 
locate the icon.   

If you are not using a mouse, press <Enter> to locate the icon.  

 

5. In the dialog box, enter the file name(s) for the release  represented 
by the icon.  Include the full path name, so that the file can be 
located anywhere in the system.  If you want to specify more than one 
release, separate the file names by commas.  The Browse button may 
be used to examine and select files currently stored on your system.  
DOS wildcards can be used in file names. 

6. Select the OK command button or press <Enter>. 

Once a map or release location is defined, you can edit the file 
information for an icon, reposition an icon, or delete an icon.   

Map Description 
Use the Map Description command on the Define menu and CHARMED 
displays a text window from which the user may describe pertinent 
information associated with a map.  For example, the user may identify 
the sensitive receptors that exist beyond the fenceline.  The description 
may be viewed from CHARM when the map is displayed.   

The Map Description command, Emergency Response Text command, 
and Site Information command all use the same text editor.  However, 
the method by which the information is saved is different.  Site 
information and Map Definition information is saved when you select 
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Save and Close from the File menu of the text editor window.  If you 
select Exit from the File menu after making changes to the text, 
CHARMED will prompt you to save the changes, and then proceed to exit 
the CHARM Editor.  Conversely, even though you may have saved Map 
Description text, the Map Description text is not really saved until you 
select Save and Close from the Map Definition Window. 

To use the Map Description command, use the following steps: 

1. Run the CHARM editor by selecting the CHARMED icon from the 
CHARM group or by executing the CHARMED.EXE file from the 
Windows Explorer or My Computer on the desktop.  The CHARMED 
window is displayed. 

2. Select the Map Definition command on the Edit menu of the 
CHARMED window.  The Map Definition window is displayed.   

Paste an image from Windows clipboard, or use the Open command 
on the File menu to select and display a map. 

3. While a map is displayed, select the Map Description command on 
the Define menu.  The following window is displayed. 

 

4. In the Map Description text window, input or modify text that is 
pertinent to information associated with the map.  Use selections 
from the Edit menu to copy, cut, or paste information from other 
Window’s applications. 

5. Select Save and Close from the File menu of the text editor window to 
save the information.  Selecting Exit from the file menu closes 
CHARMED. 

Editing Icon File Information 
The file information for an existing map or release icon can be edited.  If 
you are using a mouse, move the cursor over the icon and double-click 
the left mouse button.  If you are using the keyboard, select the Define 
Map Location or Define Release Location command to allow the cursor 
to move the desired icon.  Then, position the cursor over the icon and 
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press <Enter> (or click the left mouse button).  A dialog box containing 
the current file information is displayed.  Make the necessary changes 
and select OK or press <Enter>. 

Use the following steps to edit the file information for a map or release 
location icon: 

1. Run the CHARM editor by selecting the CHARMED icon from the 
CHARM group or by executing the CHARMED.EXE file from the 
Windows Explorer or My Computer on the desktop.  The CHARMED 
window is displayed. 

2. Select the Map Definition command on the Edit menu of the 
CHARMED window.  The map editor window is displayed.   

Use the Open command on the File menu to select and display a 
map. 

3. Using the mouse, you can move the cursor over the icon and double-
click the left mouse button; or, select the desired type of icon to edit 
from the Define menu, move the cursor over the desired icon and 
click the left mouse button. 

If you are using the keyboard, you must select the Define Map 
Location or Define Release Location command on the Define menu 
before you can move the cursor over the icon.  When the cursor is 
over the icon, press <Enter> to select it. 

A dialog box containing the file information is displayed. 

4. Edit the file information and select OK or press <Enter>. 

Repositioning an Icon 
You can relocate an existing map or release icon.  If you are using a 
mouse, move the cursor over the icon, hold the left mouse button down, 
drag the mouse to reposition the icon, and release the left mouse button.  
If you are using only the keyboard, you cannot simply move the icon.  
You must delete the icon and then redefine the icon using the Define 
Map Location or Define Release Location commands. 

Use the following steps to relocate a map or release location icon: 

1. Run the CHARM editor by selecting the CHARMED icon from the 
CHARM group or by executing the CHARMED.EXE file from the 
Windows Explorer or My Computer on the desktop.  The 
CHARMED window is displayed. 
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2. Select the Map Definition command on the Edit menu of the 
CHARMED window.  The map editor window is displayed.   

Use the Open command on the File menu to select and display a 
map. 

3. To move the icon with the mouse, position the cursor over the desired 
icon, press the left mouse button and reposition the icon by dragging 
it.  Then, release the mouse button. 

Deleting an Icon 
To delete an icon, move the cursor over the icon and press the Delete 
key.  Select Yes in the dialog box to confirm the deletion. 

Use the following steps to delete a map or release location icon: 

1. While the map containing the icon is displayed, move the cursor over 
the icon and press <Delete>.  CHARMED will verify the deletion. 

 

2. Select Yes in the dialog box or press <Enter> to confirm the deletion. 

Naming an Expand Map 
Use the Expand Map Name command on the Define menu to specify the 
name of a larger-scaled map than the one being defined.  Figure 4.9 
shows the window in which to enter the map name.  The specified map is 
displayed automatically by CHARM if the Auto Map Scale option is 
checked and the currently displayed map covers a percentage of the 
footprint display area which is less than the percentage defined by the 
Auto Map Fraction.  The rectangular area used for comparison is the 
area in which the viewport circle is inscribed.  If the current map covers 
less than the Auto Map Fraction of the rectangular area, CHARM will 
attempt to display a larger scaled map, if one has been defined.  The 
value must be between 0.05 and 0.95.  The default is 0.25. 

The Auto Map Scale and Auto Map Fraction options are on the Options 
menu of a Plan Display window in CHARM proper. 

Figure 4.9 
Expand Map 
Window 
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To name an expanded map: 

1. Run the CHARM editor by selecting the CHARMED icon from the 
CHARM group or by executing the CHARMED.EXE file from the 
Windows Explorer or My Computer on the desktop.  The CHARMED 
window is displayed. 

2. Select the Map Definition command on the Edit menu of the 
CHARMED window.  The Map Definition window is displayed.   

Paste an image from Windows clipboard, or use the Open command 
on the File menu to select and display a map. 

3. Select the Define Expand Map Name on the Define menu. 

4. Enter the full path name for the expanded map, or use the Browse 
button to display files on your disk for selection. 

5. Select OK or press <Enter>.  The map editor window is displayed. 

Saving a Map Definition 
Once you edit a map with the map definition editor, you must store it as 
a file for later retrieval.  To save a map definition, use the Save or Save 
As commands on the File menu.  The Save and Save As commands work 
the same in CHARM as in other Windows applications.   

You can enter a base name and allow CHARMED to assign the default 
extension.  CHARM uses specific extensions to identify files for selection 
list displays.  If you do not assign an extension to the file name, 
CHARMED automatically assigns the default .MAP extension to the base 
name.  When you save a map definition, another file is created with the 
same base name but with the .MFD extension.  This file contains the 
map definition information. 

Caution:  Since files with the .MFD extension contain the map definition 
information, this extension should not be used for other CHARM file 
names.  Also, a file with the .MFD extension must not be deleted, unless 
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its corresponding map is also deleted. 

If you want a base map to display automatically when the CHARM 
program is started, assign the file name BASEMAP.MAP (and the 
associated BASEMAP.MFD file ) to one of the maps you define.  This 
feature is especially useful for running CHARM in the emergency 
response mode.  When CHARM is started, if no file named 
BASEMAP.MAP is found, the main input window displays.   

For maps from the clipboard, you must assign a base name to the edited 
map.   For maps from files, you should assign a new and unique base 
name to the edited map.  If you use the same base name, the original file 
will be overwritten, thereby destroying the original metafile, TIFF, or 
bitmap file.   

Defining Population Files for Use With CHARM 

Use the Select Population Files command on the Edit menu of the 
CHARMED window to identify one or more population files which will be 
used to determine the approximate number of people impacted by a 
footprint.  The population file is created from Radian’s TIGERMAP Utility 
in the CHARM group. 

 

The program reads U.S. Census Bureau Tiger/Line(TM) 1992 data and 
creates maps and/or population files.  An icon for starting TIGERMAP is 
in the CHARM group box.  Tiger/Line(TM) 1992 data (available on CD-
ROM) is required before the population files can be created.  Contact the 
U.S. Census Bureau directly for ordering the data files needed.  Their 
number is (301) 457-4100. 

Multiple files can be entered.  If a full path name is given to a file, the 
subsequent files are assumed to be in the same subdirectory until the 
next full path name is given.  Wild cards may be used.  If no extension is 
given (including no ‘.’ at the end of the file name) on a file, then the 
default extension (normally .TPY) will be used.  If you want to select pre-
existing files press the Browse button.  A window allowing the multiple 
selection of files will appear.  Any files selected will be appended to the 
existing list. 

To define population files use the following steps: 
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1. Run the CHARM editor by selecting the CHARMED icon from the 
CHARM group or by executing the CHARMED.EXE file from the 
Windows Explorer or My Computer on the desktop.  The CHARMED 
window is displayed. 

2. Select the Select Population Files command on the Edit menu of the 
CHARMED window. 

3. In the dialog box, enter the file name(s) for those desired population 
files. 

Include the full path name, so that the file can be located anywhere 
in the system.  If you want to specify more than one release, separate 
the file names by commas.  The Browse button may be used to 
examine and select files currently stored on you system.  DOS 
wildcards can be used in the file names. 

4. Select the OK command button or press <Enter>. 

Inputting Data for Mixtures into the Chemical Database 

CHARM is capable of modeling only a single substance at a time, 
independent of whether the substance is pure or suspended in a 
mixture.  If a substance is a constituent within a mixture, there are three 
ways to model this from within CHARM. 

1) The best approach for handling a mixture is to add a new chemical to 
the CHARM Chemical Database which contains the bulk properties of the 
liquid and the bulk gas properties of the mixture.  The boiling point of 
the mixture is defined when the sum of all of the partial pressures of the 
constituents of the mixture equals one atmosphere.  For CHARM to 
report the concentration of the constituent of interest, set the Reported 
Fraction field to the molar fraction of the constituent in the mixture. For 
example, if 20% of the emission were species A and 40% species B, two 
chemicals could be added to the database.  All the parameters would be 
the same for the two species except the name and the Reported Fraction 
parameter.  For species A to be reported correctly this parameter should 
be 0.20. For species B it should be 0.40. Most species will define the 
Reported Fraction as 1.0.  If it is set to zero it is assumed to be 1.0. 

 

2) The next best approach is to add a new chemical to the CHARM 
Chemical Database that contains the bulk properties of the liquid and 
the gas properties of the species in equilibrium with the liquid mixture.  
The critical values, triple point values, and the boiling point should be 
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representative of the vapor pressure curve of the constituent of interest 
in equilibrium with the liquid mixture.  The Reported Fraction field 
should be set to 1.0. 

3) The last method for handling mixtures in a liquid release is to use the 
data for the pure species and the CHARM model.  Simply enter a 
"pseudo" pool diameter in the Pool/Lagoon release type by making the 
size of the pool proportionate to the percentage of constituent within the 
mixture.  Use the emission rate from that CHARM calculation (see 
Source/Puff Calculation Display in CHARM) as input in the User 
Specified After-Release type.  The puff diameter should be set to the 
actual pool size, not the pseudo pool size.  The molar fraction of the 
constituent of interest in the gas state in equilibrium with the pool 
mixture should be subtracted from 1.0 and the result entered in the 
molar air fraction field (i.e. all other constituents will be assumed to be 
air).  This method allows you to specify the initial concentration as well 
as the emission rate.
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Chapter 5:  The Main CHARM Input Window 

The Main CHARM Input Window provides the data that CHARM needs to 
simulate a chemical release.  When you initially run the CHARM.EXE 
program, the Main CHARM Input Window is displayed, unless there is a 
stored map file with the name BASEMAP.MAP.  In the planning mode, 
CHARM uses the input window to solicit release and meteorological data. 

If a map file has been defined using the CHARM Editor and stored with 
the BASEMAP.MAP name, the map is displayed when CHARM is started. 
The Main CHARM Input Window will still be present, but behind the Map 
Window.  It can be made active by selecting the Input Window from the 
Window menu. 

Note:  The purpose of the BASEMAP.MAP file is to save time when using 
CHARM in the emergency response mode as described in Chapter 7, 
"Using CHARM for Emergency Response." 

CHARM input consists of the release description in the top portion of 
the window and the meteorological data in the lower portion.  Figures 
5.1 and 5.2 show the release description portion of the window and 
Figure 5.3 shows the meteorological data portion. 
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Figure 5.1 
Main CHARM 
Input Window 
(top) 

Figure 5.2 
Main CHARM 
Input Window 
(middle) 

Figure 5.3 
Main CHARM 
Input Window 
(bottom) 
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The Main CHARM Input Window guides you through the data fields that 
describe the toxicity of the release and the conditions under which the 
chemical species will disperse.  Many of the input fields require an entry 
in order for CHARM to simulate the release.  CHARM provides default 
values for the input fields that you can accept or change.  If you leave a 
required field blank and try to close the dialog box, CHARM displays a 
message saying the field requires an entry.   

The release description fields that appear in the input window vary 
according to the selected species and release type.  Some of the fields in 
the input window contain default values.  CHARM uses the data entered 
in the input window to calculate and predict 1) the dispersion, 
concentration, and movement of the plume; 2) thermal radiation from a 
jet fire, liquid pool fire, or boiling liquid expanding vapor explosion 
(BLEVE); and/or 3) mechanical/explosion overpressures. 

Each release that is described in the input window and simulated in a 
CHARM run is called a scenario.  To create a scenario, CHARM 
determines the number of puffs in a release and the initial characteristics 
of each puff.  CHARM creates a variety of displays, such as the Snapshot 
Plan Plume View, based on the information entered in the input window.  
Whether you are using CHARM for emergency planning or emergency 
response, each scenario can be saved for later retrieval. 

Scrolling the Input Window 

To view the contents of the entire window, the CHARM input screen can 
be scrolled with a mouse or the keyboard.  To scroll with a mouse, use 
the vertical scroll bar to scroll up or down, and the horizontal scroll bar 
to scroll right or left.  With a mouse, you can scroll one line at a time, 
one window full of information, or to a relative location.  Refer to the 
Windows User's Guide for more details on scrolling with a mouse.  To 
scroll with the keyboard, move the inverse video bar to the next item off 
the screen, press an arrow key until the screen moves, or use <Page Up> 
and <Page Down>. 

Selecting an Input Field 

To select a field with the mouse, move the cursor over the field and 
double-click the left or right mouse button.  To select a field with the 
keyboard, use the arrow keys to move the inverse video bar to the field 
and press the Enter key.   
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When you select a field, CHARM displays a dialog box in which you enter 
the requested information.  On-line help is available from within the 
dialog box for each field. 

Modifying CHARM Input 

To change the values for any of the data fields in the Main CHARM Input 
Window, use the following steps: 

1. Move the inverse video bar to the desired field. 

To move the bar with the mouse, position the cursor over the field 
and click the left mouse button.    

To move the bar with the keyboard, use the arrow keys to position 
the bar over the field. 

2. Select the field. 

To select the field with the mouse, double-click the left mouse button 
while the bar is over the field.   

To select the field with the keyboard, press <Enter> while the bar is 
over the field.  

3. Make the necessary changes to the value(s) in the dialog box. 

To display the on-line help that provides additional information for 
the requested data, select the Help command button in the dialog 
box. 

4. Select OK to return to the Main CHARM Input Window.  

Alternatively, the user has the option of viewing the input data in a folder 
format.  For more information on inputting the release scenario and 
meteorological data in this form, see the Option Menu description under 
Main CHARM Input Window Menus later in this Chapter. 
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Main CHARM Input Window Menus 

The File, Edit, View, Window, and Help menus on the Main CHARM 
Input Window include the standard Windows commands plus some 
additional commands.  The Options, MetFile, and Displays menus are 
exclusive to the CHARM program.  Only those menu commands that are 
appropriate for the current release description are available for selection. 

View Menu 
Use the Status Bar command to display and hide the Status Bar, which 
describes the action to be executed by the selected menu item, and 
keyboard latch state.  A check mark appears next to the menu item when 
the Status Bar is displayed. 

Window Menu 
The Window menu offers the following commands, which enable you to 
arrange multiple views of multiple windows in the application window: 

COMMAND SUMMARY 

Cascade Arranges windows in an 
overlapped fashion. 

Tile Arranges windows in non-
overlapped tiles. 

Arrange Icons Arranges icons of closed 
windows. 

Window 1, 2, ... Goes to specified window. 

 

Help Menu 
The Help menu offers the following commands, which provide you 
assistance with this application: 

COMMAND SUMMARY 

Help Offers you help on the current 
task or command. 

Index Provides general instructions 
on using help. 
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Using Help Offers you an index to topics on 
which you can get help. 

Search for Help on Displays a list of keywords used 
in CHARM from which a list of 
related topics may be. 

About Displays the version number 
and copyright notice for 
CHARM. 

 

File Menu 
The File menu on the Main CHARM Input Window provides the standard 
Windows file commands for creating, opening, saving, renaming, 
printing, and exiting CHARM.  The CHARM File menu also provides a 
command for selecting a previously stored scenario. 

The File menu of the Main CHARM Input Window has the following 
commands: 

 
COMMAND SUMMARY 

New Restores all the fields on the Main 
CHARM Input Window to their 
initial values when the CHARM 
program began.  These default 
values may be changed via the 
CHARM.INI file (see CHAPTER 3: 
CHARM.INI File Description) or by 
selecting Save As Default under the 
File menu (see Save As Default 
command description below). 

Open Displays a dialog box requesting the 
name of an input file to open.  The 
dialog box contains a selection list of 
the drives and any file names that 
match the file specification.  The 
default extension is .EMG, which 
may be changed via the CHARM.INI 
file (see Chapter 3: CHARM.INI File 
Description). 
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Scenarios Displays a selection list of release 
scenario titles stored previously in 
CHARM with the .EMG default file 
name extension or other file name  
that matches the currently specified 
extension.   To create the list, 
CHARM first searches the directory 
specified for emergency response 
files in the File Location Editor of 
CHARMED.  CHARM displays the 
selected scenario.  For more 
information on this menu item, see 
the  “Scenarios Command” topic 
below.   

Save Saves the input data from the Main 
CHARM Input Window.  If no file 
name has been assigned, a dialog 
box is displayed in which you enter 
a file name. 

Save As Displays a dialog box in which you 
can enter the name of the file being 
saved.  

Save As 
Default 

Automatically saves the current 
scenario described in the CHARM 
Input Window as the default 
scenario stored in a file labeled 
CHRMDFLT.EMG;  that is, upon 
first entering CHARM or selecting 
New from the File menu, the 
parameters stored in CHRMDFLT 
file are displayed. 

Print Print the entire contents of a 
window 

Print 
Preview 

Display the window contents on the 
screen as it would appear printed. 

Printer Allows the user to change the 
current printer configuration and 
connection. 
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Exit Exit the CHARM MDI.  All windows 
are closed and exit the CHARM 
program. 

 

New Command 
The New command on the File menu restores all the fields on the Main 
Input Window to their initial values when the CHARM program began.  If 
any   modifications were made to the current scenario and the current 
scenario has not yet been saved, CHARM will prompt the user to save 
changes before resetting the release input parameters back to the default 
values.  These default values may be changed via changing the CHARM 
initialization file CHARM.INI (see CHAPTER 3: CHARM.INI File 
Description) or by simply selecting the Save As Default command from 
the file menu. 

Open File Command 
The Open command on the File menu displays a dialog box requesting 
the name of an input file to open. 

 
 
The dialog box contains a selection list of the drives and any file names 
that match the file specification.  The default extension is .EMG, which 
may be changed via the CHARM.INI file (see Chapter 3: CHARM.INI File 
Description).  Alternatively, the default extension may be changed by 
simply specifying a new extension in the Open or Save dialog boxes. 

Scenarios Command 
The Scenarios command on the File menu displays a selection list of the 
run titles for release scenarios that have been previously stored.  Unless 
you specify a different extension, release scenario files are assigned the 
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default .EMG file name extension by CHARM.  The default may be 
changed via the CHARM.INI file (see Chapter 3: CHARM.INI File 
Description). 

 

When you select a title, CHARM displays the input window containing 
the data for that scenario.  Multiple selections, one after the other, may 
be required to completely select the desired scenario.  The number of 
selections depends on the setup and location of the .IND and .EMG files.  
The first subdirectory in which CHARM searches for .EMG and .IND files 
is the directory specified for the emergency response files in the File 
Location editor of CHARMED.  CHARM displays lists until you make the 
last level of selections.  Then, CHARM displays the input window for the 
scenario described in the selected .EMG file.  You can move back and 
forth through the scenarios as desired. 

IND File 

A file containing subdirectory information that CHARM uses to locate 
.EMG files in the emergency response mode.  Files with .IND extensions 
are created by the user with a text editor.  Using the combination of .IND 
file and .EMG files allows the user to organize prestored data files by 
geography, chemical species, etc.  IND files are strictly used with the 
Scenarios command under the file menu in CHARM proper. 

Steps for using IND Files: 

1) The user must define the location of the initial .IND file under File 
Locations in the CHARM editor (CHARMED). 

2) From File Manager or Windows Explorer, create subdirectories which 
layout, for example, geographical aspects of possible release sites. 
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3) From Notepad or some other text editor, create a file with the .IND 
extension and format the file as follows: 

LINE          TEXT 

1 Subdirectory Name. 
2 Description of information associated with subdirectory name. 
3 Subdirectory Name. 
4 Description of information associated with subdirectory name. 
5 Subdirectory Name. 
6 Description of information associated with subdirectory name. 
etc... 

Example IND File 

The EXAMPLE.IND would read as follows and reside in the 
C:\CHARM\PLANT subdirectory: 

EAST 
Release occurred in east side of plant 
NORTH 
Release occurred in north side of plant 
SOUTH 
Release occurred in south side of plant 
WEST 
Release occurred in west side of plant 
 
NOTE: The above file should reside in the initial Emergency Response file 
location defined by the CHARM editor (CHARMED).  NO prestored data 
files (.EMG) should reside in the same directory as .IND files.  CHARM 
attempts to locate EMG files first.  If EMG files are located and read, no 
attempt is made to locate IND files. 

4) Repeat Step 3 for all directories. 

Save/Save As Commands 
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The Save command will save the current release description information 
into the currently opened file.  If no current file is defined, then invoking 
the Save command will invoke the Save As command and display a 
dialog box requesting the name of an input file to save the currently 
defined release scenario. 

 
 

Print Preview Command 
The Print Preview command on the File menu displays a dialog box 
illustrating how the information displayed from the Main Input Window 
will be printed.  The user has options to zoom in or out, display the next 
page of information, print the existing data, or close the preview and 
return to the CHARM Main Input   Window. 

 

 
 

Print Setup Command 
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The Print Setup command on the File menu displays a dialog box 
requesting printer configuration information.  The user has options to 
specify the desired printer, portrait or landscape orientation, and paper 
size and source.  Other options may also be available. 

 

 
 

Edit Menu 
The Edit menu of the Main CHARM Input Window has only one 
command.  Use the Copy command to send text from the input window 
to the Windows clipboard where it can be retrieved by other programs.  
All text in the window, visible or not, is sent to the clipboard.   

MetFile Menu 
Use the Metfile menu of the Main CHARM Input Window to create, open, 
save, and rename files containing meteorological data.  These commands 
are similar to the standard Windows functions.  If you are set up to 
receive automatic information from a meteorological tower, the Metfile 
menu also provides the Automatic Poll command. 

The Metfile menu includes the following commands: 

COMMAND SUMMARY 
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New Restores all met data to the values 
that existed when the program 
began.  These default values may be 
changed via the CHARM.INI file (see 
Chapter 3: CHARM.INI File 
Description) or by selecting the Save 
As Default command under the 
MetFile menu. 

 

Open Displays a dialog box requesting the 
name of a met file to open.  The 
dialog box contains a selection list of 
the drives and any file names 
matching the file specification.  The 
default extension is .MET, which 
may be changed via the CHARM.INI 
file (see Chapter 3: CHARM .INI File 
Description). 

Save Saves the met data.  If no file name 
has been assigned, a dialog box is 
displayed in which you enter the file 
name.  You can enter a base 
extension name for the file and allow 
CHARM to assign the extension, or 
you can assign the entire name. 

Save As Displays a dialog box in which you 
enter the new file name and saves 
the met data in that file.  

 

Save As 
Default 

Automatically saves the current met data 
described in the CHARM Input Window as 
the default met data stored in a file labeled 
CHRMDFLT.MET; that is, upon first entering 
CHARM or selecting New from the File 
menu, the parameters stored in CHRMDFLT 
file are displayed. 

Solar 
Radiation 
Worksheet 

A worksheet provided to aid the user 
in the estimation of solar radiation. 

444



Main CHARM Input Window   

 

100

Automatic 
Poll 

Initiates conversation between 
CHARM and the meteorological 
interface (METINTER.EXE) to 
automatically read stored met data.  
This menu item may be grayed 
(unavailable) if you do not have real-
time met capabilities.  

Stop Poll Signals CHARM to stop real-time 
data acquisition.  This option is only 
available after Automatic Polling has 
been invoked. This menu item may 
be grayed (unavailable) if you do not 
have real-time met capabilities. 

 

Use Inverse 
Square 

Available only if more than one met 
site is available to CHARM for real-
time data acquisition.  Selecting this 
method allows CHARM to determine 
meteorological conditions at a given 
site, using an algorithm that weights 
each met parameter as a function of 
the met parameter at every other site 
and their relative distances. 

Calculate 
Solar 
Radiation 

Calculate the solar radiation as real-time 
met data is acquired.  A check beside this 
option indicates that CHARM will calculate 
the solar radiation based on user input into 
the Solar Radiation Worksheet.  This option 
is only available if CHARM is configured to 
do real-time met data acquisition. 

 
Open MetFile Command 
The Open command on the File menu displays a dialog box requesting 
the name of an input file to open containing meteorological data 
previously stored in CHARM. 
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Save/Save As MetFile Commands 
The Save command will save the current meteorological data into the 
currently opened file.  If no current file is defined, then invoking the Save 
command will invoke the Save As command and display a dialog box 
requesting the name of an input file to save the currently defined 
meteorological data. 

 

Automatic Poll Command 
Use the Automatic Poll command on the Metfile menu of the Main 
CHARM Input Window to read met data automatically for up to 24 hours 
from the specified time of release.  To use this option, your system must 
be set up with the appropriate software program (METINTER.EXE) and 
communication parameters for receiving automatic data from a 
meteorological tower.  The communications parameters can be set using 
the CHARM editor. 

Solar Radiation Worksheet Command 
Use the Solar Radiation worksheet to estimate the amount of solar 
radiation as a function of the time of day, the day of the year, and 
location.  Solar radiation is a function of latitude/longitude, cloud 

446



Main CHARM Input Window   

 

102

cover, time of day, and the day of the year.  The user must specify the 
+/- offset from local time to Greenwich Mean Time (GMT).  CHARM will 
use the calculated solar radiation value to aid in the determination of the 
stability class if so desired.  Likewise, if the user elects to let CHARM 
calculate the solar radiation value, it will be displayed in the meteorology 
conditions at the bottom of the Main CHARM Input Window.  An example 
of the worksheet is illustrated below. 

 

Options Menu 
The Options menu offers the following commands: 

COMMAND SUMMARY 

Prompt at 
Exit 

Toggle switch to prompt or not to 
prompt the user before exiting 
CHARM.  A check by this menu 
item indicates that the user will 
be prompted before exiting; 
otherwise, no check indicates the 
user will not be prompted by the 
exit dialog box. 

Time is 
Minutes-
Seconds 

Toggle switch to run CHARM in 
Minutes-Seconds mode or Hours-
Minutes mode.  A check by this 
menu item indicates that CHARM 
will run in Minutes-Seconds 
mode; otherwise, no check 
indicates that CHARM will run in 
Hours-Minutes mode. 
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Default 
Metric Units 

Toggle switch to default CHARM 
to report units in metric terms or 
English units.  A check by this 
menu item indicates that CHARM 
will use metric units; otherwise, 
no check indicates that CHARM 
will report units in English terms. 

Description 
Dialog Input 

Provides a means of viewing the 
release input data in a tabbed 
folder format. 

Met Dialog 
Input 

Provides a means of viewing the 
meteorological input data in a 
tabbed folder format. 

 
Prompt At Exit Command 
Use this command to turn on/off the prompt to exit CHARM. A check by 
this menu item indicates that the user will be prompted before exiting 
CHARM; otherwise, no check mark indicates that the user will not be 
prompted by the exit dialog box. 

Time is Minutes-Seconds Command 
Use this command to toggle between CHARM’s two time modes.  A check 
by this menu item indicates CHARM is running in Minutes-Seconds 
mode; i.e. CHARM will model a maximum of 24 minutes of dispersion.  
Likewise, all output will be in terms of minutes and seconds. 

On the other hand, no check indicates that CHARM is running in Hours-
Minutes mode; i.e. CHARM will model a maximum of 24 hours of 
dispersion.  All output will be in terms of hours and minutes. 

On output displays, this is differentiated by the following: 

Hours-Minutes mode uses a colon (:) to delimit hour and minutes; 

Minutes-Seconds mode uses equals (=) to delimit Minutes-Seconds. 
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For example, when CHARM is in the seconds mode all times will be 
displayed with the separator “=“ instead of “:” or whatever the local time 
indicator is.  So fifteen seconds into the release will appear as 00=15 
rather than 00:15, which indicates fifteen minutes into the release.   All 
time labels and columns will appropriately indicate seconds rather than 
minutes. 

Default Metric Units Command 
Use this command to default CHARM to report units in metric terms or 
English units.  A check by this menu item indicates that CHARM will use 
metric units; otherwise, no check indicates that CHARM will report units 
in English terms. 

Description Dialog Input Command 
Use this command as an alternative means to view release input data 
rather than displaying the information from the single Main Input 
Window.   Depending on the release type chosen from the basic 
information tab, the data is categorized appropriately.  The basic, 
location, and building information tabs are always requested for any one 
of the three release types. 

Basic Tab 

On the Basic tab of the folder, CHARM requests the following:  

• title of the scenario; 
• the release type (Container/Surface Description, Pool/Lagoon 

Description, or User-Specified After-Release Conditions); 
• the species being modeled; 
• the desired isopleth concentrations for dispersion; and 
• the type of output to be displayed when/if the stored scenario is used 

in CHARM’s emergency response mode of operation.  The type of 
output available depends on the scenario definition. 
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Location Tab 

On the Location tab of the folder, CHARM simply requests the x,y 
Cartesian coordinates associated with the source location.  This is only 
required if the footprint generated by CHARM is to be overlayed on a 
map, or population impact calculations are to be performed.  However, 
this location may be changed once the footprint has been calculated by 
CHARM. 
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Building Tab 

On the Building tab of the folder, CHARM requests the dimensions of the 
building (height and width) and the distance and direction to the source. 
Enter the direction you would be facing if you were at the release site 
looking at the building. If the release site is not downwind of the 
building, the building is ignored. The direction can be entered in degrees 
or points of the compass. Degrees refer to the 360-degree directional 
compass, where North is 0 or 360, East is 90, South is 180, and West is 
270. Points of the compass refer to North (N), East (E), South (S), West 
(W), and the points between, such as Northeast (NE) and South 
Southeast (SSE).  Also, Enter the distance from the release site to the 
center of the building. The units are feet or meters. If the release site is 
more than ten times the minimum dimension of the building (height or 
width), the building is ignored. 

 

For a Container/Surface Description or Pool/Lagoon Description release 
types, the folder is additionally categorized by pool and surface 
information. 

Pool Tab 

On the Pool tab of the folder, CHARM requests the following: 

• Enter the height above ground of the liquid-air interface. The units 
are feet or meters. Normally a released liquid falls to the ground. 
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• Enter the total area or equivalent circular diameter of the pool size. 
The units are inches, feet, centimeters, or meters. The diameter is 
used to calculate the surface area from which the liquid will 
evaporate. Larger areas tend to evaporate more rapidly than smaller 
areas. CHARM will calculate the pool diameter/area if given the 
amount released and pool depth. 

• Enter the time from the beginning of the release when the pool is 
assumed to be covered or drained. The evaporation from the pool will 
stop at the Pool Mitigation Time. The time can be in units of hours, 
minutes, or seconds. If no mitigation time is desired the entry can be 
left blank or enter zero. 

 
 
Surface Tab 

On the Surface tab of the folder, CHARM requests the following: 

• Enter the fraction (by volume) of the spill surface that is water. This 
is the amount of water in the surface soil of the area that immediately 
surrounds the release site. The water fraction is used to determine 
whether freezing ground water may alter the heat flow into the spill.  

• A value less than 0.1 is dry. A value of 0.6 indicates mud. A value of 
1.0 is water. The suggested average value is 0.15. An entry is 
required. 
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• Select the type of surface on which the spill occurred. If you select 
User-defined surface type, you must enter values for the specific 
heat, thermal conductivity, density, relative pore volume, and Darcy’s 
constant. If you select dirt, asphalt, concrete, or steel, CHARM 
assigns default values for the surface parameters. You can accept or 
change the default values.  Otherwise, making a change to any of the 
surface parameters automatically changes the Surface Type to User-
Defined. 

 

 
 

For a Container/Surface Description release type, the folder is 
additionally categorized by container, storage, hole, pipe, and 
fire/droplets information. 

Container Tab 

On the Container tab of the folder, CHARM requests the following: 

• the container type (horizontal tank or pipeline, vertical tank, or 
spherical tank); 

• the appropriate dimensions based on the selected container type; 
• a mitigation time indicating that the release has been mitigated by 

some circumstance in which the release has been halted; 
• the amount of liquid in the container either by volume, weight, or 

depth. 
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Storage Tab 

On the Storage tab of the folder, CHARM requests storage temperature 
and pressure conditions just prior to release.   

The storage temperature can be specified in Fahrenheit, Celsius, 
Rankine, or Kelvin units.  Use a storage temperature that is greater than 
the melting point of the chemical released.  The user can specify a value 
for the temperature, use the ambient condition specified in the 
meteorological conditions, or let CHARM calculate the temperature if the 
storage pressure is NOT calculated.  

The storage pressure can be either gauge or absolute. The units are 
atmospheres, pounds/square inch, inches of Mercury, or millimeters of 
Mercury. An absolute pressure of less than one atmosphere is treated as 
one atmosphere in the release rate calculation. The user can specify a 
value for the pressure, use the ambient condition specified in the 
meteorological conditions, or let CHARM calculate the pressure if the 
storage temperature is NOT calculated. 

CHARM will inform the user if the given temperature and pressure define 
a solid phase or if no liquid should exist but a liquid depth is specified.  
However, this is only a warning, and the user may proceed with the 
erroneous input. 
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Hole Tab 

On the Hole tab of the folder, CHARM requests the following: 

• Enter the hole height above the ground of the release from the 
container.  The units are feet or meters.  For a gas release, enter the 
height where the gas enters the atmosphere.  For most heavier-than-
air gas releases, where the release height is less than 50 feet (15 
meters), the release can be set to zero without loss of accuracy. 

• Enter the height of the hole from the bottom of the container. The 
units are inches, feet, centimeters, or meters. The hole height is used 
to determine when the liquid release may stop and the pressurized 
gas release begin. It is also used to determine the amount of liquid 
that can be left in the tank for boil-off at a later time. An entry is 
required. 
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• Enter the equivalent area or circular diameter of the hole, or the 
desired release time whereby CHARM will calculate the hole size 
required to dump the entire liquid contents of the container.  When 
specifying the hole size directly, the units are inches, feet, 
centimeters, or meters.  When determining the hole size indirectly by 
specifying the release time, the units are hours, minutes, or seconds.  
An entry with a value greater than zero is required.  Alternatively, 
CHARM will calculate the hole size if the user specifies a release 
duration for the material in the container. 

• Enter the horizontal direction you would be facing if you were inside 
of the tank looking out of the hole. The direction can be entered in 
degrees or in points of the compass. Degrees refer to the 360-degree 
directional compass, where North is 0 or 360, East is 90, South is 
180, and West is 270. Points of the compass refer to North (N), East 
(E), South (S), West (W), and the points between, such as Northeast 
(NE) and South Southeast (SSE). An entry is required.  

For a gas release, the hole direction determines the initial direction 
the plume takes. It is possible for the plume to travel upwind for 
some period of time. 

CHARM can be told to assume that the hole is facing the same 
direction that the wind is blowing toward. Note that wind direction is 
specified as the direction the wind is blowing from. This reduces the 
turbulence that may occur as the release enters the atmosphere. 
Reduced turbulence generally leads to higher concentrations 
reaching further downwind. 

• Enter the vertical angle of the hole.  This is the angle that your line of 
sight would make with the horizon if you were inside the tank looking 
out through the hole.  For example, if you are looking straight up, the 
value is 90 degrees.  If you are looking straight down, the value is -90 
degrees.  A hole that is parallel to the horizon has a value of 0 
degrees.  The vertical angle of the hole can effect the plume rise of a 
gas release. 
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Pipe Tab 

On the Pipe tab of the folder, CHARM requests the following: 

• the pipe dimensions (length and diameter) as well as relative 
roughness factor.  The Relative Roughness Factor (e/D) is a measure 
of the resistance to flow by friction from the interior surface of the 
cylindrical pipe where the Roughness Factor e is a function of the 
piping material, and D is the diameter of the pipe.  Some examples of 
the Roughness Factor e are given below. 

Material Roughness Factor e (mm) 

Drawn Tubing 0.0015 

Commercial Steel or 
Wrought Iron 

0.045 

Asphalted Cast Iron 0.12 

Galvanized Iron 0.15 

Cast Iron 0.26 

Wood Stave 0.3 

Concrete 0.9 

Riveted Steel 3 

 

NOTE: Remember, the above Roughness Factors (e) must be divided by 
the diameter of the pipe to determine the Relative Roughness Factor. 
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• the number of pipe/vessel connections for each pipe type (Flush, 
Borda, Round); 

• the number of valves; 
• the number of elbows/tees. 
 

 
 
Fire/Droplets Tab 

On the Fire/Droplets tab of the folder, CHARM requests the following: 

• Specify whether the tank vents during a pool fire. 

 Specifying that the tank will vent during pool fire signals CHARM to 
use 50% of the wetted tank surface area to calculate heat transfer to 
the stored liquid that may be released due to an increase in tank 
pressure and venting. The Liquid Pool Fires release type provides the 
information for heat calculation. 

 Specifying that the tank will NOT vent merely signals CHARM that no 
additional mass will be added to the primary source. 

• Enter the efficiency (or fraction of material burned) in the BLEVE.  
CHARM can calculate an efficiency based on the vapor pressure of 
the material. 
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• Enter the fraction (0.0-1.0) of the total mass released that is assumed 
to be suspended as droplets.  The default in CHARM is to assume 
that the same amount of mass that flashes also forms as droplets. 

  

 

For a Pool/Lagoon Description release type, the folder is additionally 
categorized by pool temp/fire information.   

Pool Temp/Fire Tab 

On the Pool Temp/Fire tab of the folder, CHARM requests the following: 

• Enter the temperature of the pool or lagoon of liquid. The 
temperature can be specified in Fahrenheit, Celsius, Rankine, or 
Kelvin units.  If selected, CHARM will assume a value for the 
temperature, using the ambient condition specified in the 
meteorological conditions, or using the boiling point of the species, 
whichever temperature value is lower. 

• Specifying a number greater than 0 indicates that a nearby tank will 
vent during a pool fire.  CHARM uses the user-specified tank surface 
area which is wetted by the chemical of interest to calculate heat 
transfer to the stored liquid that may be released due to an increase 
in tank pressure and venting. The Liquid Pool Fires release type 
provides the information for heat calculation. 

Specifying 0 indicates that no venting will occur and signals CHARM 
that no additional mass will be added to the primary source. 
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Finally, for User-Specified mode, the additional categories are emission 
rate, puff, velocity, and makeup. 

Emission Rate Tab 

On the Emission Rate tab of the folder, CHARM requests the following: 

• Click on the checkbox (if available) labeled “CHARM will calculate 
(vertical velocity and molar air fraction given)” if you desire CHARM to 
calculate the emission rate, so long as the vertical velocity under the 
Velocity tab and the molar air fraction under the Makeup tab are 
user-defined. 

• If CHARM is not to calculate the emission rate, the user must specify 
an instantaneous release rate, or a continuous release rate (of which 
may be defined as constant release rate, linearly decaying release 
rate, or exponentially decaying release rate), or a user-defined 
schedule of release rates at different times since release. 

• Finally, the user must specify a duration time for CHARM to use as a 
cut-off time for material to get into the air. 
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Puff Tab 

On the Puff tab of the folder, CHARM requests the following: 

• Enter the height above the ground of the release from the container. 
The units are feet or meters. For a gas release, enter the height where 
the gas enters the atmosphere. For most heavier-than-air gas 
releases, where the release height is less than 50 feet (15 meters), the 
release height can be set to zero without loss of accuracy. 

• Enter the equivalent circular diameter or the area of the puff or 
stack. The units are inches, feet, centimeters, or meters. The puff size 
is required for a user-specified release type.  

 For an evaporating liquid, enter the surface area of the liquid pool. 
For a gas release, enter the diameter of the hole or stack. 

• Enter the temperature of the initial puff in Fahrenheit, Celsius, 
Rankine, or Kelvin units. The puff temperature is required for a user-
specified release type. If selected, CHARM assumes the ambient 
temperature or the boiling point of the species, whichever is lower. 

 For an evaporating liquid release, the puff temperature is the 
temperature just above the liquid pool. For a gas release, it is the 
temperature upon leaving the container or stack. 
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• It is recommended that you allow CHARM to calculate a depth that 
ensures mass conservation. If you enter a value, the prediction may 
be physically unrealistic. 

 

 
 

Velocity Tab 

On the Velocity tab of the folder, CHARM requests the following: 

• Enter the direction of horizontal (not vertical) movement of the initial 
puff. The direction is determined by release conditions, not by 
meteorological conditions such as wind. The puff direction is required 
for a user-specified release type. 

The direction can be entered specifically in degrees or generally in 
points of the compass. Degrees refer to the 360-degree directional 
compass, where North is 0 or 360, East is 90, South is 180, and West 
is 270. Points of the compass refer to North (N), East (E), South (S), 
West (W), and the points between, such as Northeast (NE) and South 
Southeast (SSE). 
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For an evaporating liquid pool, the direction of horizontal movement 
has little meaning, since there should be no inherent horizontal 
movement. For a gas release, the direction should be the same as the 
direction that the hole or stack is facing. If the hole faces directly 
upward or downward, any value entered for the horizontal direction 
is ignored by CHARM. 

This entry can be left blank. If selected CHARM will assume the puff 
is moving in the same direction that the wind is blowing toward. Note 
that wind direction is specified as the direction the wind is blowing 
from. This reduces the turbulence that may occur as the release 
enters the atmosphere. Reduced turbulence generally leads to higher 
concentrations reaching further downwind. 

• Enter the horizontal puff speed in miles/hour, knots, meters/second, 
or kilometers/hour. An entry is required. 

For an evaporating liquid pool, the horizontal speed is zero. For a gas 
release, it represents the horizontal component of the exit velocity 
from the hole or stack. If the hole faces directly upward or downward, 
enter 0 (zero) for the horizontal speed.  

Use the following procedure to obtain the value for the Horizontal 
Puff Speed field: 

1. Complete the entries for the Main CHARM Input Window. Let the 
Vertical Puff Speed be calculated and enter values for the Molar Air 
Fraction and Emission Rate fields. 

2. Press the Apply button. 

3. Find the value for the vertical speed (VERT SPD) on the Puff 
Description output, and enter this value in the Horizontal Puff Speed 
field. 

4. Enter 0 (zero) for the Vertical Puff Speed in the same window. 
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• Enter the vertical speed and direction of the puff. The number 
indicates the speed. A positive (+) number indicates an upward 
direction. A negative (-) number indicates a downward direction. If 
selected and values for the Molar Air Fraction and Emission Rate 
have been entered, CHARM may calculate the Vertical Puff Speed.  
However, the user must specify whether the material exists as a 
liquid or a vapor. 

For an evaporating liquid, the vertical speed is zero. For a gas release, 
the vertical speed represents the vertical component of the exit 
velocity from the hole or stack. For a puff that is directed 
horizontally, the vertical speed is zero. 

 

 
 

Makeup Tab 

On the Makeup tab of the folder, CHARM requests the following: 

• Enter the fraction of the total mass released that is assumed to be 
suspended as droplets.  This number is the mass fraction of droplets 
for each puff during the emission. An entry is required. 

• Enter the molar fraction of water vapor in the emission. It should not 
be higher than approximately 0.04, unless you are describing an 
extremely hot, saturated emission. An entry is required. 
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• Enter the molar fraction of air in the emission. This number allows 
the initial concentration of the gas to be specified. If you select 
“CHARM will calculate (emission rate and vertical velocity give)” and 
enter values for the vertical puff speed on the Velocity tab and the 
emission rate on the Emission Rate tab, then CHARM calculates the 
Molar Air Fraction. 

 

 
 

Met Dialog Input Command 
Use this command as an alternative means to view/modify 
meteorological input data rather than displaying the information from 
the single Main Input Window.  The required data is categorized by main 
information, stability class, solar radiation, and wind data. 

Main Tab 

On the Main tab of the folder, CHARM requests the following:  

• % Relative Humidity; 
• Ambient Temperature; 
• Ambient Pressure; 
• Surface Roughness if it exists; 
• Wind measurement height if a surface roughness is specified; 
• An inversion layer height. 
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Stability Class Tab 

On the Stability Class tab of the folder, CHARM requests the following:  

• Select an atmospheric stability classification (A through F), or enter 
the amount sunshine. If you specify the stability class, you can not 
make entries for the sunshine, cloud cover, or solar radiation unless 
you allow CHARM to calculate the stability class for. If you want 
CHARM to calculate the stability class, select the appropriate 
checkbox and then specify the sunshine, the cloud cover, and solar 
radiation checkbox.   If the ‘Use Solar Radiation‘ checkbox is selected, 
CHARM determines the amount of sunshine based on a Solar 
Radiation Worksheet located under the Solar tab. 
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Solar Tab 

Solar radiation is used as a source for heat transfer when calculating the 
evaporation of a liquid pool.  The user may simply specify a value or use 
the worksheet provided on the  Solar tab which will aid in CHARM’s 
estimation of solar radiation. 

Solar radiation is a function of latitude/longitude, cloud cover, time of 
day, and the day of the year.  You must also specify the +/- offset from 
your local time to Greenwich Mean Time (GMT).  CHARM will use the 
calculated solar radiation value to aid in the determination of the 
stability class if so desired.  Likewise, if the user elects to let CHARM 
calculate the solar radiation value, it will be displayed in the meteorology 
conditions at the bottom of the Main CHARM Input Window. 
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Winds Tab 

Enter sets of wind times, speeds, and directions. Each set represents the 
conditions at a specific time. At least one wind is required. If you leave 
one of the wind values blank, that wind is deleted.  The maximum 
number of wind entries is only restricted by memory. 

The time is the time since release in hours and minutes, up to 24 hours. 
The wind speed units are miles/hour, meters/second, knots, or 
kilometers/hour. Wind direction is the direction from which the wind is 
coming. The direction can be entered in degrees or in points of the 
compass. Degrees refer to the 360-degree directional compass, where 
North is 0 or 360, East is 90, South is 180, and West is 270. Points of 
the compass refer to North (N), East (E), South (S), West (W), and the 
points between, such as Northeast (NE) and South Southeast (SSE). 

CHARM performs a linear interpolation between wind times to determine 
a wind speed and direction. Therefore, there are no instantaneous wind 
shifts. To model a quick wind shift, you can enter two winds that are one 
minute apart. 
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Displays Menu 
The available commands on the Displays menu vary according to the 
input window.  Refer to Chapter 6, “Understanding CHARM Displays,” for 
display samples and more information.  The Displays menu of the Main 
CHARM Input Window provides the following displays. 

 
COMMAND SUMMARY 
Site 
Information 

Displays a text file window 
containing site-specific information.  
The text is created using the 
CHARM editor.  

Chemical Data 
Displays thermodynamic data and 
default plot concentrations from the 
chemical database for the selected 
species.  The chemical database 
can be edited using the CHARM 
editor.  

Chemical 
Response 

Displays a text window containing 
the emergency response 
information for the selected 
chemical species.  The text can be 
edited using the CHARM editor.  
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The following displays start calculations for the numerical portion of CHARM. 

Source/Puff 
Description 

Display numerical results of 
different aspects of a release 
associated with the current input 
and met data.   

 

Emission Rate Displays a plot of the emission rate 
as a function of time for the 
variables in the Main CHARM Input 
Window throughout the release.  

The following displays are available for the appropriate species and release 
types. 

BLEVE Displays a footprint of thermal 
radiation resulting from a 
fireball/BLEVE.  

Pool Fire 
(Radiation) 

Display thermal radiation of a 
Liquid Pool Fire associated with the 
current input scenario. 

Pool Fire 
(Plume) 

Display the plume of a Liquid Pool 
Fire associated with the current 
input scenario 

Jet Fire 
Radiation 

Display thermal radiation of a Jet 
Fire associated with the current 
input scenario.  

Mechanical 
Overpressures 

Display mechanical overpressures 
of a pressurized vessel associated 
with the current input scenario.  

Plume Displays a snapshot view of the plume at 
the specified time after release.  You can 
also generate a concentration history plot 
at selected points, change the position of 
the plume, and zoom any map location 
icons that are shown. 

Release Description Input 
The upper portion of the Main CHARM Input Window contains input 
fields that describe the release.  Figure 5.1 shows these fields.  The 
release description requires the name of the chemical species, a 
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release type, and other pertinent information describing the release.  For 
most release types, you can specify the proximity to a building downwind 
of the release, and CHARM will calculate a building wake.  

The selected chemical species and release type determine which release 
description fields are displayed.  On-line help is available for each input 
field on the Main CHARM Input Window. 

Version 
The version number is displayed on the most hardcopy output and is not 
an editable field. 

Title 
The run title displays on CHARM output and in the selection list for the 
Scenarios command.  Enter the title of the current run.  

 

Species 
This field requires the name of the chemical whose effects you are 
assessing.  When you select this field, CHARM displays the Chemical 
Selection window.  You can select a species from the chemical database, 
which contains data for over 100 chemical compounds.  The chemical 
database can be expanded or modified with the Chemical Database 
command in the CHARM editor (CHARMED.EXE).  See Chapter 4, "Using 
the CHARM Editor," for a list of all the chemicals in the CHARM database 
and information on modifying the chemical database. 
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The search and scroll functions are available in the selection window.  To 
perform a search through the chemical database, select Set String in the 
Chemical Selection window, enter the character string for which you 
want to search, and select OK or press <Enter>.  Then, specify whether 
the search is Up (backward) or Down (forward).  You can use the wild 
cards, * (asterisk) and ? (question mark) in the search string.  The * wild 
card represents zero or more characters. The ? wild card represents a 
character position, rather than a special character.  

Release Type 
The release type describes the conditions of the initial chemical release.  
A release type must be selected for each CHARM run. 

 

The release types provided by CHARM are defined according to the 
conditions right at and before release, or conditions right at and after 
release. 
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The release types available in CHARM are: 

Container/Surface Description 
A Container/Surface description requires that the user specify conditions 
at and before the release.  The Main CHARM Input Window will change 
to reflect only that input which is required.  Usually for a liquid release, 
the species escapes from a container and the generated pool is regulated 
by dikes or terrain.  For this reason, the user must specify a maximum 
pool size, whereby CHARM will allow the pool to expand up to this 
maximum size, and then assume that the pool only becomes deeper.  The 
remaining material of the species enters the air either as vapor or liquid 
droplets. 

Pool/Lagoon Description 
A Pool/Lagoon Description requires that the user specify conditions 
associated with a pool or lagoon of liquid.  The Main CHARM Input 
Window will change to reflect only that input which is required.  The 
release rate that the species enters the air is controlled by the rate at 
which the liquid materials evaporates from the pool.  Depending on the 
chemical data, the pool may be lit on fire. 

User-Specified After Release Conditions 
A User-Specified After Release Conditions type requires you to specify a 
detailed description of the conditions following a release.  You must 
supply the emission rate as well as the temperature, dimensions, 
direction, speed, and makeup of the initial puff.  CHARM will calculate 
one of three of the following inputs: initial emission rate, exit velocity, or 
molar air fraction.  Before you run a user-specified release, it is 
recommended that you perform a standard CHARM run using a release 
type that closely resembles the release you want to define.  The standard 
run will provide some of the necessary data to facilitate running the 
user-specified release.  This release type is useful when assessing stack 
emissions. 

The figures on the following pages show the different input fields for 
various sample releases. 

 

Figure 5.3 
Container/ 
Surface 
Description 
(top) 

473



Main CHARM Input Window   

 

129

 

 

 

Figure 5.4 
Container/ 
Surface 
Description 
(Bottom) 
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Emergency Response Output 
Select from the type of output available from the drop-down list.  The list is 
dynamic and changes depending on other scenario input.  This field indicates to 
CHARM the type of output to generate when running from emergency response 
mode. 

The six following choices may be available to the user: 

Plume Shows concentration footprints of 
the released chemical. 

Pool Fire Plume Shows the unburned portion of 
species emanating from a pool 
fire. 

Figure 5.5 
Pool/Lagoon 
Description 

Figure 5.6 
User-
Specified 
After Release 
Conditions 
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Pool Fire Radiation Shows thermal radiation 
footprints from a liquid pool fire. 

Mechanical 
Overpressures 

Shows the overpressure or 
shockwave footprints from a 
pressurized vessel failure. 

Jet Fire Radiation Shows thermal radiation 
footprints from a jet fire release. 

BLEVE Shows thermal radiation 
footprints from a fireball/BLEVE. 

 

 
X and Y Locations 

The X and Y Locations are the East/West and North/South coordinates 
of the source location.  To ensure proper placement, the point of origin 
should be the same as that of each map or population polygon you 
intend to use.  Positive (+) X numbers are to the east (right) of the origin, 
and negative(-) X numbers are to the west (left).  Positive Y numbers are 
to the north of the origin, and negative Y numbers are to the south. 

 

Isopleth Concentrations 
Isopleths are the species concentrations that are plotted on the output 
display screens and on hard-copy graphs.  CHARM uses isopleth 
concentrations for creating a plume plot.  You can enter up to three 
isopleth concentrations.  At least one concentration is required.  The 
units of concentration are parts per million (ppm) or micrograms per 
cubic meter (ug/m3).  The default values are specified in the chemical 
database for the selected chemical.  The default isopleth values for a 
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species can be changed using the Chemical Database command of the 
CHARM editor. 

 

Building Wake Input 
The following information is required for CHARM to calculate a building 
wake. 

Building Height and Width 
Enter the height and width of a building that is upwind of the release 
site.  The units are feet or meters.  CHARM uses these dimensions to 
calculate building wake.  If either the height  or width field is 0 (zero), no 
building is assumed to be present.  

 
 

Source to Building Direction and Distance 
Enter the direction you would be facing if you were at the release site 
looking at the building.  The direction can be entered in degrees or points 
of the compass.  Degrees refer to the 360° directional compass, where 
North is 0 or 360, East is 90, South is 180, and West is 270.  Points of 
the compass refer to North (N), East (E), South (S), West (W), and the 
points between, such as Northeast (NE) and South Southeast (SSE).  
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The direction is required for the Huber-Snyder building wake effect 
calculations.  If the release site is not downwind of the building, the 
building is ignored.  

The distance from the release site to the building should be calculated 
from the release site to the center of the building.  The units are feet or 
meters.  CHARM uses the distance and direction to calculate a building 
wake. 

If the distance to the release site is more than ten times the minimum 
dimension of the building (height or width), the Huber-Snyder building 
wake is not used in the dispersion calculation. 

Release Height Above Ground 
Use this field to enter the height of the release above ground.  The units 
are feet or meters.  This field can be used to describe elevated tanks. 

 

For a liquid release, enter the height of the liquid-air interface.  Normally 
a released liquid falls to the ground.  For a gas release, enter the height 
where the gas enters the atmosphere.  For most heavier-than-air 
releases, where the release height is less than 50 feet, the release height 
can be set to 0 (zero) without loss of accuracy.  For a container release 
both hole height and pool height will be requested.   
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Fraction of Liquid mass Suspended as Droplets 
This field specifies the fraction of the total released mass that is assumed 
to be suspended as droplets.  For a liquid release from a container, the 
mechanism for droplet creation is assumed to be turbulence and 
splashing during the release.  This number is the mass fraction of 
droplets for each puff during the emission.  For container/surface 
release, if this field is left blank, CHARM assumes that the droplet 
fraction of mass is the same as the flash fraction. 

 

Amount Released 
The amount released can be either the volume of the container or the 
total amount of the species released.  If you enter the volume, CHARM 
calculates the mass amount released.  The units are cubic feet, cubic 
meters, pounds, kilograms, gallons, or liters.  For a Pool/Lagoon release, 
CHARM will calculate the amount released if given the pool 
diameter/area and pool depth. 

 

For a liquid release from a container, some fraction of the total amount 
may be released as droplets.  

Maximum Pool Diameter (Pool/Lagoon Description) 
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The size of the pool can be either the total area or equivalent circular 
diameter of the pool.  The units are inches, feet, centimeters, or meters.  
If you enter the diameter, CHARM calculates the surface area from which 
the liquid will evaporate.  Larger areas tend to evaporate more rapidly 
than smaller areas.  For a Pool/Lagoon release, CHARM will calculate the 
pool diameter/area if given the amount released and the pool depth. 

 

Maximum Pool Diameter (Container/Surface Description) 
Usually for a liquid release from a container, the species escapes from a 
container and the size of the generated pool is regulated by dikes or 
terrain, whereby the user must specify a maximum pool size.  CHARM 
will allow the pool to expand up to this maximum size, and then assume 
that the pool only becomes deeper. 

 

Wetted Tank Surface Area 
CHARM allows venting for two of the three release types: 
Container/Surface and Pool/Lagoon releases.  When the scenario 
involves a container and a liquid pool fire, CHARM will inquire as to 
whether or not venting from the tank will occur.  Specifying that the tank 
will vent during pool fire signals CHARM to use 50% of the wetted tank 
surface area to calculate heat transfer to the stored liquid that may be 
released due to an increase in tank pressure and venting.  The Liquid 
Pool Fire release type provides the information for heat calculation.  
Specifying that the tank will NOT vent merely signals CHARM that no 
additional mass will be added to the primary source. 
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Likewise, if the scenario involves a liquid pool fire and a pool/lagoon of 
liquid, CHARM will inquire as to the area of a nearby tank that is wetted 
by the species.  The units are square feet or square meters.  CHARM 
uses this area to calculate heat transfer to the stored liquid that may be 
released because of an increase in tank pressure and venting.  The heat 
is calculated from the value entered for liquid pool fires and the tank is 
assumed to be surrounded by fire. 

 

Storage Temperature 
The storage temperature is the temperature of the container just prior to 
the release.  The temperature can be specified in Fahrenheit, Celsius, 
Rankine, or Kelvin units.  The storage temperature should be greater 
than the melting point of the chemical released.  The user can specify a 
value for the temperature, use the ambient condition specified in the 
meteorological conditions, or let CHARM calculate the temperature if the 
storage pressure is NOT calculated. 

Storage Pressure 
The storage pressure is the pressure of the container just prior to 
release.  This pressure can be either gauge or absolute.  An absolute 
pressure of less than one atmosphere is treated as one atmosphere for 
the release calculation.  The user can specify a value for the pressure, 
use the ambient condition specified in the meteorological conditions, or 
let CHARM calculate the pressure if the storage temperature is NOT 
calculated. 
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CHARM will inform the user if the temperature and pressure indicate 
that the phase is solid or if no liquid should be present but a liquid depth 
is specified.  However, this is only a warning, and the user may proceed 
with the non-equilibrium input. 

BLEVE Burn Efficiency 
Enter the efficiency or fraction of material burned in the Boiling Liquid 
Expanding Vapor Explosion (BLEVE).  If the field is left blank, CHARM 
calculates an efficiency based on the vapor pressure of the material.  
Calculating a BLEVE burn efficiency is only available when describing a 
container/surface release.  

 

Water Fraction of Spill Surface 
This field specifies the fraction (by volume) of the spill surface that is 
water, or the amount of water in the surface soil of the area that 
immediately surrounds the release site.  A value less than 0.1 is dry.  A 
value of 0.6 indicates mud.  A value of 1.0 is water.  The suggested 
average value is 0.15.  The water fraction is used to determine whether 
freezing ground water may alter the heat flow into the spill.  An entry is 
required. 
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Surface Description Input 
The following information is required to describe the surface on which 
the spill occurred. 

Surface Type 
Enter the type of surface on which the spill occurred.  If you select dirt, 
asphalt, or concrete, CHARM assigns default values for the surface 
characteristics.  You can accept or change the default values. 

 

If you select the user-defined surface type, you must enter the surface 
characteristics for specific heat, thermal conductivity, density, relative 
pore volume, and the Darcy constant. 

Surface Specific Heat 
Enter the specific heat of the surface on which the spill occurred.  The 
units are Joules/kilogram, BTU/pound °F, or calories/gram.  CHARM 
uses the surface specific heat for heat transfer calculations. 

 

Surface Thermal Conductivity 
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Enter the conductivity of the surface on which the spill occurred.  The 
units are watts/meter per degree Celsius, calories/second/centimeter 
per degree Celsius, or BTU/hour/foot °F per degree Fahrenheit.  CHARM 
uses the surface thermal conductivity for heat transfer calculations.  

 

Surface Density 
Enter the density of the surface on which the spill occurred.  The units 
are kilograms/cubic meter, grams/cubic centimeter, pounds/cubic foot, 
or pounds/cubic inch.  CHARM uses the surface density for heat transfer 
calculations.  An entry is required.  

 

Relative Pore Volume of Surface 
Enter the porosity or relative pore volume of the surface on which the 
spill occurred.  The unit is a fraction.  CHARM uses the relative pore 
volume to calculate the amount of liquid that can be percolated through 
the spill surface.  
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Darcy Constant of Surface 
Enter the Darcy constant to use for calculating the amount of liquid that 
can be absorbed into the spill surface.  The units are feet or meters.  

 

Tank Description Input 
The tank description fields that appear in the window are determined by 
the tank type.  The following fields describe the tank from which the 
chemical was released. 

Tank Type 
Select the type of container from which the species was released.  The 
three choices are a vertical cylinder tank, horizontal cylinder tank or 
pipeline, and a spherical tank. 

 

The tank dimensions are used to determine the amount of species 
released.  A vertical cylinder has horizontal bases and requires an entry 
for the tank height and diameter.  A horizontal cylinder requires an entry 
for the tank length and diameter.  A railroad tank car is an example of a 
horizontal cylinder. A spherical tank requires an entry only for tank 
diameter. 

Tank Height 

Enter the height of a vertical tank.  The units are inches, feet, 
centimeters, or meters.  The tank height is used to determine the 
amount of species released. 

485



Main CHARM Input Window   

 

141

 

Tank height refers to the physical dimension of the tank, rather than 
tank elevation.  The calculations for elevated tanks are handled by the 
entry in the field named Release Height.   

Tank Diameter 
Enter the diameter of the spherical container, or the cylindrical portion of 
a vertical tank or horizontal pipeline.  The units are inches, feet, 
centimeters, or meters.  

 

Tank Length 
Enter the length of a horizontal tank or the distance between closed 
valves of a pipeline.  The units are inches, feet, miles, centimeters, 
meters, or kilometers.  

 

Liquid Depth in Container 
If there is liquid inside the storage container, this field requires a value 
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for the depth of the liquid.  The units are inches, feet, centimeters, or 
meters.  The liquid depth is used to determine the amount and rate of 
liquid released. 

 
 

For a vertical tank, the liquid depth must be less than the tank height.  
For a horizontal tank or pipeline, the liquid depth must be less than the 
tank diameter.  For spherical tanks, the liquid depth must be less than 
the tank diameter.  If you change the liquid depth to a value that is 
inconsistent with the values for the tank height or diameter, CHARM 
adjusts the tank height or diameter to accommodate the liquid depth 
value. 

If liquid exists in the container, some may escape through the hole or 
some may be left in the container.  Liquid left in the container may boil 
off after any pressurized gas escapes from the container. 

Hole Diameter 
Enter the equivalent area or circular diameter of the hole.  The units are 
inches, feet, centimeters, or meters.  An entry with a value greater than 
zero is required.  
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Hole is Facing 
Enter the direction you would be facing if you were inside the tank 
looking out of the hole.  The direction can be entered specifically in 
degrees or generally in points of the compass. 

 

Degrees refer to the 360° directional compass, where North is 0 or 360, 
East is 90, South is 180, and West is 270.  Points of the compass refer to 
North (N), East (E), South (S), West (W), and the points between, such as 
Northeast (NE) and South Southeast (SSE).  

For a gas release, the hole direction determines the initial direction that 
the plume takes. It is possible for the plume to travel upwind for some 
period of time.  

Vertical Angle of Hole 
Enter the vertical angle (in degrees) that your line of sight would make 
with the horizon if you were inside the tank looking out through the hole.  
A hole that is parallel to the horizon has a value of 0 (zero). 
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For example, if you are looking straight up, the value is 90.  If you are 
looking straight down, the value is -90.  The vertical angle of the hole can 
effect the plume rise of a gas release.  An entry is required.  

Height of Hole From Container Bottom 
Enter the height of the hole from the bottom of the container.  The units 
are inches, feet, centimeters, or meters.  The hole height is used to 
determine when the liquid release may stop and the pressurized gas 
release begin.  It is also used to determine the amount of liquid that can 
be left in the tank for boil-off at a later time.  

 

Liquid Pool Surface Height Above Ground 
Enter the height above ground of the liquid-air interface.  The units are 
feet or meters.  Normally a released liquid falls to the ground. 

 

489



Main CHARM Input Window   

 

145

Connecting Pipe 
If the release occurs within piping connected to a vessel, CHARM will 
account for the piping and any piping system components in the release 
calculation.  Entries for the pipe length, diameter, relative roughness 
factor, and components will affect the flow rate due to pressure loss 
characteristics of the pipe, and therefore affect the release rate calculated 
by CHARM. 

Connecting Pipe Length 
When specifying the pipe length, include all piping and piping 
components that describe the connecting pipe from the source vessel to 
the release point. 

 

Connecting Pipe Diameter 
When specifying the pipe diameter, CHARM will assume the diameter is 
uniform throughout the length of the pipe; that is, multiple piping 
components with varying diameters is not considered. 

 

Relative Roughness Factor (e/D) (0-1) 

Relative Roughness Factor (e/D) (0-1) 
The Relative Roughness Factor (e/D) is a measure of the resistance to 
flow by friction from the interior surface of the cylindrical pipe where the 
Roughness Factor e is a function of the piping material, and D is the 
diameter of the pipe.  Some examples of the Roughness Factor e  are 
given below. 
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Material           Roughness Factor e(mm) 

Drawn Tubing 0.0015 

Commercial Steel or Wrought Iron 0.045 

Asphalted Cast Iron 0.12 

Galvanized Iron 0.15 

Cast Iron 0.26 

Wood Stave 0.3 

Concrete 0.9 

Riveted Steel 3 

NOTE: Remember, the above Roughness Factors (e) must be divided by the 
diameter of the pipe to determine the Relative Roughness Factor. 

 

Piping System Components 
CHARM allows the user to specify any number of typical components 
within the piping system between the source vessel and the release point.  
These entries will affect flow rate due to pressure loss characteristics of 
the pipe, and therefore affect the release rate calculated by CHARM. 

Example diagrams of each component type identified by CHARM are 
shown below: 

Piping System Components 

CHARM allows the user to specify any number of typical components 
within the piping system between the source vessel and the release point.  
This entry will affect flow rate due to pressure loss characteristics of the 
pipe, and therefore affect the release rate calculated by CHARM. 

491



Main CHARM Input Window   

 

147

Example diagrams of each component type identified by CHARM are 
shown below. 

 

 
 

Globe Valve (100% Open) Gate Valve (50% Open) 

 

 

 

 

90° Elbow 45° Elbow 

  

Tee Elbow-entering stem Tee Elbow-entering side 

  

Tee Straight Through Flush Pipe-Vessel Connection 
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Borda Pipe-Vessel Connection Round Pipe-Vessel Connection 

 

User-Specified Release Description Input 
If User-Specified After-Release Conditions is selected as the release type, 
CHARM requires additional release information. The following 
information is required for a user-specified release type. 

User-Specified Release Type 
An instantaneous release requires you to specify the total amount of 
material emitted.  A continuous release requires you to specify an initial 
emission rate and whether the rate is constant or decreasing.  A 
decreasing continuous release rate can be exponential or linear. 

 

Selecting User-Specified Rate allows the user to define an emission rate 
schedule.  Enter the time schedule for the emission rate from a source.  
CHARM will use this schedule for the emission for the duration of the 
release.  If release duration is longer than the schedule the last emission 
rate is extended unless it is zero.  Schedule entries can only be added if 
valid numbers are in the entry boxes.  Two times can not both be the 
same.  To delete an entry select it and press “Delete.”  To change an 
entry select it and press “Change.” 

When done changing press “Save Change.” “Clear” deletes all entries. 
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Emission Rate 
Enter the mass rate of emission of the species alone or the volume 
emission rate, which includes the species, air, and water vapor being 
emitted.  The units are pounds per hour, grams per second, standard 
cubic feet per minute, standard cubic meters per second, cubic feet per 
minute, or cubic meters per second.   

 

If you leave the Emission Rate field blank, and enter values for the 
Vertical Puff Speed and the Molar Air Fraction fields, CHARM will 
calculate the emission rate. 

Release Time 
For a constant or linearly decreasing release, the release time is the 
amount of time that lapsed during the release.  For an exponentially 
decreasing release, the release time represents the amount of time before 
the emission rate equals one percent (.01) of the initial emission rate.  
The units are hours, minutes, and seconds. 

494



Main CHARM Input Window   

 

150

 

However, for linearly and exponentially decreasing releases, you should 
enter actual times. 

Puff Temperature 
The puff temperature is the temperature of the initial puff in Fahrenheit, 
Celsius, Rankine, or Kelvin units.  If this field is left blank, CHARM 
assumes the ambient temperature or the boiling point of the selected 
species, whichever is lower. 

 

For an evaporating liquid release, this is the temperature just above the 
liquid pool.  For a gas release, this is the temperature upon leaving the 
container or stack.    

Puff Diameter 
Enter the equivalent circular diameter or area of the puff or stack.  The 
units are inches, feet, centimeters, or meters.  For an evaporating liquid, 
enter the surface area of the liquid pool.  For a gas release, enter the 
diameter of the hole or stack.  
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Puff Depth 
The Puff Depth field can be left blank, and CHARM will calculate a depth 
to ensure mass conservation.  You can enter a value, but the prediction 
may be physically unrealistic.  

 

Puff Is Moving Toward 
Enter the direction of horizontal movement of the initial puff.  The 
direction is determined by release conditions, not by meteorological 
conditions such as wind. 

 

The direction can be entered in degrees or points of the compass.  
Degrees refer to the 360° directional compass, where North is 0 or 360, 
East is 90, South is 180, and West is 270.  Points of the compass refer to 
North (N), East (E), South (S), West (W), and the points between, such as 
Northeast (NE) and South Southeast (SSE).   

If the hole faces directly upward or downward, any value entered for 
the horizontal direction is ignored by CHARM.  For an evaporating 
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liquid pool, the direction of horizontal movement has little meaning, 
because there should be no inherent horizontal movement.  For a gas 
release, the direction should be the same as the direction that the hole or 
stack is facing. 

This entry can be left blank. If it is left blank CHARM will assume the 
puff is moving in the same direction that the wind is blowing toward. 
Note that wind direction is specified as the direction the wind is blowing 
from. This reduces the turbulence that may occur as the release enters 
the atmosphere. Reduced turbulence generally leads to higher 
concentrations reaching further downwind. 

Horizontal Puff Speed 
This field requires a value for the horizontal puff speed in miles per hour, 
knots, meters per second, or kilometers per hour. 

 

For an evaporating liquid pool, the horizontal speed is 0 (zero).  For a gas 
release, it represents the horizontal component of the exit velocity from 
the hole or stack.  If the hole faces directly upward or downward, enter 0 
(zero) for the horizontal speed.  See the following section for instructions 
on obtaining the horizontal speed. 

Obtaining the Horizontal Speed 
To obtain the horizontal speed, use the following procedure: 

1. Complete the entries for the Main CHARM Input Window.  Leave the 
Vertical Puff Speed field blank and enter values for the Molar Air 
Fraction and Emission Rate fields.  CHARM will calculate the 
vertical puff speed. 

2. Find the calculated vertical speed (VERT SPD) in the Main CHARM 
Input Window, and enter this value in the Horizontal Puff Speed 
field in the Main CHARM Input Window. 

3. Enter 0 (zero) for the Vertical Puff Speed field in the same 
window.  
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Vertical Puff Speed 
Enter the speed and direction of the puff.  The number indicates the 
speed.  A positive (+) number indicates an upward direction.  A negative 
(-) number indicates a downward direction. 

 

For an evaporating liquid, the vertical speed is 0 (zero).  For a gas 
release, the vertical speed represents the vertical component of the exit 
velocity from the hole or stack.  For a puff that is directed horizontally, 
the vertical speed is 0 (zero).   

If you leave this field blank and enter values for the Molar Air Fraction 
and Emission Rate fields, CHARM will calculate the Vertical Puff 
Speed.  Also, the user must specify the physical state (liquid or vapor) in 
the CHARM Main Input Window.  the state is required to determine 
whether the liquid or vapor density should be used in the calculation.  

Molar Water Vapor Fraction 
Enter the molar fraction of water vapor in the emission.  It should not be 
higher than approximately 0.04, unless you are describing an extremely 
hot, saturated emission. 

 

Molar Air Fraction 
Enter the molar fraction of air in the emission.  This value allows the 
initial concentration of the gas to be calculated.  If you leave this field 
blank and enter values for the Vertical Puff Speed and the Emission 
Rate, CHARM calculates the Molar Air Fraction.  
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Meteorological Data Input 

The lower portion of the Main CHARM Input Window contains the 
meteorological data fields for the current scenario.  Figure 5.2 shows the 
Met Data input fields. 

Relative Humidity 
This field requires the ambient relative humidity in percent.  Acceptable 
values are greater than 0 and less than 99.  

 

Ambient Temperature 
The ambient temperature is the air temperature at the release site.  The 
temperature can be specified in Fahrenheit, Celsius, Rankine, or Kelvin 
units.  If the ambient temperature is higher than the boiling point of the 
material released, the impact may become much greater. 
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Ambient Pressure 
The ambient pressure is the atmospheric pressure at ground level at the 
release site.  The pressure can be entered in atmospheres (atm), pounds 
per square inch, inches of Mercury, millimeters of Mercury, or millibars. 

 

Normal atmospheric pressure at sea level has the following equivalents: 

1 atmosphere (atm); 
14.7 pounds per square inch (psi); 
1013.25 millibars (mb); 
29.92 inches of Mercury (in Hg); and 
760 millimeters of Mercury (mm Hg). 

Cloud Cover 
Specify the amount of cloud cover in tenths of sky coverage.  CHARM will 
use the amount of cloud cover if the user wants CHARM to determine the 
stability class and/or solar radiation. 

 

Stability Class 
Select an atmospheric stability classification (A through F), or enter the 
amount of sunshine.  If you want CHARM to calculate the stability class, 
select the appropriate checkbox and then specify the sunshine.  CHARM 
can also determine the amount of sunshine based on a Solar Radiation 
Worksheet located under the MetFile menu. 
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CHARM calculates the stability classification from the wind speed, cloud 
cover, and amount of sunshine. Sunshine is strong if the skies are clear 
and the sun is at least 60 degrees above the horizon.  A 75% middle-level 
cloud cover reduces strong sunshine to moderate.  Sunshine is slight, if 
the sun is less than 35 degrees above the horizon or a 75% low cloud 
cover exists. 

The atmospheric stability class indicates how much mixing occurs in the 
air.  An unstable condition (such as class A, B, or C) tends to mix the 
plume quickly with the ambient air, thereby reducing concentrations 
quickly.  Conditions are unstable if there is a layer of warm air near the 
ground with cooler air above it.  An unstable condition is promoted by 
bright sun with no cloud cover and low wind.  Unstable conditions rarely 
exist at night. 

Conditions are neutral if there is little or no temperature gradient 
between the lower atmosphere and the upper atmosphere.  A neutral 
condition (such as class D) exists when the sky is overcast. 

A stable condition mixes the plume more slowly and allows higher 
concentrations to reach farther downwind.  Conditions are stable if there 
is a layer of cool air near the ground with warmer air above it.  A stable 
condition (such as class E or F) can exist on a clear night with low wind 
speed. 

For ground releases, an extremely stable condition (such as class F) 
generates the greatest ground-level impacts.  For elevated releases, it is 
not as clear which stability will create the greatest ground-level impacts.  
A stable condition tends to maintain an elevated emission aloft, unless it 
is heavier than air.  However, more unstable conditions allow mixing 
downward to the ground. 
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If an automatic meteorological interface is available and the standard 
deviation of the horizontal wind direction (also known as sigma theta) is 
one of the available data values, it will be used to determine stability 
class.  

Solar Radiation  
Solar radiation is used as a source for heat transfer when calculating the 
evaporation of off a liquid pool.  A worksheet provided in the MetFile 
menu will aid in the estimation of solar radiation. 

 

Inversion Height 
The Inversion Height is the altitude above ground at which a temperature 
inversion makes it difficult or impossible for a plume to traverse 
vertically.  The units are feel, miles, meters, or kilometers.  The inversion 
height is difficult to estimate without some form of measurement above 
the surface.  

 

If a height is specified, a plume is not allowed to pass through it (except 
for a jet).  If the release height is above the inversion, the plume will 
remain above.  If the release height is below the inversion, the plume will 
remain below.  If this field is left blank, no inversion will be assumed. 

Surface Roughness 
Surface roughness is a measure of the interaction between the wind and 
the surface.  It affects wind speed with altitude and thus the amount of 
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mixing that can occur.  The units are inches, feet, centimeters, or 
meters.  If the field is left blank, no surface roughness is assumed and 
the wind is assumed to be constant with height. 

 

The following table shows some examples of surface roughnesses: 

Surface type Roughness 
(cm) 

Smooth mud flats; ice 0.001 
Smooth snow 0.005 
Smooth sea 0.02 
Level desert 0.03 
Snow surface; lawn to 1 cm high 0.1 
Lawn, grass to 60 cm high 4-9 
Fully grown root crops 14 
Parkland, bushes 50 
Large obstacles (suburb, forest) 50-100 

 
Wind Measurement Height 
The wind Measurement Height is the height above ground at which the 
wind speed and direction were measured.  It is used along with surface 
roughness to calculate the wind profile with altitude.  The units are feet 
or meters.  A value is required if a surface roughness has been entered. 

 

 
Winds 
Use this field to describe wind speeds and directions that represent 
the conditions at specific times.  At least one wind pair is required.  If 
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you leave a wind time, direction, or speed blank, that wind will be 
deleted.   

 

Time The time since release in hours and 
minutes, up to 24 hours.   

Direction The direction from which the wind is 
coming.  The direction can be entered 
specifically in degrees or generally in 
points of the compass.  Degrees refer to 
the 360° directional compass, where North 
is 0 or 360, East is 90, South is 180, and 
West is 270.  Points of the compass refer 
to North (N), East (E), South (S), West (W), 
and the points between, such as Northeast 
(NE) and South Southeast (SSE).  

Speed The wind speed in knots (kts), miles per 
hour (mph), meters per second (m/s), or 
kilometers per hour (kph).  

Add Winds  
Use this field to describe additional winds.  You can enter wind speeds 
and their directions representing the conditions at a specific time.  The 
description is the same as described in the previous section.  CHARM 
performs a linear interpolation between wind times to determine a wind 
speed and direction.  Thus there are no instantaneous wind shifts.  If 
you want to model a quick wind shift, you can enter two winds that are 
one minute apart. 
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Chapter 6:  Understanding CHARM Displays 

CHARM provides various text and graphic displays to simulate a release 
from data entered in the Main CHARM Input Window.  All CHARM 
displays are accessible through the Displays menus of the Main CHARM 
Input Window or footprint displays.  The displays available for selection 
depend on the species and release type specified in the current input 
window.  The Options menu provides various options for altering the 
CHARM displays. 

Map displays are available for maps that have been read, defined, and 
stored with the Map Definition command of the CHARM Editor.  CHARM 
superimposes plume, thermal radiation and overpressure displays 
(graphics) on a map display.  If the map display has map or release 
location icons, you can select an icon to display the map or the release 
scenario list.  The cursor is represented with cross hairs instead of an 
arrow on graphic displays.   

Main CHARM Input Window Displays 

The Displays menu of the Main CHARM Input Window permits access to 
a variety of text and graphic displays, some of which require CHARM 
calculations.  The Basemap command displays maps that have been 
predefined using the CHARM Editor (CHARMED).  These maps may 
contain release icons that are associated with prestored data file 
information, whereby CHARM may be used in an emergency response 
mode of operation.  The Site Information, Chemical Data, Chemical 
Response, and Source/Puff Calculation commands invoke text displays.  
The Emission Rate command generates a plot.  The BLEVE Radiation, 
Pool Fire Radiation and Plume, and Mechanical Overpressures 
commands invoke graphic displays.  When selecting the Displays menu 
from the Main CHARM Input Window, the cursor changes momentarily 
to an hourglass while CHARM performs source term calculations.   
During these calculations and before the menu is displayed, CHARM 
decides which types of output are valid for the current input scenario.  
For example, if the chemical being modeled, say Chlorine, does not have 
any flammable characteristics associated with it in the Chemical 
Database, then those options involving thermal radiation output (BLEVE, 
Pool Fire, and Jet Fire) are grayed and cannot be modeled. 

Basemap Display 
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Use the Basemap command on the Displays menu when the Main 
CHARM Input Window is activated to display a new map for use in 
emergency response mode.  All maps used with CHARM must first be 
defined with the Map Definition command of the CHARM editor.  Refer to 
Chapter 4, “Using the CHARM Editor,” for details on defining maps.  
When you select the Basemap command, CHARM displays a selection list 
of map files having the default map file name extension.  Initially, this 
default extension is .MAP.  For more information about changing this 
default map extension, refer to Chapter 3,  “CHARM.INI File Description”.  
When a map is selected, CHARM displays the map and a point of 
reference associated with the cross hair location in the status bar at the 
bottom of the CHARM MDI window. 

When a map is displayed, the menu bar on the CHARM MDI frame 
changes to reflect only those menus that are to be used with the active 
window; in this case, the Basemap Window.  These menu items include a 
file menu to open and close other map files, an options menu to zoom 
and unzoom an area, or display a larger-scaled map, and other standard 
windows menus.  Figure 6.0 shows a sample map from a Basemap 
display. 

 

 

Site Information Display 
The Site Information command on the Displays menu shows a text file 
window created with the CHARM Editor.  The text file contains 
information that is specific to the release site.  It may contain useful 
information such as general response procedures, telephone 
numbers, and evacuation exits.  Site information text can be printed 

Figure 6.0  
Basemap 
Display 
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or copied to the clipboard using the File and Edit menu commands 
respectively.  Figure 6.1 shows sample text for a Site Information display. 

 

Chemical Data Display 
The Chemical Data command on the Displays menu shows a text window 
containing the thermodynamic data and default isopleth concentrations 
stored in the chemical database for the selected species.  Figures 6.2, 
6.3, and 6.4 show the chemical data display for Chlorine.  Chemical data 
can be printed or copied to the clipboard using the File and Edit menu 
commands respectively.  It can be modified using the CHARM Editor. 

 

 

 

Figure 6.1  
Site Informa-
tion Display 

Figure 6.2 
Chemical 
Data Display 
(top) 

Figure 6.3 
Chemical 
Data Display 
(Temperature
Dependent 
Equations) 
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Chemical Response Display 
The Chemical Response command on the Displays menu shows the 
emergency response information stored in the chemical database for the 
selected  species.  Figure 6.5 shows a sample Chemical Response 
display.  Chemical response text can be printed or copied to the 
clipboard using the File and Edit menu commands respectively.  It can 
be modified using the CHARM Editor. 

 

Figure 6.4 
Chemical 
Data Display 
(bottom) 
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Source/Puff Calculation Display 
The Source/Puff Calculation command on the Displays menu shows the 
output of the source term calculation for a CHARM run.  The 
Source/Puff Calculation display can be printed or copied using the File 
and Edit menu commands respectively.  This output contains a detailed 
description of each portion of a release.  The data consists mainly of the 
numbers used to describe the source term, emission out of the container, 
emission of each puff into the atmosphere during the release, etc. 

During calculations, the release is divided into a number of puffs.  The 
display contains, near the end of the display, the data used to describe 
each puff during the release.  You can display the puff descriptions for 
several CHARM runs at the same time.  Figures 6.6 through 6.9 show a 
sample Source/Puff Calculation display. 

 

 

Figure 6.5 
Chemical 
Response 
Display 

Figure 6.6 
Source/Puff 
Description 
Display 
(Liquid 
Release from 
Tank) 
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Using the Source/Puff Calculation for Input 
Information from the Source/Puff Calculation display can be used as 
input for a user-specified after release scenario, which requires a 
complete puff description.  First, using a release type similar to the 

Figure 6.7 
Source/Puff 
Description 
Display 
(Vapor 
Release From 
Tank) 

Figure 6.8 
Source/Puff 
Description 
Display (Pool 
Evaporation) 

Figure 6.9 
Source/Puff 
Description 
Display (Puff 
Description) 
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one you want to define, enter the required data in the input window.  
Next, display or print the Source/Puff Calculation.  Then, using the 
User-Specified After-Release Conditions release type, perform another 
CHARM run using the data from the Source/Puff Calculation output as 
input.  The data cannot be automatically inserted by the program; they 
must be manually entered into the Main CHARM Input Window.  

Emission Rate Display 
The Emission Rate command on the Displays menu shows a plot of the 
emission rate as a function of time throughout the release.  The Emission 
Rate display can be printed or copied using the File and Edit menu 
commands respectively. 

The Emission Rate is calculated by using values from the input window.  
The maximum emission rate for the release is also specified.  Figure 6.10 
shows a sample Emission Rate display.  If the emission is out of a 
container, CHARM displays only the emission rate of the species into the 
air.  During a liquid release some of the liquid may fall to the ground to 
form a pool.  If a pool is present during the release, its evaporation rate 
will be shown separately from the container emission rate. 

 

 

Thermal Radiation Displays 
BLEVE Radiation, Pool Fire Radiation, and Jet Fire Radiation commands 
on the Displays menu presents three ways to generate thermal radiation 
displays.  A BLEVE Radiation display generates a Single Point Energy 
Flux window as shown in Figure 6.11.  This display shows the footprint 
of thermal radiation due to a fireball/BLEVE.  The thermal radiation 
footprint can be repositioned within the display.   

Since the display is a point source, it can be altered using the 

Figure 6.10 
Emission 
Rate Display 
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Options commands to change the energy flux values and/or the 
distances from the source.  Use the File menu to print the graphics in 
the window or copy visible graphics to the clipboard. 

 

Repositioning the Radiation Footprint 
To change the position of the thermal radiation footprint in the view port, 
press and hold <Ctrl> while you press the appropriate arrow key one or 
more times.  Each time you press an arrow key, the footprint moves one-
sixteenth of the dimension of the display area.  The view port is actually 
the object being moved.  Therefore, if you want to move the footprint 
down, use the <Ctrl-Up arrow> to move the view port up with respect to 
the footprint. 

 

Setting the Energy Flux Values 
To change the energy flux values for the thermal radiation display, select 

Figure 6.11 
Thermal 
Radiation 
Display 
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the Energy Fluxes command on the Options menu.  You can enter up to 
three energy flux values in BTU/hour/square foot or kilowatts/square 
meter.  

 

Setting the Radiation Distances 
To change the thermal radiation distances from the source on the 
display, select the Distances command from the Options menu.  You can 
enter up to three distance values in feet, miles, meters, or kilometers. 

 

Displaying a Radiation Footprint Vertical Cross-Section 
The Vertical X-section command on the Displays menu shows a vertical 
cross-section of the thermal radiation footprint (See Figure 6.12).  The 
maximum vertical extent may differ from the maximum horizontal extent 
if the source is not at ground level.  

 
Figure 6.12 
Thermal 
Radiation 
Vertical X-
Section 
Display 
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Pool Fire and Jet Fire Displays 
The Pool Fire and Jet Fire commands on the Displays menu presents a 
Pool or Jet Fire Energy Flux window as shown in Figure 6.13.  This 
display is the footprint of thermal radiation due to a pool or jet fire.  The 
jet fire footprint can be repositioned within the display.   

Use the File menu to print the graphics in the window or copy visible 
graphics to the clipboard. 
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Plotting Thermal Radiation Versus Time 
To generate a plot of thermal radiation as a function of time at a selected 
point, move the cursor to the desired location.  Then double-click the left 
mouse button or press <Enter>.  The plot shows a time history of the 
thermal radiation at the specified location.  The radiation values are 
determined only once a minute (or once a second if CHARM is operating 
in Minutes-Seconds Mode). 

 

Repositioning a Thermal Radiation Footprint 
To change the position of the thermal radiation footprint in the view port, 
press and hold <Ctrl> while you press the appropriate arrow key one or 
more times.  The footprint is repositioned.  Each time you press an arrow 
key, the footprint moves one-sixteenth of the dimension of the display 
area.  The view port is actually the object being moved.  Therefore, if you 
want to move the footprint down, use <Ctrl-Up arrow> to move the view 
port up with respect to the footprint. 

Figure 6.13 
Jet Fire 
Display 
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Setting the Energy Flux Values 
To set the energy flux values for the pool or jet fire radiation display, 
select the Energy Fluxes command from the Options menu.  You can 
enter up to three energy flux values in BTU/hour/square foot or 
kilowatts/square meter.  

 

Displaying a Thermal Radiation Footprint Cross-Section 
The Vertical X-section command on the Displays menu shows a plot 
representing the vertical cross-section of the thermal radiation footprint.  
The view is along the centerline of the flame as it exits the container. 
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Mechanical Overpressures Display 
The Mechanical Overpressures command on the Displays menu presents 
the Sphere Burst Overpressure window shown in Figure 6.14.  This 
display is a footprint of the overpressures expected from a pressurized 
bursting sphere.  The overpressures footprint can be repositioned within 
the display.   

 

 

Since the display is a point source, it can be altered using the Options 
commands to change the overpressure values and/or the distances from 
the source.  Use the File menu commands to save the release description 

Figure 6.14 
Mechanical 
Over-
pressures 
Display 
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input or met data in separate files, and to print the window.  Use the 
Copy command on the Edit menu to copy the footprint to the clipboard. 

Since the sphere burst is instantaneous, no time plot can be generated.  
However, overpressures due to vapor cloud explosion can be plotted as a 
function of time. 

Repositioning the Overpressures Footprint 
To change the position of the footprint in the view port, press and hold 
<Ctrl> while you press the appropriate arrow key one or more times.  The 
footprint is repositioned.  Each time you press an arrow key, the 
footprint moves one-sixteenth of the dimension of the display area.  The 
view port is actually the object being moved.  Therefore, if you want to 
move the footprint down, use <Ctrl> and the up arrow key to move the 
view port up with respect to the footprint. 

 

Setting the Overpressure Values 
To change the overpressure values for the display, select the 
Overpressures command from the Options menu.  You can enter up to 
three overpressures in pounds per square inch or bars. 

 

518



CHARM Displays   

 

174

Setting the Overpressure Distances 
You can set the overpressure distances from the source for sphere burst 
overpressures display.  To set the distances, select the Distances 
command from the Options menu.  You can enter up to three distance 
values in feet, miles, meters, or kilometers. 

 

Displaying an Overpressures Footprint Vertical Cross-Section 
The Vertical X-section command on the Displays menu presents the 
Vertical Sphere Burst Overpressure window, which is a vertical cross-
section of the overpressures footprint.  The maximum vertical extent may 
differ from the maximum horizontal extent if the sphere is not at ground 
level. 

 

 

Plume Display 
The Plume command on the Displays menu of the Main CHARM Input 
Window presents a Snapshot Plan Plume View display, which is shown in 
Figure 6.15.  This display is an instantaneous view of the plume at a 
specified time.   In Figure 6.15, the display represents a snapshot of the 
plume 15 minutes after the release began. 
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Generating a Plume Display 
To generate a plume display, select the Plume or Pool Fire (Plume) 
command from the Displays menu of the main CHARM Input Window.  
CHARM prompts the user to enter the desired time of the Snapshot Plan 
Plume View in hours and minutes since the release.  This time is used as 
the maximum time plotted for displays such as the Dose Display, 
Integrated Plume View, and Maximum Distance.   

 

After the plot time is entered, a message box appears momentarily while 
CHARM performs the necessary calculations for creating the plume.  
Select the Cancel button to abort the dispersion calculations and return 
to the Main CHARM Input Window.  Select the Stop button to stop the 
dispersion calculation at the next calculated time interval.  For example, 
if the user requested 15 minutes of dispersion calculation, and the user 
opted to press the Stop button before the calculation was complete, 
CHARM would only display dispersion calculations up to, perhaps, 
minute 11. 

Figure 6.15 
Plume 
Display 
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If calculations have been run with the current input for a previous 
display, the are not run again.  Once the calculations have been 
completed or stopped, a plume display is generated similar to the display 
in Figure 6.15. 

As the cross hair cursor is moved across the plume display, the 
concentration, distance, and angle from the source are reported at each 
point in the status bar at the bottom of the display.  The plan plume view 
window does not scroll.  If the legend at the right or bottom of the 
window is not visible, the window can be maximized.  CHARM can show 
more than one plume display at a time. 

Use the File menu commands to save the release description input or the 
met data in separate files, or plot the display to a printer or plotter.  Since 
the Options and Displays menus of the Snapshot Plan Plume View and 
the Integrated Plan Plume View are very similar, these menus are 
discussed in detail in the following section titled "Plan Plume View 
Displays." 

Repositioning the Source 
To reposition the source within the viewport of a plume display, press 
<Ctrl> and the appropriate arrow key.  Each press of an arrow key moves 
the plume one sixteenth of the distance across the area in which the 
plume is displayed.  When you release the arrow key, the screen is 
updated.  

The direction of the selected arrow key is the direction in which the view 
port (solid circle) is moved.  For example, <Ctrl-Up arrow> moves the 
view port up, thereby moving the plume and map display (if any) down.  
When the source is not at the center of the view port, automatic scaling 
is turned off.   
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To reset the position of the source to the center of the view port, use the 
Reset Source command on the Options menu. 

Generating a Dose Display Plot 
The Dose Display shows a plot of the concentration versus time at a 
selected location.  Figure 6.16 shows a sample Dose Display.  The plot is 
initially one of instantaneous concentrations calculated at each minute 
versus time.   

To generate a Dose Display plot, move the cursor to a desired location, 
and double-click the left mouse button or press <Enter>.  You can 
generate dose plots for multiple locations by repeating this procedure. 

The default averaging time is one minute, but the time can be changed 
using the Averaging option on the File menu from the Dose Display plot.   
Use the File and Edit menu commands to print and copy the Dose Display 
respectively.  You can also display the dose information in tabular form 
using the Table command on the File menu. 

Since the concentration at a location is calculated only once a minute, 
short duration releases (single puffs) may not be represented correctly.  
For a point near the source, the maximum concentration of a puff may 
move over the point not on the minute, but perhaps on a half minute.  
The maximum is then lost.  As a puff moves further downwind, it 
spreads out and the problem is reduced.  A single spike display is often 
an indication that this problem occurred. With single puffs or short 
duration releases, it may be better to use the Maximum Concentration 
command on the Displays menu and interpolate the actual maximum 
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concentration at the selected location, or use the Minutes-Seconds mode 
from the Options menu of the Main CHARM Input Window.  

 

 

Generating a Dose Display Table 
To generate a Dose Display table, first generate a Dose Display plot and 
then select the Table command on the File menu.  The Dose Display 
table shown in Figure 6.17 is a tabular time history of the concentration 
at the selected location.  The averaging time for the dose display is the 
number of minutes that are averaged to determine the display.  Since the 
concentrations are calculated at the specified location only once a 
minute, the default is one minute.  To change the averaging time, use the 
Averaging option from the File menu.  

Figure 6.16 
Dose Display 
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Setting the Averaging Time for a Dose Display 
To reset the averaging time, select the Averaging menu from the File 
menu of the Dose Display window, and enter the averaging time in 
minutes from 1 to the present plot time.  The default time is 1 minute.  
The average taken is the running average.  The concentrations at a 
specific point are averaged over time to determine a time-weighted 
average.  For example, if the averaging time is 5 minutes the 
concentration given at time 0 minutes is the average for minutes 0, 1, 2, 
3, and 4.  For minute 1, the average is for minutes 1 through 5.  For 
minute 2 the average is for minutes 2 through 6.  The averages result 
from summing instantaneous minute predictions, not averages over each 
minute.  

 

Figure 6.17 
Dose Display 
Table 
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Plan Plume View Displays 

The plan plume view displays are the Snapshot Plan Plume View (Figure 
6.15) , the Integrated Plan Plume View (Figure 6.30), the Grid Averaged 
Plume View (Figure 6.31), Mechanical/Explosion Overpressure Views 
(Figure 6.35), and the Population Visual Verify (Figure 6.32).  A Snapshot 
Plan Plume View display is an instantaneous view of the plume at a 
specified time. The Plume command on the Displays menu of the Main 
CHARM Input Window generates the snapshot view.  An Integrated Area 
Plan Plume View is a minute by minute calculation of the plume display 
that shows all areas affected by the plume. The Integrated Area 
command on the Displays menu of the Snapshot Plan Plume View 
window generates the integrated plume.  Selecting the Time-Averaged 
Plume command from the Displays menu of the Snapshot Plume 
generates a time-averaged plume based on a user-defined averaging 
interval and a user-defined grid size. The Mechanical Overpressures  
option shows a footprint of the overpressures expected from a 
pressurized bursting sphere.  It is only available if the release type is 
Container/Surface Description.  On the other hand, if flammability 
characteristics are right and concentration levels are sufficient, a plume 
may be ignited from the Explosion Overpressures command on the 
Displays menu from a Snapshot Plume View.  Finally, the user may 
visually verify how a footprint (plume, overpressures, or thermal 
radiation) impact population tracts.  This option is only available after 
the population impacts have been calculated from the Displays menu of 
any type of footprint. 

Use the Options menu on the plan plume views to alter the appearance 
of a display.  The Options menu and the Displays menu of the integrated 
view are similar to those of the snapshot view.  The selections for both 
menus are discussed in the following sections. 

Plume View Options Menu 
The Options menu of the Snapshot Plan Plume View provides selections 
for altering the appearance of the plume display, showing a new map, 
setting and resetting the source location, and specifying a new release 
time.  The Options menus for the Snapshot Plan Plume View and the 
Integrated Plume View have many of the same selections. 

Isopleths Option (Plume Footprint Display) 
Use the Isopleths command on the Options menu to change the species 
concentrations that are plotted on plume displays and graphs.  Enter the 
isopleths in parts per million or microgram per cubic meter.  At least 
on concentration is required. 
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Overpressures Option (Mechanical/Explosion Overpressures 
Display) 
Use the Overpressures command on the Options menu to change the 
desired overpressures that are plotted on the displays and graphs.  Enter 
the overpressures in psi or bar.  At least one overpressure is required. 

 

Distances Option (Explosion Overpressures Display) 
Enter up to three distances from the source. The units are feet, meters, 
miles, or kilometers. CHARM displays the default values. You can accept 
or change the default values. A value is required for at least one distance. 
CHARM uses the distances to calculate overpressures to create the 
footprint display. 

 

Averaging Time Option (Time-Averaged Footprint Display) 
You may change the averaging time associated with a Time-Averaged 
Footprint.  Enter the averaging time in minutes from 1 to the present 
plot time. The average taken is the running average. The 
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concentrations at a specific point are averaged over time to determine a 
time-weighted average. 

For example, if the averaging time is 5 minutes, the concentration given 
at time 0 minutes is the average for minutes 0, 1, 2, 3, and 4. For minute 
1, the average is for minutes 1 through 5. For minute 2 the average is for 
minutes 2 through 6. The averages result from summing instantaneous 
minute predictions, not averages over each minute. 

 

Grid Size Option (Time-Averaged Footprint Display) 
You may change the grid size associated with a Time-Averaged Footprint.  
Enter the number of points to be used in the grid when generating a 
Time-Averaged Plume.  The grid is 2-dimensional and, therefore, the user 
must enter the number of points in the X direction (East/West) and the Y 
direction (North/South). 

 

Show Grid Option (Time-Averaged Footprint Display) 
This option simply turns on or off the currently defined grid for a Time-
Averaged Footprint.  A check mark by the option indicates the grid is 
shown, while no check mark indicates that the grid is not shown. 

Grid Display Option (Time-Averaged Footprint Display) 
If the Show Grid option is on, this option displays the user-defined 
grid for the Time-Averaged Plume as a series of points or a wire mesh, 
whichever submenu item is selected.  A check by the menu item 
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indicates this option is turned on, whereas no check by the menu item 
indicates the option is not active and the grid points are not visible. 

Text Size Option (Population Impact Visual Verify Display) 
From the Population View, the user may adjust the size of the text 
describing the population number for each tract.  Increasing the number 
enlarges the current size of the text, and decreasing the number reduces 
the current size of the text.  Each population tract is described by two 
numbers, one on top of the other.  The top number is usually lower if any 
type of impact was encountered in the tract.  This number indicates the 
number of people impacted in the tract.  The lower number is the total 
number of people located in that particular tract. 

 

Line Width Option (Population Impact Visual Verify Display) 
From the Population View, the user may adjust the line width describing 
the population tracts.  This is helpful when differentiating the population 
tracts from lines drawn by overlaying maps.  Increasing the number 
enlarges the current line width, and decreasing the number reduces the 
current size of the line width. 

 

Monochrome Option (3D Plume Display) 
Use this option in the 3D Plume Display to remove the color from the 
concentration being viewed.  This menu item is switched either on or off.  
A check mark beside the menu item indicates that no color is used with 
the plume and no check mark indicates the plume is filled with color. 

Scale Radius Option (Any Footprint Display) 
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Use the Scale Radius command on the Options menu to change the 
radius of the view port (solid circle) on the plume display.  A scale change 
alters the overall display area.  Enter the radius of the view port in feet, 
miles, kilometers, or meters.  A value greater than 0 (zero) must be 
entered.   If you want CHARM to determine the radius of the view port, 
you can specify the scale ratio using the Scale Ratio command on the 
Options menu. 

 

Scale Ratio Option (Any Footprint Display) 
Use the Scale Ratio command on the Options menu to enter a ratio for 
which CHARM will determine the view port radius on the plume display.  
When you set the scale ratio, the plume display will approximate the plot 
that will be sent to the printer/plotter.  The display itself will not be set 
to scale, but the output of a plot sent to the printer/plotter will be scaled.   
Enter the scale ratio of the current plume display.  Assume a 1:scale 
relationship. The center of the plot will be at the center of the view port. 
The total area plotted is determined by the scale specified, not 
necessarily by what is visible on the screen.   

 

Distance Circles (Any Footprint Display) 
To supplement the displays of the plan view, additional circles can be 
drawn within the large circle with tick marks.  Enter the radius 
increment to use. 
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Receptor Height Option (Any Footprint Display) 
Use the Receptor Height command on the Options menu to change the 
height of the display above the ground.  The plan plume view represents 
a horizontal slice through the atmosphere.  Enter the height above 
ground in feet or meters.  This value is used for all calculations and 
displays that require a receptor height.  

 

Transparency Option (Any Footprint Display) 
The Transparency command on the Options menu is a toggle that 
changes the display between a colored, opaque plume and a "ghost" 
plume that is denoted only by concentration hatch marks.  When a map 
and plume are displayed, this feature allows the map areas beneath the 
plume to be seen.  The transparency option was used to create the plume 
figures shown in this chapter. 

No Hatch Option (Any Footprint Display) 
Use the No Hatch command to remove the hatch marks from the legend 
and the footprint so that only color may be seen.   The command is 
merely a switch.  A checkmark next to the command indicates that No 
Hatch is active.   Alternatively, no checkmark by the command indicates 
the No Hatch is inactive. 

NOTE: The No Hatch command does not work in accordance with the 
Transparency command selected. 
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Use Auto Scale Option (Any Footprint Display) 
Use Auto Scale command works in accordance with selecting an option 
(e.g. New Time, Receptor Height, etc.) for generating a new display.  If the 
Use Auto Scale command is checked and active, then CHARM will 
automatically rescale the current display so that the resulting footprint is 
completely described in the viewport (i.e. large circle).  On the other 
hand, if the Use Auto Scale command is unchecked and inactive, then 
the resulting display will remain at the current scale just before the user 
requests a option for display. 

Decay Option (Plume Footprint Display) 
Use the Decay command on the Options menu to specify the time (half-
life) required for half of the emitted material to decay into neutral 
products.  This option simulates the decay of the material in the air.  
Enter the decay time in hours, minutes, or seconds.  Any previous 
windows produced for the current scenario are not updated with the 
effects of the half-life data, but all subsequent windows are. 

 

If you enter a decay time, the downwind concentrations will be 
decreased.   

NOTE:  Use this option with caution, because the predicted concentrations 
will be lower than they would be with no decay.  

Map Option (Any Footprint Display) 
The Map command on the Options menu opens a dialog box in which 
you can select a map for display.  Any maps that have been edited with 
the CHARM Editor and stored with the default .MAP file name extension 
are displayed.  The default map name is BASEMAP.MAP.  Select the 
name of the map to display.  For more information on map displays, see 
the section of this chapter titled "Map Displays." 
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No Map Option (Any Footprint Display) 
The No Map command on the Options menu quickly and easily removes 
the current map from the display when selected. 

Location Option (Any Footprint Display) 
Use the Location command on the Options menu to relocate the source 
of the release on the current map.  This option displays the map on a 
separate screen where the source location can be changed. 

 

To change the source location, first select the new location on the map 
display.  If you are using a mouse, move the cursor to the new location 
and double-click the left mouse button.  With a mouse, you can achieve 
the same result by selecting the Define Point option in the Define menu, 
moving the cursor to the new location, and then clicking the left mouse 
button.  If you are using the keyboard, select the Define Point option in 
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the Define menu of the map display, move the cursor to the new location 
by holding down <Shift> while pressing the arrow keys, and then press 
<Enter>. 

To scroll the map display with a mouse, use the scroll bars.  To scroll the 
map with the keyboard, use <Page Up> or <Page Down>. 

Map Description (Any Footprint Display) 
Selecting this option allows the user to view pertinent information 
describing the currently displayed map.  This text is defined in the Map 
Definition Editor within CHARMED.  For more information, refer to “Map 
Description” in Chapter 3. 

 

Reset Source Option (Any Footprint Display) 
If the plume has been repositioned within the view port, the Reset Source 
command on the Options menu resets the position of the source to the 
center of the view port. 

Auto Map Change Option (Any Footprint Display) 
Use the Auto Map Change command on the Options menu to enable 
CHARM to automatically display a larger-scaled map when the scale of 
the current map display is not large enough to cover a significant portion 
of the plot area (defined by the Auto Map Fraction command).  In order 
for CHARM to identify and automatically display a larger-scaled map, the 
map must be edited with the CHARM Editor and assigned an Expand 
Map Name.  The Auto Map Change command is a toggle. 

Auto Map Fraction Option (Any Footprint Display) 
Use the Auto Map Fraction command to define the fraction of the 
footprint display area which must be covered by a map to preclude 
CHARM from trying to go to a larger scale map.  The rectangular area 
used for comparison is the area in which the viewport circle is inscribed.  
If the current map covers less than the Auto Map Fraction of the 
rectangular area, CHARM will try to go to the larger scale map defined for 
the map.  The value must be between 0.05 and 0.95.  The default is 
0.25.   
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Larger Scale Map Option (Any Footprint Display) 
Use the Larger Scale Map command on the Options menu to display a 
larger-scaled map when the scale of the current map display does not 
cover a significant portion of the plot area.  The larger-scaled map must 
be edited with the CHARM Editor.   

New Time Option 
Use the New Time command on the Options menu to change the time 
since release for the Plan Plume View.  If the requested time has already 
been calculated, the display is immediately updated.  This dialog box is 
also requested when first generating the plume or footprint from the 
Plume command of the Main CHARM Input Window. 

 

Time Circles Option (Any Concentration Footprint Display) 
The Time Circles command on the Options menu draws dashed circles 
around the source, the radii of which are determined by the time 
specified in the dialog box.  Time circles indicate the locations to which 
the current wind speed can move a parcel of air from the source in the 
number of minutes specified.  

 

Enter the time in minutes.  A time greater than 0 (zero) is required to 
display time circles.  If you enter 0 or leave the field blank, CHARM 
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does not display time circles.  Figure 6.18 shows a sample Time Circles 
display. 

 

The wind speed at the release site, current height, and the time of the 
Snapshot Plan Plume View are used to determine the radii of the circles.  
Spatial and temporal variations of the wind speed are not used.  As the 
wind speed changes, the radii change.  Wind speed changes with time 
also affect the radii of time circles. 

Create ASCII File Option (Any Footprint Display) 
Create ASCII File command on the Options menu enables the user to 
generate a file to hold a description of a footprint that can be transferred 
to other programs.  CHARM requests the name of the file through a 
standard windows Save As dialog box.  Select the drive, the directory, 
and the file name to store the text file.  The default ASCII file extension 
(.PLM) is defined by the AsciiExt variable in CHARM.INI. 

 

Figure 6.18 
Time Circles 
Display 
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This option was designed to be used with the other programs, such as 
Computer Aided Design software (CAD), which should have options to 
import the data. 

ASCII File Format 
The ASCII file contains the real world coordinated (in meters from source) 
of the currently displayed footprint.  The file contains what is envisioned 
as the minimum required for the general case.  The points given 
describing the location of an isopleth are not necessarily close enough to 
give a smooth display of an isopleth. 

RECORD VARIABLES MEANING FORTRAN 
FORMAT 

1  
HRO 
MINSO 
SECO 

Time of release: 
hours 
minutes 
seconds 

315 

2  
HRP 
MINP 
SECP 

Time of plot: hours 
minutes 
seconds 

 

3 HEIGHT Height above 
ground of plot 
(meters) 

E15.4 

4 NCON 
 
 
IUNITS 
 
ITYPE 

Number of isopleth 
values following; 
Units of isopleths; 
Type of calculation 

315 

5 CONV (1 TO 
NCON) 

Isopleth values 3E15.4 

In the above if IUNITS is 0 or mission the isopleth values are in ppm.  If 
IUNITS is 1, the isopleths are in kilowatts per square meter (thermal 
radiation). If IUNITS is 2 the isopleths are in pounds per square inch 
(overpressures). 

The type of calculation indicated how the isopleths were generated: 

ITYPE Source 
1 Snapshot Plume concentration. 
2 Pool fire or BLEVE radiation. 
3 Thermal Radiation. 
4 Overpressures from a failure of a pressurized 

vessel. 
5 Overpressures from a vapor cloud explosion. 
6 Integrated Plume concentration. 
7 Time-Averaged Plume 
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These first five records will be followed by NCON groups of records.  Each 
group will consist of: first, a record containing the number of isopleths 
for one of the CONV values (NISO, format I5), followed by up to three 
subgroups of records.  Each subgroup will have the following format: 

 
SUB-
GROUP 
RECORD 

 
VARIABLES 

 
MEANING 

FORTRAN 
FORMAT 

1 NPTS Number of X/Y 
pairs following 

15 

2 - NPTS+1 X,Y,R Points 
describing an 
isopleth; 
R is always 0. 
R is never used 
and is only 
present for 
backward 
compatibility. 

 

 

An example of records 6 and onward may help.  Assume NCON is three 
and that the three isopleths following are 1, 10, and 100 ppm.  Further 
assume there are two distinct and separate isopleths for the 100 ppm 
concentration.  This can happen if the emission rate has varied over 
time.  The other concentrations will be assumed to only have a single 
isopleth each. 

 
Record Value 
7 1 (only one isopleth for 1 ppm 

conc.) 
8 NPTS1 
9 to 8 + NPTS1 NPTS1 pairs of X/Y points 

describing 1 ppm isopleth 
9 + NPTS1 1 (one isopleth for 10 ppm 

conc). 
10 + NPTS1 NPTS10 
11 + NPTS1 to NPTS10 points pairs describing 

10 ppm 
10 + NPTS1 + 
NPTS10 

isopleth 

11 + NPTS1 
+NPTS10  

2(two isopleths for 100 ppm 
conc.) 

12 + NPTS1 + NPTS100A 

537



CHARM Displays   

 

193

NPTS10 
... NPTS100A  point pairs for first 

100 ppm isopleth 
... NPTS100B 
... NPTS100B point pairs for 

second 100 ppm isopleth 
Minimum and maximum numbers that can be expected for each of the 
variables which may dictate the use of arrays are: 

• NCON (1 to 3) 
• NISO (0 to 3) 
• NPTS (unlimited) 
 

Transferring Footprints via DDE to other Windows Programs 
A (Dynamic Data Exchange) DDE interface is available to send a footprint 
of impact (concentration, thermal radiation, or overpressure) data in a 
real-time manner to other Windows programs while CHARM is running.  
To set up the DDE a client program must initialize a conversation with 
the server, CHARM.  The following values are needed to set up the 
communication. 
 
Server Name: CHARM 
 
Topic: EISI 
 
Item: PLUME_CHARM 
 
CHARM only performs Advise services (use XTYP_ADVSTART).  After a 
conversation has been established, whenever a plan view is created or 
changed it will be sent out to all clients.  Changing receptor heights, 
isopleth values, time, etc. change the plume.  The block of data sent out 
is identical to creating an ASCIIFile except that a line is added to the 
beginning of the block.  This first line is to be used as a scenario 
indicator.  The first line is to be used as a scenario indicator.  The first 
line will look like: 
   
  CHXXXXXX 
 
where XXXXXX is a six digit number from 0 on up (leading 0s are used).  
Every data block sent with the same first line where created from the 
same input.  This is actually only true if CHARM is not stopped and the 
re-started.  Whenever CHARM begins the value of XXXXXX starts at 0.  If 
the value of CHXXXXXX is identical to that in a previous data block and 
ITYPEs are the same the new data block is an update to the previous 
footprint (possibly at a new time, height, etc.). 
 

Create Shape File Option (Any Footprint Display) 
This command enables the user to generate a file that describes a 
footprint of impact (concentration, thermal radiation, or overpressure) 
which can be transferred to ArcView for display.  Whenever a plan 
view of an impact is displayed, this option becomes available on the 
Options menu.  The default shape file extension (.SHP)  is defined by 
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the ShapeFileExt variable in CHARM.INI.  It is set to SHP and should not 
be changed since ArcView expects that extension. 

 

An ArcView shape file is actually three files: the main file, an index file, 
and a dBase file with attributes.  These three files all have the same 
names and locations except for their extensions.  The main file extension 
is .SHP. The index file extension is .SHX.  The dBase file extension is 
.DBF. 

The main file contains the real world coordinates (in meters from source) 
of the currently displayed footprint. The file contains what is envisioned 
as the minimum required for the general case. The points given 
describing the location of an isopleth are not necessarily close enough to 
give a smooth display of an isopleth.  The index file has pointers to the 
footprints in the main file so that ArcView can find the data properly.  
The dBase file has the following attributes for each isopleth of the 
footprint: REL_TIME, PLOT_TIME, X_SRC, Y_SRC, HEIGHT, 
CONT_VALUE, UNITS, and SOURCE. 

REL_TIME is the time of release.  Usually 00:00 except for emergency 
response.  Then it is clocktime of release. 

PLOT_TIME is the display time which is given as time since release. 

X_SRC, Y_SRC define the location of the source in meters.  The footprints 
vertices are given in meters from the source. 

HEIGHT is the height above ground of the footprint. 

CONT_VALUE is the numeric value defining the isopleth. 

UNITS is a flag for the units of CONT_VALUE 

539



CHARM Displays   

 

195

If UNITS is 0 the isopleth values are in ppm. If UNITS is 1, the isopleths 
are in kilowatts per square meter (thermal radiation). If UNITS is 2 the 
isopleths are in pounds per square inch (overpressures). 

The type of calculation used to generate the isopleths is indicated by the 
SOURCE attribute: 

SOURCE Source 

1 Snapshot Plume concentration. 
2 Pool fire or BLEVE radiation. 
3 Jet fire radiation. 
4 Overpressures from a failure of a pressurized vessel. 
5 Overpressures from a vapor cloud explosion. 
6 Integrated Plume concentration. 
7 Time-Averaged Plume 
 

Plume View Displays Menu 
The Displays menu of the Snapshot Plan Plume View window provides 
selections for plotting maximum distances, vertical cross-sections, 
centerline concentrations, explosion overpressures, population impacts, 
Time-Averaged plumes, and integrated area plumes.  CHARM also 
creates table displays for maximum distances and concentrations.  Met 
data, release data, puff description, and emission rate displays are also 
available from the plan plume view.    

The Displays menu of the other Plan Displays have selections that are 
similar to the snapshot plume displays menu. The Displays menu for an 
integrated plume does not provide a vertical cross-section, centerline 
concentration, or meteorological data.  The integrated plume has 
additional menu selections for recalculating a plume or continuing the 
current calculation. 

Maximum Distance Display 
The Maximum Distance command on the Displays menu plots the 
maximum distance downwind of the specified concentration as a 
function of time. 
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Enter the concentration in parts per million or micrograms per cubic 
meter.  The time interval for the plot depends on the time specified for 
the current Snapshot Plan View Plume view display.   Figure 6.19 shows 
a sample Maximum Distance Plot. 

 

Use the Copy command from the Edit menu to copy the contents of the 
window to the clipboard.  Use the File menu commands to print the 
Maximum Distance plot, or display the maximum distance information in 
the form of a table. 

Maximum Distance Table   
To display the maximum distance information in tabular form, first 
display the Maximum Distance plot and then select the Table command 
from the File menu.  The table shows the distance downwind that a 
concentration has reached as a function of time.  The distance is 
reported in feet, miles, meters, and kilometers for each minute since the 
release time specified for the plume.  Figure 6.20 shows a sample 

Figure 6.19 
Maximum 
Distance Plot 
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Maximum Distance table. 

 

Maximum Width Display 
The Maximum Width command on the Displays menu plots maximum 
crosswind width of a user-specified concentration as a function of time. 

 

Enter the concentration in parts per million or micrograms per cubic 
meter.  The time interval for the plot depends on the time specified for 
the current Snapshot Plan View Plume view display.  Figure 6.21 shows 
a sample Maximum Width Plot. 

 

Figure 6.20 
Maximum 
Distance 
Table 

Figure 6.21 
Maximum 
Distance 
Table 
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Use the Copy command from the Edit menu to copy the contents of the 
window to the clipboard.  Use the File menu commands to print the 
Maximum Width plot, or display the maximum width information in the 
form of a table. 

Maximum Width Table 
To display the maximum width information in tabular form, first display 
the Maximum Width plot and then select the Table command from the 
File menu.  The table shows the crosswind width of a user specified 
concentration as a function of time.  The distance is reported in feet, 
miles, meters, and kilometers for each minute since the release time 
specified for the plume.  Figure 6.22 shows a sample Maximum Width 
table. 
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Maximum Concentration Display 
Use the Maximum Concentration command on the Displays menu to 
enter a minimum distance from the release source beyond which CHARM 
will tabulate and display all maximum concentrations as a function of 
time. 

 

Enter the distance in feet, miles, meters, or kilometers.  Figure 6.23 
shows a sample Maximum Concentration Table.  Use the File menu 
commands to print or copy the table. 

Figure 6.22 
Maximum 
Width Table 
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The table shows the maximum concentration of the species in parts per 
million and micrograms per cubic meter as a function of time.  A 
maximum concentration is calculated for every minute since release.  
The X and Y locations and the downwind distance of the maximum 
concentrations are also reported.  Use the File and Edit menu commands 
to print or copy the Maximum Distance table respectively. 

Vertical Cross-Section 
The Vertical X-section command on the Displays menu plots a vertical 
cross-section through the middle of the plume.  The view is from the 
source through the middle of the first puff released.  Since this display 
involves one of the longest calculations in the model, it may take some 
time before the cross-section is displayed.  Figure 6.24 shows a sample 
Vertical Cross-Section display.  Use the File menu commands to print, 
plot, or copy the cross-section display.  The Monochrome command on 
the File menu creates a colorless vertical cross-section whose isopleth 
concentrations can be printed or plotted. 

Figure 6.23 
Maximum 
Concentra-
tion Table 
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Centerline Concentrations Display 
The Centerline Concentrations command on the Displays menu plots the 
concentrations down the centerline of the plume as a function of 
distance.  The concentrations are listed for the specified height and may 
not include the maximum concentration. 

 

Enter the beginning and ending points of the line to lie along the 
centerline of the plume.  You can also specify the concentration interval 
by which to show  concentrations along the centerline.  Figure 6.25 
shows a sample Centerline Concentrations display.  Use the File and Edit 
menu commands to print or copy the display respectively. 

 

Figure 6.24 
Vertical 
Cross-Section 
Display 

Figure 6.25 
Centerline 
Concentra-
tion Plot 
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To display a centerline concentration table instead of a graph, select the 
Table command from the File Menu.  To plot the log concentration 
instead of the actual value check the Log Plot option in the dialog box 
that contains the line and interval information.  Figure 6.26 shows a 
sample Centerline Concentrations Table.  Use the File and Edit menu 
commands to print, or copy the display respectively. 
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If the concentrations are expected to vary over orders of magnitude, a 
centerline concentration table of values or log plot for the actual 
concentrations may be more informative than a linear graph.   The 
centerline concentration table lists the concentrations (parts per million 
and micrograms per cubic meter) down the centerline of the plume as a 
function of distance (feet or meters).  The table lists the X and Y 
positions, the distance from the source, and the concentration at each 
point.  A positive X value indicates East and a negative X value indicates 
West.  Similarly, a positive Y value indicates North a negative Y value 
indicates South.  The concentration units are parts per million and 
micrograms per cubic meter.  The concentrations are listed for the 
specified receptor height and do not necessarily include the maximum 
concentration.  

Plume Half-Widths Display 
The Plume Half-Widths command on the Displays menu determines the 
crosswind half-width down the centerline of plume as a function of 
concentration.  The user will be prompted for the downwind spacing of 
the points along the centerline for the half-width calculations. 

 

Figure 6.26 
Centerline 
Concentra-
tions Table 
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Enter the desired concentration in parts per million or micrograms per 
cubic meter. 

 

Enter the beginning and ending points of the line to lie along the 
centerline of the plume.  Figure 6.27 shows a sample Plume Half-Width 
plot.  Use the File or Edit menu commands to print or copy the graph. 
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To display a plume half-width table instead of a graph, select the Table 
option from the File menu.  Figure 6.28 shows a sample Plume Half-
Width Table.  Use the File and Edit menu commands to print or copy the 
display respectively. 

Figure 6.27 
Plume Half-
Width Plot 
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Met Data Display 
The Met Data command on the Displays menu shows the meteorological 
data at the source location.  The values for the current receptor height 
and the time since release specified for the Snapshot Plan Plume View 
display are used.  Figure 6.29 shows a sample Met Data display.  Use the 
File and Edit menu commands to print or copy the display respectively. 

 

 

Integrated Area Display 
The Integrated Area command on the Displays menu starts a minute by 
minute calculation of the snapshot plume and displays the Integrated 
Plan Plume View.  The integrated plume display shows all areas 

Figure 6.28 
Plume Half-
Width Table 

Figure 6.29 
Met Data 
Display 
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affected by the plume.   

The integrated display looks similar to the Snapshot Plume View and has 
most of the same menus and commands.  Refer to the previous section 
titled "Plan Plume View Displays" for descriptions of the commands on 
the Options and Displays menus. 

The current isopleth concentrations are used for plotting at any time 
during the release and up to the most recent time requested.  The time 
shown on the integrated plume display is the time currently being 
calculated.  The calculation of area impacts are performed for every 
minute of the simulation.  If the changes in the plume are much more 
rapid than every minute, the display may not be a smooth 
representation.  Figure 6.30 shows a sample integrated plume. 

 

 

Since the calculation requires time, you can stop the calculation by 
selecting the Cancel button that appears in the plume window.  A cancel 
takes effect after the latest minute's calculations are complete.  
Therefore, there may be some lag time before you see a cancel response. 

The maximum concentrations at each area are displayed.  If the wind 
shifts or the emission rate varies, the areas impacted can also vary.  
Once an integration calculation has been performed, moving between the 
Snapshot and Integrated Area plumes does not require new time 
calculations. 

To continue the integration using the same time, select the Continue 
menu item from the Options menu.  To create an integrated plume 

Figure 6.30 
Integrated 
Plan Plume 
View 
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using a different time, select the Recalculate menu item from the Options 
menu. 

To generate a Dose Display plot (concentration history) at a specific 
point, move the cursor to the desired location.  Then, double-click the left 
mouse button or press <Enter>. 

To reposition the source within the view port, hold <Ctrl> while you press 
the appropriate arrow key one or more times. When you release <Ctrl>, 
the plume is repositioned.  Each time you press an arrow key, the plume 
moves one-sixteenth of the dimension of the display area.   

Use the File menu commands to save the release description input or 
met data in separate files, print the window, or plot the plume.  Use the 
Copy command on the Edit menu to copy the display to the clipboard. 

Time-Averaged Footprint 
The Time-Averaged Footprint command on the Displays menu shows a 
view of averaged concentrations at the specified time. The plume is a 
result of the source term and transport/dispersion calculations averaged 
over a user-specified time within a user-defined grid (see Averaging Time 
and Grid Resolution). The isopleth concentrations are represented by 
differing hatch marks and colors.  The user has the option of selecting 
the entire plume for averaging or a user-defined area of the plume for 
averaging. 
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Selected Area of a Time-Averaged Footprint  
Selecting the Selected Area submenu on the Time-Averaged Footprint 
command of the Displays menu changes the cursor to a magnifying glass 
and requires the user to draw a rubberband box around the area of 
interest.  To do this, find a point on the plume display, click and hold 
down the left mouse button, drag the mouse to create a rubberband box, 
and then release the left mouse button.  CHARM will only consider those 
concentrations within the extents of the rubberband box for averaging. 
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Averaging Time and Grid Resolution for a Time-Averaged 
Footprint 
Selecting the Entire Plume Area or Select Area command from the Time-
Averaged Footprint command requires the user to input the desired 
averaging time and the desired grid size. 

 

The resulting display is a Time-Averaged plume based on this user-
defined averaging interval and the user-defined grid size.  See Figure 
6.31 for example output of a Grid Averaged Plume. 

 

 

Circular Population Impact 
This command calculates the number of people affected by the listed 
concentrations, radiation fluxes, or overpressures within a user-

Figure 6.31 
Grid 
Averaged 
Plume View 
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specified radius from the source.  The user is initially prompted for the 
desired radius.   

 

The number of people is normally determined from the population 
information available on US Census Bureau Tiger/Line™ 1992 Data. 

If a population number is enclosed in brackets, that means that a failure 
occurred during calculation and the number given is a lower limit of the 
number of people impacted.  This calculation failure occurs when 
CHARM can not resolve the intersection between the plume outline and a 
population tract.  Often, however, it can be alleviated by changing the 
source location minutely.  If the population number is -1 this indicates 
that only one population tract was impacted but an error was 
encountered. 

The resulting display is independent of the footprint and only described 
by the population impacts within the user-specified radius from the 
source. 

 

Visual Verify (Population Impact) 
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From a Population Impact display, use the Visual Verify command on the 
Displays menu to illustrate overlaying the radius or footprint on to the 
population tracts that have been preprocessed in the TigerMap Utility 
and defined in the CHARM Editor (see Figure 6.32). 

 

 

Population Impact 
Use the Population Impact command to calculate the number of people 
affected by the listed concentrations, thermal radiation, or overpressures.  
The number of people is normally determined from the population 
information available on U.S. Census Bureau Tiger/LineTM 1992 Data 
(see CHAPTER 8: Using the TIGERMAP Utility). 

If a population number is enclosed in brackets, that means that a failure 
occurred during calculation and the calculated value is a conservative 
estimate of the number of people impacted.  If the population is -1 then 
this indicates that only one population tract was impacted but a failure 
in the calculation was encountered.  This failure occurs when CHARM 
can not resolve the intersection between the plume outline and a 
population tract.  Often, however, the failure can be alleviated by slightly 
changing the source location.  CHARM breaks down the impacted 
population by age, race, families, households, owners, and renters.  
Figure 6.33 show the results of a population calculation impact. 

 

Figure 6.32 
Population 
Visual Verify 
View 

Figure 6.33 
Population 
Impact 
Display 
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The method of calculation can be changed be selecting the Population 
Calculation command from the Displays menu.  Likewise, you can 
visually verify overlaying the footprint on to the population tracts that 
were preprocessed in the TigerMap Utility and defined in the CHARM 
Editor. 

Population Calculation 
The method of calculating the population impacts can be selected from 
the Population Calculation command from the Displays menu.  There are 
three methods of calculation. 

 

I. Actual footprint and population tract boundaries used 
Both the footprint and population tract boundaries will be used in the 
calculation.  The calculated area of impact is the intersection of the 
footprint and the tract.  This is the most accurate method.  It can take 
the longest time and is the most prone to a failure in the calculation to 
determine intersection between the plume outline and the population 
tracts. 
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II. Footprint rectangle and actual population tract boundaries 
used 
The footprint is represented as its bounding rectangle.  The tract 
boundary is used as determined from the Tiger/LineTM data.  The 
calculated area of impact is the intersection of the footprint rectangle and 
the tract.  This is the second most accurate method.  It is designed to 
take less calculation time than the actual plume boundary being used.  
However, this is not always the case.  It can also produce a failure in the 
calculation when determining the intersection between the rectangle 
inscribing the footprint and the population tract. 

III. Footprint and population tract rectangles used 
Both the footprint and population tract are represented by their 
bounding rectangles.  The calculated area of impact is the intersection of 
the footprint and tract rectangles.  This is the least accurate method.  It 
is the fastest calculation for determining population impacts and will 
never fail when determining the intersection between the rectangle 
inscribing the footprint and the rectangles inscribing the population 
tracts. 

To invoke the selected population calculation method, select Population 
Impacts command in the Displays menu. 

Explosion Overpressures Display 
The initial step in generating an explosion overpressure display is to first 
generate a plume containing sufficient lower explosive concentration 
limits to allow for deflagration or detonation of the plume.  Deflagration 
occurs when the flame speed is slower than mach 1.  Detonation occurs 
when flame speed is mach 1 or greater. 

Displaying Explosion Overpressures 
Once a plume has been generated, selecting the Explosion Overpressures 
command on the Displays menu of the Snapshot Plan Plume View 
window shows the overpressure footprint resulting from ignition at the 
specified release time.  It is an instantaneous view.   Figure 6.34 
illustrates a propane plume calculated by CHARM.  Figure 6.35 shows 
the explosion overpressures resulting from the ignition of the plume. 

 
Figure 6.34  
Plume View 
prior to 
Ignition 

559



CHARM Displays   

 

215

 
 
 

 

 

Changing Potential Overpressures 
This command is similar to modifying the isopleths from a Snaphot Plan 
Plume Display.   However, in this case, the user has the option of 
modifying those potential overpressures which are displayed from the 
resulting explosion.  Select Overpressures from the Options menu and 
the following dialog box appears. 

Figure 6.35   
Explosion 
Overpressure 
after Ignition 
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Changing Flame Speed 
This command allows the user to use the default flame speed defined in 
the chemical database, modify that flame speed, or specify explosion 
characteristics from a table by specifying the Expansion Dimension, 
Mixture Reactivity, and Obstacle Density.  If changes are made, the user 
has the option to reset the flame speed to the default in the chemical 
database. 

 

Plotting Potential Explosion Overpressures Versus Time 
To generate a plot of potential overpressures as a function of time at a 
specific location, move the cursor to the desired location.  Then double-
click the left mouse button or press <Enter>.  An example is illustrated 
in Figure 6.36. 

 
Figure 6.36   
Explosion 
Overpressure 
Potential 
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Maximum Distance Overpressure Display 
From the Explosion Overpressures display, you can display a maximum 
distance for an overpressure as a function of time.  From the Displays 
menu, select Max Distance and CHARM will request a single 
overpressure value and unit for plotting. 

 

Figure 6.37 shows the resulting Maximum Distance Overpressure Plot.  
The plot is also a function of the time calculated since release. 

Figure 6.37   
Maximum 
Distance plot 
for Explosion 
Overpressures 
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Displaying an Explosion Overpressures Footprint Cross-
Section 
From the Explosion Overpressures display, you can display a cross-
section of the potential overpressures by selecting the Vertical X-section 
command from the Displays menu.  Figure 6.38 shows the resulting X-
section. 

 

 
Overpressure Damage Estimates 
The following are the peak pressures formed in excess of normal 
atmospheric pressure by blast and shock waves: 

Figure 6.38   
Vertical 
Xsection of 
Explosion 
Overpressures 
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Overpressure (psi) 
Note:1 bar = 14.5 psi 

 
Expected Damage 

0.03 Occasional breaking of large 
windows already under 
stress. 

0.04 Loud noise (143 dB); sonic 
boom glass failures. 

0.10 Breakage of small windows 
under strain. 

0.15 Typical pressure for glass 
failure. 

0.30 Some damage to house 
ceilings; 10% window glass 
breakage. 

0.40 Limited minor structural 
damage. 

0.50-1.0 Windows usually shattered; 
some window frame damage. 

0.7 Minor damage to house 
structures. 

1.0 Partial Demolition of houses; 
made uninhabitable. 

1.0-2.0 Corrugated metal panels fail 
and buckle.  Housing wood 
panels blown in. 

1.0-8.0 Range for slight to serious 
injuries due to skin 
lacerations from flying glass 
and other missiles. 

1.3 Steel frame of clad building 
slightly distorted. 

2.0 Partial collapse of walls and 
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Overpressure (psi) 
Note:1 bar = 14.5 psi 

 
Expected Damage 

roofs of houses. 

2.0-3.0 Non-reinforced concrete of 
cinder block walls shattered. 

2.3 Lower limit of serious 
structural damage. 

2.4-12.2 Range for 1-90% eardrum 
rupture among exposed 
populations. 

2.5 50% destruction of home 
brickwork. 

3.0 Steel frame building distorted 
and pulled away from 
foundation. 

3.0-4.0 Frameless steel panel 
building ruined. 

4.0 Cladding of light industrial 
buildings ruptured. 

5.0 Wooded utility poles snapped. 

5.0-7.0 Nearly complete destruction 
of houses. 

7.0 Loaded train wagons 
overturned. 

7.0-8.0  8-12 in. thick non-reinforced 
brick fail by shearing of 
flexure. 

9.0 Loaded train box cars 
demolished. 

10.0 Probable total building 
destruction. 

15.5-29.0 Range for 1-99% fatalities 
among exposed populations 
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Overpressure (psi) 
Note:1 bar = 14.5 psi 

 
Expected Damage 

due to direct blast effects. 

Source: Lees, F.P, Loss Prevention in the Process Industries, Vo,. 1, 
Butterworths, London and Boston, 1980. 

Input Display 
The Input command on the Displays menu shows the input data for the 
current CHARM run just as it appears in the Main CHARM Input 
Window.  This display is for viewing only and no changes can be made.  
Use the File menu commands to print or copy the display.  This menu 
item becomes very important when viewing or comparing different sets of 
output for different input parameters.  An Input command under the 
Displays menu of many output displays will yield those input parameters 
used to obtain the given calculations. 

Source/Puff Description Display 
The Source/Puff Description command on the Displays menu shows the 
output of the source term calculation for the current CHARM run.  This 
output contains a detailed description of each portion of a release.  See 
Figures 6.6, 6.7, 6.8, and 6.9 for illustrations of the Source/Puff 
Description output. 

During calculations, the release is divided into a number of puffs.  The 
display includes the data used to describe each puff during the release.  
You can display the puff descriptions for several CHARM runs at the 
same time.  use the File menu commands to print or copy the display. 

Information from the Source/Puff Description display can be used as 
input for a user-specified release scenario, which requires a complete 
puff description.  First, using a release type similar to the one you want 
to define, enter the required data in the input window.  Next, display or 
print the Source/Puff Description.  Then, using the User Specified After-
Release Conditions release type, perform another CHARM run using the 
data from the Source/Puff Description printout as input.  The data 
cannot be automatically inserted by the program; they must be manually 
entered into the Main CHARM Input Window.  

Emission Rate Display 
The Emission Rate command on the Displays menu shows a plot of the 
emission rate as a function of time throughout the release.  The plot 
results from calculations using values from the CHARM run that created 
the current plan plume view.  The Emission Rate display is the same 
as the display shown in the Main CHARM Input Window with the 
command of the same name. (see Figure 6.6 earlier in this chapter).  
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Use the File and Edit menu commands to print or copy the display 
respectively. 

Site Information Display 
The Site Information command on the Displays menu shows a text file 
window created with the CHARM Editor.  The text file contains 
information that is specific to the release site.  It may contain useful 
information such as general response procedures, telephone numbers, 
and evacuation exits.   The Site Information display is the same as the 
display shown in the Main CHARM Input Window (see Figure 6.1 earlier 
in this chapter).  Site information text can be printed or copied to the 
clipboard using the File and Edit menu commands respectively.  

Chemical Data Display 
The Chemical Data command on the Displays menu shows a text window 
containing the thermodynamic data and default isopleth concentrations 
stored in the chemical database for the selected species.  The Chemical 
Data display is the same as the display shown in the Main CHARM Input 
Window with the command of the same name (see Figures 6.2, 6.3, and 
6.4 earlier in this chapter).  Chemical data can be printed or copied to 
the clipboard using the File and Edit menu commands respectively.  It 
can be modified using the CHARM Editor. 

Chemical Response Display 
The Chemical Response command on the Displays menu shows the 
emergency response information stored in the chemical database for the 
selected  species.  The Chemical Response display is the same as the 
display shown in the Main CHARM Input Window with the command of 
the same name (see Figure 6.5 earlier in this chapter).  Chemical 
response text can be printed or copied to the clipboard using the File and 
Edit menu commands respectively.  It can be modified using the CHARM 
Editor. 

Displaying a Map 
The Basemap command on the Displays menu of the Main CHARM Input 
Window offers one way to display a map.  When you select the Basemap 
command, CHARM displays a dialog box in which you can select the map 
to display.  Press F1 or press the ‘Help’ button to display the on-line help 
screen. 

To scroll a map display with a mouse, use the scroll bars.  To scroll a 
map with the keyboard, use <Page Up>, <Page Down>, and arrow keys.   

The Basemap display has menus that provides commands for 
zooming and unzooming a specified area, displaying another map, 

567



CHARM Displays   

 

223

displaying a larger scale map (if one is available), and displaying a map 
description.   

File Menu 
The File menu for a map displayed with the Basemap command of the 
Main CHARM Input Window provides additional commands to those 
provided by the Options menu of the input window.     

The commands available on the File menu for a map display are: 

COMMAND SUMMARY 
Open Displays a selection list of 

maps for display. 

Close Closes the Basemap display 
window. 

Larger Scale 
Map 

Displays a larger-scaled map that 
has been defined with the Map 
Definition command and named with 
the Expand map name command of 
the CHARM Editor. 

Exit Exits CHARM. 
 
Options Menu 
The Options menu for a map displayed with the Basemap command of 
the Main CHARM Input Window provides additional commands to those 
provided by the File menu.     

The commands available on the Options menu for a map display are: 

COMMAND SUMMARY 
Zoom Displays an enlargement of a  

specified map area. 

Unzoom Returns a zoomed map 
display to its original size 
when the window was 
opened. 

Map 
Description 

Displays a text description 
associated with the current map 
display.  This text is for display only 
as it is editable from within the 
CHARM Editor. 
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Zooming a Map Area 
To zoom a portion of a map display, you must mark the area to be 
zoomed.  First, select the Zoom option on the Options menu.  The cursor 
changes from a pointer to a magnifying glass.  Next, move the cursor to 
one corner of the area to be zoomed.  If you are using a mouse, hold the 
left mouse button down, move the cursor to the opposite corner of the 
area to be zoomed, and release the button.   

If you are not using a mouse, press <Enter> to mark the first corner of 
the zoom box, expand the box with the arrow keys, and press <Enter> 
again to complete the zoom box.  The zoom display may not have a one-
to-one correlation to the marked area.  To return to the initial map 
display, select the Unzoom command from the Options menu. 

Displaying a Map From the Plan View Displays 
Plumes, thermal radiation footprints, and overpressure footprints are 
considered plan view displays.  The Map command on the Options menu 
of a plan view offers another way to display a map.   

When the Auto Map Change command on the Options menu is selected, 
and the map display covers less than the fraction  of the display area 
defined by the Auto Map Fraction command, CHARM automatically 
switches to a larger-scaled map (if one is defined).  To turn off this 
feature, deselect Auto Map Change in the Options menu by clicking on it. 

When the Auto Map Change command is not selected, you decide when 
to display the larger-scaled map.  Use the Larger Scale Map command on 
the File menu to manually display the expanded map.  In this case, the 
map must be defined and assigned an expanded map name using the 
CHARMED editor.  Use the Expand Map Name command in the Map 
Definition editor to identify the larger-scaled map.  

Selecting an Icon on a Map 
The map display may show icons that represent other map locations or 
possible release locations.  These icons are positioned and defined with 
the Map Definition command of the CHARM editor.  A map location icon 
looks like boxes within boxes.  

 

A release location icon looks like a plume within a box. 
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Selecting an icon displays another map of the location or a selection list of 
releases at the location.  To select an icon on a map in the Basemap 
display, move the cursor over the icon.  If you are using a mouse, click 
either button.  If you are not using a mouse, press <Enter>.  To select an 
icon on a map in a footprint display, press and hold <Shift> while you 
move the cursor over the icon, and select the icon by double-clicking the 
left mouse button or pressing <Enter>. 

When you select a map location icon, CHARM displays the map that has 
been defined for that location.  This map may also have selectable icons 
representing other maps and releases. 

When you select a release location icon on a map in the Basemap 
display, CHARM checks for automatic meteorological data from the time 
of the release to the present time.  If no met data are available, CHARM 
displays a message that allows you to stop the run.  If the run continues, 
CHARM performs calculations in one of two ways, depending on the 
mode of operation defined by the EmergencyMode variable in the 
CHARM.INI file.  If EmergencyMode = 1 or is not defined, then CHARM 
will display a real-time footprint, updating the display minute by minute.  
If EmergencyMode = 0, CHARM calculations continue for the duration of 
the emission plus 30 minutes.  Then the time used for the footprint 
display is the time at which the lowest value of interest (e.g. 
concentration) has maximum aerial extent. 

3-Dimensional Plume 
The 3D Plume command on the Displays menu of the Plan Plume View 
offers a method to view a concentration in 3 dimensions.  CHARM 
initially requests a single concentration to display. 
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Once the concentration of interest has been entered, press the OK button 
and CHARM displays the 3D Plume Window.  Figure 6.39 illustrates the 
3D Plume Display 

 

 
This windows presents a three-dimensional view of a concentration 
plume.  Only one concentration may by viewed at a time.  The observer 
location and observed location may be changed.  The observed location is 
the point at the center of the observer’s view.  Tools can be used to move 
the observer around or away and towards the observed location.  The 
observer can also go up and down.  The tools are available either as icons 
on the toolbar or keystrokes. 

Moving the Observer 
The observer can be moved with respect to the observed location.  The 
observer can be moved around the point, closer to the point, and farther 
from the point.  The observer can also move up and down.  The observer 
can not move below surface level (z=0).  The observer can be moved via 
the mouse or keyboard. 

Moving via the Mouse 

Press the button icons on the toolbar.  The tools represent up, down, 
near, far, left, and right. 

Moving via the Keyboard 

Direction Key 
Up <Ctrl> + Up Arrow 
Down <Ctrl> + Down Arrow 

Figure 6.39 
3D Plume 
Display 
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Left Left Arrow 
Right Right Arrow 
Near Up Arrow 
Far Down Arrow 

Setting the Observer Location 
This dialog box allows you to change the location of the observer.  The 
observer will continue to look at the same observed location from a 
different position.  The observer’s location can be specified in either 
Cartesian or cylindrical coordinates.  Select the appropriate button for 
the desired coordinate system.  When one coordinate system is selected, 
the other ignores user input although it will update as new coordinates 
are entered. 

 

The x,y coordinate system is with respect to the release location.  That is, 
the release location is (0,0) in Cartesian coordinates.  The release 
location is at zero distance in cylindrical coordinates.  The z or altitude 
value is with respect to ground level.  The azimuth is given in the 
meteorological sense from the release location.   The direction can be 
entered in degrees or in points of the compass.  Degrees refer to the 360-
degree directional compass, where North is 0 or 360, East is 90, South is 
180, and West is 270.  Points of the compass refer to North (N), East (E), 
South (S), West (W), and the points between, such as Northeast (NE) and 
South Southeast (SSE). 

If you want to reset the location to what it was when the plume was 
initially drawn press the “Reset to Default” button. 

Setting the Observed Point 
This dialog box allows you to change the location of the observed 
point.  The observer will stay at the current position  and look at this 
new  observed location.  The observed location can be specified in 
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either Cartesian or cylindrical coordinates.  Select the appropriate button 
for the desired coordinate system.  When one coordinate system is 
selected, the other ignores user input although it will update as new 
coordinates are entered. 

 

The x,y coordinate system is with respect to the release location.  That is, 
the release location is (0,0) in Cartesian coordinates.  The release 
location is at zero distance in cylindrical coordinates.  The z or altitude 
value is with respect to ground level.  The azimuth is given in the 
meteorological sense  from the release location.   The direction can be 
entered in degrees or in points of the compass.  Degrees refer to the 360-
degree directional compass, where North is 0 or 360, East is 90, South is 
180, and West is 270.  Points of the compass refer to North (N), East (E), 
South (S), West (W), and the points between, such as Northeast (NE) and 
South Southeast (SSE). 

If you want to reset the location to what it was when the plume was 
initially drawn press the “Reset to Default” button. 

Setting the Observer Step Distances 
This dialog box allows you to change the stepsizes of the observer.  There 
are three dimensions the observer can move in.  The observer can move 
vertically (up and down from the ground), radially (closer or farther from 
the observed location), or azimuthally about the observed location.  The 
values given in this dialog box define the increment to be taken every 
time a movement tool or appropriate key is pressed. 
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Setting the Z Scale 
This dialog box allows the user to enter a dimensionless number to scale 
the plume z coordinates.  Normally, a plume is much larger in the 
horizontal than the vertical direction.  To make viewing easier the z 
values of the plume can be increased to make the vertical distribution 
easier to discern.  CHARM attempts to provide a scale factor determined 
on plume dimensions.  This scale will be seen when the scale factor given 
here is 1.0. 

 

Displaying a 2D Map in the 3D Plume View Display 
Use the Map section of the Options menu from the 3D Plume Display to 
display a map.  CHARM allows the user to overlay a 3D plume on a 2D 
map (see Figure 6.40). 
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Figure 6.40 
3D Plume 
Overlayed on 
2D Map 
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Chapter 7: Using CHARM for Emergency Response 

Use CHARM's emergency response mode to quickly display stored maps 
of the release site, input data, plumes or footprints, tables, graphs, and 
other useful information.  The emergency mode displays data resulting 
from input and calculations stored in the planning mode. 

Emergency Response Files 

CHARM's emergency response mode requires a map that has been edited 
with the CHARM Editor (CHARMED) and at least one release scenario 
that has been created and saved with CHARM.  If CHARM was allowed to 
assign file name extensions when the files were stored, the default 
extension for map files is .MAP and the default extension for release 
scenario files is .EMG.  The default extensions may be changed (see 
section ‘CHARM.INI File Description’ in CHAPTER 3: Getting Started).  
However, extensions other than these may have been assigned to the file 
name.  For discussion purposes, this document refers to these files as 
.MAP and .EMG files. 

Map Files 
When the CHARM program starts, it searches for a map file with the 
name BASEMAP.MAP and its corresponding definition file 
BASEMAP.MFD.  If such files exist, the map is displayed immediately 
and the CHARM considers this to be in the Emergency Response Mode.  
If these files do not exist, CHARM automatically displays the Main 
CHARM Input Window in Planning Mode.  From the Main CHARM Input 
Window, you can enter Emergency Response Mode by selecting a map 
display using the Basemap command on the Displays menu. 

Map Requirements 
All maps used in CHARM must first be edited using the Map Definition 
command of the CHARM Editor (CHARMED.EXE). A point and scale 
must be specified for each map.  To be useful in the emergency response 
mode, a map must be defined with at least one release location icon.  
This icon identifies the release scenarios that are defined at the location.  
The map may also have map location icons that point to smaller-scaled 
maps.  A map may also have a larger-scaled map associated with it and 
also text information describing attributes associated with the map(e.g. 
the date that the map was last updated). 
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Release Location Icons 
If the map display has one or more release location icons, you can select 
an icon and display a list of stored scenarios.  A release location icon 
looks like a plume within a box.   

 

The scenario contains the input data.  If the map has no release location 
icons, you can select a release using the Scenarios command on the File 
menu of the input window.  For more information on creating, moving, 
and deleting release location icons, see ‘Defining a Release Location’ in 
CHAPTER 4: Using the CHARM Editor. 

Map Location Icons 
If the map display has map location icons, you can select a map location 
icon and display a smaller-scaled map.  A map location icon looks like 
boxes within a box. 

 

Each map can point to another map.  If the map has no map location 
icons, you can select a map using the New Map command on the 
Basemap menu of the input window.  It is important the user define the 
larger-scale map of the map associated with the map icon such that it 
points back to the map utilizing the map icon.  This will allow the user to 
go back and forth between larger-scaled and detailed maps. For more 
information on creating, moving, and deleting map location icons, see 
‘Defining a Map Location’ in CHAPTER 4: Using the CHARM Editor. 

Release Scenario Files 
The emergency response data files typically have the default .EMG file 
name extension.  Files with the .EMG extension contain stored input 
data from a CHARM run, which is called a release scenario. 

In the emergency response mode, CHARM displays the titles in a  
scenario selection list (.EMG files) when you click on a release icon on a 
map display.  In planning mode, you can display the titles by selecting 
the Scenarios command from the File menu of the Main CHARM Input 
Window.  You can select from the list in the dialog box. 

Emergency Response Mode Procedures 
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CHARM's emergency response mode is useful only when a base map has 
been defined with at least one release location icon.  The emergency 
response mode requires that the input for at least one release has been 
previously stored in a scenario file. 

To use the emergency response mode: 

8. Start the CHARM program.  The method you use to start CHARM depends on the 
system and the version of Windows you are using.  Refer to Chapter 3, "Getting 
Started", for a description of these methods. 

9. CHARM displays a base map (BASEMAP.MAP) if one is defined.  Otherwise, CHARM 
displays the Main CHARM Input Window. 

If the base map is displayed, look for release or map location icons.  If 
the map has a release icon at the release site, select the icon to 
display a list of release scenarios.  Since more than one map may 
define the release area, the base map may not have a release icon.  
Instead, the map may have one or more map location icons that you 
can select to display a smaller-scaled map of the area.  Continue 
selecting map icons and looking for a release icon at the site.  Select 
the icon to display a scenario selection list.  

 

If the base map has no release or map location icons, select the Main 
Input from the Window menu to display the input window.  Then, 
select the Scenarios command from the File menu to display the 
selection list. 

If the Main CHARM Input Window is displayed instead of a map, you 
can select a map using the Basemap command on the Displays 
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menu.  Then follow the procedures described previously, as if a base 
map was initially displayed. 

10. If the Auto Met Polling command on the MetFile menu is not enabled, CHARM 
displays a dialog box indicating that automatic met data are not available. 

 

Select OK or press <Enter> to continue calculations without 
automatic data, or select Cancel to stop.  You may want to go to the 
Main CHARM Input Window and change the default met parameters. 

If automatic met polling is available, CHARM displays a dialog box 
requesting the time of release in 24-hour clock time.  Then CHARM 
begins performing the calculations.  Depending on the mode of 
operation defined by the EmergencyMode variable in CHARM.INI, 
CHARM will proceed to calculate in one of two manners.  If 
EmergencyMode = 1 or is not defined, then CHARM will display a 
real-time footprint, updating the display minute by minute.  If 
EmergencyMode = 0, CHARM calculations continue for the duration 
of the emission plus 30 minutes.  Then, the time used for the 
footprint display is the time at which the lowest value of interest (e.g. 
concentration) has maximum areal extent. 

11. Use the commands on the Options and Displays menus to show the desired 
information.  More than one display can be viewed on the same screen at a time.  
Refer to CHAPTER 6, "Understanding CHARM Displays," for detailed information. 

12. Press the F1 key to access on-line help.  CHARM displays those commands and 
procedures available for the Basemap window.  Refer to Chapter 8, “Menu and 
Command Reference” for detailed information. 

Real-Time Met Data Acquisition (METINTER)  

METINTER.EXE is a separate standalone program which provides the 
interface between external meteorological data and the CHARM 
program.  The program is represented by an icon with the sun, cloud, 
and rain in the CHARM group. 
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Each MetInter program has been customized for the specific 
meteorological data logger of file to be accessed.  There are only a few 
options available in the program. 

CHARMED must be run before MetInter will operate properly.  
CHARMED is used to define the Communications Parameters to be used 
by MetInter.  See section “Setting the Communications Parameters” in 
CHAPTER 4: Using the CHARM Editor for more information. 

MetInter uses the concepts of station and site.  A station is a location 
which can be directly accessed or dialed up.  A station may have data 
for multiple sites.  MetInter can interface to a single station at any one 
time.  The data from all the sites will be collected and stored.  The data 
from only one site will be displayed in the MetInter Data Window.  If the 
User Inverse Square command is selected from the MetFile menu in 
CHARM, then the data from all sites are used to determine the 
meteorological parameters at a specific point.  Otherwise, only the data 
in the MetInter Data Window will be used by CHARM. 

The METINTER Window 

The METINTER window has only two menus:  the Help Menu for 
acquiring on-line help, and the Options menu. 

The Options menu provides a command for each of the following: 

Data Window 
Visible 

Makes the Data Window visible 
or invisible. 

Data Window on 
Top 

Forces the Data Window to 
always be displayed in front of all 
other windows. 

Select Met Station Allows the selection of which 
station MetInter should connect 
to. 

Select Met Site Allows the selection of which site 
at a station will have its data 
displayed in the Data Window. 

Exit Exits Metinter. 

 

Data Window Visible Command 
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This option toggles whether the Data Window is visible or not.  If active 
the Data Window will be visible.  If the Data Window on Top option is 
selected, then the Data Window will always be forced in front of all other 
windows.  Otherwise the Data Window may be hidden by other 
windows.  If the Data Window has been selected to be visible, then this 
option will have a check mark next to it. 

Data Window on Top Command 
This option toggles whether the Data Window is always in front of all 
other windows or not.  If active, the Data Window will be in front of all 
other windows, even those in another application.  The Data Window 
Visible command must also be selected to see the Data Window.  If the 
Data Window has been selected to be on top, then this option will have 
a check mark next to it. 

Select Met Station Command 
Select the station for MetInter to connect to.  See the section “Defining 
Stations ID’s” in CHAPTER 4: Using the CHARM Editor for more 
information on defining stations to be used with MetInter.  Only one 
station can be connected with MetInter at any one time.  The data from 
all other met stations may be lost (depending on the data logger at the 
station). 

A station may have one or more sites connected to it.  If the Use Inverse 
Square command from the MetFile menu has been selected in CHARM, 
the data from all the sites will be used to determine the meteorological 
data at any point.  The data from one site can be displayed in the Data 
Window.  The site which will have its data displayed is selected using 
the Select Met Site command. 

Select Met Site Command 
Select which met site at the current station will have its data displayed 
in the Data Window.  See the section “Defining Site ID’s” in CHAPTER 4: 
Using the CHARM Editor for more information on defining sites to be 
used with MetInter.  Only one station can be connected with MetInter at 
any one time.  Only one site at that station can have it’s data displayed 
in the Data Window.  The station to connect to is selected by the Select 
Met Station command. 

A station may have one or more sites connected to it.  If the Use Inverse 
Square command from the MetFile menu has been selected in CHARM, 
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then the data from all the sites will be used to determine the 
meteorological data at any point.  Otherwise, CHARM will use the data 
in the Data Window.
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Chapter 8: Using the TIGERMAP Utility 

CHARM has the capability of predicting population impacts based on 
U.S. Census Bureau Tiger/Line™ 1992 data.  The TIGERMAP utility is a 
preprocessor which is used to extract only the information necessary for 
use with CHARM.  The program reads U.S. Census Bureau Tiger/Line™ 
1992 data (available on CD-ROM) and creates maps and/or population 
files.  An icon for starting TIGERMAP is in the CHARM Group box. 

 

Contact the U.S. Census Bureau directly for ordering the data files 
needed.  Their number is (301) 457-4100.  Once the TigerLine data has 
been preprocessed, files for use with CHARM must be selected in 
CHARMED (see section “Defining Population Files for Use With CHARM” 
in CHAPTER 4 “Using the CHARM Editor”).  Once the files have been 
selected in CHARMED, select the Population Impacts command from the 
Displays menu on a footprint display in CHARM (see section “Population 
Impacts” in CHAPTER 6 “Understanding CHARM Displays”). 

The TIGERMAP Window 

Like CHARM, the main TIGERMAP window is an MDI frame with several 
menus.  The View and Help menus contain the standard commands 
found in other CHARM related programs.  The File menu contains the 
following commands: 

New Creates a Map or Population 
window. 

Open Opens a preprocessed TigerMap 
Map or Population file. 

Recent File Shows up to the last four files 
used. 

Exit Exits TigerMap. 

 

Selecting the New command will prompt the user for the type data to 
pre-process - geographical information or population data.  Selecting 
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Tiger Map File will process geographical information while selecting Tiger 
Polygon File will process population tracts. 

 

 

Processing Tiger/Line Geographical Data 

File Menu 
Once the New command has been selected or a data file has been opened 
with the Open command on the File menu, the TIGERMAP MDI menu 
bar changes appropriately.  The following menu commands become 
available from the File menu for Tiger Map File: 

New Creates a new map or 
polygon window. 

Open Opens an existing map or 
polygon file.  

Close Closes the active window. 

Save Saves an opened file using 
the same file name. 

Save As Save a file to a specified 
file name. 

Process Tiger Map Requests a state and 
county to process into a 
map. 

Merge Tigers To 
Clipboard 

Requests a number of map 
files to merge and send to 
the clipboard. 

Exit Exits TigerMap 
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Process TigerMap Command 
Use this command to create a map file in TigerMap.  You will be asked to 
select the state and county or district to process.   

 

The Census data is on a county by county basis.  Each county needed 
has to be processed separately.  Later the maps of each county can be 
merged into one map with the use of the Merge Tigers To Clipboard 
command.  The following figure illustrates output from processing the 
geographical information from Tiger/Line data. 

 

Merge Tigers to Clipboard Command 
Use this command to merge a number of county maps into a single map.  
The following example dialog box displays pre-processed Tiger/Line 
map files for selection to be merged. 
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To select multiple files, hold down the <Ctrl> key while left mouse 
clicking on the desired .TGR files.  Select Open and the resulting merged 
map will be sent to the clipboard where it can be accessed by the Map 
Definition Utility in CHARMED or a drawing program capable of 
accessing a Windows Metafile.  You will be asked to select the files to 
process.  When the merging is done the last county read is displayed.  
Each county map processing is done with the Process Tiger Map 
command. 

Edit Menu 
The Edit menu offers the following commands: 

Zoom Displays an enlargement of 
a specified map area. 

Unzoom  Returns a zoomed map 
display to its original size 
when the window was 
created/opened. 

Show Text Display text. 

Set Text Size If text is being displayed, 
set the size of text. 

Set Latitude/ Longitude 
Limits 

Use this command to 
define latitude and 
longitude limits to be used 
when creating a map file. 

Set Tiger Data Directory This dialog box allows you 
to define the location of 
the Census Bureau 
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CDROM data. 

 
Zoom/Unzoom Commands 
Use this command to zoom a portion of the map display.  Select the 
Zoom command from the Edit menu.  The cursor changes from a pointer 
to a magnifying glass.  Next, move the cursor to one corner of the area to 
be zoomed.  If you are using a mouse, hold the left mouse button down, 
move the cursor to the opposite corner of the area to be zoomed , and 
release the button.  During this process, notice that a rubberband box is 
drawn around the area that you intend to zoom until you release the left 
mouse button. 

If you are not using a mouse, press <ENTER> to mark the first corner of 
the zoom box, expand the box with the arrow keys, and press < Enter> 
again to complete the zoom box.  The zoom display may not have a one-
to-one correlation to the marked area.  To return to the initial map 
display, select the Unzoom command from the Edit menu. 

Show Text Command 
Use this command to have the text drawn with the map file.  The text is 
the label for each object.  The amount of text for a map can be quite large 
and take a long time for a redraw. 

Note:  If this option is set, then text will be sent to the clipboard along with 
the rest of a map or polygon drawing.  Sending text along with a map can 
make redrawing very slow. 

The text will not be drawn regardless if this option is selected or not if the 
drawn text would be too small to be seen legibly.  The text size can be set 
by the Set Text Size command. 

Set Text Size Command 
Use this command to set relative map text size.  When a map file is first 
displayed a default text size is assumed.  The default text size depends 
on the areal coverage of the map file.  This option can be selected to 
change the size.  The default size is 1.0.  To double the text size use 2.0.  
To halve the text size use 0.5.  Whether text is displayed at all can be 
controlled by the Show Text command. 
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Set Latitude/Longitude Limits Command 
Use this command to define latitude and longitude limits to be used 
when creating a map file.  If a feature lies completely outside of the limits 
it is not made part of the map.  If part of a feature (e.g. street segment) is 
inside the limits it will be drawn. 

 

Set Tiger Directory Command 
This dialog box allows you to define the location of the Census Bureau 
CDROM data.  For example, if your CD is on drive D the directory would 
be D:\.  Use the Browse button to search and set the drive and directory 
where the Tiger/Line data exists. 
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Processing Tiger/Line Population Files 

File Menu 
Once the New command has been selected or a data file has been opened 
with the Open command on the File menu, the TIGERMAP MDI menu 
bar changes appropriately.  The following menu commands become 
available from the File menu for Tiger Map File: 

New Creates a new map or polygon 
window. 

Open Opens an existing map or polygon 
file.  

Close Closes the active window. 

Save Saves an opened file using the 
same file name. 

Save As Save a file to a specified file name. 

Process Population 
File 

Requests a state and county to 
process into a population polygon 
file. 

Merge Pop Files To 
Clipboard 

Requests a number of population 
files to merge and send to the 
clipboard. 

Import Landview II 
Data 

Use this command to create a 
population polygon file in 
TigerMap.  You will be asked to 
select the state and county or 
district to process.  The Landview 
II data is on a county by county 
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basis. 

Exit Exits TigerMap 

 

Process Population File Command 
Use this command to create a population polygon file in TigerMap.  You 
will be asked to select the state or county or district to process.   

 

The Census data is on a county by county basis.  Each county needed 
has to be processed separately.  Later the polygon files of each county 
can be merged into a map with the use of the Merge Pop. Files To 
Clipboard command.  More importantly these population files can be 
declared in CHARMED so that CHARM may use them to determine 
calculation impacts from a concentration, thermal radiation, or 
overpressure footprint. The following figure illustrates the results of 
processing the data. 
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The TigerMap Utility associates total number of people with each tract, 
along with some other data including age, race, home owners, and 
renters.  Later in CHARM when determining population impacts, CHARM 
assumes that the total number of people in a tract is uniformly dispersed 
throughout the tract. 

Merge Pop. Files To Clipboard Command 
Use this command to merge a number of county polygon population files 
into a map.  The resulting map will be sent to the clipboard where it can 
be accessed by CHARMED or a drawing program capable of accessing a 
Windows Metafile.  You will be asked to select the files to process.  When 
the merging is done the last county read is displayed.  Each county 
needs to be processed into a population file separately.  County 
population processing is done with the Process Population File 
command. 

Import Landview II Data Command 
Use this command to create a population polygon file in TigerMap.  You 
will be asked to select the state and county or district to process.  The 
Landview II data is on a county by county basis.  Each county needed 
has to be processed separately.  Later the polygon files of each county 
can be merged into a map with the use of the Merge Pop. Files To 
Clipboard command.  More importantly these population files can be 
declared in CHARMED so that CHARM may use them to determine 
calculation impacts from a concentration, thermal radiation, or 
overpressure footprint. 

The Landview II data can be put on your hard disk after purchasing a 
Landview CDROM by following the instructions provided.  You can also 
download the data from the Internet.  Simple instructions are: 
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1.  Go to site http://www.RTK.NET/landview. 
2.  Select the desired County and State and press the Submit Query 
button. 
3.  If you want the complete Landview system download all the files and 
follow instructions. 
4.  If you only need the data for inclusion into CHARM you only need to 
download the Dbase files, the MARPLOT files, and the installation script. 
5.  Put the downloaded files into a directory for expansion. 
6.  Run the batch file lvinstal.  Ignore any error messages. 
7.  Define the Data Directory in Tigermap as the directory where the files 
were expanded. 
The batch file lvinstal will write over any files of the same names already 
in the directory. 

For Tigermap to work the only files required are: 

In the directory where the expansion occurred - states.dbf, counties.dbf, 
and cen_blkg.dbf. 

Two subdirectories down (the county subdirectory) - censusb.sum and 
censusb.obj 

Edit Menu 
The Edit menu offers the following commands: 

Zoom Displays an enlargement of a 
specified map area. 

 
Unzoom  Returns a zoomed map display to its 

original size when the window was 
created/opened. 

Show Text Display text. 

Set Text Size If text is being displayed, set the size 
of text. 

Set Latitude/ 
Longitude 
Point 

Defines a Latitude/Longitude point 
in the x/y Cartesian coordinate 
system to be used in CHARMED. 

Set Tiger 
Data 
Directory 

This dialog box allows you to define 
the location of the Census Bureau 
CDROM data. 
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Zoom/Unzoom Commands 
Use this command to zoom a portion of the map display.  Select the 
Zoom command from the Edit menu.  The cursor changes from a pointer 
to a magnifying glass.  Next, move the cursor to one corner of the area to 
be zoomed.  If you are using a mouse, hold the left mouse button down, 
move the cursor to the opposite corner of the area to be zoomed , and 
release the button.  During this process, notice that a rubberband box is 
drawn around the area that you intend to zoom until you release the left 
mouse button. 

If you are not using a mouse, press <ENTER> to mark the first corner of 
the zoom box, expand the box with the arrow keys, and press < Enter> 
again to complete the zoom box.  The zoom display may not have a one-
to-one correlation to the marked area.  To return to the initial map 
display, select the Unzoom command from the Edit menu. 

Show Text Command 
Use this command to have the text drawn with the tract data.  The text is 
the population for each tract. 

Note:  If this option is set, then text will be sent to the clipboard 
along with the rest of a map or polygon drawing. 

The text will not be drawn regardless if this option is selected or not if the 
drawn text would be too small to be seen legibly.  The text size can be set 
by the Set Text Size command. 

Set Text Size Command 
Use this command to set relative map text size.  When a map file is first 
displayed a default text size is assumed.  The default text size depends 
on the areal coverage of the map file.  This option can be selected to 
change the size.  The default size is 1.0.  To double the text size use 2.0.  
To halve the text size use 0.5.  Whether text is displayed at all can be 
controlled by the Show Text command. 
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Set Latitude/Longitude Point Command 
Use this command to define latitude and longitude point which 
corresponds to a Cartesian coordinate in the reference frame used for 
defining the location of maps and release sites.  This is required so that 
CHARM knows where the population polygons are with respect to a 
footprint. 

 

Set Tiger Directory Command 
This dialog box allows you to define the location of the Census Bureau 
CDROM data.  For example, if your CD is on drive D the directory would 
be D:\.  Use the Browse button to search and set the drive and directory 
where the Tiger/Line data exists. 
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Creating a Map File for Use With CHARM 

To create a map for use with CHARM using U.S. Census Bureau 
Tiger/Line™ 1992 data, follow these steps: 

1. Upon selecting New from the File menu, select TigerMap File from the 
New window. 
 

 

2. Select the Process Tiger Map command in the File menu and press 
<OK>. 

3. In the dialog boxes with follow, select the state and county to process.  
If only one state is available for selection, the state selection will be 
skipped. 

4. Wait for the processing to be complete.  This can take a very long 
time.  Pressing cancel on the progress dialog box will stop the 
processing and all information will be lost. 

5. Save the map file with the Save As command in the File menu. 

6. Select the Merge Tigers To Clipboard command. 

7. Run CHARMED©. 
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8. Select Map Definition in CHARMED. 

9. Paste the map in the clipboard into CHARMED.  See ‘Defining Maps 
for Use with CHARM’ in CHAPTER 4: Using  the CHARM Editor for 
more information on defining the map. 

Once you have created and defined those files for use with CHARM using 
TIGERMAP and CHARMED, you can display the map two different ways 
in CHARM.  For more information on displaying a map in CHARM, see 
CHAPTER 6 :CHARM Displays. 

Creating a Population File for Use With CHARM 

To create a population file for use with CHARM using U.S. Census 
Bureau Tiger/Line™ 1992 data, follow these steps: 

1. Upon selecting New from the File menu, select Tiger Polygon from the 
New window. 
 

 

2. Select the Process Population command in the file menu. 

3. In the dialog boxes which follow select the state and county to 
process.  If only one state is available for selection, the state selection 
will be skipped. 

4. Wait for the processing to be complete.  This can take a very long 
time.  Pressing cancel on the progress dialog box will stop the 
processing and all information will be lost. 

5. Save the population file with the Save As command in the File menu. 

6. Select the Merge Pop. Files To Clipboard command. 

7. Run CHARMED©. 

8. Define the population files(s) using the Select Population Files 
command in CHARMED. 
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Once you have created and defined those files for use with CHARM using 
TIGERMAP and CHARMED, you can calculate population impacts from a 
plan footprint display in CHARM. 

For more information on calculating population impacts in CHARM, see 
CHAPTER 6 “CHARM Displays”.
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Chapter 9:  Menu and Command Quick Reference 

The purpose of this reference is to help you quickly find related 
information for CHARM menus and commands in this manual.  The 
menus are listed in alphabetical order.  The commands are listed as close 
as possible to their locations on the menus.  Although this list provides a 
complete command listing, some commands appear only on the menus of 
specific CHARM displays, while other commands appear shaded on the 
menu and are not currently selectable.  If a command is fully described 
in this reference, no page number is given.  The menus will exist in 
CHARM, CHARMED, and/or the TIGERMAP Utility. 

Define Menu (Map Definition Window in CHARMED) 

Zoom  Page 73  
Displays an enlarged map of the specified area of the current map 
display. 

Unzoom  Page 73 
Returns a zoomed map area to its initial size when the window was 
opened. 

Change Default Size  
An unzoomed map size can be changed be entering a scale factor in a 
map window.    

Define Point Page 74 
Define an x,y point of reference for a map you intend to display in 
CHARM. 

Define Scale Page 75 
Display a scale for a map you intend to display in CHARM. 

Define Map Location Page 77 
Place an icon on a map display that points to another map. 

Define Release Location Page 78 
Place an icon on a map display that identifies the location of one or more 
defined release scenarios. 

Define Expand Map Name Page 82 
Specify the name of a larger scaled map than the one being defined. 

Map Description Page 79 
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Allows the user to define pertinent information describing the currently 
displayed map. 

 

Displays Menu (Main CHARM Input Window) 

When the Displays menu is selected, the cursor changes momentarily to 
an hour glass as CHARM calculates the source term. 

Basemap  Page 160 
Displays a map which has been created with third party software and 
defined in the CHARM Editor CHARMED for use in emergency response 
mode. 

Site Information Page 161 
Displays a text file window containing site-specific information. This 
information may contain emergency phone numbers, evacuation routes, 
etc.  

Chemical Data Page 162 
Displays thermodynamic data and plot concentrations from the chemical 
database for the selected species.   

Chemical Response Page 163 
Displays a text window containing the emergency response information 
for the selected chemical species of interest. 

Source/Puff Calculation Page 164 
Displays the description resulting from the source term calculations 
using in the Main CHARM Input Window for data.    

Emission Rate Page 166 
Displays a plot of the emission rate as a function of time for the input 
data in the Main CHARM Input Window. 

BLEVE Radiation Page 166 
Displays a footprint of thermal radiation resulting from a fireball/BLEVE. 

Pool Fire  Page 169 
Displays a submenu for selecting the footprint of the thermal radiation 
associated with the fire, or a plume of the unburned material of interest 
that makes it through the flames. 

Jet Fire Radiation Page 169 
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Displays the footprint of thermal radiation resulting from a jet fire. 

Mechanical Overpressures  Page 172 
Displays a footprint of potential overpressures from a bursting sphere. 

Plume   Page 174 
Displays a snapshot view of the plume at the specified time after release. 

Displays Menu (Plan Footprint View) 

Maximum Distance Page 195 
Plots the maximum distance downwind of the specified concentration as 
a function of time.   

Maximum Width Page 197 
Plots maximum crosswind width of a user specified concentration as a 
function of time.   

Maximum Concentration Page 199 
Displays a table of maximum concentrations as a function of time. 

Vertical Xsection Page 200 
Plots a vertical cross-section through the middle of the plume.  The line 
of sight runs from the release site through the middle of the initial puff. 

3D Plume Page 225 
Presents a three dimensional view of a concentration plume. 

Centerline Concentrations Page 201 
Plots the concentrations down the centerline of the plume as a function 
of distance.  

Plume Half-Widths Page 203 
Determines the crosswind half-width down the centerline of the plume as 
a function of concentration. 

Met Data  Page 206 
Shows the meteorological data at the source location at the present 
receptor height and at the time specified for the Snapshot Plan Plume 
View display. 

Integrated Area Page 206 
Starts a minute by minute calculation of the plume display, showing all 
areas affected by the plume.   
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Time Averaged Footprint Page 208 
Displays a time averaged plume based on the user-defined averaging 
interval and the user-defined grid size.  The user will be prompted for the 
averaging time and grid resolution.  The user has the option of selecting 
an area of the footprint or the entire plume from a submenu. 

Circular Population Impact Page 210 
Predicts population impacts using Census Bureau data.  The impacted 
area is a circular region described by the user by specifying a radius out 
from the source location. 

Population Impact Page 212 
Predicts population impacts using Census Bureau data.  The number of 
people impacted depend on the Population Calculation type. 

Population Calculation Page 213 
Select the type of calculation to use when predicting population impacts. 

Explosion Overpressures Page 214 
Shows a footprint of potential overpressures if the displayed cloud 
ignited. 

Input   
Shows the input data for the current CHARM run just as it appeared in 
the Main CHARM Input Window.  

Source/Puff Calculation Page 164 
Shows the output of the source term calculation for the CHARM run that 
created the current plan plume view.   

Emission Rate Page 166 
Shows a plot of the emission rate as a function of time throughout the 
release. 

Site Information Page 161 
Displays a text file window containing site-specific information. 

Chemical Data Page 162 
Displays thermodynamic data and plot concentrations from the chemical 
database for the selected species. 

Chemical Response Page 163 
Displays a text window containing the emergency response information 
for the selected chemical species. 
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Visual Verify Page 211 
Displays the population tracts relative to the plume in order to visually 
verify that the plume indeed overlays the population tracts appropriately.  
The number of people affected within a tract will be displayed over the 
number representing the total population for that tract.  If it is 
determined that the plume is not correctly overlayed on the population 
tracts, the user may adjust the inaccuracy by repositioning the plume or 
redefining the lat/long point within the TigerMap Utility. 

 

Edit Menu (Plan Footprint Displays) 

Copy  
Sends text and/or graphics in the current window to the Windows 
clipboard where it can be retrieved by other programs.  If the window 
contains text only, all the text (visible or not) is sent to the clipboard.  If 
the window contains graphics, a bitmap and a metafile representation of 
the visible contents of the window is sent to the clipboard. 

Change Run Title 
Changes the title of the CHARM run and all windows that are using the 
same data.   

Edit Menu (TIGERMAP Utility) 

Zoom  Page 242 
Displays an enlarged map of the specified area of the current map 
display. 

Unzoom  Page 242 
Returns a zoomed map area to its initial size when the window was 
opened. 

Show Text Page 242 
Use this command to have the text drawn with the map or polygon file.  
If the drawing is a polygon file the text is the population for each polygon 
drawn at the geometric center of the polygon.  If the drawing is a map file 
the text is the label for each object.  The amount of text for a map can be 
quite large and take a long time for a redraw.  The text will not be drawn 
regardless if this option is selected or not if the drawn text would be too 
small to be seen legibly.  The text size can be set by the Set Text Size 
command. 
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Set Text Size Page 242 
Use this command to set relative map text size.  When a map file is first 
displayed a default text size is assumed.  The default text size depends 
on the areal coverage of the map file.  This option can be selected to 
change the size.  The default size is 1.0.  To double the text size use 2.0.  
To halve the text size use 0.5.  Whether text is displayed at all can be 
controlled by the Show Text command. 

Set Latitude/Longitude Limits Page 243 
Use this command to define latitude and longitude limits to be used 
when creating a map file.  If a feature lies completely outside of the limits 
it is not made part of the map.  If part of a feature (e.g. street segment) is 
inside the limits it will be drawn. 

Set Latitude/Longitude Point Page 249 
Use this command to define a latitude and longitude point which 
corresponds to a Cartesian coordinate in the reference frame used for 
defining the location of maps and release sites.  This is required so that 
CHARM knows where the population polygons are with respect to a 
footprint. 

Set TIGER Data Directory Page 249 
This dialog box allows you to define the location of the Census Bureau 
CDROM data.  For example, if your CD is on drive D the directory would 
be D:\. 

 

 

Edit Menu (CHARM Editor) 

Chemical Database Page 59 
Add, modify, or delete species data in the chemical database. 

Import Previous Database Page 27 
Requests the path to the previous version of the CHARM database.  Once 
the path is entered, CHARM will attempt to update the current database 
from those records in the previous database. 

Update Plot Concentrations Page 27 
Requests the path to the previous version of the CHARM database.  Once 
the path is entered, CHARM will attempt to update the default plot 
concentrations in the current database from those records in the 
previous database.  The user will be prompted for verification. 
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Pack Chemical Database Page 64 
Physically removes logically deleted records from the chemical database. 

Local Met Comm Parameters Page 66 
Sets the parameters for local communications with a meteorological 
tower. 

Network Met Server Location Page 28 
Requests the name/location of the server from which the meteorological 
interface will run. 

File Location Page 28 
Specifies where CHARM can find CHARM system required  files. 

Site Information Page 64 
Allows site-specific information to be entered. 

Map Definition Page 72 
Reads maps to be defined for use in CHARM. 

Select Population Files Page 84 
Requests the names of the population files which were pre-processed 
using 1992 TigerLine Census Bureau data and the CHARM TIGERMAP 
Utility. 

Change Password Page 28 
Defines CHARM/System password to regulate CHARMED entry. 

Undo 
Undo the last text edit. 

Cut 
Remove the currently selected text from the active window and put it on 
the clipboard. 

Copy 
Copy the currently selected data from the active window and put it on 
the clipboard. 

Paste 
Insert a copy of the clipboard contents into the active window at the 
insertion point. 

Copy Data Page 37 
Copy the data in the Chemical Data Sheet to the clipboard in comma 
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delimited format in the order it is displayed in the Chemical Data 
Window. 

Paste Data Page 37 
Paste the comma delimited data from the clipboard into the Chemical 
Data Sheet in the order it is displayed in the Chemical Data Window. 

Import From DIPPR Page 37 
Displays a selection list of all the species in the DIPPR chemical database 
for import into the CHARM database. 

Exit 
Exits CHARMED and closes the main CHARMED MDI window.  If the 
Prompt at Exit command on the Options menu is selected, CHARMED 
will first prompt the user before exiting.  If changes were made, the user 
is prompted as to whether or not the changes should be stored.  The Exit 
command functions the same in CHARMED as it does in other Windows 
programs. 

File Menu 

Emergency Response Text Page 61 
Modifies emergency response text that is specific to the chemical of 
interest in the CHARM Editor. 

Monochrome Page 200 
Remove the color from the vertical cross-section, thereby displaying only 
the hatch marks. 

Table 
View the current plot as records of numbers. 

New  Page 94 
Restores all the values on the Main CHARM Input Window to their 
default values. 

Open  Page 94 
Displays a dialog box requesting the name of an input file to open.   

Copy 
Sends text and/or graphics in the current window to the Windows 
clipboard where it can be retrieved by other programs.  If the window 
contains text only, all the text (visible or not) is sent to the clipboard.  If 
the window contains graphics, a bitmap and a metafile representation of 
the visible contents of the window is sent to the clipboard. 

Scenarios Page 94 
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Displays a selection list of the titles of release scenarios created and 
stored previously in CHARM.  

Save  Page 96 
Saves the input data from the Main CHARM Input Window.   

Save As  Page 96 
Displays a dialog box in which you can enter the name of the file being 
saved. 

Save Input As  
Saves the release description input data for the current plan plume view 
under a different, user-specified file name. 

Save Met As 
Saves the meteorological input data for the current plan plume view 
under a different, user-specified file name. 

Print 
Prints all the text contained in the current window, whether the text is 
visible or not. This is a standard command for most text windows.  For 
graphics windows, this command will print the display in the current 
window. 

Print Preview Page 97 
Prints all the text and graphics contained in the current window.  This is 
a standard command for most text windows. 

Printer Setup Page 97 
Allows the user to change the current printer configuration. 

Save As Default Page 93 
Saves the current scenario described in the CHARM Input Window as the 
default scenario. 

Close 
Closes the active CHARM window in the CHARM MDI.  Select the Exit 
command (described below) to terminate CHARM. 

Larger Scale Map Page 189 
Displays a larger-scaled map that has been defined and assigned an 
expanded map name. 

Process Population File Page 245 
Use this command to create a population polygon file in TigerMap.  
You will be asked to select the state and county or district to process.  
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The Census data is on a county by county basis.  Each county needed 
has to be processed separately. 

Import Landview II Data Page 246 
Use this command to create a population polygon file in TigerMap.  You 
will be asked to select the state and county or district to process.  The 
Landview II data is on a county by county basis.  Each county needed 
has to be processed separately. 

Merge Pop Files to Clipboard Page 246 
Use this command to merge a number of county polygon population files 
into a map.  The resulting map will be sent to the clipboard where it can 
be accessed by CHARMED or a drawing program capable of accessing a 
Windows Metafile.  You will be asked to select the files to process.  When 
the merging is done the last county read is displayed.  Each county 
needs to be processed into a population file separately.  County 
population processing is done with the Process Population File 
command. 

Process Tiger Map Page 250 
Use this command to create a map file in TigerMap.  You will be asked to 
select the state and county or district to process.  The Census data is on 
a county by county basis.  Each county needed has to be processed 
separately. This command has been removed. 

Merge Tigers to Clipboard Page 250 
Use this command to merge a number of county maps into a single map.  
The resulting map will be sent to the clipboard where it can be accessed 
by CHARMED or a drawing program capable of accessing a Windows 
Metafile.  You will be asked to select the files to process.  When the 
merging is done the last county read is displayed.  Each county needs to 
be processed into a map separately.  County map processing is done with 
the Process Tiger Map command. This command has been removed. 
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Exit 
Exits CHARM and closes the main CHARM MDI window.  If the Prompt 
at Exit command on the Options menu is selected, CHARM will first 
prompt the user before exiting.   If changes were made, the user is 
prompted as to whether or not the changes should be stored.  The Exit 
command functions the same in CHARM as it does in other Windows 
programs. 

Help Menu 

Help 
Offers you help on the current task or command. 

Index 
Offers an index to topics on which you can get help. 

Using Help 
Provides general instructions on using help. 

Search for Help On 
Displays a list of keywords used in CHARM from which a list of related 
topics may be displayed. 

About 
Displays the version number and standard information required by 
Windows.  This is a standard Windows command. 

MetFile Menu 

New  Page 99 
Restores all met data fields to their default values. 

Open  Page 100 
Displays a dialog box requesting the name of a met file to open.   

Save  Page 101 
Saves the current met data in a user-specified file.   

Save As  Page 101 
Saves the met data under a different, user-specified file name.  

Save As Default Page 99 
Saves the current met data described in the CHARM Input Window as 
the default met data. 
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Solar Radiation Worksheet Page 101 
Use a worksheet to determine solar radiation value.  Solar radiation is a 
function of latitude/longitude, cloud cover, time of day, and the day of 
the year.  

Automatic Poll Page 101 
Initiates conversation between CHARM and the met interface 
(METINTER.EXE) to automatically read stored meteorological data.    

Stop Poll  Page 100 
Signals CHARM to stop real-time data acquisition. 

Use Inverse Square Page 100 
Invokes inverse square weighting algorithm for use with multiple sites 
when using real-time data acquisition. 

Calculate Solar Radiation Page 100 
Calculates the solar radiation as real-time met data is acquired. 

Options Menu (Main CHARM Input Window) 

Prompt At Exit Page 103 
Switch to prompt the user before exiting CHARM. 

Time is Minutes-Seconds Page 103 
Switch to run CHARM in Minutes/Seconds mode or Hours/Minutes 
mode. 

Options Menu (Basemap Window) 

Zoom  Page 224 
Displays an enlarged map of the specified area of the current map 
display. 

Unzoom  Page 224 
Returns a zoomed map area to its initial size when the window was 
opened. 

Map Description Page 188 
Allows the user to view pertinent information describing the currently 
displayed map. 
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Options Menu (Plan Footprint Displays) 

Recalculate Page 208 
Recalculated the impacted area from the beginning on an Integrated Area 
Display. 

Continue  Page 207 
Continues simulation of the currently displayed plume integration on an 
Integrated Area Display. 

Overpressures Page 173 
Specifies up to three pressure values for the three distances shown on an 
Overpressure footprint display. 

Distances Page 174 
Specifies up to three distances from the source for the pressure and 
energy flux values shown on a BLEVE Thermal Radiation  or Mechanical 
Overpressures footprint display. 

Energy Fluxes Page 167 
Specifies up to three energy flux values for the three distances shown on 
a BLEVE Thermal Radiation display. 

Isopleths  Page 180 
Specifies the concentrations plotted on plume displays, graphs, and 
tables. 

Averaging Time Page 181 
Enter the averaging time in minutes from 1 to the present plot time for a 
time averaged plume. The average taken is the running average. The 
concentrations at a specific point are averaged over time to determine a 
time-weighted average. 

Grid Size  Page 182 
Enter the number of points to be used in the grid when generating a 
Time-Averaged Plume.  The grid is 2-dimensional and, therefore, the user 
must enter the number of points in the X direction (East/West) and the Y 
direction (North/South). 

Time Averaged Footprint  Page 208 
Displays a time averaged plume based on the user-defined averaging 
interval and the user-defined grid size. The user has the option of 
selecting an area of the footprint or the entire plume from a submenu. 
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Show Grid Page 182 
This option removes/shows the user-defined grid for the Time-Averaged 
Plume.  A check by the menu item displays the grid, whereas no check 
by the menu item indicates the option is not active and the grid is not 
visible. 

Grid Display Page 182 
If the Show Grid option is on, this option displays the user-defined grid 
for the Time-Averaged Plume as a series of points or as a wire mesh.  A 
check by either menu item indicates this option is turned on, whereas no 
check by the menu item indicates the option is not active and the grid 
points are not visible. 

Scale Radius Page 183 
Changes the radius of the view port (solid circle) on the plume display 
according to a user-specified scale.  

Scale Ratio Page 184 
Changes the radius of the view port according to a user-specified ratio.  

Distance Circles Page 184 
To supplement the display of a plan view, additional circles can be drawn 
for a given radial increment within the large circle. 

Receptor Height Page 185 
Specifies the height above ground of the display.  

Transparency Page 185 
Changes the display from a colored, opaque plume to a "ghost" plume 
denoted only by concentration hatch marks, thereby allowing the map 
areas beneath the plume to be seen.  

No Hatch  Page 185 
A toggle indicating whether or not the hatch marks on a footprint display 
and in the legend are displayed.  A check by the menu item indicates this 
option is turned on, whereas no check by the menu item indicates the 
option is not active and the hatch marks are visible. 

Use Auto Scale Page 186 
A toggle switch indicating that CHARM will automatically scale the 
display to show the entire footprint whenever aspect changes are made to 
the display. A check by the menu item indicates this option is turned on, 
whereas no check by the menu item indicates the option is not active 
and that CHARM will automatically scale the display. 
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Decay  Page 186 
Specifies the time (half-life) required for half of the emitted material to 
decay into neutral products.    

Map  Page 186 
Displays a dialog box in which you can select a map to display.   

No Map  Page 187 
Removes current map from display. 

Location  Page 187 
Relocates the source of the release on the current map display. 

Map Description Page 187 
Displays pertinent information describing the currently displayed map. 

Reset Source Page 188 
Resets the position of the source to the center of the view port. 

Auto Map Change Page 188 
Enables CHARM to automatically display a larger-scaled map when the 
scale of the current map display is not large enough to cover a significant 
portion of the plot area.  If checked, CHARM will attempt to select the 
map with best coverage. 

Auto Map Fraction Page 188 
Defines the fraction of the footprint display area which must be covered 
by a map to preclude CHARM from trying to go to a larger scale map. 

Larger Scale Map Page 189 
Displays the larger-scaled map associated with the current map. 

New Time Page 189 
Specifies the time since release for the footprint display.   

Time Circles Page 189 
Draws dashed circles around the source that indicate the location to 
which the current wind speed can move a parcel of air from the source in 
the number of minutes specified.  

Replay 
Once a Snapshot Plan Plume View display has been generated, the user 
may display the plume at every minute (or every second if Time mode is 
Minutes-Seconds) up to the current time since release.  The user may 
cancel the automation at any time before the current time since 
release by hitting the <Cancel> button in the display window..  
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Create ASCII File Page 190 
Generates a file to hold a description of a footprint of impact 
(concentration, thermal radiation, or overpressure) which can be 
transferred to other programs. 

Create Shape File Page 193 
This command enables the user to generate a file which describes a 
footprint of impact (concentration, thermal radiation, or overpressure) 
which can be transferred to ArcView for display. 

Observer Location Page 227 
Change the location of the observer in a 3-dimensional display of a 
plume. 

Observed Point Page 227 
Change the location of the observed point in a 3-dimensional display of a 
plume. 

Observer Step Distances Page 228 
Change the incremental stepsizes of the observer when altering the 
location of the observer in a 3-dimensional display of a plume. 

Z Scale  Page 229 
Enter a dimensionless number to scale the plume z coordinates in the 3-
dimensional plume display. 

Monochrome Page 183 
Remove the color from the 3D Plume view, thereby displaying only the 3D 
frame. 

View Menu 

Status Bar 
The status bar is displayed at the bottom of the CHARM window.  To 
display or hide the status bar, use the Status Bar command in the View 
menu. 

The left area of the status bar describes actions of menu items as you 
use the arrow keys to navigate through menus.  This area similarly 
shows messages that describe the actions of toolbar buttons as you 
depress them, before releasing them.  If after viewing the description of 
the toolbar button command you wish not to execute the command, then 
release the mouse button while the pointer is off the toolbar button. 
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The right areas of the status bar indicate which of the following keys are 
latched down: 

Indicator Description 
CAP The Caps Lock key is latched down. 
NUM The Num Lock key is latched down. 
SCRL The Scroll Lock key is latched down. 

 
 

Window Menu 

Cascade 
Arranges multiple opened windows in an overlapped fashion. 

Tile 
Vertically arranges multiple opened windows in a non-overlapped 
fashion. 

Arrange Icons 
Use this command to arrange the icons for minimized windows at the 
bottom of the main window.  If there is an open window at the bottom of 
the main window, then some or all of the icons may not be visible 
because they will be underneath this window. 

1, 2, … 
CHARM displays a list of currently open windows at the bottom of the 
Window menu.  A check mark appears in front of the name of the active 
window.  Choose a window from this list to make it the active window.
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Appendix A: Enhancements in CHARM Ver. 9.1 

Functional software changes in CHARM Version 9.1 that are not found in 
CHARM Version 9.0 include the following: 

• RMP distance is calculated for thermal radiation displays. 

• For (x,y) plot displays, the user may toggle a mesh grid on or off. 

• CHARM now supplies the user with container information as a species exits the 
container. 

• CHARM displays a list of the five most recently opened scenario files in the File 
menu in the Main CHARM Input. 

• CHARM displays a list of the five most recently opened meteorological files in the 
Met File menu in the Main CHARM Input Window. 

• When using a Container/Surface Release Type, CHARM will calculate the pool 
diameter/area using a depth of 1 cm to comply with RMP specifications. 

• Depending on the chemical, the solar radiation used for liquid evaporation may not 
be used completely for evaporation purposes. 

• You may define a time schedule for user-defined stability classes under the 
meteorological parameters. 

• You can execute the MS Windows Calculator program from within CHARM to do 
necessary calculations quickly and easily. 

• CHARM version 9.1 comes with documentation inserts into the version 9.0 User’s 
Manual, and updated on-line help, which includes information taken from quarterly 
training sessions. 

RMP Distance 

Risk Management Planning (RMP) dictates that flammables must be 
modeled and a distance determined at which 5 KW/m2 is attained for 40 
seconds. RMP distance is calculated in Fireball/BLEVE, Jet Fire, and 
Pool Fire Thermal Radiation displays.  Figures A-1 - A-3 illustrate where 
the RMP distance is displayed in each output. 
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Figure A-1 
BLEVE 
Display 
Illustrating 
RMP 
Distance 
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Grid Plots 

For all (x,y) plot displays, the user may toggle a mesh grid on or off by 
selecting/deselecting the 'Grid Plot' menu item under the 'File' menu.  
Figures A-4 and A-5 illustrate the mesh grid as it is (not) displayed on a 
plot. 

Figure A-2 
Jet Fire 
Display 
Illustrating 
RMP 
Distance 

Figure A-3 
Pool Fire 
Display 
Illustrating 
RMP 
Distance 
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Figure A-4 
Example of 
Plot with 
Grid OFF 

Figure A-2 
Example of 
Plot with 
Grid ON 
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Container Information 

CHARM now supplies the user with container information as a species 
exits the container.  The output may be displayed in graphical or tabular 
format. 

To generate a Mass Rate vs. Time Plot, select the 'Container Info' menu 
item from the 'Displays' menu located on the Main CHARM Input 
Window menu bar, or on any footprint display menu bar.  Select the sub-
menu item labeled 'Mass Rate'.  Figure A-6 illustrates a plot of the mass 
rate exiting from a container as a function of time. 

 

To generate a Mass Amount vs. Time Plot, select the 'Container Info' 
menu item from the 'Displays' menu located on the Main CHARM Input 
Window menu bar, or on any footprint display menu bar.  Select the sub-
menu item labeled 'Mass Amount'.  Figure A-7 illustrates a plot of the 
mass amount exiting from a container as a function of time. 

 

Figure A-6 
Mass Rate 
vs. Time Plot 
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Figure A-7 
Mass Amt 
vs. Time Plot 
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To generate a Liquid Depth vs. Time Plot, select the 'Container Info' 
menu item from the 'Displays' menu located on the Main CHARM Input 
Window menu bar, or on any footprint display menu bar.  Select the sub-
menu item labeled 'Liquid Depth'.  Figure A-8 illustrates a plot of the 
liquid remaining in the container as a function of time. 

 

Figure A-8 
Liquid 
Depth vs. 
Time Plot 
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To generate a Pressure vs. Time Plot, select the 'Container Info' menu 
item from the 'Displays' menu located on the Main CHARM Input 
Window menu bar, or on any footprint display menu bar. Select the sub-
menu item labeled 'Pressure'.  Figure A-9 illustrates a plot of the 
pressure in a container as a function of time. 

 

Figure A-9 
Pressure vs. 
Time Plot 
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Recent Scenario Files 

CHARM displays a list of the five most recently opened scenario files in 
the 'File' menu in the Main CHARM Input Window.  Choosing a file from 
this list makes it the current scenario in the Main CHARM Input 
Window. 

 Recent Meteorological Files 

CHARM displays a list of the five most recently opened meteorological 
files in the Met File menu in the Main CHARM Input Window.  Choosing 
a met file from this list makes it the current met parameters in the Main 
CHARM Input Window. 

Estimating Pool Diameter In Accordance with RMP 

When using a Container/Surface Release Type, CHARM will calculate the 
pool diameter/area using a depth of 1 cm to comply with RMP 
specifications. 

To access this parameter in CHARM, select the 'Description Dialog Input' 
command from the 'Options' menu in the Main CHARM Input Window.  
With the 'Container/Surface Description' selected as the release type, 
select the 'Pool' tab and locate the radio button labeled 'Estimate with 1 
cm depth'.  Press the 'Apply' button at the bottom of the window and 
CHARM will calculate the pool diameter based on a 1 cm depth. 
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Solar Radiation Pool Evaporation Efficiency 

When using a Container/Surface or Pool/Lagoon release type, the solar 
radiation used for liquid evaporation may not be used completely for 
evaporation purposes.  For instance, some of the solar radiation may not 
be incorporated into the evaporation, depending on the reflectivity of the 
species to light. 

To access this parameter in CHARM, select the 'Description  

Dialog Input' command from the 'Options' menu in the Main CHARM 
Input Window.  With the 'Container/Surface Description' or the 
'Pool/Lagoon'  selected as the release type, select the 'Pool' tab and locate 
the single line edit box labeled 'Solar Radiation Pool Evaporation 
Efficiency'.  You may enter a value 0.0 - 1.0. 
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Stability Class Schedule 

You may define a time schedule for user-defined stability classes under 
the meteorological parameters. CHARM will use this schedule for 
dispersion calculations and calculation of wind profiles if a surface 
roughness is defined.  Linear interpolation will be used to determine 
surface roughness at any given point. 

To access this parameter in CHARM, double-click on Stability Class in 
the meteorological parameters in the Main CHARM Input Window.  The 
following dialog box will appear: 

 

Click on the 'Use Schedule' checkbox and click on the 'Define Schedule' 
button.  The following dialog box will appear: 

 

Enter stability class values in chronological order since release.  Use the 
scroll bar to input additional data. 

Alternatively, the user may define the stability class schedule from 
the 'Met Dialog Input' command under the 'Options' menu in the 
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Main CHARM Input Window.  Select the 'Stability Class' tab after the 
following dialog box is displayed. 

 

Click on the 'Use Schedule' checkbox and click on the 'Define Schedule' 
button.  Once again, the dialog box defining stability class schedule will 
appear. 

 

Enter stability class values in chronological order since release.  Use the 
scroll bar to input additional data. 

 

627



CHARM version 9.3 Enhancements   

 

283

 

Appendix B: Enhancements in CHARM Ver. 9.3 

NOTE: CHARM Version 9.2 is exclusive to the Japanese version of 
CHARM and was not an update to the English version. 

Functional software changes in CHARM Version 9.3 that are not found in 
CHARM Version 9.1 include the following: 

• From an Emission Rate plot within CHARM proper, the user has the ability to copy 
either the container rate, the pool rate, or the total combined rates of the pool and 
the container into the User Specified Emission Rate Schedule in the User-Specified 
release type.  Once copied from the Edit menu of the Emission Rate plot, the 
selected rates may be pasted into the emission rate schedule with the push of a 
button. 

• The 'Dose at Point' menu item under the Displays Menu for Plan concentration 
views in CHARM proper allows the user to input a specified point to generate a Dose 
Plot (or concentration history plot) rather than double-clicking on the display.   

• CHARM version 9.3 comes with documentation inserts into the version 9 User’s 
Manual, and updated on-line help. 

Copy Container, Pool, Total Rate 

Once a scenario has been modeled using any one or the three release 
types (i.e. Container/Surface, Pool/Lagoon, User-Specifed After Release 
Conditions), the user may view the emission rate as a function of time. 
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Select the Edit menu to view the section allowing the user to copy either 
the Container Rate, the Pool Rate, or the Total Rate consisting of both 
the Container Rate and the Pool Rate to the clipboard. 

Once copied, the user may paste the data into the emission rate schedule 
of a User-Specified release.  To do so, change the release type to User-
Specified After Release Conditions and change the emission rate type to 
User-Specified Rate. 

 

If the copied data exists in the clipboard, notice the Paste Data button is 
activated.  Simply press the Paste Data button and the data, which 

Figure B-1 
Example 
output of 
Emission 
Rate Plot 

Figure B-2 
Emission 
Rate 
Scheduler 
Input 
Window 
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includes both time since release and emission rate, will be loaded into 
the emission rate schedule.  This allows the user the flexibility to modify 
or tweak the data. 

 

Dose At Point 

The Dose Plot (or concentration history) is normally displayed by 
generating a Plot Plan Snapshot view of the isopleths of interest, moving 
the cross-hair to the desired point, and either double-clicking the left 
mouse button or pressing <Enter>.  The desired point is generally 
specified by locating the distance and direction (or angle) from the source 
in the status bar at the bottom of the window 

 

The 'Dose at Point' menu item under the Displays Menu for Plan 
concentration views in CHARM proper allows the user to input a 
specified point to generate a Dose Plot (or concentration history plot) 
rather than double-clicking on the display.  This method allows the user 
to input an exact location by specifying the distance and direction of the 
point of interest from the source. 

Figure B-3 
Example of 
Snapshot 
Plan Plume 
Display from 
which the 
user may 
obtain a 
Dose Plot 
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Figure B-4 
Input 
window 
requesting 
direction 
and distance
from source 
to generate 
Dose Plot 
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Appendix C: Enhancements in CHARM Ver. 9.4 

Functional software changes in CHARM Version 9.4 that are not found in 
CHARM Version 9.3 include the following: 

• A glitch in the algorithm for estimating the “RMP Distance” for jet fire radiation 
effects has been corrected.  The previous glitch only affected scenarios where the 
time step shown in the release profile of the “source puff” calculation is less than 40 
seconds. 

• The near-field dispersion algorithm has been changed to reduce enhanced 
dispersion at the source.  The effects of this revision are to generally lower 
dispersion impacts as well as lower vapor cloud explosion overpressure impacts in 
the near field.  This change is going back to the approach used prior to Version 9.3. 

• The X-Y plot axes’ labels have been changed to eliminate exponential notation.  
Originally all tick marks were labeled between 1 and 10 and the axis label had the 
multiplier.  Now the tick marks are labeled with their actual values with no 
multiplier notation. 

• The “3D Plume” display shows multiple concentration isopleths corresponding to 
the isopleths shown on the 2D snapshot plume view.  Previously, only one isopleth 
was shown in the 3D view, and the user was prompted to specify the concentration 
when selecting this option. 

• A number of internal changes were made to the code that have no effect on the 
results but make maintenance and expandability of the code easier.  Some changes 
make it easier to input data.  For example, drag and drop input and output has 
been added to all tables (e.g. emission rates, winds, and stability class). 

• CHARM Version 9.41 was released shortly after Version 9.4. An error in the 
calculation of the flame length for a jet fire was corrected. 

• CHARM Version 9.4 comes with updated documentation, including on-line help and 
inserts into the CHARM User's Manual. 
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Appendix D: Enhancements in CHARM Ver. 9.5 

Functional software changes in CHARM Version 9.5 that are not found in 
CHARM Version 9.4 include the following: 

• The color for each isopleth can be user defined. They no longer are restricted to just 
green, yellow, and red. 

• A number of internal changes were made to the code such as some spelling 
corrections and text placement. 

 

633



   

 

289

 

Appendix E: Enhancements in CHARM Ver. 9.6 

Functional software changes in CHARM Version 9.6 that are not found in 
CHARM Version 9.5 include the following: 

• The number of isopleth values has been increased from 3 to 6. The code has been 
revamped to make further increases, if needed, more easily implemented. The 
isopleth values and colors can be altered in a single screen 

• The 3D display has been enhanced to allow the use of the mouse for moving the 
observer and observed direction. The display has been made to move more 
smoothly. 

• The CHARM version 9.6 help files have been reviewed to make them more useful 
and complete. 

 

 Isopleth Value and Color 

When a plan or 3-D view is in a window the isopleths (concentration, 
thermal radiation, or explosion overpressures) that are plotted can have 
their values and colors changed. 

 

Select the Isopleths… item in the Options menu to view a dialog box 
similar to the one in Figure E-1. 

Figure E-1 
Example 
input screen 
for defining 
isopeth 
value and 
color. 

634



   

 

290

You can enter a value directly into column labelled Value. To change the 
color, double click on the color to change and the dialog box shown in 
Figure E-2 will be displayed. A new color can be selected directly from 
the boxes on the left or a custom color can be created by selecting a point 
in the area to the right. 

 

Figure E-2 
Color 
Selection 
Dialog 
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default filename extensions, 15 
default values, 20 
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78, 79 
Define a Scale command, 75 
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Liquid Head Capacity Coefficient D, 44 
Liquid Head Capacity Coefficient E, 45 
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deleting an icon, 82 
editing icon information, 81 
map generation programs, 71 
map location icon, 77 
metafile format, 72 
naming a larger scaled map, 83 
reading maps from files, 71 
reading maps from the clipboard, 71 
repositioning icons, 81 
saving a map definition, 83 
scrolling, 72 

Maximum Concentration command, 
200 
Maximum Distance command, 197 
maximum distance overpressure 
display, 218 
Maximum Distance Table, 197 
maximum pool diameter, 136 
Maximum Width command, 198 
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Overpressures command, 174 
Pack Chemical Database command, 64 
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1.0 INTRODUCTION 
 
This document describes the algorithms used in URS’s Complex Hazardous Air Release 
Model (CHARM®) software program. CHARM is a modeling program that calculates 
and predicts the dispersion and concentration of airborne vapor and particle plumes from 
released chemicals. CHARM also predicts the footprints of thermal radiation, 
overpressures, and particle deposition. CHARM is especially useful for evaluating the 
impact of accidental releases, designing emergency response plans, and implementing 
training programs. 
 
The CHARM program provides a chemical database containing data on the physical, 
chemical, and toxic properties of over 100 chemical compounds. CHARM requires the 
user to select the chemical released, describe the release, select a terrain grid, and specify 
the meteorological conditions at the release site. A release can be described as 
instantaneous or continuous, contained or uncontained, liquid, gas, or particles. The 
release may be a liquid pool fire, Boiling Liquid Expanding Vapor Explosion (BLEVE), 
or jet fire. Overpressures for a flammable vapor cloud or mechanical failure of a 
pressurized vessel can also be predicted. Meteorological data for input to CHARM can be 
obtained from instruments brought to the site, from a nearby meteorological station, or 
from estimates prepared by a remote weather center. The user input combined with the 
chemical data enables CHARM to simulate the release. 
 
CHARM is a 3D Eulerian grid model. The grid determines the region of computation. 
Beyond the grid all concentrations and impacts are assumed to be zero. 
 
Section 2 of this document explains the formulations used in the source term calculations. 
CHARM’s Source Term module calculates the state of the release (e.g emission rate, 
temperature, partitioning of liquid and vapor, densities, etc.). This information is then 
provided to the Transport/Dispersion module. 
 
Section 3 of this document explains the transport and advection calculations. CHARM 
models releases that are heavier than air, neutrally buoyant, or positively buoyant. The 
model’s calculations consider vapor and particle mass, particle number, energy, and 
momentum. 
 
Section 4 describes the liquid pool fire module, which involves large spills of volatile 
organic chemicals that evaporate quickly and can form a combustible mixture with the air 
above the pool. 
 
Section 5 provides the fireball/BLEVE (Boiling Liquid Expansion Vapor Explosion) 
calculations used in CHARM. 
 
Section 6 describes CHARM’s method for calculating jet fire radiation. 
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Section 7 explains the algorithms used by CHARM to calculate two types of explosion 
overpressures: sphere bursts and vapor cloud explosions. 
 
This document provides all the major equations used in CHARM; however, it is not 
intended to repeat the detailed derivations of the equations when these derivations are 
given in cited references. This document deals with the physical models used in CHARM 
and does not discuss the computer code used to create graphics or to control the user 
interface. For information on how to operate the modeling software to produce useful 
output, refer to the CHARM User’s Manual.
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2.0 SOURCE TERM ALGORITHM 
 
The user initially provides input describing the release and the meteorological conditions 
at the release site. The Source Term calculation takes the user input and determines the 
characteristics of the release (phases, emission rate, temperature, etc.). 
 
The required calculations depend on the thermodynamic properties of the species 
released, the mechanism of the release, and the meteorological conditions. CHARM 
retrieves the thermodynamic properties of the release species from the CHARMED 
chemical database. CHARM comes with a number of chemicals in the database. Other 
chemicals can be added through use of CHARMED. 
 
After the user selects a release type, CHARM prompts the user for the appropriate input. 
Depending on the species and release type, CHARM will allow the calculation of impacts 
of concentrations, thermal radiation from BLEVEs, jet fires, pool fires, or overpressures 
from mechanical failure or vapor cloud explosions. 
 
The release description, which is calculated by the Source Term module, is prerequisite 
information for the Transport/Dispersion module. The calculated release description data 
includes the following: 
 

• X, Y, Z position; 
• Chemical mass rate (vapor and liquid phases); 
• Temperature; 
• Air mass rate; 
• Water vapor mass rate; 
• Direction and speed of exit velocity; and 
• Dimensions. 

 
The release type determines the calculations used in the Source Term module. CHARM 
models the following types of releases: 
 

• Container/surface description; 
• Evaporating pool/lagoon; 
• User-specified; and 
• User-defined grid of concentrations. 

 
Sections 2.1 through 2.3 describe the calculations used in the Source Term module. The 
algorithms used in the calculation come from EPA (1993), Crowl and Louvar (1990), and 
Fauske and Epstein (1987). The user-defined grid of concentrations requires no source 
term calculation.  The concentrations at the grid cells are held constant throughout the 
release. 
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2.1 Container/Surface Description Release 
 
If a liquid is present during the release the emission into the atmosphere may be from two 
sources. Assuming that liquid is in the container, the emission directly from the container 
may consist of flashed vapor and droplets. The second source could be from a pool that 
would form from any liquid that did not flash or become droplets. The release is divided 
into these two major divisions. The pool evaporation calculation is given in Section 2.2. 
 
The calculations given in this section are performed for a point in time. The changes in 
the source are then accounted for (e.g. some mass is gone or the pressure may fall) over 
an internally calculated time step. The calculation is then repeated with the new source 
characteristics. This is repeated until the end condition of a calculation is reached. 
 

2.1.1 Release From Container 
 
A release from a container can consist of up to four steps or phases. Figure 2-1 is a 
schematic of these four phases. The phases are: 
 

• Liquid release; 
• Depressurization to liquid/vapor equilibrium pressure; 
• Boiling; and 
• Depressurization to atmospheric pressure. 

 
If there is no liquid in the container the first three phases do not occur. If a liquid is stored 
at a pressure in equilibrium with its storage temperature the second phase will not occur. 
This section describes the calculations performed to define the release from a container. 
The depressurization phases use the same calculation method. The two phases vary only 
by the pressure at which the depressurization is assumed to stop. 
 
As the liquid is released some may form a pool that then evaporates. An example of what 
the emission rate versus time looks like for the four phases of the container release and 
the evaporating pool is given in Figure 2-2. The relationships between the container 
release rates and the emission from the pool will vary depending on chemical spilled, 
hole size, surface description, etc. 
 

Liquid Release 
 
Figure 2-3 is a blowup view of the liquid release phase in Figure 2-1. Depending on the 
storage conditions of a liquid there are three fates for the liquid: 
 

• Flash to vapor in atmosphere; 
• Become suspended droplets; or 
• Form a pool and evaporate. 
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The liquid in the container in Figure 2-3 will continue to come out until the depth of the 
liquid in the container reaches the bottom of the hole in the container. The characteristics 
of the emission depend on the storage conditions, the species, and the meteorology. The 
amount of liquid mass that goes into suspended droplets is not well defined. In CHARM 
the model can be made to assume that the same amount of mass that flashes will also go 
into forming droplets. The user can also override this assumption and force the amount of 
mass going into droplets to be a fraction between 0 and 1 of the amount of liquid that 
does not flash. 
 
The first calculation performed is for the fraction of species that flashes (F). 
 

 
( ) ( )

v

bpLcpL

H

TCTC
F

−
=  (2-1) 

 
where CpL(T) = heat capacity of liquid at constant pressure and temperature T; 
 Tc = temperature in the container; 
 Tb = boiling point of chemical at ambient pressure; and 
 Hv = latent heat of evaporation at normal boiling point. 

 
The flash fraction is restricted to be between zero and one, inclusive. 

Flash Fraction is Zero 
 
If the flash fraction is zero it is treated as a pure liquid release. The emission rate is 
determined by first calculating the exit velocity (u). From Crowl and Louvar (1990) the 
exit velocity is given by: 
 

 
( )

d
Lf2

2
1

zzg
PP

Cu
HL

L

ac

d

+

−+
ρ
−

=  (2-2) 

 
where  Cd = discharge coefficient (0.65); 
 Pc = pressure in container; 
 Pa = ambient pressure; 
 �L = liquid density; 
 g = gravitational acceleration; 
 zL = height of liquid; 
 zH = height of hole; 
 f = Fanning friction factor; 
 L = connecting pipe equivalent length (see Section 2.1.2); and 
 d = connecting pipe diameter. 
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The value of f is calculated from: 

 �
�

�

�

�
�

�

�
+ε−=

fR
255.1

d7.3
1

log4
f

1

e

 (2-3) 

 
where � = roughness length for clean pipes; 

 Re = Reynolds number (
υ
ρ

= Lud
); and 

 � = liquid viscosity at normal boiling point. 
 
Once the exit velocity is calculated the emission rate (m dot) can be calculated from: 
 
 Aum Lρ=�  (2-4) 

 
where A = area of hole. 

 
For the release of a pure liquid with no flashing the release temperature is assumed to be 
the storage temperature. 
 

Flash Fraction is Not Zero 
 
For this case the release temperature is assumed to be the atmospheric boiling point of the 
chemical. 
 
If the storage pressure is greater than 1.05 times the vapor pressure in equilibrium with 
the storage temperature and the equilibrium vapor pressure is greater than the ambient 
pressure the release is treated as that of a sub-cooled liquid. In a sub-cooled liquid release 
it is assumed that the flashing that takes place occurs after the liquid has been released. In 
this case the release rate is calculated in the same manner as for the flash fraction being 
zero with one exception. The exception is that if a pipe exists the ambient pressure (Pa) 
used in the zero flash case is replaced with the maximum of the ambient pressure and the 
vapor pressure of the chemical in equilibrium with the ambient temperature. If a pipe is 
present it is assumed that it is at ambient temperature. 
 
If the release is not treated as that of a sub-cooled liquid it is assumed that the release is 
that of a pressurized liquid in thermal equilibrium. The release rate for this case consists 
of a basic formula that then gets modified depending on the existence of a connecting 
pipe. The basic formula for the emission rate (Q) is from Fauske and Epstein (1987): 
 

 
pLclg

v

CTv

AH
Q =  (2-5) 

 
where vlg = specific volume (= 1/�v + 1/�L) at container conditions; and 
 �v = vapor density. 
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The parameter to determine how to alter Q is L/Le where Le is the pipe length required to 
establish equilibrium flow conditions. The value of Le is assumed to be 0.1 meters. If 
L/Le < 1 then the emission rate is given by: 
 

 
N
Q

m =�  (2-6) 

 
where N = the correction factor given as: 

 

 ( ) epLc
2
lg

2
DLac

2
v

L
L

CTvCPP2
H

N +
ρ−

=  (2-7) 

 
Otherwise the emission rate is given by: 
 
 FQm =�  (2-8) 
 

where F = the correction factor for friction in the pipe and is given as: 
 

 

d
L006.0

1

1
F

+
=  (2-9) 

 
Depressurization Release 

 
The depressurization release continues until the pressure in the container reaches a 
specific value. For the first depressurization phase this pressure is the one reached when 
the liquid and vapor are in equilibrium in the container. After this first depressurization it 
is assumed that boiling occurs and the container’s pressure is held constant until all liquid 
is gone. Then the second depressurization occurs. The stopping pressure of the second 
depressurization is the atmospheric pressure. 
 
The depressurization release calculation’s first subdivision is if the release is occurring 
through a pipe or not. The calculation is then further subdivided into choked/unchoked 
flow and whether condensation occurs (two-phase release). 
 

No Connecting Pipe 
 
The first calculation is to determine whether the vapor flow is choked or not. This is done 
through: 
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1

c* 1
2

PP
−γ
γ

��
�

�
��
�

�

+γ
=  (2-10) 

 
where � = ratio of heat capacities (Cpv/Cvv) for the vapor phase 
 Cpv = heat capacity of vapor at constant pressure 
 Cvv = heat capacity of vapor at content volume. 

 
If P* is greater than the ambient pressure, the flow is choked. 
 
Choked Flow - If the flow is choked, the formation of liquid droplets at choked 
conditions needs to be investigated. The temperature at choked conditions (T*) can be 
estimated from: 
 

 ��
�

�
��
�

�

+γ
=

1
2

TT c*  (2-11) 

 
This temperature can be used to determine if condensation occurs. If condensation does 
occur the value of T* is invalid. If T* is greater than the critical temperature of the 
chemical, no condensation occurs. If T* is less than the critical temperature, the vapor 
pressure at T* needs to be compared to P*. If the vapor pressure is greater than P* then 
condensation does not occur. 
 
Choked Flow (No Condensation) - The emission rate for choked flow with no 
condensation is given by: 
 

 
1
1

ccd 1
2

PACm
−γ
+γ

��
�

�
��
�

�

+γ
γρ=�  (2-12) 

 
where �c, = density of vapor in container. 

 
The release temperature (Trel) is given by: 
 

 �
�

	


�

�
��
�

�
��
�

�

+γ
−γ−=

1
1

85.01TT crel  (2-13) 

 
Choked Flow (Condensation) - For this case a more detailed calculation at the choked 
conditions is needed. First, the value of T* is needed. In this case T* is the equilibrium 
temperature at the pressure P*. The vapor fraction at choked flow conditions (xe) is 
required. It is calculated from: 
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T
1x  (2-14) 

 
where M = molecular weight of chemical; and 
 R = gas constant. 

 
Given T* and x* allows an estimate of enthalpy change (�H) and density (p*) to be made. 
 
The estimates are given by: 
 
 ( ) ( )*v*cpv x1HTTCH −+−=∆  (2-15) 
 
and 
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�

�

ρ
−+

ρ
=ρ  (2-16) 

 
The emission rate is then given by: 
 
 H70.1Am * ∆ρ=�  (2-17) 
 
The release temperature is assumed to be that in equilibrium with the ambient pressure 
(i.e. normal boiling point if the release is at sea level). With this assumption a vapor 
fraction at release (xrel) can be estimated by: 
 

 
( )

v

rel*pv
*rel H

TTC
xx

−
+=  (2-18) 

 
If xrel is between 0 and 1 the estimate of Trel is valid. Otherwise the value of xrel is set to 
one and the release temperature is calculated from: 
 

 
( )

pv

*v
*rel C

x1H
TT

−
+=  (2-19) 

Unchoked Flow - If the flow is not choked, the formation of liquid droplets still needs to 
be investigated. The method is to assume that the release has no condensation. The 
temperature at released conditions (Trel) can then be estimated. A check can be performed 
to determine if the release has condensation occurring. 
 
Unchoked Flow (No Condensation) - The emission rate for unchoked flow with no 
condensation is given by: 
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The release temperature (Trel) is given by: 
 

 [ ]c

c
rel

Ta411

T
2T

++
=  (2-21) 

 
where 

 
2

apv AMP
Rm

C2
1

a ��
�

�
��
�

�
=

�
 (2-22) 

 
This temperature can be used to determine if condensation occurs. If condensation does 
occur the value of Trel is invalid. If Trel is greater than the critical temperature of the 
chemical, no condensation occurs. If Trel is less than the critical temperature, the vapor 
pressure at Trel needs to be compared to Pa. If the vapor pressure is greater than Pa then 
condensation does not occur. If condensation does occur the unchoked flow with 
condensation calculation needs to be done. 
 
Unchoked Flow (Condensation) - First, the value of Trel is needed. In this case Trel is the 
equilibrium temperature at the pressure Pa. The vapor fraction at release (xrel) is required. 
It is calculated from: 
 

 �
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Given Trel and xrel allows an estimate of enthalpy change (�H) and density �rel to be 
made. The estimates are given by: 
 
 ( ) ( )relvrelcpv x1HTTCH −+−=∆  (2-24) 
and 
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The emission rate is then given by: 
 
 H70.1Am rel ∆ρ=�  (2-26) 
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Connecting Pipe 
 
As in the No Connecting Pipe case the first determination is whether the flow is choked 
or not. This is done in the following manner. 
 
By assuming that the Reynolds number is very large (i.e. the flow is turbulent) the 
Fanning friction factor can be estimated from: 
 

 �
�

�
�
�

�

ε
= d

7.3log4
f

1
 (2-27) 

 
The Mach velocity in the pipe (Ma1) can be calculated, with an iterative method, from: 
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 (2-28) 

 
where 

 2
11 Ma

2
1

1Y
−γ+=  (2-29) 

 
The value of P* can then be calculated from: 
 

 
1

Y2
MaPP 1

1c* +γ
=  (2-30) 

 
If P* is less than Pa or if it is less than Pc the flow is unchoked. Otherwise the flow is 
choked. 
 
Choked Flow - If the flow is choked, the formation of liquid droplets needs to be 
investigated. The temperature at choked conditions (T*) can be estimated from: 
 

 ��
�

�
��
�

�

+γ
=

1
Y2

TT 1
c*  (2-31) 

 
This temperature can be used to determine if condensation occurs. If condensation does 
occur the value of T* is invalid. If T* is greater than the critical temperature of the 
chemical, no condensation occurs. If T* is less than the critical temperature, the vapor 
pressure at T* needs to be compared to P*. If the vapor pressure is greater than P* then 
condensation does not occur. 
 
Choked Flow (No Condensation) - The emission rate for choked flow with no 
condensation is given by: 
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*

d* TR
M

ACPm
γ=�  (2-32) 

 
The release temperature (Trel) is equal to T* 
 
Choked Flow (Condensation) - For this case the calculation is identical to the case for No 
Connecting Pipe except that the emission rate calculation formula is: 
 

 

d
Lf4

1

H
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+

∆ρ=�  (2-33) 

 
Unchoked Flow - If the flow is not choked, the formation of liquid droplets still needs to 
be investigated. The method is to assume that the release has no condensation. The 
temperature at released conditions (Trel) can then be estimated. A check can be performed 
to determine if the release has condensation occurring. 
 
Unchoked Flow (No Condensation) - The emission rate for unchoked flow with no 
condensation is solved for by first determining the emission temperature (Trel) from the 
formula (solved iteratively): 
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The emission rate is then given by: 
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The release temperature can be used to determine if condensation occurs. If condensation 
does occur the value of Trel is invalid. If Trel is greater than the critical temperature of the 
chemical, no condensation occurs. If Trel is less than the critical temperature, the vapor 
pressure at Trel needs to be compared to Pa. If the vapor pressure is greater than Pa then 
condensation does not occur. If condensation does occur the unchoked flow with 
condensation calculation needs to be done. 
 
Unchoked Flow (Condensation) - For this case the calculation is identical to the case for 
No Connecting Pipe except that the emission rate calculation formula is: 
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d
Lf4

1

H
70.1Am *

+

∆ρ=�  (2-36) 

 
Boiling Release 

 
The emission rate from this portion of the release is calculated the same as for the 
depressurization portion of the release except that the emission rate is held constant until 
all liquid remaining in the container below the hole level has been emitted. The 
temperature assumed is the given storage temperature and the pressure assumed is that in 
equilibrium with the storage temperature. Whether the emission is choked/unchoked with 
or without condensation is the same as described for the depressurization. 
 

2.1.2 Connecting Pipe Description 
 
The connecting pipe specified by the user is allowed to have characteristics such as 
valves, elbows, tees, and connections. The number and types of these characteristics are 
used to calculate an equivalent pipe length. These valves etc. have the effect of 
lengthening the pipe. In all calculations where the pipe length L is used it is assumed that 
the equivalent pipe length is actually being used. Each valve, elbow, etc. increases the 
apparent length of the pipe by some factor that is to be multiplied by the diameter of the 
pipe and added to the actual pipe length. Table 2-1 lists these factors for the pipe 
characteristics used in CHARM. Another input to describe the connecting pipe that 
affects the frictional losses of flow is the Relative Roughness Factor. Some representative 
roughness lengths are given in Table 2-2. 
 

2.1.3 Pool Evaporation Release 
 
The evaporation emission from the pool is described in Section 2.2. The pool is allowed 
to grow in size with time as the liquid emission continues or the chemical spreads. 
 

2.2 Pool Dynamics for Container/Surface and Pool/Lagoon 
Release Descriptions 
 
This section describes the algorithms used to simulate the source term from an 
evaporating pool. In CHARM a pool may form in a Container/Surface Description 
release or a pool may be defined with the Pool/Lagoon Description release. In the 
Container/Surface Description release the pool is allowed to grow in diameter and depth 
as mass is added to it. In a Pool/Lagoon Description release CHARM assumes that the 
pool is of a constant diameter with no mass being added as the evaporation occurs. In 
other words, the Pool/Lagoon Description release assumes that there is no container or 
mass source for the pool. This also means that no flash calculation (Eq. 2-1) or droplet 
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suspension is assumed in the Pool/Lagoon Description release. Since the Pool/Lagoon 
Description assumes there is no flash, it should only be used for releases where no flash 
occurs, such as for low volatility liquids. Use the Pool/Lagoon Description release with 
care for high volatility liquids since flashing may actually occur. 
 

2.2.1 Pool Growth 
 
A constraint on the pool spreading is a minimum depth that the pool is allowed to be. The 
theoretical minimum that a pool should form at is the capillary depth (hcap). The capillary 
depth is given by: 
 

 
L

L
cap g

h
ρ

σ=  (2-37) 

 
where �L = surface tension of the liquid. 

 
For a spreading pool that is being fed by a mass rate ( Lm� ), the minimum depth (hfed) is 
given by (Webber, 1990, 1991): 
 

 
4
1

LL
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m6
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�
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��
�

�

π
ν=

�
 (2-38) 

 
CHARM uses the maximum of hcap and hfed to determine a minimum depth (hmin). If the 
pool becomes lower than hmin no pool diameter growth occurs. The rate of pool radius (R) 
growth is given by: 
 

 ( )minhh,0maxg2
dt
dR −=  (2-39) 

 
where h = present depth of pool. 

 
For any time step (�t) the value of h is given by: 
 

 t
dt
dh

hh old ∆+=  (2-40) 

 
where 

 
pool

L

A
m

dt
dh �

=  (2-41) 

 
 where Apool = pool area. 
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If the pool gets to the maximum diameter allowed then the rate of change of the pool 
radius is forced to be zero. This maximum diameter is explicitly defined by the user in 
the Container/Surface Description release option. In the Pool/Lagoon Description release 
the maximum diameter is assumed to be the initial diameter and Lm�  is zero. Therefore in 
the Pool/Lagoon Description release no pool growth is assumed. 
 

2.2.2 Pool Evaporation 
 
There are three processes allowed for adding energy to the pool to allow it to evaporate. 
These are heat transfer (QHT), mass transfer (QMT), and solar radiation (QS). The heat 
transfer is subdivided into heat transfer from conduction with the surface and from 
convection in the air. As suggested in the SPILLS model (Fleischer, 1980) only the 
maximum of heat transfer and mass transfer is used to determine the evaporation rate 
(QEVAP). So QEVAP is given by: 
 
 ( ) SMTHTEVAP QQ,QmaxQ +=  (2-42) 
 
In the case of the Container/Surface Description release all flash and droplet suspension 
calculations are carried out in the Container release portion of the code. For the 
Pool/Lagoon Description release no flash or droplets are assumed. 
 

Heat Transfer 
 
The equation for the heat transfer emission rate (QHT) is: 
 

 
( ) ( )ba

v

La

sv

basF
HT TT

LH
ANuk

tHp
TTAkD

Q −
∆

+
απ∆
−=  (2-43) 

 
where DF = freezing factor (see below); 
 ks = thermal conductivity of the soil; 
 A = area of spill; 
 Tb = normal boiling point; 
 p = percolation factor (see below); 
 �s = thermal diffusivity of the soil; 
 t = time; 
 ka = thermal conductivity of air; and 
 NuL = Nusselt number = h L/ka 
  where h = convective heat transfer coefficient 

 
The first term in the heat transfer equation is the conduction term. The second term is that 
due to convection. 
 
The expression for the freezing factor (DF) is 
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where � is solved from the following equation: 
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where 
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 � = thermal diffusivity; 
 � = density; 
 c = specific heat; 

 
F = latent heat of freezing water; and subscripts F and UF refer to frozen and 
unfrozen, respectively. 
 
The expression for the percolation factor (p), is: 
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K is solved from the following equation: 
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where 
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 ( ) ( )baD

v
2 TTc

H
C

−ρ
ε∆π=  

 K´ = modified Darcy’s constant; 
 �L = liquid surface tension; 
 	L = dynamic liquid viscosity; 
 � = porosity; and 
   subscripts L and D refer to liquid and dry, respectively. 

For laminar flow, the Nusselt number (NuL) is: 
 

 RePr664.0Nu 3
1

L =  (2-48) 
 

where Pr = Prandtl number = 
air/Dair 
 
For turbulent flow, the Nusselt number is 
 

 ( )200,15RePr037.0Nu 8.03
1

L −=  (2-49) 
 

Mass Transfer 
 
The equation used to calculate the mass transfer emission rate (QMT) is: 
 

 �
�

�
�
�

�ρ= − L
A

ShDQ GLacMT  (2-50) 

 
where Dc-a = molecular diffusion coefficient between the chemical and air; 

and 
 ShL = Sherwood number = kc L / Dair 

 
The SPILLS model has the following assumptions: 
 

 
air

air
LL D

ScPrandShNu
ν=≅≅  

 
This assumption allows the use of equations of the same form as those used for the 
Nusselt Number. For laminar flow, the Sherwood Number is calculated as follows: 
 

 ReSc664.0Sh 3
1

L =  (2-51) 
 
For turbulent flow, the equation for the Sherwood number is: 
 

 ( )200,15ReSc037.0Sh 8.03
1

L −=  (2-52) 
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Solar Radiation 

 
The equation for the solar radiation transfer emission rate (Qs) is: 
 
 ASfQ radsS =  (2-53) 
 

where Srad = solar radiation (from user); and 
 fs = efficiency that the solar radiation is used in evaporation(from 

user). 
 

2.3 User-Specified Release 
 
The module for a user-specified release requires the user to supply most of the parameters 
needed for the Transport/Dispersion model. The required user input for this module 
includes: 
 

• Exit temperature; 
• Source diameter; 
• Release direction of movement; 
• Horizontal release speed; 
• Vertical release speed; 
• Droplet mass fraction; 
• Molar water vapor fraction; and 
• Molar air fraction. 

 
The user must also specify whether the release is continuous or instantaneous. 
Continuous releases have emission rates that can be described as constant, linearly 
decreasing, exponentially decreasing, or some user-defined schedule. The module does 
not modify the input but performs the calculations described in the following paragraphs. 
 
CHARM can calculate one of three other variables for the user: emission rate, molar air 
fraction, or exit velocity. 
 
The volume of material being emitted per unit time (VT) is calculated by the following 
equation, which is a restatement of the Perfect Gas Law. 
 

 
a

e
T P

TR
M
E

V =  (2-54) 

 
where E = emission rate (mass/time); 
 M = molecular weight of the vapor; 
 R = universal gas constant; 
 Pa = atmospheric pressure; and 
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 Te = exit temperature. 
 
The value of VT can also be stated as 
 

 FGvD
4

V e
2
hT

π=  (2-55) 

 
where Dh = diameter of hole; 
 ve = exit velocity; and 
 FG = molar fraction of emitted material. 

 
The sum of the fractional compounds in a release must be equal to one; the calculation 
for the molar fraction of emitted material (FG) is expressed as follows. 
 
 FAFW1FG −−=  (2-56) 

 
where FW = molar fraction of water vapo; and 
 FA = molar fraction of air. 

 
Equating the two formulas for VT and using the relationships between FG, FW, and FA 
leads to an equation where, one of ve, E, or FA can be calculated, if two of the three 
variables are known and all other input (such as the hole diameter) is provided. CHARM 
considers only turbulent mixing as a source of FA. Therefore, if the user enters an exit 
velocity of zero, FA is assumed to be zero. 
 
The user-specified release can be defined as continuous or instantaneous. If the release is 
defined as continuous, the user must enter the length of time in which the emission took 
place and 
whether the emission rate is constant, decreasing linearly, decreasing exponentially, or 
user-defined. CHARM estimates the emissions as a function of time (t). 
 
For constant emissions, CHARM uses the specified rate throughout the release. For 
linearly decreasing emissions, CHARM calculates the emission rate as follows: 
 

 ��
�

�
��
�

�
−=

e
0 t

t
1EE  (2-57) 

 
where E = emission rate (mass/time); 
 E0 = initial emission rate; and 
 te = total time of emission. 

 
The amount of mass emitted (GM) between times t1 and t2 (where t2 = t1 + �t) is 
calculated as follows: 
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( )

��
�

�
��
�

� +−∆=
e

21
0 t2

tt
1tEGM  (2-58) 

 
For exponentially decreasing emissions, the total emission time is assumed to be the time 
it takes for the emission rate to reach one percent of its original value. The time it takes 
for the emission rate to become one-half of its original value (t1/2) is calculated as 
follows: 
 

 
( )
( ) e2/1 t

01.0ln
2/1ln

t =  (2-59) 

 
Therefore, the rate for an exponentially decreasing emission has the following form: 
 

 �
�

�
�
�

�

τ
−= t

expEE 0  (2-60) 

 
where 

 ( )2ln
t 2/1=τ  

 
The amount of mass emitted between times t1 and t2 is then calculated with the following 
equation: 
 

 �
�

�
�
�

�

τ
−

��
�

�
��
�

�
�
�

�
�
�

� ∆−τ= 1
0

t
exp

t
t

exp1EGM  (2-61) 

 
For a user-defined schedule, the emission rate between any two times is assumed to be 
linear. 
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Table 2-1. Equivalent Pipe Length Factors (Turbulent Flow, Multiply By Pipe 
Diameter For Equivalent Length) 

Globe Valves (100% open) 300 
Gate Valves (100% open) 7 
Gate Valves (75% open) 40 
Gate Valves (50% open) 200 
Gate Valves (25% open) 900 
90° Elbows 30 
45° Elbows 15 
Tee Elbows-Entering Stem 90 
Tee Elbows-Entering Side 60 
Tee Straight Throughs 20 
Flush Pipe-Vessel Connections 16 
Borda Pipe-Vessel Connections 30 
Round Pipe-Vessel Connections 0 
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Table 2-2. Example Roughness Lengths (mm) For Clean Pipes 

Riveted Steel 0.9-9.1 
Concrete 0.3-3 
Cast hon 0.26 
Galvinized iron 0.15 
Commercial steel 0.046 
Wrought iron 0.046 
Drawn tubing 0.0015 
Glass 0 
Plastic 0 

Source: Perry’s Chemical Engineer’s Handbook, 7th Edition, 1997 
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Liquid Release Fates 
Vapor and Droplets 

Liquid Falling to Surface 

 
Figure 2-3. Closeup of Liquid Release Phase. 
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3.0 CHARM FORMULATION 
 
There are a number of parameters calculated in CHARM as they move throughout the 
atmosphere.  These parameters include, momentum, energy, gas concentration, particle 
concentration, and particle number.  The advection and dispersion calculation for each of 
these parameters are essentially identical. Some of the parameters have extra terms to 
calculate processes that are particular to a parameter.  The basic equations are given here. 
More detail on the particular terms for some of the parameters follows. 
 
Conserved parameters (p – momentum and energy) governing equation: 
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Gas concentration equation 
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Particle concentration equation 
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where Vs = the sedimentation velocity of particle of radius ri: 
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where 

 
i

g
i r

�
numberKnudsenKn ==  

 �part = particle density 
 g = gravitational acceleration 
 � = dynamic viscosity of air 
 A, B, C = corrections for particle resistance to motion (Millikan, 1923) 
 A, B, C = 1.246, 0.42, 0.87 (Kasten, 1968) 

 
The mean free path of a gas molecule (�g) is given in terms of viscosity and air density 
(�g) as: 
 

 
gg

g v
2

ρ
η=λ  (3-5) 

 
The value of gv  is given by: 
 

 
air

B
g m

Tk8
v

π
=  (3-6) 

 
where kB = Boltzmann’s constant 
 T = temperature 
 mair = mass of an air molecule 

 
Particle mass equation 
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3.1 Grid Definition 
 
A 3D grid is required for the calculation.  For each grid column (at an x, y location) two 
parameters are required. One is the elevation of the terrain in that column, the second is 
the surface roughness. 
 
The CHARM Editor (CharmEd) has the capability of reading in DEM files and Globe 
data files to determine the terrain elevations over a grid once the position and size of the 
grid has been set. CharmEd also has the capability of reading in USGS land use files.  
The land use classifications are set to various surface roughnesses.  The user can modify 
the relationship between land use and surface roughness. Of course, surface roughness 
and elevation can be set by the user for each grid cell. 
 
It is suggested that the number of cells in the vertical should be sufficient so that the 
highest terrain is within the grid. That is, it is best if there are no grid columns that are 
completely within the terrain. 
 

3.2 West Wind Field Model 
 
CHARM is designed to be used with as little or much meteorological data as are 
available, since possible applications range from unmonitored wilderness to intensively 
instrumented research areas. Thus, the wind field uses any and all available data, with its 
accuracy improving with increased, usable data. 
 
Atmospheric stability data are interpolated via a l/r2 weighting to produce a stability field 
over the computational domain (1.0 = A stability, 7.0 = G stability). Wind observations 
are projected upwards from the measurement point through the portion of the grid 
without any measurement. Such projected data are weighted as 0.001 compared with 
user-specified weighting of from 0.0 to 1.0. 
 
The projections are based on a power law extrapolation of the form 
 

 
P

0
0 z

z
SS ��

�

�
��
�

�
=  (3-8) 

 
for speeds S and S0 at vertical coordinates z and z0, respectively, with P determined by 
linear interpolation from the following table: 
 

A B C D E F G Stability 
Category 1 2 3 4 5 6 7 
P 0.15 0.17 0.20 0.26 0.39 0.48 0.54 

 

670



 29

The maximum wind speed allowed is 20 m/sec and the initial z0 is assumed equal to �z/2. 
After the wind speeds are projected upwards, the wind speed and direction are resolved 
into u and v vector components at every wind data site. Next, the entire wind field is 
developed via a weighted 1/r2 interpolation of the vertical profiles for each horizontal 
plane. Up to this point, terrain has not been considered. Terrain first enters by shifting the 
interpolated winds upward to clear the terrain. Thus, a complete wind field is calculated. 
However, this wind field is not satisfactory since it is not divergence-free (and it has no 
vertical components). Before the winds are made divergence-free, the velocity fluxes in 
and out of the boundaries of the computational domain are adjusted such that the flux in 
equals the flux out.  If the wind field were to be made divergence-free at this point, the 
effects of atmospheric stability would be lost. Atmospheric stability has the effect of 
varying the relative response to terrain of horizontal and vertical motion.  This is 
accomplished by varying the relative transparencies of the horizontal and vertical cell 
faces. The assignment of transparency was developed on the basis of simulations of 
idealized problems and appears to be qualitatively correct. The assignment of 
transparency is as follows: 
 

Stability Category  1 2 3 4 5 6 7 
Horizontal Transparency Tx,Ty 1.0 1.0 1.0 1.0 200. 500. 1000. 
Vertical Transparency Tz 1.6 1.4 1.2 1.0 0.8 0.6 0.4 

 
Terrain cells are assigned zero transparency. 
 
The non-divergence of the wind field is imposed by an interactive solution based on 
calculating the divergence such that: 
 

 Ð
z
w

y
v

x
u

U =
∂
∂+

∂
∂+

∂
∂=∇  (3-9) 

 
and readjusting the velocity to minimize the divergence. 
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In finite difference, these expressions are written as: 
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where � is an over-relaxation factor (1.0 � <2.0) and is set to 1.25. The positioning of 
the variables is illustrated below: 
 

 

 

 

 
 
 
 
 
 
 
 
 
The subroutine sweeps through the grid from each of the eight corners for fifteen cycles. 
After each cycle, the wind data profiles are incorporated in the wind field by a weighted 
averaging of the iterative solution. At the completion of the iterative cycles, all residual 
divergences are swept out the top of the grid. This completes the wind field development. 
 

3.3 Myrup-Ranzieri Diffusivity Model 
 
CHARM uses the Myrup/Ranzieri (M/R) (Myrup and Ranzieri, 1976) model for 
calculating the diffusivity of the atmosphere.  The model calculates the surface wind 
speed and the Monin-Obukhov length (L) based on the surface stability and surface 
roughness parameter (Z0). The determination of the Monin/ Obukhov length is based on a 
three-part linear fit to the curves presented in the original M/R paper.  The fitted curves 
are shown in Figure 3-1.  A linear interpolation between integerized stability 
classifications is performed.  The top and bottom of the inversion (if any) is determined 
as follows. The inversion base height relative to the terrain (ZIbase) is calculated from: 
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where k1 is the k-coordinate of the first cell lying above the terrain and k2 is the k-
coordinate of the first cell that has a stability number greater than 4.5.  If there are no 
cells with a stability category number greater than 4.5, ZIbase is set equal to -99.00. 
 
The top of the inversion relative to the terrain (ZItop) is calculated from: 
 
 ( ) z5.0kkZI 14top ∆+−=  (3-15) 
 
where k4 is the k-coordinate of the first cell above the inversion base with a stability 
category number less than 4.5. If no such cell is found, ZItop is set equal to 106. The 
vertical diffusivities are calculated by looping over the vertical cells and determining if 
the cell is: 
 

1. below the inversion base or inside a surface inversion, 
2. inside the elevated inversion, or 
3. above the top of the inversion. 

 
For the first case, 
 

 






�





�

�

≥<�
�

�
�
�

�−

<<�
�

�
�
�

� −

≥�
�

�
�
�

� +

=

6.27
L
z

and0L
L
z

35.0
4.0

zU5.0

6.27
L
z

and0L
L
z

151zU35.0

0L
L
z

7.41zU35.0

D

3
1

*

4
1

*

*

 (3-16) 

 
where z = the height above the ground 
 L = the Monin-Obukhov length, and 
 U* = the friction velocity 
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U0 is wind speed at a height zw above the surface and 
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∆=  (3-20) 

 
The parameter z0 is the surface roughness. 
 
The vertical diffusivity D is further modified by the function 
 

 
4
1

baseZI
z

1.1DD ��
�

�
��
�

�
−=  (3-21) 

 
when 
 
 basebase ZI1.1zZI1.0 <<  (3-22) 
 
For the second case (inside an elevated inversion), the surface wind speed is set to 3.0 
m/sec, the Monin-Obukhov length is set to 20.0, and z (the height above the surface) is 
measured from ZIbase. 
 
Above the elevated inversion, the third case, neutral stability is assumed and z is 
measured from the top of the inversion ZItop.  The vertical diffusion is then limited by 
 

 
sec
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1000D
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001.0
22

<<  (3-23) 

 
and assigned to the top face of the cell. 
 
The horizontal diffusivities are calculated using the relation DH=�DV where � depends on 
stability as follows: 
 

Stability A B C D E F 
� 0.5 0.75 1.05 1.35 1.7 2.0 
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The location of the related stability vertical diffusivity and horizontal diffusivity 
parameters are indicated below: 
 
 
 
 
 
 
Note: 
 

Because the diffusivities are face-centered, the vertical stability is offset 
one-half cell above the cell center; the horizontal diffusivity is offset one- 
half cell to the left of the cell center. 

 

3.4 Advection and Diffusion 
 
The advection and diffusion formulation is the same for all constituents simulated: gases, 
aerosols, momentum, and energy.  The advection/diffusion time step is calculated such 
that the maximum normalized flux across any cell is less than alpha, i.e.: 
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The time step is limited to no less than the default time of 0.01 seconds.  Adding a 
statement in the initialization file can change this value. 
 
The model solves the differential equation describing advection and diffusion of a 
parameter (C), i. e.: 
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The solution is performed separately in each direction with the form 
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The value of u to be used is determined from the ambient wind velocity and 

modifications to that velocity due to the presence of mass that has been emitted into the 

grid.  The first modification is due to the emitted momentum in each direction: 
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where u´ = the new wind speed 
 u = the atmospheric wind speed 
 ma = the mass of air in a cell 
 mt = the total mass in a cell 
 pe = the momentum in a cell from an emission 

 
The mass from an emission is tracked for each cell as well as the fraction that may be in 
droplet form.  The volume occupied by the mass from an emission can then be calculated.  
Whatever volume remains in a cell is assumed to be air. 
 
The next modification is only to the vertical component of the velocity and is due to 
buoyancy.  If the difference of the cell’s density (�) with the ambient density (�a) is 
greater than one percent of �a then the vertical velocity may be modified.  If the cell’s 
bottom is not in contact with terrain the vertical velocity is assumed to be changing by: 
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where g = gravitational acceleration = 9.8 m/sec2 

 
If the bottom of the cell is in contact with the ground and the density difference is less 
than –0.01, the vertical motion due to slump is assumed to be transferred to horizontal 
motion.  The horizontal velocity due to the downward motion is given by: 
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The finite difference solution is based on a flux-corrected version of Crowley’s (1968) 
second-order advection scheme (Sklarew and Wilson, 1976). For the nth time step of the 
concentration (C) of the ith species in the x direction: 
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and 
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The flux corrector prohibits the calculation of negative concentrations and by an 
adjustment of the flux, as follows: 
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The location of the related concentrations and fluxes are indicated below: 
 
 
 
 
 
 
 
 
 

3.5 Cell Temperature 
 
The temperature in each cell is calculated for each time step. The calculation is given by: 
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where Tc = cell temperature; 
 Ee = energy in the cell from the emissions; 
 mair = mass of air in the cell; 
 nc = number of emitted species; 
 Cpair(T) = heat capacity of air at temperature T; 
 Cpli(T) = heat capacity of the liquid ith species at temperature T; 
 Cpvi(T) = heat capacity of the vapor ith species at temperature T; 
 fdi = mass fraction of the ith species in droplet form; 

Ci   Ci+1 

Fi+1/2 Fi-1/2 
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 Tamb = ambient temperature; 
 mi = mass of the ith species in cell. 

 
The equation needs to be solved iteratively since the term Tc cannot be totally isolated. 
 
For each time step energy is added to the source’s grid cells. The energy is then allowed 
to advect and disperse according to Equation 3-1. The amount of energy added to a 
source’s grid cell (�Ee) in a time step (dt) is defined as: 
 

 ( )dt)T(C)f1()T(Cf(RE epvidieplidi

ni

1i
ie

c

−+=∆ �
=

=

 (3-36) 

 
where Te = emission temperature 
 Ri = emission rate of the ith species 

 

3.5 Convective Heat Transfer 
 
Heat can be transferred between the plume just above the terrain and the terrain itself. 
The heat transfer is allowed only when that portion of the plume that is not at the source 
location and is in contact with the ground. 
 
The rate that energy (q) is transferred between the plume and the ground is given by: 
 

 ( )cg TTAh
dt
dq −=  (3-37) 

 
where h = convective heat transfer coefficient (assumed to be 100 W/m2 K) 
 A = surface area shared by the cell and ground 
 Tg = surface or ground temperature (assumed to be ambient) 
 Tc = cell temperature 

 
The addition or loss of energy can raise or lower the cell temperature to a new value. 
After the heat is added or depleted from the cell a new cell temperature is calculated. 
 

3.6 Source Terms 
 
The grid cells that have sources in them have mass, momentum, and energy added to 
them at the beginning of each time step.  Complete mixing is assumed to occur in the grid 
cell in which the emission occurs. 
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3.7 Particles 
 
Particles or aerosols are modeled as existing in a number of size bins. The size bins are 
geometric in nature.  That is, the particle volume in a size bin (vi) is equal to the next 
smaller volume bin (vi-1) times a constant value (Vrat). In terms of the bin with the 
smallest volume (v0), the volume of the ith bin is given as: 
 
 i

rat0i Vvv =  (3-38) 
 
The particle radius for the ith bin is then given as: 
 

 3
i

rat0i Vrr =  (3-39) 
 
If there is more than one definition of the size bins from the input (each release can have 
its own size distribution), the model uses the smallest value of Vrat, the smallest value of 
v0 and the largest bin volume to determine a new size bin distribution. 
 
When two particles of volumes vi and vj collide and stick the volume (Vi,j) of the 
resulting particle is: 
 
 jij,i vvV +=  (3-40) 
 
The volume of the resulting particle is partitioned between the two size bins k and k+1. 
The partitioning is performed in the manner described by Jacobson, et al., 1994. 
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where NB = the number of size bins 

 
Following Jacobsen and Turco, 1995, the general formula for calculating the number 
concentration change of particles due to coagulation is given by: 
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 (3-42) 

 
Jacobsen, et al., 1994 provides the formula for the volume-conserving calculation of the 
coagulation of particles of uniform composition as: 
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The Brownian diffusion kernel (�i,j) used in the calculation is from Fuchs (1964): 
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where the particle diffusion coefficient (Di) is defined by: 
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The value of pv  is given by the general formula: 
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B
p m

Tk8
v

π
=  (3-46) 

 
where mpart = the mass of a particle 

 
The mean distance (�) traveled by a particle leaving a sphere’s surface and going the 
particles mean free path distance (�pi) is given by Fuchs (1964) as: 
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where 

 
pi

i
pi v

8D
π

=λ  (3-48) 

 
Condensation and evaporation is calculated using the expression given by Fleagle and 
Businger (1963) for droplets in the atmosphere: 
 

 ( )sc
d ee

TR
MWDr

4
dt

dm −π= ∞  (3-49) 

 
where md = mass of a drop in a size bin; 
 r = drop radius; 
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 D = the diffusion coefficient; 
 MW = molecular weight of the material in the drop; 
 R = universal gas constant; 
 T = temperature of air surrounding the drop; 
 e� = vapor pressure of the material in the drop surrounding the drop; 
 esc = saturation vapor pressure of the material in the drop. 

 
The value of esc is the value of the saturation vapor pressure of the material in the drop 
over a flat surface (es), corrected for the curvature of the drop. It is given as: 
 

 ��
�

�
��
�

�

ρ
σ

=
rTR

MW2
expee ssc  (3-50) 

 
where � = surface tension of the material in the drop; 
 � = density of the drop. 

 
Once mass has been evaporated or condensed the particles in the ith size bin move to 
another size bin because the volume has changed.  Since the number of droplets have not 
changed the new volume of the droplets (Vdi) is given by: 
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V
ρ
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 (3-51) 

 
where �drop = the density of a particle. 

 
The particles with a new volume can be allocated as above using the fraction fi,j,k with Vi,j 
replaced by Vdi. 
 
When condensation or evaporation occurs latent heat and sensible heat can be exchanged. 
The exchanged energy (dE) can be given as: 
 

 
dt

dm
L

dt
dE d

v=  (3-52) 

 
where Lv = latent heat of drop component. 

 

3.8 Chemical Reactions 
 
Chemical reactions can be taken into account for each grid cell of the calculation region. 
The chemical reactions are assumed to be of the form: 
 
 dDcCbBaA K +→+  (3-53) 
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where A = mole concentration of reactant species A (moles/m3); 
 B = mole concentration of reactant species B (moles/m3); 
 C = mole concentration of product species C (moles/m3); 
 D = mole concentration of product species D (moles/m3); 
 a = the amount of species A consumed in the reaction; 
 b = the amount of species B consumed in the reaction; 
 c = the amount of species C produced in the reaction; 
 d = the amount of species D produced in the reaction; 
 K = the reaction rate (moles/m3 second). 

 
There can be unlimited reactants and products; however, each reactant and product must 
exist in the chemical database. The reactions can be entered for use in the Charmed 
program. The reactions can be grouped into sets for use in the calculation. 
 
The value for K is calculated using the expression: 
 
 nm ]B[]A[kK =  (3-54) 
 

where k = the rate constant; 
 m = the order of the reaction for species A; 
 n = the order of the reaction for species B. 

 
The values for m and n are normally determined experimentally. A number of 
dependencies are allowed for k. These are: 
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where A  = a user supplied constant; 
 b  = a user supplied constant; 
 T  = temperature in Kelvin; 
 UV  = ultraviolet radiation in kW/m2; 
 TSR  = total solar radiation in kW/m2; 
 Air  = concentration of air in moles/m3; 
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 Water  = concentration of water vapor in moles/m3; 
 AerosolArea = surface area concentration of particles in m2/m3; 

 
There is a special case usage for the value of k. Rather than being treated as a rate 
constant it is used as a mole concentration of a species. The special case is indicated to 
the model by having no reactants. One or more products can be defined, each of which 
will be assigned a constant concentration equal to the value of k. For example, if a 
constant supply of O2 is wanted in a set of reactions, the following reaction could be 
defined: 
 
 2ONone →  (3-56) 
 
The O2 concentration can then be defined to be 20 percent of the air available to the 
reaction by using the expression k = A (Air) and assigning the value of A to be 0.2. 
 

3.9 Liquid Flow Over Terrain 
 
The flow of liquid over terrain is built around a modified Manning Equation for open 
channel flow: 
 

 
water

water

liq

liq
3
2

liq

n

sD
U

ρ
η

η
ρ

=  (3-57) 

 
where U = the average speed of the liquid flow; 
 Dliq = the liquid depth; 
 s = the slope of the terrain; 
 n = the Manning Roughness Coefficient (set to 0.025); 
 pliq = the flowing liquid density; 
 �liq = the viscosity of the flowing liquid; 
 pwater = water density; and 
 �water = the viscosity of water. 

 
The flow speed from the Manning Equation is compared to the speed that would be 
expected if the liquid were spreading due to gravitational spread. The gravitational spread 
speed (Ug) is given by: 
 
 gD2U liqg =  (3-58) 

 
If the gravitational spread speed is greater than the Manning speed it is used.  The 
gravitational spread speed is normally only greater on a flat surface. 
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Much of the liquid flow calculation is taken up in determining boundary conditions such 
as the liquid is not allowed to flow uphill.  For any one grid cell the liquid is allowed to 
flow in eight directions (each corner and the center of each side). 
 
As the flow continues the heat and mass transfer and porosity terms for an evaporating 
pool as described in Chapter 2 are used to determine mass loss terms. These loss terms 
become the source terms into the atmosphere. 
 

3.10 Hydrogen Fluoride 
 
Hydrogen Fluoride exhibits non-ideal dynamics. At high concentrations, the individual 
molecules can form oligomers (polymers which contain two, three, or four monomers). 
The dynamic effect is to increase the molecular weight of the release. It may be desirable 
to have different data sets for a compound such as hydrogen fluoride. One set of 
parameters could be used for low concentration releases, the other for pure releases. From 
Bekerdite et al (1983), there is sufficient data to create a table relating the apparent 
molecular weight of hydrogen fluoride to the temperature and concentration of the 
hydrogen fluoride gas. Such a table is presented in Table 3-1. As that table shows, in pure 
concentration (1,000,000 ppm) hydrogen fluoride at 20°C has an apparent molecular 
weight of 51.6. Above 70°C, however, hydrogen fluoride is present as a monomer at all 
concentrations giving a molecular weight of 20. 
 
The dispersion of hydrogen fluoride is handled by the algorithms in this section with the 
molecular weight of the hydrogen fluoride varying according to Table 3-1. CHARM uses 
the name of the chemical to determine if the table should be used. The chemical name in 
the database must match exactly “Hydrogen Fluoride” for the table to be invoked. 
 

Table 3-1. Hydrogen Fluoride Apparent Molecular Weight As A Function Of 
Temperature And MolarFraction Concentration. 

Temp(°C)/fj 1.0 0.9 0.8 0.7 0.6 0.5 0.4 0.3 0.2 0.1 
20 51.59 48.58 43.78 39.53 35.47 31.56 27.03 23.78 21.53 20.32 
30 36.22 33.45 30.51 27.20 24.65 22.91 21.65 20.68 2037 20.03 
40 25.26 23.66 22.50 21.51 20.88 20.53 20.36 20.15 20.02 20.01 
50 21.06 20.65 20.53 20.32 20.18 20.09 20.02 20.01 20.01 20.01 
60 20.17 20.10 20.05 20.01 20.01 20.01 20.01 20.01 20.01 20.01 
70 20.01 20.01 20.01 20.01 20.01 20.01 20.01 20.01 20.01 20.01 
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Figure 3-1. 1/L as a Function of Pasquill Stability Class. 
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4.0 LIQUID POOL FIRE ALGORITHM 
 
Large spills of volatile organic chemicals evaporate readily and can form a combustible 
mixture with air above the pool. When ignited, a major fire can result. Experience has 
shown that flames initially appear at several locations over the pool and spreading begins. 
In a typical fire, the intensity grows and combustion products reach 1500°F after several 
minutes. The intensity and speed of growth depend largely on the material involved and 
its heat of combustion. The algorithms shown in this section were prepared by Shirley 
(1982). 
 
After a stable flame involving the entire pool has been established, the overall shape of 
the fire appears to be a truncated cone whose sides are slightly concave (Blackshear, 
1974). Figure 4-1 shows the general appearance and configuration. 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

Figure 4-1. General Appearance of a Liquid Pool Fire 
 
The base of the flame area is only slightly smaller that the pool itself. The diameter of the 
cone top is about 2/3 that of the base at a height roughly equal to the diameter of the base. 
Fuel evaporates from the pool surface, and air is drawn into the cone sides to mix with 
the fuel. Since air enters from the outside of the cone surface, fuel vapors in the center 
move up the axis of the cone with flames surrounding them. Near the upper end of the 
cone, these fuel vapors mix with the combustion products and react with them, as well as 
with the air being drawn further toward the cone center. As the unburned material is 
heated, cracking reactions form soot causing the pool fires to be generally very smokey. 
Mixing conditions at the lower levels of the cone are very poor, but a considerable 
amount of turbulence appears in the upper levels. 
 

d 

d´ 

Fire 
Area 

Air 
Air 
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The air supply in such fires is not enough to burn all the vapors of combustible material 
evaporated. These unburned vapors are entrained in the plume and carried up with it. 
When the fire occurs in a diked area containing tanks, heating of the tank walls occurs, 
with rapid evaporation of material in the tanks. This material joins the plume (if the tank 
vent is not remotely located). The plume is then very rich in the organic chemicals 
involved. The fire reactions are a complex mixture of oxidation, cracking, reduction, and 
recombinations. In this technique, gross estimates were used to predict likely quantities of 
heat released and the reaction products obtained. A kinetic model that accounts for 
reaction rates and residence times at various temperatures is needed to improve the 
predictions. 
 

4.1 Heat Release and Product Composition 
 
Fuel supply to the fire comes from evaporation at the surface of the pool in response to 
heat from the fire. A study (Zabetakis, 1964) of pool fires using various combustible 
materials produced an equation for predicting the drop in liquid level during burning. The 
equation is: 
 

 
v

C

H
H

0076.0V =∞  (4-1) 

 
where V� = maximum decrease in pool level (cm / min); 
 Hc = heat of combustion; and 
 Hv = heat of evaporation. 

 
The study included butane, hexane, benzene, xylene, unsymmetrical dimethyl hydrazine, 
methanol, and diethylene triamine. Figure 4-2 plots these data. 
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Figure 4-2. Relationship between liquid-burning rate (large pool diameter) and ratio 

of net heat of combustion to sensible heat of vaporization. 
 
This equation for the decrease in pool level is valid for pools in still air that are larger 
than two meters diameter and for all sizes of pools in windy conditions. No increase in 
rate is indicated at reasonable wind conditions. Small pools less than one meter in 
diameter had lower rates of surface level decreases. 
 
 
Air supply enters the fire area by diffusion and by reduced pressure in the cone caused by 
the rising of hot gases. Data on the quantity of air that entered were not available. The 
assumption was made that the burning took place at the upper flammability limit for the 
organic compound involved. Using the evaporation rate for the pool area (V) produced a 
value for the fuel rate, which was divided by the upper flammability limit value to get the 
air rate. In the formaldehyde and phenol cases evaluated, both water vapor and the 
chemical evaporated. The upper flammability limit is affected (Zabetakis, 1964) by an 
inert diluent, as shown in Figure 4-3. 
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Figure 4-3. Limits of flammability of ethylene-carbon dioxide-air and ethylene-

nitrogen-air mixtures at atmospheric pressure and 26° C. 
 
This figure shows the effect of N2 diluent and CO2 diluent for ethylene. The upper 
flammability limits for formaldehyde and phenol were adjusted using the nitrogen 
example, because the molar heat capacities of nitrogen and water are similar. 
 
The stoichiometric amount of combustible in air is related to its molecular constituents. 
Given the compound CNHMOLFK, where C is carbon, H is hydrogen, O is oxygen and F is 
a halogen, the equation (Zabetakis, 1964) is: 
 

 
�
�

�
�
�

� −−++
=

4
L2KM

N733.41

100
CST  (4-2) 

 
where CST = concentration (volume percent) of combustible in air at 

stoichiometric ratio. 
 
An estimate for the percent burned is required. The percent burned can be estimated by 
assuming the burning plume is axially symmetric. The value of CST should lie between 
the lower and the upper flammable limits. Above the lower flammable limit and below 
CST all is burned. Above CST, too much organic is present to burn entirely. One hundred 
percent is assumed to be burned at CST, and zero percent is assumed burned at the upper 
flammable limit. Between CST and the upper flammable limit, the relationship between 
the concentration and the percent burned is assumed to be linear. The amount of material 
burned (mB) is: 
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where FL = concentration, vol. %, of combustible in air at lower flammable 

limit; 
 FU = concentration, vol. %, of combustible in air at upper flammable 

limit; 
 c = concentration at some radial distance, r, from plume center; 
  = c0 exp(-a2 r2); 
 c0 = concentration at plume center; 
 a = inverse of standard deviation of plume concentration; and 
 dV = 2 � r dr dz. 

 
The total mass, mT, in the plume is given as: 
 

 �
∞

=
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T dVcm  (4-4) 

 
The percent burned, B%, is then given as: 
 

 
T

B
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m100
B =  (4-5) 

 
Integrating and using the mass per vertical length dz, leads to: 
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The value of c0 is assumed to be identical to FU since that is the first concentration at 
which a burn will occur. 
 
In a review of the literature on carbon black manufacture, Schwartz et al (1974), Hustvedt 
et al. (1976), Shreve and Brink (1977), and U.S. EPA (1979)) provide an estimate of heat 
release and product composition for a combustion reaction involving cracking. The data 
indicates that at 1500 to 1800°F, an approximate 10 percent yield of carbon could be 
obtained from heavy aromatic compounds. The ratio of CO to CO2 in the gas stream 
would be about 1:1, and 1/2 mole of H2 would be present for each mole of CO and CO2 
present. Under these conditions, the endothermic reactions reduce the heat of reaction to 
about 80 percent of the standard net heat of combustion. These conditions were chosen 
for evaluating liquid pool fires. The heat evolved in these fires is calculated as 
evaporation rate times the fraction burned times 80 percent of the heat of reaction. If 
chlorine is present in the material being burned, the model assumes that 10 percent of the 
CO is being converted to phosgene. 
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The one-to-one ratio for CO:CO2 is accurate to ±30% and the 0.5-to-one ratio for H2 to 
(CO + CO2) is accurate to about ±50%. There will be some CO and some H2 remaining in 
the plume after it cools to a temperature that is below the activation temperature. The 
amount depends on the equilibrium approach in the CO2-H2O-soot system, which exists 
at high temperatures for relatively long residence times (two or three seconds) in the fire 
area. The carbon black production data used for these assumptions were at slightly higher 
temperatures for very short residence times (< 1/2 second). Lower values for these ratios 
result in higher temperature plumes with less potential for hazards, while higher values 
yield lower temperature plumes. 
 
The assumption of 10 percent of CO being converted to phosgene in the presence of 
chlorine atoms is a gross estimate of unknown accuracy. Most or very few of the chlorine 
atoms may be converted to phosgene; the only data available indicates that phosgene has 
been observed in fires with chlorine present. As a case in point, carbon tetrachloride is no 
longer recommended for fire extinguisher use, with phosgene evolution being the primary 
cause. 
 

4.2 Heat Sumps 
 
Heat from the fire evaporates the materials from the pool, heats the evaporated material 
and air to auto-ignition temperature, radiates to the surroundings, and heats the 
combustion/reaction products in the plume. The considerations for heat include: 
 

• Heat of evaporation, which is the product of quantity of material evaporated times 
the latent heat of evaporation; 

• Quantity of vapor generated multiplied by its heat capacity; 
• Temperature difference between boiling point and auto-ignition temperature; 
• Quantity of air times its heat capacity; and 
• Temperature difference between ambient temperature and auto-ignition 

temperature. 
 
In the original study (Burgess et al, 1961), which developed the evaporation rate 
equation, infrared sensors were located around the pool to measure radiation and 
determine the percent of total heat that radiated to the surroundings from various fires. 
These data were found to correlate with free energy of formation (�F at 25°C) for the 
chemicals burned. This relationship does not apply for hydrogen, but appears usable for 
hydrocarbons and alcohols. Figure 4-4 shows a plot of the data in this form. 
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Figure 4-4. Relationship between percent of total heat radiated to the surroundings 

and free energy of formation. 
 
The developed equation is: 
 
 27F26.0R +∆=  (4-7) 
 

where R = percent of total heat release radiated to surroundings; and 
 �F = free energy of formation (kcal/mole). 

 
The radiant heat is the product of total heat evolved in the fire times R/l00. 
 
To obtain a heat available for raising the combustion product temperature, the total heat 
release is reduced by the latent heat of evaporation, by sensible heats of the air and 
organic vapors up to auto-ignition temperature, and by the radiant heat to surroundings. 
To determine this temperature rise, the composition of the combustion products and the 
quantity of each component is determined by a material balance. Then each component is 
multiplied by its heat capacity. The summation of these multiplications is the heat 
capacity of the plume in units of BTU per unit time per °F temperature difference. 
Dividing the heat available by the heat capacity of the plume gives the increase in 
temperature of the products above the auto-ignition temperature. The sum of these is the 
plume temperature. The equations are: 
 

 �
=

=
n

1i
piiplume CWE  (4-8) 

 
where Eplume = energy addition to plume (BTU “F / second); 
 n = number of components 
 Wi = rate each component is added to plume (pounds / second); and 
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 Cpn = heat capacity of each component (BTU °F / pound). 
 

 
plume

plume E
Q

T =∆  (4-9) 

 
where  �Tplume = temperature rise of plume; and 
 Q = heat available from combustion. 

 
 plumeiplume TTT ∆+=  (4-10) 
 

where  Tplume = final plume temperature; and 
 Ti = auto-ignition temperature. 

 
The material balance provides information on hazardous chemicals remaining in the 
plume and the total quantities of components in the plume. The total volume at the final 
temperature is computed to obtain a plume velocity at the top of the cone-shaped fire 
area. 
 

4.3 Tank Involvement in Fire 
 
When a fire surrounds a tank, materials in the tank are heated and vented. National Fire 
Codes (National Fire Protection Association, 1973-74) specify the size of vents required 
in terms of the volume rate of release for tanks with fire surrounding them. Table 4-1 
shows the required venting rates as free airflow. The table shows the wetted area versus 
cubic feet free air per hour at 14.7 psia and 60° F. 
 
Table 4-1. Wetted Area Versus Cubic Feet Free Air* 

Square Feet Cubic Feet/Hour 
20 21,100 
30 31,600 
40 42,100 
50 52,700 
60 63,200 
70 73,700 
80 84,200 
90 94,800 

100 105,000 
120 126,000 
140 147,000 
160 168,000 
180 190,000 
200 211,000 
250 239,000 
300 265,000 
350 288,000 
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400 312,000 
500 354,000 
600 392,000 
700 428,000 
800 462,000 
900 493,000 

1,000 524,000 
1,200 557,000 
1,400 587,000 
1,600 614,000 
1,800 639,000 
2,000 662,000 
2,400 704,000 

2,800 and over 742,000 
* Interpolate for intermediate values. 

 
The wetted surface area is the area inside the tank in contact with the liquid. This table 
was used to determine airflow rate, and a conversion to the equivalent flow of organic 
chemical was made by using the density of the chemical vapor at its boiling point. This 
procedure gave a slightly higher venting rate than an alternate procedure that estimates 
the heat transfer rate shown in the appendix of the National Fire Codes. 
 
The effect of the blending vapors into the plume is the reduction of the plume 
temperature and the increase of the total component weight of the plume due to the added 
chemical. The heat capacity of the added chemical vapor times its weight included in the 
plume heat capacity provided a smaller Tplume for the mixed system. The heat used to 
vaporize the material in the tank was assumed to be included in the heat radiated to 
surroundings. 
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5.0 FIREBALL/BLEVE ALGORITHM 
 
The Fireball/BLEVE (Boiling Liquid Expanding Vapor Explosion) algorithm is one of 
the simplest in CHARM; only a few equations must be solved. The method comes from 
Moorhouse and Pritchard (1982) and Roberts (1982). Instead of being derived from 
fundamental principles, the BLEVE equations are parametric. 
 

5.1 Calculation of the Efficiency of Explosion 
 
An efficiency of explosion is either entered by the user or calculated by CHARM. If 
calculated, the explosion efficiency (
) is a function of the vapor pressure of the material 
and is: 
 
 32.0

SP27.0=ν  (5-1) 

 
where PS = vapor pressure in Pascals of the chemical at the storage pressure. 

 
The radius (Rf) of the ensuing fireball (in meters) is calculated as follows: 
 
 327.0

kgf m665.2R =  (5-2) 

 
where mkg = mass of material in kilograms involved in the explosion. 

 
The duration (Tf) of the fireball in seconds is given as: 
 
 327.0

kgf m089.1T =  (5-3) 
 
Finally, the amount of radiation (W) being emitted is given as: 
 

 
f

kgc

T

1000mH
W

ν
=  (5-4) 

 
where W = energy emission rate in watts; and 
 Hc = heat of combustion of the material in Joules per gram. 
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5.2 Calculation of Fluxes 
 
Once the energy emission rate (W) is calculated, the fluxes can be determined at any 
distance from the source. The fireball is assumed to be a point source. As such, the flux 
(F) at some distance (r) from the fireball can be calculated using the inverse square 
property of radiation: 
 

 2r4
W

F
π

=  (5-5) 

 
Because the fireball is assumed to be a point source, either F or r can be specified and the 
other parameter calculated. 
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6.0 JET FIRES 
 
The jet fire algorithm used is designed around the Multiple Point Source Model (MPSM) 
described by Crocker and Napier (1988). In this method, the radiation from a jet fire is 
divided into three components: that which falls on a vertical target perpendicular to the 
X-axis, that which falls on a vertical target parallel to the X-axis, and that which falls on 
a horizontal target. 
 

6.1 Calculation of the Flame Length 
 
Crocker and Napier present an expression relating the flame length to jet fluid mole 
fraction in an unreacted stoichiometric mixture, flame temperature, and ratio of reactants 
to products in the unreacted stoichiometric mixture. These values would change for 
different releases and may be difficult to discern for any single release. Because of this, 
CHARM uses another expression for the flame length, which is also given by Crocker 
and Napier. The flame length calculation is actually for a vertical flame, but it has 
simpler parameters for its computation, which should result in longer flames. 
 
The length of flame (L) expression is: 
 
 aQ10x32.1L 52.03 −= −  (6-1) 

 
where Q = total heat released by combustion (W); and 
 a = distance of the base of the flame from the exit (m). 

 
Q is the emission rate times the heat of combustion. The emission rate is calculated from 
one of the source term algorithms described in Section 2.0. Only those sources with an 
exit velocity greater than zero are allowed to also have a jet fire analysis performed. 
 

6.2 Calculation of the Lift-Off Distance of the Flame 
 
The lift-off distance (a) of the flame from the exit, is: 
 

 
1

j
j U

U
d6.1a π=  (6-2) 

 
where dj = diameter of the jet; 
 Uj = exit velocity of jet; and 
 U1 = velocity of jet at distance a from the exit, given as 0.2 Mach. 

 
If Uj is less than U1, the value of a is set equal to zero. 
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6.3 Calculation of the Radiation Fields of the Flame 
 
The values of a and L are used in placement of the flame. In CHARM, the radiation fields 
are calculated as if the flame is at the origin of the coordinate system and the centerline is 
in the direction of the X-axis. The flame may be at an upward angle but the projection of 
the flame axis into the X-Y plane is assumed to fall on the X-axis. After the calculation is 
completed, the radiation field is rotated and translated to reflect the actual location of the 
flame base. This action makes the calculation somewhat simpler by eliminating cross 
terms in the formulae presented by Crocker and Napier. 
 

6.3.1 Calculation of Radiation Falling on a Horizontal Target 
 
The equation used for the intensity of radiation falling on a horizontal target (qh) is: 
 

 ( ) ��
�

�
��
�

�
−

+
−π
+=

OL

L
2

2

h P
C

P
CxB

cd4bL2
m1Qf

q  (6-3) 

 
where f = fraction of total heat released as radiation 
  jc

4 MH10x2.2 −=  

   where Hc = heat of combustion (J/g); and 
    Mj = molecular weight of jet fluid at exit; 
 m = slope of flame; 
 b = -2 (x-m z) 
 c = x2+y2+z2; 

 d = l+m2; 
 B = m b+2dz; 
 C =2 m c+b z; 

 cxbxdP L
2
LL ++=  

 cPO =  

 �
�

�
�
�

� Θ−π=
2

cosLx L  

 � = flame tilt from vertical; and 
 x, y, z = location of the center of the target relative to the source. 
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6.3.2 Calculation of Radiation Falling on a Vertical Target 
 
The equation for the radiation falling on a vertical target perpendicular to the X-axis 
( ⊥vq ), outside of the flame and where x > xL, is given by: 
 

 ( ) ��
�

�
��
�

�
−

+
−π

+=⊥
OL

L
2

2

v P
E

P
ExD

bcd4L2
m1Qf

q  (6-4) 

 
where D = 2 x d + b; and 
 E = x b+2 c 

 
Finally, the equation for the radiation falling on a vertical target parallel to the X-axis 
(qv=) is: 
 

 ( ) ��
�

�
��
�

�
−

+
−π

+==
OL

L
2

2

v P
b

P
bxd2

bcd4L2
m1yQf

q  (6-5) 

 

6.3.3 Calculation of the Total Radiation 
 
The intensity of radiation falling on horizontal and vertical targets contributes to the 
entire radiation being received at the target. The total radiation (q) received is calculated 
as follows: 
 

 2
v

2
v

2
h qqqq =⊥ ++=  (6-6) 

 
The isopleths of radiation flux for the jet fire are determined by performing a binary 
search in both directions pointed at by the flame. For example, if the flame is pointing 
from the origin down the X-axis, CHARM first searches down the positive X-axis until 
the desired radiation flux value is passed, and then it searches down the negative X-axis. 
 
Once the two extremes are found, CHARM arbitrarily divides the distance into twenty 
segments. For each segment, CHARM performs a binary search left and right of the line 
on which the flame lays to find the extremes of the desired radiation. 
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7.0 EXPLOSION OVERPRESSURES 
 
CHARM calculates overpressures or shockwave pressures for two scenarios: a sphere 
bursting due to failure of the vessel and an unconfined vapor cloud explosion. Both of 
these phenomena are modeled using methods from Baker et al. (1983). 
 

7.1 Sphere Burst Overpressure 
 
Although the equations described here are strictly for the mechanical failure of a 
pressurized sphere, they are used for all cases of pressurized failure. A mechanical 
failure, such as in an instantaneous gas release, is always assumed to be from a spherical 
vessel. 
 
Two important factors in a pressurized vessel failure shockwave calculation are the 
storage pressure and the amount of material stored. Pressure has the units of energy 
density and describes the amount of energy available for shockwave formation. 
 
The equation for calculating the maximum overpressure of a sphere burst is provided by 
Liepman and Roshko (1967): 
 

 

( )

( )

��
�

�
��
�

�

−γ
γ−





�




�

�





�




�

�

�
�

	


�

�
��
�

�
��
�

�
−+γ+γγ

��
�

�
��
�

�
−��

�

�
��
�

�
−γ

−=

1
2

0

0s
000

0

0s

1

0
1

0

0s

0

1

1

1

1
p
p

122

1
p
p

a
a

1

1
p
p

p
p

 (7-1) 

 
where p1 = pressure inside the sphere; 
 p0 = atmospheric pressure; 
 ps0 = air shock pressure at the instant of burst; 
 �1 = Cp/Cv for gas in sphere; 
 �0 = Cp/Cv for air; 
 Cp = specific heat at constant pressure; 
 Cv = specific heat at constant volume; 
 a0 = speed of sound in air; and 
 a1 = speed of sound in sphere; 

 
The parameter that must be solved for by iteration, is ps0/p0. 
 
The value used in CHARM is the overpressure ( SP ), which is defined as follows: 
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 1
p
p

P
0

s
S −=  (7-2) 

 
At the sphere surface, the overpressure equation is: 
 

 1
p
p

P
0

0s
0S −=  (7-3) 

 
The other parameter required for predicting the overpressure at distances downwind is an 
energy-scaled radius ( R ). At the surface of the sphere, the energy-scaled radius ( 1R ) 
given by Baker is: 
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where r1 = radius of the sphere; 
 R0 = energy radius 
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−

; and 

 V1 = volume of sphere. 
 
Once the values of SP  and R  are known at the sphere surface, a curve that agrees with 

these values can be selected from Figure 7-1. Once a curve is selected, if either value, R  
or SP , is known, the other can be calculated. The curves shown in Figure 7-1 have been 
digitized, and CHARM interpolates the actual curve to use once the conditions at the 
sphere surface are known. The dimensional pressure and radius can be found by 
multiplying the dimensionless overpressures and radii by p0 and R0, respectively. 
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Figure 7-1. SP  Versus R  for Sphere Burst Overpressure Calculations. 

 

7.2 Unconfined Vapor Cloud Explosion 
 
Vapor cloud explosions are modeled also by determining the SP  and R  at some location 
in the vapor cloud and then using Figure 7-1 to predict the overpressures at any distance. 
The vapor cloud is subdivided into user-definable cells. These cells are not the ones that 
CHARM uses to calculate the advection and dispersion of the release. Each cell is 
exploded individually, and its contribution at a point is individually determined. The 
maximum overpressure at a point is selected as the maximum overpressure from any of 
the exploding cells. 
 
The creation of isopleths of overpressure is handled similarly to the jet fire case. The 
maximum extents of the selected overpressure values upwind and downwind are 
determined. Once the two extremes are found, CHARM creates a grid containing the 
impact region. 
 
The amount of mass within an exploding cell is only the amount that is in concentrations 
greater than the lower explosive limit (LEL). A cloud can either detonate or deflagrate. 
Detonation is treated as the case limit of deflagration as the flame speed increases. If the 
flame speed is greater than Mach 1, CHARM treats it as a detonation. Otherwise, 
CHARM treats it as a deflagration. Figure 7-2 illustrates the hierarchy of mechanisms 
used. The chosen mechanism is determined by flame speed. 
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Figure 7-2. Maximum Wave Overpressure Versus Energy-Scaled Distance for 
Explosions With an Energy Density q = 8 and Various Normal Burn Velocities. 

 
Figure 7-2 illustrates the different overpressures that can be expected in the case of a 
cloud with energy density of 8. The curve labeled P represents Pentolite. All other solid 
curves were calculated using the CLOUD program. The curve labeled D is for Detonation 
and S is for a Sphere Burst of the same energy density. The horizontal dashed lines 
represent the predicted flame overpressures for very low-velocity flames calculated using 
the theory of Taylor (1946) for piston motion where the piston motion has been 
transformed to an equivalent normal burning velocity for a flame system. The vertical 
dashed line in the figure represents the final radius of the cloud based on energy-scaled 
radius for an energy density of 8 when the energy is added so slowly that there is no 
pressure rise. 
 
The dashed lines outside this vertical line are predicted overpressures based on the 
following equation: 
 

 
R
1

PS =  (7-5) 

 
The dashed vertical line in the figure represents the final radius of a deflagrating cloud 
based on an energy-scaled radius when the energy is added so slowly that there is no 
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pressure rise. This scaled radius is equivalent to the 1R  in the sphere burst calculation. 

1R  is different for a deflagration than a detonation. The value of 1R  is: 
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where q = energy density 

  = 
ava

ceff

TC
H

 

 Hceff = effective heat of combustion; and 
 Cva = specific heat at constant volume of air. 

 
Hceff is the molar weighted average of the heats of combustion of the released material 
(Mg) and air (Ma). Normally, the heat of combustion of air is ignored, so that it can be 
calculated from: 
 

 ( ) ag

gc
ceff MFG1MFG

MHFG
H

−+
=  (7-7) 

 
where FG = molar fraction of the emitted material in the cell 

 
In either deflagration or detonation the value of R0 is the same: 
 

 
3
1

0
0 p

E
R ��

�

�
��
�

�
=  (7-8) 

 
where E = energy expended from the burn 
  = mlel � Hc; 
 mlel = mass above LEL; and 
 � = efficiency of explosion. 

 
Given values for 1R  and R0, a value for r1 can be calculated. This leaves the computation 
of the value of SP . Consider the case of a flame speed of less than Mach 1, which is 

considered by CHARM to be a deflagration. The value of SP  at 1R  is given by Taylor 
(1946) as: 
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where �1 = density ahead of the flame; 
 �2 = density behind the flame; and 
 MSU = flame speed in Mach. 

 
The ratio of �2/�1 can be taken as the zero pressure rise density change across the flame if 
the overpressure is assumed to be low, which is valid for many deflagration cases. Using 
this assumption leads to: 
 

 1
q

11

2 +
γ

=
ρ
ρ

 (7-10) 

 
The Taylor equation breaks down as MSU gets large. If MSU gets larger than (�2/2) �1 an 
extrapolation is made from lower MSU values. In such a case, the value of SP  is assumed 
to go as the logarithm of MSU. 
 
In the detonation case, the sphere burst technique of solution is used after determining an 
equivalent storage pressure. As shown in Figure 7-2, the detonation and sphere burst 
curves are similar. In a detonation, there is a choking limit velocity called the Chapman-
Jouguet velocity (MCJ) that cannot be exceeded. MCJ is given by: 
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The SP at the speed MCJ is treated as equivalent to the storage pressure in a bursting sphere 
and is calculated as: 
 

 
1

M1
P

1

2
CJ1

CJ +γ
γ+

=  (7-12) 

 
If MSU is greater than or equal to MCJ, the problem is treated as a bursting sphere with the 
internal storage pressure given as CJP . If MSU is less than MCJ, a second SP  is calculated 
for a bursting sphere at the same value of q as in the vapor cloud explosion calculation. 
 
The shockwave speed for the bursting sphere (Mbs) from Liepmann and Roshko (1967) 
is: 
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( )
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1
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q1
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γ
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+=  (7-13) 

 
Once again, SP  is assumed to go as the logarithm of MSU. With the two values of SP  and 

the two values of M, an equation can be formulated to estimate the value of SP  for the 
given flame speed, MSU.
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Input Data Used for Site 3 Emission Estimate Modeling 
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Input Data Used for Site 3 Emission Estimate Modeling 
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Site3_Path1_0 1 1 1.515 75.8 51.55 29.7692308 0.11357556 28.9158669 14.4579335 5299880 11622415 1 5299893 11622382 4.5 5299866 

Site3_Path1_1 1 1 1.205 112.3 51.39 29.5314286 0.16522094 28.9158669 14.4579335 5299880 11622415 1 5299893 11622382 4.5 5299866 

Site3_Path1_2 1 1 1.524 79.4 51.36 30.1382353 0.19099539 28.9158669 14.4579335 5299880 11622415 1 5299893 11622382 4.5 5299866 

Site3_Path1_3 1 2 1.642 84.7 51.23 95.3029412 356.612967 28.9158669 14.4579335 5299880 11622415 1 5299893 11622382 4.5 5299866 

Site3_Path1_4 1 4 2.562 121.6 50.96 377.925 323.477726 28.9158669 14.4579335 5299880 11622415 1 5299893 11622382 4.5 5299866 

Site3_Path1_5 1 3 1.692 93 50.91 29.94 0.19595918 28.9158669 14.4579335 5299880 11622415 1 5299893 11622382 4.5 5299866 

Site3_Path1_6 1 1 1.536 113 50.89 31.0176471 1.89107355 28.9158669 14.4579335 5299880 11622415 1 5299893 11622382 4.5 5299866 

Site3_Path1_7 1 1 2.352 112.2 50.66 29.3294118 0.23076524 28.9158669 14.4579335 5299880 11622415 1 5299893 11622382 4.5 5299866 

Site3_Path1_8 1 1 1.92 58.06 50.6 29.1352941 0.18610932 28.9158669 14.4579335 5299880 11622415 1 5299893 11622382 4.5 5299866 

Site3_Path1_9 1 3 2.395 113.3 50.6 38.8785714 35.811893 28.9158669 14.4579335 5299880 11622415 1 5299893 11622382 4.5 5299866 

Site3_Path1_10 1 4 1.848 97.1 50.59 29.5478261 0.11747179 28.9158669 14.4579335 5299880 11622415 1 5299893 11622382 4.5 5299866 

Site3_Path1_11 1 2 1.242 85.2 50.6 659.40303 674.18905 28.9158669 14.4579335 5299880 11622415 1 5299893 11622382 4.5 5299866 

Site3_Path1_12 1 3 1.782 62.66 50.49 145.597143 369.747296 28.9158669 14.4579335 5299880 11622415 1 5299893 11622382 4.5 5299866 

Site3_Path1_13 1 3 1.384 97.3 50.53 29.9352941 0.09965338 28.9158669 14.4579335 5299880 11622415 1 5299893 11622382 4.5 5299866 

Site3_Path1_14 1 1 1.934 114.9 50.6 30.2735294 1.14411765 28.9158669 14.4579335 5299880 11622415 1 5299893 11622382 4.5 5299866 

Site3_Path1_15 1 1 1.65 92.8 50.55 30.1529412 0.09466751 28.9158669 14.4579335 5299880 11622415 1 5299893 11622382 4.5 5299866 

Site3_Path1_16 1 2 1.525 81.9 50.59 210.429412 418.233631 28.9158669 14.4579335 5299880 11622415 1 5299893 11622382 4.5 5299866 

Site3_Path1_17 1 1 1.521 99.4 50.57 229.436364 465.632582 28.9158669 14.4579335 5299880 11622415 1 5299893 11622382 4.5 5299866 

Site3_Path1_18 1 2 1.312 98.1 50.63 30.2885714 0.11897522 28.9158669 14.4579335 5299880 11622415 1 5299893 11622382 4.5 5299866 

Site3_Path1_19 1 4 1.368 111.1 50.62 30.5 1.6744402 28.9158669 14.4579335 5299880 11622415 1 5299893 11622382 4.5 5299866 

Site3_Path1_20 1 3 1.28 107.3 50.77 30.112 0.11771151 28.9158669 14.4579335 5299880 11622415 1 5299893 11622382 4.5 5299866 

Site3_Path1_21 1 4 1.389 93.9 50.81 30.4 0.14142136 28.9158669 14.4579335 5299880 11622415 1 5299893 11622382 4.5 5299866 

Site3_Path2_0 1 1 1.282 99.9 50.97 1103 902.1933 46.6573042 23.3286521 5299880 11622415 1 5299893 11622382 4.5 5299870 

Site3_Path2_1 1 3 1.689 105.6 51.1 58.05 5.75695232 46.6573042 23.3286521 5299880 11622415 1 5299893 11622382 4.5 5299870 

Site3_Path2_2 1 3 1.989 133.1 50.96 448.524 609.634497 46.6573042 23.3286521 5299880 11622415 1 5299893 11622382 4.5 5299870 
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Site3_Path2_3 1 2 2.227 122.1 50.92 168.927273 281.84622 46.6573042 23.3286521 5299880 11622415 1 5299893 11622382 4.5 5299870 

Site3_Path2_4 1 2 2.166 117.2 50.89 1057.87879 928.343193 46.6573042 23.3286521 5299880 11622415 1 5299893 11622382 4.5 5299870 

Site3_Path2_5 1 5 1.54 103 50.95 523.30303 417.873439 46.6573042 23.3286521 5299880 11622415 1 5299893 11622382 4.5 5299870 

Site3_Path2_6 1 1 1.973 70.4 50.94 1325.59375 636.620956 46.6573042 23.3286521 5299880 11622415 1 5299893 11622382 4.5 5299870 

Site3_Path2_7 1 1 1.768 91.5 50.8 307.684848 560.759433 46.6573042 23.3286521 5299880 11622415 1 5299893 11622382 4.5 5299870 

Site3_Path2_8 1 1 1.517 120.3 50.82 354.267647 409.052336 46.6573042 23.3286521 5299880 11622415 1 5299893 11622382 4.5 5299870 

Site3_Path2_9 1 1 1.627 54.07 50.56 369.418182 482.707397 46.6573042 23.3286521 5299880 11622415 1 5299893 11622382 4.5 5299870 

Site3_Path2_10 1 1 1.976 150.9 50.44 100.574286 181.451853 46.6573042 23.3286521 5299880 11622415 1 5299893 11622382 4.5 5299870 

Site3_Path2_11 1 1 1.783 111.7 50.27 40.6823529 0.54203895 46.6573042 23.3286521 5299880 11622415 1 5299893 11622382 4.5 5299870 

Site3_Path2_12 1 1 1.968 90.6 50.16 40.5735294 0.16504692 46.6573042 23.3286521 5299880 11622415 1 5299893 11622382 4.5 5299870 

Site3_Path2_13 1 2 1.863 139.4 50.16 58.3294118 32.9236597 46.6573042 23.3286521 5299880 11622415 1 5299893 11622382 4.5 5299870 

Site3_Path2_14 1 1 1.309 213.1 49.99 40.9970588 1.53593913 46.6573042 23.3286521 5299880 11622415 1 5299893 11622382 4.5 5299870 

Site3_Path2_15 1 1 1.132 70.7 50 242.005882 548.441451 46.6573042 23.3286521 5299880 11622415 1 5299893 11622382 4.5 5299870 

Site3_Path2_16 1 4 1.475 103.1 49.97 1051.50606 758.262498 46.6573042 23.3286521 5299880 11622415 1 5299893 11622382 4.5 5299870 

Site3_Path2_17 1 2 2.033 109.2 49.98 323.590625 372.443219 46.6573042 23.3286521 5299880 11622415 1 5299893 11622382 4.5 5299870 

Site3_Path2_18 1 1 0.999 94 49.95 716.461765 622.526027 46.6573042 23.3286521 5299880 11622415 1 5299893 11622382 4.5 5299870 

Site3_Path2_19 1 1 1.69 152.9 49.98 829.848485 611.736545 46.6573042 23.3286521 5299880 11622415 1 5299893 11622382 4.5 5299870 

Site3_Path2_20 1 1 1.728 174 49.88 124.241176 102.217867 46.6573042 23.3286521 5299880 11622415 1 5299893 11622382 4.5 5299870 

Site3_Path2_21 1 2 1.899 134.4 49.71 514.220588 678.90871 46.6573042 23.3286521 5299880 11622415 1 5299893 11622382 4.5 5299870 

Site3_Path2_22 1 3 2.429 136.2 49.65 653.511765 556.585267 46.6573042 23.3286521 5299880 11622415 1 5299893 11622382 4.5 5299870 

Site3_Path2_23 1 2 1.631 112.8 49.78 42.2911765 3.16946531 46.6573042 23.3286521 5299880 11622415 1 5299893 11622382 4.5 5299870 

Site3_Path2_24 1 2 1.512 85.5 49.88 362.705882 553.905075 46.6573042 23.3286521 5299880 11622415 1 5299893 11622382 4.5 5299870 

Site3_Path2_25 1 1 1.504 93.9 49.92 766.936364 693.631238 46.6573042 23.3286521 5299880 11622415 1 5299893 11622382 4.5 5299870 

Site3_Path2_26 1 1 1.394 148.7 50.05 43.1942857 5.92288264 46.6573042 23.3286521 5299880 11622415 1 5299893 11622382 4.5 5299870 

Site3_Path2_27 1 4 1.459 79.2 50.08 244.19697 450.192518 46.6573042 23.3286521 5299880 11622415 1 5299893 11622382 4.5 5299870 

Site3_Path2_28 1 1 0.917 146.3 50.15 149.264706 145.637879 46.6573042 23.3286521 5299880 11622415 1 5299893 11622382 4.5 5299870 

Site3_Path2_29 1 4 1.329 187 50.29 40.1352941 0.41008059 46.6573042 23.3286521 5299880 11622415 1 5299893 11622382 4.5 5299870 
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Site3_Path2_30 1 1 1.363 142.6 50.3 40.0941176 0.13271193 46.6573042 23.3286521 5299880 11622415 1 5299893 11622382 4.5 5299870 

Site3_Path2_31 1 1 2.254 43.98 50.36 40.0181818 0.142392 46.6573042 23.3286521 5299880 11622415 1 5299893 11622382 4.5 5299870 

Site3_Path2_32 1 5 1.772 66.9 50.34 40.0735294 0.14206217 46.6573042 23.3286521 5299880 11622415 1 5299893 11622382 4.5 5299870 

Site3_Path2_33 1 5 1.468 71.4 50.44 169.358824 306.465778 46.6573042 23.3286521 5299880 11622415 1 5299893 11622382 4.5 5299870 

Site3_Path2_34 1 3 1.61 74.4 50.51 1691.875 800.025615 46.6573042 23.3286521 5299880 11622415 1 5299893 11622382 4.5 5299870 

Site3_Path2_35 1 1 2.78 142.1 50.54 1075.12121 878.037897 46.6573042 23.3286521 5299880 11622415 1 5299893 11622382 4.5 5299870 

Site3_Path2_36 1 1 2.713 132.6 50.97 553.49697 838.770981 46.6573042 23.3286521 5299880 11622415 1 5299893 11622382 4.5 5299870 

Site3_Path2_37 1 1 1.818 157.7 50.91 1748.73333 477.253876 46.6573042 23.3286521 5299880 11622415 1 5299893 11622382 4.5 5299870 

Site3_Path2_38 1 2 2.085 96.2 51.01 105.697059 156.279152 46.6573042 23.3286521 5299880 11622415 1 5299893 11622382 4.5 5299870 

Site3_Path2_39 1 1 0.444 128.4 51.08 40.1352941 0.35220511 46.6573042 23.3286521 5299880 11622415 1 5299893 11622382 4.5 5299870 

Site3_Path2_40 1 4 2.458 143.4 51.41 175.393939 435.893906 46.6573042 23.3286521 5299880 11622415 1 5299893 11622382 4.5 5299870 

Site3_Path2_41 1 3 1.92 123.9 51.33 655.215152 463.100631 46.6573042 23.3286521 5299880 11622415 1 5299893 11622382 4.5 5299870 

Site3_Path2_42 1 1 2.269 114.9 51.32 1077.51515 687.655751 46.6573042 23.3286521 5299880 11622415 1 5299893 11622382 4.5 5299870 

Site3_Path2_43 1 1 0.872 143.1 51.29 1451.19655 838.482273 46.6573042 23.3286521 5299880 11622415 1 5299893 11622382 4.5 5299870 

Site3_Path2_44 1 1 1.452 58.62 51.42 521.491176 634.387763 46.6573042 23.3286521 5299880 11622415 1 5299893 11622382 4.5 5299870 

Site3_Path2_45 1 1 0.645 160.4 51.28 65.0352941 62.9950926 46.6573042 23.3286521 5299880 11622415 1 5299893 11622382 4.5 5299870 

Site3_Path2_46 
14
35 1 1.727 147.9 51.88 314.739506 419.02995 46.6573042 23.3286521 5299880 11622415 1 5299893 11622382 4.5 5299870 
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